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คาํนํา 

ในระยะเวลาหลายสบิปีทีѷผา่นมา แม ้Excel ถกูพัฒนาใหเ้ป็นโปรแกรมทีѷเป็นประโยชนม์ากขึѸน มี
คําสัѷงและมเีครืѷองมอืใหม่ๆ เตรยีมไวใ้หเ้ลอืกใชม้ากขึѸนกวา่แตก่อ่นก็ตาม แตต่ัวสตูรทีѷ Excel มี
อยูก่ลับมกีารเปลีѷยนแปลงนอ้ยมาก มสีตูรใหมท่ีѷจําเป็นตอ่การใชง้านเกดิขึѸนใหมเ่พยีงเล็กนอ้ย
เทา่นัѸน เชน่ ใน Excel 365 รุน่ลา่สดุมสีตูรทีѷชว่ยลัดขั Ѹนตอนในการคํานวณไดง้า่ยขึѸนโดยไม่
จําเป็นตอ้งเสยีเวลาคํานวณทลีะขั Ѹน แตส่ตูรใหมไ่มส่ามารถใชก้บั Excel รุน่กอ่น 

หลักสตูรฉลาดใชส้ารพัดสตูร Excel อยา่งมอือาชพีก็ผา่นรอ้นผา่นหนาวมาหลายปีเชน่กนั 
หลักสตูรนีѸมุง่ใหผู้ใ้ช ้Excel รูจั้กคดิ ฉลาดเลอืกใชส้ตูร Excel ใหถ้กูกบัสถานการณ์ โดยเลอืก
เฉพาะสตูรทีѷมคีวามจําเป็นตอ้งนํามาใชง้านขึѸนมาอบรมเพืѷอทราบขอ้ด ีขอ้เสยี และขอ้ควรระวัง 
แนะนําวธิคีดิออกแบบตารางใหเ้หมาะสมกบัการคํานวณ และหาทางกระตุน้ใหผู้เ้ขา้อบรมเรยีนรู ้
วธิแีกปั้ญหาไดด้ว้ยตัวเอง โดยมุง่ใชส้ตูรทีѷใชไ้ดก้บั Excel ทกุรุน่เป็นหลัก 

อยา่งไรก็ตามเนืѷองจากระยะเวลาเรยีนในหอ้งอบรมมเีพยีง 2-3 วัน ไมส่ามารถแนะนําเรืѷองราว
และถา่ยทอดประสบการณ์การใชส้ตูรไดค้รบถว้น จงึขอแนะนําใหอ้า่นคูม่อืเลม่นีѸซ ึѷงมเีนืѸอหาทีѷ
อาจไมม่โีอกาสหยบิยกขึѸนมาอบรมอยูอ่กีมาก 

คูม่อืประกอบการอบรมเลม่นีѸไดร้วบรวมเนืѸอหาสําคัญของหลายหลักสตูร ทั Ѹงหลักสตูรสดุยอด
เคล็ดลับและลัดของ Excel หลักสตูรหันมาใช ้Excel จัดการฐานขอ้มลูแทน Access กนัดกีวา่ 
และหลักสตูรประยกุตใ์ช ้Excel เพืѷอวางแผนความตอ้งการวัสดแุละจัดตารางการผลติ ตลอดจน
การใชส้ตูรใน VBA อกีทั Ѹงไดนํ้าตัวอยา่งคําถามคําตอบและสตูรแบบแปลกๆจากเว็บหลายแหง่
มารวมไว ้จงึหวังวา่ผูเ้ขา้อบรมจะไดเ้ปิดหเูปิดตาและไดแ้นวทางนํากลับไปสรา้งงานของตน 

ประเด็นสําคัญของการสรา้งสตูร คอื ตอ้งรูจั้กคดิและสรา้งสตูรไดด้ว้ยตัวเอง มใิชล่อกสตูรของ
คนอืѷนมาใชแ้ลว้แกะหรอืแกไ้ขตอ่ใหด้ขี ึѸนกวา่เดมิไมเ่ป็น 

          สมเกยีรต ิฟุ้งเกยีรต ิ    
           13 เมษายน 2564 
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วธิปีรบั Excel ใหพ้รอ้ม 
ตอ่การใชง้านอยา่งมอือาชพี 

1. ตอ้งการปรบัใหก้ดปุ่ ม Enter เพืѷอ
บนัทกึคา่แลว้อยูท่ ีѷเซลลเ์ดมิ สัѷง 
File > Options > Advanced > ตัด
กาชอ่ง After pressing Enter, 
Move selection  
 
ทั ѸงนีѸใน Excel 2007 สัѷง Office > 
Excel Options แทน File > 
Options > 
 
 

2. ตอ้งการปรบัใหก้ดปุ่ ม F2 เพืѷอ Edit แกไ้ขบน Formula Bar แทนในเซลล ์สัѷง File > 
Options > Advanced > ตัดกา
ชอ่ง Allow editing directly in 
cells  
คําสัѷงนีѸยังมผีลทําใหเ้มืѷอดับเบลิ
คลกิทีѷเซลลส์ตูรแลว้ Excel จะยา้ย
ตําแหน่งไปยังตําแหน่งเซลลต์น้
ทางทีѷอา้งองิในสตูรนัѸน และเมืѷอกด
ปุ่ ม F5 > Enter จะยา้ยกลับมาทีѷ
เซลลเ์ดมิทีѷเคยดับเบลิคลกิ 
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3. ตอ้งการเปลีѷยนระบบการคาํนวณเป็น manual สัѷง File > Options > Formulas > กา
ชอ่ง Manual จากนัѸนตอ้งกดปุ่ ม F9 เพืѷอสัѷงคํานวณทกุแฟ้มหรอืกด Shift+F9 เพืѷอสัѷง
คํานวณเฉพาะชทีทีѷเลอืกอยูเ่ทา่นัѸน 

 
หมายเหต ุระบบการคํานวณจะเปลีѷยนตามระบบของแฟ้มแรกทีѷเปิดขึѸนกอ่นเสมอ 
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การกาํหนดตาํแหนง่อา้งองิ 

บทความนีѸมจีดุประสงคใ์หผู้ท้ีѷเคยใช ้Excel มากอ่นและมพีืѸนฐานมาบา้ง ซึѷงพอทราบวา่ตําแหน่ง
อา้งองิ (Cell Reference) ในตาราง Excel คอือะไรและนําไปใชก้นัอยา่งไร จะไดเ้ปิดหเูปิดตา
เรยีนรูเ้คล็ดลับทีѷคนทัѷวไปอาจมองขา้มหรอืไมน่กึฝันวา่จะเป็นไปได ้แลว้สามารถนําตําแหน่ง
อา้งองิไปใชก้บัสตูรและคําสัѷงไดอ้ยา่งพลกิแพลงมากยิѷงขึѸน โดยเฉพาะการเลอืกใสเ่ครืѷองหมาย 
$ ใหก้บัตําแหน่งอา้งองินัѸน ไมว่า่จะเป็น $ ในเซลลส์ตูร, $ ใน Conditional Format, $ ใน 
Data Validation, หรอื $ ในในเครืѷองมอือืѷนๆของ Excel ก็ตาม ผมถอืวา่ $ เป็นหัวใจของการใช ้
Excel ทเีดยีว 

ต ัҟงหลกักนักอ่นวา่จะใช ้Excel อยา่งคอมพวิเตอร ์

คณุลองนกึดวูา่มนุษยเ์ราไดร้ับประโยชนจ์ากการใชเ้ครืѷองคอมพวิเตอรต์า่งจากสมัยทีѷยงัมแีต่
เครืѷองคดิเลขใหใ้ชก้นัอยา่งไรบา้ง หลายคนน่าจะตอบวา่ เครืѷองคอมพวิเตอรต์อ้งชว่ยใหคํ้าตอบ
ทีѷเร็วกวา่เครืѷองคดิเลขใชไ่หม แลว้ความเร็วทีѷวา่นีѸถกูวัดมาจากเวลาทีѷใชไ้ปของเครืѷอง
คอมพวิเตอรห์รอืเวลาของคณุกนัละ่ 

แน่นอนทีѷสดุวา่เครืѷองคอมพวิเตอรย์อ่มทํางานเร็วกวา่เครืѷองคดิเลข และเครืѷองคอมพวิเตอรร์ุน่
ใหมย่อ่มทํางานไดเ้ร็วกวา่เครืѷองคอมพวิเตอรร์ุน่เกา่ ยิѷงใช ้Excel ทีѷตดิตั Ѹงบนเครืѷองคอมพวิเตอร์
รุน่ลา่สดุ ก็ยิѷงไดคํ้าตอบผลลัพธจ์ากการคํานวณเร็วขึѸน ซึѷงถา้ใครหลงเขา้ใจวา่ตัวเองใช ้Excel 
แบบคอมพวิเตอรเ์ป็นอยูแ่ลว้เพยีงเพราะดจูากความเร็วของเครืѷองคอมพวิเตอรท์ีѷใชอ้ยู ่ก็เป็น
ความเขา้ใจทีѷถกูตอ้งเพยีงบางสว่น (และเป็นสว่นทีѷไมส่ําคัญเทา่ใดเสยีดว้ย) เพราะถา้คณุใช ้
Excel อยา่งคอมพวิเตอรเ์ป็น ตอ่ใหย้กเครืѷองคอมพวิเตอรร์ุน่โบราณทีѷทํางานชา้เป็นเตา่ ก็จะ
พบวา่คณุไมไ่ดเ้สยีเวลาตา่งกนัมากนัก 

ลักษณะของการใช ้Excel อยา่งคอมพวิเตอรม์ดีังนีѸ 

1. คณุจะตอ้งเสยีเวลาสรา้งงานนานหน่อย เนืѷองจากตอ้งหาทางคดิสรา้งงานใหเ้หมาะสม
กบัแตล่ะสถานการณ์ ซึѷงคณุควรตั Ѹงหลักไวว้า่ แฟ้มงานทีѷสรา้งขึѸนมานัѸน จะตอ้งสามารถ
นํากลับมาใชซ้ํѸาแลว้ซํѸาอกีไดโ้ดยไมต่อ้งยอ้นกลับไปแกไ้ขใหมอ่กีแมแ้ตน่อ้ย 

2. หากจําเป็นตอ้งแกไ้ข ตอ้งสามารถแกไ้ขปรับปรงุแฟ้มไดง้า่ย ใชเ้วลาไมม่าก และไม่
สง่ผลกระทบตอ่การคํานวณเดมิทีѷถกูตอ้งอยูแ่ลว้ ทั ѸงนีѸไมว่า่จะกําหนดใหผู้ท้ีѷทําหนา้ทีѷ



9 

 

© พ.ศ.2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ
www.ExcelExpertTraining.com 

แกไ้ขนัѸนคอืคณุซึѷงเป็นผูส้รา้งแฟ้มนัѸนเอง หรอืแมแ้ตจ่ะเป็นผูอ้ืѷนซึѷงไมเ่คยใชแ้ฟ้มนัѸนมา
กอ่นก็ตาม 

3. สามารถลดจํานวนคนและไมต่อ้งเพิѷมอตัรากําลังคนตามปรมิาณงานทีѷเพิѷมขึѸน 
4. ประหยัดเงนิลงทนุ เพราะไมต่อ้งจา่ยเพืѷอซืѸอเครืѷองหรอืโปรแกรมคอมพวิเตอรร์ุน่ใหม ่
5. คณุตอ้งมคีวามสขุและมเีวลาวา่งใหก้บัชวีติมากขึѸน 

สตูรฉลาด (Smart Formula) 

Smart Formula แปลวา่ สตูรฉลาด ซึѷงสตูรฉลาดทีѷวา่นีѸจะฉลาดไดก้็ตอ่เมืѷอใชค้วามฉลาดของ
คณุในการสรา้งสตูรขึѸนมา เพืѷอใหม้ลัีกษณะการใชง้านไดต้ามนีѸ 

ในชทีหนึѷงๆหรอืตารางหนึѷงๆ ตอ้งมสีตูรตน้ฉบับเพยีงเซลลเ์ดยีว ซึѷงสามารถนําไปใช ้

ไดก้บัเซลลอ์ืѷนๆไดทั้ Ѹงตาราง แลว้เมืѷอใดทีѷจําเป็นตอ้งแกไ้ขสตูรใหม ่ก็จัดการแกไ้ข
สตูรนีѸเพยีงเซลลเ์ดยีวแลว้ Copy นําไป Paste เพืѷอใชไ้ดก้บัทกุเซลลใ์นตาราง 

ในโครงสรา้งของตัวสตูรฉลาดอาจใชว้ธิกีําหนดตําแหน่งอา้งองิแบบเซลลเ์ดยีวหรอืแบบกําหนด
ขอบเขตตารางก็ได ้โดยไมว่า่จะใชว้ธิใีดก็หลกีหนกีารกําหนดตําแน่งอา้งองิทีѷมเีครืѷองหมาย $ 
กํากบัตําแหน่ง 3 แบบตอ่ไปนีѸไปไมพ่น้ 

 ตาํแหนง่อา้งองิแบบ Absolute Reference มเีครืѷองหมาย $ วางไวด้า้นหนา้ของทัѸง
ตําแหน่ง Row และ Column เชน่ =$A$1 โดยใหใ้ชตํ้าแหน่งอา้งองิแบบนีѸกบักรณีทีѷ
ตอ้งการนําคา่คงทีѷไปใช ้

 ตาํแหนง่อา้งองิแบบ Relative Reference เป็นตําแหน่งอา้งองิซึѷงไมม่เีครืѷองหมาย 
$ เชน่ =A1 ซึѷงสตูรทีѷอา้งองิแบบนีѸจะตอ้งใชท้ีѷเซลลเ์ดมิเซลลเ์ดยีวไปตลอด ไมส่ามารถ 
Copy นําไป Paste เพืѷอทําใหไ้ดค้า่เดมิซํѸาทีѷเซลลอ์ืѷนไดอ้กี เพราะตําแหน่งอา้งองิจะ
เขยืѸอนตา่งจากตําแหน่งเดมิเสมอ ดังนัѸนจงึเป็นการอา้งองิแบบทีѷใชใ้นเซลลส์ตูรกนันอ้ย
ทีѷสดุ แตก่ลับถกูนํามาใชก้นัมากใน Conditional Formatting หรอื Data Validation 

 ตาํแหนง่อา้งองิแบบ Mixed Reference เป็นตําแหน่งอา้งองิทีѷนยิมใชก้นัมากทีѷสดุ 
โดยผูส้รา้งสตูรตอ้งเลอืกใสเ่ครืѷองหมาย $ ดา้นหนา้ตําแหน่ง Row หรอื Column เพยีง
อยา่งใดอยา่งหนึѷง เชน่ =A$1 เพืѷอคงตําแหน่ง Row 1 ไวต้ามเดมิตลอด หรอื =$A1 
เพืѷอคงตําแหน่ง Column A ไวต้ามเดมิตลอด ไมว่า่จะ Copy นําสตูรไป Paste ทีѷ
ตําแหน่งอืѷนก็ตาม 
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วธิสีรา้งสตูรใหม้ตํีาแหน่งอา้งองิทีѷมเีครืѷองหมาย $ นําหนา้ตําแหน่งของ Row และหรอื Column 
นีѸ ใหใ้ชว้ธิ ีPointing แลว้กดปุ่ ม F4 ซํѸาไปเรืѷอยๆจนกวา่จะไดตํ้าแหน่ง $ ตามตอ้งการ 

1. ใหเ้ริѷมจากพมิพเ์ครืѷองหมายเทา่กบั = ลงไปในเซลลท์ีѷตอ้งการสรา้งสตูร (เพืѷอแสดงการ
ยดึครองเซลลนั์Ѹนไวก้อ่นวา่ เป็นเซลลท์ีѷจะรับสตูรลงไปเมืѷอเรากดปุ่ ม Enter) 

2. จากนัѸนใชว้ธิชีีѸลงไปในเซลลท์ีѷตอ้งการ (Pointing แปลวา่ ชีѸ) โดยใช ้Mouse คลกิเลอืก
เซลลท์ีѷตอ้งการ ไมว่า่จะอยูต่า่งชทีหรอืตา่งแฟ้มกนัก็ตาม เชน่ คลกิทีѷเซลล ์A1 จะได ้
สตูร =A1 

3. จากนัѸนใหก้ดปุ่ ม F4 ไปเรืѷอยๆ จะพบวา่มเีครืѷองหมาย $ แทรกลงในสตูรใหเ้องตามลําดับ
ทีѷมกีารกดปุ่ ม F4 ดังนีѸ A1  $A$1  A$1  $A1  A1  แลว้จะมเีครืѷองหมาย $ 
วนซํѸาไปอกี 

4. เมืѷอไดตํ้าแหน่ง $ ควบคมุตําแหน่ง Row และหรอื Column ตามตอ้งการแลว้ใหก้ดปุ่ ม 
Enter เพืѷอรบัสตูรลงไปในเซลล ์แลว้จะพบวา่ Excel จะพากลบัมาทีѷเซลลซ์ึѷงพมิพ์
เครืѷองหมายเทา่กบันําหนา้สตูรเอาไวต้ั Ѹงแตแ่รกนัѷนเอง 

การใสเ่ครืѷองหมาย $ เพืѷอเป็นการควบคมุตําแหน่งอา้งองิไวไ้มใ่หเ้ขยืѸอนนีѸ นอกเหนอืจากการทํา
ใหค้ณุสามารถ Copy สตูรไปใชใ้นเซลลอ์ืѷนไดทั้นทแีลว้ ยังเป็นเรืѷองน่าสงัเกตวา่ชว่ยทําใหแ้ฟ้ม
มขีนาดเล็กลงกวา่แฟ้มทีѷมสีตูรซึѷงไมม่ ี$ กําหนดไวเ้ลย (ขอใหท้ดลองลบเครืѷองหมาย $ ทิѸง
จากสตูรในตารางขนาดใหญเ่พืѷอเปรยีบเทยีบดขูนาดแฟ้ม โดยใชคํ้าสัѷง Replace เครืѷองหมาย $ 
แตไ่มไ่ด ้Replace with ดว้ยเครืѷองหมายใด) 

นอกจากตําแหน่งอา้งองิทีѷตอ้งมเีครืѷองหมาย $ เป็นองคป์ระกอบสําคัญแลว้ ในโครงสรา้งของ
สตูร Smart Formula ยังอาจจําเป็นตอ้งพึѷงสตูร IF, And, Or หรอืสตูรอืѷนๆซึѷงทําหนา้ทีѷตัดสนิใจ 
เพืѷอชว่ยทําใหส้ตูรมเีงืѷอนไขในการคํานวณตา่งไปจากเดมิไดเ้องทันท ีเมืѷอมกีารนําสตูรเดยีวกนั
ไปใชซ้ํѸาทีѷตําแหน่งเซลลอ์ืѷน 

ใน Excel 365 รุน่ลา่สดุมวีธิกีารสรา้งสตูรแบบ Dynamic Array เพิѷมขึѸนใหมโ่ดยจะกระจายสตูร
ทีѷใชตํ้าแหน่งอา้งองิหลายเซลลไ์ปใหเ้องตามขนาดของเซลลท์ีѷใชอ้า้งองิโดยไมต่อ้งใส ่$ และ
ไมต่อ้งกดปุ่ ม Ctrl+Shift+Enter เพืѷอสรา้ง {} ปิดหัวทา้ยสตูรอกีตอ่ไป หากนําแฟ้มทีѷสรา้งจาก
รุน่กอ่นมาเปิดใน Excel 365 จะพบเครืѷองหมาย @ นําหนา้สตูรเพืѷอดงึคา่เพยีงคา่เดยีวมาใชแ้ละ
หยดุการกระจายสตูรออกไป 
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ตวัอยา่ง Smart Formula แบบใชต้ําแหนง่อา้งองิเซลลเ์ดยีว 

ขอใหส้รา้งตารางสตูรคณู ซึѷงนําตัวเลขบนหัวตารางมาคณูกบัตัวเลขดา้นขา้งซา้ยของตาราง 

 

ขั Ѹนตอนการสรา้ง 

1. เริѷมจากเลอืกเซลล ์C3 แลว้พมิพเ์ครืѷองหมายเทา่กบั = ลงไป 
2. จากนัѸนคลกิเซลล ์C2 จะไดส้ตูร =C2 
3. กดปุ่ ม F4 เพืѷอเปลีѷยนสตูรใหเ้ป็น =C$2 
4. พมิพเ์ครืѷองหมายคณู * 
5. จากนัѸนคลกิเลอืกเซลล ์B3 จะไดส้ตูร =C$2*B3 
6. กดปุ่ ม F4 เพืѷอเปลีѷยนสตูรเป็น =C$2*$B3 
7. กดปุ่ ม Enter เพืѷอรับสตูรลงไปในเซลล ์C3 
8. Copy ไปทับตาราง C3:F5 

คําอธบิาย 

 เซลล ์C3 เป็นเซลลท์ีѷมสีตูร Smart Formula ซึѷงโดยทัѷวไปจะเลอืกใหเ้ซลลห์ัวมมุ
ดา้นซา้ยบนของตารางเป็นเซลลท์ีѷมสีตูร Smart Formula 

 คณุอาจเลอืกสรา้งสตูรคณูโดยใชเ้ลข 2 นําหนา้แลว้นําไปคณูกบัเลข 10 เพืѷอทําใหไ้ด ้
สตูร =C$2*$B3 หรอืจะเลอืกใชเ้ลข 10 นําหนา้แลว้นําไปคณูกบัเลข 2 ซึѷงจะทําใหเ้กดิ
สตูร =$B3*C$2 ก็ไดแ้ละทําใหเ้กดิผลลัพธถ์กูตอ้งเทา่กนัทั Ѹงสองแบบ แตข่อแนะนําให ้
สรา้งพฤตกิรรมในการสรา้งสตูรของตนวา่ “ทกุสตูรทีѷสรา้งขึҟนจะนําตาํแหนง่อา้งองิ
ตามแนวนอนขึҟนกอ่นตาํแหนง่อา้งองิตามแนวต ัҟงเสมอ” ซึѷงหลักนีѸจะชว่ยใหค้ณุแกะ
สตูรของตัวเองไดง้า่ยขึѸน และหากสงัเกตสตูรอืѷนๆของ Excel เชน่ Index หรอื Offset 
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จะใชตํ้าแหน่งอา้งองิจากแนวนอน Row ขึѸนกอ่นตําแหน่งอา้งองิจากแนวตั Ѹง Column 
เชน่กนั 

 C$2 ตอ้งมเีครืѷองหมาย $ วางไวห้นา้เลข 2 เนืѷองจากตารางสตูรคณูนีѸม ีRow 2 เป็น
ตําแหน่งอา้งองิทีѷตอ้งควบคมุไวไ้มใ่หเ้ปลีѷยน สว่นตัว C ไมต่อ้งมเีครืѷองหมาย $ นําหนา้ 
เพืѷอปลอ่ยให ้C เปลีѷยนตําแหน่งเป็น Column D E F หรอื Column อืѷนๆตามแตว่า่จะใช ้

สตูรนีѸหรอืไม ่
 $B3 ตอ้งมเีครืѷองหมาย $ วางไวห้นา้ Column B เนืѷองจากตารางสตูรคณูนีѸม ีColumn B 

เป็นตําแหน่งอา้งองิทีѷตอ้งควบคมุไวไ้มใ่หเ้ปลีѷยน สว่นเลข 3 ไมต่อ้งมเีครืѷองหมาย $ 
นําหนา้ เพืѷอปลอ่ยใหเ้ลข 3 เปลีѷยนตําแหน่งเป็น Row 4 5 6 หรอื Row อืѷนๆตามแตว่า่
จะใชส้ตูรนีѸหรอืไม ่

 หลักการใสเ่ครืѷองหมาย $ นีѸ ใหจํ้าไวว้า่ “ถา้ตําแหน่งอา้งองิในสตูรมาจากคา่ตาม
แนวนอน ใหใ้ส ่$ ไวห้นา้ Row (เพราะ แนวนอน = Row) แตถ่า้ตําแหน่งอา้งองิในสตูร
มาจากคา่ตามแนวตั Ѹง ใหใ้ส ่$ ไวห้นา้ Column (เพราะ แนวตัѸง = Column)” 

ตวัอยา่ง Smart Formula แบบใชต้ําแหนง่อา้งองิตามขอบเขตพืҟนทีѷหวั
ตาราง 

ขอใหส้รา้งตารางสตูรคณู ซึѷงนําตัวเลขบนหัวตารางมาคณูกบัตัวเลขดา้นขา้งซา้ยของตาราง 

 

วธิกีารสรา้งคลา้ยกบัวธิแีรก แทนทีѷจะคลกิเลอืกเซลล ์C2 หรอืเซลล ์B3 วธินีีѸใหค้ลกิเลอืกเซลล ์
C2:F2 และ B3:B5 ซึѷงเป็นหัวตารางดา้นบนและดา้นซา้ยทัѸงหมด แลว้กดปุ่ ม F4 เพืѷอทําใหเ้กดิ
สตูร =$C$2:$F$2*$B$3:$B$5 

1. เริѷมจากเลอืกเซลล ์C3 แลว้พมิพเ์ครืѷองหมายเทา่กบั = ลงไป 
2. จากนัѸนคลกิเลอืกเซลลบ์นหัวตารางดา้นบนจากเซลลเ์ลข 2 - 5 จะไดส้ตูร =C2:F2 
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3. กดปุ่ ม F4 เพืѷอเปลีѷยนสตูรใหเ้ป็น =$C$2:$F$2 
4. พมิพเ์ครืѷองหมายคณู * 
5. จากนัѸนคลกิเลอืกเซลลบ์นหัวตารางดา้นซา้ยจากเซลลเ์ลข 10 - 30 จะไดส้ตูร 

=$C$2:$F$2*B3:B5 
6. กดปุ่ ม F4 เพืѷอเปลีѷยนสตูรเป็น =$C$2:$F$2*$B$3:$B$5 
7. กดปุ่ ม Enter เพืѷอรับสตูรลงไปในเซลล ์C3 แลว้ Copy ไปทับตาราง C3:F5 (Excel 365 

จะกระจายสตูรลงไปในเซลล ์C3:F5 ใหเ้อง)  

คําอธบิาย 

 สตูรแบบทีѷอา้งองิกบัตําแหน่งทั Ѹงหมดบนหัวตารางหรอืขา้งตาราง แลว้ใสเ่ครืѷองหมาย $ 
ใหก้บัตําแหน่งทั Ѹง Row และ Column นีѸ ผมตั Ѹงชืѷอเรยีกวา่ สตูรแบบลอ้มร ัҟว โดยทีѷสตูร 
=$C$2:$F$2*$B$3:$B$5 จะทําหนา้ทีѷนําตําแหน่งอา้งองิบนรั Ѹวตามแนวตั Ѹงฉากทีѷตัดกนั
มาคณูกนัทลีะตัวใหเ้อง ทําใหไ้มต่อ้งคอยพะวงวา่จะตอ้งเลอืกใสเ่ครืѷองหมาย $ เพืѷอ
ควบคมุตําแหน่งอา้งองิตามแนวใดเป็นหลัก 

 ถา้เปรยีบเทยีบกบัสตูรคณูวธิแีรกซึѷงใชตํ้าแหน่งอา้งองิแบบเซลลเ์ดยีว จะพบวา่การใช ้

สตูรอา้งองิแบบเซลลเ์ดยีวมคีวามยดืหยุน่มากกวา่ เชน่เมืѷอหัวตารางมขีนาดใหญม่ากขึѸน 
ก็สามารถ Copy สตูรไปใชต้อ่ไดทั้นท ีแตถ่า้สรา้งสตูรแบบลอ้มรั Ѹว จะตอ้งสรา้งสตูรใหม่
เพืѷอกําหนดตําแหน่งอา้งองิในสตูรใหม้ขีนาดขยายตาม (เวน้แตว่า่คณุทราบวธิขียาย
ขอบเขตตําแหน่งอา้งองิ ซึѷงจะนํามาอธบิายตอ่ไปในภายหลัง) 

 จดุออ่นของสตูรแบบลอ้มรั Ѹวก็คอื สตูรแบบนีѸใสเ่ครืѷองหมาย $ ควบคมุตําแหน่งแบบ 
Absolute จงึคํานวณหาคําตอบใหไ้ดเ้ฉพาะตารางจาก C3:F5 ซึѷงอยูภ่ายในขอบเขต
ของรั Ѹวเป็นแนวของตําแหน่งคงทีѷ หาก Copy สตูรไปใชน้อกรั Ѹวจะเกดิ Error ขึѸนตามรปู 
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ตวัอยา่ง Smart Formula แบบใชต้ําแหนง่อา้งองิแบบ Array ตาม
ขอบเขตพืҟนทีѷหวัตาราง 

ขอใหส้รา้งตารางสตูรคณู ซึѷงนําตัวเลขบนหัวตารางมาคณูกบัตัวเลขดา้นขา้งซา้ยของตาราง 

 

ขั Ѹนตอนการสรา้ง 

1. แทนทีѷจะเลอืกเซลล ์C3 เพยีงเซลลเ์ดยีว คราวนีѸใหเ้ลอืกพืѸนทีѷตารางจากเซลล ์C3:F5 
ทั Ѹงหมดพรอ้มกนัไวก้อ่น 

2. จากนัѸนพมิพเ์ครืѷองหมายเทา่กบั = 
3. คลกิเลอืกเซลล ์C2:F2 บนหัวตาราง จะไดส้ตูร =C2:F2 
4. พมิพเ์ครืѷองหมายคณู * 
5. คลกิเลอืกเซลล ์B3:B5 จากขา้งตาราง จะไดส้ตูร =C2:F2*B3:B5 
6. จากนัѸนแทนทีѷจะกดปุ่ ม Enter ใหก้ดปุ่ ม Ctrl+Shift+Enter พรอ้มกนัทเีดยีว 3 ปุ่ ม จะ

ทําใหเ้กดิเครืѷองหมายวงเล็บปีกกาปิดหัวทา้ยสตูรใหเ้องกลายเป็น {=C2:F2*B3:B5} 

คําอธบิาย 

 สาเหตทุีѷตอ้งเลอืกพืѸนทีѷตาราง C3:F5 ไวก้อ่นแทนการเลอืกเซลล ์C3 เพยีงเซลลเ์ดยีว 
เพืѷอทําใหผ้ลลัพธท์ีѷไดจ้ากสตูร Array คนืคา่กระจายคําตอบลงไปในตารางใหค้รบทกุ
ตําแหน่ง (ใน Excel 365 หากสรา้งลงไปใน C3 เซลลเ์ดยีวจะกระจายสตูรใหเ้อง) 

 ลองใช ้Mouse คลกิลงไปในชอ่ง Formula Bar เลอืกเฉพาะสว่นของสตูร C2:F2 แลว้
กดปุ่ ม F9 จะพบวา่ตําแหน่งอา้งองิสว่นนีѸเปลีѷยนเป็น {2,3,4,5} จากนัѸนใหก้ดปุ่ ม Esc 
เพืѷอคนืสภาพสตูรตามเดมิ 
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 ลองใช ้Mouse คลกิลงไปในชอ่ง Formula Bar เลอืกเฉพาะสว่นของสตูร B3:B5 แลว้
กดปุ่ ม F9 จะพบวา่ตําแหน่งอา้งองิสว่นนีѸเปลีѷยนเป็น {10;20;30} จากนัѸนใหก้ดปุ่ ม Esc 
เพืѷอคนืสภาพสตูรตามเดมิ 

 หากกดปุ่ ม F2 ตามดว้ย F9 จะพบวา่สตูร Array เดมิบน Formula Bar {=
C2:F2*B3:B5} จะเปลีѷยนเป็น ={20,30,40,50;40,60,80,100;60,90,120,150} แลว้
ขอใหส้งัเกตวา่มเีครืѷองหมาย Comma และ Semi-Colon ขั Ѹนอยูร่ะหวา่งตัวเลข (ซึѷง
เครืѷองหมาย Comma , นีѸแสดงถงึวา่คา่ถัดไปยังคงอยูใ่น Row เดมิ สว่นเครืѷองหมาย 
Semi-Colon ; แสดงวา่คา่ถัดไปตอ้งขึѸน Row ใหม)่ 

 ดังนัѸน ={20,30,40,50;40,60,80,100;60,90,120,150} จงึแสดงใหเ้ห็นวา่สตูร Array 
นีѸคนืคา่เป็นคําตอบซึѷงมขีนาดความกวา้ง 4 Column และมคีวามสงู 3 Row ตามขนาด
พืѸนทีѷตั Ѹงแต ่C3:F5 ทีѷตอ้งเลอืกไวก้อ่น เพืѷอใหก้ระจายคา่ลงไปใหค้รบนัѷนเอง 

 หากหัวตารางมขีนาดเปลีѷยนไป ตอ้งลบสตูร Array ทีѷสรา้งไวเ้ดมินีѸทิѸงไปกอ่นแลว้จงึ
สรา้งสตูร Array ใหมล่งไป ซึѷงในการลบสตูร Array ทิѸงนีѸ หากตอนทีѷสรา้งสตูรเกดิจาก
การสรา้งพรอ้มกนัทเีดยีวหลายเซลล ์จะเลอืกลบสตูรทิѸงบางเซลลไ์มไ่ด ้ตอ้งเลอืกเซลล ์
C3:F5 ทั Ѹงหมดแลว้จงึสัѷงลบสตูรทิѸงพรอ้มกนัทเีดยีวจงึจะลบได ้

 เนืѷองจากสตูร Array ในตัวอยา่งนีѸเกดิจากการสรา้งพรอ้มกนัทั Ѹงตารางดว้ยสตูรเดยีว จงึ
ทําให ้Excel คํานวณสตูรทั Ѹงตารางสตูรคณูเพยีงครั Ѹงเดยีว ถอืเป็นเคล็ดลับและลัดทีѷ
น่าสนใจเป็นอยา่งยิѷงเพราะถา้สรา้งไดจ้ะทําใหแ้ฟ้มคํานวณเร็วขึѸนอยา่งผดิหผูดิตาทเีดยีว 
(เร็วกวา่ตัวอยา่งสตูรคณูซึѷงสรา้งสตูรลงไปในเซลลเ์ดยีวแลว้ตอ้ง Copy ไป Paste 
เพืѷอใหคํ้านวณซํѸาอกีในเซลลอ์ืѷน) 

 หากตอ้งการคน้หาวา่สตูร Array ทีѷเห็นนัѸนสรา้งขึѸนพรอ้มกนัจากเซลลใ์ดถงึเซลลใ์ด ให ้
เริѷมจากคลกิเลอืกเซลลส์ตูร Array นัѸนๆกอ่นเพยีงเซลลเ์ดยีว แลว้กดปุ่ ม F5 > 
Special > กาชอ่ง Current array 
จะพบวา่ Excel เลอืกพืѸนทีѷตารางสว่นทีѷ
เกดิจากการสรา้งดว้ยสตูร Array พรอ้ม
กนันัѸนใหทั้นท ีจากนัѸนหากตอ้งการลบ
หรอืสรา้งสตูร Array ใหมล่งไปก็ให ้
กระทําตอ่พืѸนทีѷตารางทีѷเลอืกใหแ้ลว้นัѸน
รว่มกนัเสมอ 
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วธิคีน้หาสตูร 

เมืѷอเจอปัญหาในงาน ใหค้อ่ยๆวเิคราะหปั์ญหาทลีะขั Ѹนตอน แบง่ปัญหาแยกออกเป็นขั Ѹนๆ 
ตามลําดับการคํานวณ ตามลําดับการตัดสนิใจ ควรลองสรา้งแนวทางแตล่ะขั Ѹนลงบนกระดาษ
กอ่น เพืѷอจัดลําดับการสง่คา่ไปทลีะขั Ѹนใหถ้กูตอ้ง แลว้ลองใชม้อื ใชเ้ครืѷองคดิเลข คดิคํานวณ
อยา่งครา่วๆกอ่นวา่ จะใชส้ตูรคํานวณอยา่งไร และไดผ้ลลัพธอ์อกมาเป็นเทา่ใด 

ปัญหาทีѷวา่ยาก อาจยากเพราะเราทําใหม้ันยากขึѸนเอง เชน่ คํานวณวา่ ถา้ซืѸอสนิคา้ตน้ทนุ 127 
บาทตอ่หน่วย มาปรับกําไรขึѸนอกี 13.45% จะตอ้งกําหนดราคาขายเทา่ใด 

ปัญหานีѸทําใหง้า่ยลง โดยใชเ้ลขตัวกลมแทนตัวเลขจรงิไปกอ่น ลองคํานวณตน้ทนุ 100 บาท
แทน 127 บาท ลองกําหนดกําไรเป็น 10% แทน 13.45% จะคํานวณไดผ้ลลัพธง์า่ยขึѸนจรงิ
ไหม  

สาเหตทุีѷเราปรับปัญหาใหง้า่ยลงนีѸ เพืѷอใหม้องทีѷลําดับขั Ѹนการคํานวณแทนทีѷจะมัววุน่อยูก่บั
ตัวเลข เมืѷอไดข้ั Ѹนการคํานวณทีѷตอ้งการแลว้ จงึหันมาสรา้งมาคน้หาสตูร Excel ทีѷจะใช ้ภายหลัง
จากสรา้งสตูรเสร็จแลว้ เราจะเปลีѷยนตัวเลขใหย้ากขึѸนเทา่ใดก็ไดทั้ ѸงนัѸน Excel จะคํานวณให ้
เสร็จในพรบิตา 

ขอใหย้ดึหลักวา่ Excel มสีตูรคํานวณสําหรับปัญหาของเราทกุอยา่ง บางปัญหาตอ้งใชส้ตูร
รว่มกบัสตูรอืѷนตอ่ๆกนัไป บางปัญหาตอ้งใชส้ตูรซอ้นสตูร แตบ่างปัญหาใชส้ตูรๆเดยีวก็ได ้
ผลลัพธแ์ลว้ ขั Ѹนตอนการแกปั้ญหาจงึเป็นภาระของมนุษย ์ตอ้งหาสตูรทีѷตอ้งการใชใ้หเ้จอ 

แทนทีѷจะเสยีเงนิซืѸอหนังสอืเรืѷองสตูร ใหเ้ปิดดจูาก Excel Help ซึѷงตดิมากบัโปรแกรม Excel อยู่
แลว้ (หนังสอืเรืѷองสตูรทีѷขายกนั สว่นมากมักลอกคําอธบิายจาก Excel Help ไปใช ้มนีอ้ยเลม่
มากทีѷเขยีนอธบิายดว้ยตัวเอง) 
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วธิที ีѷ 1 คน้หาตามชืѷอสตูร 

เลอืกเซลลว์า่งๆทีѷยังไมม่สีตูรใดๆ แลว้ใชคํ้าสัѷง Formulas > Insert Function หรอืคลกิทีѷปุ่ ม fx 
บน Formula Bar 

ถา้ไมรู่ว้า่สตูรนัѸนๆอยูใ่นกลุม่ไหน ใหค้ลกิ
เลอืก All ในชอ่ง select a category แลว้
คลกิลงไปในชอ่ง Select a function ตรง
สตูรใดก็ได ้แลว้พมิพต์ัวอกัษรนําของสตูร
นัѸนๆลงไป Excel จะเลืѷอนไปหาชืѷอสตูรตาม
ตัวอกัษรทีѷตอ้งการใหทั้นท ีสว่นดา้นลา่งใต ้
จอจะแสดงรปูแบบของสตูร หรอืคลกิทีѷคําวา่ 
Help on this function ดา้นลา่งซา้ยสดุเพืѷอ
เปิดดรูายละเอยีดของสตูร 

วธิที ีѷ 2 คน้หาสตูรทีѷใชง้านทดแทน
กนั 

เมืѷอเปิดสตูรทีѷตอ้งการ แลว้เลืѷอนจอไปดา้นลา่สดุ ใหค้ลกิคําวา่ See Also เพืѷอเปิดรายชืѷอสตูรทีѷ
เกีѷยวขอ้งกนั 
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ควรรอบรูส้ตูรซึѷงมคีวามเกีѷยวขอ้งกนัทั Ѹงหมดกอ่น แลว้จงึตัดสนิใจเลอืกใชส้ตูรซึѷงเหมาะกบั
ปัญหาทีѷสดุ 

วธิที ีѷ 3 คน้หาตวัแปรทีѷใชใ้นสตูร 

ใหเ้ริѷมพมิพ ์= ตามดว้ยชืѷอสตูรทีѷตอ้งการใชง้านกอ่น แลว้กดปุ่ ม Ctrl+a เพืѷอเปิด Help สําหรับ
ชว่ยเลอืกตัวแปรในสตูรใหเ้อง  

 

ไมแ่นะนําใหใ้ช ้Function Screen Tips เพราะคําอธบิายทีѷปรากฏขึѸนจะทับแนวของหัว column 
ทําใหม้องไมว่า่เป็น column ใด โดยตัดกาชอ่ง Show Function ScreenTips จากการสัѷง File 
> Options > Advanced (และควรสัѷง File > Options > Formulas > ตัดกาชอ่ง Formula 
AutoComplete ทิѸงไปดว้ยเพราะ Excel จะพยายามเดาชืѷอสตูรทีѷพมิพล์งไปให)้ 
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วธิที ีѷ 4 คน้หาขอ้จํากดัของสตูร 

เมืѷอเปิดดรูายละเอยีดของสตูรใน Excel Help แลว้ใหด้ขูอ้จํากดัของสตูรไดจ้าก Remarks ซึѷง
อธบิายขอ้แมห้รอืขอ้จํากดัในการใชง้านของสตูรเอาไว ้
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วธิแีกะสตูร 

ลองพจิารณาสตูรคํานวณหาเวลาสิѸนสดุในงาน Material Requirements Planning ตอ่ไปนีѸ 

=INDEX(Begin,COUNTIF(Cum_Hour,"<"&(I10+((INDEX(Cum_Hour,MATCH(VLOOKU
P(J10,Begin,1),Begin,1),1)-INDEX(Working_Hour,MATCH(VLOOKUP(J10,Begin,1) 
,Begin,1),1))+((J10-VLOOKUP(J10,Begin,1))*24))))+1,1)+(((I10+((INDEX( 
Cum_Hour,MATCH(VLOOKUP(J10,Begin,1),Begin,1),1)-INDEX(Working_Hour,MATCH 
(VLOOKUP(J10,Begin,1),Begin,1),1))+((J10 - VLOOKUP(J10, Begin, 1))*24)))-
(INDEX(Cum_Hour,(COUNTIF(Cum_Hour,"<"&(I10+((INDEX (Cum_Hour,MATCH( 
VLOOKUP(J10,Begin,1),Begin,1),1)-INDEX(Working_Hour,MATCH( VLOOKUP(J10, 
Begin,1),Begin,1),1))+((J10-VLOOKUP(J10,Begin,1))*24))))+1),1)-INDEX( 
Working_Hour,(COUNTIF(Cum_Hour,"<"&(I10+((INDEX(Cum_Hour,MATCH(VLOOK
UP(J10,Begin,1),Begin,1),1)-INDEX(Working_Hour,MATCH(VLOOKUP( 
J10,Begin,1),Begin,1),1))+((J10-VLOOKUP(J10,Begin,1))*24))))+1),1)))/24) 

 เริѷมจากสงัเกตเครืѷองหมายเทา่กบั เครืѷองหมายวงเล็บ และเครืѷองหมายลกูนํѸา ซึѷงเป็น
องคป์ระกอบแยกโครงสรา้งของสตูร  

 สงัเกตตัวอกัษรตัวใหญ ่เป็นชืѷอสตูรและตําแหน่งอา้งองิ  
 เมืѷอกดปุ่ ม F2 หรอืคลกิลงไปในสตูรบน formula bar จะพบวา่ Excel เปลีѷยนสแีตล่ะ

สว่นของสตูร พรอ้มกบัมกีรอบสตีรงกนัลอ้มรอบเซลล ์เพืѷอชีѸใหเ้ห็นตําแหน่งของ
เซลลซ์ึѷงถกูนําไปอา้งองิในสตูร  

 ใหค้ลกิลงบนสตูร แลว้ใชแ้ป้นพมิพเ์ลืѷอนลกูศรผา่นเครืѷองหมายวงเล็บ จะพบวา่ 
เครืѷองหมายวงเล็บคูก่นัทั Ѹงดา้นหนา้และดา้นหลัง จะเปลีѷยนเป็นสดํีาเขม้ประมาณ 2 
วนิาท ีเพืѷอบอกวา่เป็นวงเล็บคูเ่ดยีวกนั  

 เมืѷอพบวงสตูรทีѷเป็นวงเล็บชดุเดยีวกนัแลว้ ใหค้ลกิเลอืกสตูรนัѸนในชอ่ง Formula 
Bar แลว้กดปุ่ ม F9 จะเห็นผลลัพธเ์ฉพาะสว่นทีѷเลอืกไว ้แลว้ใหก้ดปุ่ ม Esc เพืѷอ
ยอ้นกลับไปแสดงสตูรตามเดมิ 

 ให ้double คลกิลงไปในเซลลส์ตูร จะพบวา่ Excel ยา้ยตําแหน่งตัวชีѸไปเลอืกเซลล์
ตน้ทางทีѷใชใ้นสตูร ทั ѸงนีѸตอ้งตัดกาชอ่ง Allow editing directly in Cells ในคําสัѷง 
File > Options > Advanced ไวก้อ่น และเมืѷอไปยังเซลลต์น้ทางแลว้หากตอ้งการ
ยา้ยกลับมายังเซลลส์ตูรเดมิ ใหก้ดปุ่ ม F5 แลว้กดปุ่ ม Enter 

 ควรใสว่รรคระหวา่งเครืѷองหมายทีѷใชใ้นสตูร เพืѷอแยกใหห้า่งออกจากกนั จะได ้
สะดวกในการแกะสตูร หากตอ้งการแยกสตูรขึѸนบรรทัดใหมใ่นสตูรเดมิ ใหก้ด 
Alt+Enter  

 หากอยูร่ะหวา่งการแกไ้ขสตูร แตย่ังแกไ้ขไมเ่สร็จ ใหพ้มิพเ์ครืѷองหมายคําพดูใส่
ดา้นหนา้เครืѷองหมายเทา่กบั เพืѷอทําใหส้ตูรกลายเป็นตัวอกัษรไปกอ่น หากไมใ่ชว้ธินีีѸ
ตอ้งคอยระวังอยา่กด Enter เพราะ Excel จะรับสตูรลงไปและเตอืนขอ้ผดิพลาดหรอื
แกไ้ขสตูรตา่งไปจากทีѷตอ้งการ 
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 ควรพมิพ ์Comment กํากบัเซลล ์โดยคลกิขวาลงไปในเซลลท์ีѷตอ้งการ แลว้เลอืก
เมนูยอ่ย Insert Comment เพืѷออธบิายสตูรทีѷใชง้านวา่มคีวามเป็นมาอยา่งไร  

 สตูรซึѷงอยูใ่นวงเล็บในสดุ จะสง่คา่ตอ่มาใหส้ตูรสว่นนอก ดังนัѸนจงึควรแกะสตูรจาก
นอกเขา้ใน เพืѷอเขา้ใจกบัความหมายของสตูรทั Ѹงหมดกอ่น แลว้แกะสตูรจากใน
ออกมาอกีครั Ѹงเพืѷอไลลํ่าดับการคํานวณสง่คา่ในสตูรเซลลห์นึѷงๆ  

 สตูรบางสตูรไมไ่ดอ้ยูใ่นเซลล ์แตเ่ป็น Formula 
Name ใหด้ไูดจ้ากคําสัѷง Formulas > Name 
Manager เพืѷอเขา้ไปดแูละแกไ้ขสตูร  

 ถา้ตอ้งการคน้หาเซลลต์น้ทางหรอืปลายทางทีѷ
เชืѷอมโยงกนัดว้ยสตูร ใหเ้ลอืกเซลลส์ตูรแลว้กดปุ่ ม 
F5 > Special > กาชอ่ง Row Differences หรอื 
Column Differences หรอืเลอืก Precedents / 
Dependents และเลอืก Direct only เพืѷอหาเซลล์
ถัดไป แลว้กดปุ่ ม OK จากนัѸนใหก้ดปุ่ ม F4 ตอ่ไป
เรืѷอยๆเพืѷอสัѷงให ้Excel ทวนคําสัѷงคน้หานีѸซํѸาไป
เรืѷอยๆจนกวา่จะหมดการเชืѷอมโยง 

 ถา้ตอ้งการลากเสน้ลกูศรแสดงความเชืѷอมโยงสง่คา่ระหวา่งสตูร ใหใ้ชเ้มนู 
Formulas > Formula Auditing > Trace Precedents/Dependents 
 

 
 

 แสดงสตูรในเซลลใ์หเ้ห็นแทนการแสดงผลลัพธ ์
ใหใ้ชเ้มนู Formulas > Formula Auditing > 
Show Formulas และใชคู้ก่บัคําสัѷง File > 
Options > Formulas > กาชอ่ง R1C1 
reference style เพืѷอแสดงรปูแบบตําแหน่ง
อา้งองิวา่เป็นแบบเดยีวกนัหรอืไม ่และแกค้นืสู่
สภาพเดมิเมืѷอตรวจสอบสตูรเรยีบรอ้ยแลว้ 
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วธิสีรา้งสตูรซอ้นสตูร 

จดุประสงคข์องการนําสตูรมาซอ้นสตูร เพืѷอทําใหส้ตูรๆเดยีวสามารถคํานวณใหผ้ลลัพธไ์ดเ้ลย
ทันท ีโดยไมต่อ้งพึѷงพาสตูรในเซลลอ์ืѷนๆ ทําใหเ้กดิประโยชนด์ังนีѸ 

• ชว่ยจํากดัเซลลท์ีѷตอ้งใชเ้พืѷอสรา้งสตูร  
• ชว่ยใหค้น้หาเซลลส์ตูรไดง้า่ยเนืѷองจากสตูรถกูนํามารวมกนัไวเ้พยีงทีѷเดยีว  
• หากมจํีานวนเซลลท์ีѷมสีตูรยาวๆจํานวนไมม่ากนัก จะทําให ้file มขีนาดเล็ก

ลง เนืѷองจากไมต่อ้งเปลอืงเซลลห์รอื sheet เพืѷอแยกเก็บสตูร และชว่ยให ้
คํานวณรวดเร็วขึѸน  

สว่นขอ้เสยีของการสรา้งสตูรซอ้นสตูรก็คอื สรา้งยาก และทําใหแ้กไ้ขสตูรในภายหลังยากขึѸน 
จงึตอ้งเปรยีบเทยีบขอ้ดขีอ้เสยีดังกลา่วนีѸเสมอ หากสรา้งเองใชเ้องแกไ้ขเองคงไมต่อ้งหว่งนัก 
แตถ่า้สรา้งสตูรแลว้ทิѸงไวใ้หค้นอืѷนแกไ้ข คงตอ้งลมืกนัไปเลยวา่ จะเริѷมตน้แกไ้ขกนัยังไงด ี
สว่นมากมักสรา้งสตูรขึѸนใหมเ่ลยดกีวา่ 

หลกัการสรา้งสตูรซอ้นสตูร 

1. ควรรวมกลุม่ของสตูรซึѷงคํานวณเป็นลําดับตอ่เนืѷองกนัไวเ้ป็นสตูรเดยีว และแยก
ขั Ѹนตอนซึѷงไมต่อ่เนืѷองออกเป็นอกีสตูรหนึѷง  

2. ควรแยกสตูรออกใหทํ้างานคนืคา่ซึѷงมคีวามหมายสมบรูณ์ในขั ѸนนัѸนๆ และงา่ยตอ่การ
ตรวจสอบวา่ ลําดับการคํานวณขั Ѹนใดผดิพลาด จะไดส้ะดวกตอ่การแกไ้ขใหถ้กูตอ้ง  

3. อยา่รวมทกุขั Ѹนตอนของการคํานวณไวใ้นสตูรๆเดยีวจนยาวเกนิไป  

วธิสีรา้งสตูรซอ้นสตูร 

ใหส้รา้งสตูรซึѷงควรเป็นสตูรวงเล็บในสดุกอ่นสตูรอืѷน สตูรนีѸมักใชคํ้านวณหาคา่พืѸนฐานแรกสดุ 
ซึѷงจะถกูนําไปใชเ้ป็นตัวแปรในสตูรอืѷนถัดไป เชน่ สรา้งสตูรคํานวณหาเลขทีѷบรรทัด ดว้ยสตูร  
=MATCH( MinimumCost, TotalCost, 0)  

จากนัѸนจงึสรา้งสตูรอืѷนครอ่มขา้งนอกเพืѷอนําผลลัพธจ์ากสตูร Match ไปใช ้เชน่ 

=INDEX( LotSize, MATCH( MinimumCost, TotalCost, 0), 1) 

ถา้เป็นสตูรชว่ยการตัดสนิใจ เชน่ สตูร IF ใหพ้จิารณาหาสตูรซึѷงใชต้ัดสนิใจอืѷนๆ มาซอ้นเขา้ไป
ในสตูรเดมิเมืѷอถงึตัวแปรซึѷงตอ้งการใชส้ตูรอืѷนคํานวณคา่ให ้เชน่ ตอ้งการตัดสนิคะแนน 0 - 50 
ใหเ้กรด C ถา้คะแนน 51 - 80 ใหเ้กรด B แตถ่า้เกนิกวา่ 80 ใหเ้กรด A ใหส้รา้งสตูรหาเกรด A 
ใหไ้ดก้อ่น 
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=IF(คะแนน>80,"A","BC")  

แลว้คอ่ยพจิารณาตอ่วา่ จะตัดสนิเกรด B C ตอ่ไปดว้ยสตูร IF อยา่งไร 

=IF(คะแนน>80,"A",IF(คะแนน>50,"B","C"))  

ถา้ไมถ่นัดสรา้งสตูรตอ่กนัซอ้นกนัไปเลยทเีดยีว ใหส้รา้งสตูรแยกแตล่ะขั Ѹนตอนออกไปลงใน
เซลลแ์ยกจากกนักอ่น แลว้จงึ copy ตัวสตูร ไป paste ทับในตําแหน่งอา้งองิ เชน่ 

A1: =NOW() 

A2: =DAY(A1) 

ให ้copy สตูร NOW() จากเซลล ์A1 ไปทับคําวา่ A1 ในเซลล ์A2 จะไดส้ตูรซอ้นกนัเป็น 
=DAY(NOW()) 

วธิ ีcopy สตูร ใหค้ลกิเลอืกสว่นของสตูรทีѷตอ้งการจากสตูรบน Formula Bar เชน่ เลอืกคําวา่ 
NOW() แลว้คลกิขวาเลอืก copy (หรอืกด Ctrl+c) แลว้กด Esc หนึѷงครั Ѹงเพืѷอออกจากการเลอืก 
แลว้จงึไปคลกิเลอืกคําวา่ A1 บน Formula Bar ของสตูรในเซลล ์A2 แลว้คลกิขวาสัѷง paste 
(หรอืกด Ctrl+v) 
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วธิสีรา้งชืѷอซอ้นชืѷอ 

ใชคํ้าสัѷง Formulas > Define Name เพืѷอตั Ѹงชืѷอใหก้บัสตูร หลังจากนัѸนจงึนําชืѷอนัѸนไปซอ้นใน
ชืѷออืѷนตอ่ไปอกี เชน่ สตูรในงานวางแผนการผลติ ซึѷงใชเ้วลาเริѷมงาน และเวลาทีѷใชทํ้างาน 
คํานวณหาเวลาสิѸนสดุงาน ตอ่ไปนีѸ 

Calc1 =VLOOKUP(RelativeStart, Begin, 1)  

Calc2 =INDEX(Working_Hour, MATCH( Calc1, Begin, 1 ), 1 )  

Calc3 =INDEX(Cum_Hour, MATCH( Calc1, Begin, 1 ), 1 )  

Calc4 =Calc3 - Calc2  

Calc5 =RelativeStart - Calc1  

Calc6 =Calc4 + ( Calc5*24 )  

Calc7 =RelativeHour + Calc6  

Calc8 =COUNTIF(Cum_Hour, "<" & Calc7 ) + 1  

Calc9 =INDEX(Working_Hour, Calc8, 1)  

Calc10 =INDEX(Cum_Hour, Calc8, 1)  

Calc11 =Calc10 - Calc9  

Calc12 =(Calc7 - Calc11) / 24  

Calc13 =INDEX(Begin, Calc8, 1)  

Calc14 =Calc13 + Calc12  

วธินํีาชืѷอทีѷตั Ѹงไวม้าใสใ่นสตูร ใหก้ดปุ่ ม F3 เพืѷอเลอืกชืѷอทีѷตั Ѹงไว ้เพืѷอสรา้งสตูรลงไปในเซลลก์อ่น
แลว้จงึ Copy สตูรไปใสต่อ่ในชอ่งสตูรของ Define Name 

เวลาใชง้านก็นําสตูรชืѷอ Calc14 ไปใชเ้ทา่นัѸน ก็จะคํานวณสตูรทั Ѹงหมดตั Ѹงแต ่Calc1 – Calc13 
ใหอ้ตัโนมัต ิ
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เร ืѷองทีѷไมค่อ่ยรูก้นัเกีѷยวกบัสตูร 

โปรแกรม Microsoft Excel รุน่ใหม ่มไิดม้เีสน่หอ์ยูท่ีѷรปูรา่งหนา้ตาบนหนา้จอทีѷประกอบไปดว้ย
แถบรบิบอนแบบใหม(่ทีѷยังไมค่อ่ยคุน้เคย) และมพีืѸนทีѷตารางซึѷงมขีนาดใหญม่ากขึѸนกวา่เดมิ
หลายเทา่เพยีงเทา่นัѸน แตส่าเหตทุีѷทําให ้Excel มเีสน่ห ์กลายเป็นโปรแกรมยอดนยิมมานาน
แสนนาน ก็เพราะมอีงคป์ระกอบสําคัญ นัѷนคอื Excel ตั Ѹงแตรุ่น่แรกๆไดจั้ดเตรยีมสตูรสําเร็จรปูไว ้
มากมายใหนํ้ามาใชก้นั หากสตูรทีѷมอียูย่ังไมส่ามารถใชคํ้านวณหาคําตอบทีѷตอ้งการได ้เราก็
สามารถนําสตูรทีѷมอียูนั่ Ѹนมาใชร้ว่มกนั ซอ้นกนั หรอืผกูสตูรเขา้ดว้ยกนั จนกลา่วไดว้า่เราสามารถ
ใช ้Excel คํานวณหาคําตอบไดก้บัโจทยก์ารคํานวณทกุเรืѷอง ปัญหาใดทีѷคดิวา่ไมส่ามารถใช ้
Excel หาคําตอบ นัѷนเป็นเพราะคนเราตา่งหากทีѷยังคดิไมอ่อก ไมใ่ชว่า่ใช ้Excel หาคําตอบ
ไมไ่ด ้บางปัญหาอาจตอ้งใชเ้วลาคดินับสบิปีกวา่จะทราบวา่ตอ้งเอาสตูรนัѸนมาซอ้นกบัสตูรนีѸแลว้
ก็จะไดคํ้าตอบทีѷตอ้งการออกมานัѷนเอง 

เคล็ดลับทีѷชว่ยใหส้ามารถใชส้ตูรจนชํѷาชอง มใิชว่า่ตอ้งรูจั้กสตูรทกุสตูรทีѷ Excel มอียูห่รอก 
เพราะสตูรทีѷใชง้านกนัประจํานัѸนมไีมม่ากนัก แครู่จั้กการใชส้ตูร Sum, If, And, Or, Choose, 
VLookup, Match, Index, CountIF, SumIF, Offset, Indirect, และ Array Formula ใหเ้ป็น 
และสามารถนําสตูรแคน่ีѸแหละมาใชร้ว่มกนัใหเ้ป็นก็เพยีงพอแลว้ แตก่วา่จะใชส้ตูรใหเ้ป็นยังมี
หลายเรืѷองทีѷตอ้งทําความเขา้ใจกนั หากคดิเพยีงวา่ขอใชส้ตูรเหลา่นีѸเป็นก็พอแลว้ คณุก็จะถงึ
ทางตันในไมช่า้ โดยบทความนีѸจะขอนําเรืѷองทีѷไมค่อ่ยรูก้นัเกีѷยวกบัสตูรมาอธบิาย หลายเรืѷอง
เป็นเรืѷองสําคัญทีѷคดิกนัวา่ไมส่ําคัญ บางเรืѷองก็งา่ยแตค่ดิไมถ่งึวา่เรืѷองงา่ยนัѷนแหละยังมอีะไร
หลายอยา่งซอ่นอยูอ่กี 

ทาํอยา่งไรใหเ้กง่สตูร Excel   

1. ไมจํ่าเป็นตอ้งซืѸอหนังสอืเกีѷยวกบัสตูร เพยีงแคเ่ปิดโปรแกรม Excel แลว้กดปุ่ ม F1 ก็จะ
เปิด Excel Help ขึѸนมาคน้หาสตูรทีѷ Excel มอียูไ่ดแ้ลว้ ถา้คณุตอ้งการซืѸอหนังสอื
เกีѷยวกบัสตูร ขอใหห้าซืѸอหนังสอืทีѷอธบิายเรืѷองสตูรไดล้ะเอยีดกวา่ทีѷมใีน Help (ซึѷงหา
ไดย้ากมาก เพราะคนแตง่หนังสอืมักเขยีนอธบิายตา่งจาก Help ไมม่าก) 

2. ถา้ซืѸอหนังสอื Excel มาแลว้ ขอใหเ้ปิดอา่นตั Ѹงแตห่นา้แรกจนถงึหนา้สดุทา้ยโดยไมต่อ้ง
เปิดคอมพวิเตอร ์เพราะถา้มัวเปิดอา่นไปทําตัวอยา่งไปบนหนา้จอพรอ้มกนั กวา่จะอา่น
หมดเลม่ก็จะใชเ้วลาเกนิปีครึѷง (ซึѷง Excel จะมรีุน่ใหมใ่หพ้วกเราไดใ้ชง้านกนัประมาณ
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ทกุปีครึѷง แลว้คณุจะตอ้งซืѸอหนังสอื Excel รุน่ใหมม่าตั Ѹงตน้อา่นกนัตั Ѹงแตห่นา้แรกกนัใหม่
อกี สดุทา้ยกไ็มส่ามารถรูจั้ก Excel ครบทัѸงหมดสกัท)ี 

3. ถา้ยังไมไ่ดซ้ืѸอหนังสอื ขอใหค้น้หาจาก Google แตต่อ้งเปรยีบเทยีบคําอธบิายจาก
หลายแหลง่ใหด้ ีเพราะยคุนีѸมคํีาแนะนําผดิๆหรอืแนะนําสิѷงทีѷไมค่วรใชเ้ยอะมาก 

4. ขอใหพ้ยายามรอบรูก้อ่นรูล้กึ คณุควรรอบรูไ้วก้อ่นวา่ Excel มสีตูรอะไรบา้ง จากนัѸนเมืѷอ
ถงึเวลาทํางานจงึคอ่ยใชเ้วลารูล้กึเรยีนรูส้ตูรแตล่ะสตูรใหค้ลอ่งในภายหลัง 

5. ตั Ѹงหลักไวเ้ลยวา่ Excel มสีตูรทีѷคณุสามารถนํามาใชก้บังานทกุอยา่งของคณุไดอ้ยูแ่ลว้ 
ถา้ไมม่สีตูรสาํเร็จรปูทีѷคํานวณลัดหาคําตอบไดโ้ดยตรง ใหห้าทางนําสตูรหลายสตูรมาใช ้

งานรว่มกนั 
6. เริѷมแรกทีѷทดลองใชส้ตูร ควรใชก้บัโจทยง์า่ยๆทีѷทราบคําตอบทีѷถกูตอ้งอยูแ่ลว้ จะได ้

เขา้ใจหลักการคํานวณทีѷ Excel ใชว้า่มขีั Ѹนตอนการคดิคํานวณอยา่งไร และเมืѷอได ้
คําตอบตรงกบัทีѷทราบ จะชว่ยทําใหค้ณุเกดิความมัѷนใจ และเกดิความกลา้ทีѷจะนําสตูรไป
ใชใ้นปัญหาอืѷนตอ่ไป ลองคดิดวูา่ =2*3 กบั =123*4.56 สตูรใดทีѷงา่ยกวา่กนั 

7. ถา้สตูรคํานวณไดคํ้าตอบอืѷนตา่งจากทีѷตอ้งการ อยา่คดิวา่ตัวเองสรา้งสตูรผดิ แตค่วร
พยายามคดิคน้หาใหไ้ดว้า่คําตอบทีѷไดนั้Ѹนหมายถงึการคํานวณของอะไร หลายๆครั Ѹง
ทเีดยีวทีѷคณุจะไดส้ตูรลัดและลับแปลกๆทีѷคนอืѷนไมรู่จั้กกนั 

8. อยา่รรีอทีѷจะสรา้งสตูรใหเ้ห็นผลลัพธก์บัตาวา่ถกูหรอืผดิ ถา้คณุเอาแตก่ลัวๆกลา้ๆไมย่อม
สรา้งสตูรสกัทกี็จะไมม่วีันเกง่สตูรไดห้รอก ขอใหส้รา้งสตูรบอ่ยๆ สตูรทีѷผดิหรอืถกู
เหลา่นัѸนจะเป็นบทเรยีนสอนคณุใหเ้กง่กวา่คนอืѷนทีѷไมเ่คยยอมทําผดิ 

9. ถา้ปัญหาการคํานวณซบัซอ้นยากมาก ควรแยกเซลลใ์หใ้ชเ้ซลลห์ลายๆเซลลแ์ยก
คํานวณสตูรแตล่ะขั Ѹน จากนัѸนจงึคอ่ยหาวธินํีาสตูรมาตอ่กนัเป็นสตูรยาวๆสตูรเดยีวใน
เซลลเ์ดยีว 

10. พยายามหาทางแกปั้ญหาสรา้งสตูรดว้ยตัวเองใหไ้ด ้ถา้ทําไดเ้องแลว้คณุจะเกดิความ
ภาคภมูใิจ เกดิความกลา้และอยากลอง ทําใหเ้กง่ขึѸนไปไดเ้อง อยา่ลอกสตูรคนอืѷนมาใช ้
ถา้พยายามอยา่งไรแลว้คดิสตูรไมอ่อก ขอใหค้น้หาคําตอบจาก Google กอ่นทีѷจะเอย่
ปากถามใคร 

หวังวา่คําแนะนํา 10 ขอ้นีѸจะเป็นแนวทางชว่ยใหค้ณุกลายเป็นคนเกง่สตูร Excel และขอฝากคน
ทีѷชอบใชส้ตูรรุน่ใหมท่ีѷเพิѷงเกดิขึѸนวา่ อยา่เพิѷงรบีรอ้นนําสตูรใหม่ๆ เหลา่นัѸนมาใช ้เพราะตราบใดทีѷ
เพืѷอนของคณุยังคงใช ้Excel รุน่เกา่กวา่อยู ่เขาจะไมส่ามารถนําแฟ้มของคณุทีѷสรา้งไวโ้ดยใช ้

สตูรรุน่ใหมม่าคํานวณไดเ้ลย คณุนัѷนแหละทีѷจะตอ้งรับภาระยอ้นกลับไปแกไ้ขสตูรรุน่ใหมใ่หเ้ป็น
รุน่เกา่เพืѷอเปิดแฟ้มใน Excel รุน่เกา่ทีѷคนอืѷนเขายังไมเ่ลกิใชก้นั 
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Formula vs Function 

ทั ѸงสองคํานีѸถา้แปลเป็นไทยก็แปลวา่ “สตูร” เหมอืนกนั โดยคําวา่ Formula เป็นคําทีѷมี
ความหมายกวา้งกวา่ Function กลา่วคอื  

 Formula หมายถงึ สตูรทกุอยา่งทีѷมเีครืѷองหมายเทา่กบั = นําหนา้ เชน่ =A1 หรอื 
=1+2 หรอื =Now() 

 Function หมายถงึ สตูรสําเร็จรปูทีѷตดิมากบัโปรแกรม Excel เชน่ สตูร Sum, Max, 
Min, If, VLookup หรอื Now เป็นตน้ 

ดังนัѸนเพืѷอทําความเขา้ใจใหต้รงกนั ในบทความนีѸจะใชคํ้าวา่ สตูร ซึѷงหมายถงึทั Ѹง Formula และ 
Function หรอือกีนัยหนึѷง สตูรก็คอือะไรก็ตามทีѷมเีครืѷองหมาย = นําหนา้ สว่นตัวผมเองจะเขยีน
อธบิายเรืѷองสตูรในกระดาษโดยใชต้ัวใหญป่นตัวเล็ก เชน่ Sum หรอื VLookup เพืѷอชว่ยใหอ้า่น
แตล่ะคําของสตูรไดง้า่ย แตเ่มืѷอถงึคราวนําไปใชใ้น Excel โปรดพมิพส์ตูรดว้ยตัวเล็กทั Ѹงหมด
เสมอ 

Text vs Number 

คา่ทีѷพมิพบ์ันทกึลงไปในเซลลห์รอืผลจากการคํานวณมอียูเ่พยีง 3 อยา่งคอื คา่ทีѷถอืเป็นText 
คา่ทีѷถอืเป็น Number และคา่ทีѷ error ไมส่ามารถนําไปใชคํ้านวณตอ่ได ้

 Text คอื คา่ทีѷพมิพล์งไปในเซลลห์รอืเกดิจากสตูรคํานวณแลว้จะชดิซา้ยของเซลล์
ทันท ี(โดยไมต่อ้งกาํหนด Format) เชน่ พมิพคํ์าวา่ abc หรอื กขค หรอืแมแ้ตต่ัวเลขทีѷ
พมิพต์อ่ทา้ยเครืѷองหมายฝนทอง เชน่ ‘123 หรอืผา่นการกําหนด Format Number ให ้
ถอืเป็นแบบ Text ซึѷงโดยทัѷวไปหากเซลลด์า้นขวายังวา่งอยู ่จะพบวา่ถา้เซลลม์ ีText ทีѷ
ยาวกวา่ความกวา้งของเซลล ์จะยอมให ้Text นัѸนแสดงตอ่ไปในเซลลด์า้นขวา 

 Number คอื คา่ทีѷพมิพล์งไปในเซลลห์รอืเกดิจากสตูรคํานวณแลว้จะชดิขวาของเซลล์
ทันท ี(โดยไมต่อ้งกําหนด Format) เชน่ พมิพต์ัวเลข 123 หรอืพมิพว์ันทีѷ 14/2/2009 
ซึѷงโดยทัѷวไปถา้เซลลม์คีวามกวา้งไมพ่อทีѷจะแสดงตัวเลขทัѸงหมด Excel จะแสดงดว้ย
เครืѷองหมาย ####### ซํѸาจนเต็มเซลล ์(แกไ้ดโ้ดยคลกิขวาลงไปในเซลลแ์ลว้สัѷง 
Format Cells > Alignment > กาชอ่ง Shrink to fit เพืѷอสัѷงให ้Excel ยอ่ขนาด
ของ Font ใหม้ขีนาดพอดทีีѷจะแสดงไดเ้ต็มความกวา้งของเซลล)์ 

 Error เป็นผลทีѷเกดิจากการคํานวณทีѷไมส่ามารถนําไปคํานวณตอ่ได ้เชน่  
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o #N/A เมืѷอสตูรหาขอ้มลูทีѷตอ้งการไมพ่บ (Not Available) 
o #NAME? เมืѷอสตูรหาชืѷอทีѷตอ้งการไมพ่บ เชน่ =answer โดยทีѷในแฟ้มนัѸน

ไมไ่ดต้ั Ѹงชืѷอ Range Name วา่ answer ไวก้อ่น 
o #NULL! เมืѷอสตูรหาตําแหน่งทีѷตัดกนัไมไ่ด ้เชน่ =A:A B:B 
o #NUM! เมืѷอสตูรใชต้ัวเลขทีѷเป็นไปไมไ่ดใ้นการคํานวณ เชน่ =Sqrt(-1) 
o #REF! เมืѷอตําแหน่งเซลลท์ีѷเคยอา้งไวใ้นสตูรถกู delete ทิѸงไป 
o #VALUE! เมืѷอสตูรไมส่ามารถคํานวณได ้เชน่ นําตัวเลขคณูตัวอกัษร =123*a 
o #SPILL! เมืѷอสตูรทีѷจะกระจายตัวถกูเซลลท์ีѷใชง้านอืѷนมาขวางไว ้

หลักการใช ้Excel ทีѷด ีคอื คา่ใดๆทีѷเกีѷยวขอ้งกบัตัวเลข ก็ขอใหเ้ป็นตัวเลขทีѷชดิขวา
ของเซลลเ์สมอ ไมค่วรใชต้ัวเลขทีѷชดิซา้ยของเซลล ์

ขนาดแฟ้ม vs ประเภทขอ้มลู 

ขนาดของแฟ้มขึѸนกบัประเภทของขอ้มลู โดยเรยีงลําดับขนาดแฟ้มจากเล็กไปใหญไ่ดต้ามนีѸ 

1. แฟ้มทีѷเก็บขอ้มลูเป็น Number เชน่ 1, 111, 123 
2. แฟ้มทีѷเก็บขอ้มลูเป็น Text เชน่ a, aaa, abc 
3. แฟ้มทีѷเก็บขอ้มลูเป็นสตูรทีѷคนืคา่เป็น Number เชน่ =1, =111, =123 
4. แฟ้มทีѷเก็บขอ้มลูเป็นสตูรทีѷคนืคา่เป็น Text เชน่ =”a”, =”aaa”, =”abc” 

ทีѷแปลกก็คอื ขนาดของแฟ้ม ไมข่ึѸนกบัความยาวของคา่ในเซลล ์เชน่ ถา้เซลลม์คีา่ทีѷบันทกึไว ้
เป็น 1 หรอืเพิѷมความยาวตัวเลขเป็น 111 หรอื 123 ก็จะมขีนาดแฟ้มเทา่กนักบั 1 ตัวเดยีว หรอื
ถา้สรา้งเป็นสตูร =1 หรอืเพิѷมความยาวตัวเลขเป็น =111 หรอื =123 จะมขีนาดแฟ้มเทา่กนักบั 
=1 

ดังนัѸนถา้ตอ้งการลดขนาดแฟ้มใหเ้ล็กทีѷสดุ แทนทีѷจะพมิพเ์ลข 1 แลว้สรา้งสตูรบวกเลขตอ่กนัไป
ทลีะเซลลใ์หก้ลายเป็นลําดับตัวเลข 1, 2, 3, 4, 5 ก็ควรพมิพเ์ลขลงไปในเซลลโ์ดยตรงแทน
การสรา้งสตูร และสตูรใดๆทีѷคํานวณเสร็จเรยีบรอ้ยไปแลว้และไมม่กีารเปลีѷยนแปลงคําตอบตา่ง
จากเดมิอกีแลว้ เราก็ควร Copy แลว้ Paste Special ใหก้ลายเป็น Value จะทําใหแ้ฟ้มเล็กลง
ไปมากทเีดยีว 

สว่นเซลลส์ตูรทีѷเกดิ Error ขึѸนก็ควรใชส้ตูร IF ปรบั Error ใหเ้ปลีѷยนเป็นคา่อืѷนแทน ดังนีѸ 
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 ในกรณีทีѷ A1 คนืคา่เป็น Number ใหใ้ช ้=IF( IsError(A1), 0, A1)  
 ในกรณีทีѷ A1 คนืคา่เป็น Text ใหใ้ช ้=IF( IsError(A1), “คําเตอืนใดๆก็ได”้, A1)  

ซึѷงตัวผมเอง นยิมใชส้ตูร =IF( IsError(A1), 0, A1) ทั Ѹงในกรณีทีѷเดมิคนืคา่เป็น Number หรอื 
Text ก็ตาม เพราะสามารถใช ้Format ปรับการแสดงเลข 0 ใหแ้สดงเป็นคา่อืѷนหรอืแมแ้ตทํ่าให ้
ดเูหมอืนกลายเป็นเซลลว์า่งไดต้อ่ไป 

สตูร =IFERROR(A1,0) แมส้ั Ѹนกวา่แตไ่มเ่ปิดใหก้รณีทีѷไม ่error ใหเ้ปลีѷยนเป็นคา่อืѷน 

ตาํแหนง่เซลลท์ีѷเลอืกสําหรบัสรา้งสตูร 

เห็นหัวขอ้นีѸแลว้คงสงสยักนัวา่ตําแหน่งเซลลท์ีѷเลอืกสรา้งสตูรลงไปนัѸนเป็นประเด็นทีѷตอ้งใสใ่จ
กนัดว้ยหรอื ถา้คดิกนังา่ยๆวา่ “ในเมืѷอฉันตอ้งการจะสรา้งสตูรลงไปตรงนีѸก็ตอ้งตามใจฉัน ฉันจะ
สรา้งสตูรลงไปตรงนีѸเสยีอยา่ง ใครจะทําไม” ก็แสดงวา่คณุมองขา้มอะไรทีѷเป็นเรืѷองสําคัญอยา่ง
หนึѷงไปแลว้ 

ตําแหน่งเซลลท์ีѷคณุสรา้งสตูรหาคําตอบลงไป สามารถชีѸเป็นชีѸตายใหก้บังานของคณุทเีดยีว 
เพราะถา้อยูม่าวันหนึѷง เมืѷอยา้ยเซลลส์ตูรไปทีѷตําแหน่งอืѷน สตูรทีѷเคยคํานวณหาคําตอบไดต้ลอด
มา อาจคนืคา่เป็นคําตอบทีѷผดิหรอืแสดงผลลัพธแ์ตกตา่งไปจากเดมิก็ได ้

วธิทีดสอบสตูรทีѷคณุหรอืใครสรา้งขึѸนวา่เป็นสตูรทีѷใชไ้ดห้รอืไม ่ใหท้ดลองยา้ยเซลลส์ตูรไปทีѷอืѷน 
ยา้ยไปเรืѷอยๆหลายๆตําแหน่ง พรอ้มกนันัѸนทดลองยา้ยตารางขอ้มลูทีѷใชอ้า้งองิไปทีѷอืѷนดว้ย ลอง 
Insert Row หรอื Column แทรกตารางขอ้มลูเขา้ไปอกี ถา้สตูรนัѸนยังคงหาคําตอบได ้
เหมอืนเดมิ แสดงวา่สตูรนัѸนใชง้านได ้

ทราบไหมวา่ถา้ตารางขอ้มลูทีѷเก็บคา่อยูใ่นตารางชว่ง B2:D5 คณุควรสรา้งสตูรคํานวณซึѷง
เกีѷยวขอ้งกบัการใชข้อ้มลูในตารางนีѸไวท้ีѷเซลลใ์ด ซึѷงจะรับประกนัวา่สตูรทีѷสรา้งขึѸนจะสามารถ
นําไปใชง้านตอ่ไดท้กุทีѷ 

คําตอบก็คอื หา้มสรา้งสตูรในแนวเดยีวกบัตารางขอ้มลู นัѷนคอื อยา่สรา้งสตูรในชว่ง Column B 
ถงึ D และชว่ง Row 2 ถงึ 5 

สาเหตทุีѷหา้ม เพราะการสรา้งสตูรใดๆทีѷมตํีาแหน่งอา้งองิไปยังคา่ในแนวเดยีวกบัตารางขอ้มลู 
อาจคนืคา่เป็นคําตอบเป็นคา่ในตารางตามแนวเดยีวกนัก็ได ้
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หากสรา้งสตูรในเซลลซ์ึѷงไมไ่ดอ้ยูใ่นแนวเดยีวกบัชว่ง Column B ถงึ D และชว่ง Row 2 ถงึ 5 
แลว้คณุหาทางปรับสตูรนัѸนใหคํ้านวณหาคําตอบทีѷตอ้งการ ยอ่มรับประกนัไดว้า่ สตูรนัѸนเป็นสตูร
ทีѷใชง้านไดจ้รงิและจะยังคงคนืคา่เป็นคําตอบเดมิไปตลอด ไมว่า่จะยา้ยเซลลส์ตูรไปทีѷตําแหน่ง
อืѷนก็ตาม 

พอพบวา่สตูรทํางานไดจ้รงิแลว้ จากนัѸนจะยา้ยเซลลส์ตูรไปวางไวใ้นแนวคูข่นานกบัตารางขอ้มลู
ทีѷใชใ้นการคํานวณก็ไมว่า่กนั 

สตูรก็มจีงัหวะหายใจดว้ยนะ   

ผูท้ีѷใช ้Excel เป็นประจําตอ้งรูจั้กสตูรตอ่ไปนีѸเป็นอยา่งด ี=IF(C2=0, 0, B2/C2) 

สตูรขา้งตน้นีѸคอืสตูรทีѷใชส้ําหรับปรับสตูรทีѷนําตัวเลขมาหารกนัไมใ่หแ้สดงคําเตอืน Error วา่ 
#DIV/0! ขึѸนมา  

เมืѷอเซลล ์C2 ซึѷงเป็นเลขตัวหารมคีา่เป็น 0 ใหค้นืคา่ 0 เป็นตัวเลขคําตอบแทน แตถ่า้เซลล ์C2 
ไมไ่ดเ้ป็นเลข 0 ก็ยอ่มนํา C2 มาหาร B2 ไดต้ามปกต ิผูท้ีѷสรา้งสตูรหารกนัจะหลกีเลีѷยงสตูร
ดังกลา่วนีѸไมไ่ด ้

ขอถามวา่ เวลาทีѷคณุสรา้งสตูร คณุมพีฤตกิรรมในการสรา้งสตูรกนัอยา่งไร คณุจะพมิพล์งไปใน
เซลลว์า่ =if(c2=0,0,b2/c2) รวดเดยีวใหค้รบทัѸงหมดแลว้จงึกดปุ่ ม Enter หรอืไม ่หรอืจะคอ่ยๆ
พมิพ ์=if แลว้หยดุหายใจพักหนึѷงแลว้จงึพมิพ ์c2=0 ตอ่ แลว้ก็หยดุพักหายใจอกีเฮอืกหนึѷงจงึ
คอ่ยๆพมิพส์ว่นทีѷเหลอืตอ่ 

ขอ้ผดิพลาดทีѷพบบอ่ยในการสรา้งสตูรของคนทีѷเพิѷงเรยีนรูก้ารใช ้Excel ก็คอื มักหลงลมื
เครืѷองหมายวงเล็บ พมิพเ์ครืѷองหมาย Comma ขาดไป บางครัѸงพมิพส์ลับทีѷ บางครั Ѹงพมิพข์าด 
บางครั Ѹงพมิพเ์กนิ ทําใหเ้มืѷอกดปุ่ ม Enter ลงไปแลว้ Excel ตอ้งเตอืนขึѸนมาบนจอใหค้ณุทราบวา่
สตูรทีѷสรา้งนัѸนผดิ 

ผูส้รา้งสตูรตอ้งมสีมาธพิอตัว สมาธทิีѷวา่นีѸเกดิจากการรูจั้กวา่เมืѷอใดจะหยดุเมืѷอใดจะสรา้งตอ่ ถา้รู ้
หลักจังหวะหายใจจะชว่ยใหค้ณุสรา้งสตูรไดง้า่ยขึѸน ไมว่า่สตูรสั Ѹนๆหรอืสตูรยากๆยาวๆก็ใชห้ลัก
จังหวะหายใจนีѸกนัทั ѸงนัѸน 
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จังหวะหายใจทีѷวา่นีѸ ไมใ่ชจั่งหวะหายใจของ Excel หรอกนะ Excel มันไมไ่ดม้กีารหายใจ
เหมอืนกบัมนุษย ์แตเ่ป็นจังหวะหายใจของคณุนัѷนแหละ ตอ้งรูว้า่เมืѷอใดทีѷควรจะหยดุแลว้หายใจ
สกัเฮอืกหนึѷงแลว้จงึสรา้งสตูรตอ่ ซึѷงเรืѷองการหายใจนีѸไมต่อ้งลอกจังหวะการหายใจใหเ้หมอืนกบั
ผมก็ได ้ตัวใครตัวมัน ขอใหเ้ลอืกจังหวะหายใจทีѷตัวเองคดิวา่ถนัดก็แลว้กนั 

ขอยกสตูรทั Ѹงหมดมาดกูนัอกีครั Ѹง  

=IF(C2=0, 0, B2/C2)  

มาดกูนัวา่ถา้เป็นวธิขีองผม จะสรา้งสตูรนีѸโดยหยดุพักเพืѷอหายใจกนัตรงไหนบา้ง เอา้หายใจเขา้
แลว้นะ จากนัѸนเริѷมสรา้งสตูรโดยใชว้ธิตีามลําดับตอ่ไปนีѸ 

1. พมิพเ์ครืѷองหมายเทา่กบั 
2. พมิพคํ์าวา่ if( 
3. หยดุเพืѷอหายใจ จากนัѸนสรา้งสตูรตอ่ดว้ยขั Ѹนตอ่ไป 
4. หยบิเมาสค์ลกิเซลล ์C2 
5. แลว้พมิพ ์=0, ตอ่ 
6. หยดุเพืѷอหายใจ 
7. ในใจอา่นสตูรทีѷไดต้ามนีѸ =if(C2=0, วา่ถา้เซลลต์ัวหารมคีา่เทา่กบั 0 ละ่กอ้ 
8. พมิพ ์0, ตอ่ 
9. หยดุเพืѷอหายใจ 
10. ในใจอา่นสตูรทีѷพมิพ ์0, วา่ ใหคํ้าตอบทีѷไดเ้ป็น 0 แทนนะ จากนัѸน 
11. หยบิเมาสค์ลกิเซลล ์B2 
12. พมิพเ์ครืѷองหมายหาร / 
13. แลว้หยบิเมาสค์ลกิเซลล ์C2 
14. หยดุเพืѷอหายใจ 
15. ในใจอา่นสตูร B2/C2 ทีѷไดม้าวา่ แตถ่า้ตัวหารไมใ่ชเ่ลข 0 ใหคํ้าตอบทีѷไดเ้ป็นสตูรหาร

กนัตามปกต ิ
16. จากนัѸนจงึกดปุ่ ม Enter รับสตูรลงไปในเซลล ์โดยไมต่อ้งพมิพเ์ครืѷองหมายวงเล็บปิด 

เพราะถา้มวีงเล็บเปิดตัวเดยีว Excel จะพมิพเ์ครืѷองหมายวงเล็บปิดใหเ้อง 

จับหลักไดไ้หมเอย่ ขอใหส้งัเกตวา่ใหห้ยดุเพืѷอหายใจไดห้ลังจากพมิพจ์บตรงเครืѷองหมายนัѸนๆ
ไง ถา้ใชเ้ครืѷองหมายจดุจดุแทนชว่งหยดุเพืѷอหายใจ จะไดส้ตูรตามแบบนีѸ  
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=if(.........C2=0,.........0,......... B2/C2 

ฝึกหยดุเพืѷอพักหายใจใหไ้ดจั้งหวะ วธินีีѸจะชว่ยลดขอ้ผดิพลาดหลงลมืการใสเ่ครืѷองหมายวงเล็บ
หรอืเครืѷองหมาย Comma ในการสรา้งสตูรไปไดเ้ยอะทเีดยีว 

ธรรมชาตขิองสตูร   

ถา้เขา้ใจธรรมชาตติอ่ไปนีѸของสตูร จะทําใหเ้ราใชส้ตูร Excel ไดง้า่ยโดยไมต่อ้งทอ่งจําและลด
ขอ้ผดิพลาดเมืѷอนําสตูรมาใช ้

1. ชืѷอสตูรเป็นตัวอกัษรภาษาองักฤษตัวใหญ ่เชน่ IF, MAX, MIN ดังนัѸนเวลาพมิพส์ตูรใหพ้มิพ์
ตัวเล็ก พอกดปุ่ ม Enter แลว้จะพบวา่ ถา้เราสะกดชืѷอสตูรถกูตอ้ง Excel จะเปลีѷยนตัวอกัษร
จากตัวเล็กไปเป็นตัวใหญทั่Ѹงหมดใหทั้นท ี

2. เราสามารถพมิพส์ตูรโดยถา้ในสตูรมเีครืѷองหมายวงเล็บเปิดเพยีงวงเล็บเดยีว พอกดปุ่ ม 
Enter จะพบวา่ Excel พมิพเ์ครืѷองหมายวงเล็บปิดใหเ้อง แตถ่า้มวีงเล็บเปิดหลายตัว เราตอ้ง
ใสเ่ครืѷองหมายปิดวงเล็บใหค้รบทกุคู ่เพราะถา้กดปุ่ ม Enter ลงไป Excel จะพยายามคดิใส่

เครืѷองหมายวงเล็บปิดใหค้รบแตอ่าจใสว่งเล็บปิดผดิคูใ่หก้็ได ้
3. วงเล็บในสตูรตอ้งใสใ่หค้รบคูแ่ละถกูตําแหน่ง มวีงเล็บเกนิดกีวา่ขาดวงเล็บ 
4. ถา้ไมใ่สว่งเล็บ Excel จะไลคํ่านวณตามลําดับดังนีѸ ยกกําลังกอ่นแลว้ตามดว้ยคณูหรอืหาร

แลว้ตามดว้ยบวกหรอืลบ (คณูหาร หรอืบวกลบ มศีักดิѻศรเีทา่กนั จะไลคํ่านวณจากซา้ยไป
ขวาแลว้แตว่า่เครืѷองหมายใดมกีอ่น) ดตูัวอยา่งทา้ยขอ้ 7 

5. โครงสรา้งสตูร Excel ถกูสรา้งขึѸนมาเลยีนแบบลําดับความคดิของมนุษย ์ดังนัѸนถา้เราเขา้ใจ
ตัวเองวา่เรามองเราคดิทลีะขั Ѹนอยา่งไร เราก็จะสรา้งสตูรไดง้า่ยโดยไมต่อ้งทอ่ง เชน่ เวลา
เราคดิเรืѷองเงืѷอนไขวา่ ถา้ทําด ีตอ้งไดด้ ีแตถ่า้ไมทํ่าด ีตอ้งไดเ้รืѷองอืѷนๆ ตัวสตูร IF ของ 
Excel ก็จะมลํีาดับในโครงสรา้งสตูรตามแบบทีѷเราคดิออกมาเป็น =IF(ทําดใีชไ่หม, ไดด้,ี 
ไดอ้ืѷนๆ) ขอใหอ้า่นรายละเอยีดประเด็นนีѸจากบทความเรืѷอง เมืѷอสตูร Excel มชีวีติจติใจ หรอื
จากลงิค ์www.excelexperttraining.com/blogs/archives/z300-ExcelCore000706.php 

6. ในโครงสรา้งสตูร ถา้มกีารอา้งองิกบัตําแหน่งเซลลต์ามแนวนอนและแนวตั Ѹง จะตอ้งใส่

ตําแหน่งอา้งองิตามแนวนอนไวก้อ่นแนวตั Ѹงเสมอ ดไูดจ้ากสตูร Index หรอืสตูร Offset 
(ดังนัѸนเราควรสรา้งสตูรคํานวณบวกลบคณูหารอืѷนๆใหใ้ชตํ้าแหน่งอา้งองิตามแนวนอนกอ่น
แนวตั Ѹงดว้ยเชน่กนั เพืѷอเป็นแบบแผนชว่ยใหเ้ขา้ใจทีѷไปทีѷมาและแกะสตูรไดง้า่ย) 
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7. ถา้ในโครงสรา้งสตูรประเภทฐานขอ้มลู มตีัวแปร (Option) ทีѷอาจใสห่รอืไมใ่สก่็ได ้เชน่สตูร 
VLookup หรอืสตูร Match ขอใหย้ดึหลักวา่ 
7.1. ถา้ไมใ่ส ่Option หรอืละไว ้หรอืใสต่ัวเลข 1 นัѸน สตูรนีѸจะใชก้บัตารางขอ้มลู ทีѷเรยีงคา่

จากนอ้ยไปมาก (จําไวว้า่เรยีงตามธรรมชาตติอ้งเรยีงจากนอ้ยไปมากเสมอ) 
7.2. ถา้ใส ่Option เป็น False หรอืใสต่ัวเลข 0 สตูรนีѸจะใชก้บัตารางขอ้มลูทีѷไมเ่รยีงลําดับ 

(จําไวว้า่ 0 แปลวา่ไม ่หมายถงึไมต่อ้งเรยีงลําดับ) 
7.3. ถา้ใส ่Option เป็นตัวเลข -1 นัѸน สตูรนีѸจะใชก้บัตารางขอ้มลู ทีѷเรยีงคา่จากมากไปนอ้ย 

(จําไวว้า่เรยีงผดิธรรมชาตติอ้งเรยีงจากมากไปนอ้ย) 

ตวัอยา่งลําดบัการคาํนวณตามเครืѷองหมายบวกลบคณูหาร 

ถา้สรา้งสตูร =1+2-3*4/5^6 ลงไปในเซลล ์Excel จะคํานวณตามหลักการดังนีѸ 

1. คํานวณเครืѷองหมายยกกําลัง ^ กอ่น นัѷนคอืจะคํานวณ 5^6 
2. ตามดว้ยการคํานวณคณูหรอืหาร แลว้แตว่า่เครืѷองหมายใดมากอ่นจากซา้ยไปขวา นัѷนคอื

จะคํานวณ 3*4 แลว้จงึนําผลคณูทีѷไดไ้ปหารดว้ยคําตอบทีѷไดจ้าก 5^6 
3. ตามดว้ยการคํานวณบวกหรอืลบ แลว้แตว่า่เครืѷองหมายใดมากอ่นจากซา้ยไปขวา นัѷนคอื

จะคํานวณ 1+2 แลว้จงึนําผลบวกทีѷไดไ้ปลบกบัผลลัพธท์ีѷไดจ้าก 3*4/5^6 

จะสรา้งสตูรใหวุ้น่กนัไปไดแ้คไ่หน   

สตูรสําเร็จรปูของ Excel 2003 ทีѷเราใชก้นัจนชนิ (จนไมอ่ยากเปลีѷยนมาใช ้Excel 2007 หรอื 
Excel รุน่ทีѷใหมก่วา่) มขีอ้กําหนดในตัวสตูรวา่ ในวงเล็บของสตูรสําเร็จรปูหนึѷงๆนัѸน สามารถซอ้น
สตูรเขา้ไปไดอ้กี 7 สตูร และในวงเล็บของบางสตูรจะถกูแบง่ Argument หรอืตัวแปรทีѷคัѷนดว้ย
เครืѷองหมาย comma แบง่ไดส้งูสดุ 30 Arguments (หรอือกีนัยหนึѷงใส ่Comma ไดส้งูสดุ 29 
ตัวเพืѷอแบง่สว่นในวงเล็บออกเป็น 30 สว่น) และสตูรทีѷยาวทีѷสดุทีѷสามารถพมิพล์งไปในเซลล์
หนึѷงๆไดนั้Ѹน ยาวไดส้งูสดุ 1,024 ตัวอกัษร 

ขอ้กําหนดเหลา่นีѸนับวา่เพยีงพอกบัการคํานวณทัѷวไป นานๆทจีงึมโีจทยท์ีѷตอ้งใชจ้นเกนิกวา่
ขดีจํากดั ซึѷงแกไ้ขไดง้า่ยๆโดยแยกการคํานวณเป็นสว่นๆ แลว้แบง่แตล่ะเซลลใ์หแ้ยกคํานวณ
แตล่ะสว่นของสตูร จากนัѸนจงึนําผลการคํานวณทีѷไดม้าคํานวณรว่มกนัตอ่เป็นขั Ѹนๆ หรอืไมก่็ตอ้ง
ฉลาดเลอืกใชส้ตูรอืѷนทีѷคํานวณไดคํ้าตอบแบบเดยีวกนัแทน  



34 

 

© พ.ศ.2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ
www.ExcelExpertTraining.com 

สําหรับสตูรสาํเร็จรปูใน Excel รุน่ 2007 เป็นตน้มา ปรับขอ้กําหนดดังกลา่วเป็นดังนีѸ 

1. ในวงเล็บของสตูรสําเร็จรปู สามารถซอ้นสตูรเขา้ไปไดอ้กี 64 สตูร (Nested levels of 
functions) 

2. ในวงเล็บของสตูรสําเร็จรปู สามารถแบง่ออกเป็น 255 arguments (Arguments in 
Functions) 

3. ในเซลลห์นึѷงๆรับสตูรไดย้าวทีѷสดุ 8,192 characters (Length of formula contents) 

ขอ้กําหนดเหลา่นีѸเปิดกวา้งใหเ้ราสรา้งสตูรไดส้บายขึѸน ซึѷงขอแนะนําวา่อยา่ใชค้วามสบายจนเกนิ
ตัว เพราะตัวคณุนัѷนแหละทีѷจะถกูลงโทษหากสรา้งสตูรแบบสบายเกนิไป เพราะหากตอ้ง
ยอ้นกลับมาแกะสตูรเพืѷอแกไ้ขอกีในภายหลัง มันไมใ่ชง่านทีѷงา่ยเลยทีѷจะแกะสตูรซอ้นกนัหลาย
สบิชั Ѹน 

พงึระลกึไวเ้สมอวา่ สตูรทีѷคณุสรา้งตั Ѹงแตแ่รกนัѸน ตอ้งเป็นสตูรทีѷใชง้านไดต้ลอดไปโดยไมต่อ้ง
ยอ้นกลับมาแกไ้ขสตูรอกี แตถ่า้จําเป็นตอ้งแกไ้ขสตูร ก็ตอ้งแกไ้ขไดง้า่ย ไมว่า่คณุหรอืเพืѷอน
ของคณุก็ตอ้งแกะสตูรไดง้า่ย 

ดังนัѸนการทีѷ Microsoft ปรับขอ้จํากดัของสตูรใหย้ดืหยุน่มากขึѸนนีѸ ถา้สตูรใดทีѷคณุคดิวา่มเีงืѷอนไข
ของการคํานวณไมย่ากนัก"ตอ่การจําของคณุ"และงา่ยทีѷจะยอ้นกลับมาแกไ้ข ก็เชญิซอ้นสตูรเขา้
ไปหลายๆชั Ѹนไดต้ามใจ แตถ่า้มทีางเลอืกอืѷนทีѷดกีวา่ เชน่ มสีตูรอืѷน หรอืตอ้งปรับโครงสรา้ง
ตารางเสยีใหมเ่พืѷอใหเ้ขา้กบัสตูรนัѸน ก็ขอแนะนําใหต้ัดสนิใจเลอืกใหด้ ี

สตูรทีѷหาคา่ได ้ก็ใชบ้อกตาํแหนง่ได ้  

เชืѷอไหมวา่เรืѷองทีѷจะอธบิายนีѸแทบทกุคนทีѷใช ้Excel ทราบกนัดอียูแ่ลว้ ใชก้นัอยูท่กุวัน แตน่กึไม่
ถงึวา่สตูรทีѷหาคา่ได ้จะใชบ้อกตําแหน่งทีѷแปลกแตกตา่งจากทีѷเขา้ใจกนัอยา่งไร 

พอสรา้งสตูรลงไปในเซลลใ์ดๆก็ตามวา่ =A1 สตูรนีѸก็จะดงึคา่จากเซลล ์A1 มาแสดงใหเ้ห็น 
และพรอ้มกนันัѸนเราก็จะทราบดว้ยวา่ คา่ทีѷไดน้ีѸมาจากเซลล ์A1 เพราะดจูากตัวสตูรทีѷใชตํ้าแหน่ง
อา้งองิ =A1 นัѷนเอง 

ทีѷพเิศษไปกวา่นีѸ หากคณุตัดกาในชอ่ง Allow edit directly in cells ทิѸงไป จะพบวา่เมืѷอดบัเบลิ
คลกิทีѷเซลลส์ตูร =A1 จะยา้ยตําแหน่ง cursor ไปทีѷเซลลต์น้ทาง A1 ใหทั้นท ี
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สิѷงทีѷอธบิายขา้งตน้นีѸเคยอธบิายมาหลายตอ่หลายครั Ѹงในการอบรมและในเว็บ 
ExcelExpertTraining.com ซึѷงพฤตกิรรมแบบนีѸแหละทีѷนําไปสูเ่รืѷองแปลกทีѷคาดไมถ่งึ จากเดมิ
ทีѷเขยีนวา่ "สตูรทีѷหาคา่ได ้ก็ใชบ้อกตําแหน่งได"้ ขอเขยีนใหมใ่หล้ะเอยีดชดัเจนกวา่เดมิวา่ 

สตูรใดๆทีѷสามารถหาคา่ทีѷเก็บไวจ้ากตารางไดโ้ดยตรง สตูรนัѸนยอ่มเป็นสตูรทีѷบอก
ตําแหน่งได ้โดยอยา่สรา้งสตูรนัѸนลงไปในเซลล ์แตต่อ้งนําสตูรนัѸนไปซอ้นในสตูรอืѷนก็
จะกลายเป็นสตูรทีѷบอกตําแหน่ง  

ยกตัวอยา่งเชน่ สตูร =INDEX(A1:B10,5,2) เป็นสตูรหาคา่จากตารางขอ้มลูชว่ง A1:B10 ใน
ตําแหน่ง Row 5 ตัดกบั Column 2 จะไดค้า่จากเซลล ์B5 

ถา้อยากจะตามไปดวูา่เซลล ์B5 อยูท่ีѷไหนโดยไมต่อ้งนัѷงแกะสตูรวา่ Row 5 ตัดกบั Column 2 
คอืเซลลใ์ด ใหห้ยบิเมาสค์ลกิลากทับสตูร =INDEX(A1:B10,5,2) ทีѷแสดงบน Formula Bar 
จากนัѸนกดปุ่ ม F5 แลว้กดปุ่ ม Enter จะพบวา่สตูร =INDEX(A1:B10,5,2) เปลีѷยนไปเป็น =B5 
ใหทั้นท ีพอเห็นดังนีѸแลว้ใหก้ดปุ่ ม Esc เพืѷอทําใหส้ตูรคนืสูส่ภาพเดมิ 

ยิѷงกวา่นัѸน ถา้ Copy สตูร =INDEX($A$1:$B$10,5,2) ไวก้อ่นแลว้กดปุ่ ม F5 แลว้กดปุ่ ม Ctrl+v 
เพืѷอ Paste สตูรนีѸลงไปในชอ่ง Reference แลว้กดปุ่ ม Enter จะพบวา่ Excel พาคณุยา้ย
ตําแหน่งไปทีѷเซลล ์B5 ใหเ้ลย (สงัเกตวา่วธินีีѸตอ้งกําหนดตําแหน่งอา้งองิเป็น Absolute คอื 
$A$1:$B$10 กอ่นดว้ย) 

ยิѷงกวา่นีѸของยิѷงกวา่นัѸนอกี ถา้นําสตูร INDEX(A1:B10,5,2) ไปซอ้นในสตูรอืѷน เชน่ สตูร Offset 
จะทําใหส้ตูร INDEX(A1:B10,5,2) ทําหนา้ทีѷชีѸตําแหน่งตอ่ใหก้บั Offset 

ขอใหส้รา้งสตูร =OFFSET(INDEX(A1:B10,5,2),2,3) แลว้ลองใชว้ธิขีา้งตน้คน้หาวา่หมายถงึ
เซลลใ์ด จะพบวา่เป็นเซลล ์E7 ใชไ่หม เพราะเซลล ์E7 เป็นเซลลท์ีѷอยูถ่ัดลงมาจากเซลล ์B5 
จํานวน 2 row และถัดไปดา้นขวาจํานวน 3 column เทยีบเทา่กบัการใชส้ตูร 
=OFFSET(B5,2,3) นัѷนเอง 

แตถ่า้สรา้งสตูร =INDEX(A1:B10,5,2) ไวใ้นเซลล ์D12 แลว้ใชส้ตูร Offset อา้งถงึ D12 ใน
แบบ =OFFSET(D12,2,3) จะพบวา่ D12 ไมไ่ดช้ว่ยบอกตําแหน่งตอ่ใหก้บัสตูร Offset เพราะ
สตูร Index ในเซลล ์D12 ทําหนา้ทีѷหาคา่จากเซลล ์B5 มาแสดงเสร็จก็จบหนา้ทีѷไปแลว้ 
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สตูรทีѷสามารถหาคา่ทีѷเก็บไวจ้ากตารางไดโ้ดยตรง ซึѷงทํางานไดแ้บบทีѷอธบิายนีѸ ไดแ้ก ่If, 
Choose, Index, Offset, Indirect (แตไ่มร่วมสตูร VLookup เพราะมันไมไ่ดห้าคา่ไดโ้ดยตรง) 
ซึѷงไมจํ่าเป็นตอ้งคนืคา่เพยีงคา่เดยีวเป็นตําแหน่งเซลลเ์ดยีว โดยสามารถคนืคา่เป็นตารางเพืѷอ
ใชบ้อกตําแหน่งตารางทั Ѹงตารางก็ยังได ้

จํานวนเซลลส์ตูรเดยีว   

ผูส้รา้งสตูร Excel ทัѷวไป คุน้เคยกบัการสรา้งสตูรหนึѷงทีѷคนืคา่เพยีงหนึѷงคา่ หรอือกีนัยหนึѷง
เรยีกวา่ สตูรเดยีวคนืคา่เดยีว ซึѷงสรา้งลงไปในเซลลเ์ดยีว แตน่อ้ยคนนักทีѷจะทราบวา่ สตูร Excel 
สตูรหนึѷงๆสามารถคนืคา่เป็นคําตอบไดห้ลายคา่ก็เป็นไปไดเ้หมอืนกนั สตูรพวกหลังนีѸเรยีกวา่ 
สตูร Array 

การทีѷเราเลอืกเซลลเ์ดยีว แลว้พมิพส์ตูรลงไปในเซลลเ์ดยีวนัѸน มสีาเหตเุนืѷองจากสตูรนัѸนคนืคา่
ไดคํ้าตอบเพยีงคา่เดยีว 

ถา้สตูรหนึѷงๆคนืคา่เป็นคําตอบไดห้ลายคา่ หากสรา้งสตูรนัѸนลงไปในเซลลเ์ดยีว ยอ่มไมถ่กูตอ้ง 
แมจ้ะเห็นคําตอบแสดงขึѸนมาก็ตาม เพราะคําตอบทีѷแสดงขึѸนมาใหเ้ห็นนัѸนเป็นเพยีงคําตอบแรก
คําตอบเดยีว เราหมดโอกาสทราบคําตอบคา่อืѷนๆ (ถา้ใช ้Excel 365 รุน่ลา่สดุ Excel จะกระจาย
คา่ออกไปใหเ้องซึѷงเป็นวธิกีารใหมเ่รยีกวา่ Dynamic Array) 

พออา่นถงึตรงนีѸ คนทีѷไมรู่จั้กกบัสตูร Array คงเริѷมสงสยัวา่ สตูรแบบไหนกนัทีѷมคํีาตอบไดห้ลาย
คา่ในสตูรเดยีว มาทดลองโดยเริѷมจากพมิพค์า่ใดๆก็ไดล้งไปในเซลล ์A1:A3 สมมตวิา่พมิพ ์11, 
22, 33 ตามลําดับ  
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แลว้สรา้งสตูร =A1:A3 ลงไปในเซลล ์B1 จะเห็นคําตอบเป็นเลข 11 คา่เดยีวใชไ่หม (ถา้ใช ้
Excel 365 รุน่ลา่สดุ จะพบวา่สตูรกระจายตัวลงไปในเซลล ์B1:B3 ใหเ้อง หากตอ้งการใหแ้สดง
แบบ Excel รุน่กอ่นใหใ้ช ้=@A1:A3 จะบังคับให ้Excel 365 ทํางานแบบ Excel รุน่กอ่น) 

จากนัѸนใหแ้กะดคูา่ทีѷแทจ้รงิในสตูร โดยกดปุ่ ม F2 ตามดว้ยปุ่ ม F9 จะพบวา่สตูร =A1:A3 
เปลีѷยนเป็น ={11;22;33} 

ขอใหส้งัเกตวา่เครืѷองหมายวงเล็บ { ทีѷเกดิขึѸนนัѸนอยูห่ลังจากเครืѷองหมายเทา่กบั ซึѷงแสดงคา่
แบบ Array และระหวา่งตัวเลขจะมเีครืѷองหมาย semi-colon ; คัѷน ซึѷงแสดงวา่คา่ถัดไปอยูใ่น 
Row ถัดไป (หรอืขึѸน Row ใหม)่ 

พอเห็นคา่แลว้วา่สตูรนีѸม ี3 คา่และแตล่ะคา่อยูต่ามแนวตั Ѹง ก็ใหก้ดปุ่ ม Esc เพืѷอยอ้นกลับไปเป็น
สตูร =A1:A3 ตามเดมิ 

คราวนีѸถงึขั Ѹนตอนสําคัญ หากตอ้งการกระจายคา่แตล่ะคา่ในสตูร Array ลงไปในเซลล ์ใหเ้ริѷม
จากเลอืกเซลล ์3 เซลลต์ามแนวตั Ѹง (เพราะเราทราบจากการแกะสตูรมากอ่นแลว้วา่มคีา่ 3 คา่
ตามแนวตั Ѹง) โดยจะเลอืกทีѷตําแหน่งใดก็ไดใ้นชที จากนัѸนสรา้งสตูร =A1:A3 ลงไปแลว้กดปุ่ ม 
Ctrl+Shift+Enter พรอ้มกนั จะพบวา่ Excel กระจายคา่ในสตูรลงไปในเซลลแ์ตล่ะเซลลใ์หเ้ห็น
จนครบ และตัวสตูรเปลีѷยนเป็น {=A1:A3} โดยสงัเกตวา่คราวนีѸเครืѷองหมาย { ตัวแรกวางไว ้
กอ่นเครืѷองหมายเทา่กบั แสดงวา่เป็นวงเล็บปีกกาทีѷเกดิจากการกดปุ่ ม Ctrl+Shift+Enter 
(ไมใ่ชว่งเล็บปีกกาทีѷใชก้ํากบัลําดับของคา่ทีѷตอ้งอยูห่ลังเครืѷองหมายเทา่กบั) 

ประโยชนข์องการเลอืกจํานวนเซลลใ์หค้รบเหมาะกบัจํานวนและแนวของคา่ทีѷตอ้งการนีѸ จะชว่ย
ใหเ้ราเห็นคา่ทกุคา่กระจายตัวลงไปในเซลลแ์ตล่ะเซลล ์ทําใหป้ระหยัดเวลาไมต่อ้งคอยกดปุ่ ม 
F2 ตามดว้ย F9 เพืѷอแกะสตูรเป็นครั Ѹงๆไป อกีทั Ѹงสตูรทีѷสรา้งขึѸนพรอ้มกนัทเีดยีวหลายเซลล ์จะ
ทําให ้Excel เสยีเวลาในการคํานวณเพยีงครั Ѹงเดยีว 

วธิแีก ้error #VALUE! ดว้ย Lotus 1-2-3   

เมืѷอนําเซลลท์ีѷมคีา่เป็นตัวเลขมาบวกดว้ยเซลลท์ีѷมคีา่เป็นตัวอกัษรโดยการสรา้งสตูรบวกทีѷนํา
เซลลม์าบวกกนั เชน่ =A1+A2 จะพบวา่ไดคํ้าตอบเป็น #VALUE! นัѸน เราสามารถสัѷงให ้Excel 
คํานวณหาคําตอบเป็นยอดรวมเฉพาะตัวเลขไดโ้ดยใชส้ัѷงให ้Excel คํานวณแบบ Lotus 1-2-3 
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ใน Excel 2010 เริѷมจากสัѷง File > Options > Advanced > แลว้เลืѷอนจอไปดา้นลา่งสดุจะพบ 
Lotus compatibility Settings for: ชืѷอชทีทีѷตอ้งการใหคํ้านวณแบบ Lotus 1-2-3 โดยใหก้า
ชอ่ง Transition formula evaluation (Excel 2007 ใหค้ลกิปุ่ ม Office แทน File) 

 

คําสัѷง Transition formula evaluation นีѸเกดิขึѸนในสมัยทีѷคนทัѸงโลกยังนยิมใช ้Lotus 1-2-3 กนั 
ดังนัѸนเพืѷอชว่ยทําใหค้นเปลีѷยนใจมาใช ้Excel ไดง้า่ยขึѸน ทางไมโครซอฟทจ์งึสรา้งคําสัѷงนีѸข ึѸน
เพืѷอใหพ้วกเราสามารถนําแฟ้มทีѷสรา้งจาก Lotus 1-2-3 มาเปิดใชใ้น Excel ตอ่ไดทั้นทโีดย 
Excel จะเปลีѷยนระบบการคํานวณในชทีทีѷเลอืกไวใ้หคํ้านวณตามแบบทีѷ Lotus 1-2-3 ใชนั้ѷนคอื
ใน Lotus 1-2-3 ถอืวา่ตัวอกัษรมคีา่เทา่กบั 0 (สว่น Excel ถอืวา่ตัวอกัษรมคีา่มากกวา่เลขทัѸง
ปวง) 

นอกจากนัѸนหากกาชอ่ง Transition formula entry จะชว่ยทําใหส้ตูรทีѷสรา้งจาก Lotus 1-2-3 
release 2.2 ถกูเปลีѷยนเป็นสตูรของ Excel ใหทั้นทเีมืѷอเปิดแฟ้มทีѷใชส้ตูรนัѸนดว้ย Excel 

สว่นชอ่ง Transition navigation keys จะเปลีѷยนพฤตกิรรมของปุ่ มลกูศร ปุ่ ม Tab หรอืปุ่ มใดๆทีѷ
ทําหนา้ทีѷเคลืѷอนยา้ยตําแหน่งเซลลท์ีѷเลอืก ใหทํ้าตามทีѷ Lotus 1-2-3 ใช ้ซึѷงชว่งแรกกวา่ผมจะ
หันมาใช ้Excel อยา่งเต็มตัว ตอ้งอาศัยกาชอ่งนีѸอยูน่านเพราะมอืยังไมคุ่น้กบัปุ่ มทีѷเคยเลืѷอนไป
เลืѷอนมาตามแบบทีѷตัวเองเคยชนิ 
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ตวัอกัษรมไิดม้คีา่เทา่กบั 0 

กอ่นจะจบบทความนีѸ ทราบไหมวา่ ตัวอกัษร a หรอืตัวอกัษรใดๆก็ตามทีѷบันทกึลงไปในเซลล ์
มไิดถ้อืวา่มคีา่เทา่กบั 0 หรอกนะ ถา้ไมเ่ชืѷอ สมมตวิา่เซลล ์A1 มคีา่เป็น a ขอใหล้องสรา้งสตูร 
=A1=0 ดกูไ็ดจ้ะพบวา่ไดคํ้าตอบเป็น FALSE สว่นสตูร =A1>999999999 จะไดคํ้าตอบเป็น 
TRUE 

Excel ถอืวา่ตัวอกัษรใดๆมคีา่มากกวา่เลขทัѸงปวง อกีนัยหนึѷงมคีา่เป็น Infinity หากสรา้งสตูร 
=Sum(A1,123) แลว้ไดคํ้าตอบเทา่กบั 123 เป็นเพราะ Excel จะละเลยไมนํ่าตัวอกัษรมา
คํานวณในสตูร Sum นีѷแหละเป็นเรืѷองทีѷหลายๆคนชอบเขา้ใจผดิกนัวา่ ตัวอกัษรมคีา่เป็น 0 

ถา้สรา้งสตูร =A1+123 จะไดคํ้าตอบเป็น #VALUE! เพราะ Excel จะไมย่อมรับการนําตัวอกัษร
มาบวกกบัตัวเลข แตเ่ราสามารถเปลีѷยนพฤตกิรรมของ Excel ใหค้ดิแบบ Lotus 1-2-3 ไดต้าม
คําอธบิายขา้งตน้ 

ถา้ถามวา่ระหวา่งสตูรบวกกบัสตูร Sum เราจะเลอืกใชก้ารบวกเลขวธิใีดกบังานสําคัญ 

คําตอบก็คอื ตอ้งเลอืกใชส้ตูรบวก เพราะหากมกีารบันทกึตัวเลขผดิ กลายเป็นบันทกึตัวอกัษร
ลงไปแทน จะพบวา่ Excel ไมย่อมคํานวณให ้โดยไดคํ้าตอบเป็น #VALUE! ซึѷงเทา่กบัชว่ย
เตอืนเราใหท้ราบวา่เกดิขอ้ผดิพลาดขึѸนมาในระหวา่งการบันทกึขอ้มลูนัѷนเอง 
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การแบง่ขอบเขตพืҟนทีѷตาราง 

ในชทีของ Excel 2007 เป็นตน้มามพีืѸนทีѷตารางใหญก่วา่รุน่กอ่นอยา่งมาก จากเดมิมเีพยีง 
65,536 row และ 256 column ไดป้รับเพิѷมเป็น 1,048,576 row และ 16,384 column ซึѷงถา้
คณุพมิพค์า่ลงไปแลว้พยายาม paste ใหค้รบทกุเซลลใ์นชที จะพบวา่ Excel ตอ้งใชเ้วลานาน
แสนนานทเีดยีวกวา่จะไดข้อ้มลูเต็มทั Ѹงชที และเมืѷอสัѷง save จะไมม่ ีhard disk เครืѷองไหนทีѷ
สามารถเก็บแฟ้มขอ้มลูนัѸนได ้เพราะแฟ้มจะมขีนาดใหญเ่กนิกวา่จะรับได ้(ขออยา่พยายาม
ทดลองทําตามนีѸเด็ดขาด เพราะคณุจะรอไมไ่หวแลว้ตอ้งหันไปปิดเครืѷองคอมพวิเตอรไ์ปกอ่นทีѷ
จะ save เสร็จ) 

สาเหตทุีѷ Excel ขยายขนาดตารางใหใ้หญข่ึѸนจนดเูหมอืนใหญก่วา่ความจําเป็น มไิดมุ้ง่ใหค้ณุ
จําเป็นตอ้งใชใ้หค้รบทกุเซลล ์เพยีงแตจ่ะชว่ยใหส้ามารถรับขอ้มลูจากโปรแกรมอืѷนเขา้มาเก็บไว ้
ในชทีไดส้ะดวกขึѸน และเมืѷอคณุหันมาใช ้Excel 2007 แลว้ก็มไิดห้มายความวา่จากนีѸไปคณุไม่
จําเป็นตอ้งใชโ้ปรแกรมฐานขอ้มลูอืѷนอกีตอ่ไป เพราะในทีѷสดุแลว้เมืѷอขอ้มลูมปีรมิาณมากขึѸนและ
มคีวามสมัพนัธใ์นตัวฐานขอ้มลูซบัซอ้นตามขึѸนไปแลว้ โปรแกรมทีѷสรา้งขึѸนมาเพืѷอจัดการ
ฐานขอ้มลูโดยเฉพาะยอ่มเหมาะกวา่อยูด่ ี

อยา่วา่แตข่นาดของตารางทีѷมขีนาดใหญส่ามารถรับขอ้มลูไดม้ากขึѸนนีѸเลย ตอ่ใหใ้ช ้Excel 2003 
ทีѷมขีนาดตารางเล็กกวา่ หากผูใ้ช ้Excel ไมเ่ป็น พอนําขอ้มลูมาเก็บไวใ้นชทีอยา่งไมม่หีลักการ 
แลว้เมืѷอถงึเวลาจะตอ้งแยกขอ้มลูออกจากกนัเป็นสว่นๆก็จะทําไดย้าก จงึขอเสนอใหใ้ชห้ลกั 
ICO แบง่ขอบเขตพืѸนทีѷตาราง กลา่วคอื 

1. ใหแ้บง่แยกตารางขอ้มลูออกเป็น 3 ประเภท คอื ตาราง Input, ตาราง Calculate, และ 
ตาราง Output (หรอืใชต้ัวยอ่วา่ ICO) 

2. ตาราง Input คอื ตารางทีѷใชเ้ก็บขอ้มลูทีѷพมิพล์งไปหรอืเป็นขอ้มลูทีѷรับมาจากโปรแกรม
อืѷน หรอือกีนัยหนึѷงเป็นตารางฐานขอ้มลูนัѷนเอง ตาราง Input นีѸตอ้งออกแบบใหโ้ครงสรา้ง
ของตารางมลัีกษณะดังนีѸ 
2.1. หัวตารางดา้นบนและแตล่ะรายการ ตอ้งเป็น row เดยีว ซึѷงอาจแตง่ขอ้ความในเซลลใ์ห ้

แสดงเป็นหลายบรรทัดได ้โดยกดปุ่ ม Alt+Enter เพืѷอขึѸนขอ้ความในบรรทัดใหมใ่น
เซลลเ์ดมิ 
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2.2. ตอ้งบันทกึขอ้มลูใน column ใด column หนึѷงตดิตอ่กนัไปตลอด หา้มเวน้ชอ่งวา่ง ซึѷง
โดยทัѷวไป column ซา้ยสดุมักจะมขีอ้มลูตดิตอ่กนัไปอยูแ่ลว้เนืѷองจากเป็นขอ้มลูของ
เลขทีѷรายการ หรอืขอ้มลูรหัส หรอืขอ้มลูวันทีѷซ ึѷงเรยีงไปตามลําดับรายการทีѷเกดิขึѸน 

2.3. ตอ้งเวน้ขอบตารางไมว่า่จะเป็นขอบดา้นบนลา่งซา้ยขวาอยา่งนอ้ยขา้งละ 1 เซลล ์หา้ม
นําตาราง Input ไปตดิกบัเซลลข์อ้มลูอืѷนซึѷงไมใ่ชข่อ้มลูเรืѷองเดยีวกบัตารางขอ้มลูนัѸน 

3. ตาราง Calculate คอื ตารางทีѷใชส้รา้งสตูรคํานวณ ไมจํ่าเป็นตอ้งมโีครงสรา้งตามแบบ
ของตาราง Input แตใ่นตาราง Calculate นีѸคณุตอ้งหาทางสรา้งสตูรทีѷเซลลห์ัวมมุเป็นสตูร
ฉลาดทีѷสามารถปรับตําแหน่งอา้งองิไดเ้อง และในขณะทีѷสรา้งสตูรตอ้งใชปุ้่ ม F4 เพืѷอใส่

เครืѷองหมาย $ เพืѷอควบคมุตําแหน่งอา้งองิในสตูรไปยังเซลลท์ีѷบันทกึคา่ตัวแปรทีѷใชคํ้านวณ
ไว ้ซึѷงโดยทัѷวไปเซลลค์า่ตัวแปรจะวางไวต้ามแนวคูข่นานกบัแนวของตาราง Calculate เพืѷอ
ชว่ยใหเ้ครืѷองหมาย $ ทีѷใสไ่วใ้นสตูร ทําหนา้ทีѷควบคมุตําแหน่งของแนวของเซลลต์ัวแปรไว ้
เพืѷอนําคา่มาใชคํ้านวณนัѷนเอง 

4. ตาราง Output คอื ตารางแสดงผลลัพธท์ีѷตอ้งการ โดยตารางนีѸจะออกแบบใหม้หีนา้ตา
อยา่งไรก็ไดต้ามแตว่า่จะนําไปแสดงผลบนจอภาพหรอืในหนา้กระดาษทีѷสัѷงพมิพ ์

สาเหตทุีѷตอ้งใชห้ลัก ICO แยกขอ้มลูแตล่ะประเภทออกจากกนั เพืѷอชว่ยทําใหเ้ราสามารถใช ้
Excel รองรับกบัขอ้มลูทีѷมปีรมิาณมากขึѸนไปเรืѷอยๆไดต้ลอด ซึѷงในชว่งแรกทีѷยังมขีอ้มลูไมม่าก
นัก อาจใชช้ทีเดยีวเก็บขอ้มลูทั Ѹง I C และ O ไวด้ว้ยกนั จากนัѸนเมืѷอมปีรมิาณขอ้มลูมากขึѸนหรอื
ขอ้มลูมคีวามสลับซบัซอ้นมากขึѸนจงึคอ่ยยา้ยตารางแยกไปเก็บในชทีอืѷนหรอืแฟ้มอืѷนไดทั้นที
โดยไมก่ระทบกบัสตูรคํานวณทีѷสรา้งไว ้

ขอ้ผดิพลาดทีѷพบเห็นบอ่ยครั Ѹงเกดิจากการออกแบบตารางตามแบบรายงานทีѷตอ้งพมิพ ์เชน่ 
หากมรีายงานยาว 100 หนา้ ก็มักออกแบบตารางใน Excel ใหย้าวเหยยีดตอ่ๆกนัลงมาทัѸง 100 
หนา้แลว้จงึสัѷงพมิพอ์อกไปทลีะหนา้ ซึѷงวธินีีѸทําใหแ้ฟ้มมขีนาดใหญแ่ละยากตอ่การแกไ้ขเพราะ
จําเป็นตอ้งยอ้นกลับไปไลแ่กไ้ขในตารางแตล่ะหนา้ 

แตห่ากออกแบบตารางแบบ ICO เป็น ใหเ้ริѷมจากแยกตารางขอ้มลูทีѷเป็น Input ออกไป แลว้ใช ้

สตูรดงึคา่จากตาราง Input มาคํานวณในตาราง Calculate จากนัѸนจงึดงึผลลัพธท์ีѷคํานวณเสร็จ
แลว้ไปสรา้งตาราง Output ซึѷงจดุสําคัญอยูท่ีѷตาราง Output นีѷแหละ โดยเราตอ้งหาทางสรา้ง
ตาราง Output ไวเ้พยีงหนา้เดยีว จากนัѸนตอ้งสรา้งสตูรดงึขอ้มลูแตล่ะหนา้มาแสดงในตาราง 
Output หนา้เดยีวนีѸใหไ้ด ้ชว่ยใหแ้ฟ้มมขีนาดเล็กและแกไ้ขไดง้า่ยกวา่มาก 
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สมมตวิา่หนา้กระดาษทีѷพมิพม์ ี30 บรรทัดตอ่หนา้ ดังนัѸนพอพมิพเ์ลขหนา้ทีѷ 1 ลงไป ตอ้งสรา้ง
สตูรดงึผลลัพธบ์รรทัดทีѷ 1 - 30 มาแสดงในหนา้นีѸ จากนัѸนพอเปลีѷยนเลขหนา้เป็นเลข 2 ก็จะได ้
บรรทัดทีѷ 31 – 60 มาแสดง พอเป็นหนา้ 3 ก็ไดบ้รรทัดทีѷ 61 - 90 มาแสดง ซึѷงสตูรทีѷดงึขอ้มลู
เชน่นีѸไดก้็คอืสตูร VLookup, Match, Index เป็นตน้ 

การจดัเตรยีมพืҟนทีѷ ICO เพืѷอรบัขอ้มลูและป้องกนัการแกไ้ข 

แฟ้มทีѷสรา้งเสร็จพรอ้มใชง้าน ตอ้งมรีะบบแยกแยะตําแหน่งตารางทีѷเปิดใหร้ับคา่ใหมไ่ดพ้รอ้มทั Ѹง
หาทางป้องกนัตารางทีѷไมต่อ้งการใหใ้ครเขา้ไปแกไ้ข โดยตอ้งพจิารณาจากพืѸนทีѷตารางแตล่ะ
สว่น กลา่วคอื 

1. ตาราง Input เป็นพืѸนทีѷสว่นทีѷเปิดใหผู้ใ้ชง้านสามารถพมิพค์า่ใหมล่งไปได ้โดยมขีั Ѹนตอน
ในการจัดเตรยีมพืѸนทีѷดังนีѸ 
1.1. คลกิเลอืกพืѸนทีѷตารางสว่นทีѷเป็น Input (หากมหีลายพืѸนทีѷไมต่ดิตอ่กนั ใหก้ดปุ่ ม Ctrl 

คา้งไวก้อ่นแลว้คลกิเลอืกพืѸนทีѷแตล่ะสว่น แลว้อาจกําหนดส ีFont ใหแ้ตกตา่งจากสว่น
อืѷน ซึѷงผมเองชอบใชส้ชีมพเูพืѷอบอกผูใ้ชว้า่เป็นเซลล ์Input) 

1.2. คลกิขวา สัѷง Format Cells > Protection > แลว้ตัดกาชอ่ง Locked ทิѸงไป 

 
1.3. สัѷง Review > Protect Sheet  
1.4. หลังจากทีѷ Protect Sheet เสร็จ เมืѷอพมิพข์อ้มลูใหมล่งไปในเซลลท์ีѷเป็น Input แลว้ 

ใหก้ดปุ่ ม Tab ซึѷงจะพบวา่ Excel จะกระโดดไปเลอืกเซลล ์Input ตอ่ไปใหเ้อง 
2. ตาราง Calculate และตาราง Output เป็นพืѸนทีѷซ ึѷงมเีซลลส์ว่นใหญเ่ป็นสตูรซึѷงเมืѷอสรา้ง

เสร็จแลว้ ควรป้องกนัไมใ่หใ้ครเขา้ไปดสูตูร แกไ้ขสตูร หรอืลบสตูรทิѸงไดอ้กี โดยมขีั Ѹนตอน
ในการจัดเตรยีมพืѸนทีѷดังนีѸ (ถา้ชทีถกู Protect อยูต่อ้ง Unprotect Sheet กอ่น) 
2.1. คลกิเลอืกพืѸนทีѷตารางสว่นทีѷเป็นตาราง Calculate และตาราง Output 
2.2. คลกิขวา สัѷง Format Cells > Protection > แลว้กาชอ่ง Hidden เพืѷอซอ่นการ

แสดงสตูรทีѷจะเห็นบน Formula Bar และยังป้องกนัไมใ่ห ้Copy สตูรออกไปไดด้ว้ย 
โดยจะ Copy เฉพาะคา่ผลลัพธอ์อกไปไดเ้ทา่นัѸน (หา้มตดักาชอ่ง Locked ทิҟงอยา่ง
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เด็ดขาด) และตอ้งทําขั Ѹนตอนตอ่ไปกอ่นดว้ยจงึจะเห็นผล 

 
2.3. สัѷง Review > Protect Sheet  
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การกาํหนดตาํแหนง่อา้งองิ 
ขา้มชทีหรอืขา้มแฟ้ม 

ผมเริѷมตน้ใชโ้ปรแกรม Excel ตั Ѹงแตย่คุทีѷในแฟ้มหนึѷงๆยังมชีทีใหใ้ชง้านไดเ้พยีงชทีเดยีวและยัง
ไมส่ามารถใชส้ตูรเชืѷอมขอ้มลูจากแฟ้มอืѷนมาใชง้านรว่มกนั ในยคุนัѸนตอ้งออกแบบตารางทั Ѹงหมด
ลงไปในชทีเดยีว ตอ่มา Excel ถกูพัฒนาใหส้ามารถสง่ขอ้มลูจากแฟ้มหนึѷงออกไปยังแฟ้มอืѷนได ้
แตก่็ยังไมส่ามารถทําหนา้ทีѷทั Ѹงรับทั Ѹงสง่ขอ้มลูกลับไปกลับมาระหวา่งแฟ้มเชน่ทีѷ Excel ในรุน่
ปัจจบุันทําได ้ซึѷงถา้ดใูหด้จีะพบวา่สิѷงทีѷ Excel สามารถสง่ขอ้มลูกลับไปกลับมาไดนั้Ѹนเป็นเพราะ
เราถกู Excel หลอกใหด้เูหมอืนวา่มหีลายชทีหรอืมหีลายแฟ้ม...แคนั่Ѹนเอง 

ขอใหจํ้าไวว้า่ ไมว่า่จะเป็นตา่งชทีหรอืตา่งแฟ้ม พอเปิดแฟ้มขึѸนมาใชง้านพรอ้มกนั มัน
ก็คอืชทีเดยีวกนันัѷนแหละ 

การทีѷเราเห็นวา่ในแฟ้มหนึѷงๆมหีลายชทีนัѸน เป็นภาพลวงตาทีѷชว่ยใหผู้ใ้ชง้านสามารถแยกเก็บ
ขอ้มลูตา่งเรืѷองไวใ้นชทีตา่งกนัไป สว่นขอ้มลูทีѷ link ขา้มแฟ้มไดนั้Ѹน ถา้คณุใช ้Excel รุน่แรกๆมา
กอ่นอยา่งผม พอสัѷง Unhide Sheet จะพบวา่ในแฟ้มปลายทางมชีทีหนึѷงถกูซอ่นไว ้โดยชทีนีѸใช ้

เก็บขอ้มลูจากชทีตน้ทางไวทั้ Ѹงหมด ดังนัѸนขอ้มลูทีѷไดม้าจากสตูร link ขา้มแฟ้ม ถา้วา่กนัให ้
ถกูตอ้ง ไมไ่ดเ้ป็นผลจากสตูรทีѷ link มาจากแฟ้มตน้ทางโดยตรง แตเ่ป็นขอ้มลูทีѷไดม้าจากชทีทีѷ
ซอ่นไวภ้ายในชทีปลายทางในแฟ้มเดยีวกนักบัแฟ้มทีѷมสีตูร link นัѷนเอง โดยเรยีกขอ้มลูทีѷเก็บ
ในชทีนีѸวา่ Cache Data ซึѷงสง่ผลใหแ้ฟ้มปลายทางมขีนาดแฟ้มใหญก่วา่ปกตติามไปดว้ย 
(ตอ่มา Microsoft ไดป้รับปรงุให ้Excel ซอ่นชทีนีѸไวโ้ดยไมส่ามารถคน้หาพบเชน่แตก่อ่น)  

ถา้คณุสามารถสรา้งสตูร link ขอ้มลูภายในชทีเดยีวกนั ก็ขอใหใ้ชว้ธิเีดยีวกนัในการ link ขอ้มลู
ขา้มชทีหรอืแมแ้ตข่า้มแฟ้ม ขอเพยีงอยา่กลัวภาพลวงตาทีѷทําใหเ้ห็นวา่เป็นตา่งชทีหรอืตา่งแฟ้ม
กนัเพราะความจรงิมันก็คอืชทีเดยีวกนันัѷนเอง ซึѷงกอ่นทีѷจะใชว้ธิสีรา้งสตูร link ทีѷนยิมใชก้นั
ตอ่ไปนีѸ ขอใหเ้ปิดแฟ้มทกุแฟ้มทีѷตอ้งการสรา้งสตูร link ขอ้มลูระหวา่งกนัขึѸนมากอ่นทัѸงแฟ้มตน้
ทางและแฟ้มปลายทางแลว้จะชว่ยใหส้รา้งสตูร link ไดง้า่ยมาก 

1. วธิยีอ้นปลายกลบัมาหาตน้  
1.1. ใหเ้ริѷมจากพมิพเ์ครืѷองหมายเทา่กบั = ทีѷเซลลป์ลายทาง  
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1.2. (หากไมต่อ้งการ link ขา้มชทีหรอืขา้มแฟ้มใหข้า้มขั ѸนตอนนีѸ) คลกิเลอืกชืѷอชทีตน้ทาง 
หรอืคลกิชืѷอแฟ้มตน้ทางทีѷเปิดไวก้อ่นแลว้จากคําสัѷง View > Switch Windows  

1.3. แลว้คลกิเลอืกเซลลต์น้ทาง  
1.4. จากนัѸนกดปุ่ ม Enter เพืѷอรับสตูร link ตําแหน่งเซลลต์น้ทางกลับไปบันทกึไวท้ีѷเซลล์

ปลายทาง (วธินีีѸโดยทัѷวไปจะทําไดท้ลีะเซลล ์เวน้แตจ่ะสรา้งสตูรแบบ Array จงึจะสรา้ง
พรอ้มกนัหลายเซลลทั์ Ѹงตาราง และขอใหส้งัเกตวา่ถา้เป็นสตูร link ขา้มแฟ้มจะได ้
ตําแหน่งอา้งองิแบบ Absolute เสมอ) 

2. วธิ ีCopy จากตน้ แลว้มา Paste Special แบบ Paste Link ทีѷปลาย  
2.1. ใหเ้ริѷมจากเลอืกพืѸนทีѷตารางตน้ทางทัѸงตารางพรอ้มกนั 
2.2. สัѷง Copy 
2.3. (หากไมต่อ้งการ link ขา้มชทีหรอืขา้มแฟ้มใหข้า้มขั ѸนตอนนีѸ) คลกิเลอืกชืѷอชที

ปลายทาง หรอืคลกิชืѷอแฟ้มปลายทางทีѷเปิดไวก้อ่นแลว้จากคําสัѷง View > Switch 
Windows  

2.4. จากนัѸนใหเ้ลอืกเซลลห์ัวมมุตารางปลายทางเพยีงเซลลเ์ดยีวแลว้คลกิขวา สัѷง Paste 
Special > กดปุ่ ม Paste Link จะไดส้ตูร link พรอ้มกนัทเีดยีวทั Ѹงตาราง 

 
3. วธิ ีCut จากตน้ แลว้ไป Paste ทีѷปลาย โดยวธินีีѸวา่ไปแลว้ไมไ่ดเ้ป็นการสรา้งสตูร link 

แตใ่หเ้ริѷมจากสรา้งสตูร link ไวใ้นชทีเดยีวกนัตามวธิขีา้งตน้ใหเ้สร็จกอ่น จากนัѸนจงึสัѷง Cut 
ตารางสตูรจากชทีตน้ทางไป Paste ทีѷตําแหน่งปลายทางในชทีอืѷนหรอืแฟ้มอืѷน ซึѷง Excel 
จะปรับโครงสรา้งตําแหน่งอา้งองิในสตูรใหก้ลายเป็นตําแหน่งอา้งองิขา้มชทีหรอืขา้มแฟ้มให ้
เองทันท ี 

วธิทีีѷ 3 นีѸเป็นเคล็ดลับสําคัญในการสรา้งสตูร link ขา้มแฟ้ม โดยเริѷมจากสรา้งสตูร link 
ทั Ѹงหมดในชทีเดยีวกนัใหเ้สร็จกอ่น จากนัѸนเมืѷอ Cut เซลลส์ตูรไปทีѷชทีอืѷนจะไดส้ตูร link 
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ขา้มชที หรอืถา้ Cut เซลลส์ตูรไปทีѷแฟ้มอืѷนจะไดส้ตูร link ขา้มแฟ้ม ชว่ยใหไ้มต่อ้งเสยี
แรงเสยีเวลาสรา้งสตูร link ขา้มชทีหรอืขา้มแฟ้มตั Ѹงแตแ่รกแมแ้ตน่อ้ย เชน่  

 จากเดมิสรา้งสตูร link ในชทีเดยีวกนัเป็น =A1  
 พอ Cut ไปทีѷชทีอืѷน สตูรนีѸจะปรับตัวใหมเ่ป็น =Sheet1!A1 
 พอ Cut ตอ่ไปทีѷแฟ้มอืѷน สตูรนีѸจะปรบัตัวใหมเ่ป็น =[Source.xlsx]Sheet1!A1 

โดยคําวา่ Source ก็คอืชืѷอแฟ้มตน้ทาง และคําวา่ Sheet1 คอืชืѷอชทีตน้ทาง 
 ตอ่มาถา้ปิดแฟ้มตน้ทางทีѷชืѷอ Source ทิѸง สตูรนีѸจะปรับตัวใหมเ่ป็น 

='D:\Dummy\[Source.xlsx]Sheet1'!A1 
ซึѷงการทีѷมชีืѷอ Drive D และชืѷอโฟลเดอรว์า่ Dummy แสดงไวด้า้นหนา้สตูร แสดง
วา่แฟ้มตน้ทางทีѷชืѷอ Source นัѸน ในขณะนัѸนถกูจัดเก็บไวท้ีѷใดแตย่ังไมไ่ดถ้กูเปิด
ขึѸนมา 

ขอ้ควรระวงัในการรกัษาสตูร link ขา้มแฟ้มใหใ้ชง้านไดถ้กูตอ้งตลอดไป 

1. หากตอ้งการทําการแกไ้ขใดๆในแฟ้มทีѷ link กนั ตอ้งเปิดแฟ้มทีѷ link กนัทกุแฟ้มขึѸนมา
ทั Ѹงแฟ้มตน้ทางและแฟ้มปลายทางกอ่นทีѷจะเริѷมทําการแกไ้ขเสมอ เพืѷอทําใหก้ารแกไ้ขทีѷ
เกดิขึѸน เชน่ การยา้ยตําแหน่งเซลล ์การเปลีѷยนชืѷอชทีหรอืแมแ้ตช่ืѷอแฟ้ม สง่ผลให ้Excel ไล่
แกตํ้าแหน่งอา้งองิในสตูร link ขา้มแฟ้มใหเ้อง (ถา้ตอ้งการให ้Excel ชว่ยจําวา่ตอ้งเปิด
แฟ้มใดบา้งพรอ้มกนั ใหใ้ชก้ารเปิดแฟ้ม Workspace ชว่ย ซึѷงจะอธบิายในภายหลัง) 

2. หากตอ้งการ Save as เพืѷอเปลีѷยนชืѷอแฟ้มหรอืยา้ยโฟลเดอรท์ ีѷเก็บ ใหทํ้าการ Save 
แฟ้มตน้ทางกอ่นแลว้จงึ Save แฟ้มปลายทางตามทหีลัง โดยการ Save ทีѷวา่นีѸใหใ้ช ้

โปรแกรม Excel เปิดแฟ้มแลว้ Save จากโปรแกรม Excel เทา่นัѸน เพืѷอทําให ้Excel ปรบั
ตําแหน่งอา้งองิในสตูรตามตําแหน่งของโฟลเดอรแ์ละชืѷอแฟ้มทีѷเปลีѷยนไป (ตา่งจากการใช ้
Windows Explorer ในการยา้ยโฟลเดอรห์รอืเปลีѷยนชืѷอแฟ้ม ซึѷงจะไมช่ว่ยใหส้ตูรมกีาร
แกไ้ขตําแหน่งอา้งองิตามแมแ้ตน่อ้ย) 

3. หากตอ้งการแกไ้ขตาํแหนง่อา้งองิเนืѷองจาก Excel เตอืนวา่คน้หา link ไมพ่บ อาจ
เป็นเพราะคณุพลัѸงเผลอไมไ่ดป้ฏบิัตติามขอ้ควรระวัง 2 ขอ้ขา้งตน้ ก็ยังสามารถแกไ้ขให ้link 
ทํางานตามเดมิไดต้ามขั Ѹนตอนตอ่ไปนีѸ โดย Excel จะไลแ่กไ้ขชืѷอแฟ้มตน้ทางในเซลลส์ตูร 
link ทกุเซลลใ์หเ้องไมว่า่อยูใ่นชทีใด 
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3.1. ใหเ้ปิดแฟ้มปลายทางขึѸนมากอ่นโดยไมต่อ้งเปิดแฟ้มตน้ทาง (แฟ้มปลายทางนีѸก็คอื
แฟ้มทีѷเปิดขึѸนมาแลว้พบวา่ Excel มคํีาเตอืนวา่หา link ไมพ่บ) 

3.2. ตรวจสอบวา่ไมม่ชีทีใดถกูสัѷง Protect Sheet เอาไว ้(เพราะถา้ชทีใดถกู Protect จะไม่
สามารถแกไ้ขสตูร link ทีѷมอียูใ่นชทีนัѸนไดเ้ลย แมจ้ะสัѷงผา่น Excel ก็ตาม) 

3.3. จากนัѸนใหใ้ชคํ้าสัѷง Data > Edit Links  
3.4. คลกิเลอืกชืѷอแฟ้มตน้ทางทีѷแสดงในชอ่งรายชืѷอ Source  
3.5. กดปุ่ ม Change Source แลว้คลกิไลห่าแฟ้มตน้ทางทีѷเก็บไวใ้นโฟลเดอรท์ีѷตอ้งการ 

 
4. เคล็ดอืѷนๆซึѷงสามารถนํามาใชร้ว่มกบัคําสัѷง Edit Links จากรปูขา้งตน้ 

4.1. ปุ่ ม Update Values ทําหนา้ทีѷ update ขอ้มลูจากแฟ้มตน้ทางทีѷเลอืกชืѷอไวจ้ากชอ่ง 
Source ชว่ยทําใหส้ามารถเปิดแฟ้มขึѸนมาโดยไมต่อ้ง update ในตอนเปิดแฟ้มก็ได ้
(เพราะหากสัѷง update ตอนเปิดแฟ้ม จะทําให ้Excel เสยีเวลาอยา่งมากในการไล ่
update แฟ้มตน้ทางทีѷมทีกุแฟ้ม) แลว้ตอ่เมืѷอตอ้งการดงึขอ้มลูใหมจ่ากแฟ้มตน้ทาง
เมืѷอใด จงึคอ่ยคลกิปุ่ ม Update Values นีѸทลีะแฟ้มทีѷตอ้งการ 

4.2. ปุ่ ม Open Source ทําหนา้ทีѷเปิดแฟ้มตน้ทาง ตามชืѷอแฟ้มทีѷเลอืกไวจ้ากชอ่ง Source  
4.3. ปุ่ ม Break Link ทําหนา้ทีѷทําลายสตูรทั Ѹงหมดในเซลลท์กุเซลลท์ีѷมสีตูร link ขา้มแฟ้ม

ใหก้ลายเป็นคา่ value หรอืผลลัพธ ์ซึѷงไมแ่นะนําใหใ้ชว้ธินีีѸเพราะ Excel จะทําลายสตูร 
link ในแฟ้มนัѸนทั Ѹงหมดโดยเราไมม่ทีางทราบไดเ้ลยวา่เป็นเซลลใ์ดบา้งและยังไม่
สามารถ Undo ดังนัѸนหากตอ้งการทําลายสตูร link ในเซลลใ์ด ใหค้น้หาตําแหน่งเซลล์
ทีѷมสีตูร link โดยใชช้ืѷอแฟ้มทีѷแสดงในชอ่ง Source สําหรับคน้หาตําแหน่งเซลลนั์Ѹน 
เพืѷอ Copy แลว้ Paste Special แบบ Value ทับเฉพาะเซลลนั์Ѹนๆจะเหมาะกวา่ 
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ระบบการรกัษาความปลอดภยั 
ในการ Link File  

แมว้า่ขนาดตารางในชทีของ Excel มจํีานวน 1,048,576 rows และ 16,384 columns ชว่ย
รองรับกบัขอ้มลูจํานวนมหาศาลมากขึѸนกวา่ Excel รุน่กอ่นก็ตาม แตม่ไิดทํ้าใหว้ธิบีันทกึขอ้มลูทีѷ
ถกูตอ้งตา่งไปจากทีѷควร กลา่วคอื ในแฟ้มหนึѷงๆควรเลอืกบนัทกึเฉพาะขอ้มลูทีѷจําเป็นตอ้ง
ใชง้านเรืѷองทีѷเก ีѷยวขอ้งกนัไวด้ว้ยกนัในชทีเดยีวกนัเทา่น ัҟน เชน่ แยกแฟ้มเก็บขอ้มลูการ
ขายในชว่งแตล่ะไตรมาสไวด้ว้ยกนั แฟ้มแรกเก็บขอ้มลูเดอืน 1-3 แฟ้มทสีองเก็บขอ้มลูเดอืน 4-
6 แฟ้มทีѷสามเก็บขอ้มลูเดอืน 7-9 และแฟ้มทีѷสีѷเก็บขอ้มลูเดอืน 10-12 จากนัѸนเมืѷอตอ้งการดงึ
ขอ้มลูของไตรมาสใดมาใช ้ใหส้รา้งสตูร link ขา้มแฟ้มนําขอ้มลูมาคํานวณ และใชคํ้าสัѷง 
Change Sources เพืѷอเปลีѷยนการ link จากแฟ้มเดมิไปยังแฟ้มอืѷนเพืѷอนําขอ้มลูชว่งไตรมาสทีѷ
ตอ้งการมาคํานวณโดยไมต่อ้งเสยีเวลาสรา้งสตูร link ใหมแ่ตอ่ยา่งใด 

ใน Excel 2010 เป็นตน้มา ไมไ่ดม้วีธิกีารสรา้งสตูร link หรอืมรีะบบการ Change Sources ตา่ง
ไปจาก Excel รุน่กอ่น แตใ่น Excel 2010 มรีะบบการรักษาความปลอดภัยในการใชข้อ้มลูทีѷ
เครง่ครัดกวา่รุน่กอ่นและสง่ผลทําให ้Excel 2010 แสดงอาการและมคํีาเตอืนตา่งไปจากเดมิเมืѷอ
มกีารเปิดแฟ้มทีѷ link กนั บทความนีѸจะทดสอบระบบการ link file ของ Excel 2010 โดยจําลอง
สถานการณ์ในแตล่ะขั Ѹนตอนมาใหศ้กึษาตั Ѹงแตเ่ริѷมตน้ยังไมม่ขีอ้มลู จวบจนสรา้งสตูร link และ
ทดลองปรับระบบการรักษาความปลอดภัยวา่จะสง่ผลตอ่คําเตอืนเรืѷองการ link อยา่งใดบา้ง 

ระบบความปลอดภัยใน Excel 2010 ทีѷจะนํามาทดสอบกบัระบบการ link เชน่ Trusted 
Location และ Trusted Document (เชญิ Download แฟ้มทีѷใชใ้นการทดสอบนีѸไดจ้าก 
www.ExcelExpertTraining.com/download/testlink.zip) 

1. เริѷมตน้จากทดสอบขนาดแฟ้มทีѷเปิดขึѸนมาโดยยังไมม่ขีอ้มลูอะไรเลย สัѷง Save แฟ้มตั Ѹง
ชืѷอวา่ Target.xlsx พบวา่มขีนาดแฟ้ม 8.18 KB 

2. ในแฟ้มชืѷอ Target นีѸ ทดลองพมิพคํ์าวา่ Operations ลงไปในเซลล ์B2 พบวา่ จากแฟ้ม
วา่งๆซึѷงมขีนาด 8.18 KBแฟ้มมขีนาดใหญข่ึѸนเล็กนอ้ยเป็น 8.55 KB พอพมิพต์ัวเลข 
20496 ลงไปในเซลล ์C2 แฟ้มมขีนาดใหญเ่พิѷมขึѸนเป็น 8.57 KB (แสดงวา่ขอ้มลูตัวเลข
ทําใหแ้ฟ้มมขีนาดใหญข่ึѸนชา้กวา่ขอ้มลูทีѷเป็นตัวอักษร) 
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3. สรา้งแฟ้มฐานขอ้มลูจํานวน 200 รายการ ชืѷอ Source.xlsx มขีนาด 19.1 KB 

 
4. ในแฟ้ม Target เซลล ์C2 เมืѷอสรา้งสตูร link เพืѷอหายอดรวมจากแฟ้ม Source ของ

รายการ Department ทีѷมชีืѷอ Operations วา่มยีอดของ Actual รวมเทา่กบั 20496 โดย
ใชส้ตูร Array {=SUM((Source.xlsx!DEPARTMENT=B2)*Source.xlsx!ACTUAL)} 
ทําใหแ้ฟ้ม Target มขีนาดเพิѷมขึѸนจาก 8.57 KB เป็น 12.5KB (แสดงวา่สตูรคํานวณทํา
ใหแ้ฟ้มมขีนาดเพิѷมขึѸนไดง้า่ยกวา่ขอ้มลูทีѷเป็นตัวเลขหรอืตัวอกัษร และการ link ขา้ม
แฟ้มทําใหเ้กดิ cache data ขึѸนในแฟ้มปลายทาง ทําใหแ้ฟ้มปลายทางมขีนาดใหญข่ึѸน
เป็นพเิศษจากการเก็บ cache data เอาไว)้ 

 
5. เมืѷอปิดแฟ้ม Source ซึѷงเป็นแฟ้มตน้ทาง ใหค้งเหลอืแฟ้มปลายทาง Target เปิดอยู่

เพยีงแฟ้มเดยีว พบวา่แฟ้ม Target ยงัคงมขีนาดเทา่เดมิเป็น 12.5 KB และเมืѷอเปลีѷยน
คําวา่ Operations เป็น Security หรอื R&D เพืѷอหายอดรวมของรายการ พบวา่สามารถ
หายอดรวมไดต้ามตอ้งการ โดยไมต่อ้งเปิดแฟ้ม Source และไมทํ่าใหข้นาดแฟ้ม 
Target เปลีѷยนแปลงแตอ่ยา่งใด (แสดงวา่ใชข้อ้มลูจาก cache data ทีѷเก็บไวใ้นแฟ้ม 
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Target) 

 
6. ตรวจสอบคําสัѷง File > Options > Advanced > พบวา่ระบบของ Excel กาชอ่ง Ask to 

update automatic links ไว ้

 
7. จากนัѸนทดลองปิดแฟ้ม Target แลว้เปิดแฟ้ม Target ขึѸนมาใหมเ่พยีงแฟ้มเดยีว ปรากฏ

แถบคําเตอืน Security Warning ตรงดา้นบนของจอเตอืนวา่ Automatic update of 
links has been disabled และเมืѷอคลกิลงไปทีѷขอ้ความคําเตอืนนีѸ จะเปิดหนา้ Info 
ขึѸนมาอธบิายวา่ The following content has been disabled: Workbook links  
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8. ทดลองยอ้นกลับไปทีѷ Home โดยยังไมไ่ด ้Enable Content แลว้ใชคํ้าวา่ R&D หายอด

รวมแทนคําวา่ Operations พบวา่สามารถหายอดรวมของ R&D ไดเ้ชน่เดมิ 
9. เมืѷอเปิดแฟ้ม Source ขึѸนมา พบวา่คําเตอืน Security Warning ในแฟ้ม Target หายไป 

แสดงวา่มกีาร Enable Content เพืѷอ Update Link ใหเ้องทันทเีมืѷอเปิดแฟ้มตน้ทางคูก่บั
แฟ้มปลายทาง 

10. ปิดแฟ้ม Target 
11. ในแฟ้ม Source ทดลองลบตัวเลข Actual ของ Department ทีѷเป็น Operations  ให ้

เหลอืเฉพาะรายการแรกซึѷงมคีา่เทา่กบั 2562 แลว้สัѷง Save แฟ้ม Source เก็บยอดใหมน่ีѸ
ไว ้เพืѷอทดสอบวา่ ถา้เปิดแฟ้ม Target ทีѷปิดไปกอ่นแลว้จะแสดงยอดรวมของ 
Operations เทา่กบัเทา่ใดเมืѷอเปิดแฟ้ม Target เพยีงแฟ้มเดยีว 

12. ปิดแฟ้ม Source แลว้เปิดแฟ้ม Target ขึѸนมาเพยีงแฟ้มเดยีวจะพบคําเตอืน Security 
Warning และยอดรวมของ Operations เทา่เดมิเชน่เดยีวกบัการทดลองในขอ้ 7-8 

13. คราวนีѸกดปุ่ ม Enable Content ทําใหคํ้าเตอืน Security Warning หายไปและไดย้อด 
Operations รวมเทา่กบั 2562 ตามยอดใหมท่ีѷเก็บไวใ้นแฟ้ม Source แสดงวา่การกดปุ่ ม 
Enable Content เป็นการสัѷงให ้Excel update cache data ในแฟ้ม Target ตามขอ้มลู
ใหมท่ีѷแกไ้ขและเก็บไวใ้นแฟ้ม Source 

14. ปิดแฟ้ม Target โดยไมต่อ้งสัѷง Save แลว้เปิดแฟ้ม Target ขึѸนมาอกีครั Ѹงหนึѷง ไมพ่บวา่ 
Excel 2010 เตอืน Security Warning และยอดรวมของ Operations แสดงตัวเลข
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เทา่กบั 2562 ทันท ีแสดงวา่เมืѷอเปิดเดมิแฟ้มซํѸาอกี Excel จะเปิดตามวธิทีีѷผูใ้ชเ้คยเปิด
ใหทั้นท ี

15. ตรวจสอบระบบของ Trust Center พบวา่ ระบบตามปกตขิอง Excel 2010 กําหนดใหใ้ช ้
Trusted Document ไวเ้ป็น default โดยไมไ่ดก้าชอ่ง Disable Trusted Documents 
เอาไวต้ั Ѹงแตแ่รกแลว้ ทําให ้Excel ถอืวา่แฟ้ม Target เป็นแฟ้มทีѷเชืѷอถอืไดเ้พราะคราว
กอ่นทีѷเปิดแฟ้มนีѸ ไดส้ัѷง Enable Content (Excel จะจําไวใ้หทั้ Ѹงๆทีѷไมไ่ดส้ัѷง save เก็บ
แฟ้ม Target ไวก้็ตาม) 

 
16. ตามภาพในขอ้ 15 ทดลองกดปุ่ ม Clear เพืѷอกําหนดใหท้กุแฟ้มทีѷเคยเปิดถอืวา่เป็นแฟ้ม

ทีѷไมเ่คยไวใ้จ แลว้เปิดแฟ้ม Target ขึѸนมาใหม ่พบวา่ Excel เตอืน Security Warning 
ตามการทดลองในขอ้ 7 ตามเดมิ 

17. ตามภาพในขอ้ 15 ทดลองกาชอ่ง Disable Trusted Documents เพืѷอเลกิใชร้ะบบ 
Trusted Document แลว้เปิดแฟ้ม Target ซํѸาหลายๆครั Ѹง พบวา่ Excel เตอืน Security 
Warning ตามขอ้ 7 ทกุครั Ѹงแมจ้ะกดปุ่ ม Enable Content แลว้สัѷง Save แฟ้ม Target 
บันทกึคา่ใหมท่ีѷ Update ไปแลว้ก็ตาม 

18. จากขอ้ 17 ซึѷงเลกิใชร้ะบบ Trusted Document ไปแลว้ ใหท้ดลองใช ้Trusted 
Locations โดยกําหนดใหโ้ฟลเดอรท์ีѷเก็บแฟ้ม Source และ Target เป็นโฟลเดอรท์ีѷ
ไวใ้จได ้พบวา่เมืѷอเปิดแฟ้ม Target จะไมม่กีารเตอืน Security Warning อกีตอ่ไป 

การทดลองขา้งตน้ทําใหต้อ้งเพิѷมความระมัดระวังในการใชแ้ฟ้ม Excel ทีѷ link กนัมากขึѸนกวา่แต่
กอ่น โดยเฉพาะอยา่งยิѷงการใชเ้ครืѷองคอมพวิเตอรแ์ละแฟ้มรว่มกนัหลายคน เพราะหากผูใ้ช ้
Excel คนใดคนหนึѷงเขา้ไปปรับแกร้ะบบการเตอืน Security Warning ของ Excel 2010 ใหต้า่ง
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ไปจากเดมิหรอืแตกตา่งจากทีѷเคยใชร้ว่มกนั ยอ่มสง่ผลใหผู้ใ้ช ้Excel คนอืѷนเกดิความสบัสนและ
นําขอ้มลูไปใชอ้ยา่งผดิพลาดขึѸนมาได ้

หากจําเป็นตอ้งใชเ้ครืѷองคอมพวิเตอรแ์ละแฟ้มรว่มกนัหลายคน ขอใหก้าชอ่ง Disable Trusted 
Documents เพืѷอเลกิใชร้ะบบ Trusted Document และหา้มกาํหนดโฟลเดอรใ์ดเป็น Trusted 
Locations ไวอ้ยา่งเด็ดขาด 

นอกจากนีѸเมืѷอทดลองตัดกาชอ่ง Ask to update automatic links ตามภาพในขอ้ 6 ทิѸง โดย
จัดระบบใหไ้มใ่ช ้Trusted Locations และไมใ่ช ้Trusted Document พบวา่ Excel 2010 จะ
ยังคงเตอืน Security Warning เสมอ ทําใหเ้ขา้ใจวา่คําสัѷง Ask to update automatic links นีѸ
ไมไ่ดส้ง่ผลตอ่การใชง้านใน Excel 2010 อกีตอ่ไป อาจยังคงมปีระโยชนก์บัแฟ้มทีѷสรา้งขึѸนจาก 
Excel 2003 หรอื Excel รุน่กอ่นหนา้นัѸนทีѷนํามาเปิดดว้ย Excel 2010 ก็เป็นได ้

ในกรณีทีѷไมต่อ้งการให ้Excel 2010 เตอืนเมืѷอเปิดแฟ้มทีѷ link กนั สามารถปรับระบบ Trust 
Center ของ External Content โดยเลอืกกาชอ่ง Enable automatic update for all 
Workbook Links (ซึѷงไมแ่นะนําใหใ้ช)้ แทนชอ่ง Prompt user on automatic update for 
Workbook links  
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หลกัการต ัҟงชืѷอและใชช้ืѷอใน Excel 

การตั Ѹงชืѷอและใชช้ืѷอเป็นหัวใจสําคัญของการนําตําแหน่งอา้งองิไปใชซ้ํѸา เนืѷองจากหากปราศจาก
การตั Ѹงชืѷอทีѷดขี ึѸนมาใชแ้ทนตําแหน่งอา้งองิของเซลลแ์ลว้ สตูรสั Ѹนๆทีѷดไูมม่พีษิภัยอะไร จะกลับ
กลายเป็นปัญหาอยา่งมาก ยิѷงใน Excel 2007 ขึѸนไปมพีืѸนทีѷตารางกวา่หมืѷน Column และลา้น
กวา่ Row จะทําให ้สตูร =JAN2009 ซึѷงเป็นสตูรทีѷนําคา่มาจากเซลลใ์น Column JAN ตัดกบั 
Row 2009 สามารถดผูาดๆและถกูตคีวามวา่เป็นคา่ของเดอืน Jan ปีค.ศ.2009 แทนก็เป็นได ้

หากสงัเกตขนาดของตัวอกัษรแตล่ะตัวในคําแตล่ะคําทีѷปรากฏในตาราง Excel จะพบวา่ ชืѷอใดๆ
ก็ตามทีѷเป็นชืѷอมาตรฐานของโปรแกรม Excel ซึѷงเราไมส่ามารถเขา้ไปแกไ้ขเปลีѷยนแปลงใหเ้ป็น
ชืѷออืѷน ไดถ้กูจัดใหใ้ชต้ัวอักษรตัวใหญทั่Ѹงหมด (เวน้ชืѷอคําสัѷงบน Ribbon หรอืเมนู) เชน่ ชืѷอ
ตําแหน่ง Column A B C D จนถงึ XFD (Excel 2003 ม ีColumn สดุทา้ยชืѷอ IV) และสตูร
สําเร็จรปูของ Excel ทกุสตูร เชน่สตูร SUM, MAX, MIN, VLOOKUP ลว้นใชต้ัวอกัษรตัวใหญ่
ทั Ѹงหมด ดังนัѸนแทนทีѷจะพรอ้มใจกนัตั Ѹงชืѷอแลว้ใชช้ืѷอทีѷเป็นตัวใหญทั่Ѹงหมดตามแบบของชืѷอของ 
Excel เราควรกําหนดหลักการตั Ѹงชืѷอและใชช้ืѷอทีѷสืѷอความหมายไดด้ขี ึѸนกวา่เดมิ ดังนีѸ 

1. หากแฟ้มใดจะถกูใชซ้ํѸา ขอใหต้ั Ѹงใจตั Ѹงชืѷอใหด้ ีเพืѷอทําใหไ้มว่า่ผูท้ีѷนําแฟ้มงานไปใชซ้ํѸานัѸนจะ
เป็นตัวคณุซึѷงเป็นผูส้รา้งแฟ้มนัѸนเองหรอืจะเป็นเพืѷอนทีѷเพิѷงเปิดใชแ้ฟ้มนัѸนเป็นครั Ѹงแรกก็ตาม 
จะไดส้ามารถเปิดแฟ้มดแูลว้สามารถไลท่ีѷไปทีѷมาของสตูรในเซลลไ์ดทั้นท ีแตถ่า้แฟ้มใดถกู
สรา้งขึѸนมาเพืѷอใชง้านงา่ยๆเพยีงครั Ѹงเดยีวแลว้ทิѸง ไมต่อ้งนํากลับมาใชอ้กี ก็ไมจํ่าเป็นตอ้งตั Ѹง
ชืѷอใหด้กี็ได ้

2. ชืѷอใดทีѷคณุตั ѸงขึѸนมาไมว่า่จะเป็นชืѷอชที ชืѷอแฟ้ม ชืѷอโฟลเดอร ์ชืѷอตําแหน่งเซลล ์(Range 
Name) ชืѷอสตูร (Formula Name) หรอืชืѷอทีѷตั Ѹงใหก้บัคา่คงทีѷ (Constant Name) ใหต้ั Ѹงชืѷอ
โดยใชต้ัวอกัษรตัวใหญผ่สมกบัตัวเล็กเสมอ 

3. เมืѷอใดทีѷตอ้งการสรา้งสตูรหรอือา้งถงึชืѷอใดๆก็ตาม ใหใ้ชต้ัวอกัษรตัวเล็กทั Ѹงหมดเทา่นัѸน 
เพราะเมืѷอพมิพล์งไปในเซลลแ์ลว้กดปุ่ ม Enter จะเกดิขอ้สงัเกตในตัวอกัษรของแตล่ะชืѷอ
ขึѸนมาทันทกีลา่วคอื 
3.1. ตัวอกัษรทีѷกลายเป็นตัวใหญทั่Ѹงหมด แสดงวา่เป็นชืѷอเฉพาะของ Excel 
3.2. ตัวอกัษรทีѷกลายเป็นตัวใหญผ่สมตัวเล็ก แสดงวา่เป็นชืѷอทีѷคณุตั Ѹงไว ้
3.3. ตัวอกัษรทีѷยังคงเป็นตัวเล็กทั Ѹงหมด แสดงวา่สะกดชืѷอผดิ ดังนัѸน Excel จงึไมย่อมรับชืѷอ

นัѸน ทําใหข้นาดตัวอกัษรไมเ่ปลีѷยนแปลงตาม 
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4. ชืѷอทีѷตั ѸงขึѸนควรใชต้ัวอกัษรตั Ѹงแต ่4 ตัวขึѸนไปเพืѷอมใิหซ้ํѸากบัชืѷอของ Column แตถ่า้
จําเป็นตอ้งตั Ѹงชืѷอทีѷมตีัวอักษร 2-3 ตัวก็ทําได ้เพราะการตั Ѹงชืѷอทีѷใชต้ัวอกัษรตัวใหญผ่สมตัว
เล็กจะชว่ยในการแยกแยะใหเ้ห็นไดช้ดัอยูแ่ลว้วา่ Jan2009 มไิดม้คีวามหมายเดยีวกบั 
JAN2009 ทีѷเป็นเซลลใ์น Column JAN ตัดกบั Row 2009 (ถา้ตอ้งการตั Ѹงชืѷอทีѷเป็นตัวอักษร
ตัวเดยีว ขอใหห้ลกีเลีѷยงตัว C และ R เพราะซํѸากบัตัวยอ่ของ Row และ Column) 

5. Excel จะไมย่อมรับชืѷอ Range Name ทีѷมกีารเวน้วรรค โดยหากสัѷงให ้Excel ใชข้อ้ความใน
เซลลต์ามขอบตารางมาเป็นชืѷอโดยอตัโนมัต ิจะถกูแกไ้ขเครืѷองหมายวรรคเป็นเครืѷองหมาย
ขดีลา่ง _ (Underscore) ใหเ้อง และ Excel จะไมย่อมรับชืѷอ Range Name ทีѷเป็นตัวเลข
ลว้นหรอืเป็นตัวเลขนําหนา้ตัวอกัษร 

6. แมจ้ะไมม่ขีอ้หา้มในการตั Ѹงชืѷอเป็นภาษาไทย แตก่็แนะนําใหต้ั Ѹงชืѷอเป็นภาษาองักฤษจะ
เหมาะสมกวา่ เพราะหากใช ้Excel version ภาษาองักฤษ เปิดแฟ้มทีѷมกีารใชช้ืѷอภาษาไทย 
จะอา่นชืѷอภาษาไทยไมอ่อก 

7. ในการตั Ѹงชืѷอชที หา้มตั Ѹงชืѷอวา่ History เนืѷองจากเป็นชืѷอทีѷ Excel สํารองไวใ้ชภ้ายใน 
8. ในการตั Ѹงชืѷอ Range Name หา้มตั Ѹงชืѷอวา่ Criteria หรอื Extract เพราะชืѷอ Criteria นีѸจะถกู

ลบทิѸงหรอืเปลีѷยนแปลงตําแหน่ง Extract จากเดมิไดเ้องทันททีีѷใชคํ้าสัѷง Advanced Filter 
9. หากตอ้งการไดร้ับความสะดวกจากคําสัѷง Data Form ใหต้ั Ѹงชืѷอตารางฐานขอ้มลูวา่ 

Database เพืѷอทําให ้Excel ดงึขอ้มลูมาใชใ้น Data Form ไดเ้องโดยทีѷคณุไมต่อ้งเลอืก
ตารางฐานขอ้มลูนัѸนไวก้อ่น 

10. โปรดเขา้ใจเพิѷมเตมิวา่ ในการเขยีนชืѷอสตูรและชืѷอตา่งๆทีѷใชใ้นการอบรมตลอดจนขอ้มลูบน
เว็บ www.ExcelExpertTraining.com นัѸน ใชว้ธิเีขยีนชืѷอโดยใชอ้กัษรตัวใหญผ่สมตัวเล็ก
เสมอ เพืѷอชว่ยในการอา่นใหส้ามารถแยกแตล่ะสว่นของคําไดง้า่ยขึѸน เชน่ VLookup, 
SumIF, SumProduct เป็นตน้ ซึѷงเมืѷอใดทีѷตอ้งการนําชืѷอไปใช ้ใหพ้มิพต์วัเล็กตลอดตาม
หลักการขา้งตน้ 
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การตั Ѹงชืѷอแบบทีѷตั Ѹงเอง สามารถใชช้อ่ง Name Box หรอืผา่นคําสัѷงบนเมนูซึѷงทําได ้2 วธิ ีคอื 

1. หากตอ้งการตั Ѹงชืѷอเดยีว ใหส้ัѷง Formulas > Define Name 
2. หากตอ้งการตั Ѹงชืѷอหลายชืѷอและสามารถยอ้นกลับมาแกไ้ขหรอืตั Ѹงชืѷออืѷนใหมอ่กีไดใ้นทันท ี

ใหส้ัѷงผา่น Formulas > Name Manager  

 
2.1. กดปุ่ ม New เพืѷอตั Ѹงชืѷอใหม ่หรอื 
2.2. กดปุ่ ม Edit เพืѷอแกไ้ขตําแหน่งอา้งองิในชืѷอ หรอื 
2.3. กดปุ่ ม Delete เพืѷอลบชืѷอทิѸง 

นอกจากนัѸน Excel 2007 เป็นตน้มา ไดป้รับปรงุระบบการตั Ѹงชืѷอใหส้นองตอบตอ่การใชง้านใน
ระดับ File Level หรอื Sheet Level ไดส้ะดวกกวา่แตก่อ่นมาก กลา่วคอื 

 

 การต ัҟงชืѷอเพืѷอใชใ้นระดบั File Level เป็นระบบมาตรฐานทีѷ Excel เลอืก Scope เป็น 
Workbook ไวใ้หต้ั Ѹงแตต่น้ เพืѷอทําใหช้ืѷอทีѷตั ѸงขึѸนในระดับนีѸสามารถนําไปใชร้ว่มกนัไดท้กุ
ชที 

 การต ัҟงชืѷอเพืѷอใชใ้นระดบั Sheet Level โดยคลกิเปลีѷยน Scope เป็นชืѷอชทีทีѷ
ตอ้งการ ทําใหช้ืѷอทีѷตั ѸงขึѸนในระดับชทีเป็นชืѷอทีѷใชใ้นชทีนัѸนและเป็นอสิระจากชทีอืѷน 
สง่ผลใหส้ามารถตั ѸงชืѷอซํѸากนัไดใ้นแฟ้มเดยีวกนั (น่าสงัเกตวา่เราสามารถกําหนด Scope 
ใหอ้ยูต่า่งชทีกบัชทีทีѷ Refers to ก็ยงัได)้ 
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การต ัҟงชืѷอ Constant Name 

Constant Name เป็นชืѷอทีѷตั Ѹงใหก้บัคา่คงทีѷ ซึѷงตามปกตใินการดําเนนิธรุกจิตอ้งเกีѷยวขอ้งกบั
คา่คงทีѷมากมาย นับตั Ѹงแต ่ชืѷอบรษัิท ทีѷอยู ่ชืѷอผูบ้รหิาร รหัสทีѷเป็นความลับ หมายเลขบัญช ี
ตัวเลขทางการเงนิตา่งๆ เชน่ อตัราดอกเบีѸย คา่เสืѷอมราคา ตัวเลขเงนิเดอืน ดังนัѸนแทนทีѷจะตอ้ง
บันทกึคา่เหลา่นีѸซํѸาลงไปในเซลลโ์ดยตรง นอกจากจะเสยีเวลาพมิพเ์องใหมท่กุครั Ѹงแลว้ ยังอาจ
พลัѸงเผลอบันทกึขอ้มลูตา่งไปจากเดมิ จงึขอแนะนําใหต้ั Ѹงชืѷอใหก้บัคา่คงทีѷทั Ѹงหมดทีѷม ีแทนทีѷ
จะตอ้งพมิพช์ืѷอยากๆยาวๆ ก็เพยีงพมิพช์ืѷอสั Ѹนๆทีѷจํางา่ยกวา่ และภายหลังหากมกีารเปลีѷยนแปลง
คา่ทีѷเคยคดิวา่คงทีѷ ก็ใหทํ้าการแกไ้ขคา่ทีѷกําหนดใหก้บัชืѷอทีѷเป็น Constant Name นีѸเพยีงครั Ѹง
เดยีว ก็จะสง่ผลใหท้กุเซลลท์ีѷนํา Constant Name ไปใชม้คีา่ใหมต่ามการแกไ้ขนัѸนไดทั้นท ี

สมมตวิา่ ตอ้งการตั Ѹงชืѷอ Constant Name วา่ “MyKey1” ใหม้คีา่เทา่กบัชืѷอ “Excel Expert 
Training” ใหเ้ริѷมจากพมิพช์ืѷอทีѷตอ้งการตั Ѹงลงไปในชอ่ง Name (โดยไมต่อ้งใสเ่ครืѷองหมาย
คําพดูปิดหัวทา้ยชืѷอ) จากนัѸนพมิพค์า่ทีѷตอ้งการลงไปในชอ่ง Refers to โดยตอ้งมเีครืѷองหมาย
เทา่กบันําหนา้เสมอและถา้มคีา่เป็นตัวอกัษรก็ตอ้งใสข่อ้ความไวร้ะหวา่งเครืѷองหมายคําพดูดว้ย
ตามนีѸ 

Name: MyKey1 

Refers to: =”Excel Expert Training” 

แตถ่า้ตอ้งการตั Ѹงชืѷอ Constant Name ใหม้คีา่เป็น
ตัวเลข ก็ไมต่อ้งใสเ่ครืѷองหมายคําพดู แตต่อ้งใส่

เครืѷองหมายเทา่กบันําหนา้เชน่กนัตามนีѸ 

Name: MyKey2 

Refers to: =23187021 

จากนัѸนเมืѷอตอ้งการนําชืѷอ Constant Name นีѸไปใชใ้นเซลล ์ใหพ้มิพ ์=mykey1 (สงัเกตวา่ถา้
พมิพเ์องใหพ้มิพด์ว้ยตัวเล็กตลอด) หรอืกดปุ่ ม F3 เพืѷอเปิดรายชืѷอทีѷตั Ѹงไวใ้นแฟ้มนัѸนขึѸนมาแสดง
บนจอ แลว้ใหด้ับเบิѸลคลกิทีѷชืѷอทีѷตอ้งการ (หรอืคลกิปุ่ ม OK) แลว้กดปุ่ ม Enter เพืѷอรับสตูร 
=MyKey1 ลงไปในเซลล ์จะไดคํ้าวา่ Excel Expert Training แสดงในเซลลนั์Ѹน 
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หมายเหต ุชืѷอทีѷเป็น Range Name หรอื Formula Name มขีั Ѹนตอนการใชช้ืѷอเหมอืนกบั
Constant Name เชน่กนั 

การต ัҟงชืѷอ Range Name 

Range Name เป็นชืѷอทีѷตั Ѹงใหก้บัเซลลเ์ดยีวหรอืพืѸนทีѷตาราง (ทีѷมพีืѸนทีѷตดิกนัหรอืไมต่ดิกนัก็ได)้ 
ซึѷงมวีธิตีั Ѹงชืѷอไดห้ลายวธิ ีดังนีѸ 

1. วธิใีช ้Name Box เป็นชอ่งดา้นซา้ยมอืของ Formula Bar วธินีีѸเป็นวธิตีั Ѹงชืѷอทีѷงา่ยทีѷสดุ แต่
ใชก้บัการตั Ѹงชืѷอไดอ้ยา่งเดยีว ไมส่ามารถใช ้Name Box เพืѷอแกไ้ขหรอืลบชืѷอทิѸง 

 
1.1. เริѷมจากคลกิเลอืกเซลลห์รอืตารางทีѷตอ้งการ (หากตอ้งการเลอืกเซลลท์ีѷไมต่ดิตอ่กนั ให ้

กดปุ่ ม Ctrl แลว้คลกิเลอืกพืѸนทีѷตารางทีѷตอ้งการไปเรืѷอยๆ) 
1.2. คลกิลกูศรดา้นขวาของชอ่ง Name Box แลว้พมิพช์ืѷอ Range Name ทีѷตอ้งการลงไป

ในชอ่ง Name Box ขอใหส้งัเกตวา่ พอพมิพต์ัวอกัษรทลีะตัวของชืѷอลงไป ชอ่ง Name 
Box จะเลืѷอนไปหาชืѷอเกา่ทีѷตั Ѹงไวก้อ่นแลว้เพืѷอคณุจะไดต้ั Ѹงชืѷอใหมท่ีѷไมซ่ํѸากบัชืѷอเดมิทีѷมี
อยูแ่ลว้ 

1.3. กดปุ่ ม Enter เพืѷอรับชืѷอลงไปในชอ่ง Name Box 
2. วธิใีชค้าํส ัѷง Formulas > Define Name หรอื Formulas > Name Manager โดย

กรอกชืѷอทีѷตอ้งการตั Ѹงลงไปในชอ่ง Name: แลว้คลกิลงไปในชอ่ง Refers to (โดยใหค้ลกิ
ตอ่ทา้ยตําแหน่งเดมิทีѷแสดงไวใ้นชอ่ง Refers to: นีѸ) จากนัѸนใหเ้ลอืกพืѸนทีѷตารางทีѷตอ้งการ
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แลว้กดปุ่ ม OK เพืѷอรับชืѷอ 

 
3. วธิใีชค้าํส ัѷง Formulas > Create from selection วธินีีѸชว่ยนําขอ้ความทีѷอยูข่อบ

ตารางมาตั Ѹงเป็นชืѷอใหก้บัพืѸนทีѷตารางในฝัѷงตรงขา้มกบัขอ้ความนัѸน เริѷมจากคลกิเลอืกพืѸนทีѷ
ตารางทีѷตอ้งการตั Ѹงชืѷอโดยใหเ้ลอืกรวมทัѸงพืѸนทีѷหัวตารางไวด้ว้ย จากนัѸนใชคํ้าสัѷง Formulas 
> Create from Selection จะพบหนา้จอตอ่ไปนีѸเปิดขึѸนมา ใหด้วูา่ตรงตามตอ้งการแลว้กด
ปุ่ ม OK เพืѷอรับชืѷอ 

 
Excel เลอืกชอ่ง Left column ไวใ้ห ้เนืѷองจาก Column ซา้ยสดุของพืѸนทีѷตารางทีѷเลอืกนัѸน
มตีัวอกัษรบันทกึไว ้โดย Excel จะตั ѸงชืѷอพืѸนทีѷตาราง C2:E2 วา่ Income และตั ѸงชืѷอพืѸนทีѷ
ตาราง C3:E3 วา่ Cost ตามขอ้ความใน Column ซา้ยสดุใหทั้นท ีทั ѸงนีѸขอใหเ้ขา้ใจดว้ยวา่ 
ชืѷอ Income และ Cost เป็นชืѷอทีѷ Excel ชว่ยตั Ѹงใหเ้พยีงครั Ѹงเดยีวตอนทีѷใชคํ้าสัѷง Create 
from selection นีѸเทา่นัѸน และจะยังคงใชช้ืѷอนีѸอยูโ่ดยไมเ่ปลีѷยนแปลงตามขอ้ความใน 
Column ซา้ยทีѷอาจมขีอ้ความตา่งไปจากเดมิแตอ่ยา่งใด 

หากตอ้งการขยายขอบเขตของ Range Name ใหใ้ชว้ธิกีาร Insert Row หรอื Insert Column 
หรอืใชว้ธิทีีѷ 2 หรอืวธิทีีѷ 3 ขา้งตน้เพืѷอเขา้ไปกําหนดขอบเขตพืѸนทีѷตารางใหมใ่หม้ขีนาดใหญข่ึѸน
ตามตอ้งการ 
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Range Name ทีѷตั ѸงขึѸน สามารถนําไปใชอ้า้งองิผา่นสตูรสําเร็จรปูของ Excel ไดทั้นท ีเชน่ หาก
ตอ้งการหายอดรวมของตัวเลขใน Range Name ชืѷอ Income ใหเ้ริѷมสรา้งสตูรตามลําดับ
ตอ่ไปนีѸ 

1. พมิพ ์=sum( 
2. กดปุ่ ม F3 เพืѷอแสดงรายชืѷอทีѷตั Ѹงไวใ้นแฟ้ม (ในกรณีทีѷตอ้งการนําชืѷอมาจากแฟ้มอืѷน ใหย้า้ย

ไปอยูใ่นแฟ้มทีѷมชีืѷอ Range Name ทีѷตอ้งการนัѸนกอ่นแลว้จงึกดปุ่ ม F3) 
3. ดับเบิѸลคลกิทีѷชืѷอ Income จะไดส้ตูร =sum(Income 
4. กดปุ่ ม Enter จะไดส้ตูร =SUM(Income)  

แตถ่า้นํา Range Name ไปใชอ้า้งองิโดยตรงโดยไมไ่ดใ้ชอ้า้งองิผา่นสตูรสําเร็จรปูของ Excel 
จะพบวา่หากตั Ѹงชืѷอใหก้บัตารางทีѷมเีซลลต์ั Ѹงแต ่2 เซลลข์ึѸนไป ชืѷอนัѸนจะนํามาใชไ้ดเ้ฉพาะในแนว
คูข่นานกบัแนวพืѸนทีѷตารางทีѷตั Ѹงชืѷอไวเ้ทา่นัѸน เชน่ หากตั Ѹงชืѷอตัวเลขหัวตารางในตําแหน่งจาก 
C2:F2 วา่ Top และตั Ѹงชืѷอตัวเลขขา้งตารางตําแหน่งจาก B3:B5 วา่ Left จะสง่ผลใหใ้ชส้ตูร 
=Top*Left คํานวณหาคําตอบไดเ้ฉพาะในขอบเขตตารางทีѷแนวคูข่นานของ Top ตัดกบั Left 
คอืพืѸนทีѷตารางตั Ѹงแต ่C3:F5 โดยสตูรนอกแนวคูข่นานจะไมคํ่านวณแตค่นืคา่เป็น Error 
#VALUE! 

 

ใน Excel 365 พอสรา้งสตูรลงไปในเซลล ์C3 แลว้กดปุ่ ม Enter จะพบวา่สตูรกะจายตวัลงไปใน
พืѸนทีѷ C3:F5 ใหเ้อง โดยไมต่อ้งเสยีเวลา copy ไปวางแตอ่ยา่งใด   
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วธิตี ัҟงชืѷอตาํแหนง่อา้งองิแบบไรข้อบเขตจํากดั 

ขอยอ้นนําตัวอยา่งการคํานวณทีѷตั Ѹงชืѷอหัวตารางดา้นบนวา่ Top มาคณูกบัหัวตารางดา้นซา้ยทีѷตั Ѹง
ชืѷอวา่ Left โดยใชส้ตูร =Top*Left มาวเิคราะหอ์ยา่งละเอยีดวา่ ดว้ยเหตใุดสตูร =Top*Left 
จงึสามารถคํานวณหาคําตอบไดเ้ฉพาะพืѸนทีѷตารางในสว่นทีѷตัดกนัของแนวคูข่นานของ Top ตัด
กบั Left เทา่นัѸน สว่นพืѸนทีѷตารางนอกขอบเขตแนวทีѷตัดกนัจะใหคํ้าตอบเป็น Error 

 

เมืѷอใชคํ้าสัѷง Formulas > Name Manager ยอ้นไปตรวจสอบตําแหน่งอา้งองิทีѷ Excel 
กําหนดใหก้บัตําแหน่งอา้งองิทีѷมชีืѷอวา่ Top กบั Left จะพบวา่ เป็นตําแหน่งอา้งองิแบบ 
Absolute โดยมเีครืѷองหมาย $ ควบคมุตําแหน่งทั Ѹงแนว Row และ Column ตามรปูตอ่ไปนีѸ 

 

 ตําแหน่งอา้งองิชืѷอ Top มตํีาแหน่งอา้งองิ Refers to: =Sheet1!$C$2:$F$2 
 ตําแหน่งอา้งองิชืѷอ Left มตํีาแหน่งอา้งองิ Refers to: =Sheet1!$B$3:$B$5 

ดว้ยสาเหตทุีѷตําแหน่งอา้งองิถกูควบคมุดว้ยเครืѷองหมาย $ ทั Ѹงแนว Row และ Column นีѷเองทีѷ
ทําใหเ้กดิการจํากดัขอบเขตใหใ้ชส้ตูรอา้งองิถงึชืѷอ Top กบั Left ไดเ้ฉพาะในแนวคูข่นาน 

ดังนัѸนหากคณุเขา้ใจถงึเหตแุละผลตามทีѷไปทีѷมาดังกลา่วขา้งตน้ จะสามารถเลอืกใชเ้ครืѷองหมาย 
$ ในการกําหนดขอบเขตแบบไมจํ่ากดัได ้โดยปรับตําแหน่งเครืѷองหมาย $ ตามหลักตอ่ไปนีѸ 
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 หากตอ้งการใหก้ําหนดตําแหน่งอา้งองิใหห้มายถงึ ทกุเซลลใ์นแนวนอน ใหใ้ช ้

ตําแหน่งอา้งองิจากเซลลเ์ดยีวตามแนวคูข่นานกบัเซลลท์ีѷจะใชช้ืѷอนัѸน และใส่

เครืѷองหมาย $ ควบคมุตาํแหนง่เฉพาะ Row เชน่ C$2 
 หากตอ้งการใหก้ําหนดตําแหน่งอา้งองิใหห้มายถงึ ทกุเซลลใ์นแนวต ัҟง ใหใ้ชตํ้าแหน่ง

อา้งองิจากเซลลเ์ดยีวตามแนวคูข่นานกบัเซลลท์ีѷจะใชช้ืѷอนัѸน และใสเ่ครืѷองหมาย $ 
ควบคมุตาํแหนง่เฉพาะ Column เชน่ $B3 

 หากตอ้งการใหก้ําหนดตําแหน่งอา้งองิใหห้มายถงึ ทกุแนว ใหใ้ชตํ้าแหน่งอา้งองิจาก
เซลลเ์ดยีวตามแนวคูข่นานกบัเซลลท์ีѷจะใชช้ืѷอนัѸน และไมใ่สเ่ครืѷองหมาย $  

 หากตอ้งการใหตํ้าแหน่งอา้งองิใชไ้ดก้บัทกุชที ก็ไมต่อ้งระบชุืѷอชทีนําหนา้ตําแหน่ง

อา้งองิแตต่อ้งทิѸงเครืѷองหมาย ! ไวด้ว้ยเพืѷอหมายถงึทกุชที เชน่ !I5 

เนืѷองจากตําแหน่งอา้งองิแบบทีѷไมไ่ดใ้ส ่$ แบบ Absolute นีѸ จะยา้ยตําแหน่งไปตามแนวคูข่นาน
กบัตําแหน่งเซลลส์ตูรทีѷใช ้ดังนัѸนกอ่นทีѷจะใชคํ้าสัѷง Formulas > Name Manager เขา้ไป
กําหนดตําแหน่ง คณุจะตอ้งเลอืกเซลลใ์นแนวเดยีวกบัเซลลท์ีѷอา้งถงึในชอ่ง Refers to: ไว ้
ลว่งหนา้เสมอ ตามรปูตัวอยา่งตอ่ไปนีѸ 

 

1. หากตอ้งการตั Ѹงชืѷอ TopRow และ LeftColumn (หรอืชืѷอใดก็ไดต้ามใจชอบ) ใหม้ี
ตําแหน่งอา้งองิทีѷหมายถงึทกุเซลลใ์น Row 2 และทกุเซลลใ์น Column B ตามลําดับ 
1.1. ใหค้ลกิเลอืกเซลล ์C3 ไวก้อ่นแลว้จงึสัѷง Formulas > Name Manager 
1.2. ตั Ѹงชืѷอ TopRow ใหม้ตํีาแหน่งอา้งองิ Refers to: =Sheet1!C$2 
1.3. ตั Ѹงชืѷอ LeftColumn ใหม้ตํีาแหน่งอา้งองิ Refers to: =Sheet1!$B3 

2. หากตอ้งการตั Ѹงชืѷอ Sum3Above (หรอืชืѷอใดก็ไดต้ามใจชอบ) ใหทํ้าหนา้ทีѷหายอดรวม
ของเซลล ์3 เซลลท์ีѷอยูเ่หนอืขึѸนไปจากเซลลท์ีѷใชช้ืѷอนีѸอยูโ่ดยเวน้เซลลท์ีѷตดิกบัเซลลส์ตูร 
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2.1. ใหค้ลกิเลอืกเซลล ์C13 ไวก้อ่นแลว้จงึสัѷง Formulas > Name Manager 
2.2. ตั Ѹงชืѷอ Sum3Above ใหม้ตํีาแหน่งอา้งองิ Refers to: =SUM(Sheet1!C9:C11) 

3. หากตอ้งการตั Ѹงชืѷอ Left2 (หรอืชืѷอใดก็ไดต้ามใจชอบ) ใหทํ้าหนา้ทีѷหาคา่จากเซลลท์ีѷอยู่
ดา้นซา้ยถัดไป 2 เซลลจ์ากเซลลท์ีѷใชช้ืѷอนีѸอยูแ่ละใหใ้ชก้บัทกุชทีไดด้ว้ย 
3.1. ใหค้ลกิเลอืกเซลล ์G10 ไวก้อ่นแลว้จงึสัѷง Formulas > Name Manager 
3.2. ตั Ѹงชืѷอ Left2 ใหม้ตํีาแหน่งอา้งองิ Refers to: =!E10 
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การต ัҟงชืѷอ Formula Name 

ในความเป็นจรงินัѸนทั Ѹง Constant Name หรอื Range Name ตา่งก็คอื Formula Name นัѷนเอง
เพราะในชอ่ง Refers to: ตอ้งใสเ่ครืѷองหมายเทา่กบัไวด้า้นหนา้คา่คงทีѷหรอืตําแหน่งอา้งองิไว ้
เสมอ จงึเทา่กบัวา่เป็นการตั Ѹงชืѷอใหก้บัสตูร เพยีงแตว่า่สตูรทีѷเป็น Constant Name กําหนดใหม้ี
คา่เป็นคา่คงทีѷ สว่น Range Name ไดก้ําหนดใหม้คีา่เทา่กบัคา่ทีѷเก็บไวใ้นตารางตามทีѷระบไุวใ้น
ชอ่ง Refers to: ซึѷงนอกจากจะอา้งถงึคา่คงทีѷหรอืตําแหน่งอา้งองิตามทีѷอธบิายผา่นไปแลว้ เรา
ยังสามารถใชช้อ่ง Refers to: ไดอ้กีหลายแบบ กลา่วคอื 

 ใชผ้สมกนัระหวา่งคา่คงทีѷและตําแหน่งอา้งองิ เชน่ =5*Top*Left โดยเลข 5 ถอืเป็น
คา่คงทีѷ สว่น Top กบั Left เป็นตําแหน่งอา้งองิ 

 ใชร้ว่มกบัสตูรสําเร็จรปูของ Excel เชน่ =SUM(Income) 
 ใชย้อ่สตูรยากๆยาวๆใหเ้ป็นชืѷอสั Ѹนๆเพยีงชืѷอเดยีว โดยทยอยนําชืѷอทีѷตั Ѹงไวม้าคํานวณใน

สตูรยาวๆทีѷคณุสรา้งขึѸน เชน่ แทนทีѷจะตั Ѹงชืѷอเดยีวใหก้บัสตูร 
=(5*Top*Left)+Sum(Income) ก็สามารถตั Ѹงชืѷอใหก้บัสตูรแตล่ะสว่นกอ่นแลว้จงึนําชืѷอ
มาใชต้อ่เป็น =MyVar1+MyVar2 โดยกําหนดใหต้ั Ѹงชืѷอ MyVar1 มคีา่ =5*Top*Left 
และตั Ѹงชืѷอ MyVar2 มคีา่ =SUM(Income) ไวก้อ่น 

 ใชก้ําหนดตําแหน่งอา้งองิแบบ Dynamic Range โดยใชส้ตูร Offset ชว่ยกําหนดขนาด
ตารางใหย้อ่หรอืขยายไดโ้ดยอตัโนมัตติามขนาดของขอ้มลู 

การเปลีѷยนตําแหน่งอา้งองิในสตูรทีѷมอียูก่อ่นใหก้ลายเป็นชืѷอทีѷตั ѸงขึѸนในภายหลัง 

 

สมมตวิา่สรา้งสตูร =C2-C3 เอาไวใ้นเซลล ์C4 เป็นตัวเลขกําไรขั Ѹนตน้ แลว้ Copy สตูรนีѸไปใช ้

ในเซลลต์ั Ѹงแต ่C4:E4 จากนัѸนตอ่มาไดต้ั Ѹงชืѷอ Income และ Cost เป็น Range Name ใหก้บั
พืѸนทีѷตารางตั Ѹงแต ่C2:E2 และ C3:E3 ตามลําดับ หากตอ้งการใหส้ตูรในเซลล ์C4:E4 เปลีѷยนไป
เป็นสตูร =Income-Cost ตามชืѷอทีѷตั ѸงขึѸนในภายหลัง ใหเ้ลอืกพืѸนทีѷ C4:E4 แลว้สัѷง Formulas 
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> Define Name > Apply Names แลว้เลอืกชืѷอ Income และ Cost (ซึѷง Excel มักจะ
เลอืกชืѷอทีѷเกีѷยวขอ้งกบัสตูรในพืѸนทีѷ C4:E4 ใหเ้อง) จากนัѸนกดปุ่ ม OK 

เคล็ดลบัอืѷนๆทีѷควรทราบเกีѷยวกบัชืѷอทีѷบอกตาํแหนง่ 

1. ชอ่ง Name Box แสดงไดเ้ฉพาะชืѷอ Range Name ทีѷอยูใ่นแฟ้มนัѸนเทา่นัѸน  
2. การคน้หาตําแหน่งเซลลห์รอืตารางทีѷตั Ѹงชืѷอไว ้ใหใ้ช ้Name Box หรอืกดปุ่ ม F5 เพืѷอเลอืก

ชืѷอทีѷแสดงไวห้รอืพมิพช์ืѷอทีѷทราบลงไปเองก็ได ้
3. หากตอ้งการ Copy ชืѷอตําแหน่งอา้งองิไปใชท้ีѷแฟ้มอืѷนใหม้ชีืѷอแบบเดยีวกนั ใหเ้ลอืก Copy 

พืѸนทีѷตารางทั Ѹงหมดทีѷเกีѷยวขอ้งและสตูรไปดว้ยกนั (ซึѷงหมายถงึ พืѸนทีѷตารางทีѷระบไุวใ้น
ตําแหน่งอา้งองิ และเซลลส์ตูรทีѷอา้งถงึชืѷอตําแหน่งอา้งองิซึѷงอยูใ่นพืѸนทีѷทีѷเลอืกนัѸนดว้ย) 
จากนัѸนให ้Paste ลงไปในแฟ้มใหมต่ามตาํแหนง่เดมิของพืѸนทีѷตารางทีѷ Copy มา แลว้จงึ
สัѷงยา้ยไปทีѷอืѷนในภายหลังตามตอ้งการ 

4. เซลลเ์ดยีวมชีืѷอไดห้ลายชืѷอ แตช่อ่ง Name Box แสดงชืѷอแรกทีѷตั Ѹงตามลําดับตัวอกัษร เชน่ 
เซลล ์A1 ตั Ѹงชืѷอ Range Name ไวห้ลายชืѷอทั Ѹง Income, Sales, และ Revenue จะพบวา่
เมืѷอคลกิเขา้ไปทีѷเซลล ์A1 ในชอ่ง Name Box จะแสดงวา่มชีืѷอวา่ Income เพราะตัวอกัษร I 
มากอ่นตัวอกัษร R หรอื S แตถ่า้ไลด่รูายชืѷอใน Name Box จะพบชืѷออืѷนแสดงไวด้ว้ย 

5. ตัวชืѷอ Range Name กบัตําแหน่งอา้งองิในชอ่ง Refers to: ไมจํ่าเป็นตอ้งอยูใ่นแฟ้ม
เดยีวกนัก็ได ้โดยเราสามารถตั Ѹงชืѷอไวใ้นแฟ้มหนึѷง แตก่ําหนดใหตํ้าแหน่ง Refers to: ไปอยู่
ในแฟ้มอืѷนได ้โดยใช ้Mouse คลกิเลอืกตําแหน่งตารางในแฟ้มอืѷนก็จะไดตํ้าแหน่งทีѷตอ้งการ
มาใสใ่นชอ่ง Refers to: ใหเ้อง 

6. หาก Cut ตารางทีѷตั Ѹงชืѷอ Range Name เอาไวไ้ปวางไวใ้นแฟ้มอืѷน จะทําใหต้ัวชืѷอ Range 
Name ยังอยูใ่นแฟ้มเดมิ แตตํ่าแหน่งอา้งองิในชอ่ง Refers to: จะยา้ยตามไปทีѷแฟ้มอืѷน 
และยังสง่ผลใหช้อ่ง Name Box ไมแ่สดงชืѷอ Range Name นัѸนอกีตอ่ไป (โดยยังคงดชูืѷอ
ทกุประเภทไดจ้ากคําสัѷง Formulas > Name Manager) 

7. หากตอ้งการหาคา่ ณ ตําแหน่งเซลลท์ีѷตัดกนัของตารางทีѷตั Ѹงชืѷอไว ้(Intersection) ใหใ้ช ้

สตูรทีѷมเีครืѷองหมายวรรคคัѷนระหวา่งชืѷอ เชน่ =Top Left จะไดค้า่จากเซลลท์ีѷทีѷตําแหน่งตัด
กนัของ Top ตัดกบั Left 

8. หากตอ้งการสรา้งสตูรทีѷอา้งถงึตําแหน่งอา้งองิในตารางโดยตรง โดยไมต่อ้งการใหส้ตูรทีѷ
เกดิขึѸนใชช้ืѷอ Range Name ใหเ้ริѷมจากเลอืกเซลลต์ั Ѹงแต ่2 เซลลข์ึѸนไปไวก้อ่นแลว้จงึพมิพ ์
= แลว้คลกิเลอืกเซลล ์จะไดส้ตูรทีѷมตํีาแหน่งอา้งองิโดยไมอ่า้งถงึชืѷอ Range Name 
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9. Formula Name ทีѷใชตํ้าแหน่งอา้งองิทีѷไมใ่ช ่Absolute Reference ในบางกรณีจะไม่
คํานวณตามคา่ตัวแปรทีѷเปลีѷยนไป ซึѷงแกไ้ขไดโ้ดยปรับสตูรใหคํ้านวณรว่มกบัสตูร Now() 
หรอื Today() เชน่ Sum3Above ใช ้Refers to: =SUM(Sheet1!C9:C11)*Now()/Now() 

10. ชืѷอทีѷตั Ѹงไวจ้ะถกูเก็บไวใ้นแฟ้มทีѷใชต้ั Ѹงชืѷอเทา่นัѸน หากตอ้งการทําใหแ้ฟ้มใหมม่ชีืѷอทีѷตั Ѹงไว ้
แบบเดยีวกบัแฟ้มเดมิ ให ้Copy เซลลส์ตูรทีѷใชช้ืѷอในการอา้งองิถงึตําแหน่งเซลลไ์ปพรอ้ม
กบัเซลลท์ีѷถกูตั Ѹงชืѷอไวไ้ปดว้ยกนั และในการสัѷง Paste ในแฟ้มใหม ่ตอ้ง Paste ลงไปใน
ตําแหน่งเดมิดว้ย จงึจะทําใหแ้ฟ้มใหมเ่กดิชืѷอและมตํีาแหน่งอา้งองิถกูตอ้งตามแฟ้มเดมิ 
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การใชส้ตูรปรบัตาํแหนง่อา้งองิ 

คําอธบิายจากนีѸไปจะมปีระโยชนต์อ่เมืѷอคณุมพีืѸนฐานมากอ่นแลว้วา่ตําแหน่งอา้งองิมปีระโยชน์
อยา่งไรและจะนําตําแหน่งอา้งองิไปใชซ้ํѸาโดยการ Copy หรอืโดยการตั Ѹงชืѷอตําแหน่งอา้งองิได ้
อยา่งไร ซึѷงการนําตําแหน่งอา้งองิไปใชซ้ํѸาตามวธิทีีѷใชก้นัโดยทัѷวไป คณุตอ้งเสยีแรงเสยีเวลา 
Copy หรอืตอ้งสรา้งสตูรใหมท่กุครั Ѹง จงึเป็นเรืѷองน่าคดิวา่จะมวีธิใีดบา้งทีѷจะทําใหตํ้าแหน่ง
อา้งองิเดมิทีѷมอียูป่รับตําแหน่งไดเ้องโดยคณุไมต่อ้งเขา้ไปยุง่เกีѷยวแกไ้ขสตูรใหมอ่กีเลย 

วธิที ีѷ 1 : ใชส้ตูร Indirect(“Text บอกตาํแหนง่”) แบบเซลลเ์ดยีว 

ลองนกึดซูวิา่ ถา้เดมิคณุสรา้งสตูรเพืѷอดงึคา่จากเซลล ์A1 มาใชด้ว้ยสตูร =A1 จากนัѸนหาก
ตอ้งการทําใหส้ตูรในเซลลเ์ดมินัѷนแหละ ดงึคา่จากเซลล ์A2 มาแทน จะทําไดอ้ยา่งไรโดยไม่
ตอ้งยอ้นกลับไปแกไ้ขสตูรใหเ้ปลีѷยนเป็น =A2 แตอ่ยา่งใด 

 

แทนทีѷจะสรา้งสตูรตรงๆลงไปวา่ =A1 คราวนีѸใหย้อมเปลอืงเซลลห์น่อย เริѷมจากใชเ้ซลล ์C4 
และ C5 เป็นเซลลร์ับตัวอกัษร a และเลข 1 ลงไปตามลําดับ จากนัѸนนําตัวอักษรกบัตัวเลขมาตอ่
กนัในเซลล ์C6 โดยใชส้ตูร =C4&C5 จะไดคํ้าวา่ a1 ซึѷงเป็น Text ทีѷบอกตําแหน่งตามแบบ
มาตรฐานของตําแหน่งอา้งองิใน Excel (ถา้อยากลัดขั Ѹนตอน จะใชเ้ซลล ์C6 สําหรับพมิพ์
ตําแหน่งเซลล ์a1 ลงไปเลยก็ได ้โดยไมต่อ้งเสยีเซลล ์C4 และ C5 เพืѷอแยกตําแหน่งแตล่ะสว่น
ไวก้อ่น) 

จากนัѸนเซลล ์C7 ใชส้ตูร =Indirect(C6) จะไดค้า่เป็นตัวเลข 11 ซึѷงเป็นคา่จากเซลล ์A1 นัѷนเอง 
ทนีีѸหากตอ้งการคา่จากเซลลใ์ด ใหใ้ชตํ้าแหน่งอา้งองิตามคา่ในเซลล ์C6 ซึѷงอาจเกดิจากการ
พมิพแ์ยกสว่นของตัวอกัษรและตัวเลขทีѷบอกตําแหน่ง Column และตําแหน่ง Row ลงไปใน
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เซลล ์C4 และ C5 หรอืจะใชว้ธิพีมิพตํ์าแหน่งเซลลท์ีѷตอ้งการลงไปเองโดยตรงในเซลล ์C6 เลย
ก็ได ้เชน่  

 ถา้พมิพคํ์าวา่ a2 ลงไปในเซลล ์C6 ก็จะไดคํ้าตอบในเซลล ์C7 เทา่กบัคา่จากเซลล ์a2 
 ถา้พมิพคํ์าวา่ a3 ลงไปในเซลล ์C6 ก็จะไดคํ้าตอบในเซลล ์C7 เทา่กบัคา่จากเซลล ์a3 
 ถา้พมิพคํ์าวา่ sheet3!a2 ลงไปในเซลล ์C6 ก็จะไดคํ้าตอบในเซลล ์C7 เทา่กบัคา่จาก

เซลล ์a2 แตค่ราวนีѸมาจากชทีชืѷอ Sheet3 เป็นสตูรดงึคา่ขา้มชทีตามชืѷอชทีทีѷตอ้งการ 

วธิที ีѷ 2 : ใชส้ตูร Indirect(“Text บอกตาํแหนง่”) แบบใชต้าํแหนง่
ขอบเขตตาราง 

วธินีีѸมหีลักการคลา้ยกบัวธิแีรกทีѷใชตํ้าแหน่งอา้งองิจากเซลลเ์ดยีว เพยีงแตตํ่าแหน่งอา้งองิแบบ
ขอบเขตตารางตอ้งอยูใ่นโครงสรา้งของ ตาํแหนง่เซลลต์น้ทาง:ตาํแหนง่เซลลป์ลายทาง 
เชน่ A1:A3 จากนัѸนจงึนําตําแหน่งอา้งองิทีѷไดไ้ปใชก้บัสตูร Indirect 

 

สมมตวิา่คณุตอ้งการหาผลรวมของตัวเลขในเซลล ์A1:A3 ซึѷงปกตติอ้งใชส้ตูร =Sum(A1:A3) 
ซึѷงสตูรนีѸยังไงๆก็จะหาผลรวมจากเซลล ์A1:A3 ไปตลอด แตถ่า้ตอ้งการใหห้ายอดรวมจากเซลล์
ใดก็ไดถ้งึเซลลใ์ดก็ไดล้ะ่ จะสรา้งสตูรอยา่งไรครั Ѹงเดยีวแลว้ไมต่อ้งแกไ้ขสตูรอกีเลยในภายหลัง 

จากภาพขา้งตน้ ม ีText ทีѷบอกตําแหน่งเซลลต์น้ทาง a1 ในเซลล ์C6 ตรงกบัตัวอยา่ง Indirect 
แบบเซลลเ์ดยีว เพยีงแตค่ราวนีѸใหใ้ชเ้ซลล ์E4, E5, และ E6 สําหรับสรา้ง Text ทีѷบอกตําแหน่ง
ของเซลลป์ลายทาง a3 

จากนัѸนใชเ้ซลล ์D8 นําตําแหน่งเซลลต์น้ทางมาเชืѷอมตอ่กบัเครืѷองหมาย : แลว้เชืѷอมตอ่กบั
ตําแหน่งเซลลป์ลายทางดว้ยสตูร =C6&”:”&E6 จะไดค้า่ a1:a3 
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หากตอ้งการหายอดรวมก็สามารถนํา Text ทีѷบอกตําแหน่งในเซลล ์D8 ไปใชร้ว่มกบัสตูร Sum 
และ Indirect เชน่ เซลล ์D9 ใชส้ตูร =Sum(Indirect(D8)) จะหายอดรวมตัวเลขจากตารางใน
ขอบเขตทีѷตอ้งการ 

นอกจากนีѸแทนทีѷจะนําคา่ในเซลล ์D8 ซึѷงมสีตูรเป็น =C6&”:”&E6 ไปใชต้อ่ในสตูร Sum เพืѷอ
หาผลรวม เรายังสามารถนําขอบเขตตําแหน่งอา้งองิทีѷไดน้ีѸไปใชใ้นสตูรอืѷนไดเ้ชน่เดยีวกนั 
เพยีงแตต่อ้งใชส้ตูร Indirect นําหนา้ตําแหน่งอา้งองิไวเ้สมอ เชน่ =Max(Indirect(D8)), 
=Min(Indirect(D8)), =Average(Indirect(D8)), =Index(Indirect(D8),2,1) เป็นตน้ 

ยิѷงกวา่นัѸนหากนําสตูร =$C$6&”:”&$E$6 หรอื =Indirect($C$6&”:”&$E$6) ไปตัѸงชืѷอเป็น 
Formula Name วา่ MyRange1 และ MyRange2 ตามลําดับ (หรอืชืѷออืѷนใดก็ได ้โดยตําแหน่ง
อา้งองิทีѷใชใ้น Formula Name ตอ้งกําหนดตําแหน่งแบบ Absolute จงึจะหาคา่ไดถ้กูตอ้ง) จะ
ชว่ยใหก้ารนําตําแหน่งอา้งองิไปใชต้อ่ไดส้ะดวกขึѸน เชน่ จากเดมิตอ้งใชส้ตูร 
=Sum(Indirect(D8)) ก็จะเทยีบเทา่กบัสตูร =Sum(Indirect(MyRange1)) หรอื 
=Sum(MyRange2) ซึѷงนอกเหนอืจากจะเป็นสตูรทีѷดดูกีวา่มากแลว้ยังไมข่ ึѸนกบัคา่ในเซลล ์D8 
ทีѷอาจถกูแกไ้ขอยา่งพลัѸงเผลอใหผ้ดิเพีѸยนไปในภายหลังไดอ้กีดว้ย 

วธิที ีѷ 3 : ใชส้ตูร Indirect(“Text บอกตาํแหนง่”) แบบใชช้ืѷอ Range 
Name 

 

ตัวอยา่งนีѸตา่งจากตัวอยา่งทีѷผา่นมาเพยีงแคนํ่าชืѷอ Range Name มาใชแ้ทนตําแหน่งอา้งองิ
โดยตรง เชน่ หากตั ѸงชืѷอพืѸนทีѷตาราง D3:D6 วา่ Chonburi และตั ѸงชืѷอพืѸนทีѷตาราง C4:E4 วา่ 
Year2 (ใหใ้ชคํ้าสัѷง Formulas > Create from selection เพืѷอตั ѸงชืѷอพืѸนทีѷตามคําทีѷอยูบ่น
ของตารางรวดเดยีว) 
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จากนัѸนใชเ้ซลล ์C9 และ C10 สําหรับพมิพช์ืѷอ Range Name ลงไป เชน่ พมิพคํ์าวา่ Chonburi 
และ Year2 ลงไปตามลําดับ 

 เซลล ์D9 หายอดรวมของ Chonburi ไดโ้ดยใชส้ตูร =Sum(Indirect(C9)) 
 เซลล ์D10 หายอดรวมของ Year2 ไดโ้ดยใชส้ตูร =Sum(Indirect(C10)) 
 เซลล ์E9 หาคา่ของ Chonburi ในปี Year2 ไดโ้ดยใชส้ตูรหาคา่แบบ Intersection 

=Indirect(C9) Indirect(C10) 

ขอ้ควรระวงัในการใชส้ตูร Indirect 

สตูรทกุสตูรของ Excel มทัี Ѹงขอ้ดแีละขอ้ดอ้ย สตูรบางสตูรทีѷพวกเราชอบใชเ้พราะเป็นสตูรทีѷ
เขยีนสั Ѹนๆ แตก่ลับทําให ้Excel ทํางานชา้ลงก็ม ี(เชน่ สตูร VLookup เป็นตน้) ซึѷงสตูร Indirect 
ก็มขีอ้ควรระวังอยูด่ว้ยกลา่วคอื สตูร Indirect สามารถ link ขอ้มลูขา้มแฟ้มได ้แตแ่ฟ้มตน้ทาง
ตอ้งเปิดขึѸนพรอ้มกบัแฟ้มปลายทางทีѷใชส้ตูรนีѸอยู ่และเป็นสตูรหนึѷงทีѷถอืเป็น Volatile Function 

Volatile Function เป็นชืѷอเรยีกประเภทของสตูร ทีѷจะทําการคํานวณใหมท่กุครั Ѹงตามการคํานวณ
ทีѷเกดิขึѸนในแฟ้ม ทั Ѹงๆทีѷเซลลส์ตูรนัѸนไมไ่ดม้ตํีาแหน่งอา้งองิทีѷสมัพันธก์บัเซลลอ์ืѷนมกีารคํานวณ
แมแ้ตน่อ้ย (ตามปกตสิตูรจะคํานวณใหมต่ามตอ่เมืѷอมเีซลลอ์ืѷนทีѷมตํีาแหน่งอา้งองิเกีѷยวขอ้งเกดิ
การคํานวณเทา่นัѸน) ดังนัѸนหากใชส้ตูรทีѷทําหนา้ทีѷแบบ Volatile นีѸมากไปจะทําใหแ้ฟ้มคํานวณ
ชา้ลง แตถ่า้มกีารใชส้ตูรเพยีงไมก่ีѷเซลลก์็ไมส่ง่ผลเทา่ใดนัก 

สตูรทีѷจัดเป็นประเภท Volatile Function ไดแ้ก ่สตูร Areas, Cell, Column, Columns, 
Indirect, Info, Now, Offset, Rand, Row, Rows, Today 

วธิที ีѷ 4 : ใชส้ตูรเพืѷอยา้ยตาํแหนง่อา้งองิโดยอตัโนมตั ิ

แมส้ตูร  Indirect ชว่ยทําใหส้ามารถเปลีѷยนตําแหน่งอา้งองิไดก้็ตาม แตค่ณุยังคงตอ้งเป็นผู ้
กําหนดตําแหน่งใหมล่งไปเองทกุครั Ѹง ซึѷง Excel ยังมสีตูรอืѷนอกีมากมายทีѷทําหนา้ทีѷเปลีѷยนยา้ย
ตําแหน่งอา้งองิไดเ้ชน่ทีѷสตูร Indirect ทําได ้แถมยังมคีวามสามารถเหนอืกวา่เพราะสามารถ
เปลีѷยนยา้ยตําแหน่งอา้งองิตามเงืѷอนไขทีѷกําหนดหรอืจะกําหนดใหเ้ปลีѷยนยา้ยตําแหน่งโดย
อตัโนมัตไิดอ้กีดว้ย 
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 สตูรทีѷสามารถเปลีѷยนยา้ยตําแหน่งอา้งองิตามเงืѷอนไขทีѷกําหนด เชน่ IF, Choose, 
Index, Offset 

 สตูรทีѷสามารถเปลีѷยนยา้ยตําแหน่งอา้งองิโดยอตัโนมัต ิเชน่ VLookup, Match ทีѷ
นํามาใชร้ว่มกบัสตูร Index หรอื Offset, Address ทีѷนํามาใชร้ว่มกบัสตูร Indirect 
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การกาํหนดตาํแหนง่อา้งองิแบบวงกลม 
(Circular Reference) 

เมืѷอแรกเห็นชืѷอการกําหนดตําแหน่งอา้งองิแบบวงกลมน่าจะทําใหค้ดิไปวา่เป็นชืѷอเรยีกทีѷน่ารักด ี
แตเ่มืѷอใดทีѷเกดิการกําหนดตําแหน่งอา้งองิแบบวงกลมขึѸน เมืѷอนัѸนแฟ้มงานของคณุจะเขา้ขา่ย
เสีѷยงทเีดยีววา่จะใชแ้ฟ้มนัѸนตอ่ไปไดห้รอืไม ่เพราะตําแหน่งอา้งองิแบบวงกลมอาจเกดิขึѸนโดย
ไมต่ั Ѹงใจโดยไมรู่ต้ัว หรอืเกดิขึѸนอยา่งเจตนาใหม้ันเกดิขึѸนก็ได ้ซึѷงถา้ใครทีѷใช ้Excel เป็นประจํา
ทกุวัน น่าจะเคยเจอคําเตอืนตอ่ไปนีѸแสดงขึѸนบนหนา้จอมาแลว้บา้ง 

 

“การกําหนดตําแหน่งอา้งองิแบบวงกลมอาจจะทําให ้Excel คํานวณผดิพลาด” นีѷเป็นประเด็น
สําคัญของคําเตอืนทีѷแสดงขึѸนบนจอ  

ทีѷน่ากลัวทีѷสดุก็คอืคนบางคนทีѷใช ้Excel มานาน แตอ่าจไมเ่คยพบคําเตอืนตามหนา้จอขา้งบนนีѸ
เปิดขึѸนมาแสดงสกัครั Ѹงเดยีว ซึѷงเป็นไปไดน้อ้ยมากทีѷผูใ้ช ้Excel ไมเ่คยพลัѸงเผลอสรา้งสตูรผดิ
แบบ Circular มากอ่น แตอ่าจเป็นไปไดว้า่ตัวเองไดส้รา้งสตูรแบบ Circular Reference นีѸมา
กอ่นแลว้ เพยีงแตว่า่เขาเหลา่นัѸนสัѷงให ้Excel เลกิเตอืน โดยเฉพาะแฟ้มงานทีѷเป็นมรดกตกทอด
ใชต้อ่กนัมาหลายตอ่หลายรุน่ พอเปิดแฟ้มเขา้ไปแกไ้ขสตูรหรอืโยกยา้ยเซลลท์ีѷรุน่พีѷเขาสรา้งไว ้
โดยไมรู่จั้กทีѷไปทีѷมาของสตูรในเซลลเ์หลา่นัѸน ก็อาจทําใหเ้กดิ Circular Reference ไดทั้นท ี

ตัวอยา่งการสรา้งสตูรทีѷมตํีาแหน่งอา้งองิแบบวงกลมทีѷงา่ยทีѷสดุ เชน่ ในเซลล ์A1 สรา้งสตูร 
=A1 ลงไป หรอืในเซลล ์B3 สรา้งสตูร = B1+B2+B3 ลงไป หรอืสงัเกตงา่ยๆวา่สตูรในเซลล์
ใดมตํีาแหน่งอา้งองิทีѷระบถุงึเซลลนั์Ѹนเองอยูด่ว้ย ซึѷงนอกจากนีѸหากมสีตูรทีѷ link ตอ่ๆกนัไป
หลายๆเซลลแ์ลว้กลับสง่คา่กลับมาในเซลลใ์ดเซลลห์นึѷงในวงจรของเซลลท์ีѷ link กนั เชน่ 
เซลล ์A1 มสีตูร =A3 และเซลล ์A2 มสีตูร =A1 แลว้เซลล ์A3 มสีตูร =A2 ยอ่มทําใหเ้กดิ 
ตําแหน่งอา้งองิแบบวงกลมไดเ้ชน่กนั ซึѷงเรยีกอกีแบบหนึѷงวา่เกดิการคํานวณแบบวงกลม 
(Circular Calculation) 
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ในการดําเนนิงานทางธรุกจิ มงีานหลายประเภทซึѷงอาจมเีงืѷอนไขทีѷจําเป็นตอ้งสรา้งสตูรทีѷมกีาร
กําหนดตําแหน่งอา้งองิแบบวงกลม อาทเิชน่ 

 ในเงืѷอนไขการคํานวณตน้ทนุสนิคา้ ซึѷงนําคา่ใชจ้า่ยทั Ѹงทางตรงและทางออ้มมา allocate 
เป็นตน้ทนุของสนิคา้ จากนัѸนหากสนิคา้นัѸนกลับไปใชเ้ป็นวัตถดุบิใหก้บัสนิคา้อืѷน แลว้
สดุทา้ยก็นําสนิคา้อืѷนนัѸนมาใชเ้ป็นองคป์ระกอบรว่มกบัสนิคา้เดมิอกี 

 หากบรษัิทรับจา่ยภาษีเงนิไดบ้คุคลธรรมดาแทนพนักงาน ซึѷงตามกฎเกณฑท์างภาษี
อากรกําหนดใหนํ้าภาษีทีѷจา่ยแทนนัѸนนํามาบวกเป็นเงนิไดเ้พิѷม แลว้เงนิไดร้วมทีѷเพิѷมขึѸนนีѸ
ก็ตอ้งนํากลับไปยอ้นคดิภาษีเงนิไดอ้กี 

 คา่ใชจ้า่ยบางรายการ อาจมขีอ้กําหนดทางภาษีวา่หา้มนํามาหักภาษีซํѸาอกี แตค่า่ใชจ้า่ย
นัѸนกลับมฐีานการคํานวณทีѷเกดิขึѸนจากกําไรสทุธ ิ

 ในกรณีของการกูเ้งนิ ถา้บรษัิทนําดอกเบีѸยจา่ยเงนิกูไ้ปเพิѷมยอดเงนิทีѷตอ้งกูเ้พิѷม ยอ่มทํา
ใหต้อ้งจา่ยดอกเบีѸยเพิѷมและทําใหต้อ้งกูเ้พิѷม 

 การของบประมาณคา่ใชจ้า่ยทีѷกําหนดวา่จะใหต้ามอตัรารอ้ยละของกําไร ซึѷงถา้กําไรเพิѷม
ก็จะทําใหไ้ดง้บประมาณคา่ใชจ้า่ยเพิѷม แตค่า่ใชจ้า่ยทีѷเพิѷมขึѸน ยอ่มสง่ผลใหก้ําไรลด 
และทําใหไ้ดง้บประมาณคา่ใชจ้า่ยลดลงตาม ซึѷงกลับทําใหก้ําไรเพิѷมขึѸน 

 งานคํานวณอืѷนๆ เชน่ การควบคมุให ้Excel เพิѷมคา่ตัวเลขครั Ѹงละเทา่ๆกนั โดยสรา้งสตูร 
=Number+A1 ลงไปในเซลล ์A1 หรอืการบันทกึประวัตติัวเลขสงูสดุ โดยสรา้งสตูร 
=Max(A1,NumberRange) ลงไปในเซลล ์A1 

หมายเหต ุแทนทีѷจะใชส้ตูรทีѷมตํีาแหน่งอา้งองิแบบวงกลม ซึѷงทําใหแ้ฟ้มนัѸนมรีะบบการคํานวณ
แบบพเิศษทีѷตอ้งสัѷงให ้Excel ยอมรับกอ่นจงึจะคํานวณไดคํ้าตอบถกูตอ้ง เราสามารถใชคํ้าสัѷง
อืѷนทีѷทําหนา้ทีѷสัѷงให ้Excel คํานวณซํѸาได ้เชน่ Goal Seek หรอืใช ้Solver Add-in หรอืใชคํ้าสัѷง
จาก Visual Basic ควบคมุการคํานวณแทน 
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ข ัҟนตอนการสรา้งสตูรคาํนวณแบบ Circular Reference 

1. ใหเ้ลอืกสรา้งสตูรอืѷนๆทีѷคํานวณตามปกตทิกุสตูร (ทีѷไมต่อ้งใชก้ารคํานวณแบบ Circular 
Reference) ใหเ้สร็จกอ่น แลว้จงึสรา้งสตูรทีѷตอ้งคํานวณแบบ Circular Reference เป็นสตูร
สดุทา้ย เนืѷองจากหากตอ้งการให ้Excel คํานวณแบบ Circular เมืѷอใด คณุจะตอ้งสัѷงให ้
Excel เลกิเปิดคําเตอืน ซึѷงหากมกีารสรา้งสตูรผดิพลาดเผลอไปสรา้งสตูร Circular 
Reference ขึѸนโดยไมเ่จตนา ก็ยอ่มไมม่กีารเตอืนใหท้ราบ 

2. เมืѷอสรา้งสตูรคํานวณแบบ Circular Reference แลว้กดปุ่ ม Cancel เพืѷอปิดคําเตอืนบน
หนา้จอตามรปูขา้งตน้แลว้ จะพบคําวา่ Circular References: ตอ่ดว้ยตําแหน่งเซลลแ์สดง
ขึѸนตรงขอบดา้นลา่งซา้ยของจอ พรอ้มทัѸงในพืѸนทีѷตารางก็จะมเีสน้ลกูศรสนํีѸาเงนิชีѸตําแหน่ง
เซลลท์ีѷทําใหเ้กดิการอา้งองิแบบวงกลม ซึѷงหากตอ้งการให ้Excel แสดงชืѷอตําแหน่งเซลลท์ีѷ
เกีѷยวขอ้งกบัการอา้งองิแบบวงกลมดว้ย ใหส้ัѷง Formulas > Error Checking > 
Circular References แลว้จะพบตําแหน่งเซลลท์ีѷเกีѷยวขอ้งปรากฏตอ่ทา้ยคําสัѷงนีѸ 

 
3. เมืѷอตอ้งการให ้Excel ยอมรับการคํานวณแบบ Circular Reference ใหส้ัѷง File > Options 

> Formulas > กาชอ่ง Enable iterative calculation 
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4. ชอ่ง Maximum Iterations และชอ่ง Maximum Change นัѸนไมจํ่าเป็นตอ้งเขา้ไปแกไ้ข
ตัวเลขใดๆ ซึѷง 2 ชอ่งนีѸทําหนา้ทีѷสัѷงให ้Excel คํานวณสงูสดุถงึ 100 ครั Ѹง หรอือาจไมถ่งึ 100 
ครั Ѹงก็ไดโ้ดยใหคํ้านวณจนกวา่จะพบวา่ คําตอบทีѷคํานวณไดใ้นแตล่ะรอบใหค้า่แตกตา่งกนั
นอ้ยกวา่ .001 ก็จะหยดุคํานวณ ซึѷงการคํานวณเป็นรอบดังกลา่วนีѸจะเกดิขึѸนทันททีีѷมกีาร
สรา้งสตูรนัѸนเสร็จแลว้กดปุ่ ม Enter รบัสตูรลงไปหรอืเมืѷอมกีารกดปุ่ ม F9 เพืѷอสัѷงให ้Excel 
คํานวณ 
4.1. ใหเ้พิѷมตัวเลขจํานวนรอบสงูสดุในชอ่ง Maximum Iterations เมืѷอพบวา่ทกุครั Ѹงทีѷกดปุ่ ม 

F9 เพืѷอสัѷงคํานวณ จะไดต้ัวเลขคําตอบตา่งจากเดมิไปเสมอ ซึѷงหากเพิѷมตัวเลขในชอ่งนีѸ
แลว้กดปุ่ ม F9 พบวา่ตัวเลขผลจากการคํานวณไมเ่ปลีѷยนแปลงตอ่ไปอกี ยอ่มแสดงวา่
ไดคํ้าตอบสดุทา้ยแลว้ 

4.2. ใหป้รับตัวเลขคา่ความละเอยีดในชอ่ง Maximum Change ตอ่เมืѷอตอ้งการให ้Excel 
คํานวณละเอยีดขึѸน ซึѷงยอ่มทําใหต้อ้งใชจํ้านวนครั Ѹงในชอ่ง Maximum Iterations 
เพิѷมขึѸนตามไปดว้ย 

5. หลังจากสัѷงคําสัѷงตามขอ้ 3 แลว้ จะไมพ่บขอ้ความหรอืตําแหน่งเซลลท์ีѷ
แสดงบนหนา้จอตามตําแหน่งตา่งๆทีѷเคยแสดงไวต้ามขอ้ 2 อกีตอ่ไป แต่
จะพบคําวา่ Calculate แสดงคา้งอยูต่รงขอบจอดา้นลา่งซา้ยของโปรแกรม Excel แทน และ
ขอใหส้งัเกตวา่ทกุครั Ѹงทีѷกดปุ่ ม F9 จะทําใหคํ้าวา่ Calculate นีѸหายไปชัѷวขณะหนึѷงแลว้
กลับมาแสดงใหม ่(โดยไมเ่กีѷยวขอ้งกบัการสัѷงใหคํ้านวณแบบ Manual ทีѷจะมคํีาวา่ 
Calculate แสดงขึѸนมาเชน่กนั แตเ่มืѷอกดปุ่ ม F9 เพืѷอสัѷงคํานวณแบบ Manual จะทําใหคํ้าวา่ 
Calculate หายไปโดยไมก่ลับมาใหมอ่กี) 

6. ในกรณีทีѷตอ้งการตรวจสอบทีѷไปทีѷมาของสตูรทีѷมกีารใชตํ้าแหน่งอา้งองิแบบวงกลมวา่มี
เซลลใ์ดทีѷเกีѷยวขอ้งบา้ง ใหย้อ้นกลับไปตดักาชอ่ง Enable iterative calculation ทิҟง
ไป จากนัѸน Excel จะแสดงตําแหน่งเซลลท์ีѷเกีѷยวขอ้งไวท้ีѷคําสัѷง Formulas > Error 
Checking > Circular References ซึѷงเซลลเ์หลา่นัѸนอาจจะเป็นเซลลส์ตูรทีѷสรา้งไว ้
อยา่งตั Ѹงใจหรอืเผลอแกไ้ขสตูรใหต้า่งจากเดมิไปจนทําใหเ้กดิ Circular reference ขึѸนก็ได ้
จากนัѸนใหท้ยอยลบสตูรในเซลลด์ังกลา่วทิѸงไปทลีะเซลล ์จนกวา่จะพบวา่เมืѷอลบสตูรใน
เซลลใ์ดเสร็จแลว้ ทําใหไ้มเ่กดิคําเตอืน Circular ตอ่ไปอกี หลังจากนัѸนจงึไลส่รา้งสตูรใหม่
ขึѸนมาแทน ซึѷงหลายๆครั Ѹงจะพบวา่ตอ้งไลล่บสตูรในเซลลท์ิѸงแลว้ตอ้งสรา้งสตูรใหมนั่บรอ้ย
นับพันเซลลท์เีดยีว โดยเฉพาะตารางคํานวณทีѷตอ้งคํานวณรายการรายวันหรอืรายเดอืนตอ่
กนัไปเป็นตารางขนาดใหญ ่ดังนัѸนผูใ้ช ้Excel ทกุคนตอ้งรูต้ัวทันทเีมืѷอตัวเองเผลอสรา้งสตูร
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ทีѷมตํีาแหน่งอา้งองิแบบวงกลมขึѸนมาเป็นครั Ѹงแรก หากปลอ่ยไวก้็จะตอ้งเสยีแรงเสยีเวลาไล่
ยอ้นมาแกไ้ขกนัใหมท่ลีะเซลล ์

7. เซลลท์ีѷทําใหเ้กดิ Circular นีѸ ควรใสส่ใีหต้า่งจากเซลลอ์ืѷน หรอืทําเครืѷองหมายพเิศษ หรอื
เขยีนอธบิายกํากบัไวด้ว้ยเพืѷอเตอืนผูใ้ชง้านใหแ้กไ้ขสตูรอยา่งระมัดระวัง 

8. ควรตั Ѹงชืѷอแฟ้มทีѷมสีตูรทีѷมตํีาแหน่งอา้งองิแบบวงกลมใหม้ชีืѷอทีѷสะดดุตา จะไดไ้มเ่ผลอเปิด
แฟ้มทีѷตอ้งคํานวณแบบ Iterations นีѸข ึѸนมาใชง้านพรอ้มกบัแฟ้มอืѷน เพราะแฟ้มอืѷนๆจะรับ
คําสัѷง Iterations นีѸตามไปดว้ยโดยไมจํ่าเป็น 

9. หากปิดโปรแกรม Excel แลว้เปิด Excel ขึѸนมาใหม ่จะพบวา่ Excel ตัดกาชอ่ง Enable 
iterative calculation ทิѸงไปใหเ้สมอ 

เคล็ดลบัอืѷนๆเกีѷยวกบัการใชต้ําแหนง่อา้งองิ 

1. ในกรณีตอ้งการหายอดรวมทกุชทีจากตําแหน่งเซลลเ์ดยีวกนั ใหส้รา้งสตูรหายอดรวมแบบ 
3 มติ ิซ ึѷงจะอยูใ่นโครงสรา้งสตูร =SUM(ชืѷอชทีแรก:ชืѷอชทีสดุทา้ย!ตําแหน่งเซลล)์ เชน่ 
=SUM(Sheet1:Sheet3!A1) ทําหนา้ทีѷหายอดรวมของเซลล ์A1 ทีѷอยูใ่นชที Sheet1 ถงึ 
Sheet3 ดังนัѸนหากตอ้งการใหร้วมขอ้มลูจากชทีใด ใหย้า้ยชทีนัѸนไปวางไวร้ะหวา่ง Sheet1 
ถงึ Sheet3 
1.1. ใหเ้ลอืกเซลลคํ์าตอบ พมิพ ์=sum( 
1.2. คลกิเซลลใ์นชทีแรกทีѷตอ้งการ 
1.3. กดปุ่ ม Shift คา้งไวแ้ลว้คลกิชทีสดุทา้ยทีѷตอ้งการ 
1.4. กดปุ่ ม Enter 

2. หากตอ้งการหายอดรวมจากทกุชทีเวน้ชทีทีѷสรา้งสตูรนีѸลงไป ใหพ้มิพส์ตูร =SUM('*'!
ตําแหน่งเซลล)์ เชน่ เมืѷอสรา้งสตูร =SUM('*'!A1) ลงไปในชที Sheet1 จะไดส้ตูร 
=SUM(Sheet2:Sheet3!A1) 

3. ในกรณีทีѷตอ้งการปรับโครงสรา้งของตารางในชทีหนึѷงๆใหเ้ป็นหลายแบบ โดยไมจํ่าเป็นตอ้ง
สรา้งชทีใหมส่ําหรับโครงสรา้งตารางแตล่ะแบบ แตใ่หป้รับโครงสรา้งในชทีเดมิชทีเดยีวนัѸน
แลว้สัѷงให ้Excel จดจําโครงสรา้งหนา้ตาตารางโดยสัѷง 
View > Custom Views > Add จากนัѸนใหต้ั Ѹงชืѷอ
หนา้ตาโครงสรา้งตารางนัѸนลงไป แลว้เมืѷอใดทีѷตอ้งการ
แสดงหนา้ตาตารางชืѷอใดใหส้ัѷง View > Custom 
Views แลว้เลอืกชืѷอ View ทีѷเคยตั Ѹงชืѷอไว ้(วธินีีѸสามารถตั Ѹงชืѷอ View ขา้มชทีไดด้ว้ย ทําให ้
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ไมต่อ้งพึѷงชืѷอชที แถมยังชว่ยปรับ Print settings และ Filter settings ตามแบบทีѷกําหนดไว ้
ในขณะทีѷตั Ѹงชืѷอใหทั้นท)ี 

4. ขอใหอ้อกแบบชทีทกุชทีทีѷเก็บขอ้มลูประเภทเดยีวกนัไวใ้หใ้ชตํ้าแหน่งเซลลเ์ดยีวกนัของ
ทกุชที โดยไมต่อ้งคํานงึวา่บางชทีจะมขีอ้มลูครบหรอืไม ่จากนัѸนใหส้ัѷง Hide รายการทีѷไมม่ี
ขอ้มลูนัѸนออกไป และใหใ้ช ้Custom View ชว่ยบันทกึแบบโครงสรา้งตารางทั Ѹงกอ่นและ
หลังการ Hide ไวด้ว้ย 

5. พยายามหลกีเลีѷยงการใชเ้ซลลใ์ดๆใน Column A และ Row 1 ทัѸงนีѸเพืѷอทําใหภ้าพตารางทีѷ
แสดงบนจอดไูมอ่ดึอดั และยังสามารถปรับขนาดความสงูความกวา้งของ Column A และ 
Row 1 เพืѷอชว่ยปรับตําแหน่งตารางในหนา้กระดาษพมิพไ์ดด้กีวา่การกําหนด Margin แต่
เพยีงอยา่งเดยีว 

6. หา้ม Merge เซลลท์ีѷเกีѷยวขอ้งกบัการคํานวณ เพราะตําแหน่งอา้งองิในสตูรทีѷอา้งถงึเซลลท์ีѷ 
Merge กนัไวนั้Ѹนอาจใหตํ้าแหน่งอา้งองิทีѷคลาดเคลืѷอนจากความเป็นจรงิเมืѷอมกีาร Copy 
สตูรทีѷอา้งองิถงึตําแหน่งเซลลท์ีѷ Merge ไปใชท้ีѷเซลลอ์ืѷน ดังนัѸนหากตอ้งการปรับการแสดง
ขอ้มลูใหเ้ห็นวา่อยูก่ลางชว่งเซลลเ์ชน่เดยีวกบั Merge แตว่า่เซลลแ์ตล่ะเซลลย์ังคงเป็น
เซลลข์องมันเองโดยมไิดร้วมเป็นเซลลเ์ดยีวอยา่ง Merge แตอ่ยา่งใด ใหเ้ลอืกชว่งเซลลนั์Ѹน
แลว้คลกิขวา สัѷง Format Cells > Alignment > Center Across Selection  

 
7. ในกรณีทีѷตอ้งการ Cut ตารางจากชทีหนึѷงไปยังชทีอืѷนหรอืแฟ้มอืѷน ใหเ้ริѷมจากเลอืกพืѸนทีѷ

ตารางทีѷตอ้งการจะ Cut ไปทัѸงหมด (โดยตอ้งตรวจสอบวา่เป็นพืѸนทีѷตารางทั Ѹงหมดทีѷมสีตูรทีѷ
เกีѷยวขอ้งกนั มฉิะนัѸนจะมเีซลลส์ตูรบางเซลลท์ีѷกลายเป็นสตูร link ขา้มแฟ้ม) จากนัѸนเมืѷอ
ตอ้งการ Paste สามารถเลอืก Paste ทีѷเซลลใ์ดในชทีใหมก่็ได ้โดย Excel จะปรับตําแหน่ง
อา้งองิตามตําแหน่งในชทีใหมใ่หเ้อง 

8. ในกรณีทีѷตอ้งการ Copy ตารางจากชทีหนึѷงไปยังชทีอืѷนหรอืแฟ้มอืѷน ใหเ้ริѷมจากเลอืกพืѸนทีѷ
ตารางทีѷตอ้งการจะ Copy จากนัѸนเมืѷอตอ้งการ Paste ใหเ้ลอืกเซลลใ์นชทีใหมท่ีѷเป็นเซลล์
เดยีวกบัเซลลแ์รกของตารางทีѷ Copy ไวก้อ่น แลว้จงึสัѷง Paste  
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9. หากตอ้งการป้องกนัไมใ่หผู้อ้ืѷนนําแฟ้มไปแกไ้ขสตูร ไมจํ่าเป็นตอ้ง Protect Sheet ก็ได ้แต่
ใหส้ัѷงตัดเครืѷองหมาย $ ออกจากเซลลส์ตูรทกุเซลลโ์ดยใชคํ้าสัѷง Replace เพืѷอทําใหส้ตูร
ทั Ѹงหมดถกูแกไ้ขหรอืสรา้งใหมไ่ดย้ากมาก (น่าสงัเกตวา่พอตัดเครืѷองหมาย $ ทิѸงไป แฟ้มจะ
มขีนาดใหญข่ึѸน) 

10. หากตอ้งการป้องกนัการ Insert Row หรอื Insert Column ในพืѸนทีѷชว่งใด ใหส้รา้งสตูร 
Array ลงไปพรอ้มกนัเป็นรั ѸวขอบเขตนัѸน เชน่ เลอืกเซลล ์A1:A10 แลว้พมิพส์ตูร =0 หรอื 
=”” (=”” นีѸ จะกลายเป็นรั Ѹวไฟฟ้าทีѷมองไมเ่ห็นขอ้มลูในเซลลร์ั ѸวนัѸนดว้ย)แลว้กดปุ่ ม 
Ctrl+Shift+Enter ลงไป จะไดร้ั Ѹวป้องกนัการ Insert Row ในชว่ง Row 1 ถงึ Row 10 

11. หากตอ้งการใช ้Windows Explorer ในการ copy แฟ้ม Excel ทีѷ link กนัหลายๆแฟ้มไปเก็บ
ทีѷ drive อืѷนหรอืโฟลเดอรอ์ืѷน ให ้Copy ทั Ѹงโฟลเดอรท์ีѷเก็บแฟ้มทีѷ link กนันัѸนไปพรอ้มกนั
ทั Ѹงหมด เชน่ ใน ถา้เก็บแฟ้มทีѷ link กนัไวใ้นโฟลเดอรช์ืѷอ MyExcelFile ก็ให ้Copy ตัว
โฟลเดอร ์MyExcelFile ซึѷงมแีฟ้มทีѷ link กนัอยูภ่ายในนัѸนไปทัѸงชดุ โดยในโฟลเดอรช์ืѷอ 
MyExcelFile อาจมโีฟลเดอรย์อ่ยสรา้งไวด้ว้ยก็ได ้เมืѷอ Copy ไปไวท้ีѷ drive อืѷนแลว้ คณุจะ
เปลีѷยนชืѷอโฟลเดอร ์MyExcelFile เป็นชืѷออืѷนก็ได ้แตห่า้มเปลีѷยนชืѷอโฟลเดอรย์อ่ยเพราะสตูร 
link ในแฟ้ม Excel จะจําชืѷอโฟลเดอรย์อ่ยไวใ้นสตูร (แตไ่มจํ่าชืѷอโฟลเดอร ์MyExcelFile) 

12. แทนทีѷจะจัดเก็บแฟ้มไวใ้นชืѷอเดมิ ขอใหจั้ดเก็บแฟ้มในชืѷออืѷนทกุครั Ѹงทีѷมกีารแกไ้ขใดๆใน
แฟ้มนัѸน ทั ѸงนีѸเพืѷอทําใหม้แีฟ้มเกา่เก็บไวห้ลายๆรุน่ ดกีวา่การมแีฟ้มรุน่เดยีวแฟ้มเดยีว ซึѷง
เสีѷยงหากแฟ้มนัѸนอาจเสยีหายจนเปิดไมไ่ด ้
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แป้นพมิพล์ดัทีѷเกีѷยวขอ้งกบัตําแหนง่อา้งองิและขอบเขตพืҟนทีѷตาราง 

F2 ใชแ้กไ้ขขอ้มลูหรอืสตูรในเซลล ์

F3 ใชใ้สช่ืѷอตําแหน่งเซลลห์รอืชืѷอสตูรทีѷตั Ѹงไวใ้นแฟ้มนัѸนๆลงไปในสตูร  
หรอืสัѷง Paste List ตอ่ จะสรปุชืѷอทีѷตั Ѹงไวทั้ Ѹงหมดลงไปในตาราง 

F4 ใชใ้สเ่ครืѷองหมาย $ กํากบัตําแหน่งอา้งองิ  
หรอืสัѷงทวนคําสัѷงสดุทา้ยซํѸา 

F5 ใชห้าเซลล ์ตามตําแหน่งหรอืชืѷอตําแหน่งเซลลท์ีѷทราบ 
หรอืสัѷง Special ตอ่ จะคน้หาตําแหน่งเซลลไ์ดอ้กีหลายแบบ 

F8 ใชค้วบคมุตําแหน่งเซลลแ์รกไวไ้มใ่หข้ยับเพืѷอขยายตาราง (Extend)  

F9 ใชส้ัѷงคํานวณทกุชทีทกุแฟ้มทีѷเปิดขึѸน 

Shift + F9 ใชส้ัѷงคํานวณเฉพาะชทีทีѷเลอืกอยูช่ทีเดยีวเทา่นัѸน 

F2 ตามดว้ย F9 ใชแ้กะสตูรในเซลลเ์พืѷอดวูา่มคีา่ทีѷแทจ้รงิเป็นอยา่งไร แลว้กด Esc 

Ctrl + * หรอื Ctrl+a ใชเ้ลอืกพืѸนทีѷตารางซึѷงมขีอ้มลูตดิตอ่กนัไป (Current Region) 

Ctrl + . ใชย้า้ย Active Cell ไปตามเซลลหั์วมมุของตารางทีѷเลอืกไว ้

Ctrl + Shift +  

Shift + End  

ใชเ้ลอืกพืѸนทีѷตารางจากเซลลท์ีѷเลอืกไวไ้ปจนสดุทางดา้นขวา  
หรอืตามทศิทางของลกูศรทีѷกด 

Ctrl + PgUp ใชเ้ลอืกชทีถัดไป 

Ctrl + PgDn ใชเ้ลอืกชทีกอ่นหนา้ 

Ctrl + Tab ใชเ้ลอืกแฟ้มถัดไปทีѷเปิดอยู ่

Ctrl + Shift + Tab ใชเ้ลอืกแฟ้มกอ่นหนา้ทีѷเปิดอยู ่

Ctrl + Shift + Enter ใชส้รา้งสตูร Array ซึѷงจะมเีครืѷองหมาย { } ปิดหัวทา้ยสตูร 
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หลกัการแยกตวัแปร 

1. ตัวแปร คอื คา่ทีѷมนุษยส์ามารถกําหนดใหม้คีา่เปลีѷยนแปลงตา่งไปจากเดมิ ตัวแปรอาจ
เป็นไดทั้ Ѹงคา่ทีѷเป็นตัวเลข ตัวอกัษร หรอืแมแ้ตส่ตูร 

2. เซลลร์ับตัวแปรอาจใชเ้ซลลเ์ดยีวหรอืหลายเซลล ์ขึѸนกบัประเภทของตัวแปรนัѸนๆวา่มกีาร
เปลีѷยนแปลงไปตามระยะเวลาหรอืเงืѷอนไขอืѷนใดหรอืไม ่ถา้เป็นคา่คงทีѷซ ึѷงใชค้า่เดยีวไป
ตลอด ก็สามารถใชเ้ซลลร์ับคา่เพยีงคา่เดยีวเซลลเ์ดยีวในแฟ้มหนึѷง แตถ่า้เป็นคา่ทีѷมี
ความผันผวนเปลีѷยนแปลงไปตามระยะเวลาก็จําเป็นตอ้งใชห้ลายเซลล ์เชน่ ตัวแปร
ประเภทราคาสนิคา้ ควรกําหนดใหแ้ตล่ะชว่งเวลามรีาคาสนิคา้แตกตา่งกนัไปเพืѷอใหเ้กดิ
ความยดืหยุน่ในการคํานวณ ก็จําเป็นตอ้งใชห้ลายเซลลเ์พืѷอรับตัวแปรประเภทราคา
สนิคา้ทีѷมยีอดตา่งกนัไปในแตล่ะชว่งเวลา 

3. ควรคดิเผืѷอไวต้ั Ѹงแตต่น้เสมอวา่ คา่คงทีѷทกุคา่เป็นตัวแปรทีѷคา่อาจเปลีѷยนแปลง เพราะ
คา่คงทีѷใดๆทีѷคดิวา่คงทีѷในวันนีѸ อาจเป็นไปไดว้า่ไมใ่ชค่า่ทีѷจะคงทีѷไปตลอด ดังนัѸนหาก
ไมม่ัѷนใจวา่จะคงทีѷไปตลอดหรอืไม ่ควรออกแบบตารางตั Ѹงแตแ่รกเผืѷอไวใ้หส้ามารถ
เปลีѷยนแปลงตัวแปรตามระยะเวลาไดด้ว้ย เชน่ อตัราภาษีธรุกจิเฉพาะ ซึѷงอาจถกู
ปรับเปลีѷยนใหต้า่งไปจากเดมิในอนาคต 

4. ลกูเลน่ทางธรุกจิเป็นตัวแปรไดเ้หมอืนกนั อยา่คดิวา่วธิดํีาเนนิการทางธรุกจิตอ้งเป็นแบบ
ปัจจบุันไปตลอด คณุตอ้งเผืѷอเซลลร์ับตัวแปรทีѷอาจเกดิขึѸนหรอืไมเ่กดิขึѸนไวก้อ่นตั Ѹงแต่
แรก ดกีวา่ทีѷจะยอ้นกลับไปแกไ้ขตารางแทรกตัวแปรเพิѷมในภายหลัง ขอใหอ้อกแบบ
โครงสรา้งตารางเผืѷอไวก้อ่นดกีวา่ขาด 

5. ในกรณีทีѷตัวแปรมเีงืѷอนไขซบัซอ้น ควรแยกตัวแปรประเภทนัѸนไปเก็บเป็นตารางเฉพาะ
หรอืเป็นชทีเฉพาะหรอืแมแ้ตเ่ป็นแฟ้มเฉพาะสําหรับตัวแปรนัѸนๆ โดยใหอ้อกแบบตาราง
ตามแบบโครงสรา้งฐานขอ้มลูทีѷดดีว้ย 

6. ควรใสส่สีรรคใ์หเ้ห็นเซลลร์ับตัวแปรแยกชดัเจนแตกตา่งจากเซลลส์ตูรคํานวณและ
กําหนดให ้Excel เปิดรับคา่ใหมไ่ด ้โดยคลกิขวาลงไปในเซลลต์ัวแปรนัѸน สัѷง Format 
Cells > Protection แลว้ตัดกาชอ่ง Locked ทิѸงไป จากนัѸนสัѷง Review > Protect 
Sheet แลว้จะพบวา่เมืѷอกดปุ่ ม Tab จะยา้ยตําแหน่งเซลลไ์ปตามเซลลท์ีѷเป็นตัวแปรให ้
เอง 
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วธิใีช ้Goal Seek 

เลขอะไรเอย่นําไปคณูกบัเลข 3 แลว้ไดผ้ลลัพธเ์ป็นเลข 30 คณุก็ตอ้งตอบวา่เลข 10 เพราะคณุ
คดิสตูรคณูในใจออกมาไดทั้นทเีลยใชไ่หมวา่ 10*3 = 30 แตถ่า้เปลีѷยนโจทยใ์หมว่า่ เลขอะไร
เอย่นําไปคณูกบัเลข 3 แลว้ไดผ้ลลัพธเ์ป็นเลข 77.77 คราวนีѸสมองของคณุก็จะคดิในใจอยา่ง
รวดเร็ววา่ “ไมไ่หว คดิไมไ่หว” ถา้ตอ้งเสยีเวลากดเครืѷองคดิเลขหรอืสรา้งสตูรเอาเลข 77.77 ตั Ѹง
แลว้หารดว้ย 3 เพืѷอหาเลขอะไรเอย่ตัวนัѸนก็ได ้ยอ่มแสดงวา่คณุใช ้Goal Seek ไมเ่ป็น 

Goal Seek เป็นเครืѷองมอืทีѷชว่ยคดิยอ้นโดยคณุไมต่อ้งเสยีเวลาสรา้งสตูรใหมเ่พืѷอคดิยอ้นเอง
แมแ้ตน่อ้ย เพยีงแตว่า่ Goal Seek จะทํางานไดต้อ่เมืѷอมเีซลลร์ับตัวแปรทีѷสามารถถกู Excel ทํา
หนา้ทีѷเปลีѷยนแปลงเป็นเลขใหมต่ามตอ้งการ แตห่ากเป็นเซลลส์ตูรจะไมส่ามารถใช ้Goal Seek 
เขา้ไปแกไ้ขสตูรใดๆในเซลลใ์หเ้ป็นคา่ใหมไ่ด ้

จากโจทยเ์ดมิ เลขอะไรเอย่นําไปคณูกบัเลข 3 แลว้ไดผ้ลลัพธเ์ป็นเลข 77.77 

1. สรา้งตัวอยา่ง 2*3 ได ้6 ตามตัวอยา่งทีѷผา่นมา 
2. คลกิเลอืกเซลล ์B2 ไวก้อ่นแลว้สัѷง Data > What-If Analysis > Goal Seek  

 
3. คลกิในชอ่ง Set cell: แลว้ใหค้ลกิตอ่ไปทีѷเซลล ์D2 โดยเซลลน์ีѸตอ้งเป็นเซลลส์ตูร

คํานวณ สว่นชอ่ง To value: ใหพ้มิพเ์ลข 77.77 ลงไป แลว้ใหค้ลกิในชอ่ง By 
changing cell: แลว้คลกิตอ่ไปทีѷเซลล ์B2 โดยเซลล ์B2 นีѸตอ้งเป็นเซลลร์ับตัวแปรทีѷ
กําลังตอ้งการหา ถอืเป็นตัวเลขคําตอบใหมท่ีѷตอ้งการ 
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4. กดปุ่ ม OK จะพบวา่ Excel เปลีѷยนตัวเลข 2 ในเซลล ์B2 เป็นตัวเลข 25.92333 ซึѷงทํา
ใหเ้กดิผลลัพธท์ีѷเซลล ์C2 เป็นเลข 77.77 ตามตอ้งการ แลว้ใหก้ดปุ่ ม OK เพืѷอยอมรับ
คําตอบทีѷ Goal Seek หาให ้

 
5. หากตอ้งการหาตัวเลขคําตอบทีѷตา่งจากเดมิ ตอ้งสัѷง Data > What-If Analysis > Goal 

Seek ซํѸาเองใหม ่

คราวนีѸมาลองใช ้Goal Seek กบัปัญหาทีѷยากขึѸน โดยใหห้าวา่ตัวเลขคา่โฆษณาในเซลล ์G18 
ตอ้งเป็นเทา่ใด จงึจะคดิเป็น 15% ของกําไรขั Ѹนตน้ 

 

จากภาพตารางขา้งบนนีѸ เซลล ์G16 และเซลล ์H17 เป็นเซลลร์ับตัวแปร ซึѷงมคีา่เป็นตัวเลข
ยอดขาย 1,000 บาทและตัวเลขเปอรเ์ซน็ตต์น้ทนุขายเทา่กบั 20% ตามลําดับ สว่นเซลลส์ตูร
คํานวณมใีนเซลล ์G17 มสีตูร =H17*G16 เพืѷอหายอดตน้ทนุขายเทา่กบั 200 บาท (คดิเป็น 
20% ของยอดขาย) สว่นเซลล ์G19 เป็นเซลลส์ตูรคํานวณหากําไรขั Ѹนตน้มสีตูร =G16-G17-
G18 มาจากยอดขายหักตน้ทนุขายและหักคา่โฆษณา เซลลท์ีѷเวน้วา่งไวค้อืเซลล ์G18 ใหใ้ชห้า
คา่โฆษณา ซึѷงตอนเริѷมตน้นีѸเวน้วา่งไว ้จงึทําใหเ้ซลล ์H18 ซึѷงมสีตูรคํานวณหาสดัสว่นรอ้ยละ
ของคา่โฆษณาตอ่กําไรขั Ѹนตน้ =G18/G19 ซึѷงขณะนีѸคนืคา่เทา่กบั 0 

ตัวอยา่งนีѸไมส่ามารถใชว้ธิคีดิงา่ยๆวา่ ในเมืѷอตอ้งการคา่โฆษณาเป็น 15% ของกําไรขั Ѹนตน้ ก็ให ้
สรา้งสตูร =.15*G19 ลงในในเซลล ์G18 ก็สิѸนเรืѷอง เพราะหากสรา้งสตูร =.15*G19 ลงไปใน
เซลล ์G18 จะพบวา่เกดิการอา้งองิแบบวงกลม (ตอ้งหันไปใชก้ารคํานวณแบบ Iteration เขา้มา
ชว่ย ซึѷงเป็นอกีวธิหีนึѷงในการแกปั้ญหานีѸ) เพราะหากคา่โฆษณาเพิѷม จะทําใหก้ําไรลด แลว้พอ
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กําไรลด ยอ่มสง่ผลใหค้า่โฆษณาลดตาม พอคา่โฆษณาลดลง กําไรก็ตอ้งเพิѷม กลายเป็นการ
คํานวณแบบวงกลมทีѷไมส่ามารถหาคําตอบสดุทา้ยไดโ้ดยวธิธีรรมดาทัѷวไป 

คณุสามารถแกปั้ญหานีѸโดยใช ้Goal Seek โดยเริѷมตน้จากคลกิเลอืกเซลล ์G18 ไวก้อ่นแลว้สัѷง 
สัѷง Data > What-If Analysis > Goal Seek 

 

1. คลกิในชอ่ง Set cell: แลว้ใหค้ลกิตอ่ไปทีѷเซลล ์H18 โดยเซลลน์ีѸเป็นเซลลส์ตูร
คํานวณหาวา่คา่โฆษณาเป็นรอ้ยละเทา่ใดของกําไรขั Ѹนตน้ =G18/G19 

2. ชอ่ง To value: ใหพ้มิพเ์ลข .15 ซึѷงเป็นตัวเลขคําตอบทีѷตอ้งการ 
3. คลกิในชอ่ง By changing cell: แลว้คลกิตอ่ไปทีѷเซลล ์G18 เพืѷอใหห้าตัวเลขคา่

โฆษณา 
4. กดปุ่ ม OK > OK จะไดต้วัเลขคําตอบคา่โฆษณาเทา่กบั 104.50377964375 ทีѷ Goal 

Seek คดิให ้

 

Goal Seek เป็นเครืѷองมอืพสิดารทีѷเหมาะในการวางแผนงบประมาณ ชว่ยตั Ѹงราคาขายสนิคา้เพืѷอ
ทําใหไ้ดก้ําไรตามตอ้งการ หรอืชว่ยในการคํานวณยอ้นกลับในงานทีѷคนเราคดิเองไมไ่หวได ้
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อยา่งไมน่่าเชืѷอ ซึѷงในงานวางแผนตัดสนิใจนัѸน แทบเป็นไปไมไ่ดเ้ลยทีѷเราจะมคีวามเชืѷอมัѷน 
100% ตอ่คําตอบทีѷมอียูเ่สมอไป ดังนัѸนแทนทีѷจะเสีѷยงกบัการใชต้ัวเลขเพยีงตัวเดยีว ขอแนะนํา
ใหใ้ช ้Goal Seek คดิยอ้นหาชว่งคา่ทีѷเป็นไปไดว้า่อยูใ่นชว่งตัวเลขระหวา่งคา่ใด เพืѷอทําให ้
สามารถวางแผนไดอ้ยา่งยดืหยุน่มากขึѸน เชน่ เดมิเคยถามวา่ ตัวเลขคา่โฆษณาในเซลล ์G18 
ตอ้งเป็นเทา่ใด จงึจะคดิเป็น 15% ของกําไรขั Ѹนตน้ ก็ใหใ้ช ้Goal Seek คน้หาคําตอบทีѷยดืหยุน่
กวา่เดมิวา่ ตัวเลขคา่โฆษณาในเซลล ์G18 ตอ้งเป็นคา่ระหวา่งเลขใด จงึจะคดิเป็น 15% - 
20% ของกําไรขั Ѹนตน้ 

ขอ้จํากดัของ Goal Seek และวธิแีกไ้ข 

ขอ้จํากดัทีѷสําคัญของ Goal Seek เกดิจากทกุครั Ѹงทีѷตอ้งการคดิยอ้นครั Ѹงใหม ่คณุตอ้งเป็นผูส้ัѷงให ้
Goal Seek ทํางานซํѸาดว้ยตนเอง และ Goal Seek จะยอมใหเ้ปลีѷยนแปลงตัวเลขตัวแปรไดเ้พยีง
เซลลเ์ดยีว นอกจากนีѸสว่นทีѷไมย่ดืหยุน่ทีѷสดุก็คอื คณุตอ้งกรอกตัวเลขทีѷตอ้งการลงไปในชอ่ง 
To value เองเสมอ โดยไมส่ามารถ link คา่ตัวเลขเป้าหมายทีѷตอ้งการจากเซลลเ์ขา้ไปใชใ้น 
Goal Seek จงึเป็นเครืѷองมอืทีѷไมเ่หมาะสําหรับผูท้ีѷไมเ่คยใช ้Goal Seek มากอ่น 

เราสามารถแกไ้ขจดุออ่นของ Goal Seek ใหส้ามารถรับคา่จากเซลลไ์ดโ้ดยตรง และหาทาง
ปรับปรงุให ้Goal Seek ทํางานหาคําตอบใหเ้องทันทอียา่งอตัโนมัต ิโดยเริѷมจากใช ้Macro 
Recorder บันทกึการสัѷง Data > What-If Analysis > Goal Seek แลว้ใชง้านตามตัวอยา่งการ
คํานวณหาคา่โฆษณาในตัวอยา่งทีѷผา่นมา จะไดร้หัส VBA ตามนีѸ 

Sub SetGoal() 

    Range("H18").GoalSeek Goal:=0.15, ChangingCell:=Range("G18") 

End Sub 

จากนัѸนใหแ้กไ้ขตําแหน่งอา้งองิและคา่คงทีѷในตัวรหัสใหอ้า้งถงึชืѷอ Range Name ทีѷตั Ѹงไวใ้น
ตารางกลายเป็นรหัสใหมด่ังนีѸ 

Sub SetGoal() 

    [MyTarget].GoalSeek Goal:=[TargetValue], ChangingCell:=[ChangeCell] 

End Sub 
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โดยกําหนดใหต้ั Ѹงชืѷอ Range Name ชืѷอวา่ MyTarget ใหก้บัเซลล ์H18 และชืѷอ ChangeCell 
ใหก้บัเซลล ์G18 และเมืѷอใดทีѷตอ้งการตัวเลขตัวใหม ่ใหก้รอกตัวเลขลงไปในเซลลท์ีѷตั Ѹงชืѷอวา่ 
TargetValue  

หากตอ้งการความสะดวกมากขึѸน ควรสัѷงให ้Goal Seek ทํางานเองโดยใช ้Event ก็จะได ้
ผลลัพธทั์นทโีดยไมต่อ้งเสยีเวลามาเปิด Goal Seek ขึѸนเพืѷอกรอกคา่เองอกีตอ่ไป เชน่ หากใช ้
Calculation Event ก็จะไดผ้ลลัพธต์ามการคํานวณใดๆทีѷเกดิขึѸนในชทีนัѸน 

Private Sub Worksheet_Calculate() 

    [MyTarget].GoalSeek Goal:=[TargetValue], ChangingCell:=[ChangeCell] 

End Sub 

วธิกีารนีѸแสดงขั Ѹนตอนการสรา้งไวใ้นหลักสตูรเคล็ดการเพิѷมผลงาน ลดความซบัซอ้นของงาน
ดว้ย Excel VBA 
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วธิใีช ้Data Table 

ถา้ถามวา่ตอนเริѷมตน้ใชส้ตูรคํานวณใน Excel แรกเริѷมนัѸนคณุตอ้งรูจั้กใชอ้ะไรใหเ้ป็น ก็ตอบวา่
ตอ้งรูจั้กการกําหนดตําแหน่งอา้งองิโดยการใชเ้ครืѷองหมาย $ ควบคมุแนวของคา่ทีѷใชใ้นการ
คํานวณ แลว้ถา้ถามตอ่ไปวา่ ตอนสรา้งแฟ้มงานเสร็จแลว้ละ่ตอ้งใชอ้ะไรใหเ้ป็น คําตอบก็คอื
ตอ้งใช ้Data Table สรปุคําตอบทีѷเป็นไปไดเ้พืѷอใชต้ัดสนิใจ 

Data Table เป็นคําสัѷงทีѷมมีานานแลว้แตม่ักถกูละเลยไมส่นใจใชก้นันัก คงเป็นเพราะคําสัѷงนีѸถกู
ออกแบบมาใหอ้ยูก่นัเมนู Data จงึทําใหน้กึไปวา่เป็นคําสัѷงทีѷไมเ่กีѷยวขอ้งกบัการคํานวณ อกี
ทั Ѹงตัวอยา่งและคําอธบิายใน Help ก็มไิดใ้หร้ายละเอยีดชดัเจนนัก ผูท้ีѷจะเขา้ใจ Data Table ได ้
ก็ตอ้งลองใชคํ้าสัѷงนีѸดแูลว้จงึจะซึѸงถงึประโยชนข์องมัน 

Data Table อาศัยการออกแบบตารางแบบพเิศษทีѷจะชว่ยให ้Excel นําคา่ทีѷวางไวบ้นหัวตาราง
หรอืขา้งตารางดา้นใดดา้นหนึѷงหรอืทั Ѹงสองดา้น สง่ตอ่ไปแทนทีѷคา่หรอืสตูรทีѷบันทกึไวใ้นเซลล ์
เมืѷอคา่ในเซลลเ์หลา่นัѸนเปลีѷยนไปตามคําสัѷง Data Table ก็จะทําใหเ้ซลลส์ตูรทีѷเกีѷยวขอ้ง
คํานวณหาคําตอบใหม ่เพยีงแตก่ารเปลีѷยนแปลงคา่ในเซลลแ์ละคําตอบใหมท่ีѷเกดิขึѸนนัѸน เราจะ
ไมเ่ห็นมกีารเปลีѷยนแปลงใดๆเกดิขึѸนในตาราง แตจ่ะพบวา่ Excel นําคําตอบมาสรปุไวใ้นตาราง 
Data Table ใหเ้อง 

สําหรับผูท้ีѷคุน้เคยกบัการเขยีนโปรแกรมสําเร็จรปู การทํางานของ Data Table เปรยีบเทยีบได ้
กบัการใชร้หัสโปรแกรมสัѷงให ้Excel ทํางานซํѸาหลายครั Ѹงเป็น loop โดย Excel จะสง่คา่ไปทีѷ
เซลลท์ีѷเรากําหนดใหใ้นแตล่ะ loop ทั ѸงนีѸ Data Table จะทํางานเป็น loop ใหอ้ตัโนมัตโิดยเรา
ไมต่อ้งเสยีเวลาเขยีนโปรแกรมแมแ้ตน่อ้ย 

Data Table ม ี3 แบบตามจํานวนตัวแปรทีѷเกีѷยวขอ้ง ไดแ้ก ่

 Data Table แบบ 1 ตัวแปร  
 Data Table แบบ 2 ตัวแปร 
 Data Table แบบไมจํ่ากดัตัวแปร โดยใชร้ว่มกบัสตูร Index (กลายเป็นวธิทีีѷฉลาดกวา่

การใช ้Scenarios) 

โครงสรา้งตาราง Data Table แบง่เป็น 4 สว่น ตามรปู 
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Data Table แบบ 1 ตวัแปร 

จากตัวอยา่งการหาคา่โฆษณา หากกําหนดใหค้า่โฆษณาเป็นตัวเลขในชว่ง 100 ถงึ 400 บาท 
ใหห้าวา่จะสง่ผลตอ่กําไรขั Ѹนตน้อยา่งไร 

ทางออกในการแกปั้ญหานีѸ หากคณุไมรู่จั้ก Data Table มากอ่น ก็คงตอ้งสรา้งตารางคํานวณซํѸา
กนัหลายๆตารางเพืѷอทดลองใสต่ัวเลขคา่โฆษณาลงไปเพืѷอหาผลลัพธท์ีѷตอ้งการ 

แทนทีѷจะเสยีแรงเสยีเวลาสรา้งตารางคํานวณซํѸา ใหอ้อกแบบโครงสรา้งตาราง Data Table 
ขึѸนมากอ่น โดยในปัญหานีѸสงัเกตวา่ตอ้งการเปลีѷยนคา่โฆษณาเพยีงคา่เดยีว ดังนัѸนจงึเขา้ขา่ย 
Data Table แบบ 1 ตัวแปร ซึѷงมโีครงสรา้งแยกแยะออกไปอกี 2 แบบยอ่ยตามแตว่า่คณุ
ตอ้งการดตูัวแปรตามแนวใด ไดแ้ก ่

 Data Table แบบวางตัวแปรไวใ้นหัวตารางดา้นขา้งตามแนวตั Ѹง สว่นหัวตารางดา้นบน
เป็นสตูรคําตอบทีѷ link มา และเมืѷอสัѷง Data Table ใหเ้ลอืกใชช้อ่ง Column Input Cell 

 Data Table แบบวางตัวแปรไวใ้นหัวตารางดา้นบนตามแนวนอน สว่นหัวตารางดา้นขา้ง
เป็นสตูรคําตอบทีѷ link มา และเมืѷอสัѷง Data Table ใหเ้ลอืกใชช้อ่ง Row Input Cell 

ตัวอยา่งการใช ้Data Table แบบวางตัวแปรไวใ้นหัวตารางดา้นขา้งตามแนวตั Ѹง 
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1. นําตัวเลขคา่โฆษณามาพมิพล์งในเซลล ์E23:E27 โดยจะกําหนดใหเ้ป็นตัวเลขใด
กอ่นหลังก็ได ้ไมจํ่าเป็นตอ้งเรยีงลําดับมากนอ้ย 

2. เซลล ์F22 และ G22 สรา้งสตูร link ผลลัพธข์องสตูรคํานวณมาจากเซลล ์G19 และ 
H18 ตามลําดับ 

3. ใหเ้ลอืกพืѸนทีѷ E22:G27 แลว้สัѷง Data > What-If Analysis > Data Table  
4. คลกิลงในชอ่ง Column input cell แลว้คลกิตอ่ไปทีѷเซลล ์G18 (เพืѷอกําหนดให ้Data 

Table ยงิตัวเลขคา่โฆษณาทีѷวางไวต้ามแนวตั Ѹงไปทีѷเซลล ์G18) แลว้กดปุ่ ม OK 
5. จะพบคําตอบปรากฏในตาราง F23:G27 และเมืѷอคลกิดจูะพบสตูร {=TABLE(,G18)} 

ซึѷงสตูรนีѸเราไมส่ามารถสรา้งเอง ตอ้งใชคํ้าสัѷง Data Table เทา่นัѸนจงึจะเกดิสตูรนีѸข ึѸน 
และเมืѷอดใูนสตูรจะพบ (,G18) แสดงถงึการไมใ่ช ้Row Input แตใ่ช ้Column Input มี
เซลล ์G18 เป็นเซลลร์ับคา่ 

หากใชต้าราง Data Table แบบวางตัวแปรไวใ้นหัวตารางดา้นบนตามแนวนอน ตอ้งออกแบบ
ตารางตามรปูตอ่ไปนีѸ 

 

ขอ้สงัเกต 

1. Data Table แบบ 1 ตัวแปร สามารถหาคําตอบมาแสดงในตารางไดห้ลายเรืѷอง ตามแต่
วา่จะ link สตูรคําตอบเรืѷองใดมาแสดงในหัวตารางอกีขา้งหนึѷง จงึใหผ้ลลัพธไ์ดม้ากกวา่ 
Data Table แบบ 2 ตัวแปร ซึѷงแมจ้ะใชต้ัวแปรได ้2 ตัว แตจ่ะแสดงคําตอบในตารางได ้
เพยีงเรืѷองเดยีวเพราะมเีซลลห์ัวมมุเพยีงเซลลเ์ดยีว  

2. ถา้ตอ้งการใชต้ัวแปรมากกวา่ 2 ตัว หรอืตอ้งการคําตอบหลายเรืѷอง สามารถใชส้ตูร If, 
Choose หรอื Index ชว่ยทําให ้Data Table ทํางานไดไ้มจํ่ากดั 

3. สตูรทีѷ Excel สรา้งใหเ้มืѷอสรา้ง Data table เป็นสตูรทีѷถกูสรา้งขึѸนแบบ Array พรอ้มกนั
ทกุเซลล ์โดยมโีครงสรา้งสตูรดังนีѸ 
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=Table(Row Input Cell, Column Input Cell) 
 
Data Table แบบ 1 ตัวแปร จะเกดิสตูร =Table(Row Input Cell,) เมืѷอเป็นตารางทีѷใช ้
Row Input และจะเกดิสตูร =Table(, Column Input Cell) เมืѷอเป็นตารางทีѷใช ้
Column Input สว่น Data Table แบบ 2 ตัวแปรจะเกดิสตูรทีѷใชโ้ครงสรา้งแบบเต็ม 
=Table(Row Input Cell, Column Input Cell) 

4. การอา่นผลลัพธจ์ากตาราง Data Table ตอ้งอธบิายใหช้ดัเจนวา่ ในขณะทีѷคา่โฆษณา
เปลีѷยนแปลงไปนัѸน ตัวเลขตัวแปรอืѷน ไดแ้ก ่ยอดขาย และ %ตน้ทนุขาย ถอืวา่คงทีѷ 

5. คา่โฆษณาในเซลล ์G18 จะเวน้วา่งไวห้รอืจะใสต่ัวเลขใดๆแมจ้ะสรา้งสตูรคํานวณไวก้อ่น
หรอืหลังการสัѷง Data Table ก็ได ้เพราะไมม่ผีลตอ่การคํานวณใน Data Table 

6. ตาราง Data Table ไมส่ามารถถกู Copy ออกไปใชท้ีѷอืѷน เพราะเมืѷอ Paste จะพบวา่สตูร 
Table ในตารางถกูเปลีѷยนเป็นตัวเลขคา่คําตอบแทนทกุเซลล ์

7. เราไมส่ามารถ Insert แทรกเซลลส์ตูร Table และหากตอ้งการลบสตูร Table ทิѸง ตอ้ง
เลอืกพืѸนทีѷตารางทั Ѹงหมดทีѷมสีตูร Table แลว้จงึจะสามารถลบสตูรทิѸงพรอ้มกนัทกุเซลล ์

Data Table แบบ 2 ตวัแปร 

ในตัวอยา่งเดมิ หากตอ้งการวเิคราะหว์า่ถา้เราเปลีѷยนแปลงตน้ทนุขายและคา่โฆษณาจะมผีล
อยา่งไรบา้งตอ่ยอดกําไรขั Ѹนตน้ 

 

1. พมิพต์ัวแปรตน้ทนุขายไวใ้นเซลล ์F22:H22 ซึѷงถอืเป็น Row Input 
2. พมิพต์ัวแปรตน้คา่โฆษณาไวใ้นเซลล ์E23:E27 ซึѷงถอืเป็น Column Input 



90 

 

© พ.ศ.2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ
www.ExcelExpertTraining.com 

3. ในเซลลห์ัวมมุตาราง E22 สรา้งสตูร =G19 เพืѷอ link สตูรคํานวณหากําไรขั Ѹนตน้มาใช ้
4. จากนัѸนใหเ้ลอืกพืѸนทีѷตั Ѹงแต ่E22:H27 แลว้สัѷง Data > What-If Analysis > Data 

Table  
5. คลกิลงไปในชอ่ง Row Input Cell แลว้คลกิตอ่ไปยังเซลล ์G17 ซึѷงเป็นเซลลต์น้ทนุ

ขาย 
6. คลกิลงไปในชอ่ง Column Input Cell แลว้คลกิตอ่ไปยังเซลล ์G18 ซึѷงเป็นเซลลค์า่

โฆษณา แลว้กดปุ่ ม OK จะพบคําตอบของกําไรขั Ѹนตน้ แสดงในตาราง F23:H27 

เมืѷอนํา Data Table มาเปรยีบเทยีบกบั Goal Seek มขีอ้สงัเกตดังนีѸ 

1. Data Table สามารถสง่คา่ตัวแปรใหมค่รั Ѹงละหลายตัวไปแทนทีѷเซลลท์ีѷมสีตูรสรา้งไว ้ซึѷง 
Excel จะคํานวณใหต้ามคา่ตัวแปรใหมนั่Ѹน โดยถอืวา่ไมไ่ดใ้ชส้ตูรทีѷสรา้งไวก้อ่นแลว้ในเซลล์
นัѸนมาใชคํ้านวณรว่มดว้ยแตอ่ยา่งใด สว่น Goal Seek สามารถสง่ตัวแปรใหมไ่ปไดค้รั Ѹงละ 1 
ตัวและไมส่ามารถสง่ตัวแปรไปแทนเซลลท์ีѷเป็นสตูร 

2. Data Table เหมาะกบัการใชว้างแผนระยะยาว โดยกําหนดคา่ตัวแปรบนหัวตารางให ้
ครอบคลมุชว่งคา่ทีѷเป็นไปไดเ้พืѷอดผูลลัพธท์ีѷเกดิขึѸนในชว่งคา่นัѸนๆซึѷงอาจไมไ่ดคํ้าตอบตรง
กบัคา่เป้าหมายทีѷตอ้งการ สว่น Goal Seek เหมาะสําหรับการวเิคราะหห์าตัวเลขเฉพาะกจิ 
ซึѷงจะคดิยอ้นกลับจนไดต้ัวเลขตามตอ้งการ 

3. เราสามารถสัѷง Formulas > Calculation Options > Automatic Except for Data Tables 
เพืѷอกําหนดใหใ้ชก้ารกดปุ่ ม F9 เพืѷอสัѷงให ้Data Table คํานวณเฉพาะเมืѷอตอ้งการเทา่นัѸน 
สว่น Goal Seek แมว้า่จะพบวา่ใชก้บัการคํานวณแบบ Automatic หรอื Manual ก็ได ้แตเ่รา
ควรใช ้Goal Seek รว่มกบัการคํานวณแบบ Automatic ไวก้อ่น เพืѷอชว่ยทําใหม้ัѷนใจวา่เซลล์
สตูรทีѷเกีѷยวขอ้งถกูคํานวณตามกนัไปครบทัѸงหมดดว้ย 

4. เนืѷองจากเราเป็นผูก้ําหนดคา่ตัวแปรใหใ้ชก้บั Data Table ดังนัѸน Excel จะถกูสัѷงใหคํ้านวณ
ตามคา่ตัวแปรเหลา่นัѸนจนครบทกุตัว สว่น Goal Seek จะคํานวณยอ้นกลับใหเ้องแตอ่าจได ้
คําตอบเฉพาะในชว่งคา่ทีѷ Excel คน้หาใหเ้ทา่นัѸน  

5. หาก Data Table ไมส่ามารถหาคําตอบทีѷตอ้งการ ก็สามารถใช ้Goal Seek ทํางานตอ่บน
ตาราง Data Table โดยใหใ้ช ้Goal Seek คดิยอ้นหาคา่ตัวแปรบนหัวตาราง Data Table 
จนกวา่จะคํานวณไดคํ้าตอบมาปรากฏขึѸนในพืѸนทีѷสว่นของคําตอบในตาราง Data table
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หลากหลายแนวทางการใชส้ตูร IF 

ในบรรดาสตูรสําเร็จรปูของ Excel นัѸน สตูรทีѷใชม้ากทีѷสดุและมปีระโยชนม์ากทีѷสดุรองจากสตูร 
SUM เห็นจะหนไีมพ่น้สตูร IF ซึѷงแปลวา่ "ถา้" นีѸแหละ โดยเฉพาะคนทีѷมตํีาแหน่งขึѸนชืѷอวา่เป็น
หัวหนา้ ถา้ใชส้ตูร IF ไมเ่ป็น ก็ไมส่มควรเป็นหัวหนา้หรอกนะ เปลีѷยนตําแหน่งใหไ้ดช้ืѷอตรงขา้ม
กบัคําวา่หัวกบัหนา้ ใหก้ลายเป็นตําแหน่งเทา้หลังแทนจะเหมาะสมกวา่ 

ถา้นําเงืѷอนไขขา้งตน้เกีѷยวกบัหัวหนา้มาเขยีนดว้ยสตูร IF จะไดส้ตูรตามนีѸ 

=IF ( หัวหนา้ใชส้ตูร IF เป็นหรอืไม ่, ถา้ใชเ้ป็น ใหเ้ป็นหัวหนา้ตอ่ไป , ถา้ใชไ้มเ่ป็น ให ้
เป็นเทา้หลังแทน ) 

หรอืถา้คดิเขยีนสตูร IF ตามหลักกฎแหง่กรรมของการทําดตีอ้งไดด้ ีทําชัѷวไดช้ัѷว จะไดส้ตูรตาม
นีѸ 

=IF ( คณุทําดใีชไ่หม , ถา้ทําด ีตอ้งไดด้ ี, ถา้ไมทํ่าด ีตอ้งไดร้ับผลอืѷนๆ ) 

สงัเกตวา่ในสตูร IF ของการตรวจสอบวา่ทําดหีรอืไมนั่Ѹน ถา้ไมไ่ดทํ้าด ีไมใ่ชว่า่จะไดช้ัѷว เพราะ
เงืѷอนไขทีѷใชเ้ป็นเพยีงตรวจสอบวา่ทําดอียา่งเดยีวเทา่นัѸน คนทีѷไมไ่ดทํ้าด ีไมใ่ชว่า่ตอ้งทําชัѷวก็
ได ้อาจอยูเ่ฉยๆไมไ่ดทํ้าดไีมไ่ดทํ้าชัѷว ดังนัѸนกรณีทีѷไมไ่ดทํ้าด ีจงึตอ้งไดร้ับผลอยา่งอืѷนซึѷงไมใ่ช่

ผลจากการทําด ี

ถา้คณุเขา้ใจวธิคีดิเงืѷอนไขในใจของตัวคณุเอง ก็จะพบวา่บรษัิทไมโครซอฟทไ์ดส้รา้ง Excel 
ขึѸนมาโดยใชส้ตูร IF ทีѷมโีครงสรา้งของสตูรตามหลักการเดยีวกนักบัทีѷคณุคดิไดนั้ѷนเอง 

โครงสรา้งสตูร IF 

=IF(การตรวจสอบเงืѷอนไข, ผลลัพธก์รณีทีѷตรวจสอบเงืѷอนไขวา่ใช,่ ผลลัพธก์รณีทีѷ
ตรวจสอบเงืѷอนไขวา่ไมใ่ช)่ 

ในสว่นของการตรวจสอบเงืѷอนไข ใหใ้สส่มการทีѷตอ้งการลงไป โดยใชเ้ครืѷองหมาย =, >, <, 
>=, <=, หรอืไมเ่ทา่กบั <> หรอืในสว่นของการตรวจสอบเงืѷอนไขนีѸ อาจใชส้ตูรอืѷนซึѷงคนืคา่
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เป็น TRUE หรอื FALSE อยา่งใดอยา่งหนึѷง เชน่ AND, OR, TRUE, FALSE, ISNUMBER เป็น
ตน้ 

ตัวอยา่งการใช ้IF แบบงา่ยๆ 

=IF(SaleChoice="n", 1000, 2000) 

สตูรนีѸจะคนืคา่เป็นตัวเลข 1000 ตอ่เมืѷอเซลลท์ีѷตั Ѹงชืѷอวา่ SaleChoice มคีา่เป็นตัวอกัษร n 
เทา่นัѸน แตถ่า้ SaleChoice มคีา่อืѷน จะคนืคา่เป็นตัวเลข 2000 แทน 

เนืѷองจากตัวอกัษร n เป็นตัวอกัษรทีѷ Excel ไมรู่จั้ก จงึจําเป็นตอ้งใส ่"n" ไวร้ะหวา่งเครืѷองหมาย
คําพดู สว่นคําวา่ IF และ SaleChoice นัѸนแมว้า่เป็นตัวอกัษรแตไ่มต่อ้งใสร่ะหวา่งเครืѷองหมาย
คําพดูเพราะเป็นตัวอกัษรทีѷ Excel รูจั้กแลว้วา่คําวา่ IF คอืสตูรชืѷอ IF และคําวา่ SaleChoice เป็น 
Range Name ทีѷตั Ѹงชืѷอไว ้สว่นตัวเลข 1000 และ 2000 เป็นตัวเลขทีѷ Excel รับทราบอยูแ่ลว้วา่
เป็นตัวเลขจงึไมต่อ้งใสร่ะหวา่งเครืѷองหมายคําพดูแตอ่ยา่งใด 

=IF(MyMargin>0, MyMargin*0.3, 0) 

สตูรนีѸใชก้บัการคํานวณหายอดภาษี ถา้ MyMargin หรอืเซลลก์ําไรขั Ѹนตน้มคีา่มากกวา่ 0 ยอ่ม
แสดงวา่มกีําไรเกดิขึѸน จงึนํายอดกําไรขั Ѹนตน้ไปคณูดว้ยอตัราภาษี 30% แตถ่า้ไมม่กีําไรก็ไม่
ตอ้งจา่ยภาษี  

แนวทางการใชส้ตูร IF 

1.ใชเ้ปลีѷยนเสน้ทางการรับคา่ 

2.ใชใ้นการตัดสนิใจ 

3.ใชใ้นการเปลีѷยนคา่หรอืแสดงคา่ 

4.ใชเ้ปลีѷยนเสน้ทางการสง่คา่ 
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การใชส้ตูร IF ในการเปลีѷยนเสน้ทางการรบัคา่   

การสรา้งสตูรลงิคเ์พืѷอเชืѷอมโยงคา่โดยทัѷวไปเป็นการเชืѷอมโยงกนัแบบ 1 ตอ่ 1 เชน่ เมืѷอตอ้งการ
ทําใหเ้ซลล ์A2 มคีา่เทา่กบัเซลล ์A1 ก็จะสรา้งสตูร =A1 ลงไปในเซลล ์A2 ทําใหเ้ซลล ์A2 
แสดงคา่เปลีѷยนแปลงตามคา่ในเซลล ์A1 ซึѷงการลงิคแ์บบนีѸเซลล ์A1 เรยีกวา่เป็นเซลลต์น้ทาง 
และเซลล ์A2 เรยีกวา่เป็นเซลลป์ลายทาง 

แตถ่า้เซลลต์น้ทางมมีากกวา่ 1 เซลล ์เชน่กําหนดใหเ้ซลล ์C2 และ C3 สามารถเป็นเซลลต์น้
ทางไดทั้ Ѹงคู ่โดยกําหนดใหเ้ซลล ์E3 เป็นเซลลป์ลายทางเพยีงเซลลเ์ดยีว โดยเลอืกทีѷจะรับคา่
จากเซลล ์C2 หรอื C3 ก็ไดแ้ลว้แตเ่งืѷอนไขทีѷเรากําหนดวา่จะใหเ้ลอืกรับคา่มาจากเซลลใ์ด 

 

จากภาพกําหนดใหเ้ซลล ์E2 เป็นเซลลส์ําหรับใสค่า่เงืѷอนไขลงไปวา่จะเป็นตัวอกัษร A หรอื B 
(หรอืคา่อืѷนใดก็ได)้ สว่นเซลล ์E3 ซึѷงเป็นเซลลป์ลายทาง ใหส้รา้งสตูรตอ่ไปนีѸ 

=IF( E2="A", C2, C3) 

ดังนัѸนเมืѷอเซลล ์E2 มคีา่เป็น A จงึทําใหเ้ซลล ์E3 รับคา่ 100 มาจากเซลล ์C2 แตถ่า้เซลล ์E2 
ไมไ่ดม้คีา่เป็น A ก็จะทําใหเ้ซลล ์E3 เปลีѷยนเสน้ทางการรับคา่ 200 มาจากเซลล ์C3 แทน 

แตถ่า้กําหนดใหม้จํีานวนเซลลต์น้ทางมากมายหลายเซลล ์เชน่ ตามรปูตอ่ไปนีѸใชเ้ซลลต์น้ทาง
ถงึ 14 เซลล ์
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สตูรลงิคเ์พืѷอเลอืกรับคา่ในเซลล ์F9 จะกลายเป็นสตูรซบัซอ้นมากขึѸน 

=IF(E9="A",C2,IF(E9="B",C5,IF(E9="C",C8,IF(E9="D",C11,IF(E9="E",C14,IF(
E9="F",C17,IF(E9="G",F2,IF(E9="H",F17,IF(E9="I",I2,IF(E9="J",I5,IF(E9="
K",I8,IF(E9="L",I11,IF(E9="M",I14,I17))))))))))))) 

ซึѷงเซลล ์E9 มคีา่เป็น K จงึทําใหส้ตูร IF ในเซลล ์F9 เลอืกรับคา่มาจากเซลล ์I8 

แตถ่า้โครงสรา้งตารางไมไ่ดจั้ดใหเ้ป็นระเบยีบ แมส้ตูร IF จะยงัคงทํางานไดต้ามเดมิก็ตาม แต่
จะพบวา่การแกะสตูรเพืѷอตรวจสอบความถกูตอ้งทําไดย้ากขึѸนมาก 

 

 

สตูรในเซลล ์F9 

=IF(E9="A",C2,IF(E9="B",I3,IF(E9="C",J11,IF(E9="D",F2,IF(E9="E",I9,IF(E9
="F",J16,IF(E9="G",H14,IF(E9="H",E14,IF(E9="I",G17,IF(E9="J",H7,IF(E9=
"K",C8,IF(E9="L",D6,IF(E9="M",D12,C17))))))))))))) 

แตช่ว่ยตรวจสอบวา่ แมว้า่ E9 มคีา่เทา่กบั K ทําใหเ้ซลล ์F9 รับคา่ 1100 มาจากเซลล ์C8 ได ้
ถกูตอ้งตามตอ้งการก็ตาม แตค่า่ 1100 ทีѷไดร้ับมานัѸน ไมใ่ชต่ัวเลขของคา่ K แตเ่ป็นของคา่ X 
มใิชห่รอื 

ตั Ѹงแต ่Excel 2007 เป็นตน้มา ในวงเล็บของแตล่ะสตูร เราสามารถซอ้นสตูรเขา้ไปไดถ้งึ 64 สตูร 
(Excel 2003 และรุน่กอ่นนัѸนจะซอ้นไดเ้พยีง 7 สตูร) ซึѷงจากตัวอยา่งขา้งตน้น่าจะทําใหเ้ราได ้
เรยีนรูว้า่ ถงึแมว้า่เราสามารถใชส้ตูร IF ซอ้น IF เพืѷอหาคา่ทีѷกระจายกนัอยูต่า่งทีѷตา่งชทีตา่ง
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แฟ้มไดก้็ตาม แตก่ารกระจายกนัของคา่นีѷเอง หากกระจายอยา่งขาดระเบยีบ ยอ่มเพิѷมความเสีѷยง
ทีѷจะหาคําตอบผดิพลาดไดโ้ดยไมรู่ต้ัว และเมืѷอจะตรวจสอบแกไ้ขก็จะทําใหทํ้าไดย้าก 

ดังนัѸนโปรดจําไวว้า่ ขอใหเ้ลอืกใชส้ตูร IF กบัปัญหางา่ยๆ แตเ่มืѷอปัญหาซบัซอ้นมากขึѸน เราควร
ปรับเปลีѷยนโครงสรา้งตารางหรอืเลอืกใชส้ตูรอืѷนซึѷงทํางานไดเ้ชน่เดยีวกนักบัสตูร IF จะ
เหมาะสมกวา่ 
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การใชส้ตูร IF ในการตดัสนิใจ   

โครงสรา้งสตูร IF แบบงา่ยๆ =IF(เงืѷอนไข,ผลกรณีใช,่ผลกรณีไมใ่ช)่ มพีืѸนฐานของตัวสตูรทํา
หนา้ทีѷตัดสนิใจตามเงืѷอนไขทีѷเรากําหนดลงไปในสตูรอยูแ่ลว้ ไมว่า่จะใชส้ตูร IF ในการเปลีѷยน
เสน้ทางการรับคา่หรอืใชใ้นการปรับเปลีѷยนคา่ก็ตาม ยอ่มถอืวา่เป็นการใชส้ตูร IF ในการ
ตัดสนิใจนัѷนเอง เพยีงแตห่ัวขอ้นีѸจะแยกแยะประเภทของการตัดสนิใจใหเ้ห็นชดัขึѸน  

การใชส้ตูร IF ในการตัดสนิใจม ี2 แบบ ขึѸนกบัวา่เงืѷอนไขถัดไปกําหนดวา่ตอ้งผา่นเงืѷอนไขกอ่น
หนา้อยา่งไร 

1. การใช ้IF แบบกําหนดเงืѷอนไขแตกตอ่กรณีทีѷไมใ่ช ่
2. การใช ้IF แบบกําหนดเงืѷอนไขแตกตอ่กรณีทีѷใช ่

การใช ้IF แบบกําหนดเงืѷอนไขแตกตอ่กรณีทีѷไมใ่ช ่ 

เป็นเงืѷอนไขทีѷพบเห็นกนัทัѷวไป เชน่ สตูร IF ในตัวอยา่งทีѷใชส้ําหรับเปลีѷยนเสน้ทางในการรับคา่
นัѷนเอง เมืѷอเงืѷอนไขการรับคา่แรกผา่นไปแลว้ ไดคํ้าตอบแรกตามเงืѷอนไขแรกเมืѷอตัดสนิวา่ใชไ่ป
แลว้ก็จะไดคํ้าตอบกรณีทีѷใชเ่รยีบรอ้ย แตห่ากเงืѷอนไขแรกไมผ่า่น ก็จะตอ้งพจิารณาเงืѷอนไขใน
ลําดับถัดไป ซึѷงแสดงเป็นโครงสรา้งสตูร IF จากแบบงา่ยๆกลายเป็นแบบซอ้นกนัดังนีѸ  

สําหรับการตดัสนิใจในเงืѷอนไขแรก 

=IF(เงืѷอนไขทีѷ 1, ผลกรณีใชข่องเงืѷอนไขทีѷ 1, ผลกรณีไมใ่ชข่องเงืѷอนไขทีѷ 1) 

ถา้เงืѷอนไขทีѷ 1 ยังไมผ่า่น ใหแ้ตกผลกรณีไมใ่ชข่องเงืѷอนไขทีѷ 1 ตอ่เป็น IF สตูรทีѷสองเพืѷอคดิ
ตามเงืѷอนไขทีѷ 2 

=IF(เงืѷอนไขทีѷ 2, ผลกรณีใชข่องเงืѷอนไขทีѷ 2, ผลกรณีไมใ่ชข่องเงืѷอนไขทีѷ 2) 

เมืѷอนําสตูรทั Ѹงสองเงืѷอนไขมาซอ้นเป็นสตูรในเซลลเ์ดยีว จะไดส้ตูรตามนีѸ 

=IF(เงืѷอนไขทีѷ 1, ผลกรณีใชข่องเงืѷอนไขทีѷ 1, IF(เงืѷอนไขทีѷ 2, ผลกรณีใชข่อง
เงืѷอนไขทีѷ 2, ผลกรณีไมใ่ชข่องเงืѷอนไขทีѷ 2) ) 
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ตัวอยา่งการใช ้IF แบบกําหนดเงืѷอนไขแตกตอ่กรณีทีѷไมใ่ชใ่นการตัดเกรด 

 

กําหนดใหเ้ซลล ์B3:C5 เป็นตารางคะแนน-เกรด  

 ถา้สอบไดต้ั Ѹงแต ่90 คะแนนขึѸนไปใหไ้ดเ้กรด A 
 ถา้สอบไดต้ั Ѹงแต ่70 คะแนนขึѸนไปใหไ้ดเ้กรด B 
 ถา้สอบไดต้ั Ѹงแต ่0 คะแนนขึѸนไปใหไ้ดเ้กรด C 

สมมตวิา่เซลล ์E3 มคีา่เป็น 75 เป็นคะแนนทีѷสอบได ้เซลล ์F3 หาคําตอบเป็นเกรด B โดยใช ้

สตูร IF ซอ้นกนัดังนีѸ 

=IF( E3>=B3, C3, IF(E3>=B4,C4,C5) ) 

ซึѷงแปลสตูรออกมาตามเงืѷอนไขทีѷกําหนดไดเ้ป็น 

=IF( คะแนนทีѷสอบได ้>=90, "A", IF(คะแนนทีѷสอบได ้>=70,"B","C") ) 

ขอ้สงัเกต 

1. การเขยีนสตูร IF ซอ้น IF มหีลักการสาํคัญ คอื ตอ้งจดัลําดบัของเงืѷอนไขทีѷเปิด
โอกาสให ้IF ทกุตวัในสตูรมโีอกาสไดท้ํางาน ดังนัѸนจงึตอ้งใชเ้งืѷอนไข คะแนนทีѷ
สอบได ้>=90 ขึѸนกอ่นเป็นเงืѷอนไขแรก หากเงืѷอนไขนีѸไมผ่า่นจงึปลอ่ยใหเ้งืѷอนไขถัดไป
ทํางาน (แตถ่า้สรา้งผดิโดยใชเ้งืѷอนไข >=70 ขึѸนกอ่น จะปิดโอกาสของเงืѷอนไขเกรด A 
เพราะ >=70 ยอ่มหมายถงึ >=90 อยูแ่ลว้) 

2. แมต้อ้งการเกรด A, B, C แตเ่ราใช ้IF ซอ้นกนัเพยีง 2 IF เทา่นัѸน เพราะถา้ไมใ่ชทั่ Ѹงสอง
เงืѷอนไข ก็ตอ้งเป็นเกรด C นัѷนเอง 
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การใช ้IF แบบกําหนดเงืѷอนไขแตกตอ่กรณีทีѷใช ่ 

เป็นเงืѷอนไขทีѷกําหนดซอ้นเขา้ไปเพืѷอตัดสนิใจในทกุเงืѷอนไขพรอ้มกนัไป เกดิเป็นโครงสรา้งสตูร
ตามนีѸ 

=IF(เงืѷอนไขทีѷ 1, IF(เงืѷอนไขทีѷ 2, ผลกรณีใชข่องเงืѷอนไขทีѷ 1 และ 2, ผลกรณีไมใ่ช่

ของเงืѷอนไขทีѷ 2), ผลกรณีไมใ่ชข่องเงืѷอนไขทีѷ 1) 

หากผลกรณีทีѷใชข่องทกุเงืѷอนไขเป็นคา่เดยีวกนั สว่นผลกรณีทีѷไมใ่ชข่องเงืѷอนไขทีѷ 1 และผล
กรณีทีѷไมใ่ชข่องเงืѷอนไขทีѷ 2 เป็นคา่เดยีวกนั แทนทีѷจะใชส้ตูร IF ซอ้นกนัหลายสตูร ใหใ้ชส้ตูร 
And หรอื Or มาชว่ยในสตูร IF เพยีงสตูรเดยีวไดด้ังนีѸ 

=IF( And( เง ืѷอนไขทีѷ 1,เง ืѷอนไขทีѷ 2), ผลกรณใีช,่ ผลกรณีไมใ่ช)่ 

=IF( OR( เง ืѷอนไขทีѷ 1,เง ืѷอนไขทีѷ 2), ผลกรณีใช,่ ผลกรณีไมใ่ช)่ 

หมายเหต ุ

1. สตูร And จะคนืคา่เป็นจรงิตอ่เมืѷอทกุเงืѷอนไขเป็นจรงิพรอ้มกนั หากเงืѷอนไขใดเงืѷอนไข
หนึѷงเป็นเท็จ จะคนืคา่เป็นเท็จ (จําวา่ False เป็นลักษณะเดน่) 

2. สตูร OR จะคนืคา่เป็นเท็จตอ่เมืѷอทกุเงืѷอนไขเป็นเท็จพรอ้มกนั หากเงืѷอนไขใดเงืѷอนไข
หนึѷงเป็นจรงิ จะคนืคา่เป็นจรงิ (จําวา่ True เป็นลักษณะเดน่) 
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ตวัอยา่งการใช ้IF แบบกําหนดเงืѷอนไขแตกตอ่กรณีทีѷใชใ่นการป้องกนั
สตูรลบั  

 

สมมตวิา่เราตอ้งการบวกเลข 1 กบัเลข 2 ในเซลล ์B2 และ C2 เขา้ดว้ยกนั แตก่อ่นจะยอมให ้
สตูร B2+C2 ทํางานไดต้ามปกต ิตอ้งผา่นการกรอกรหัสลงไปในเซลล ์B4 และ B5 เป็นเลข 
123 และ 999 ตามลําดับใหถ้กูตอ้งเรยีบรอ้ยกอ่น 

ถา้สรา้งสตูร IF ซอ้น IF จะไดส้ตูรตามเซลล ์D2 

=IF( B4=123, IF(B5=999, B2+C2, 0), 0) 

หรอืใชส้ตูร And มาใชง้านรว่มดว้ย กลายเป็นสตูร IF เพยีงสตูรเดยีวดังนีѸ 

=IF( AND(B4=123,B5=999), B2+C2, 0) 

ในแงข่องการคํานวณแมส้ตูร IF ซอ้น IF กบีสตูร IF ซอ้น And ใหคํ้าตอบแบบเดยีวกนัก็ตาม 
แตใ่นแงข่องความเป็นจรงินัѸนการใช ้IF ซอ้น IF ตรวจสอบเงืѷอนไขทลีะขั Ѹน เมืѷอพบวา่ B4=123 
จรงิจงึจะผา่นไปตรวจสอบ B5=999 ในลําดับตอ่ไป สว่นเงืѷอนไขในสตูร And ถอืวา่เงืѷอนไขแต่
ละสว่นทํางานรว่มกนัหรอืจะเรยีกวา่ตอ้งตรวจเงืѷอนไขใหค้รบทัѸงหมดกอ่น 

ยกตัวอยา่งการตัดสนิใจเกีѷยวขอ้งกบัการสอบขอ้เขยีน พอสอบขอ้เขยีนผา่นถงึคะแนนทีѷกําหนด
แลว้จงึจะเขา้สอบสมัภาษณ์ กรณีแบบนีѸควรใชส้ตูร IF ซอ้น IF ซึѷงจะทําให ้Excel ทํางานเร็วขึѸน
ดว้ยเพราะสตูรจะคัดกรองเฉพาะคนทีѷผา่นขอ้เขยีนใหเ้หลอืรายการนอ้ยลงกอ่น 
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ตวัอยา่งการใช ้IF แบบกําหนดเงืѷอนไขแตกตอ่กรณีทีѷใชใ่นการรบัเงนิ
ในชว่งวนัทีѷกําหนด 

 

หากตอ้งการรับเงนิ 100 บาท ระหวา่งวันทีѷ 2-5 กําหนดใหใ้ช ้Range Name ในตารางตอ่ไปนีѸ 

 B3:B8 ชืѷอ From 
 C3:C8 ชืѷอ To 
 D3:D8 ชืѷอ Amount 
 E2:K2 ชืѷอ Date 

เซลล ์E3 เป็นสตูรรับเงนิในชว่งวันทีѷตอ้งการตามนีѸ 

=IF( Date>=From, IF(Date<=To,Amount,0), 0) 

หรอื 

=IF( AND(Date>=From,Date<=To), Amount, 0) 

ขอ้สงัเกต 

ตัวอยา่งนีѸใชส้ตูร And มาชว่ยเพราะตอ้งการใหค้นืคา่เป็น True เฉพาะในชว่งวันทีѷ 2-5 เทา่นัѸน 
(ดเูซลล ์E8:K8) 
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การใชส้ตูร IF ในการเปลีѷยนคา่หรอืแสดงคา่   

ในกรณีทีѷผลลัพธจ์ากการคํานวณหรอืคา่ทีѷไดจ้ากการลงิคต์อ่มาจากเซลลอ์ืѷน อาจไมใ่ชค่า่ทีѷ
ตอ้งการแสดงใหผู้ใ้ชเ้ห็นเสมอไป เราสามารถนําสตูร IF มาชว่ยเปลีѷยนคา่เดมินัѸนใหก้ลายเป็น
คา่ใหมห่รอืเปลีѷยนจากตัวเลขหรอืคําเตอืน Error ใหก้ลายเป็นตัวอกัษรทีѷสืѷอความหมายได ้
ชดัเจนกวา่แทน 

 

โปรดดตูัวอยา่งจาก Row 2 ขา้งตน้ ในการนําเลขมาหารกนันัѸน หากเป็นตัวเลขทีѷนํามาหารกนั
ได ้ก็ยอ่มคนืคา่ทีѷตอ้งการออกมาไดทั้นท ีเชน่ เมืѷอนําเลข 100 จากเซลล ์B2 มาหารดว้ยเลข 5 
จากเซลล ์C2 โดยสรา้งสตูร = B2/C2 ลงไปในเซลล ์D2 จะไดคํ้าตอบเป็นตัวเลข 20 

ใน Row 5 ถา้เปลีѷยนเลข 5 ทีѷเป็นตัวหาร ใหเ้ป็นเลข 0 แทน จะพบวา่สตูร =B5/C5 ไมส่ามารถ
คํานวณได ้โดยแสดง Error #DIV/0! ออกมาแทน (#DIV/0! ยอ่มาจากคําวา่ Error from 
Divided by Zero หรอื Error เนืѷองจากการถกูหารดว้ยเลข 0) 

เราสามารถเปลีѷยนการแสดง Error ใหเ้ป็นเลข 0 แทน โดยใชส้ตูรตามตัวอยา่งใน Row 8 ดังนีѸ 

=IF(C8=0, 0, B8/C8) 

หรอือา่นสตูรเป็นคําแปลวา่ ถา้เซลลต์ัวหารมคีา่เทา่กบั 0 ใหผ้ลลัพธแ์สดงเลข 0 แทนการแสดง 
Error แตถ่า้ตัวหารไมใ่ชเ่ลข 0 ก็ใหคํ้านวณหารกนัตอ่ไปตามปกต ิ

ถา้ตัวหารไมใ่ชเ่ลข 0 แตก่ลับกลายเป็นตัวอกัษร o จะพบวา่สตูร IF ขา้งตน้นีѸคอืคา่ออกมาเป็น 
#VALUE! แทน เพราะ Excel ไมย่อมรับการนําตัวอกัษรไปหารตัวเลข 

ใน Row 11 กรณีทีѷตัวหารเป็นตัวอกัษร o (หรอืตัวอกัษรอืѷนใด) เราสามารถป้องกนัการเกดิ 
Error จากการหารโดยใชส้ตูร IsError มาชว่ยตรวจสอบการคํานวณวา่จะเกดิ Error หรอืไม ่
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=IF( ISERROR(B11/C11), 0, B11/C11) 

หรอืตั Ѹงแต ่Excel 2007 เป็นตน้มาม ีIfError เป็นสตูรใหมท่ีѷสั Ѹนลง 

=IFERROR(B11/C11,0) 

หมายเหต ุ

1. กอ่นทีѷจะใชส้ตูร IsError ควรหาทางตรวจสอบสตูรคํานวณทีѷสรา้งกอ่นวา่สามารถ
คํานวณไดคํ้าตอบทีѷตอ้งการหรอืไม ่เพราะหากใชส้ตูร IsError เขา้มาชว่ยรว่มกบัสตูร IF 
แลว้ เราจะไมเ่ห็น Error เกดิขึѸนอกีเลย 

2. ควรเลอืกนําเฉพาะบางสว่นของการคํานวณจากสตูรทีѷจะนํามาตรวจสอบดว้ยสตูร 
IsError โดยไมจํ่าเป็นตอ้งนําสตูรยาวๆทั Ѹงหมดมาใสล่งไปในวงเล็บของสตูร IsError 

3. ในกรณีทีѷเกดิ Error ขึѸน ในกรณีทีѷผลลัพธเ์ดมิเป็น Text ควรเปลีѷยน Error เป็นคําเตอืน 
หรอืกรณีผลลัพธเ์ดมิเป็นเลข ควรเปลีѷยน Error เป็นเลข 0 แทน จากนัѸนใหใ้ช ้Format 
0;-0; ซอ่นเลข 0 ใหด้เูหมอืนเป็นชอ่งวา่ง 

4. ในการเปลีѷยนการแสดง Error ใหแ้สดงเป็นชอ่งวา่ง พยายามหลกีเลีѷยงการใช ้Null Text 
หรอื "" (แทนการใชเ้ลข 0) เพราะ "" มสีภาพเป็น Text ซึѷงหากนําคา่นีѸไปบวกลบคณู
หารตอ่จะเกดิ Error ตอ่ไปอกี กลายเป็นภาระใหเ้ราตอ้งสรา้งสตูร =IF(Cell="", "", 
Cell) ตอ่ไปอกี ซึѷงทําใหแ้ฟ้มคํานวณชา้ลงและมขีนาดใหญข่ึѸนโดยไมจํ่าเป็น 

5. ในกรณีทีѷตอ้งการแสดง #N/A ใหใ้ชส้ตูร NA() 
6. นอกเหนอืจากการใชส้ตูร IF ชว่ยในการเปลีѷยน Error ใหเ้ป็นคา่อืѷนแลว้ ในหนา้กระดาษ

ทีѷถกูพมิพ ์สามารถใชคํ้าสัѷง Page Setup > Sheet > Print > Cells error as เพืѷอ
เปลีѷยนเซลลท์ีѷมคีา่เป็น Error ใหแ้สดงเป็นชอ่งวา่ง, --, #N/A แทนไดอ้กีดว้ย 

สตูรกลุม่ Is ทีѷใชช้ว่ยในการตรวจสอบ  

 IsNA ตรวจสอบ Error #N/A "Not Available" ซึѷงเกดิจากสตูรกลุม่ Lookup ในกรณีทีѷ
หาคา่ทีѷตอ้งการไมพ่บ 

 IsError ตรวจสอบ Error ทกุประเภท 
 IsErr ตรวจสอบ Error เกอืบทกุประเภท เวน้ NA 
 IsBlank ตรวจสอบเซลลว์า่ง 
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 IsText ตรวจสอบเซลลม์คีา่เป็น Text หรอืคา่ทีѷจะชดิซา้ยใหเ้องเมืѷอพมิพล์งไป เชน่ 
'123 ถอืวา่เป็น Text 

 IsNumber ตรวจสอบเซลลม์คีา่เป็น Number หรอืคา่ทีѷจะชดิขวาใหเ้องเมืѷอพมิพล์งไป 
เชน่ 10/4/2010 จะชดิขวาเพราะถอืวา่เป็น Number 

การใชส้ตูร IF ในการเปลีѷยนเสน้ทางการสง่คา่   

ตามปกตสิตูรทีѷสรา้งลงไปในเซลลจ์ะทําหนา้ทีѷคํานวณหรอืรับคา่ทีѷลงิคม์าจากเซลลต์น้ทาง สว่น
การสง่คา่จากเซลลต์น้ทางไปยังเซลลป์ลายทางโดยไมต่อ้งสรา้งสตูรลงไปในเซลลนั์Ѹนไม่
สามารถทําไดโ้ดยวธิปีกตทัิѷวไป แตต่อ้งเขยีนรหัส VBA เขา้มาชว่ย 

 

ตัวอยา่ง กําหนดใหส้ง่คา่จากเซลล ์Source ไปยังเซลล ์Target1 หรอื Target2 ตามเงืѷอนไข
ตอ่ไปนีѸ 

 หาก Source มคีา่นอ้ยกวา่ 0 เชน่มคีา่เป็นเลข -111 ใหส้ง่คา่ -111 ไปยังเซลล ์
Target1 

 หาก Source มคีา่มากกวา่หรอืเทา่กบั 0 เชน่มคีา่เป็นเลข 222 ใหส้ง่คา่ 222 ไปยัง
เซลล ์Target2 

เริѷมตน้จากใหต้ั Ѹงชืѷอ Source, Target1, Target2 ใหก้บัเซลล ์C2, C5 ,C6 ตามลําดับและตั Ѹงชืѷอ 
Target เป็น Formula Name มคีา่เป็นสตูร 

=IF( Source<0, Target1, Target2) 

จากนัѸนใหส้รา้งชดุคําสัѷงนีѸลงไปใน Visual Basic Editor 

Sub SendData() 
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MyVar = [Source] 

[Target] = MyVar 

End Sub 

 

1. ชดุคําสัѷงนีѸจะรับคา่ทีѷเก็บไวใ้นเซลลท์ีѷตั Ѹงชืѷอไวว้า่ Source ไปเก็บไวท้ีѷตัวแปรทีѷมชีืѷอวา่ 
MyVar 

2. จากนัѸนคา่ทีѷเก็บไวใ้น MyVar จะถกูสง่ตอ่ไปยัง Formula Name ทีѷตั Ѹงชืѷอไวว้า่ Target 
3. เนืѷองจาก Target เป็นสตูร =IF( Source<0, Target1, Target2) จงึทําหนา้ทีѷ

ตรวจสอบคา่ทีѷรับมาจาก Source กอ่นแลว้จงึเลอืกสง่คา่ไปยังเซลลท์ีѷตั Ѹงชืѷอวา่ Target1 
หรอื Target2 ตามเงืѷอนไขทีѷกําหนดไวข้า้งตน้ตอ่ไป 

วธิกีารใช ้VBA นีѸอยูใ่นหลักสตูรเคล็ดการเพิѷมผลงาน ลดความซบัซอ้นของงานดว้ย Excel VBA 
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หลบรอ้นหนสีตูร IF ไปหาทางออกอืѷน 

สตูร IF เป็นสตูรทีѷมคีวามยดืหยุน่อยา่งมาก เราสามารถใชทั้ Ѹงตัวเลข ตัวอกัษร สตูรอืѷน หรอื
ตําแหน่งอา้งองิเพืѷอใชใ้นการกําหนดเงืѷอนไข และสามารถใชเ้งืѷอนไขเปรยีบเทยีบคา่ไดทั้ Ѹง
เทา่กบั มากกวา่ นอ้ยกวา่ หรอืไมเ่ทา่กบั ซึѷงใน Excel ตั Ѹงแตรุ่น่ 2007 เป็นตน้มาไดป้รับปรงุให ้
สามารถนําสตูรมาซอ้นเขา้ไปไดถ้งึ 64 สตูร ทําใหใ้ชส้ตูร IF ไดก้วา้งขวางกวา่ Excel 2003 
หรอืรุน่เกา่กอ่นนัѸนทีѷซอ้นสตูรไดอ้กีเพยีง 7 สตูรเทา่นัѸน 

ไมว่า่จะใชส้ตูร IF ใหเ้ต็มทีѷตามความสามารถของ Excel รุน่เกา่หรอืรุน่ใหม ่ถา้เขยีนสตูร IF 
ซอ้นกนัจนกลายเป็นสตูรยาวเหยยีดตามสตูรในเซลล ์D9 ตอ่ไปนีѸ คณุคดิวา่อยากจะใชส้ตูร IF 
ตอ่ไปอกีหรอื 

 

=IF(F9>C9,1,IF(SUM(F9:G9)>C9,2,IF(SUM(F9:H9)>C9,3,IF(SUM(F9:I9)>C9,4,IF(SU
M(F9:J9)>C9,5,IF(SUM(F9:K9)>C9,6,IF(SUM(F9:L9)>C9,7,0))))))) 

+IF(SUM(F9:L9)>C9,0,IF(SUM(F9:M9)>C9,8,IF(SUM(F9:N9)>C9,9,IF(SUM(F9:O9)>
C9,10,IF(SUM(F9:P9)>C9,11,IF(SUM(F9:Q9)>C9,12,IF(SUM(F9:R9)>C9,13,0))))))) 

+IF(SUM(F9:R9)>C9,0,IF(SUM(F9:S9)>C9,14,IF(SUM(F9:T9)>C9,15,IF(SUM(F9:U9)
>C9,16,IF(SUM(F9:V9)>C9,17,IF(SUM(F9:W9)>C9,18,IF(SUM(F9:X9)>C9,19,0)))))
)) 

+IF(SUM(F9:X9)>C9,0,IF(SUM(F9:Y9)>C9,20,IF(SUM(F9:Z9)>C9,21,IF(SUM(F9:AA9
)>C9,22,IF(SUM(F9:AB9)>C9,23,IF(SUM(F9:AC9)>C9,24,IF(SUM(F9:AD9)>C9,25,0)
)))))) 
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+IF(SUM(F9:AD9)>C9,0,IF(SUM(F9:AE9)>C9,26,IF(SUM(F9:AF9)>C9,27,IF(SUM(F9:
AG9)>C9,28,IF(SUM(F9:AH9)>C9,29,IF(SUM(F9:AI9)>C9,30,IF(SUM(F9:AJ9)>C9,31
,0))))))) 

สตูรขา้งตน้เป็นสตูรคํานวณหาวันทีѷใดในแตล่ะเดอืนซึѷงสนิคา้ทีѷเก็บไวใ้น Stock จะเริѷมไม่
เพยีงพอตอ่การเบกิใช ้โดยตอ้งนําสตูร IF มาซอ้นกนัเพืѷอตรวจสอบยอดเบกิใชส้ะสมตั Ѹงแตว่ัน
แรกไปจนถงึสิѸนเดอืน เริѷมจากยอดเบกิวันแรกในเซลล ์F9 กลายเป็นยอดเบกิสะสม 2 วันจาก
เซลล ์F9:G9 หรอืยอดเบกิสะสม 3 วันจากเซลล ์F9:H9 เรืѷอยไปจนถงึ F9:AJ9 ซึѷงเป็นยอดเบกิ
ใชส้ะสมถงึ 31 ครั Ѹงตามจํานวนวันในแตล่ะเดอืนมาเทยีบกบัปรมิาณ Stock ในเซลล ์C9  

ถา้ใช ้Excel 2003 หรอืรุน่กอ่นนัѸน ตอ้งแยกสตูรทีѷซอ้นกนัชดุละ 7 วัน โดยกําหนดเงืѷอนไขในแต่
ละชดุวา่ หากไมเ่ป็นจรงิใหค้นืคา่เทา่กบั 0 โปรดสงัเกตวา่ในวงเล็บของ IF ทีѷซอ้นกนัแตล่ะชดุ
นัѸนจะลงทา้ยดว้ย ,0))))))) แลว้จงึนําสตูร IF ทีѷซอ้นกนัมาบวกเขา้ดว้ยกนั 

โจทยเ์ดยีวกนันีѸ หากใช ้Excel 2007 เป็นตน้มา เราสามารถซอ้น IF ลงไปในวงเล็บของสตูร IF 
รว่มกนัไดส้งูสดุถงึ 64 สตูรไดเ้ลย ทําใหส้ตูรสั Ѹนลงบา้งเหลอืสตูรตามนีѸ 

=IF(F9>C9,1,IF(SUM(F9:G9)>C9,2,IF(SUM(F9:H9)>C9,3,IF(SUM(F9:I9)>C9,4,IF(SU
M(F9:J9)>C9,5,IF(SUM(F9:K9)>C9,6,IF(SUM(F9:L9)>C9,7,IF(SUM(F9:M9)>C9,8,IF(
SUM(F9:N9)>C9,9,IF(SUM(F9:O9)>C9,10,IF(SUM(F9:P9)>C9,11,IF(SUM(F9:Q9)>C9
,12,IF(SUM(F9:R9)>C9,13,IF(SUM(F9:S9)>C9,14,IF(SUM(F9:T9)>C9,15,IF(SUM(F9:
U9)>C9,16,IF(SUM(F9:V9)>C9,17,IF(SUM(F9:W9)>C9,18,IF(SUM(F9:X9)>C9,19,IF(
SUM(F9:Y9)>C9,20,IF(SUM(F9:Z9)>C9,21,IF(SUM(F9:AA9)>C9,22,IF(SUM(F9:AB9)
>C9,23,IF(SUM(F9:AC9)>C9,24,IF(SUM(F9:AD9)>C9,25,IF(SUM(F9:AE9)>C9,26,IF(
SUM(F9:AF9)>C9,27,IF(SUM(F9:AG9)>C9,28,IF(SUM(F9:AH9)>C9,29,IF(SUM(F9:AI
9)>C9,30,IF(SUM(F9:AJ9)>C9,31,0))))))))))))))))))))))))))))))) 

แมส้ตูร IF สามารถคํานวณหาคําตอบไดต้ามตอ้งการ แตจ่ากโครงสรา้งยาวเหยยีดนอกจากจะ
ทําใหแ้ฟ้มมขีนาดใหญข่ึѸนแลว้ ยังเพิѷมความเสีѷยงในการตดิตามแกไ้ขหรอืตรวจสอบอกีดว้ย 
ดังนัѸนแทนทีѷจะใชส้ตูร IF เราสามารถใชส้ตูรตอ่ไปนีѸแทน 

=(F9<=C9)+(SUM(F9:G9)<=C9)+(SUM(F9:H9)<=C9)+(SUM(F9:I9)<=C9)+(SUM(F
9:J9)<=C9)+(SUM(F9:K9)<=C9)+(SUM(F9:L9)<=C9)+(SUM(F9:M9)<=C9)+(SUM(F
9:N9)<=C9)+(SUM(F9:O9)<=C9)+(SUM(F9:P9)<=C9)+(SUM(F9:Q9)<=C9)+(SUM(
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F9:R9)<=C9)+(SUM(F9:S9)<=C9)+(SUM(F9:T9)<=C9)+(SUM(F9:U9)<=C9)+(SUM
(F9:V9)<=C9)+(SUM(F9:W9)<=C9)+(SUM(F9:X9)<=C9)+(SUM(F9:Y9)<=C9)+(SU
M(F9:Z9)<=C9)+(SUM(F9:AA9)<=C9)+(SUM(F9:AB9)<=C9)+(SUM(F9:AC9)<=C9)
+(SUM(F9:AD9)<=C9)+(SUM(F9:AE9)<=C9)+(SUM(F9:AF9)<=C9)+(SUM(F9:AG9)
<=C9)+(SUM(F9:AH9)<=C9)+(SUM(F9:AI9)<=C9)+(SUM(F9:AJ9)<=C9)+1 

ถา้ยังยาวเกนิไปอกี ก็ตอ้งหันมาใชส้ตูร Array กนัตามนีѸ 

{=SUM((SUBTOTAL(9,INDIRECT(ADDRESS(ROW(F9),COLUMN(F9))&":"&ADDRESS(
ROW(F9),ROW(INDIRECT(COLUMN(F9)&":"&COLUMN(AJ9))))))<=C9)*1)+1} 

หนสีตูร IF ไปใชส้ตูร Choose หรอื Index   

Choose เป็นสตูรซึѷงทําหนา้ทีѷเลอืกคา่ทีѷใสไ่วใ้นวงเล็บของตัวสตูร Choose เองตามเลขลําดับทีѷ
เรากําหนด โดยใชเ้ลขลําดับตั Ѹงแตเ่ลข 1 - 254 ตามโครงสรา้งสตูร ดังนีѸ 

=CHOOSE(เลขลําดับ, คา่ทีѷ1, คา่ทีѷ2, .... คา่ทีѷ 254) 

สตูร Choose กบัสตูร IF มคีวามเหมอืนกนัตรงทีѷ 2 สตูรนีѸเหมาะกบัการหาคา่คําตอบจากคา่ทีѷ
กระจายตัวโดยไมจํ่าเป็นตอ้งอยูใ่นตารางทีѷเป็นพืѸนทีѷตอ่เนืѷองกนัไป เพยีงแตส่ตูร Choose ตอ้ง
ใชต้ัวเลขลําดับเป็นเลขจํานวนเต็มตั Ѹงแตเ่ลข 1 - 254 เป็นเงืѷอนไขในการเลอืกคําตอบ สว่นสตูร 
IF สามารถรบัเงืѷอนไขเปรยีบเทยีบไดทั้ Ѹงตัวเลขและตัวอกัษรและไมจํ่ากดัวา่ตอ้งใชเ้งืѷอนไขกรณี
เทา่กนัเพยีงอยา่งเดยีวเชน่ทีѷสตูร Choose กําหนดไว ้

สมมตวิา่สตูร IF ทีѷใชอ้ยูเ่ป็นสตูรตามนีѸ  

=IF(E9="A",C2,IF(E9="B",C5,IF(E9="C",C8,IF(E9="D",C11,IF(E9="E",C14,IF(
E9="F",C17,IF(E9="G",F2,IF(E9="H",F17,IF(E9="I",I2,IF(E9="J",I5,IF(E9="K
",I8,IF(E9="L",I11,IF(E9="M",I14,I17))))))))))))) 

สตูรขา้งตน้ใชค้า่ในเซลล ์E9 เป็นเงืѷอนไขในการเปรยีบเทยีบกบัตัวอกัษร A - M เชน่ ถา้เซลล ์
E9 มคีา่เป็นตัวอกัษร A จะคนืคา่เป็นคา่จากเซลล ์C2 แตถ่า้เซลล ์E9 มคีา่เป็นตัวอกัษร B จะคนื
คา่เป็นคา่จากเซลล ์C5 เป็นตน้ 
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เนืѷองจากเงืѷอนไขทีѷใชใ้นสตูร IF ใชเ้ทยีบกบัตัวอกัษร จงึไมม่ทีางทีѷจะนําสตูร Choose มาใช ้

แทน แตห่ากเราสามารถเปลีѷยนเงืѷอนไขจากตัวอกัษรทีѷใชเ้ดมิ หันมาใชเ้ปรยีบเทยีบกบัตัวเลข
แทน กลายเป็นสตูรตามนีѸ 

=IF(E9=1,C2,IF(E9=2,C5,IF(E9=3,C8,IF(E9=4,C11,IF(E9=5,C14,IF(E9=6,C1
7,IF(E9=7,F2,IF(E9=8,F17,IF(E9=9,I2,IF(E9=10,I5,IF(E9=11,I8,IF(E9=12,I
11,IF(E9=13,I14,I17))))))))))))) 

สตูร IF ทีѷแกไ้ขใหมน่ีѸ ใชค้า่ในเซลล ์E9 เป็นเงืѷอนไขในการเปรยีบเทยีบกบัตัวเลข 1 - 13 เชน่ 
ถา้เซลล ์E9 มคีา่เป็นตัวเลข 1 จะคนืคา่เป็นคา่จากเซลล ์C2 แตถ่า้เซลล ์E9 มคีา่เป็นตัวเลข 2 
จะคนืคา่เป็นคา่จากเซลล ์C5 เป็นตน้ 

เนืѷองจากสตูร IF ใชเ้งืѷอนไขเทยีบกบัตัวเลข และเป็นตัวเลขจํานวนเต็มตั Ѹงแตเ่ลข 1 - 13 ซึѷงไม่
เกนิ 254 และเป็นเงืѷอนไขทีѷใชก้ารตรวจสอบวา่เทา่กบัหรอืไมเ่ทา่นัѸน (ไมไ่ดต้รวจสอบวา่
มากกวา่นอ้ยกวา่) จงึสามารถใชส้ตูร Choose ทีѷสั Ѹนกวา่แทนไดด้ว้ยตามนีѸ 

=CHOOSE(E9, C2,C5,C8,C11,C14,C17,F2,F17,I2,I5,I8,I11,I14,I17) 

ถา้เซลล ์E9 มคีา่เป็นตัวเลข 1 จะคนืคา่เป็นคา่จากเซลล ์C2 แตถ่า้เซลล ์E9 มคีา่เป็นตัวเลข 2 
จะคนืคา่เป็นคา่จากเซลล ์C5 แตถ่า้ E9 มคีา่เป็นตัวเลข 14 จะคนืคา่เป็นคา่จากเซลล ์I17 

สตูร Choose สามารถใชเ้ลอืกคา่ทีѷกระจาย ซึѷงการกระจายตัวนีѷเองทีѷจะกลายเป็นหนามยอกอก
หากมกีารกระจายตัวกนัมากเกนิไปเชน่สตูรตอ่ไปนีѸ 

=CHOOSE(E9, C2,C5,C8,C11,C14,C17,F2,F17,I2,I5,I8, 

I11,I14,I17,D3,D6,D9,D12,D15,D18,G3,G18,J3,J6,J9, 

J12,J15,J18,E4,E7,E10,E13,E16,E19,H4,H19,K4,K7, 

K10,K13,K16,K19) 

เพยีงเห็นสตูรแวบเดยีวก็รูส้กึเหนืѷอยแลว้ใชไ่หม แมว้า่สตูร Choose จะสามารถใชเ้ลอืกคา่ทีѷ
กระจายตัวกนัอยูไ่ดส้งูสดุถงึ 254 คา่ก็ตาม หากเราเผลอจัดลําดับคา่คําตอบสลับทีѷกนัเพยีงคา่
เดยีว จะสง่ผลทําใหส้ตูร Choose คนืคา่คําตอบผดิพลาดทันท ี
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ถา้คา่ทีѷตอ้งการเลอืกนัѸนถกูนํามาจัดลําดับใหมไ่วใ้นตารางใหเ้ป็นพืѸนทีѷซ ึѷงตอ่เนืѷองกนัไป เรา
สามารถนําสตูร Index มาใชแ้ทน Choose เพราะสตูร Index มโีครงสรา้งสตูรตามนีѸ 

=INDEX(พืѸนทีѷตารางทีѷเป็น Single Row, เลขลําดับ) 

หรอื 

=INDEX(พืѸนทีѷตารางทีѷเป็น Single Column, เลขลําดับ) 

Single Row หรอื Single Column หมายถงึพืѸนทีѷตารางทีѷมคีวามสงูหรอืความกวา้งเป็นเซลล์
เดยีวตามแนวนอนหรอืแนวตั Ѹง 

ดังนัѸนแทนทีѷจะใชส้ตูร IF หรอืสตูร Choose ตามตัวอยา่งทีѷกลา่วไปแลว้นัѸน หากเราสามารถจัด
โครงสรา้งตารางใหมใ่หอ้ยูใ่นแนวนอนหรอืแนวตั Ѹง และใชต้ัวเลขจํานวนเต็มตั Ѹงแตเ่ลข 1 เป็นตน้
ไปเป็นตัวชีѸตําแหน่ง ก็ควรหันมาใชส้ตูร Index แทนดกีวา่ กลายเป็นสตูรตามนีѸ 

=INDEX(A1:A10000, E9) 

ถา้เซลล ์E9 มคีา่เป็นตัวเลข 1 จะคนืคา่เป็นคา่จากเซลล ์A1 แตถ่า้เซลล ์E9 มคีา่เป็นตัวเลข 2 
จะคนืคา่เป็นคา่จากเซลล ์A2 แตถ่า้ E9 มคีา่เป็นตัวเลข 10000 จะคนืคา่เป็นคา่จากเซลล ์
A10000 ซึѷงการนําคา่ทีѷตอ้งการมาจัดไวใ้นพืѸนทีѷเซลล ์A1:A10000 ทําใหง้า่ยในการคน้หา
ตําแหน่งเซลลเ์พืѷอบันทกึหรอืเปลีѷยนแปลงคา่ใหมใ่นอนาคต 

การเลอืกใชส้ตูรไดอ้ยา่งเหมาะสม สตูรนัѸนตอ้งสามารถรองรับกบัเงืѷอนไขทีѷอาจเปลีѷยนแปลงได ้
ในอนาคตโดยเราไมต่อ้งยอ้นกลับมาแกไ้ขสตูรเกา่ทีѷเคยสรา้งไวอ้กีเลย ดังนัѸนจะเลอืกใชส้ตูร IF 
หรอื Choose หรอื Index ก็ตอ้งคดิพจิารณาใหเ้หมาะสมดว้ยวา่โครงสรา้งตารางและคา่ทีѷใชเ้ป็น
เงืѷอนไขนัѸนเป็นอยา่งไร  

แทนทีѷจะปลอ่ยใหบ้ันทกึคา่อยา่งตามใจหรอืไมไ่ดใ้สใ่จวา่จะใชตํ้าแหน่งเซลลท์ีѷใดในการบันทกึ
คา่ หากรูจั้กออกแบบตารางใหเ้หมาะสมจะชว่ยใหเ้ราสามารถเลอืกใชส้ตูรไดย้ดืหยุน่มากขึѸน 
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หนสีตูร IF ไปใชส้ตูร VLookup   

VLookup ยอ่มาจากคําวา่ Vertical Lookup ทําหนา้ทีѷตรงตามคําแปลทีѷหมายถงึการมองตาม
แนวตั Ѹง โดยเริѷมจากใชค้า่ทีѷตอ้งการคน้หา นําไปเปรยีบเทยีบกบัคา่ทีѷเก็บไวใ้นตารางจาก 
Column ซา้ยสดุวา่ คา่ทีѷใชค้น้หานัѸนอยูใ่นแนวของคา่ใดใน Column ซา้ยสดุนัѸน แลว้คนืคา่เป็น
คําตอบจาก Column ตามเลขทีѷเราตอ้งการ โดย VLookup มโีครงสรา้งสตูร 2 แบบ 

โครงสรา้งสตูรแบบ Approaching Match  

เหมาะกบัตารางขอ้มลูทีѷ Column ซา้ยสดุเป็นตัวเลขตอ่เนืѷองทีѷเรยีงคา่จากนอ้ยไปมาก 
โครงสรา้งนีѸทํางานตามเงืѷอนไขแบบนอ้ยกวา่หรอืเทา่กบั 

=VLOOKUP(คา่ทีѷใชห้า, ตารางทีѷเก็บคา่, เลขทีѷ Column ของคําตอบ) 

โครงสรา้งสตูรแบบ Exact Match  

เหมาะกบัตารางขอ้มลูทีѷ Column ซา้ยสดุเป็นรหัส ซึѷงไมจํ่าเป็นตอ้งเรยีงคา่ โครงสรา้งนีѸ
ทํางานแบบเงืѷอนไขเทา่กบั 

=VLOOKUP(คา่ทีѷใชห้า, ตารางทีѷเก็บคา่, เลขทีѷ Column ของคําตอบ,  
   FALSE หรอื 0) 

ในกรณีทีѷใชส้ตูร IF หาคําตอบเป็นเกรด A B หรอื C โดยใชส้ตูร =IF( E3>=B3, C3, 
IF(E3>=B4,C4,C5) ) 

 

หากตอ้งการเปลีѷยนมาใชส้ตูร VLookup ตอ้งเรยีงคะแนนในตารางจากนอ้ยไปมาก ตามรปู
ตอ่ไปนีѸแทน 
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เซลล ์F3 สรา้งสตูร =VLOOKUP(E3,B3:C5,2) ซึѷงเป็นสตูร VLookup แบบ Approaching 
Match เนืѷองจากคา่ทีѷใชห้าเป็นตัวเลข และตัวเลขนีѸสามารถเป็นตัวเลขทีѷตอ่เนืѷองกนัไป และคนื
คา่ไดคํ้าตอบเป็นเกรด B โดยมลํีาดับการทํางานของสตูร ดังนีѸ 

1. VLookup นําคะแนนทีѷสอบได ้75 คะแนน ไปตรวจสอบกบัตารางขอ้มลู B3:C5 
2. ใน Column ซา้ยสดุทีѷเรยีงเลขจากนอ้ยไปมากนัѸน พบวา่เลขคะแนน 70 เป็นเลขทีѷมาก

ทีѷสดุทีѷยังนอ้ยกวา่หรอืเทา่กบัเลข 75 ซึѷงเป็นคะแนนทีѷสอบได ้แสดงวา่คําตอบทีѷตอ้งการ 
อยูใ่นแนวเดยีวกบัเลขคะแนน 70 แน่นอน 

3. เลข 2 ทีѷใสล่งไปในวงเล็บของสตูร VLookup เป็นตัวเลขแทน Column ทีѷสองในพืѸนทีѷ
ตาราง B3:C5 ซึѷงเป็น Column เรืѷองเกรดทีѷเป็นคําตอบ จงึคนืคา่ออกมาเป็นเกรด B 

หากเลอืกใชส้ตูรแบบ Exact Match =VLOOKUP(E3,B3:C5,2,0) ซึѷงเพิѷมเลข 0 ตอ่ทา้ยลงไป
ในวงเล็บ จะไดคํ้าตอบเป็น #N/A เนืѷองจาก Column ซา้ยสดุทีѷเป็นตัวเลขคะแนน ไมม่เีลข 75 
แสดงไว ้จงึคนืคา่คําตอบออกมาวา่ Not Available แสดงวา่หาคา่ทีѷตอ้งการไมพ่บ 

แมก้ารใชส้ตูร VLookup จะชว่ยใหไ้ดส้ตูรทีѷสั Ѹนลงก็ตาม แตจ่ะทําให ้Excel คํานวณชา้กวา่ใน
กรณีทีѷใชส้ตูร IF หากตารางทีѷใชเ้ก็บขอ้มลูมขีนาดใหญข่ึѸน ก็จะสง่ผลใหส้ตูร VLookup คํานวณ
ชา้ลง เราจงึตอ้งพงึระวังไวเ้สมอวา่ทกุอยา่งมทัี Ѹงขอ้ดขีอ้เสยี ไดอ้ยา่งก็จําเป็นตอ้งเสยีอยา่ง
เชน่กนั 
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หนสีตูร IF ไปใชส้ตูร Max Min หรอืแคใ่ชว้งเล็บชว่ย   

ในบรรดาเงืѷอนไขทีѷใชก้นัมากทีѷสดุในชวีติประจําวันเห็นจะหนีไมพ่น้เงืѷอนไขเกีѷยวกบัการตัดสนิใจ
ในเรืѷองหา้มเกนิกวา่หรอืหา้มตํѷากวา่ ยกตัวอยา่งทีѷใกลต้ัว เชน่ เกณฑก์ารคํานวณภาษีเงนิได ้
บคุคลธรรมดา มหีลักคํานวณภาษีจากเงนิไดว้า่ เงนิไดช้ว่งทีѷไมเ่กนิกวา่ยอดนัѸนยอดนีѸใหใ้ชอ้ตัรา
ภาษีเทา่นัѸนเทา่นีѸ หรอืภาษีเงนิไดข้องบรษัิทตอ้งคํานวณจากยอดกําไร แตถ่า้ขาดทนุก็ไม่
จําเป็นตอ้งจา่ยภาษี เทยีบไดก้บัเงืѷอนไขทีѷหา้มคดิภาษีถา้มตีัวเลขตํѷากวา่ 0 นัѷนเอง 

ถา้มตีัวเลขใดๆทีѷอาจเป็นไปไดทั้ Ѹงคา่บวกลบและศนูย ์แลว้กําหนดใหใ้ชส้ตูร IF ปรับคา่นีѸใหเ้ป็น
คา่ใหมท่ีѷหา้มตํѷากวา่ 0 แตถ่า้ตัวเลขนัѸนมคีา่มากกวา่ 0 อยูแ่ลว้ ก็ขอใหค้งคา่เดมิ จะตอ้งสรา้ง
สตูรตามนีѸ 

=IF(เซลลต์วัเลข<0, 0, เซลลต์ัวเลข) 

หรอื 

=IF(เซลลต์วัเลข>=0, เซลลต์ัวเลข, 0) 

แทนทีѷจะใชส้ตูร IF ในเงืѷอนไขทีѷเกีѷยวขอ้งกบัขอ้กําหนดหา้มตํѷากวา่หรอืหา้มเกนิกวา่ เรา
สามารถนําสตูร Max หรอื Min มาใชแ้ทนโดยใชห้ลักชว่ยจํา ดังนีѸ 

 สตูร Max หรอื Min นีѸทํางานตรงขา้มกบัความเขา้ใจ 
 ปกตสิตูร Max ทําหนา้ทีѷหาคา่สงูสดุ แตใ่หใ้ชก้บัเงืѷอนไขหา้มตํѷากวา่ โดยใชส้ตูร 

=MAX(ตวัเลขตามเกณฑต์ํѷาสดุทีѷเป็นไปได,้ ตวัเลขทีѷตอ้งการเทยีบ) 
 ปกตสิตูร Min ทําหนา้ทีѷหาคา่ตํѷาสดุ แตใ่หใ้ชก้บัเงืѷอนไขหา้มเกนิกวา่ โดยใชส้ตูร 

=MIN(ตวัเลขตามเกณฑส์งูสดุทีѷเป็นไปได,้ ตวัเลขทีѷตอ้งการเทยีบ) 

ตามตัวอยา่งขา้งตน้ทีѷใชส้ตูร IF ปรับตัวเลขไมใ่หตํ้ѷากวา่ 0 นัѸน สามารถเปลีѷยนมาใชส้ตูร Max 
ตอ่ไปนีѸแทน 

=MAX(0, เซลลต์ัวเลข) 

สว่นในกรณีทีѷตอ้งการสรา้งสตูรควบคมุตัวเลขไมใ่หเ้กนิเลข 100 สามารถใชส้ตูร IF หรอื Min 
ไดต้ามนีѸ 

=IF(เซลลต์วัเลข>100, 100, เซลลต์ัวเลข) 
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หรอื 

=IF(เซลลต์วัเลข<=100, เซลลต์ัวเลข, 100) 

หรอื 

=MIN(100, เซลลต์ัวเลข) 

นอกจากนีѸเรายังสามารถใชว้งเล็บชว่ยในการตัดสนิใจโดยไมจํ่าเป็นตอ้งพึѷงพาสตูรใดๆ เชน่ 
กรณีทีѷตอ้งการเปลีѷยนตัวเลขใหไ้มตํ่ѷากวา่ 0 ตามตัวอยา่งขา้งตน้ ใหใ้ชส้ตูรทีѷใชว้งเล็บชว่ย
ตอ่ไปนีѸไดเ้ลย 

=(เซลลต์ัวเลข<=0)*0 + (เซลลต์ัวเลข>0)*เซลลตั์วเลข 

การใชว้งเล็บชว่ยในการตัดสนิใจ มหีลักการดังนีѸ 

1. สามารถใชไ้ดเ้ฉพาะเมืѷอผลลัพธท์ีѷตอ้งการเป็นตัวเลขเทา่นัѸน เนืѷองจากตอ้งนําตัวเลขมา
คํานวณตอ่กนัไปเรืѷอยๆ 

2. หากมหีลายวงเล็บ ตอ้งมเีงืѷอนไขเดยีวในวงเล็บหนึѷงเทา่นัѸนทีѷเป็นจรงิ และเงืѷอนไขใน
วงเล็บอืѷนตอ้งเป็นเท็จทั Ѹงหมด 

3. เงืѷอนไขทีѷใชต้รวจสอบนัѸน ถา้คนืคา่เป็นเท็จ ถอืวา่มคีา่เทา่กบัเลข 0 แตถ่า้คนืคา่เป็นจรงิ 
ถอืวา่มคีา่เทา่กบัเลข 1 

4. ใหนํ้าเงืѷอนไขมาบวกกนัในกรณีทีѷกําหนดใหเ้งืѷอนไขเดยีวเทา่นัѸนเป็นจรงิ หรอืนําเงืѷอนไข
มาคณูกนัในกรณีทีѷตอ้งการตรวจสอบวา่ทกุเงืѷอนไขเป็นจรงิพรอ้มกนั 

จากตัวอยา่งขา้งตน้ในกรณีทีѷหา้มตํѷากวา่ 0 เชน่ เซลลต์ัวเลขมคีา่เทา่กบั -5 เมืѷอนํามาแทนคา่ลง
ไปในสตูร =(เซลลต์ัวเลข<=0)*0 + (เซลลต์ัวเลข>0)*เซลลต์ัวเลข แลว้ Excel จะคดิทลีะขั Ѹน
ตามนีѸ 

1. แทนคา่ตัวเลขลงไปในสตูรเป็น =(-5<=0)*0 + (-5>0)*-5 
2. วงเล็บของ (-5<=0) จะคนืคา่ TRUE หรอืเทยีบเทา่กบั 1 
3. วงเล็บของ (-5>0) จะคนืคา่ FALSE หรอืเทยีบเทา่กบั 0 
4. จะไดส้ตูร =1*0 + 0*-5 
5. จะไดส้ตูร =0 + 0 
6. ซึѷงปรับคา่ -5 ออกมาเป็น 0 
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แตถ่า้เซลลต์ัวเลขมคีา่เทา่กบั 5 เมืѷอนํามาแทนคา่ลงไปในสตูร =(เซลลต์ัวเลข<=0)*0 + 
(เซลลต์ัวเลข>0)*เซลลต์ัวเลข แลว้ Excel จะคดิทลีะขั ѸนตามนีѸ 

1. แทนคา่ตัวเลขลงไปในสตูรเป็น =(5<=0)*0 + (5>0)*5 
2. วงเล็บของ (5<=0) จะคนืคา่ FALSE หรอืเทยีบเทา่กบั 0 
3. วงเล็บของ (5>0) จะคนืคา่ TRUE หรอืเทยีบเทา่กบั 1 
4. จะไดส้ตูร =0*0 + 1*5 
5. จะไดส้ตูร =0 + 5 
6. ซึѷงปรับคา่ 5 ออกมาเป็น 5 เทา่กบัคา่บวกตามคา่เดมินัѷนเอง 

แมก้ารใชว้งเล็บชว่ยในการตัดสนิใจจะเกดิสตูรทีѷมคีวามยาวซึѷงดเูหมอืนไมจํ่าเป็นก็ตาม แต่
โครงสรา้งสตูรภายในวงเล็บทกุวงเล็บมคีวามคลา้ยคลงึกนั จงึสามารถตรวจสอบแกไ้ขไดง้า่ย 
และยังเป็นพืѸนฐานของการคํานวณแบบ Array อกีดว้ย 
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หนสีตูร IF ไปใชค้าํส ัѷง Format   

สมัยทีѷผมใช ้Excel รุน่แรกๆ Excel ไมไ่ดม้คํีาสัѷงบนเมนูใหเ้ลอืกใชไ้ดม้ากมายอยา่งเชน่ทกุวันนีѸ 
แตก่็ไดพ้ึѷงสตูร IF นีѷแหละชว่ยในการตรวจสอบคา่ตา่งๆ อยา่งเชน่ถา้ตอ้งการตรวจสอบคา่ทีѷ
พมิพล์งไปวา่เป็นตัวเลขอยา่งเดยีวเทา่นัѸน ก็ตอ้งใชส้ตูร IF มาผสมกบัสตูร IsNumber เพืѷอ
ตรวจสอบคา่ทีѷพมิพว์า่ ถา้ไมใ่ชต่ัวเลข ใหแ้สดงคําเตอืนออกมาวา่ Input is Wrong ตามสตูร
ตอ่ไปนีѸ 

=IF(ISNUMBER(Cell), "OK", "Input is Wrong") 

การใชส้ตูรดังกลา่วจําเป็นตอ้งสรา้งสตูรลงไปในอกีเซลลห์นึѷงเพืѷอเป็นเซลลท์ีѷแสดงคําเตอืน
ออกมาใหเ้ห็น นอกจากสตูร IF ก็มแีตร่ปูแบบจากคําสัѷง Format เป็นอกีเครืѷองมอืหนึѷงทีѷกําหนด
ลงไปในเซลล ์เชน่ ถา้หากตอ้งการเตอืนวา่ Input is Wrong ในเซลลท์ีѷควบคมุวา่ตอ้งเป็น
ตัวเลขเทา่นัѸน ก็สามารถกําหนด Format ตามนีѸ 

0;-0;0;"Input is Wrong" 

แม ้Format จะแสดงคําวา่ Input is Wrong ใหเ้ห็นในเซลลท์ีѷบันทกึคา่ลงไปก็ตาม แตก่็ถอืวา่
ไดเ้กดิคา่ทีѷผดิพลาดขึѸนมาแลว้ ตา่งจาก Excel รุน่ใหมท่ีѷมคํีาสัѷงบนเมนู Data Validation กบั 
Conditional Formatting ใหเ้ลอืกใช ้ซึѷงสามารถแสดงคําเตอืนหรอืเปลีѷยนสใีหเ้ห็นชดัในเซลล์
นัѸนๆเลย 
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วธิใีช ้Data Validation 

สมมตวิา่ตอ้งการพมิพช์ืѷอเดอืนลงไปในเซลล ์ซึѷงทีѷผา่นมาเคยพมิพผ์ดิซํѸาแลว้ซํѸาอกี จงึตอ้งการ
สัѷงให ้Excel แสดงคําเตอืนขึѸนมาเมืѷอพมิพช์ืѷอเดอืนผดิ  

 

1. ตั Ѹงชืѷอ Range Name ใหก้บัเซลลท์ีѷเก็บชืѷอเดอืนในเซลล ์B2:B7 ใหม้ชีืѷอวา่ Choice 
2. เลอืกเซลล ์D2 ทีѷเป็นเซลลซ์ึѷงตอ้งการพมิพช์ืѷอเดอืนทีѷตอ้งการแลว้สัѷง Data > Data 

Validation  
3. ในชอ่ง Allow คลกิเลอืก List (ในชอ่ง Allow นีѸเองทีѷเราสามารถเลอืกประเภทของ

ขอ้มลูทีѷยอมรับไดอ้กีหลายอยา่งตามแตจ่ะกําหนด หรอืเลอืก Allow แบบ Custom เพืѷอ
ใชส้ตูรตรวจสอบการบันทกึคา่) 

4. ใหค้ลกิลงไปในชอ่ง Source แลว้กดปุ่ ม F3 เพืѷอเปิดรายชืѷอ Range Name ทีѷมอียูข่ ึѸนมา 
5. ใหเ้ลืѷอนหาชืѷอ Choice เพืѷอเลอืกแลว้กดปุ่ ม OK 2 ครั Ѹง 
6. จะพบวา่เซลล ์D2 มปีุ่ มลกูศรแสดงขึѸนมาทางขอบดา้นขวา และเมืѷอคลกิปุ่ มลกูศรนีѸก็จะมี

รายชืѷอเดอืนแสดงใหค้ลกิเลอืกก็ได ้หรอื
หากทดลองพมิพช์ืѷอเดอืนลงไปในเซลล ์
D2 เอง ถา้เราพมิพช์ืѷอเดอืนผดิ พอกด
ปุ่ ม Enter เพืѷอรับชืѷอเดอืนลงไป จะมคํีา
เตอืนแสดงขึѸนมาใหเ้ห็นวา่ The value you entered is not valid. 
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วธิใีช ้Conditional Formatting 

สมมตวิา่พอคลกิเลอืกชืѷอเดอืน May ในเซลล ์D2 แลว้ ตอ้งการเปลีѷยนสเีซลลใ์นตารางทีѷตั Ѹงชืѷอ
วา่ Choice ในเซลลท์ีѷมคํีาวา่ May ตรงตามทีѷเลอืก ใหทํ้าดังนีѸ  

 

1. เลอืกพืѸนทีѷตารางทีѷตั Ѹงชืѷอวา่ Choice 
2. สัѷง Home > Conditional Formatting > New Rules > Use a formula to 

determine which cells to format  
3. สรา้งสตูร =B2=$D$2 ลงไปในชอ่ง Edit the Rule Description 
4. กดปุ่ ม Format แลว้กําหนดรปูแบบทีѷแตกตา่งไปจากเดมิตามตอ้งการ 
5. Data Validation กบั Conditional Formatting ถอืเป็นเครืѷองมอืซึѷงควรนํามาใชพ้รอ้ม

กนัเสมอ โดย Validation จะทําหนา้ทีѷเสมอืนยามเฝ้าประตตูรวจสอบแขกทีѷจะยอมให ้
ผา่นประตเูขา้มา แตถ่า้มแีขกเดนิผา่นประตเูขา้มาแลว้ก็ตอ้งใช ้Conditional 
Formatting เปลีѷยนสแีสดงตัวแขกผูนั้ѸนขึѸนมา  
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การใช ้Validation และ Conditional Formatting ควบคมุตาํแหนง่ของ
เซลลท์ีѷจะเปิดใหพ้มิพค์า่  

จากรปูตอ่ไปนีѸ หากตอ้งการควบคมุใหเ้ปิดบันทกึคา่ไดต้ามตําแหน่งตัวชีѸบนหัวตารางทีѷเป็น Y 
และตามตําแหน่งขา้งตารางทีѷเป็น B และใหเ้ปลีѷยนสบีอกตําแหน่งอกีดว้ย จะพบวา่เซลล ์D4 
เปลีѷยนสแีละเป็นเซลลเ์ดยีวเทา่นัѸนทีѷจะเปิดใหพ้มิพค์า่ใหมล่งไปได ้

 

1. คลกิเลอืกพืѸนทีѷเซลล ์C3:E4 ซึѷงเป็นพืѸนทีѷในตาราง 
2. จากนัѸนใชคํ้าสัѷง Conditional Formatting ในทํานองเดยีวกบัตัวอยา่งขา้งตน้ ตา่งกนั

เพยีงใชส้ตูร =C$2&$B3=$C$6&$C$7 
3. ตามดว้ยคําสัѷง Data Validation โดยใช ้Allow แบบ Custom โดยกําหนดใหใ้ชส้ตูร 

=C$2&$B3=$C$6&$C$7 ซึѷงเป็นสตูรเดยีวกนักนัทีѷใชก้บั Conditional 
Formatting นัѷนเอง (หรอืจะใชส้ตูร =And(C$2=$C$6,$B3=$C$7) 
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สตูร Array 

เรืѷองสตูร Array เป็นเรืѷองทีѷผมเคยเขยีนมาแลว้หลายครั Ѹง เคยอธบิายมาแลว้หลายรอบ ทกุครั Ѹงทีѷ
จัดอบรมก็พดูเรืѷองสตูร Array อยูเ่สมอ คนทีѷฟังเรืѷองสตูร Array แลว้เขา้ใจก็จะเขา้ใจในทันท ี
แลว้ก็ตอ้งมานัѷงเบืѷอนัѷงทนฟังผมอธบิายเรืѷองสตูร Array นีѸซํѸาแลว้ซํѸาอกี เพราะคนสว่นใหญเ่ขา
ฟังกีѷทกีีѷทกี็ไมเ่ขา้ใจเรืѷองสตูร Array นีѸสกัท ีไมใ่ชว่า่ฟังแบบเขา้หซูา้ยแลว้ทะลหุขูวาหรอก แต่
แยย่ิѷงกวา่นัѸนอกี พออธบิายเรืѷองสตูร Array ทไีร ปรากฏวา่เสยีงพดูอธบิายของผมมันเดนิทางไป
ไมถ่งึหคูนฟังเสยีดว้ยซํѸา เพราะคนฟังพอฟังแลว้ไมรู่เ้รืѷองกจ็ะมอีาการหนังตาหนักขึѸนเรืѷอยๆแลว้
หลับหหูลับตาไมไ่ดฟั้งทกุครั Ѹงไป 

"ถา้คณุใชส้ตูร Array เป็น จะแกปั้ญหาอะไรไดบ้า้ง" ผมคดิวา่ตอ้งเริѷมอธบิายใหพ้วกเราเห็น
คณุประโยชนข์องสตูร Array กนักอ่น ถา้เห็นประโยชนข์องสตูร Array วา่จะชว่ยแกปั้ญหาของ
ตัวเองไดม้ากมายขนาดไหน จะไดเ้กดิความอยากใชแ้ลว้จะไดม้คีวามตั Ѹงหนา้ตั Ѹงตาตั Ѹงใจมา
เรยีนรูส้ตูร Array 

ประโยชนข์องสตูร Array  

สตูร Array จะชว่ยทําใหค้ณุสามารถทําสิѷงทีѷไมน่กึไมฝั่นวา่ Excel จะทําไดม้ากอ่น ไดแ้ก ่

1. ทําใหแ้ฟ้มมขีนาดเล็กลง เนืѷองจากแทนทีѷจะตอ้งสรา้งตารางหลายๆตารางเพืѷอแยก
คํานวณทลีะขั Ѹน เราสามารถสรา้งสตูร Array ลงไปในเซลลเ์พยีงเซลลเ์ดยีวก็ไดคํ้าตอบ
ทีѷตอ้งการแลว้ 

2. ทําใหเ้กบ็ขอ้มลูไวใ้นตารางเดยีวชทีเดยีว โดยไมต่อ้งแยกตารางฐานขอ้มลูออกเป็น
หลายตารางหรอืหลายชทีเพยีงเพืѷอตอ้งการหายอดรวมแยกประเภทตามขอ้มลูทีѷจัดแยก
ไว ้

3. ทําให ้Excel ทํางานแบบคอมพวิเตอรไ์ดอ้ยา่งแทจ้รงิ พอกรอกคา่ลงไปก็จะไดคํ้าตอบทีѷ
ตอ้งการทันท ีไมต่อ้งเสยีแรงและเสยีเวลาคลกิเลอืกใชคํ้าสัѷงบนเมนู เชน่ ไมต่อ้งสัѷง 
Sort ตารางก็จัดเรยีงใหเ้องแลว้ หรอืไมต่อ้งสัѷง AutoFilter ก็สามารถหายอดรวมแยก
ประเภทไดแ้ลว้ 

4. ทําใหส้ตูรสําเร็จรปูของ Excel มคีวามสามารถเหนอืชั ѸนขึѸนกวา่เดมิ สามารถใชส้ตูรใน
เซลลเ์ดยีวลัดหาคําตอบ 
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ในการอบรมครั Ѹงหนึѷงมผีูเ้ขา้อบรมคนหนึѷงมทีา่ทไีมส่นใจเรยีนรูส้ตูร Array โดยอา้งวา่ ทําไมตอ้ง
ใชส้ตูร Array ดว้ยในเมืѷอ Excel ก็มสีตูรและคําสัѷงบนเมนูอยูแ่ลว้ ถา้อยากไดอ้ะไรก็แคค่ลกิ
คําสัѷงบนเมนู ก็จะไดคํ้าตอบทีѷตอ้งการแลว้มใิชห่รอื 

ผมจงึเรยีนถามกลับวา่ แลว้มอืทีѷใชค้ลกิคําสัѷงบนเมนูทีѷวา่นัѸนน่ะเป็นมอืของใคร ถา้คณุสง่แฟ้มไป
ใหห้ัวหนา้ทีѷใช ้Excel ไมเ่ป็น หัวหนา้จะรูว้ธิเีลอืกคลกิเมนูนัѸนเมนูนีѸดว้ยหรอื เห็นทหีัวหนา้ตอ้ง
พึѷงพามอืของคณุไปชัѷวชวีติหรอืไม ่แตถ่า้คณุสรา้งสตูร Array เป็น แฟ้มนัѸนๆจะทํางานตอ่เอง
อยา่งอตัโนมัตโิดยไมต่อ้งหว่งวา่ใครจะเป็นผูใ้ชแ้ฟ้มของคณุ 

อยา่งเรืѷองการใช ้Pivot Table เหมอืนกนัทีѷหัวหนา้มักชอบใชเ้ป็นชวีติจติใจแลว้ผลักดันให ้
ลกูนอ้งใช ้Pivot Table ตามกนัไปทัѸงบรษัิท โดยหารูไ้มว่า่ถา้ใช ้Array เป็นก็แทบไมจํ่าเป็นตอ้ง
ใช ้Pivot Table เสยีดว้ยซํѸา  

ขอ้เสยีของสตูร Array 

1. ทําใหแ้ฟ้มคํานวณชา้ลง แตเ่นืѷองจากการใชส้ตูร Array จะชว่ยทําใหแ้ฟ้มมขีนาดเล็กลง
ซึѷงโดยทัѷวไปยอ่มสง่ผลใหแ้ฟ้มเล็กคํานวณเร็วกวา่แฟ้มใหญ ่ถา้คณุออกแบบโครงสรา้ง
ตารางใหเ้หมาะกบัสตูร Array ดว้ย ปัญหาเรืѷองนีѸก็จะชดเชยกนัไป 

2. ทําใหแ้กไ้ขสตูรยากขึѸน เพราะคนทัѷวไปมักไมเ่ขา้ใจเรืѷองสตูร Array เป็นพืѸนอยูแ่ลว้และ
ไมท่ราบวา่ขั Ѹนตอนการสรา้งสตูร Array ตอ้งกดปุ่ ม Ctrl+Shift+Enter (CSE) พรอ้มกนั
แทนทีѷจะกดปุ่ ม Enter  

3. คนทีѷตดินสิยัชอบสรา้งสตูร Array มักหลงลมืมองขา้มสตูรสําเร็จรปูอืѷนทีѷมอียูแ่ลว้ใน
โปรแกรม Excel ซึѷงสตูรสําเร็จรปูจะใชเ้วลาคํานวณเร็วกวา่สตูร Array 

4. ใน Excel 365 รุน่ลา่สดุไดพ้ัฒนา Dynamic Array ชว่ยทําใหไ้มต่อ้งกดปุ่ ม CSE อกี
ตอ่ไป โดย Excel จะกระจายคา่ใหเ้ห็นถา้เป็น Array ทีѷคนืคา่หลายคา่ หรอืเมืѷอใส่

เครืѷองหมาย @ จะชว่ยทําใหส้ตูรคนืคา่เดยีวออกมา 
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เบืҟองตน้ของ Array 

ขนาดผมใชส้ตูร Array มานานนับสบิปี สรา้งสตูร Array เพืѷอใชก้บังานมาสารพัดชนดิ ตอบ
คําถามเรืѷอง Array ใน Excel Expert Forum ซํѸาแลว้ซํѸาอกีนับเป็นพันๆครั Ѹง แตก่็ยังมสีตูร Array 
อกีเยอะทีѷผมเห็นแลว้ตอ้งถอนหายใจ ไมส่ามารถแกะทีѷไปทีѷมาของลําดับการคํานวณทีѷใชใ้น
สตูร Array เหลา่นัѸน เพราะเป็นสตูรทีѷคนอืѷนสรา้งขึѸน ถา้คนทีѷสรา้งสตูร เขาไมไ่ดเ้ขยีนอธบิาย
แนวคดิประกอบสตูรไวด้ว้ย ยอ่มทําใหผู้อ้ืѷนคดิถามในใจวา่ “เขาสรา้งสตูรยากๆยาวๆแบบนีѸข ึѸนมา
ไดอ้ยา่งไรกนั” แลว้ถา้เราไดแ้ตล่อกเอาสตูรของคนอืѷนมาใช ้ก็ไดแ้ตใ่ช ้ไมส่ามารถดัดแปลง
แกไ้ขสตูรทีѷลอกมาเพืѷอปรับใหเ้ขา้กบัเงืѷอนไขในงาน วันหนึѷงเราก็จะหนา้แตก เมืѷอถกูจับไดว้า่
ไมไ่ดเ้กง่จรงิ “ออ้ ลอกสตูรเขามานีѷเอง” ดังนัѸนถา้จะคดิใชส้ตูร Array ตอ้งหาทางสรา้งสตูรเอง
ใหเ้ป็น แมส้ตูร Array ทีѷสรา้งขึѸนเองเป็นสตูรยาวกวา่สตูรของคนอืѷนก็ตาม 

สตูร Array สตูรแรกๆทีѷทําใหผ้มเกดิความประทับใจแลว้เกดิแรงบันดาลใจใหอ้ยากเรยีนรูเ้รืѷอง
สตูร Array มากขึѸน เป็นสตูรทีѷใชคํ้านวณหาจํานวน Unique Items หรอืนับจํานวนชืѷอรายการทีѷ
ไมซ่ํѸากนั 

{=SUM(1/CountIF(DataRange,DataRange))} 

สมมตวิา่ใน DataRange บันทกึชืѷอลกูคา้ไวต้ามนีѸ aa, bb, aa, cc, bb สตูรนีѸจะหาคําตอบเป็น
เลข 3 ซึѷงหมายถงึการนับชืѷอลกูคา้วา่มอียู ่3 คน คอื aa, bb, และ cc แตก่วา่จะหาทางสรา้งสตูร
ใหทํ้างานไดก้็ตอ้งทราบกอ่นวา่เครืѷองหมายวงเล็บปีกกา { } ทีѷเห็นอยูด่า้นหนา้สดุและดา้น
ทา้ยสดุของสตูรนัѸน ไมใ่ชเ่ครืѷองหมายวงเล็บปีกกาทีѷพมิพเ์อง แตเ่กดิจากการกดปุ่ ม 
Ctrl+Shift+Enter พรอ้มกนัและหา้มมชีอ่งวา่งใน DataRange ดว้ย 

ตอนทีѷผมเห็นสตูรนีѸก็คดิไมอ่อกวา่มันใชห้ลักการใดในการคํานวณ แตพ่ออา่นคําอธบิายทีѷมากบั
สตูรจงึเขา้ใจ สตูรนีҟเป็นการหายอดรวมของคา่เฉลีѷยตอ่ตวัของแตล่ะรายการใน 
DataRange กลา่วคอื ถา้นับจํานวนชืѷอแตล่ะชืѷอใน DataRange aa, bb, aa, cc, bb จะพบ
จํานวนของการซํѸากนัดังนีѸ 

 ม ีaa ซํѸากนัอยู ่2 ตัว ดังนัѸนคา่เฉลีѷยตอ่ตัวของ aa แตล่ะตัวคอื 1/2 
 ม ีbb ซํѸากนัอยู ่2 ตัว ดังนัѸนคา่เฉลีѷยตอ่ตัวของ bb แตล่ะตัวคอื 1/2 
 ม ีcc อยู ่1 ตัว ดังนัѸนคา่เฉลีѷยตอ่ตัวคอื 1 
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เมืѷอรวมคา่เฉลีѷยตอ่ตัวเขา้ดว้ยกนั จาก DataRange aa, bb, aa, cc, bb 
=1/2+1/2+1/2+1+1/2 จะไดคํ้าตอบเป็นจํานวนของ Unique Items เทา่กบั 3 

จวบจนปัจจบุันนีѸยังตามหาคนทีѷคดิสรา้งสตูรยอดเยีѷยมนีѸข ึѸนมาเป็นครั Ѹงแรกไมพ่บวา่เป็นใคร ยังดี
ทีѷมคํีาอธบิายประกอบสตูรนีѸไวด้ว้ย 

อยากเกง่สตูร Array ตอ้งสรา้งไปแกะไป 

จากคําอธบิายทีѷเขยีนไวเ้กีѷยวกบัทีѷไปทีѷมาของสตูรคํานวณหาจํานวน Unique Items วา่ เป็นการ
หายอดรวมของคา่เฉลีѷยตอ่ตัวของแตล่ะรายการใน DataRange ยอ่มทําใหค้นสว่นใหญท่ีѷเพิѷง
รูจั้กสตูร Array เป็นครั Ѹงแรกคงยังไมเ่ขา้ใจลําดับในการคํานวณทีѷใชใ้นสตูรนีѸชดัเจนนัก ถา้
อยากจะเขา้ใจอยา่งถอ่งแทว้า่สตูร Array ทํางานไดอ้ยา่งไร ตอ้งเรยีนรูจ้ากการปฏบิัตเิทา่นัѸน 
โดยใชว้ธิทีดลองสรา้งสตูรไปแกะไปซึѷงมอียู ่2 วธิ ี

1. สรา้งสตูร Array ลงไปในเซลลเ์ดยีวแลว้แกะคา่ในแตล่ะสว่นของสตูร โดยการกดปุ่ ม F9 
เพืѷอดใูนชอ่ง Formula Bar หรอื 

2. สรา้งสตูร Array ลงไปในตารางพรอ้มกนัทเีดยีวหลายๆเซลลห์รอืใชต้ารางแยกคํานวณ
ทลีะขั Ѹน เพืѷอดผูลลัพธก์ระจายออกมาใหเ้ห็นในตาราง (Excel 365 จะกระจายคา่ใหเ้อง) 

โดยทัѷวไปจะใชว้ธิแีรกสําหรับแกะสตูรทีѷไมซ่บัซอ้นหรอืไมย่าวนัก พอแกะสตูรโดยการกดปุ่ ม F9 
แลว้ตอ้งอยา่ลมืกดปุ่ ม Esc เพืѷอยอ้นหลังกลับคนืสูส่ภาพเดมิกอ่นแกะ (ถา้แกะสตูรแลว้เผลอกด 
Enter ลงไปจะทําลายสตูรใหก้ลายเป็นคา่คงทีѷแทน) 

วธิทีีѷสอง เหมาะสําหรับคนทีѷเพิѷงเรยีนรูเ้รืѷอง Array หรอืใชแ้กะสตูรยากๆยาวๆ หรอืใชท้ดลอง
สรา้งสตูร Array ขึѸนใหมต่ั Ѹงแตแ่รก เพราะวธินีีѸจะเห็นผลลัพธแ์ตล่ะขั Ѹนของการคํานวณแสดง
กระจายใหเ้ห็นในเซลลแ์ตล่ะเซลลใ์นตาราง จากนัѸนพอซอ้นสตูรตอ่ๆกนัไปจนไดคํ้าตอบทีѷ
ตอ้งการแลว้จงึนําสตูรแตล่ะขั Ѹนมาซอ้นตอ่กนัเป็นสตูรเดยีวเพืѷอนําไปใชง้านตอ่ไป 
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วธิแีกะสตูร Array วธิที ีѷ 1 

 

DataRange คอื ตารางชว่ง B3:B7 

เซลล ์D3 มสีตูร Array {=SUM(1/COUNTIF(DataRange,DataRange))} โดย
เครืѷองหมายวงเล็บปีกกาเกดิจากการกดปุ่ ม Ctrl+Shift+Enter พรอ้มกนั (ไมไ่ดพ้มิพ ์{} เอง) 

1. เริѷมจากคลกิลงไปในชอ่ง Formula Bar คลกิลากทับสว่นของสตูร 
COUNTIF(DataRange,DataRange) 

2. กดปุ่ ม F9 จะพบวา่สตูร CountIF นับจํานวนซํѸาของคา่แตล่ะตัว ทําใหส้ตูรทั Ѹงหมด
เปลีѷยนเป็นสตูร =SUM(1/{2;2;2;1;2}) 

3. ตัวเลข  {2;2;2;1;2} หมายถงึ จํานวนซํѸาของแตล่ะคา่ กลา่วคอื aa ม ี2 คา่, bb ม ี2 คา่
, aa ม ี2 คา่, cc ม ี1 คา่, และ bb ม ี2 คา่ 

4. คลกิลากทับสว่นของสตูร 1/{2;2;2;1;2} 
5. กดปุ่ ม F9 จะพบวา่สตูร 1/{2;2;2;1;2} หาคา่เฉลีѷยจากจํานวนซํѸาของคา่แตล่ะตัว ทําให ้

สตูรทั Ѹงหมดเปลีѷยนเป็นสตูร =SUM({0.5;0.5;0.5;1;0.5}) 
6. ตัวเลข {0.5;0.5;0.5;1;0.5} เกดิจากสว่นของหารหาคา่เฉลีѷยโดย 1/2 ทําใหเ้กดิเลข 

0.5 และ 1/1 ทําใหเ้กดิเลข 1 
7. คลกิลากทับสตูร SUM({0.5;0.5;0.5;1;0.5}) แลว้กดปุ่ ม F9 จะไดคํ้าตอบเป็นสตูร =3 
8. กดปุ่ ม Esc เพืѷอทําใหส้ตูรแปลงกลับไปเป็นสตูรแรกเริѷมตามเดมิ 

หมายเหต ุการคลกิแลว้ลากทับสว่นของสตูรทีѷแสดงในชอ่ง Formula Bar นีѸ ตอ้งคลกิแลว้ลาก
ทับสว่นของสตูรทีѷครบและพรอ้มจะคํานวณได ้เชน่ COUNTIF(DataRange,DataRange) แต่
ถา้ลากทับขาดหรอืเกนิ เชน่ ลากทับ /COUNTIF(DataRange,DataRange) ซึѷงมเีครืѷองหมาย
หารเกนิเขา้มาดว้ย จะทําใหเ้มืѷอกดปุ่ ม F9 จะพบวา่ไมส่ามารถแกะสตูรสว่นนัѸนได ้



124 

 

© พ.ศ.2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ
www.ExcelExpertTraining.com 

วธิแีกะสตูร Array วธิที ีѷ 2 

วธินีีѸใชต้ารางเป็นตัวชว่ยหาผลลัพธข์องการคํานวณทลีะขั Ѹนแสดงใหเ้ห็นไดทั้นทวีา่ หลังจาก
คํานวณขั Ѹนแรกเสร็จแลว้ สง่ผลไปคํานวณตอ่ในการคํานวณขั Ѹนถัดไปอยา่งไรและเกดิผลลัพธ์
อยา่งไร ซึѷงพอคํานวณตอ่กนัไปจนเกดิผลลัพธไ์ดถ้กูตอ้งตามทีѷตอ้งการแลว้ จงึนําสตูรแตล่ะขั Ѹน
มาซอ้นกนัเป็นสตูร Array เพยีงสตูรเดยีว 

 

ใหเ้ริѷมจากแยกสตูร =SUM(1/COUNTIF(DataRange,DataRange)) ออกเป็นสว่นๆตามลําดับ
การคํานวณ โดยไลจ่ากสตูรทีѷอยูภ่ายในวงเล็บในสดุออกมา 

1. Step1 เซลล ์D3 สรา้งสตูร =COUNTIF(DataRange,B3) แลว้ copy ลงมาตลอดแนว
จนถงึ เซลล ์D7 

2. ตัวเลขทีѷไดจ้ากเซลล ์D3:D7 เป็นตัวเลขการนับวา่ขอ้มลูแตล่ะตัวมบีันทกึไวซ้ํѸากนักีѷครั Ѹง
ภายใน DataRange 

3. Step2 เซลล ์E3 สรา้งสตูร =1/D3 แลว้ copy ลงมาตลอดแนวจนถงึ เซลล ์E7 
4. ตัวเลขทีѷไดจ้ากเซลล ์E3:E7 เป็นตัวเลขคา่เฉลีѷยตอ่ตัวจากการนับวา่ขอ้มลูแตล่ะตัวมี

บันทกึไวซ้ํѸากนักีѷครั Ѹงภายใน DataRange 
5. Step3 เซลล ์F3 สรา้งสตูร =SUM(E3:E7) เพืѷอหายอดรวมของคา่เฉลีѷย ไดคํ้าตอบเป็น

จํานวนของ Unique Items 

หมายเหต ุใน Step1 และ Step2 แทนทีѷจะสรา้งสตูรลงไปในเซลล ์D3 และ E3 เพยีงเซลล์
เดยีว ใหท้ดลองสรา้งสตูรคํานวณแบบ Array ลงไปในตารางหลายเซลลพ์รอ้มกนัแทนก็ได ้

 Step1 ใหเ้ลอืกเซลล ์D3:D7 แลว้พมิพส์ตูร =COUNTIF(DataRange,DataRange) 
แลว้กดปุ่ ม Ctrl+Shift+Enter เพืѷอสรา้งสตูรนีѸลงไปพรอ้มกนัทเีดยีว จะพบวา่ไดคํ้าตอบ
เป็นการนับคา่ซํѸาเชน่เดยีวกนั เนืѷองจากสตูร CountIF จะใชแ้ตล่ะคา่ใน DataRange 
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ตรวจสอบจํานวนการบันทกึซํѸาจากพืѸนทีѷ DataRange ทั Ѹงหมดเชน่เดยีวกบัสตูรทีѷนับแต่
ละตัว 

 Step2 ใหเ้ลอืกเซลล ์E3:E7 แลว้พมิพส์ตูร =1/D3:D7 แลว้กดปุ่ ม Ctrl+Shift+Enter 
เพืѷอสรา้งสตูรนีѸลงไปพรอ้มกนัทเีดยีว จะพบวา่ไดคํ้าตอบเป็นคา่เฉลีѷยเชน่เดยีวกนั 

Array คอือะไร 

บทความนีѸยกความหมายของ Array มาไวต้อนหลัง เพืѷอใหเ้ห็นตัวอยา่งการใชส้ตูร Array ไว ้
กอ่นบา้ง ทําใหไ้ดเ้ห็นวา่ เรานําสตูร Array ไปใชง้านกนัอยา่งไร แลว้มันคํานวณหาอะไร พอได ้
ผา่นการลองทํากบัมอืมาแลว้ คงพอเดากนัไดบ้า้งวา่ Array คอือะไร 

Array คอื คา่ตั Ѹงแตส่องคา่ขึѸนไป แทนทีѷจะใชเ้ซลลเ์ดยีวรับคา่เดยีวตามวธิปีกตทัิѷวไป เรา
สามารถใชเ้ซลลเ์ดยีวรับคา่หลายคา่ลงไปก็ได ้แทนทีѷจะใชพ้ืѸนทีѷตารางของจรงินับรอ้ยนับพัน
เซลลเ์พืѷอกรอกคา่หรอืสรา้งสตูรใหคํ้านวณตอ่ๆกนัไปทลีะขั Ѹน ดว้ยการใช ้Array จะชว่ยใหเ้รา
สามารถใชเ้ซลลเ์พยีงเซลลเ์ดยีวแทนพืѸนทีѷตารางขนาดใหญ ่กลายเป็นเซลลท์ีѷทําหนา้ทีѷแทน
ตารางของจรงิซึѷงเรยีกวา่เป็นตารางในอดุมคตกิ็ได ้

คา่ตั Ѹงแตส่องคา่ขึѸนไปจะเรยีงตามแนวนอน หรอืแนวตั Ѹง หรอืเรยีงตอ่กนัไปเป็นพืѸนทีѷตารางทีѷมี
ความสงูความกวา้งหลาย row หลาย column ก็ได ้โดย Excel กําหนดใหใ้ชเ้ครืѷองหมายในการ
แบง่ลําดับของคา่ ดังนีѸ 

 ถา้เป็น Array ในแนวนอน ใหใ้ชเ้ครืѷองหมาย comma , คัѷนระหวา่งคา่แตล่ะคา่ เชน่ 
11,22,33 

 ถา้เป็น Array ในแนวตั Ѹง ใหใ้ชเ้ครืѷองหมาย semi-colon ; คัѷนระหวา่งคา่แตล่ะคา่ เชน่ 
11;22;33 

 ถา้เป็น Array ทีѷมขีนาดความสงู 2 row และมคีวามกวา้ง 3 column จะแสดงคา่ทีѷมี
เครืѷองหมาย comma และ semi-colon ผสมกนั เชน่ 1,2,3;11,22,33 โดย Array จะไล่
ลําดับจากแนวนอน 1,2,3 กอ่นแลว้จงึใช ้; ขึѸนแนวนอนถัดไปเป็น 11,22,33 

การนําคา่แบบ Array ไปใชใ้นเซลล ์ตา่งจากการใชว้ธิพีมิพ ์1,2,3 ลงไปในเซลลต์ามปกต ิโดย
ตอ้งใช ้Array แบบสตูรทีѷมเีครืѷองหมายเทา่กบันําหนา้สดุเทา่นัѸน ดังนีѸ 



126 

 

© พ.ศ.2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ
www.ExcelExpertTraining.com 

1. การใชแ้บบสตูร Array Constant เชน่ พมิพ ์={1,2,3} ลงไปในเซลลใ์ดๆ จะพบวา่
ในเซลลแ์สดงคา่แรกคอืเลข 1 เพยีงคา่เดยีว ซึѷงถา้ตอ้งการแสดงใหค้รบทกุคา่ ตอ้ง
เลอืกเซลล ์3 เซลลต์ดิกนัตามแนวนอนแลว้พมิพ ์={1,2,3} แลว้กดปุ่ ม 
Ctrl+Shift+Enter เพืѷอบนัทกึ จะพบวา่สตูร ={1,2,3} ซึѷงมวีงเล็บปีกกาอยูด่า้นหลัง
เครืѷองหมายเทา่กบั จะมวีงเล็บปีกกาเพิѷมดา้นหนา้เครืѷองหมายเทา่กบัอกีชั Ѹนหนึѷงเป็น {=
{1,2,3}} 

2. การใชแ้บบสตูร Array ซึѷงรบัคา่มาจากการอา้งองิกบัพืҟนทีѷในตาราง เชน่ รับคา่ 
Array มาจากเซลลต์ามแนวนอน {=A1:C1} หรอืรับคา่ Array มาจากเซลลต์ามแนวตั Ѹง 
{=A1:A3} หรอืรับคา่ Array มาจากตารางขนาดความสงู 2 row และมคีวามกวา้ง 3 
column {=A1:C2} ทั ѸงนีѸโปรดสงัเกตวา่วธินีีѸจะมเีครืѷองหมายวงเล็บปีกกาแสดงไวห้นา้
เครืѷองหมายเทา่กบั แสดงวา่เป็นวงเล็บปีกกาทีѷเกดิจากการกดปุ่ ม Ctrl+Shift+Enter 

3. การใชแ้บบสตูร Array ซึѷงรบัคา่มาจากสตูรทีѷคนืคา่แบบ Array เชน่ 
{=Offset(A1,0,0,2,3)} ซึѷงเทยีบเทา่กบัการอา้งองิมาจากเซลล ์A1:C2 เป็นตน้ 

การนําคา่แบบ Array ทั Ѹง 3 แบบไปใช ้ขอใหเ้ลอืกพืѸนทีѷตารางใหม้ขีนาดพอดบิพอดกีบัจํานวน
ของคา่ทีѷมอียูใ่น Array หรอืใหม้ขีนาดตารางเทา่กบัจํานวนผลลัพธท์ีѷตอ้งการไวก้อ่นทีѷจะสรา้ง
สตูรลงไป กลา่วคอื ถา้ในสตูร Array คนืคา่สดุทา้ยเพยีงคา่เดยีวก็ใหส้รา้งสตูรลงไปในเซลล์
เพยีงเซลลเ์ดยีว แตถ่า้สตูร Array คนืคา่ผลลัพธท์ีѷมจํีานวนคา่มากกวา่คา่เดยีว ก็ตอ้งเลอืกพืѸนทีѷ
ตารางใหม้ขีนาดความสงูและความกวา้งเทา่กนักบัจํานวนและลําดับคา่ทีѷมอียู ่จากนัѸนใหก้ดปุ่ ม 
Ctrl+Shift+Enter ในการรับสตูร Array ลงไป จะพบวา่ Excel กระจายคา่ทีѷมอียูล่งไปในพืѸนทีѷ
ตารางทีѷเตรยีมไวใ้หเ้ห็นไดค้รบทกุคา่ 
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ตวัอยา่งการสรา้งตารางสตูรคณูแบบ Array 

 

เมืѷอตั Ѹงชืѷอ Range Name ใหก้บัตัวเลขบนหัวตารางและขา้งตารางวา่ Top และ Left เสร็จแลว้ 
ใหท้ดลองเลอืกพืѸนทีѷเซลล ์C3:H7 ซึѷงเกนิกวา่แนวขอบเขตตารางตัวเลขทีѷม ีแลว้สรา้งสตูร 
=Top*Left แลว้กดปุ่ ม Ctrl+Shift+Enter จะไดส้ตูร Array {=Top*Left} 

สงัเกตวา่เฉพาะพืѸนทีѷตาราง C3:F5 ซึѷงอยูภ่ายในขอบเขตของ Top กบั Left เทา่นัѸนสามารถ
คํานวณหาผลคณูเป็นตารางสตูรคณูทีѷตอ้งการ สว่นพืѸนทีѷนอกเหนอืจาก C3:F5 ทีѷมสีตูร Array 
จะคนืคา่เป็น Error #N/A 

จากนัѸนใหค้ลกิเซลลใ์ดก็ไดท้ีѷมสีตูร {=Top*Left} แลว้กดปุ่ ม F2 ตามดว้ยปุ่ ม F9 จะแสดง
ผลลัพธเ์ป็น Array Constant {20,30,40,50;40,60,80,100;60,90,120,150} โดยผลลัพธน์ีѸมี
เครืѷองหมาย ; คัѷนอยู ่2 ตัว แสดงวา่ม ี3 row เพราะมกีารขึѸน row ใหม ่2 ครั Ѹง และในชว่งทีѷคัѷน
ดว้ย ; นัѸน มเีครืѷองหมาย , คัѷนอยูช่ว่งละ 3 ตัว แสดงวา่ในแตล่ะ row มคีา่อยู ่4 column หรอือกี
นัยหนึѷงแสดงวา่ พืѸนทีѷตารางทีѷเหมาะจะสรา้งสตูร {=Top*Left} ลงไปนัѸน ตอ้งมคีวามสงู 3 row 
และกวา้ง 4 column ดังนัѸนหากเลอืกพืѸนทีѷเกนิกวา่ทีѷจําเป็นก็จะไดคํ้าตอบเป็น Error #N/A 

แตถ่า้ตอ้งการหายอดรวมของผลคณูของ =Top*Left ในเซลล ์C9 ใหส้รา้งสตูร 
=SUM(Top*Left) แลว้กดปุ่ ม Ctrl+Shift+Enter จะไดส้ตูร Array {=SUM(Top*Left)} ซึѷง
สาเหตทุีѷคราวนีѸสรา้งสตูรลงไปในเซลล ์C9 เพยีงเซลลเ์ดยีว เพราะคําตอบของการหายอดรวมมี
เพยีงคา่เดยีวเทา่นัѸน 
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เร ืѷองอืѷนๆเกีѷยวกบั Array ทีѷควรทราบ 

1. ใน Excel Help เรยีกพืѸนทีѷใดๆทีѷมจํีานวนตัѸงแต ่2 เซลลข์ึѸนไปวา่ Array 
2. การแกะดคูา่ทีѷคํานวณไดจ้ากสตูร Array ใหเ้ริѷมจากคลกิลงไปในเซลลส์ตูรแลว้กดปุ่ ม 

F2 แลว้ตามดว้ยปุ่ ม F9 เมืѷอเห็นคา่ทีѷคํานวณไดแ้ลว้ใหก้ดปุ่ ม Esc เพืѷอกลับเป็นสตูร
ตามเดมิ ทั ѸงนีѸถา้คา่ทีѷแกะไดจ้ากสตูร Array คนืคา่หลายคา่จนเกนิกวา่ทีѷเซลลห์นึѷงจะรับ
ได ้จะพบวา่ Excel ไมย่อมแสดงคา่ใหเ้ห็น 

3. วธิคีน้หาพืѸนทีѷของสตูร Array ทีѷเกดิจากการสรา้ง
ขึѸนหลายเซลลพ์รอ้มกนั ใหเ้ริѷมจากคลกิเลอืก
เซลลใ์ดเซลลห์นึѷงซึѷงใชส้ตูร Array แลว้กดปุ่ ม 
F5 > Special > กาชอ่ง Current array 
 

4. บางคนกดปุ่ ม Ctrl+Shift+Enter แตไ่มไ่ด ้
เครืѷองหมายวงเล็บปีกกา เพราะไมไ่ดก้ดทัѸงสาม
ปุ่ มพรอ้มกนัจรงิ ถา้อยากใหไ้ด ้{ } อยา่งแน่นอน 
ใหใ้ชม้อืซา้ยกดปุ่ ม Ctrl+Shift แชค่า้งไวก้อ่น จากนัѸนใชม้อืขวากดปุ่ ม Enter ลงไป 

5. สตูร Array ทีѷเกดิจากการสรา้งขึѸนหลายเซลลพ์รอ้มกนัโดยการกดปุ่ ม 
Ctrl+Shift+Enter จะไมส่ามารถ Insert หรอื Delete เฉพาะบางเซลล ์หากตอ้งการ
แกไ้ขหรอืลบทิѸง ตอ้งเลอืกพืѸนทีѷทั Ѹงหมดทีѷใชส้ตูร Array นัѸนกอ่นแลว้จงึแกไ้ขสตูรหรอื
ลบสตูรทิѸง (ดังนัѸนหากสามารถลบสตูร Array เพยีงเซลลเ์ดยีวได ้ยอ่มแสดงวา่เป็นสตูร 
Array ทีѷสรา้งทลีะเซลล)์ 

6. สตูร Array ทีѷเราสรา้งขึѸนโดยการกดปุ่ ม 
Ctrl+Shift+Enter จะไมส่ามารถสรา้งลงไปใน
เซลลท์ีѷถกู Merge ไวก้อ่นแลว้ จะถกูเตอืนวา่ 
Array formulas are not valid in merged 
cells (แตเ่ราสามารถ Merge เซลลท์ีѷสรา้งสตูร Array ไวก้อ่น) 
 

7. สตูร Array ทีѷเกดิจากการสรา้งขึѸนหลายเซลลพ์รอ้มกนัโดยการกดปุ่ ม 
Ctrl+Shift+Enter จะใชเ้วลาคํานวณเร็วกวา่การสรา้งสตูรคํานวณเพืѷอหาคําตอบทลีะ
เซลลแ์ยกจากกนั 

8. สตูร Array ทีѷเราสรา้งขึѸนโดยการกดปุ่ ม Ctrl+Shift+Enter ทั Ѹงทีѷสรา้งในเซลลเ์ดยีวหรอื
หลายเซลลพ์รอ้มกนั จะใชเ้วลาคํานวณชา้กวา่สตูรสําเร็จรปูทีѷมอียูใ่น Excel ดังนัѸนจงึ
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แนะนําใหใ้ชส้ตูร Array ตอ่เมืѷอไมม่สีตูรสําเร็จรปูอืѷนซึѷงสามารถคํานวณหาคําตอบทีѷ
ตอ้งการไดแ้ลว้เทา่นัѸน 

9. ใน Excel รุน่ 2003 และรุน่เกา่กอ่นนัѸน สตูร Array ทีѷเราสรา้งขึѸนโดยการกดปุ่ ม 
Ctrl+Shift+Enter จะไมย่อมรับการอา้งองิพืѸนทีѷตารางทีѷมขีนาดใหญเ่ต็มความสงูทั Ѹง 
65,536 row ของตาราง เชน่  
{=MIN(IF(A:A<>0,ROW(A:A)))} หรอื  
{=MIN(IF(A1:A65536<>0,ROW(A1:A65536)))}  
แตถ่า้แกเ้ป็น {=MIN(IF(A1:A65535<>0,ROW(A1:A65535)))} จะใชไ้ด ้

10. นอกจากสตูร Array ทีѷเราสรา้งขึѸนโดยการกดปุ่ ม Ctrl+Shift+Enter แลว้ ใน Excel ยังมี
สตูรสําเร็จรปูอืѷนอกีทีѷทํางานแบบ Array โดยไมต่อ้งกดปุ่ ม Ctrl+Shift+Enter เชน่ สตูร 
SumIF, CountIF, SumIFs, CountIFs, AverageIfs, SumProduct ซึѷงถา้พจิารณาตาม
หลักการแลว้สตูรใดก็ตามซึѷงรับคา่จากเซลลต์ั Ѹงแต ่2 เซลลข์ึѸนไปได ้ยอ่มเป็นสตูรทีѷ
ทํางานแบบ Array จงึยังมสีตูรอกีมากทีѷสามารถทํางานแบบ Array ได ้เชน่ สตูร Sum, 
Max, Min, And, Or, Index, หรอื Offset เป็นตน้ 

11. SumIFs, CountIFs, AverageIfs เป็นสตูรทีѷเกดิขึѸนใน Excel 2007 เป็นตน้มา ดังนัѸน
หากยังจําเป็นตอ้งใช ้Excel 2003 หรอืรุน่เกา่กวา่นีѸอยูอ่กี แนะนําใหห้ลกีเลีѷยงสตูร 
SumIFs, CountIFs, AverageIfs ไปกอ่น โดยหันไปใชส้ตูร Sum-IF-Array, Count-
IF-Array, Average-If-Array ซึѷงสามารถใชง้านใน Excel ไดท้กุรุน่ แตจํ่าเป็นตอ้งสรา้ง
โดยการกดปุ่ ม Ctrl+Shift+Enter 

12. Max, Min, And, Or เมืѷอนํามาใชแ้บบ Array จะไมส่ามารถคนืคา่หลายคา่แบบ Array 
เชน่ ถา้สรา้ง {=Max(RangeA,RangeB)} จะไมไ่ดคํ้าตอบเป็นคา่สงูสดุของแตล่ะ
ตําแหน่งใน RangeA เมืѷอนํามาเทยีบกบัแตล่ะตําแหน่งใน RangeB แตจ่ะไดคํ้าตอบเป็น
คา่สงูสดุเพยีงคา่เดยีวจากคา่ทั Ѹงหมดใน RangeA และ RangeB 

13. สตูร Array บางสตูรไมส่ามารถหาคําตอบมาแสดงใหเ้ห็นในเซลล ์แตถ่า้นําสตูรนัѸนไป
ซอ้นในสตูรอืѷนจะสามารถทํางานรว่มกบัสตูรอืѷนได ้

14. สตูร Array ทีѷคนืคา่คําตอบหลายคา่ ไมค่วรสรา้งสตูรนัѸนลงไปในเซลลเ์ดยีวเพราะจะได ้
คําตอบไมค่รบทัѸงหมดหรอืไดคํ้าตอบ error  

15. ถา้สรา้งสตูร Array ทีѷคนืคา่คําตอบหลายคา่ ลงไปในเซลลเ์ดยีวในแนวเดยีวกบัคําตอบ
จากตารางฐานขอ้มลู จะไดคํ้าตอบจากเซลลใ์นแนวคูข่นานกบัตําแหน่งเซลลท์ีѷสรา้งสตูร
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ลงไป ซึѷงถอืเป็นความบังเอญิเทา่นัѸน ถา้ยา้ยสตูรไปนอกแนวคูข่นานจะไดคํ้าตอบ error 

 
16. ถา้สรา้งสตูร Array ลงไปในตารางหลายเซลลพ์รอ้มกนั จะพบวา่ในการสรา้งสตูรตอนทีѷ

คลกิเลอืกพืѸนทีѷเซลลท์ีѷเคยตั Ѹงชืѷอ Range Name ไวก้อ่นนัѸน Excel จะไมย่อมนําชืѷอ 
Range Name มาใสใ่หใ้นสตูร เชน่ เดมิตั Ѹงชืѷอเซลล ์B4:B8 วา่ DataRange จากนัѸนเมืѷอ
เลอืกเซลลอ์ืѷนใดเพืѷอจะสรา้งสตูรลงไปพรอ้มกนั พอพมิพ ์= แลว้คลกิเลอืกเซลล ์B4:B8 
จะไมไ่ดช้ืѷอ DataRange มาใสใ่นสตูร แตจ่ะไดตํ้าแหน่งเซลล ์B4:B8 แสดงในสตูร
เหมอืนวา่ไมเ่คยมชีืѷอ DataRange ตั Ѹงไวก้อ่นแตอ่ยา่งใด หากตอ้งการนําชืѷอ Range 
Name มาใสใ่นสตูร ใหก้ดปุ่ ม F3 เพืѷอเลอืกชืѷอทีѷตอ้งการมาใชแ้ทนการคลกิเลอืกเซลล ์

17. ถา้อยากจะเกง่ Excel ใหท้ดลองสรา้งสตูรกบัตารางขนาดเล็กใหผ้า่นกอ่น แลว้ใหล้อง
กดปุ่ ม Enter ตามธรรมดาบา้ง หรอืกดปุ่ ม Ctrl+Shift+Enter บา้ง เพราะบางครั Ѹงจะได ้
คําตอบตา่งไปจากเดมิ 

18. ไมค่วรปลอ่ยใหค้นทีѷไมรู่จั้กวธิสีรา้งสตูร Array ทีѷสรา้งขึѸนโดยการกดปุ่ ม 
Ctrl+Shift+Enter มาแกไ้ขแฟ้มทีѷมสีตูร Array เพราะเขาจะกดปุ่ ม Enter แทนแลว้อาจ
ทําใหไ้ดคํ้าตอบผดิเพีѸยนไปหรอืไดคํ้าตอบ error ขึѸนมาแทน 
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สตูร Array IF  
เพืѷอใชห้ายอดรวมแยกประเภท 

สตูร Array IF เพืѷอใชห้ายอดรวมแยกประเภท ถอืเป็นสตูรทีѷสําคัญเป็นอยา่งยิѷงและเป็นสตูรทีѷใช ้

บอ่ยทีѷสดุสตูรหนึѷงทเีดยีว จนใน Excel 2007 เป็นตน้มาบรษัิทไมโครซอฟทไ์ดเ้พิѷมสตูร 
SumIFs, CountIFs, และ AverageIFs เพืѷอตอบสนองตอ่ความตอ้งการของผูใ้ช ้เพราะใน 
Excel รุน่กอ่นนัѸนมเีพยีงสตูร SumIF และ CountIF ซึѷงไมส่ามารถรับเงืѷอนไขในการคํานวณเกนิ
กวา่ 1 เงืѷอนไข 

แตถ่า้คณุนําแฟ้มทีѷใชส้ตูร SumIFs, CountIFs, และ AverageIFs ไปเปิดดว้ย Excel 2003 
หรอืรุน่เกา่กวา่ จะพบวา่สตูรใหมเ่หลา่นีѸไมทํ่างานเพราะ Excel รุน่ทีѷจะใชส้ตูรใหมไ่ดก้็ตอ้งเป็น 
Excel รุน่ใหมเ่ชน่กนั 

บทความนีѸจะแนะนําแนวทางการสรา้งสตูร Array IF วา่มทีีѷไปทีѷมาอยา่งไร เพืѷอชว่ยใหส้ามารถ
สรา้งสตูรหายอดรวมแยกประเภทไดโ้ดยไมจํ่าเป็นตอ้งอาศัยสตูร SumIFs, CountIFs, และ 
AverageIFs แตอ่ยา่งใด แลว้เมืѷอคณุทราบหลักการทํางานของการใช ้Array IF หรอื Array 
แบบเงืѷอนไข ยังจะชว่ยใหส้ามารถนําไปพัฒนาสรา้งสตูรหาคําตอบประเภทอืѷนๆไดไ้มย่าก 

สตูร Array IF คอือะไร 

สตูร Array IF คอื สตูร IF ทีѷทําหนา้ทีѷตรวจสอบคา่หลายคา่วา่ตรงตามเงืѷอนไขทีѷกําหนดหรอืไม ่
โดยจะไดผ้ลลัพธจ์ากการตรวจสอบเป็น True หรอื False หลายคา่ตามลําดับตําแหน่งของคา่ทีѷ
ใช ้ซึѷงตา่งจากสตูร IF ธรรมดาทีѷมกีารตรวจสอบคา่เพยีงคา่เดยีวและเกดิผลลัพธเ์ป็น True หรอื 
False อยา่งใดอยา่งหนึѷงเพยีงคา่เดยีว 

โดยลําพังของสตูร Array IF จะไมส่ามารถหายอดรวมแยกประเภทได ้แตเ่มืѷอนําผลลัพธ ์True 
หรอื False ทีѷไดนั้Ѹนไปเทยีบกบั Array ของตัวเลขคําตอบทีѷตอ้งการ จะทําใหเ้ราสามารถเลอืก
เก็บตัวเลขเฉพาะตําแหน่งคา่ทีѷตรงกบัตําแหน่งของ True แลว้จงึนําผลทีѷไดไ้ปหายอดรว่มกบั
สตูรอืѷนๆก็จะกลายเป็นสตูร Array เพืѷอหาคา่ตามสตูรนัѸนๆ เชน่ เมืѷอนําผลทีѷไดห้ลังจากการเทยีบ
ตําแหน่ง True/False ไปซอ้นในสตูร Sum ก็จะกลายเป็นสตูร Array Sum IF ซึѷงหายอดรวม
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แยกประเภท หรอืถา้ซอ้นในสตูร Average ก็จะกลายเป็นสตูร Array Average IF ซึѷงหาคา่เฉลีѷย
แยกประเภท 

โครงสรา้งของสตูร Array IF ประกอบดว้ย 2 สว่นใหญ่ๆ  ซึѷงโดยทัѷวไปทัѸง 2 สว่นตอ้งมขีนาด
ความสงูความกวา้งของ Array เทา่กนั กลา่วคอื 

1. สว่นของ Array ทีѷทําหนา้ทีѷคนืคา่ True หรอื False 
2. สว่นของ Array ทีѷเป็นตัวเลขหรอืคา่คําตอบเรืѷองทีѷตอ้งการ 

(ในเบืѸองตน้ขอใหจํ้าไวว้า่ขนาด Array ทั Ѹงสองสว่นนีѸตอ้งมขีนาดเทา่กนั ซึѷงทีѷจรงิแลว้ขอเพยีงวา่
มขีนาดความสงูหรอืขนาดความกวา้งดา้นใดดา้นหนึѷงเทา่กนัก็ใชไ้ดแ้ลว้) 

การใชส้ตูร Array IF แบบเงืѷอนไขเดยีว 

 

โปรดสงัเกตวา่ใน Range ID มรีหัส a001 และ a002 เป็นรายการทีѷบันทกึซํѸา ซึѷงถา้มรีหัสไมซ่ํѸา
แลว้ตอ้งการหายอด Amount ของ a001 จะสามารถหาคําตอบโดยใชส้ตูร Vlookup ไดทั้นท ี
แตเ่มืѷอมรีายการซํѸา ถา้ใชส้ตูร Vlookup ก็จะไดย้อดของ a001 รายการแรกเพยีงรายการเดยีว 
หากตอ้งการหายอดรวม Amount ของ a001 หรอืจะแยกหายอดแตล่ะรายการทีѷซํѸาของ a001 
ก็ตอ้งอาศัยสตูรคํานวณแบบ Array มาชว่ย 

ถา้ไมใ่ชส้ตูร Array IF จะหายอดรวม Amount ของรหัส a001 จากการคํานวณทลีะขั Ѹนได ้
อยา่งไร 
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1. เพืѷอทําใหต้ารางแสดงเฉพาะพืѸนทีѷซ ึѷงเกีѷยวขอ้งกบัการคํานวณเทา่นัѸน จงึขอลบพืѸนทีѷสว่น
ของ Num และ Name ทิѸงไป แลว้ Insert เพิѷม column C และ E มาใชคํ้านวณทลีะขั Ѹน 

2. ตั Ѹงชืѷอ Check ใหก้บัเซลล ์C3:C7 แลว้สรา้งสตูร =Id=$G$3 จะพบวา่ไดคํ้าตอบเป็น 
TRUE; FALSE; TRUE; FALSE; FALSE ตามลําดับ โดยตําแหน่งทีѷเป็น True คอื
ตําแหน่งของรหัส a001 นัѷนเอง 

3. เซลล ์E3:E7 สรา้งสตูร =IF(Check,Amount,0) จะพบวา่ถา้ตําแหน่งใดใน Check มคีา่
เทา่กบั True สตูร IF นีѸจะเก็บคา่ Amount มาใชต้ามเดมิ แตถ่า้ไมใ่ชจ่ะใสค่า่ 0 แทน 

4. เซลล ์E8 สรา้งสตูร =SUM(E3:E7) ไดคํ้าตอบเทา่กบั 40 ซึѷงเป็นยอดรวมแยกประเภท
ของรหัส a001 ตามตอ้งการ 

แทนทีѷจะตอ้งสรา้งตารางเพิѷมเตมิเพืѷอคํานวณทลีะขั Ѹน เราสามารถลัดหาคําตอบยอดรวมแยก
ประเภทของรหัส a001 ทีѷตอ้งการโดยพจิารณาแยกพืѸนทีѷตารางเป็น 2 สว่น 
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1. Id เป็นสว่นของ Array ทีѷทําหนา้ทีѷคนืคา่ True หรอื False จากการนําไปเปรยีบเทยีบคา่
กบัรหัสทีѷตอ้งการ 

2. Amount เป็นสว่นของ Array ทีѷเป็นตัวเลขหรอืคา่คําตอบเรืѷองทีѷตอ้งการ 

จากนัѸนเราสามารถหาคําตอบยอดรวมแยกประเภทของรหัส a001 ซึѷงบันทกึไวใ้นเซลล ์G3 เป็น
เซลลส์ําหรับใสร่หัสทีѷตอ้งการ แลว้ใชส้ตูรตอ่ไปนีѸหาผลลัพธท์ีѷตอ้งการ 

1. สตูร SUMIF โดยใชส้ตูร =SUMIF(Id,$G$3,Amount) หรอื 
2. สตูร Array SumIF โดยใชส้ตูร { =SUM(IF(Id=$G$3,Amount))} โดยตอ้งกดปุ่ ม 

Ctrl+Shift+Enter ดว้ยจงึจะเกดิวงเล็บปีกกา { } ปิดหัวทา้ยสตูร หรอื 
3. สตูร SumArray โดยใชส้ตูร { =SUM((Id=$G$3)*Amount)} โดยตอ้งกดปุ่ ม 

Ctrl+Shift+Enter ดว้ยจงึจะเกดิวงเล็บปีกกา { } ปิดหัวทา้ยสตูร หรอื 
4. สตูร SumProduct โดยใชส้ตูร =SUMPRODUCT((Id=$G$3)*Amount) โดยไม่

ตอ้งกดปุ่ ม Ctrl+Shift+Enter ดว้ยแตอ่ยา่งใด 

สตูรทั Ѹงสีѷแบบใชห้ลักการคํานวณแบบเดยีวกนั คอื 

1. Id เป็นสว่นของ Array ทีѷทําหนา้ทีѷคนืคา่ True หรอื False จากการนําไปเปรยีบเทยีบคา่
กบัรหัส a001 ทีѷตอ้งการ จะคนืคา่ออกมาเป็น Array  
{TRUE;FALSE;TRUE;FALSE;FALSE} 

2. Amount เป็นสว่นของ Array ทีѷเป็นตัวเลขหรอืคา่คําตอบเรืѷองทีѷตอ้งการ 
{10;20;30;40;50} 

3. เมืѷอนํา Array {TRUE;FALSE;TRUE;FALSE;FALSE} มาเทยีบตําแหน่งกบั Array 
{10;20;30;40;50} จะได ้Array ตัวเลขเฉพาะตัวเลขคําตอบทีѷตอ้งการออกมาเป็น  
{10;FALSE;30;FALSE;FALSE} 

4. จากนัѸนเมืѷอนําผล {10;FALSE;30;FALSE;FALSE} ไปหายอดรวมดว้ยสตูร Sum จงึหา
คําตอบเป็น 40 ตามตอ้งการ 

แมว้า่สตูรทั ѸงสีѷแบบนีѸจะหาผลลัพธท์ีѷตอ้งการไดเ้ชน่เดยีวกนัก็ตาม แตข่อใหพ้จิารณาเลอืกใชใ้ห ้
เหมาะสมกบังาน กลา่วคอื 

1. สตูร SUMIF ใหใ้ชก้บัโจทยท์ีѷงา่ยไปตลอดเพราะสตูรนีѸรับเงืѷอนไขไดเ้พยีงเงืѷอนไข
เดยีว และสตูรนีѸใชเ้วลาคํานวณเร็วทีѷสดุในบรรดาสีѷสตูรทีѷกลา่วถงึอยูน่ีѸ 
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2. สตูร Array SumIF สตูรนีѸเป็นสตูรพเิศษ เพราะเราสามารถเปลีѷยนสตูร Sum ดา้นหนา้
ไปเป็นสตูร Average, Count, Max, Min, หรอื Small เพืѷอหายอดอืѷนๆตามสตูรทีѷใช ้

แทนนัѸน และถา้มหีลายเงืѷอนก็สามารถซอ้น IF เขา้ไปไดอ้กี 
 
{ =SUM(IF(Id=$G$3,Amount))} หายอดรวมของ a001 ไดเ้ทา่กบั 40 
{ =AVERAGE(IF(Id=$G$3,Amount))} หาคา่เฉลีѷยของ a001 ไดเ้ทา่กบั 20 
{ =COUNT(IF(Id=$G$3,Amount))} นับยอดของ a001 ไดเ้ทา่กบั 2 
{ =MAX(IF(Id=$G$3,Amount))} หายอดสงูสดุของ a001 ไดเ้ทา่กบั 30 
{ =MIN(IF(Id=$G$3,Amount))} หายอดตํѷาสดุของ a001 ไดเ้ทา่กบั 10 

3. สตูร SumArray เป็นสตูรทีѷผมนยิมใชเ้พราะใชม้านานและพบวา่สามารถหาคําตอบทีѷ
ตอ้งการไดเ้สมอแมจ้ะลงิคข์า้มแฟ้มมาจากแฟ้มทีѷไมไ่ดเ้ปิดก็ยังทํางานได ้และถา้มี
หลายเงืѷอนไข การใชว้งเล็บหลายๆชดุชว่ยตรวจสอบเงืѷอนไขยังงา่ยกวา่ทีѷจะใชส้ตูร IF 
ซอ้นกนัเขา้ไป 

4. สตูร SumProduct เป็นสตูรยอดนยิมของคนทัѷวไปเพราะไมจํ่าเป็นตอ้งกดปุ่ ม 
Ctrl+Shift+Enter ดว้ยแตอ่ยา่งใด ซึѷงแทจ้รงิแลว้โครงสรา้งภายในวงเล็บของสตูรนีѸก็
เหมอืนกบัของสตูร SumArray นัѷนเอง 

เร ืѷองแปลกของ True กบั False 

คณุควรทราบลักษณะสําคัญของคา่ True หรอื False เพิѷมเตมิกอ่นทีѷจะเรยีนรูว้ธิใีชส้ตูร Array 
IF แบบหลายเงืѷอนไข กลา่วคอื Excel ถอืวา่คา่ True มคีา่เทา่กบั 1 และคา่ False มคีา่เทา่กบั 
0 ซึѷงเราจะเห็นคา่เหลา่นีѸไดช้ดั ตอ่เมืѷอนําคา่ True หรอื False มาคาํนวณตอ่  

แตถ่า้นําคา่ True ทีѷไดไ้ปเทยีบตรงๆกบัเลข 1 วา่เทา่กนัหรอืไม ่จะพบวา่ True ไมเ่ทา่กบั 1 
และถา้นําคา่ False ทีѷไดไ้ปเทยีบตรงๆกบัเลข 0 วา่เทา่กนัหรอืไม ่จะพบวา่ False ไมเ่ทา่กบั 0 
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จากภาพตัวอยา่งนีѸ เซลล ์B2 มคีา่ =TRUE() จากนัѸนเรามาทดสอบคา่ของ B2 กนั จะพบวา่ใน
เซลล ์C2 เมืѷอนํามาเทยีบคา่กนัโดยตรง ซึѷงมสีตูร =B2=1 บอกเราวา่ False แสดงวา่ True 
ไมไ่ดเ้ทา่กบั 1 แตเ่มืѷอนําคา่จาก B2 ไปคํานวณตอ่ในเซลล ์C3:C8 ไมว่า่จะนํา B2 ไป *1, /1, 
+0, -0, หรอืใสเ่ครืѷองหมายลบลบไวข้า้งหนา้ หรอืนําไปคณูกบั TRUE() จะกระตุน้ใหแ้สดงคา่
เทา่กบัเลข 1 ออกมาใหเ้ห็น 

ทํานองเดยีวกนั เซลล ์G2 มคีา่ =FALSE() จากนัѸนเรามาทดสอบคา่ของ G2 กนั จะพบวา่ใน
เซลล ์H2 เมืѷอนํามาเทยีบคา่กนัโดยตรง ซึѷงมสีตูร =G2=0 บอกเราวา่ False แสดงวา่ False 
ไมไ่ดเ้ทา่กบั 0 แตเ่มืѷอนําคา่จาก G2 ไปคํานวณตอ่ในเซลล ์H3:H8 ไมว่า่จะนํา G2 ไป *1, /1, 
+0, -0, หรอืใสเ่ครืѷองหมายลบลบไวข้า้งหนา้ หรอืนําไปคณูกบั TRUE() จะกระตุน้ใหแ้สดงคา่
เทา่กบัเลข 0 ออกมาใหเ้ห็น 

ดังนัѸนถา้เราม ีArray ซึѷงมคีา่ True หรอื False แลว้นําไปบวกหรอืคณูกบั Array อืѷนทีѷมคีา่เป็น
ตัวเลขหรอืมคีา่เป็น True หรอื False ก็ตาม ยอ่มเหมอืนกบันําเลข 1 หรอืเลข 0 ไปบวกหรอืคณู
กบัคา่อืѷนนัѷนเอง โปรดดขูอ้พสิจูนจ์ากรปูตอ่ไปนีѸ 

 

Array ทีѷมเีลข 1 และ 0 จากการบวกหรอืคณูนีѷแหละทีѷชว่ยทําใหเ้ราหายอดรวมแยกประเภท
ตอ่ไปได ้
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การใชส้ตูร Array IF แบบหลายเงืѷอนไข 

กรณี Range ทีѷใชต้รวจสอบเงืѷอนไขมาจากเรืѷองเดยีวกนั ใหใ้ชบ้วก 

 

ใหห้ายอดรวม Amount ของรหัส Id a001 กบั a002 (ทั ѸงนีѸทีѷเรยีกวา่ เป็นเรืѷองเดยีวกนัเพราะ
เงืѷอนไขเป็นเรืѷองของรหัสเชน่กนัทั Ѹงคู)่ โดยบันทกึรหัสทีѷตอ้งการใหใ้ชเ้ป็นรหัสทีѷคน้หาไวท้ีѷ
เซลล ์G3 และ H3 ตามลําดับ ซึѷงสามารถใชส้ตูรหาคําตอบเป็นยอดรวม 110 ไดห้ลายวธิ ีดังนีѸ 

1. ใชส้ตูร {=SUM(IF(Id=G3, Amount, IF(Id=H3,Amount,0) ))} 
 
โดยตอ้งกดปุ่ ม Ctrl+Shift+Enter เพืѷอสรา้งเครืѷองหมายวงเล็บปีกกา { } ปิดหัวทา้ย
สตูร ถา้แกะสตูร IF(Id=G3, Amount, IF(Id=H3,Amount,0) ) โดยการคลกิลากทับ
สว่นของสตูรนีѸแลว้กดปุ่ ม F9 จะได ้Array {10;20;30;0;50} ซึѷงเปลีѷยนคา่ Amount 
ของรหัสอืѷนทีѷไมเ่ทา่กบั a001 หรอื a002 ใหเ้ทา่กบั 0 แทน 

2. ใชส้ตูร { =SUM(  ((Id=G3)+(Id=H3))  *Amount) } 
 
โดยตอ้งกดปุ่ ม Ctrl+Shift+Enter เพืѷอสรา้งเครืѷองหมายวงเล็บปีกกา { } ปิดหัวทา้ย
สตูร ถา้แกะสตูร ((Id=G3)+(Id=H3)) โดยการคลกิลากทับสว่นของสตูรนีѸแลว้กดปุ่ ม 
F9 จะได ้Array {1;1;1;0;1} โดยมเีลข 1 ตรงกบัตําแหน่งของรหัสทีѷตอ้งการ  
ถา้แกะทีѷมาของเงืѷอนไข (Id=G3) จะได ้Array ของ 
{TRUE;FALSE;TRUE;FALSE;FALSE} ทีѷนํามาบวกกบั (Id=H3) ซึѷงเป็น Array ของ 
{FALSE;TRUE;FALSE;FALSE;TRUE} ทําใหไ้ด ้Array  
{1;1;1;0;1}  
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และเมืѷอนํา {1;1;1;0;1} คณูกบั Array ของ Amount {10;20;30;40;50} 
จะได ้Array {10;20;30;0;50} ซึѷงรวมคา่ทั Ѹงหมดไดเ้ทา่กบั 110 ตามตอ้งการ 

3. ใชส้ตูร =SUMPRODUCT(  ((Id=G3)+(Id=H3))  *Amount) 
 
โดยมหีลักการคํานวณแบบเดยีวกบัวธิทีีѷสอง แตไ่มต่อ้งอาศัย { } 

เพืѷอชว่ยทําใหม้องเห็นลําดับการคํานวณไดช้ดัเจนขึѸน ขอใหด้ภูาพตอ่ไปนีѸแลว้ดหูลักการ
คํานวณทลีะขั Ѹนจาก column ซา้ยไปขวา 

 

 Column ทีѷ 1 เป็นรหัส Id จะพบวา่มรีหัส a001 กบั a002 อยู ่4 รายการ 
 Column ทีѷ 2 ตรวจสอบรหัส Id a001 จะพบวา่มรีหัส a001 อยู ่2 รายการ โดยถา้มอง

ตําแหน่งทีѷเป็นรหัสทีѷตอ้งการเป็นเลข 1 และตําแหน่งทีѷไมใ่ชเ่ป็นเลข 0  
จะไดเ้ลข 1, 0, 1, 0, 0 ตามลําดับจากบนมาลา่ง 

 Column ทีѷ 3 ตรวจสอบรหัส Id a002 จะพบวา่มรีหัส a002 อยู ่2 รายการ โดยถา้มอง
ตําแหน่งทีѷเป็นรหัสทีѷตอ้งการเป็นเลข 1 และตําแหน่งทีѷไมใ่ชเ่ป็นเลข 0  
จะไดเ้ลข 0, 1, 0, 0, 1 ตามลําดับจากบนมาลา่ง 

 Column ทีѷ 4 เป็นผลรวมเมืѷอนํา Column ทีѷ 2 มารวมกบั Column ทีѷ 3  
จะไดเ้ลข 1, 1, 1, 0, 1 ตามลําดับจากบนมาลา่ง แสดงตําแหน่งของรหัส a001 กบั 
a002 ณ ตําแหน่งทีѷตรงกบัเลข 1 

 Column ทีѷ 5 เป็นตัวเลข Amount ทั Ѹงหมด 
 Column ทีѷ 6 เป็นผลคณูเมืѷอนํา Column ทีѷ 4 มารวมกบั Column ทีѷ 5 

จะไดเ้ลข 10, 20, 30, 0, 50 ตามลําดับจากบนมาลา่ง ซึѷงรวมเทา่กบั 110 

หมายเหต ุสามารถใชส้ตูร CountIF มาชว่ยแทนการนําเงืѷอนไขมาบวกกนั ซึѷงเป็นวธิกีารใหมท่ีѷ
ผมเพิѷงคน้พบและนํามาสอนในหลักสตูร Excel Dynamic Reports 
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การใชส้ตูร Array IF แบบหลายเงืѷอนไข 

กรณี Range ทีѷใชต้รวจสอบเงืѷอนไขมาจากตา่งเรืѷองกนั ใหใ้ชค้ณู 

 

ใหห้ายอดรวม Amount ของรหัส Id a001 เฉพาะรายการทีѷม ีName เทา่กบั c (ทั ѸงนีѸทีѷเรยีกวา่ 
เป็นตา่งเรืѷองกนั เพราะเงืѷอนไขรหัสตา่งจากเงืѷอนไขชืѷอ) โดยบันทกึรหัสทีѷตอ้งการใหใ้ชเ้ป็นรหัส
และชืѷอทีѷคน้หาไวท้ีѷเซลล ์G3 และ H3 ตามลําดับ ซึѷงสามารถใชส้ตูรหาคําตอบเป็นยอดรวม 30 
ไดห้ลายวธิ ีดังนีѸ 

1. ใชส้ตูร { =SUM(IF(Id=G3, IF(Name=H3,Amount,0), 0 ))} 
 
โดยตอ้งกดปุ่ ม Ctrl+Shift+Enter เพืѷอสรา้งเครืѷองหมายวงเล็บปีกกา { } ปิดหัวทา้ย
สตูร ถา้แกะสตูร IF(Id=G3, IF(Name=H3,Amount,0), 0 ) โดยการคลกิลากทับสว่น
ของสตูรนีѸแลว้กดปุ่ ม F9 จะได ้Array {0;0;30;0;0} ซึѷงเปลีѷยนคา่ Amount ของรหัส
อืѷนทีѷไมเ่ทา่กบั a001 และชืѷอไมใ่ช ่c ใหเ้ทา่กบั 0 แทน 

2. ใชส้ตูร { =SUM(  (Id=G3)*(Name=H3)  *Amount) } 
 
โดยตอ้งกดปุ่ ม Ctrl+Shift+Enter เพืѷอสรา้งเครืѷองหมายวงเล็บปีกกา { } ปิดหัวทา้ย
สตูร ถา้แกะสตูร (Id=G3)*(Name=H3) โดยการคลกิลากทับสว่นของสตูรนีѸแลว้กดปุ่ ม 
F9 จะได ้Array {0;0;1;0;0} โดยมเีลข 1 ตรงกบัตําแหน่งรายการทีѷตอ้งการ  
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ถา้แกะทีѷมาของเงืѷอนไข (Id=G3) จะได ้Array ของ 
{TRUE;FALSE;TRUE;FALSE;FALSE} นํามาคณูกบั (Name=H3) ซึѷงเป็น Array ของ 
{FALSE;FALSE;TRUE;FALSE;FALSE} ทําใหไ้ด ้Array  
{0;0;1;0;0} 
และเมืѷอนํา {0;0;1;0;0} คณูกบั Array ของ Amount {10;20;30;40;50} 
จะได ้Array {0;0;30;0;0} ซึѷงรวมคา่ทั Ѹงหมดไดเ้ทา่กบั 30 ตามตอ้งการ 

3. ใชส้ตูร =SUMPRODUCT(  (Id=G3)*(Name=H3)  *Amount) 
โดยมหีลักการคํานวณแบบเดยีวกบัวธิทีีѷสอง แตไ่มต่อ้งอาศัย { } 

4. ใชส้ตูร =SUMIFS(Amount,Id,G3,Name,H3) เป็นสตูรทีѷเกดิขึѸนใน Excel 2007 
เป็นตน้มา 

เพืѷอชว่ยทําใหม้องเห็นลําดับการคํานวณไดช้ดัเจนขึѸน ขอใหด้ภูาพตอ่ไปนีѸแลว้ดหูลักการ
คํานวณทลีะขั Ѹนจาก column ซา้ยไปขวา 

 

 Column ทีѷ 1 เป็นรหัส Id จะพบวา่มรีหัส a001 อยู ่2 รายการ 
 Column ทีѷ 2 ตรวจสอบรหัส Id a001 จะพบวา่มรีหัส a001 อยู ่2 รายการ โดยถา้มอง

ตําแหน่งทีѷเป็นรหัสทีѷตอ้งการเป็นเลข 1 และตําแหน่งทีѷไมใ่ชเ่ป็นเลข 0  
จะไดเ้ลข 1, 0, 1, 0, 0 ตามลําดับจากบนมาลา่ง 

 Column ทีѷ 3 เป็นชืѷอ Name จะพบวา่มชีืѷอ c อยู ่1 รายการ 

 Column ทีѷ 4 ตรวจสอบชืѷอ Name c จะพบวา่มชีืѷอ Name c อยู ่1 รายการ โดยถา้มอง
ตําแหน่งทีѷเป็นรหัสทีѷตอ้งการเป็นเลข 1 และตําแหน่งทีѷไมใ่ชเ่ป็นเลข 0  
จะไดเ้ลข 0, 0, 1, 0, 0 ตามลําดับจากบนมาลา่ง 

 Column ทีѷ 5 เป็นผลคณูเมืѷอนํา Column ทีѷ 2 มาคณูกบั Column ทีѷ 4  
จะไดเ้ลข 0, 0, 1, 0, 0 ตามลําดับจากบนมาลา่ง แสดงตําแหน่งของรหัส a001 มชีืѷอ 
Name c ณ ตําแหน่งทีѷตรงกบัเลข 1 
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 Column ทีѷ 6 เป็นตัวเลข Amount ทั Ѹงหมด 
 Column ทีѷ 7 เป็นผลคณูเมืѷอนํา Column ทีѷ 5 มาคณูกบั Column ทีѷ 6 

จะไดเ้ลข 0, 0, 30, 0, 0 ตามลําดับจากบนมาลา่ง ซึѷงรวมเทา่กบั 30 

วธิพีลกิแพลงสตูร SumProduct 

สตูร SumProduct เป็นสตูรทีѷทํางานแบบ Array อยูใ่นตัว มหีนา้ทีѷนํา Range ของตัวเลขแตล่ะ
ตําแหน่งจากตารางทีѷมขีนาดเทา่กนั มาคณูกนัทลีะเซลลต์ามตําแหน่งทีѷตรงกนั จากนัѸนจงึบวก
รวมผลคณูทีѷไดนั้Ѹนเขา้ดว้ยกนั  

ตัวอยา่ง เชน่ เราตอ้งการหามลูคา่ตน้ทนุรวมของสนิคา้ โดยนําตน้ทนุตอ่หน่วยมาคณูกบัจํานวน
หน่วย ซึѷงหากไมรู่จั้กสตูร SumProduct ก็ตอ้งนํา Cost*Quantity ทลีะรายการ เพืѷอใหไ้ด ้
ตัวเลข Total ตาม Column D จากนัѸนจงึสรา้งสตูรในเซลล ์F2 =SUM(D3:D5) จงึจะไดย้อด
รวมตน้ทนุทั Ѹงหมด 

 

ซึѷงแทนทีѷจะตอ้งเสยีพืѸนทีѷคํานวณหา Total ใน Column D เราสามารถใชส้ตูร SumProduct ลัด
หาตน้ทนุรวมไดโ้ดยใชส้ตูรตามนีѸ 

1. =SUMPRODUCT(Cost, Quantity) เป็นการใชส้ตูรตามโครงสรา้งปกต ิโดยใช ้

เครืѷองหมาย comma , คัѷนแตล่ะ Range ในสตูร หรอื 
2. =SUMPRODUCT(Cost*Quantity) เป็นสตูรทีѷนําแตล่ะ Range มาคณูกนัเลย ซึѷง

การสรา้งแบบคณูกนันีѸ จะชว่ยใหเ้ราสามารถคลกิลากทับการคํานวณในวงเล็บแลว้กดปุ่ ม 
F9 เพืѷอเห็นผลการคณูกนัของแตล่ะตําแหน่งไดด้ว้ย 
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จากนัѸน ขอยอ้นกลับไปเรืѷองโครงสรา้งภายในสตูร Array IF ตามทีѷอธบิายไวแ้ลว้วา่ โครงสรา้ง
ของสตูร Array IF ประกอบดว้ย 2 สว่นใหญ่ๆ  ซึѷงโดยทัѷวไปทัѸง 2 สว่นตอ้งมขีนาดความสงูความ
กวา้งของ Array เทา่กนั กลา่วคอื 

1. สว่นของ Array ทีѷทําหนา้ทีѷคนืคา่ True หรอื False 
2. สว่นของ Array ทีѷเป็นตัวเลขหรอืคา่คําตอบเรืѷองทีѷตอ้งการ 

ขอนําสตูร =SUMPRODUCT(  (Id=G3)*(Name=H3)  *Amount) มาวเิคราะหแ์ยก
โครงสรา้งขา้งตน้ จะพบวา่ 

1. สว่นของ Array ทีѷทําหนา้ทีѷคนืคา่ True หรอื False ไดแ้ก ่สว่นของ (Id=G3) และ 
(Name=H3)  ซึѷงนํามาคณูกนัเพืѷอทําใหเ้ปลีѷยน True เป็นเลข 1 และเปลีѷยน False เป็น
เลข 0 

2. สว่นของ Array ทีѷเป็นตัวเลขหรอืคา่คําตอบเรืѷองทีѷตอ้งการ ไดแ้กส่ว่นของ Amount 

ดังนัѸนหากตอ้งการปรับสตูรใหคํ้านวณนับแทนการหายอดรวมของ Amount โดยใหนั้บวา่มคีา่
ตามเงืѷอนไขทัѸงสิѸนกีѷรายการ ใหใ้ชส้ตูรใดสตูรหนึѷงตอ่ไปนีѸก็ได ้

1. =SUMPRODUCT(  (Id=G3)*(Name=H3) ) โดยสตูร SumProduct จะทํา
หนา้ทีѷรวมเลข 1 ทีѷไดจ้ากการคณูกนัของ Array ภายในวงเล็บวา่มเีลข 1 กีѷตัว นัѷนคอืนับ
จํานวนรายการทีѷมเีงืѷอนไขตามตอ้งการนัѷนเอง 

2. =SUMPRODUCT(  (Id=G3)*1, (Name=H3)*1) 
3. =SUMPRODUCT(  (Id=G3)/1, (Name=H3)/1) 
4. =SUMPRODUCT(  (Id=G3)+0, (Name=H3)+0) 
5. =SUMPRODUCT(  (Id=G3)-0, (Name=H3)-0) 
6. =SUMPRODUCT(  --(Id=G3), --(Name=H3) ) 

สตูร SumProduct แบบทีѷ 2-6 เป็นสตูรทีѷใชเ้ครืѷองหมาย comma , คัѷน จงึจําเป็นตอ้งกระตุน้ให ้
เปลีѷยน True เป็นเลข 1 และเปลีѷยน False เป็นเลข 0 โดยนํา True หรอื False ทีѷไดจ้ากการ
ตรวจสอบเงืѷอนไขไป *1, /1, +0, -0, หรอืใสเ่ครืѷองหมายลบลบไวข้า้งหนา้กอ่น 

ดังนัѸนจงึขอแนะใหส้รา้งสตูร SumProduct แบบนําเงืѷอนไขมาคํานวณ(คณูหรอืบวก)กนัเองกอ่น 
เพราะนอกจากจะแกะหาผลจากการคณูหรอืบวกกนัจากสว่นของเงืѷอนไขทีѷนํามาคํานวณกนัได ้
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แลว้ ยังเป็นสตูรทีѷสั Ѹนกวา่และมขีั Ѹนตอนการคํานวณนอ้ยกวา่สตูร SumProduct ทีѷใชแ้บบ
เครืѷองหมาย comma , คัѷนอยูภ่ายใน 

หมายเหต ุ

โดยทัѷวไปหากเงืѷอนไขทีѷใชใ้นสตูร Array IF เป็นการตรวจสอบวา่เทา่กนัหรอืไม ่โดยใช ้

เครืѷองหมาย = ในการเปรยีบเทยีบวา่เป็น True หรอื False เราสามารถทอ่งจําไวเ้ลยดังนีѸ 

 ถา้ Range ทีѷนํามาตรวจสอบเงืѷอนไขเป็น เร ืѷองเดยีวกนั ใหนํ้าผลลัพธจ์ากการ
ตรวจสอบเงืѷอนไขมา บวกกนั และมวีงเล็บเปิดดา้นหนา้ 3 ตัว 

 ถา้ถา้ Range ทีѷนํามาตรวจสอบเงืѷอนไขเป็น ตา่งเรืѷองกนั ใหนํ้าผลลัพธจ์ากการ
ตรวจสอบเงืѷอนไขมา คณูกนั และมวีงเล็บเปิดดา้นหนา้ 2 ตัว 

แตถ่า้เป็นการตรวจสอบเงืѷอนไขประเภทมากกวา่หรอืนอ้ยกวา่หรอืผสมกนั แม ้Range ทีѷนํามา
เป็นเงืѷอนไขจะเป็นเรืѷองเดยีวกนั ก็ไมจํ่าเป็นวา่ตอ้งนําผลลัพธจ์ากการตรวจสอบเงืѷอนไขมาบวก
กนัเสมอไป บางกรณีอาจใชค้ณูกนัก็ได ้ทั ѸงนีѸข ึѸนกบัลักษณะการเปรยีบเทยีบทีѷใชด้ว้ย โดยขอให ้
คดิหาวธิใีดก็ไดท้ีѷจะทําใหเ้กดิเลข 1 ชีѸเฉพาะตําแหน่งรายการทีѷตอ้งการใหไ้ด ้
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ของจรงิ ของปลอม  
ของใชไ้มไ่ดใ้น Excel 

ในเรืѷองความซืѷอสตัยส์จุรติ โปรแกรม Excel ถอืวา่ไดห้นึѷงรอ้ยคะแนนเต็ม ไมว่า่คณุจะบันทกึคา่ 
สรา้งสตูร หรอืนํา Excel มาใชแ้บบใด อะไรทีѷคณุทําลงไปใน Excel ก็จะไดร้ับผลตามนัѸน แตถ่า้
คณุเขา้ใจ Excel ไดไ้มด่พีอ ก็อาจจะตโีพยตพีายเมืѷอเห็นวา่ Excel ทรยศ เพราะมันใหคํ้าตอบทีѷ
ผดิพลาดตา่งจากคําตอบทีѷคณุตอ้งการ ทั Ѹงๆทีѷแทจ้รงิแลว้คณุนัѷนแหละทีѷเขา้ใจผดิ 

ของจรงิทีѷทาํใหส้ตูร IF กลายเป็นของปลอม 

เนืѸอหาทีѷจะนํามาอธบิายตอ่ไปนีѸจะชีѸเป็นชีѸตายใหก้บัคนทีѷชอบใชส้ตูร IF หรอืสตูรใดก็ตามทีѷ
เกีѷยวขอ้งกบัการตัดสนิใจหรอืใชใ้นการคน้หาขอ้มลูวา่ แฟ้มงานทีѷคณุสรา้งขึѸนนัѸนมคีวาม
น่าเชืѷอถอืหรอืไม ่เพืѷอพสิจูนใ์หเ้ห็นกบัตา ลองดสูตูร IF ตอ่ไปนีѸแลว้คดิวา่จะไดคํ้าตอบออกมา
เป็นคําวา่ เทา่กนั หรอื ไมเ่ทา่กนั 

=IF( 22.3-22.2=0.1, "เทา่กนั", "ไมเ่ทา่กนั") 

เชืѷอหรอืไม!่!! Excel จะใหคํ้าตอบออกมาวา่ 22.3-22.2 นัѸนไมเ่ทา่กบั 0.1 โดยคนืคา่ออกมาเป็น
คําวา่ ไมเ่ทา่กนั ซึѷงถอืเป็นคําตอบทีѷถกูตอ้ง เพราะ 22.3-22.2 ไมไ่ดคํ้านวณออกมาแลว้ใหผ้ล
ลัพธเ์ทา่กบั 0.1 ตามทีѷเราเขา้ใจ 

ขอใหล้องสรา้งสตูร =22.3-22.2 ลงไปในเซลล ์แลว้กดปุ่ ม F2 ตามดว้ยปุ่ ม F9 จะพบวา่คา่ทีѷ
แทจ้รงิทีѷ Excel คํานวณไดค้อื 0.100000000000001 ซึѷงแน่นอนวา่ไมใ่ช ่0.1 

บางคนมองคา่ 0.100000000000001 แลว้ยอมรับตัวเลขทีѷไดน้ีѸ เพราะเห็นวา่มันตา่งจาก 0.1 ทีѷ
ตอ้งการเพยีงเล็กนอ้ย ถา้ใครคดิเชน่นีѸแสดงวา่เขา้ใจ Excel ผดิ เพราะ Excel จะไมย่อมรับวา่คา่ 
0.1 เทา่กบั0.100000000000001 ไมว่า่คา่ทีѷแตกตา่งกนันัѸนจะนอ้ยมากก็ตาม 

การทีѷ Excel คํานวณไดค้า่ทีѷเพีѸยนตา่งจากทีѷควรนีѸ ไมไ่ดถ้อืวา่เป็นการคํานวณทีѷผดิพลาด และ
ไมไ่ดม้แีคก่รณีนีѸกรณีเดยีว สตูรหรอืการคํานวณใดๆทีѷคณุใชม้โีอกาสคนืคา่เพีѸยนไปจากทีѷ
ตอ้งการไดทั้ ѸงนัѸน 
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Excel จะใชร้ปูแบบ (Format Number) แสดงคา่ในเซลลต์ามลักษณะตัวเลขทีѷพมิพ ์นีѷคอื
สาเหตปุระการแรกทีѷอธบิายวา่ ทําไม Excel จงึไมแ่สดงคา่ 0.100000000000001 ในเซลล์
ออกมาใหเ้ห็นครบทกุหลัก เนืѷองจากตัวเลข 22.3-22.2 ทีѷพมิพล์งไปมทีศนยิมเพยีงหนึѷงหลัก 
ดังนัѸน Excel จงึแสดงผลลัพธใ์หเ้ห็นตัวเลขทีѷมทีศนยิมเพยีงหนึѷงหลักตามไปดว้ย 

คา่ทีѷเพีѸยนไปไมไ่ดถ้อืวา่เกดิจากการคํานวณทีѷผดิพลาด แตเ่ป็นเพราะ Excel ใชห้ลักการคํานวณ
แบบเลขฐานสองแลว้แปลงกลับมาเป็นเลขฐานสบิ ซึѷงคา่ 22.3-22.2 คํานวณแบบเลขฐานสอง 
ไดคํ้าตอบเป็นเลขทีѷซํѸาไมรู่จ้บ (Repeating Binary Number) จากนัѸนเมืѷอแปลงกลับมาเป็น
เลขฐานสบิใหพ้วกเราเขา้ใจ จงึตอ้งปรับคา่ใหเ้หลอืเพยีง 15 หลัก (Excel มคีวามละเอยีด
Precision โดยรับตัวเลขไดส้งูสดุ 15 หลัก) แลว้สง่ผลใหไ้ดผ้ลลัพธแ์ตกตา่งจากทีѷควรบา้ง
เล็กนอ้ย และมไิดเ้กดิขึѸนเฉพาะกรณี 22.3-22.2 เทา่นัѸน เราไมม่ทีางคาดการณ์ไดเ้ลยวา่จะ
เพีѸยนเมืѷอใดและเกดิจากการคํานวณใด 

ดงัน ัҟนกอ่นทีѷคณุจะใชส้ตูรทีѷเก ีѷยวขอ้งกบัการตดัสนิใจหรอืสตูรในการคน้หาขอ้มลู เชน่ 
IF, SumIF, VLookup, หรอื Match จําเป็นตอ้งปรับคา่ใหเ้ทา่กบัคา่ทีѷตอ้งการ เพืѷอใหเ้ป็นไป
ตามเงืѷอนไขทีѷตอ้งการกอ่นเสมอ โดยใชส้ตูรอืѷนเขา้มาชว่ยปรบัคา่ จากนัѸนเมืѷอไดค้า่ตามทีѷ
ตอ้งการจรงิๆแลว้คณุจะกําหนดรปูแบบ Format ใดๆใหก้บัคา่นัѸนก็ตามใจ (หา้มใชแ้ตเ่พยีงการ
กําหนดรปูแบบเทา่นัѸนเพราะมันไมไ่ดช้ว่ยปรับคา่ทีѷแทจ้รงิแตอ่ยา่งใด) 

สตูรสําคัญซึѷงใชใ้นการปรับคา่ตัวเลขใหเ้ป็นไปตามตอ้งการ (โปรดศกึษารายละเอยีดของสตูร
ไดจ้าก Excel Help) ไดแ้ก ่

1. สตูร =Round(ตวัเลข, จํานวนหลกั) ใชส้ําหรบัการปัดคา่ 
 
=Round(123.45,0) คนืคา่ 123 
=Round(123.45,1) คนืคา่ 123.5  
=Round(123.45,-1) คนืคา่ 120 
=Round(123.45,-2) คนืคา่ 100 
 

2. สตูร =Trunc(ตวัเลข, จํานวนหลกั) ใชส้ําหรบัการตัดคา่ 
 
=Trunc(123.45,0) คนืคา่ 123 
=Trunc(123.45,1) คนืคา่ 123.4 ตา่งจาก Round 
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=Trunc(123.45,-1) คนืคา่ 120 
=Trunc(123.45,-2) คนืคา่ 100 
 

3. สตูร =Int(ตวัเลข) ใชส้ําหรับปรับเป็นตัวเลขจํานวนเต็ม(ทีѷนอ้ยกวา่คา่เดมิ) 
 
=Int(1.23) คนืคา่ 1 
=Int(-1.23) คนืคา่ -2 
 

4. สตูร =Mod(เลขต ัҟงต ัҟง, เลขตวัหาร) ใชส้ําหรับหาเศษทีѷเหลอืจากการหาร 
 
=Mod(7,2) คนืคา่ 1 เพราะ 7/2 เทยีบเทา่กบั 3 1/2 
=Mod(7,4) คนืคา่ 3 เพราะ 7/4 เทยีบเทา่กบั 1 3/4 
=Mod(123.45,1) คนืคา่เทา่กบั .45 !!!  

วนัทีѷจอมปลอม 

 

ในหนา้รายงานของทกุคน ตอ้งมขีอ้มลูเกีѷยวกบัวันเดอืนปีของรายงานนัѸนกํากบัอยูด่ว้ยเสมอ 
ขอใหเ้ปิดแฟ้มของคณุขึѸนมาดซูวิา่ในเซลลท์ีѷมขีอ้มลูแสดงวันเดอืนปี ถา้ไมไ่ดก้ําหนดรปูแบบให ้
ชดิซา้ยหรอืชดิขวา ขอ้มลูวันเดอืนปีของคณุชดิซา้ยของเซลลต์ามรปูขา้งบนนีѸเหมอืนใน 
Column B หรอืชดิขวาของเซลลเ์หมอืนใน Column C 

Column B เป็นชืѷอเดอืนทีѷชดิซา้ยของเซลล ์ไมว่า่คณุจะบันทกึไวเ้ป็นเพยีงเลขทีѷวัน หรอืเฉพาะ
เลขทีѷเดอืน หรอืชืѷอเดอืนเทา่นัѸนตามแบบทีѷเห็นในภาพนีѸ ถา้มันชดิซา้ยเองโดยคณุไมไ่ด ้
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กําหนดใหม้ันชดิซา้ย แสดงวา่ขอ้มลูนัѸนมคีา่เป็น Text ซึѷงไมม่ปีระโยชนใ์นการนําขอ้มลูไปใช ้

คํานวณตอ่แมแ้ตน่อ้ย อยา่งเชน่เซลล ์B2 ทีѷมคํีาวา่ Jan ไมไ่ดใ้หร้ายละเอยีดวา่เป็นวันทีѷใดของ
เดอืนมกราคมหรอืเป็นเดอืนมกราคมของปีใด คําวา่ Jan ทีѷชดิซา้ยใหค้วามหมายแตเ่พยีงบอกวา่
เป็นเดอืนมกราคมเทา่นัѸน ซึѷงหลายคนแกปั้ญหาโดยการเพิѷมเซลลบ์ันทกึเลขปีลงไปอกี 

Column C เป็นการบันทกึแบบทีѷถกูตอ้ง สงัเกตวา่ชืѷอเดอืนชดิขวาของเซลล ์และแมใ้นเซลล ์
C2 แสดงคําวา่ Jan ก็ตาม แตเ่มืѷอมองทีѷชอ่ง Formula Bar ดา้นบน จะพบวา่มคีา่ทีѷแทจ้รงิเป็น 
15/1/2010 ซึѷงหากตอ้งการใหแ้สดงชืѷอเดอืนตั Ѹงแตเ่ซลล ์C3 ตอ่ๆกนัไป ใหส้รา้งสตูร =C2+30 
ลงไปในเซลล ์C3 แลว้ Copy สตูรนีѸตอ่ลงไปในแนวตั Ѹง จากนัѸนใหก้ําหนด Format Cells ใน 
Column C เป็น [$-409]mmm หรอื [$-en-US]mmm จะทําใหค้า่ 15/1/2010, 
14/2/2010, 16/3/2010 แสดงเฉพาะชืѷอเดอืน Jan, Feb, Mar ทีѷชดิขวาของเซลล ์ 

สาเหตทุีѷใชค้า่แรกในเซลล ์C2 เป็นวันทีѷ 15 นัѸนเพืѷอชว่ยใหเ้ราสามารถบวกเพิѷมตอ่ไปเซลลล์ะ 
30 วัน เพืѷอทําใหไ้ดเ้ดอืนตอ่ไปเพิѷมทลีะเดอืนไดง้า่ยกวา่ทีѷจะเริѷมเซลลแ์รกเป็นวันทีѷส ิѸนเดอืน ซึѷง
ตอ้งบวกเพิѷมดว้ยจํานวน 31 วัน 30 วัน 28-29 วันแตกตา่งกนัไปในแตล่ะเดอืน 
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หลกัการใชว้นัทีѷและเวลา 

1. ในการบันทกึ ใหพ้มิพใ์หค้รบทัѸงวันเดอืนปี อยา่บันทกึเฉพาะวันทีѷหรอืเฉพาะเดอืนหรอืเฉพาะ
ปีเทา่นัѸน โดยจะพมิพส์ว่นของเวลาตอ่ทา้ยดว้ยหรอืไมก่็ได ้เชน่ 14/2/2010 12:00 

2. ใหบ้ันทกึโครงสรา้งของวันทีѷลงไปในเซลลต์ามแบบทีѷกําหนดไวใ้น Regional Setting ของ 
Windows เชน่ ถา้กําหนดไวใ้น Regional Setting เป็น Thai ก็ตอ้งบันทกึวันทีѷตามแบบของ
ประเทศไทยซึѷงใชลํ้าดับตามวันกอ่นเดอืนกอ่นปี แตถ่า้กําหนดใน Regional Setting เป็น 
USA ก็ตอ้งบันทกึตามลําดับเดอืนกอ่นวันกอ่นปี 

3. แมจ้ะใช ้Regional Setting เป็น Thai แตใ่นการบันทกึในสว่นของเลขปีตอ้งใชปี้ค.ศ.ในการ
บันทกึเทา่นัѸน จากนัѸนใหใ้ช ้Format ปรับการแสดงปีค.ศ.ใหเ้ป็นปีพ.ศ.ในภายหลัง เชน่ ให ้
บันทกึ 14/2/2010 (หา้มใชปี้พ.ศ.แทนอยา่งเด็ดขาด) จากนัѸนเมืѷอตอ้งการแสดงเป็น 
14/2/2553 ใหใ้ช ้Format [$-1070000]d/mm/yyyy 

4. ในโครงสรา้งของวันทีѷใหพ้มิพเ์ครืѷองหมาย / ในการแบง่สว่นของ วนั/เดอืน/ปีค.ศ. และ
ในโครงสรา้งของเวลาใหพ้มิพเ์ครืѷองหมาย : ในการแบง่สว่นของ ช ัѷวโมง:นาท:ีวนิาท ี

5. ควรพมิพเ์ลขปีค.ศ.ใหค้รบทัѸง 4 หลักเสมอ แตถ่า้จําเป็นตอ้งพมิพแ์คส่องหลักทา้ย พอกด
ปุ่ ม Enter เพืѷอบันทกึคา่ลงไป Excel จะเปลีѷยนตัวเลขปี 2 หลักทา้ย ดังนีѸ 
5.1. ตั Ѹงแตเ่ลข 00-29 ใหเ้ป็นชว่งปีค.ศ. 2000-2029  
5.2. ตั Ѹงแตเ่ลข 30-99 ใหย้อ้นกลับเป็นชว่งปีค.ศ. 1930-1999 

6. เมืѷอบันทกึวันทีѷแลว้ตอ้งชดิขวาของเซลลเ์สมอ (สาเหตทุีѷชดิขวาเพราะมคีา่เป็นตัวเลข) และ
ขอใหห้ลกีเลีѷยงการใชว้ันทีѷแบบ Text ซึѷงชดิซา้ยของเซลลเ์นืѷองจาก Excel จะไมนํ่า 
Regional Setting มาชว่ยควบคมุในการแบง่สว่นของวันเดอืนปีทีѷใชแ้บบ Text  

7. คา่ของวันทีѷและเวลามชีืѷอเรยีกวา่ Date Serial Number หรอืเรยีกวา่ Serial Number (SN) 
โดย Excel ถอืวา่ 1/1/1900 0:00:00 มคีา่ SN=1 ซึѷงเราสามารถแกะดคูา่ SN ไดโ้ดย
เปลีѷยน Format เป็น General (โดยการกดปุ่ ม Ctrl+Shift+ ~) เชน่ 14/2/2010  
12:00:00 มคีา่ SN เทา่กบั 40223.5 
7.1. ในสว่นของตัวเลข SN สว่นทีѷเป็นจํานวนเต็ม คอื คา่ของวันทีѷ 
7.2. ในสว่นของตัวเลข SN สว่นทีѷเป็นเศษทศนยิม คอื คา่ของเวลา 

8. เวลาของ Excel เริѷมจาก 0:00:00-23:59:59 และใช ้Format h:mm:ss  
9. ระยะเวลา เริѷมจาก 0:00:00 ขึѸนไป โดยไมส่ ิѸนสดุทีѷ 23:59:59 

9.1. ใช ้Format [h]:mm:ss เพืѷอแสดงเลขตั Ѹงแต ่24 ชัѷวโมงขึѸนไปได ้
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9.2. ใช ้Format [mm]:ss เพืѷอแสดงเลขตั Ѹงแต ่60 นาทขีึѸนไปได ้
9.3. ใช ้Format [ss] เพืѷอแสดงเลขตั Ѹงแต ่60 วนิาทขีึѸนไปได ้

10. ในการแสดงเวลาหรอืระยะเวลา ถา้คา่ SN < 1 จะใช ้Format ของเวลาหรอืระยะเวลาก็ได ้
แตถ่า้ SN >=1 ตอ้งเลอืกใช ้Format ของระยะเวลาเทา่นัѸน 

11. ถา้ตอ้งการบันทกึการทํางานขา้มคนื ไมค่วรบันทกึเฉพาะเวลาเขา้ออกงาน แตใ่หบ้ันทกึวัน
เดอืนปีกํากบัเวลาไวด้ว้ย เชน่ 14/2/2010 20:00 เพืѷอทําให ้Excel รับรูค้า่เป็น SN ทีѷมคีรบ
ทัѸงสว่นของวันทีѷและเวลา 

12. Format ในการแสดงวันและเวลา 
12.1. แสดงเลขวันทีѷ ใช ้d หรอื dd  
12.2. แสดงเป็นชืѷอวัน แบบยอ่ใช ้ddd หรอืแบบเต็ม dddd 
12.3. แสดงเป็นเลขเดอืน ใช ้m หรอื mm 
12.4. แสดงเป็นชืѷอเดอืน แบบยอ่ใช ้mmm หรอืแบบเต็ม mmmm 
12.5. แสดงเป็นเลขปี ใช ้yy หรอื yyyy 
12.6. แสดงชัѷวโมง นาท ีวนิาท ีใช ้h:mm:ss หรอื hh:mm:ss 
12.7. รหัสควบคมุ Locale ใช ้[$-409] หรอื [$-en-US]mmm สําหรบั USA และ [$-

1070000] หรอื [$-,107 สําหรับไทย 

การคาํนวณวนัทีѷและเวลา 

กอ่นทีѷจะนําวันทีѷและเวลามาคํานวณได ้ตอ้งเริѷมจากการตรวจสอบวา่ขอ้มลูเกีѷยวขอ้งกบัวันทีѷและ
เวลาซึѷงถกูบันทกึไวว้า่มโีครงสรา้งทีѷถกูตอ้งตรงกบั Regional Setting หรอืไม ่หากบันทกึไวผ้ดิ 
เชน่ ใน Regional Setting กําหนดไวเ้ป็น USA แตค่นทีѷบันทกึขอ้มลูพมิพว์นัทีѷไวใ้นแบบ
ประเทศไทย เชน่ พมิพ ์4/2/2001 ซึѷงตอ้งการบันทกึแบบไทยใหห้มายถงึวันทีѷ 4 เดอืน 2 ปี 
2001 จะพบวา่เมืѷอนําแฟ้มนัѸนมาเปิดบนเครืѷองทีѷม ีRegional Setting เป็นไทย เลขทีѷของวันจะ
สลับกบัเลขทีѷของเดอืน จะแสดงเป็น 2/4/2001 แทน ทําใหก้ําหนดเวลาทีѷบันทกึไวผ้ดิทั Ѹงหมด 
ถา้ไมเ่กง่สตูรเกีѷยวขอ้งกบัวันทีѷและเวลาก็ตอ้งจัดการพมิพทั์บใหมทั่ Ѹงหมด 

นอกจากนีѸตอ้งตรวจสอบตอ่ไปอกีวา่ คา่ของวันทีѷซ ึѷงบันทกึไวเ้ป็นขอ้มลูทีѷมคีา่เป็นตัวเลข (Date 
Serial Number หรอื SN) หรอืไม ่โดยเริѷมจากยกเลกิการจัดชดิซา้ยชดิขวาของเซลลว์ันทีѷ
ทั Ѹงหมด หากพบวา่ ชดิขวาก็ใชไ้ด ้แตถ่า้พบวา่ชดิซา้ยแสดงวา่มคีา่เป็น Text ซึѷงไมส่ามารถ
นํามาคํานวณตอ่ไดใ้นทันท ีจําเป็นตอ้งอาศัยสตูร Left, Right, Mid แยกตัวเลขแตล่ะสว่นทีѷเป็น
วันเดอืนปีออกจากกนัแลว้ใชส้ตูรวันทีѷและเวลามาชว่ยแกไ้ขใหม้คีา่เป็น SN 
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หากคณุอยากจะเกง่สตูรคํานวณเรืѷองวันทีѷและเวลา ตอ้งรูจั้กสตูรหา SN หรอืสตูรทีѷสามารถ
แปลงเลขทีѷของวันเดอืนปีทีѷมนุษยเ์ขา้ใจไปเป็นคา่ SN ทีѷ Excel รูจั้ก เชน่ สตูร Now(), 
Today(), Date(Year,Month,Day), Time(Hour,Minute,Second)  

จากนัѸนตอ้งสามารถใชส้ตูรแปลงคา่ SN กลับมาเป็นเลขทีѷของวันเดอืนปี เชน่ สตูร Day(SN), 
Month(SN), Year(SN), และ WeekDay(SN) หรอืหาเลขทีѷของเวลา เชน่ Hour(SN), 
Minute(SN), Second(SN) 

สตูรแปลงเลขทีѷของวนัเดอืนปีและเวลาทีѷมนษุยเ์ขา้ใจ 
ไปเป็นคา่ Serial Number 

เพืѷอชว่ยใหเ้ขา้ใจสตูรไดง้า่ยขึѸน ขอสมมตวิา่ปจัจบุนั คอื วันทีѷ 14 เดอืนกมุภาพันธ ์ปีค.ศ. 
2010 เวลา 12 นาฬกิา 30 นาท ี45 วนิาท ี

1. =NOW() จะไดว้ันเดอืนปีและเวลาปัจจบุัน เชน่ 14/2/2010 12:30:45 
2. =Today() จะไดเ้ฉพาะวันเดอืนปีปัจจบุัน เชน่ 14/2/2010 
3. =Date(2010,2,14) จะได ้14/2/2010 
4. =Date( Year(Today()), Month(Today())+1, 0) จะไดวั้นเดอืนปีของวันสดุทา้ย

ของเดอืนปัจจบุัน คอื 28/2/2010 (หรอืจะใชส้ตูร =EOMonth(Today(),0)) 
5. =Time(12,30,45) จะไดเ้วลา 12:30:45 
6. =Time(12,30,45)+1 จะไดร้ะยะเวลา 36:30:45 ซึѷงตอ้งใช ้Format [h]:mm:ss ดว้ย 

สตูรแปลงคา่ Serial Number  
กลบัมาเป็นเลขทีѷของวนัเดอืนปีและเวลาทีѷมนษุยเ์ขา้ใจ 

สมมตวิา่เซลล ์A1 มสีตูร =NOW() ซึѷงแสดงออกมาเป็น 14/2/2010 12:30:45 (ถา้ตอ้งการ
แสดงคา่ออกมาเป็น SN โดยการเปลีѷยน Format เป็น General จะพบวา่ เซลล ์A1 มคีา่ SN 
เทา่กบั 40223.5213541667 ซึѷงเป็นตัวเลขทีѷ Excel รูจั้กแตเ่ราไมรู่จั้ก) 

1. =Day(A1) จะไดเ้ลขวันทีѷ 14 
2. =Month(A1) จะไดเ้ลขเดอืน 2 
3. =Year(A1) จะไดเ้ลขปี 2010 
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4. =WeekDay(A1) จะไดเ้ลขของวันในสปัดาห ์1=Sunday, 2=Tuesday,…7=Saturday 
5. =Hour(A1) จะไดเ้ลขชัѷวโมง 12 
6. =Minute(A1) จะไดเ้ลขนาท ี30 
7. =Second(A1) จะไดเ้ลขวนิาท ี45 
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หลกัการกาํหนด  
Format Cells > Number 

1. Excel ใชเ้ครืѷองหมาย # และ 0 แทนตําแหน่งของตัวเลข ซึѷงถา้ใชเ้ครืѷองหมาย # แลว้
ตัวเลขมคีา่ไมถ่งึก็จะไมแ่สดงเลขหลักนัѸน แตถ่า้ใช ้0 จะแสดงแทนดว้ยเลข 0 ออกมาให ้
เห็น เชน่ ถา้พมิพต์ัวเลข 1.2 ลงไป ถา้ใช ้Format ##.## จะแสดง 1.2 แตถ่า้ใช ้Format 
00.00 จะแสดง 01.20 ดว้ยเหตนุีѸใน Format มาตรฐานทีѷ Excel เตรยีมไว ้จะพบวา่อยา่ง
นอ้ยตัวเลขหลักหน่วยและหลักทศนยิม จงึกําหนดใหใ้ชเ้ลข 0 ไวเ้สมอ เชน่ #,##0.00 

2. ดา้นหนา้ของ Format ทีѷเป็นเครืѷองหมาย # หรอืเลข 0 เราสามารถกําหนดสขีอง Font ได ้
โดยพมิพช์ืѷอสทีีѷตอ้งการไวใ้นเครืѷองหมาย [ ] เชน่ [Red] หรอืถา้จําชืѷอสไีมไ่ด ้ใหใ้ช ้
[Colorn] แทน โดย n คอืเลขของสทีีѷตอ้งการ เชน่ [Color12] 

3. เครืѷองหมายวงเล็บ [ ] ยังใชใ้นแบบเงืѷอนไขเพืѷอควบคมุใหแ้สดงผลออกมาเฉพาะเมืѷอตรง
กบัเงืѷอนไขทีѷกําหนดไวใ้นเครืѷองหมาย [ ] เชน่ [>=90]00000.00 จะทําใหต้ัวเลขทีѷพมิพล์ง
ไปในเซลลท์ีѷใช ้Format นีѸ เฉพาะเมืѷอมคีา่มากกวา่หรอืเทา่กบั 90 ใหแ้สดงตัวเลขใน
รปูแบบ 00000.00 

4. ใน Format สามารถแทรกสญัลักษณ์หรอืตัวอกัษรไวด้า้นหนา้ ดา้นหลัง หรอืระหวา่ง 
Format ทีѷเป็นเครืѷองหมาย # หรอืเลข 0 
4.1. กรณีแทรกสญัลักษณ์ ใหพ้มิพแ์ทรกไดโ้ดยตรง เชน่ (0 . 00) % มเีครืѷองหมายวงเล็บ 

เครืѷองหมายวรรค จดุทศนยิม และ % เป็นสญัลักษณ ์
4.2. กรณีแทรกตัวอกัษร ตอ้งพมิพต์ัวอกัษรไวร้ะหวา่งเครืѷองหมายคําพดู เชน่  

“Total” 0.00 “บาท” 
5. ถา้ตอ้งการปัดตัวเลขใหเ้ป็นหลักพันใหเ้ตมิเครืѷองหมายคอมมาตอ่ทา้ยหนึѷงตัว ถา้ตอ้งการ

ปัดเป็นหลักลา้นใหเ้ตมิคอมมาตอ่ทา้ยสองตัว เชน่ 0.00,, จะแสดงตัวเลข 123456789 ทีѷ
บันทกึลงไปออกมาเป็น 123.46 โดยคา่ทีѷแทจ้รงิยังคงเทา่กบั 123456789 ตามเดมิ 

6. ใหใ้ชเ้ครืѷองหมาย ; ไดส้งูสดุ 3 ตัว เพืѷอควบคมุ Format ใหเ้ปลีѷยนตามคา่บวก คา่ลบ คา่
ศนูย ์และคา่ทีѷเป็นตัวอกัษร ในโครงสรา้งตามนีѸ คา่บวก;คา่ลบ;คา่ศนูย;์คา่ทีѷเป็นตวัอกัษร 
6.1. ถา้ไมใ่สเ่ครืѷองหมาย ; เลย แสดงวา่เป็น Format กลางทีѷใหต้ัวเลขทกุคา่ใช ้Format 

นัѸนรว่มกนั 
6.2. หลังจากเครืѷองหมาย ; ทีѷเตมิตอ่ทา้ยลงไป ถา้ใส ่; ตัวใด ตอ้งตามดว้ย Format ของคา่

นัѸนๆ แตถ่า้เราไมไ่ดก้ําหนด Format ของนัѸนๆไวด้ว้ย จงึไมแ่สดงคา่น ัҟนๆ 
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ตัวอยา่งตอ่ไปนีѸ สมมตวิา่คา่ทีѷพมิพล์งไปในเซลลค์อื 123, -123, 0, Hello 

 Format ;;; จะไมแ่สดงอะไรใหเ้ห็นเลย 
 Format 0.00 จะแสดง 123.00, -123.00, 0.00, Hello 
 Format 0.00; จะแสดง 123.00, คา่ลบไมแ่สดง, 0.00, Hello 

 Format 0.00;[Red](0.00) จะแสดง 123.00, (123.00) ในสแีดง, 0.00, Hello 
 Format 0.00;; จะแสดงเฉพาะคา่บวก 123.00 กบั Hello เทา่นัѸน คา่ ลบ และ 0 ไม่

แสดง 
 Format 0.00;;; จะแสดงเฉพาะคา่บวก 123.00 เทา่นัѸน 
 Format 0.00;(0.00);; จะแสดงเฉพาะคา่บวก123.00 กบัคา่ลบ (123.00) 
 Format “Yes”;”No”;”Reject”; จะแสดง Yes, No, Reject 
 Format “Total” 0 “Baht”. 00 “Satang”;;; จะแสดง Total 123 Baht. 00 Satang 
 Format 0.00_);(0.00);; จะแสดง 123.00 ไดแ้นวตรงกบัคา่ลบ (123.00) โดย

เครืѷองหมาย _) ทีѷเตมิตอ่ทา้ย Format คา่บวก หมายถงึ ใหห้า่งจากขอบขวาของเซลล์
เทา่กบัความกวา้งของเครืѷองหมาย ) 

ตัวอยา่ง Format แปลกๆ 

 Format [>=90]”A”;[>=70]”B”;”C” จะเปลีѷยนตัวเลขในเซลลต์ามเงืѷอนไขวา่  
ถา้คา่มากกวา่หรอืเทา่กบั 90 ใหแ้สดงตัว A แทนตัวเลขนัѸน 
ถา้คา่มากกวา่หรอืเทา่กบั 70 ใหแ้สดงตัว B แทนตัวเลขนัѸน 
หรอืมฉิะนัѸนใหแ้สดงตัว C 

 Format [=1]”Yes”;[=0]”No”;”Reject” จะแสดงคําวา่ Yes, No, Reject แทนตัวเลขทีѷ
มคีา่เทา่กบั 1, 0, หรอืตัวเลขอืѷน ตามลําดับ 

 Format “4”;”4”;”4”;”4” จะเปลีѷยนคา่ใหเ้ป็นเลข 4 แทนไมว่า่คา่ทีѷแทจ้รงิจะเป็นเทา่ใด 
 Format 0000 จะแสดงเลข 123 ออกมาเป็น 0123 (ซึѷงตัวเลขยังคงมสีถานะเป็นตัวเลข

ตามเดมิ ถกูตอ้งกวา่การพมิพ ์‘0123 หรอืใชคํ้าสัѷง Format Cells > Number > Text 
ซึѷงทําใหต้ัวเลขเปลีѷยนสถานะมาเป็น Text ซึѷงดงูา่ยๆวา่จะชดิซา้ยของเซลล)์ 

 หากตอ้งการแทรกสญัลักษณ์แปลกทีѷไมม่บีนแป้นพมิพล์งไปใน Format เชน่ 
เครืѷองหมายบวกลบ ± ใหก้ดปุ่ ม Alt คา้งไวแ้ลว้พมิพต์ัวเลข 0177 ซึѷงสามารถคน้หาตัว



154 

 

© พ.ศ.2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ
www.ExcelExpertTraining.com 

เลขทีѷตอ้งพมิพน์ีѸไดจ้าก โปรแกรม Character Map ซึѷงสัѷงเปิดโปรแกรมนีѸไดง้า่ยๆโดย
พมิพคํ์าวา่ charmap ลงไปในชอ่งของคําสัѷง Start > Run 

 

การใชคํ้าสัѷง Format Cells > Number จะชว่ยปรับการแสดงตัวเลขใหม้ตีัวอกัษรแทรก โดย
คา่ทีѷแทจ้รงิยังคงถอืวา่เป็น Number ทีѷเห็นไดจ้ากการชดิขวาของเซลล ์แตถ่า้เซลลม์คีวาม
กวา้งไมพ่อจะเห็นเป็นเครืѷองหมาย ###### แทน ซึѷงแกไ้ดโ้ดยสัѷง Format Cells > 
Alignment > กาชอ่ง Shrink to fit เพืѷอทําให ้Excel ปรบัขนาด Font ยอ่ลงใหแ้สดงให ้
เห็นไดใ้นเซลลนั์Ѹนเสมอ 

ประเด็นเรืѷอง Format นีѸขอยํѸาวา่ การใช ้Format เป็นเพยีงการเปลีѷยนสิѷงเห็นเทา่นัѸน มไิดแ้กไ้ข
คา่ใหต้า่งไปจากเดมิแมแ้ตน่อ้ย 

หากตอ้งการนําตัวเลขไปแสดงรว่มกบัตัวอกัษร ยังมอีกีวธิหีนึѷง โดยใชส้ตูร Text เขา้มาชว่ยปรับ
รปูแบบของตัวเลขแลว้นําไปเชืѷอมตอ่กบัตัวอกัษรทีѷตอ้งการโดยใชเ้ครืѷองหมาย & เป็นตัวเชืѷอม  

สมมตวิา่ เซลล ์A1 มคีา่เทา่กบั .15 หากตอ้งการนําเลข .15 ไปแสดงใหเ้ป็นคําวา่ Profit 
15.0% ทําได ้2 วธิ ี

 วธิแีรก ใชคํ้าสัѷง Format Cells > Number > Custom แลว้กําหนด Type เป็น 
“Profit” 0.0% 

 วธิที ีѷสอง สรา้งสตูร =”Profit ”&Text(A1,”0.0%”) 
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จะพบวา่ผลจากวธิแีรกไดคํ้าวา่ Profit 15.0% ชดิขวาของเซลลแ์สดงวา่สามารถนําไปคํานวณ
ตอ่ได ้แตว่ธิทีีѷสองแมจ้ะไดคํ้าเดยีวกนัแตจ่ะชดิซา้ยของเซลลซ์ึѷงไมส่ามารถนําไปคํานวณตอ่ จงึ
ขอแนะนําใหใ้ชว้ธิทีีѷสองกบัผลลัพธส์ดุทา้ยทีѷไมต่อ้งนําไปใชคํ้านวณตอ่เทา่นัѸน 

นอกจากนีѸสตูร Text ยังเปรยีบไดก้บัสตูร Round โดยสตูร Text นีѸจะปัดตัวเลขและแสดงตัวเลข
ตามรปูแบบใหด้ว้ย เชน่ =TEXT(123456789,"0.00,,") จะไดคํ้าตอบเป็น 123.46 และมคีา่ 
123.46 ดว้ย 
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วธิใีช ้Add-In 

Add-In เป็นแฟ้มทีѷมนีามสกลุ .xla หรอื .xlam ซึѷงแฟ้มเหลา่นีѸจะทําให ้Excel ทีѷตดิตั Ѹงไวใ้นแต่
ละเครืѷองมสีตูรหรอืคําสัѷงเพิѷมขึѸนมากกวา่เดมิ ซึѷงทกุวันนีѸเราสามารถนําแฟ้ม Add-in ทีѷแจกฟรี
จากอนิเตอรเ์น็ตมาใชก้นัไดทั้นท ี

1. เริѷมจาก Download แฟ้ม Add-in มาเก็บไวใ้นเครืѷองคอมพวิเตอรข์องคณุกอ่น 
2. จากนัѸนเปิดโปรแกรม Excel แลว้สัѷง File > Options > Add-ins แลว้คลกิทีѷปุ่ ม Go 

ดา้นลา่งของหนา้ จะเปิดใหเ้ห็นรายชืѷอ Add-ins Available ทีѷมาพรอ้มกบัโปรกรม Excel  
3. กดปุ่ ม Browse คน้หาแฟ้ม Add-in ทีѷคณุเก็บไวใ้นเครืѷองตามขอ้ 1 ใหพ้บแลว้กดปุ่ ม OK 
4. จะพบชืѷอ Add-in ทีѷคณุเลอืกปรากฏเพิѷมในชอ่งรายชืѷอ Add-ins Available  

ขอใหเ้ลอืกกาชืѷอ Add-ins เฉพาะทีѷตอ้งการนํามาใชง้านเทา่นัѸน เพราะการเปิดใช ้Add-in ก็
เหมอืนกบัการเปิดแฟ้มทัѷวไป เพยีงแตเ่มืѷอเปิด Excel จะเปิดแฟ้ม Add-in ทีѷเลอืกไวต้อ่ใหเ้อง 
แตจ่ะไมเ่ห็นตัวแฟ้มแตอ่ยา่งใด ซึѷง Add-in จะทําใหค้ณุมสีตูรเพิѷมเตมิหรอืทําใหม้คํีาสัѷงเพิѷมทีѷ
จะเห็นไดบ้นเมนูก็แลว้แตแ่ฟ้ม Add-in นัѸนสรา้งขึѸนมาเพืѷอจดุประสงคใ์ด 

ขอแนะนําใหใ้ช ้Expert2000.xla ซึѷงเป็น Add-in ทีѷแจกใหใ้ชใ้นหลักสตูรสดุยอดเคล็ดลับ 
โดยจะทําใหค้ณุไดเ้มนูชืѷอ Expert และมคํีาสัѷงเพิѷมขึѸน ทําหนา้ทีѷเกีѷยวขอ้งกบัการปรับแตง่
หนา้จอเมืѷอสรา้งงานเสร็จแลว้ และยังทําใหม้สีตูรตอ่ไปนีѸเพิѷมเตมิ  

 =Fml(cell) ทําหนา้ทีѷแสดงสตูรในเซลล ์
 =Fmt(cell) ทําหนา้ทีѷแสดง Format ในเซลล ์

ถา้เรยีกใช ้Add-in ชืѷอ Money.xla จะไดส้ตูร =Money(ตัวเลข,”ชืѷอหน่วยเงนิ”,”ชืѷอหน่วยเศษ
สตางค”์) เชน่ =Money(1234.56,”Dollar”,”Cent”) จะอา่นตัวเลขออกมาเป็นคําวา่ One 
Thousand Two Hundred Thirty Four Dollars and Fifty Six Cents 

เนืѷองจากสตูรเหลา่นีѸไมใ่ชส่ตูรทีѷมาตามปกตขิอง Excel ดังนัѸนหากเปิดแฟ้มทีѷใชส้ตูร Fml ขึѸนมา
โดยทีѷยังไมไ่ดเ้รยีกใช ้Expert2000.xla จะทําใหส้ตูรเหลา่นีѸกลายเป็น Error วา่ #NAME! 
ทั Ѹงหมด ซึѷงแกไ้ขไดโ้ดยทําการตดิตั Ѹง Add-in Expert2000.xla กอ่นแลว้จงึตามดว้ยการเปิด
แฟ้มทีѷมสีตูรเหลา่นีѸตอ่ แตถ่า้พบวา่สตูรยังคง Error อยู ่ใหค้ลกิทีѷเซลลส์ตูรแลว้กดปุ่ ม F2 แลว้
กดปุ่ ม Enter เพืѷอกระตุน้ใหส้ตูรเริѷมทํางานตอ่ไปไดต้ามปกต ิ  
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Function VBA 

แทนทีѷจะตอ้งสรา้งสตูรซึѷงมขีั ѸนตอนการคํานวณยาวเหยยีดซํѸาแลว้ซํѸาอกีลงไปในตาราง  
Function VBA เป็นทางออกทีѷจะชว่ยทําใหเ้กดิสตูรลัดขึѸนมาใชง้านในแฟ้ม 

วธิสีรา้ง Function VBA 

1. เปิด Visual Basic Editor โดยกดปุ่ ม Alt+F11  
2. ใชเ้มนูคําสัѷง Insert > Module เพืѷอเปิดพืѸนทีѷจัดเก็บรหัส  
3. copy รหัสทีѷตอ้งการ โดยเลอืกชว่งตั Ѹงแตบ่รรทัด Function ถงึบรรทัด End Function  
4. paste รหัสทีѷ copy ไวนั้Ѹนลงใน module ทีѷตอ้งการ  
5. ใน Module หนึѷงๆ จะใชเ้ก็บ Function ไดไ้มจํ่ากดั ใหเ้รยีง Function ตอ่กนัไปเรืѷอยๆ  
6. สัѷง File > Save โดยกําหนดนามสกลุแฟ้ม xlsm 

 

วธิใีช ้Function VBA 

ใชส้ตูรเชน่เดยีวกบัสตูรทัѷวไปอืѷนๆ หากใชคํ้าสัѷง Formulas > Insert Function หรอืคลกิทีѷปุ่ ม 
Fx บน Formula Bar จะพบสตูร VBA Function รวมไวใ้นกลุม่ Function category : User 
Defined และแสดงรปูแบบสตูรในจอดา้นขวาและดา้นลา่ง 
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1 
Function GetFormat(cell) 
   GetFormat = cell.NumberFormat 
End Function 

  

    แสดงรปูแบบทีѷใชใ้นเซลล ์   
 

2 

Function GetFormula(Cell) 

   GetFormula = Cell.Formula 

End Function 

Function GetFormulaI(cell) 

   If VarType(cell) = 8 Then 

    GetFormulaI = "'" & cell.formula 
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   Else 

    GetFormulaI = cell.formula 

   End If 

   If cell.HasArray Then _ 

     GetFormulaI = "{" & cell.formula & "}" 

End Function 

    แสดงสตูรทีѷใชใ้นเซลล ์   
 

3 

Function FormulaText(cell_ref) 
    'Allow formula to be updated if changes are made on the sheet 
    Application.Volatile 
   'Test for reference style in use 
    If Application.ReferenceStyle = xlA1 Then 
        'Set the return value of the function to the A1 style formula 
        FormulaText = cell_ref.Formula 
    Else '  xlR1C1 --Set the return value of the function to the R1C1 style 
formula 
        FormulaText = cell_ref.FormulaR1C1 
    End If 
End Function 

  

    แสดงสตูรทีѷใชใ้นเซลล ์ทั Ѹงแบบปกตหิรอืแบบ R1C1   
 

4 Function FUNCTION_DEF(FCELL As Variant)As Variant    
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'Let's make sure the function  
'recalculates when required  
    Application.Volatile  
 
'If the argument is not a range  
'then return appropriate error.  
    If Not TypeName(FCELL) = "Range" Then  
        FUNCTION_DEF = CVErr(xlErrRef)  
        Exit Function  
    End If  
 
'If the argument is not a single  
'cell then return appropriate error.  
    If Not FCELL.Cells.Count = 1 Then  
        FUNCTION_DEF = CVErr(xlErrRef)  
        Exit Function  
    End If  
 
'If the argument cell contains no  
'formula, then just return its value  
    If Not FCELL.HasFormula Then  
        FUNCTION_DEF = FCELL.Value  
        Exit Function  
    End If  
 
'Find out the format of the formula  
'we need to return...  
    Select Case Application.ReferenceStyle  
        Case xlA1  
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            FUNCTION_DEF = FCELL.Formula  
        Case xlR1C1  
            FUNCTION_DEF = FCELL.FormulaR1C1  
    End Select  
 
'Finally check whether we are looking at a cell  
'containing an array function.  
    If FCELL.HasArray Then _  
        FUNCTION_DEF = "{" & FUNCTION_DEF & "}" 

End Function  
 

    แสดงสตูรในเซลล ์   
 

5 

Option Explicit 
 
Function DATEDIFF(d1, d2) As Variant 
    Dim YearDiff As Integer 
    Dim MonthDiff As Integer 
    Dim DayDiff As Integer 
    Dim temp As Date 
     
'   Swap arguments, if necessary 
    If d1 > d2 Then 
        temp = d1 
        d1 = d2 
        d2 = temp 
    End If 
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'   Do the year part 
    YearDiff = Year(d2) - Year(d1) 
    If DateSerial(Year(d2), Month(d1), Day(d1)) > d2 _ 
        Then YearDiff = YearDiff - 1 
     
'   Do the month part 
    If Month(d2) > Month(d1) Then 
        If Day(d2) >= Day(d1) Then 
            MonthDiff = Month(d2) - Month(d1) 
        Else 
            MonthDiff = Month(d2) - Month(d1) - 1 
        End If 
    Else 
        If Day(d2) >= Day(d1) Then 
            MonthDiff = Month(d2) - Month(d1) + 12 
            If MonthDiff = 12 Then MonthDiff = 0 
        Else 
            MonthDiff = Month(d2) - Month(d1) + 11 
        End If 
    End If 
 
'   Do the day part 
    If Day(d2) >= Day(d1) Then 
        DayDiff = Day(d2) - Day(d1) 
    Else 
        DayDiff = Day(DateSerial(Year(d1), _ 
            Month(d1) + 1, 1) - 1) - Day(d1) + Day(d2) 
    End If 
 
'   Create the variant array to be returned 
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    DATEDIFF = Array(YearDiff, MonthDiff, DayDiff) 
End Function 
  

    
แสดงระยะเวลาระหวา่งชว่งเวลาทีѷกําหนด  

www.j-walk.com\ss\excel\tips\tip55.htm 
  

 

6 

Function Age(TheDate As Double) As String 
Age = _ 
    CStr(Evaluate("=DATEDIF(" & TheDate & "," & CDbl(Now)  & 
",""y"")")) & " years " & _ 
    CStr(Evaluate("=DATEDIF(" & TheDate & "," & CDbl(Now) & 
",""ym"")")) & " months " & _ 
    CStr(Evaluate("=DATEDIF(" & TheDate & "," & CDbl(Now) & 
",""md"")")) & " days" 
End Function 

  

    แสดงระยะเวลาระหวา่งชว่งเวลาทีѷกําหนดเป็นประโยครวม   
 

7 

Function OrdDate(arg) 

    dd = Day(arg) 

    mmmm = Format(arg, "mmmm")    '*Corrected* 

    yyyy = Year(arg) 

    Select Case Day(arg) 

       Case 1, 21, 31 
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          OrdDate = dd & "st " & mmmm & ", " & yyyy 

       Case 2, 22 

          OrdDate = dd & "nd " & mmmm & ", " & yyyy 

       Case 3, 23 

          OrdDate = dd & "rd " & mmmm & ", " & yyyy 

       Case 4 To 20, 24 To 30 

          OrdDate = dd & "th " & mmmm & ", " & yyyy 

    End Select 

End Function 

    แปลงวันทีѷใหม้คํีาตอ่ทา้ย st nd rd th   
 

8 
Function SheetName() As String 
    SheetName = Application.Caller.Parent.Name  'in XL97 
End Function 

  

    แสดงชืѷอ sheet   
 

9 

Function CellType(c) 

'   Returns the cell type of the upper left 

'   cell in a range 

    Application.Volatile 
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    Set c = c.Range("A1") 

    Select Case True 

        Case IsEmpty(c): CellType = "Blank" 

        Case Application.IsText(c): CellType = "Text" 

        Case Application.IsLogical(c): CellType = "Logical" 

        Case Application.IsErr(c): CellType = "Error" 

        Case IsDate(c): CellType = "Date" 

        Case InStr(1, c.Text, ":") <> 0: CellType = "Time" 

        Case IsNumeric(c): CellType = "Value" 

    End Select 

End Function 

    แสดงประเภทของคา่ในเซลล ์   
 

10 

Function CellValue(c) As Double 

    'John Walkenbach 2001-04-25 

    '      misc returns number part 

    CellValue = Val(c) 

End Function 

  

    แสดงคา่เป็นตัวเลข   
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11 
Function HasFormula(cell) 
  HasFormula = cell.HasFormula 
End Function 

  

    ตรวจสอบวา่ มสีตูรหรอืไม ่   
 

12 

Function UseFormula(cell) 
    '-- Usage: Not recommended, see notes 
    UseFormula = Application.Evaluate(cell.formula) 
End Function 

Function UseFormula2(cell) 

   'Documented in  
http://www.geocities.com/davemcritchie/excel/formula.htm 

   ' UseFormula Jul 20, 1998,  UseFormula2 Jun 13, 2000 

   'Application.Volatile = True  -- DO NOT DO THIS 

    If Trim(cell.Value) = "" Then 

       UseFormula2 = "" 

       Exit Function 

    ElseIf Left(cell.Value, 1) = "=" Then 

       UseFormula2 = Application.Evaluate(cell.Formula) 

       Exit Function 

    Else 
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       UseFormula2 = "'#bad formula" 

    End If 

End Function 

    แปลงสตูรทีѷเป็นตัวอกัษร ใหเ้ป็นสตูรทีѷใชง้านได ้   
 

13 

Function fontinfo(cell As Range) As String 

  fontinfo = cell.FONT.Name & " -- " & cell.FONT.Size 

  If Left(cell.FONT.FontStyle, 7) = "Regular" Then 

     fontinfo = Trim(fontinfo & Mid(cell.FONT.FontStyle, 8, 100)) 

  Else 

     fontinfo = Trim(fontinfo & " " & cell.FONT.FontStyle) 

  End If 

End Function 

  

    แสดงรายละเอยีดของ font ทีѷใช ้   
 

14 

Function SumByColor(InputRange As Range, ColorRange As Range) As 
Double 
Dim cl As Range, TempSum As Double, ColorIndex As Integer 
    ColorIndex = ColorRange.Cells(1, 1).Interior.ColorIndex 
    TempSum = 0 
    On Error Resume Next ' ignore cells without values 
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    For Each cl In InputRange.Cells 
        If cl.Interior.ColorIndex = ColorIndex Then TempSum = 
TempSum + cl.Value 
    Next cl 
    On Error GoTo 0 
    Set cl = Nothing 
    SumByColor = TempSum 
End Function 

    หายอดรวมตามสทีีѷใช ้www.erlandsendata.no   
 

15 

Function CountByColor(InputRange As Range, ColorRange as Range) As 
Long 

Dim cl As Range, TempCount As Long, ColorIndex As Integer 

    ColorIndex = ColorRange.Cells(1, 1).Interior.ColorIndex 

    TempCount = 0 

    For Each cl In InputRange.Cells 

        If cl.Interior.ColorIndex = ColorIndex Then TempCount = 
TempCount + 1 

    Next cl 

    Set cl = Nothing 

    CountByColor = TempCount 

End Function 
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    นับจํานวนตามสทีีѷใช ้   
 

16 

Function WEEKNR(InputDate As Long) As Integer 

Dim A As Integer, B As Integer, C As Long, D As Integer 

    WEEKNR = 0 

    If InputDate < 1 Then Exit Function 

    A = Weekday(InputDate, vbSunday) 

    B = Year(InputDate + ((8 - A) Mod 7) - 3) 

    C = CDate("1.1." & B) 

    D = (Weekday(C, vbSunday) + 1) Mod 7 

    WEEKNR = Int((InputDate - C - 3 + D) / 7) + 1 

End Function 

  

    คนืคา่เป็นเลขทีѷสปัดาห ์www.erlandsendata.no   
 

17 

Function UniqueItem(InputRange As Range, ItemNo As Long) As 
Variant 

Dim cl As Range, cUnique As New Collection, cValue As Variant 

    Application.Volatile 

    On Error Resume Next 
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    For Each cl In InputRange 

        If cl.Formula <> "" Then 

            cUnique.Add cl.Value, CStr(cl.Value) 

        End If 

    Next cl 

    UniqueItem = "" 

    If ItemNo = 0 Then 

        UniqueItem = cUnique.Count 

    Else 

        If ItemNo <= cUnique.Count Then 

            UniqueItem = cUnique(ItemNo) 

        End If 

    End If 

    On Error GoTo 0 

End Function 

    

แสดงคา่ unique values  

=UniqueItem(A1:A100,2) แสดงคา่ the 2nd unique value  
=UniqueItem(A1:A100,0) แสดงจํานวน unique values  
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18 

Function INDEXN(InputRange As Range, N As Integer) As Variant 

' returns every N-th item from InputRange 

' select the desired target range for the function and 

' enter as an array function with Ctrl+Shift+Enter. 

Dim ItemList() As Variant, c As Range, i As Long, iCount As Long 

    i = 0 

    iCount = 0 

    ReDim ItemList(1 To InputRange.Cells.Count \ N) 

    For Each c In InputRange 

        i = i + 1 

        If i Mod N = 0 Then 

            iCount = iCount + 1 

            On Error Resume Next 

            ItemList(iCount) = c.Value 

            On Error GoTo 0 

        End If 

    Next c 

    INDEXN = ItemList 

    If InputRange.Rows.Count >= InputRange.Columns.Count Then 
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        INDEXN = Application.WorksheetFunction.Transpose(INDEXN) 

    End If 

    Erase ItemList 

End Function 

    แสดงคา่ทีѷอยูใ่นลําดับทีѷ n   
 

19 

Sub FindUniqueValues(SourceRange As Range, TargetCell As Range) 

    SourceRange.AdvancedFilter Action:=xlFilterCopy, 
CopyToRange:=TargetCell,  Unique:=True 

End Sub 

  

    แยก unique items ออกมาสรปุ   
 

20 

Function TimeInterval(StartTime As Double, EndTime As Double, _ 

LowerLimit As Double, UpperLimit As Double) As Double 

' returns EndTime-StartTime limited by LowerLimit and UpperLimit 

    TimeInterval = 0 

    If StartTime > EndTime Then Exit Function 

    If StartTime > UpperLimit Then Exit Function 

    If EndTime < LowerLimit Then Exit Function 
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    If StartTime < LowerLimit Then StartTime = LowerLimit 

    If EndTime > UpperLimit Then EndTime = UpperLimit 

    TimeInterval = EndTime - StartTime 

End Function 

    ระยะเวลาระหวา่งชว่ง   
 

21 

Option Explicit 
 
'**************** 
' Main Function * 
'**************** 
Function BahtEng(ByVal MyNumber) 
Dim Baht, Satang, Temp 
Dim DecimalPlace, Count 
 
ReDim Place(9) As String 
Place(2) = " Thousand " 
Place(3) = " Million " 
Place(4) = " Billion " 
Place(5) = " Trillion " 
 
' String representation of amount 
MyNumber = Trim(Str(MyNumber)) 
 
' Position of decimal place 0 if none 
DecimalPlace = InStr(MyNumber, ".") 
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'Convert Satang and set MyNumber to Baht amount 
If DecimalPlace > 0 Then 
Satang = GetTens(Left(Mid(MyNumber, DecimalPlace + 1) & "00", 2)) 
MyNumber = Trim(Left(MyNumber, DecimalPlace - 1)) 
End If 
 
Count = 1 
Do While MyNumber <> "" 
Temp = GetHundreds(Right(MyNumber, 3)) 
If Temp <> "" Then Baht = Temp & Place(Count) & Baht 
If Len(MyNumber) > 3 Then 
MyNumber = Left(MyNumber, Len(MyNumber) - 3) 
Else 
MyNumber = "" 
End If 
Count = Count + 1 
Loop 
 
Select Case Baht 
Case "" 
Baht = "No Baht" 
Case "One" 
Baht = "One Baht" 
Case Else 
Baht = Baht & " Baht" 
End Select 
 
Select Case Satang 
Case "" 
Satang = " and No Satang" 



175 

 

© พ.ศ.2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ
www.ExcelExpertTraining.com 

Case "One" 
Satang = " and One Satang" 
Case Else 
Satang = " and " & Satang & " Satang" 
End Select 
 
BahtEng = Baht & Satang 
End Function 
 
'******************************************* 
' Converts a number from 100-999 into text * 
'******************************************* 
Private Function GetHundreds(ByVal MyNumber) 
Dim Result As String 
 
If Val(MyNumber) = 0 Then Exit Function 
MyNumber = Right("000" & MyNumber, 3) 
 
'Convert the hundreds place 
If Mid(MyNumber, 1, 1) <> "0" Then 
Result = GetDigit(Mid(MyNumber, 1, 1)) & " Hundred " 
End If 
 
'Convert the tens and ones place 
If Mid(MyNumber, 2, 1) <> "0" Then 
Result = Result & GetTens(Mid(MyNumber, 2)) 
Else 
Result = Result & GetDigit(Mid(MyNumber, 3)) 
End If 
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GetHundreds = Result 
End Function 
 
'********************************************* 
' Converts a number from 10 to 99 into text. * 
'********************************************* 
Private Function GetTens(TensText) 
Dim Result As String 
 
Result = "" 'null out the temporary function value 
If Val(Left(TensText, 1)) = 1 Then ' If value between 10-19 
Select Case Val(TensText) 
Case 10: Result = "Ten" 
Case 11: Result = "Eleven" 
Case 12: Result = "Twelve" 
Case 13: Result = "Thirteen" 
Case 14: Result = "Fourteen" 
Case 15: Result = "Fifteen" 
Case 16: Result = "Sixteen" 
Case 17: Result = "Seventeen" 
Case 18: Result = "Eighteen" 
Case 19: Result = "Nineteen" 
Case Else 
End Select 
Else ' If value between 20-99 
Select Case Val(Left(TensText, 1)) 
Case 2: Result = "Twenty " 
Case 3: Result = "Thirty " 
Case 4: Result = "Forty " 
Case 5: Result = "Fifty " 
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Case 6: Result = "Sixty " 
Case 7: Result = "Seventy " 
Case 8: Result = "Eighty " 
Case 9: Result = "Ninety " 
Case Else 
End Select 
Result = Result & GetDigit _ 
(Right(TensText, 1)) 'Retrieve ones place 
End If 
GetTens = Result 
End Function 
 
'******************************************* 
' Converts a number from 1 to 9 into text. * 
'******************************************* 
Private Function GetDigit(Digit) 
Select Case Val(Digit) 
Case 1: GetDigit = "One" 
Case 2: GetDigit = "Two" 
Case 3: GetDigit = "Three" 
Case 4: GetDigit = "Four" 
Case 5: GetDigit = "Five" 
Case 6: GetDigit = "Six" 
Case 7: GetDigit = "Seven" 
Case 8: GetDigit = "Eight" 
Case 9: GetDigit = "Nine" 
Case Else: GetDigit = "" 
End Select 
End Function 
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    สตูรแปลงตัวเลขเป็นคําอา่น   
 

22 

Option Explicit 
 
'**************** 
' Main Function * 
'**************** 
Function BahtOnly(ByVal MyNumber) 
Dim Baht, Satang, Temp 
Dim DecimalPlace, Count 
 
ReDim Place(9) As String 
Place(2) = " Thousand " 
Place(3) = " Million " 
Place(4) = " Billion " 
Place(5) = " Trillion " 
 
' String representation of amount 
MyNumber = Trim(Str(MyNumber)) 
 
' Position of decimal place 0 if none 
DecimalPlace = InStr(MyNumber, ".") 
'Convert Satang and set MyNumber to Baht amount 
If DecimalPlace > 0 Then 
Satang = GetTens(Left(Mid(MyNumber, DecimalPlace + 1) & "00", 2)) 
MyNumber = Trim(Left(MyNumber, DecimalPlace - 1)) 
End If 
 
Count = 1 
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Do While MyNumber <> "" 
Temp = GetHundreds(Right(MyNumber, 3)) 
If Temp <> "" Then Baht = Temp & Place(Count) & Baht 
If Len(MyNumber) > 3 Then 
MyNumber = Left(MyNumber, Len(MyNumber) - 3) 
Else 
MyNumber = "" 
End If 
Count = Count + 1 
Loop 
 
Select Case Baht 
Case "" 
Baht = "No Baht" 
Case "One" 
Baht = "One Baht" 
Case Else 
Baht = Baht & " Baht" 
End Select 
 
Select Case Satang 
Case "" 
Satang = " Only" 
Case "One" 
Satang = " and One Satang" 
Case Else 
Satang = " and " & Satang & " Satang" 
End Select 
 
BahtOnly = Baht & Satang 
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End Function 
 
'******************************************* 
' Converts a number from 100-999 into text * 
'******************************************* 
Private Function GetHundreds(ByVal MyNumber) 
Dim Result As String 
 
If Val(MyNumber) = 0 Then Exit Function 
MyNumber = Right("000" & MyNumber, 3) 
 
'Convert the hundreds place 
If Mid(MyNumber, 1, 1) <> "0" Then 
Result = GetDigit(Mid(MyNumber, 1, 1)) & " Hundred " 
End If 
 
'Convert the tens and ones place 
If Mid(MyNumber, 2, 1) <> "0" Then 
Result = Result & GetTens(Mid(MyNumber, 2)) 
Else 
Result = Result & GetDigit(Mid(MyNumber, 3)) 
End If 
 
GetHundreds = Result 
End Function 
 
'********************************************* 
' Converts a number from 10 to 99 into text. * 
'********************************************* 
Private Function GetTens(TensText) 
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Dim Result As String 
 
Result = "" 'null out the temporary function value 
If Val(Left(TensText, 1)) = 1 Then ' If value between 10-19 
Select Case Val(TensText) 
Case 10: Result = "Ten" 
Case 11: Result = "Eleven" 
Case 12: Result = "Twelve" 
Case 13: Result = "Thirteen" 
Case 14: Result = "Fourteen" 
Case 15: Result = "Fifteen" 
Case 16: Result = "Sixteen" 
Case 17: Result = "Seventeen" 
Case 18: Result = "Eighteen" 
Case 19: Result = "Nineteen" 
Case Else 
End Select 
Else ' If value between 20-99 
Select Case Val(Left(TensText, 1)) 
Case 2: Result = "Twenty " 
Case 3: Result = "Thirty " 
Case 4: Result = "Forty " 
Case 5: Result = "Fifty " 
Case 6: Result = "Sixty " 
Case 7: Result = "Seventy " 
Case 8: Result = "Eighty " 
Case 9: Result = "Ninety " 
Case Else 
End Select 
Result = Result & GetDigit _ 
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(Right(TensText, 1)) 'Retrieve ones place 
End If 
GetTens = Result 
End Function 
 
'******************************************* 
' Converts a number from 1 to 9 into text. * 
'******************************************* 
Private Function GetDigit(Digit) 
Select Case Val(Digit) 
Case 1: GetDigit = "One" 
Case 2: GetDigit = "Two" 
Case 3: GetDigit = "Three" 
Case 4: GetDigit = "Four" 
Case 5: GetDigit = "Five" 
Case 6: GetDigit = "Six" 
Case 7: GetDigit = "Seven" 
Case 8: GetDigit = "Eight" 
Case 9: GetDigit = "Nine" 
Case Else: GetDigit = "" 
End Select 
End Function 

    สตูรแปลงตัวเลขเป็นคําอา่น   
 

23 

Option Explicit 
 
'**************** 
' Main Function * 
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'**************** 
Function Money(ByVal MyNumber, UnitName1, UnitName2) 
Dim KeyUnit1, KeyUnit2, Temp 
Dim DecimalPlace, Count 
 
ReDim Place(9) As String 
Place(2) = " Thousand " 
Place(3) = " Million " 
Place(4) = " Billion " 
Place(5) = " Trillion " 
 
' String representation of amount 
MyNumber = Trim(Str(MyNumber)) 
 
' Position of decimal place 0 if none 
DecimalPlace = InStr(MyNumber, ".") 
'Convert KeyUnit2 and set MyNumber to KeyUnit1 amount 
If DecimalPlace > 0 Then 
KeyUnit2 = GetTens(Left(Mid(MyNumber, DecimalPlace + 1) & "00", 2)) 
MyNumber = Trim(Left(MyNumber, DecimalPlace - 1)) 
End If 
 
Count = 1 
Do While MyNumber <> "" 
Temp = GetHundreds(Right(MyNumber, 3)) 
If Temp <> "" Then KeyUnit1 = Temp & Place(Count) & KeyUnit1 
If Len(MyNumber) > 3 Then 
MyNumber = Left(MyNumber, Len(MyNumber) - 3) 
Else 
MyNumber = "" 



184 

 

© พ.ศ.2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ
www.ExcelExpertTraining.com 

End If 
Count = Count + 1 
Loop 
 
Select Case KeyUnit1 
Case "" 
KeyUnit1 = "No " & UnitName1 
Case "One" 
KeyUnit1 = "One " & UnitName1 
Case Else 
KeyUnit1 = KeyUnit1 & " " & UnitName1 & "s" 
End Select 
 
Select Case KeyUnit2 
Case "" 
KeyUnit2 = " Only" 
Case "One" 
KeyUnit2 = " and One " & " " & UnitName2 
Case Else 
KeyUnit2 = " and " & KeyUnit2 & " " & UnitName2 & "s" 
End Select 
 
Money = KeyUnit1 & KeyUnit2 
End Function 
 
'******************************************* 
' Converts a number from 100-999 into text * 
'******************************************* 
Private Function GetHundreds(ByVal MyNumber) 
Dim Result As String 
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If Val(MyNumber) = 0 Then Exit Function 
MyNumber = Right("000" & MyNumber, 3) 
 
'Convert the hundreds place 
If Mid(MyNumber, 1, 1) <> "0" Then 
Result = GetDigit(Mid(MyNumber, 1, 1)) & " Hundred " 
End If 
 
'Convert the tens and ones place 
If Mid(MyNumber, 2, 1) <> "0" Then 
Result = Result & GetTens(Mid(MyNumber, 2)) 
Else 
Result = Result & GetDigit(Mid(MyNumber, 3)) 
End If 
 
GetHundreds = Result 
End Function 
 
'********************************************* 
' Converts a number from 10 to 99 into text. * 
'********************************************* 
Private Function GetTens(TensText) 
Dim Result As String 
 
Result = "" 'null out the temporary function value 
If Val(Left(TensText, 1)) = 1 Then ' If value between 10-19 
Select Case Val(TensText) 
Case 10: Result = "Ten" 
Case 11: Result = "Eleven" 
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Case 12: Result = "Twelve" 
Case 13: Result = "Thirteen" 
Case 14: Result = "Fourteen" 
Case 15: Result = "Fifteen" 
Case 16: Result = "Sixteen" 
Case 17: Result = "Seventeen" 
Case 18: Result = "Eighteen" 
Case 19: Result = "Nineteen" 
Case Else 
End Select 
Else ' If value between 20-99 
Select Case Val(Left(TensText, 1)) 
Case 2: Result = "Twenty " 
Case 3: Result = "Thirty " 
Case 4: Result = "Forty " 
Case 5: Result = "Fifty " 
Case 6: Result = "Sixty " 
Case 7: Result = "Seventy " 
Case 8: Result = "Eighty " 
Case 9: Result = "Ninety " 
Case Else 
End Select 
Result = Result & GetDigit _ 
(Right(TensText, 1)) 'Retrieve ones place 
End If 
GetTens = Result 
End Function 
 
'******************************************* 
' Converts a number from 1 to 9 into text. * 
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'******************************************* 
Private Function GetDigit(Digit) 
Select Case Val(Digit) 
Case 1: GetDigit = "One" 
Case 2: GetDigit = "Two" 
Case 3: GetDigit = "Three" 
Case 4: GetDigit = "Four" 
Case 5: GetDigit = "Five" 
Case 6: GetDigit = "Six" 
Case 7: GetDigit = "Seven" 
Case 8: GetDigit = "Eight" 
Case 9: GetDigit = "Nine" 
Case Else: GetDigit = "" 
End Select 
End Function 

    สตูรแปลงตัวเลขเป็นคําอา่น   
 

24 

Option Explicit 
 
'**************** 
' Main Function * 
'**************** 
Function UnitText(ByVal MyNumber, UnitName1, UnitName2) 
Dim KeyUnit1, KeyUnit2, Temp 
Dim DecimalPlace, Count 
 
ReDim Place(9) As String 
Place(2) = " Thousand " 
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Place(3) = " Million " 
Place(4) = " Billion " 
Place(5) = " Trillion " 
 
' String representation of amount 
MyNumber = Trim(Str(MyNumber)) 
 
' Position of decimal place 0 if none 
DecimalPlace = InStr(MyNumber, ".") 
'Convert KeyUnit2 and set MyNumber to KeyUnit1 amount 
If DecimalPlace > 0 Then 
KeyUnit2 = GetTens(Left(Mid(MyNumber, DecimalPlace + 1) & "00", 2)) 
MyNumber = Trim(Left(MyNumber, DecimalPlace - 1)) 
End If 
 
Count = 1 
Do While MyNumber <> "" 
Temp = GetHundreds(Right(MyNumber, 3)) 
If Temp <> "" Then KeyUnit1 = Temp & Place(Count) & KeyUnit1 
If Len(MyNumber) > 3 Then 
MyNumber = Left(MyNumber, Len(MyNumber) - 3) 
Else 
MyNumber = "" 
End If 
Count = Count + 1 
Loop 
 
Select Case KeyUnit1 
Case "" 
KeyUnit1 = "No " & UnitName1 
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Case "One" 
KeyUnit1 = "One " & UnitName1 
Case Else 
KeyUnit1 = KeyUnit1 & " " & UnitName1 & "" 'without s 
End Select 
 
Select Case KeyUnit2 
Case "" 
KeyUnit2 = " Only" 
Case "One" 
KeyUnit2 = " and One " & " " & UnitName2 
Case Else 
KeyUnit2 = " and " & KeyUnit2 & " " & UnitName2 & "" 'without s 
End Select 
 
UnitText = KeyUnit1 & KeyUnit2 
End Function 
 
'******************************************* 
' Converts a number from 100-999 into text * 
'******************************************* 
Private Function GetHundreds(ByVal MyNumber) 
Dim Result As String 
 
If Val(MyNumber) = 0 Then Exit Function 
MyNumber = Right("000" & MyNumber, 3) 
 
'Convert the hundreds place 
If Mid(MyNumber, 1, 1) <> "0" Then 
Result = GetDigit(Mid(MyNumber, 1, 1)) & " Hundred " 
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End If 
 
'Convert the tens and ones place 
If Mid(MyNumber, 2, 1) <> "0" Then 
Result = Result & GetTens(Mid(MyNumber, 2)) 
Else 
Result = Result & GetDigit(Mid(MyNumber, 3)) 
End If 
 
GetHundreds = Result 
End Function 
 
'********************************************* 
' Converts a number from 10 to 99 into text. * 
'********************************************* 
Private Function GetTens(TensText) 
Dim Result As String 
 
Result = "" 'null out the temporary function value 
If Val(Left(TensText, 1)) = 1 Then ' If value between 10-19 
Select Case Val(TensText) 
Case 10: Result = "Ten" 
Case 11: Result = "Eleven" 
Case 12: Result = "Twelve" 
Case 13: Result = "Thirteen" 
Case 14: Result = "Fourteen" 
Case 15: Result = "Fifteen" 
Case 16: Result = "Sixteen" 
Case 17: Result = "Seventeen" 
Case 18: Result = "Eighteen" 
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Case 19: Result = "Nineteen" 
Case Else 
End Select 
Else ' If value between 20-99 
Select Case Val(Left(TensText, 1)) 
Case 2: Result = "Twenty " 
Case 3: Result = "Thirty " 
Case 4: Result = "Forty " 
Case 5: Result = "Fifty " 
Case 6: Result = "Sixty " 
Case 7: Result = "Seventy " 
Case 8: Result = "Eighty " 
Case 9: Result = "Ninety " 
Case Else 
End Select 
Result = Result & GetDigit _ 
(Right(TensText, 1)) 'Retrieve ones place 
End If 
GetTens = Result 
End Function 
 
'******************************************* 
' Converts a number from 1 to 9 into text. * 
'******************************************* 
Private Function GetDigit(Digit) 
Select Case Val(Digit) 
Case 1: GetDigit = "One" 
Case 2: GetDigit = "Two" 
Case 3: GetDigit = "Three" 
Case 4: GetDigit = "Four" 
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Case 5: GetDigit = "Five" 
Case 6: GetDigit = "Six" 
Case 7: GetDigit = "Seven" 
Case 8: GetDigit = "Eight" 
Case 9: GetDigit = "Nine" 
Case Else: GetDigit = "" 
End Select 
End Function 

    สตูรแปลงตัวเลขเป็นคําอา่น   
 

25 

Option Explicit 
 
Function NetYMD(Day1 As Date, Day2 As Date) As String 
Dim years, months, days, m 
 
years = Year(Day2) - Year(Day1) 
If Month(Day1) > Month(Day2) Then 
years = years - 1 
End If 
 
If Month(Day2) < Month(Day1) Then 
months = 12 - Month(Day1) + Month(Day2) 
Else 
months = Month(Day2) - Month(Day1) 
End If 
 
If Day(Day2) < Day(Day1) Then 
months = months - 1 
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If Month(Day2) = Month(Day1) Then 
years = years - 1 
months = 11 
End If 
End If 
 
days = Day(Day2) - Day(Day1) 
If days < 0 Then 
m = CInt(Month(Day2)) - 1 
If m = 0 Then m = 12 
Select Case m 
Case 1, 3, 5, 7, 8, 10, 12 
days = 31 + days 
Case 4, 6, 9, 11 
days = 30 + days 
Case 2 
If (Year(Day2) Mod 4 = 0 And Year(Day2) _ 
Mod 100 <> 0) Or Year(Day2) Mod 400 = 0 Then 
days = 29 + days 
Else 
days = 28 + days 
End If 
End Select 
End If 
NetYMD = CStr(years) + " years " + CStr(months) _ 
+ " months " + CStr(days) + " days " 
End Function 
 
Function NetYear(Day1 As Date, Day2 As Date) As String 
Dim years, months, days, m 
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years = Year(Day2) - Year(Day1) 
If Month(Day1) > Month(Day2) Then 
years = years - 1 
End If 
NetYear = CStr(years) 
 
End Function 
 
Function NetMonth(Day1 As Date, Day2 As Date) As String 
Dim years, months, days, m 
 
If Month(Day2) < Month(Day1) Then 
months = 12 - Month(Day1) + Month(Day2) 
Else 
months = Month(Day2) - Month(Day1) 
End If 
 
If Day(Day2) < Day(Day1) Then 
months = months - 1 
If Month(Day2) = Month(Day1) Then 
years = years - 1 
months = 11 
End If 
End If 
 
NetMonth = CStr(months) 
 
End Function 
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Function NetDay(Day1 As Date, Day2 As Date) As String 
Dim years, months, days, m 
 
days = Day(Day2) - Day(Day1) 
If days < 0 Then 
m = CInt(Month(Day2)) - 1 
If m = 0 Then m = 12 
Select Case m 
Case 1, 3, 5, 7, 8, 10, 12 
days = 31 + days 
Case 4, 6, 9, 11 
days = 30 + days 
Case 2 
If (Year(Day2) Mod 4 = 0 And Year(Day2) _ 
Mod 100 <> 0) Or Year(Day2) Mod 400 = 0 Then 
days = 29 + days 
Else 
days = 28 + days 
End If 
End Select 
End If 
 
NetDay = CStr(days) 
 
End Function 

    สตูรคํานวณระยะเวลา   
 

26 Function PersonalTax(TaxableIncome)    
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Const UpperRange0 = 50000 
Const UpperRange1 = 100000 
Const UpperRange2 = 500000 
Const UpperRange3 = 1000000 
Const UpperRange4 = 4000000 
Const TaxRate0 = 0 
Const TaxRate1 = 0.05 
Const TaxRate2 = 0.1 
Const TaxRate3 = 0.2 
Const TaxRate4 = 0.3 
Const TaxRate5 = 0.37 
Const TotalTaxPay0 = 0 
Const TotalTaxPay1 = 2500 
Const TotalTaxPay2 = 42500 
Const TotalTaxPay3 = 142500 
Const TotalTaxPay4 = 1042500 
Select Case TaxableIncome 
Case Is >= UpperRange4 
PersonalTax = TotalTaxPay4 + _ 
(TaxRate5 * (TaxableIncome - UpperRange4)) 
Case Is >= UpperRange3 
PersonalTax = TotalTaxPay3 + _ 
(TaxRate4 * (TaxableIncome - UpperRange3)) 
Case Is >= UpperRange2 
PersonalTax = TotalTaxPay2 + _ 
(TaxRate3 * (TaxableIncome - UpperRange2)) 
Case Is >= UpperRange1 
PersonalTax = TotalTaxPay1 + _ 
(TaxRate2 * (TaxableIncome - UpperRange1)) 
Case Is >= UpperRange0 
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PersonalTax = TotalTaxPay0 + _ 
(TaxRate1 * (TaxableIncome - UpperRange0)) 
Case Is < UpperRange0 
PersonalTax = TaxRate0 * TaxableIncome 
End Select 

End Function 

    สตูรคํานวณภาษีหัก ณ ทีѷจา่ย   
 

27 

Public Function SigFig(X As Variant, SigFigs As Integer) As Variant 
 
'Rounds X to Sigfigs significant figures 
'Many thanks to John N. of Locum Destination Consulting for sharing his 
SigFig() function for rounding to significant figures. 
'http://www.pcqna.com/Excel_Rounding.htm 
 
Dim Powers As Double, Sign As Long 
On Error GoTo ErrHandler 
If SigFigs < 1 Then GoTo ErrHandler 
Sign = Sgn(X) 
X = Abs(X) 
Powers = 10 ^ (Int(Log(X) / Log(10#)) + 1) 
'Application.Round() in next line is an Excel function; adjust as needed 
SigFig = Sign * Application.Round(X / Powers, SigFigs) * Powers 
Exit Function 
ErrHandler: 
SigFig = CVErr(xlErrValue) 
End Function 
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'Further developed by Somkiat Foongkiat 
'Excel Expert Training 
 
Public Function SigFigDown(X As Variant, SigFigs As Integer) As Variant 
Dim Powers As Double, Sign As Long 
On Error GoTo ErrHandler 
If SigFigs < 1 Then GoTo ErrHandler 
Sign = Sgn(X) 
X = Abs(X) 
Powers = 10 ^ (Int(Log(X) / Log(10#)) + 1) 
SigFigDown = Sign * Application.RoundDown(X / Powers, SigFigs) * 
Powers 
Exit Function 
ErrHandler: 
SigFigDown = CVErr(xlErrValue) 
End Function 
 
 
Public Function SigFigUp(X As Variant, SigFigs As Integer) As Variant 
Dim Powers As Double, Sign As Long 
On Error GoTo ErrHandler 
If SigFigs < 1 Then GoTo ErrHandler 
Sign = Sgn(X) 
X = Abs(X) 
Powers = 10 ^ (Int(Log(X) / Log(10#)) + 1) 
SigFigUp = Sign * Application.RoundUp(X / Powers, SigFigs) * Powers 
Exit Function 
ErrHandler: 
SigFigUp = CVErr(xlErrValue) 
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End Function 
 
 
Public Function PowerNum(X As Variant) As Double 
X = Abs(X) 
PowerNum = (Int(Log(X) / Log(10#)) + 1) 
End Function 
 
Public Function RoundSP(Num As Variant, NumDigits As Integer) As 
Variant 
Dim PowersX As Double, PowersZ As Double, Sign As Long 
Dim X1 As Variant, X2 As Variant, X3 As Variant 
Dim Y1 As Variant, Y2 As Variant 
Dim Z1 As Variant, Z2 As Variant, Z3 As Variant 
 
On Error GoTo ZeroHandler 
Sign = Sgn(Num) 
Num = Abs(Num) 
 
X1 = Application.RoundDown(Num, NumDigits + 1) 
PowersX = 10 ^ (Int(Log(X1) / Log(10#)) + 1) 
X2 = X1 / PowersX 
X3 = Right(X2, 1) 'หาตัวเลขหลักถัดไป 
 
Y1 = Application.RoundDown(Num, NumDigits + 1) 
Y2 = Num - Y1 'หาวา่ถัดจากนัѸนมคีา่อะไรอยูอ่กี 
 
Z1 = Application.RoundDown(Num, NumDigits) 
PowersZ = 10 ^ (Int(Log(Z1) / Log(10#)) + 1) 
Z2 = Z1 / PowersZ 
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Z3 = Right(Z2, 1) 'หาตัวเลข ณ หลักนัѸน 
 
If (X3 > 5) _ 
Or ((X3 = 5) And (Y2 <> 0)) _ 
Or ((X3 = 5) And (Z3 - Application.Odd(Z3)) = 0) _ 
Then 
RoundSP = Sign * Application.Round(Num, NumDigits) 
Else 
RoundSP = Sign * Application.RoundDown(Num, NumDigits) 
End If 
Exit Function 
ZeroHandler: 
RoundSP = Sign * Application.Round(Num, NumDigits) 
End Function 
 
 
Public Function SigFigSP(X As Variant, SigFigs As Integer) As Variant 
Dim Powers As Double, Sign As Long 
On Error GoTo ErrHandler 
If SigFigs < 1 Then GoTo ErrHandler 
Sign = Sgn(X) 
X = Abs(X) 
Powers = 10 ^ (Int(Log(X) / Log(10#)) + 1) 
SigFigSP = Sign * RoundSP(X / Powers, SigFigs) * Powers 
Exit Function 
ErrHandler: 
SigFigSP = CVErr(xlErrValue) 
End Function 
 
Public Function CountDecimal(X As Variant) As Integer 
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X = Abs(X) 
If X < 1 Then 
CountDecimal = Len(X) - Len(Int(X)) 
Else 
CountDecimal = Application.Max(0, Len(X) - Len(Int(X)) - 1) 
End If 
End Function 
 
Public Function CountInteger(X As Variant) As Integer 
X = Abs(X) 
If Int(X) = 0 Then 
CountInteger = 0 
Else 
CountInteger = Len(Int(X)) 
End If 
End Function 
 
Public Function CountSF(X As Variant) As Integer 
Dim Powers As Double, X1 As Variant 
X = Abs(X) 
Powers = 10 ^ (Int(Log(X) / Log(10#)) + 1) 
X1 = X / Powers 
CountSF = Len(X1) - 1 
End Function 

    Significant Figure   
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General Functions 

1 =SUM(Sheet1:Sheet10!A1:A100)   

    รวมคา่ในเซลล ์A1:A100 ของทกุ sheet ตั Ѹงแต ่sheet 1 ถงึ 10   
 

2 =COUNTA(Sheet1:Sheet10!A1:A100)   

    นับเซลล ์A1:A100 ทีѷมคีา่ของทกุ sheet ตั Ѹงแต ่sheet 1 ถงึ 10   
 

3 =COUNTIF(data,"<0")   

    นับจํานวนเซลลท์ีѷมคีา่นอ้ยกวา่ 0   
 

4 =COUNTIF(data,"yes")   

    นับจํานวนเซลลท์ีѷมคีา่ "yes"   
 

5 =COUNTIF(data,"*")   

    นับจํานวนเซลลท์ีѷมคีา่ใดๆ   
 

6 =COUNTIF(data,"s*")   
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    นับจํานวนเซลลท์ีѷมคีา่นําดว้ยตัวอกัษร "s"   
 

7 =COUNTIF(data,"*s*")   

    นับจํานวนเซลลท์ีѷมตีัวอกัษร "s"   
 

8 =COUNTIF(data,"yes")+COUNTIF(data,"no")    

    นับจํานวนเซลลท์ีѷมคีา่ "yes" หรอื "no"   
 

9 =COUNTIF(data,"???")   

    นับจํานวนเซลลท์ีѷมคีา่ 3 ตัวอกัษร   
 

10 =COUNTIF(data,">=1")-COUNTIF(data,">10")   

    นับจํานวนเซลลท์ีѷมคีา่ระหวา่ง 1 ถงึ 10   
 

11  =SUMIF(A2:A10,"Jan",C2:C10)   

    รวมคา่ของ C2:C10 ในตําแหน่งซึѷง A2:A10 = "Jan"   
 

12  =COUNTIF(A2:A10,"Jan",C2:C10)   
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    นับคา่ของ C2:C10 ในตําแหน่งซึѷง A2:A10 = "Jan"   
 

13 =SUMIF(A2:A10,"<>Jan",C2:C10)   

    รวมคา่ของ C2:C10 ในตําแหน่งซึѷง A2:A10 <> "Jan"   
 

14 =SUMIF(Month,"Jan",Sales)+SUMIF(Month,"Feb",Sales)   

    รวมคา่ของ Sales ในตําแหน่งซึѷง Month="Jan" หรอื "Feb"   
 

15 
=SUMIF(A1:A6,"Part#1",B1:B6) 
=SUMPRODUCT((A1:A6="Part#1")*(B1:B6)) 

  

    รวมคา่ของ Part#1   
 

16 =SUM(IF(FREQUENCY(data,data)>0,1,0))   

    นับจํานวนเซลลท์ีѷมคีา่ unique numeric values    
 

17 
=IF(COUNTIF(A$2:A2,A2)>1,COUNTIF(A$2:A2,A2),"")  
=IF(COUNTIF(A$2:A2,A2)>1,"Dup","") 

  

    แสดงตําแหน่งเซลลท์ีѷมคีา่ซํѸา   
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18 

=IF(A1>=1,INT(A1)&"' ","") & TEXT(MOD(A1,1)*12,"- 
0"&IF(ABS(MOD(A1,1)*12-ROUND(MOD(A1,1)*12,0))>1/32," 
0/"&CHOOSE(ROUND(MOD(MOD(A1,1)*12,1)*16,0),16,8,16,4,16, 
8,16,2,16,8,16,4,16,8,16),"")) &""""  

  

    
ปัดเลขความยาวจาก feet และ decimal feet ไปเป็น feet, inches 
แบบปัดคา่ 1/16 inch fractions. 

  

 

19 

=INT(A1/12)&"' " & TEXT(MOD(A1,12),"0"&IF(ABS(MOD(A1,12)-
ROUND(MOD(A1,12),0))>1/32," 
0/"&CHOOSE(ROUND(MOD(MOD(A1,12),1)*16,0), 
16,8,16,4,16,8,16,2,16,8,16,4,16,8, 16),"")) & """"  

  

    
ปัดเลขความยาวจาก inches และ decimal fractions ไปเป็น feet 
และ inches แบบปัดคา่ 1/16th inch fractions 

  

 

20 
=TEXT(A1,"0"&IF(ABS(A1-ROUND(A1,0))>1/32," 0/"& CHOOSE( 
ROUND(MOD(A1,1)*16,0),16,8,16, 
4,16,8,16,2,16,8,16,4,16,8,16),"")) &""""  

  

    
ปัดเลขความยาวจาก inches และ decimal fractions ไปเป็น inches 
only with rounded 1/16th inch fractions 

  

 

21 
=VALUE(LEFT(A1,FIND("'",A1)-1)) + 
VALUE(MID(A1,FIND("'",A1) +1,FIND("""",A1)-FIND("'",A1)-
1))/12  
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    เปลีѷยนเลขความยาว จาก Feet and Inches ไปเป็น feet   
 

22 
=VALUE(LEFT(A1,FIND("'",A1)-1))*12 + 
VALUE(MID(A1,FIND("'",A1) +1,FIND("""",A1)-FIND("'",A1)-1))  

  

    เปลีѷยนเลขความยาว จาก Feet and Inches back ไปเป็น inches   
 

23 

สตูร คนืคา่ 

=SUM(E4:E23) รวมคา่ใน E4:E23 

=SUBTOTAL(9;G4:G26) 
รวมคา่ใน G4:G26 เฉพาะ visible 
cells 

=SUMPRODUCT(E4:E13;F4:F13)
รวมผลคณูระหวา่งn E4:E13 คณูกบั 
F4:F13 

{=SUM(E4:E13*F4:F13)} เหมอืนสตูรขา้งตน้แตใ่ช ้array formula 

=SUMSQ(E4:E13) S(x²) 

=SUMX2MY2(E4:E13;E14:E23) S(x² - y²) 

=SUMX2PY2(E4:E13;E14:E23) S(x² + y²) 

=SUMXMY2(E4:E13;E14:E23) S(x - y)² 
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24 =COUNTBLANK(E2:E23)   

    นับเซลลว์า่ง   
 

25 =CELL("filename")   

    แสดง path- และ filenames   
 

26 =RAND()*100   

    แสดงเลขสุม่เป็นเลขทศนยิมระหวา่ง 0 ถงึ 100   
 

27 =RAND()*(100-50)+50   

    แสดงเลขสุม่เป็นเลขทศนยิมระหวา่ง 50 ถงึ 100   
 

28 =ROUND(RAND()*100,0)   

    แสดงเลขสุม่เป็นเลขจํานวนเต็มระหวา่ง 0 ถงึ 100   
 

29   A สตูรสะสม   
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1 100 =SUM($A$1:A1) 

2 200 =SUM($A$1:A2) 

3 300 =SUM($A$1:A3) 

4 400 =SUM($A$1:A4) 

5 500 =SUM($A$1:A5 
 

    สตูรยอดรวมสะสม   
 

30 =LEN(B1)-LEN(SUBSTITUTE(SUBSTITUTE(B1,"B",""),"b",""))   

    
count the number of "B"s, both upper and lower case, in the 
string in B1 

  

 

31 =OFFSET(Sheet1!$A$2,0,0,COUNTA($A$2:$A$20),1)   

    Dynamic Ranges   
 

32 
=RIGHT(A2,LEN(A2)-FIND("*",SUBSTITUTE(A2," ","*",LEN(A2)- 
LEN(SUBSTITUTE(A2," ",""))))) 
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To return the last name. Suppose cell A2 contains the name 
"John A Smith" 

  

 

33 
=LEFT(A2,FIND("*",SUBSTITUTE(A2," ","*",LEN(A2)- 
LEN(SUBSTITUTE(A2," ",""))))-1) 

  

    
To return the first name, including the middle name (if 
present), 

  

 

34 =LEFT(B2,FIND(" ",B2,1))   

    
To return the first name, without the middle name (if 
present), 

  

 

35 =LEFT(A1,FIND(" ",A1,1))   

    Returning  First Word In A String   
 

36 =RIGHT(A1,LEN(A1)-FIND(" ",A1,1))   

    Returning All But First Word In A String   
 

37 
"Grades" which refers to ={0,"F";60,"D";70,"C";80,"B";90,"A"} 
 
=VLOOKUP(A1,Grades,2) 
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    to convert the number to the grade:   
 

38 
=IF(ROW()-ROW(TopRng)+1>TopN,"",LARGE(RankRng,ROW()-
ROW(TopRng)+1)) 

  

    

Ranking Numbers : to return the N highest or lowest values 
from a range of data  

Suppose we have a range of numeric data called 
RankRng.   Create a range next to RankRng (starting in the 
same row, with the same number of rows) called TopRng. 
Also, create a named cell called TopN, and enter into it the 
number of values you want to return (e.g., 5 for the top 5 
values in RankRng). Enter the following formula in the first 
cell in TopRng, and use Fill Down to fill out the range 

  

 

39 
=IF(ROW()-ROW(TopRng)+1>TopN,"",SMALL(RankRng,ROW()-
ROW(TopRng)+1)) 

  

    To return the TopN smallest values of RankRng   
 

40 =CELL("filename",A1)   

    To return the full sheet name (including the file path)   
 



211 

 

© พ.ศ.2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ
www.ExcelExpertTraining.com 

41 
=MID(CELL("filename",A1),FIND("]",CELL("filename",A1))+1, 
LEN(CELL("filename",A1))-FIND("]",CELL("filename",A1))) 

  

    To return the sheet name, without the path   
 

42 
=MID(CELL("filename",A1),FIND("[",CELL("filename",A1))+1,FIND("]", 
CELL("filename",A1))-FIND("[",CELL("filename",A1))-1) 

  

    To return the file name without the path   
 

43 

=LEFT(CELL("filename",A1),FIND("]",CELL("filename",A1))) Or  

=SUBSTITUTE(SUBSTITUTE(LEFT(CELL("filename",A1),FIND("]", 
CELL("filename",A1))),"[",""),"]","") 

  

    To return the file name with the path   
 

44 

=RadiusEarth*ACOS(COS(RADIANS(90-
(Lat1*24)))*COS(RADIANS(90-(Lat2*24)))+ 
SIN(RADIANS(90-(Lat1*24)))*SIN(RADIANS(90-(Lat2*24)))* 
COS(RADIANS(24*(Long1-Long2)))) 

  

    

Great Circle Distances  

Lat1 is the latitude of point 1, entered as DD:MM:SS. 
Long1 is the longitude of point 1, entered as DD:MM:SS. 
Lat2 is the latitude of point 2, entered as DD:MM:SS. 
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Long2 is the longitude of point 2, entered as DD:MM:SS. 
RadiusEarth is the radius of the earth (3,963 miles or 6,377 
kilometers). 

 

45 

=RadiusEarth*ACOS(COS(RADIANS(90-
Lat1))*COS(RADIANS(90-Lat2))+ 
SIN(RADIANS(90-Lat1))*SIN(RADIANS(90-
Lat2))*COS(RADIANS(Long1-Long2))) 

  

    
mixing hemispheres, enter Northern and Western coordinates 
as positive, and Southern and Eastern coordinates as 
negative 

  

 

46 
=LEFT(A2,IF(ISERROR(FIND(",",A2,1)),LEN(A2),FIND(",",A2,1)-
1)) 

  

    To return the last name of the full name in A2   
 

47 
=TRIM(IF(ISERROR(FIND(",",A2,1)),A2,MID(A2,FIND(",",A2,1)+1, 
IF(ISERROR(FIND(" ",A2,FIND(",",A2,1)+2)),LEN(A2), 
FIND(" ",A2,FIND(",",A2,1)+2))-FIND(",",A2,1)))) 

  

    To return the first name    
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48 
=TRIM(RIGHT(A2,LEN(A2)-IF(ISERROR(FIND(" ",A2, 
FIND(" ",A2,FIND(",",A2,1)+2))),LEN(A2), 
FIND(" ",A2,FIND(" ",A2,FIND(",",A2,1)+2))-1))) 

  

    To return the middle name    
 

49 =MAX(A1:A10,B1)   

    

the highest score ever reached  

the Tolls->Options dialog, click on the Calculation tab, and 
check the Interations check box 

  

 

50 =SUM(INDIRECT("A1:A10"))   

    =SUM($A$1:$A$10),   
 

51 
=A1&IF(AND(A1>=10,A1<=14),"th", 
CHOOSE(MOD(A1,10)+1,"th","st","nd","rd","th","th","th","th","th","th")) 

  

    return the number in A1 with the suffix appended   
 

52 =RANK(C7,C$7:C$16)+COUNTIF(C$7:C7,C7)-1   

    Unique Ranks    
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53 
=COUNT(C$7:C$16)-
(RANK(C7,C$7:C$16)+COUNTIF(C$7:C7,C7))+2 

  

    Reverse Unique Ranks    
 

54 =CELL("filename",A1)   

    D:\driveM\excel\TAXES\[1996FEDT.XLS]Sheet1    
 

55 
=LEFT(CELL("filename",A1),FIND("[",CELL("filename",A1),1)-1)  
=INFO("directory") 

  

    D:\driveM\excel\TAXES\   
 

56 
=SUBSTITUTE(LEFT(CELL("filename",A1),FIND("]",CELL("filename",A1),1)-
1),"[","") 

 

    D:\driveM\excel\TAXES\1996FEDT.XLS   
 

57 
=SUBSTITUTE(SUBSTITUTE(CELL("filename",A1),"[",""),"]"," [") 
& "]" 

  

    
D:\driveM\excel\TAXES\1996FEDT.XLS [Sheet1]  
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58 

=SUBSTITUTE(LEFT(LOWER(CELL("filename",A1)),FIND("]", 
CELL("filename",A1))-1),"[","") & " [" & 
MID(CELL("filename",A1),FIND("]",CELL("filename",A1))+1,28) & 
"]" 

  

    d:\drivem\excel\taxes\1996fedt.xls [Sheet1]   
 

59 
=MID(CELL("filename",A1),FIND("[",CELL("filename",A1),1)+1,FIND("]", 
CELL("filename",A1),1)-FIND("[",CELL("filename",A1),1)-1) 

 

    1996FEDT.XLS  
 

60 

=RIGHT(CELL("filename",A1),LEN(CELL("filename",A1))-
FIND("]", CELL("filename",A1)))  
=MID(CELL("filename",A1),FIND("]",CELL("filename",A1))+1,99)  
=SheetName() 

  

    Sheet1    
 

61 

=INFO("directory")  

directory, memavail, memused, numfile, origin, osversion, recalc, 
release, system, totmem 

  

    C:\WINNT\Profiles\Administrator\Personal\    
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62 
=UPPER(LEFT(A37,1)&"."&MID(A37,FIND(" ",A37&" ")+1,1)&". 
") 

  

    Extract the first two initials   
 

63 
=IF(LEN(A11)=0,"",IF(ISERR(FIND(" 
",A11)),A11,LEFT(A11,FIND(" ",A11)-1))) 

  

    Extract the first word   
 

64 
=len(a1)-len(substitute(a1,"a",""))     — lettercase must match  
=len(a1)-len(substitute(upper(a1),"A",""))     — lettercase does 
not matter 

  

    Find number of occurrences of a character in a cell       
 

65 =LEN(A1)-LEN(SUBSTITUTE(A1,",",""))+(LEN(TRIM(A1))>0)    

    Find the number of items separated by commas   
 

66 
=LEN(SUBSTITUTE(TRIM(A1),CHAR(32),CHAR(32)&CHAR(32)) 
)-LEN(TRIM(A1))+1 

  

    Find the number of words in a string   
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67 =LEN(A1)-LEN(SUBSTITUTE(A1,"aa","")))/LEN("aa")   

    Find the number of occurences of a string in a single cell   
 

68 =countif(A1:J1,"aa")       

    
Find the number of cells in a range that have string as their 
value 

  

 

69 
=IF(ISERR(FIND("/",E22)),E22,MID(E22,FIND("/",E22,1)+1,99)) 
=IF(ISERR(FIND("/",E22)),"",MID(E22,FIND("/",E22,1)+1,99)) 
  

  

    Return string after first "/" character   
 

70 
=NOT(ISNUMBER(VALUE(LEFT(D7,1))))  

=IF(LEFT(TRIM(D7))="","",NOT(ISNUMBER(VALUE(LEFT(D7,1))))) 
  

    First Character checked as alphabetic character   
 

71 =SUBSTITUTE(A1," ","")   

    Remove All Spaces   
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72 

=IF(MOD(INT(16*(+B2-
INT(B2)+0.0312)),16)=0,TEXT(B2,"#"),IF(MOD(INT(16*(+B2-
INT(B2)+0.0312)),8)=0,TEXT(B2,"# 
0/2"),IF(MOD(INT(16*(+B2-INT(B2)+0.0312)),4)=0,TEXT(B2,"# 
0/4"),IF(MOD(INT(16*(+B2-INT(B2)+0.0312)),2)=0,TEXT(B2,"# 
0/8"),TEXT(B2,"# 0/16"))))) 

  

    to reduce 8/16's to 1/2, 10/16 to 5/8   
 

73 =SUMPRODUCT(B2:B6,C2:C6)/SUM(C2:C6)   

    Weighted Average   
 

74 =OFFSET(MySheet!$A$1,0,0,COUNTA(MySheet!$A:$A),1)    

    Dynamic Named Ranges   
 

75 

=POWER((SUM(IF(values0,values*(POWER(1+rRate,(MAX(dates)-
dates)/daybase)) ,0)))/(SUM(IF(values<0,values/(POWER 
(1+iRate,(MAX(dates)-dates)/daybase)) ,0)))*-1,1/((MAX(dates)-
MIN(dates))/daybase))-1  

  

    

combine the functionality of the XIRR and MIRR functions  

values is the row or column range of cashflows  
dates is the row or column range of corresponding dates  
iRate is the interest rate you pay on the money used in the 
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cash flows  
rRate is the interest rate you receive on the cash flows as you 
reinvest them 
daybase is days-in-year basis to use (usually 360 or 365).  

 

7
6 

=MROUND(Num,IF(VALUE(RIGHT(Num/10^(INT(LOG(ABS(Num)))-
Plc+1),2))=0.5,2,1)* SIGN(Num)*10^(INT(LOG(ABS(Num)))-Plc+1))  

=MROUND(Num,IF(VALUE(RIGHT(Num/Fact,2))=0.5,2,1)*SIGN(Num)*Fac
t)  

 

    
'bankers rounding' for a number (Num) to a given number (Plc) of 
significant digits 
define 'Fact' as =10^(INT(LOG(ABS(Num)))-Plc+1),  

 

 

77 =INDEX(FREQUENCY((A1,A3,A5),20),2)    

    นับจํานวนเซลลซ์ึѷงไมไ่ดต้ดิตอ่กนั และมคีา่มากกวา่ 20   
 

78 
=LEN(A1)-LEN(SUBSTITUTE(A1,"B",""))  

=LEN(A1)-LEN(SUBSTITUTE(SUBSTITUTE(A1,"B",""),"b","")) 
  

    นับตัวอกัษร b ในเซลล ์   
 

79 =SUM(LEN(A1)-LEN(SUBSTITUTE(A1,B1,"")))/LEN(B1)    
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=SUM(LEN(A1)-
LEN(SUBSTITUTE(UPPER(A1),UPPER(B1),"")))/LEN(B1) 

    นับจํานวนคํา B1 ในประโยค A1   
 

80 
=A1&IF(OR(VALUE(RIGHT(A1,2))={11,12,13}), 
"th",IF(OR(VALUE(RIGHT(A1))={1,2,3}),CHOOSE(RIGHT(A1), 
"st","nd","rd"), "th")) 

  

    Ordinal Number   
 

81 
=IF(AND(A1>0,A1<257),IF(A1>26,CHAR(CEILING(A1/26,1)+63),"") 
&CHAR(IF(MOD(A1,26)=0,26,MOD(A1,26))+64),"") 

  

    แปลงเลขทีѷ column เป็นตัวอกัษร column   
 

82 
=MID(A1,FIND("*",SUBSTITUTE(A1,"\","*",LEN(A1)-
LEN(SUBSTITUTE(A1,"\",))))+1,LEN(A1)) 

  

    แยกชืѷอ file จาก c:\MainDir\ชืѷอ file   
 

83 
=IF(ISERR(LEFT(A1,FIND(" ",A1)-1)),A1,LEFT(A1,FIND(" ",A1)-
1)) 

  

    แยกคําแรกออกจากประโยคภาษาองักฤษ   
 



221 

 

© พ.ศ.2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ
www.ExcelExpertTraining.com 

84 
=IF(LEN(A4)-LEN(SUBSTITUTE(A4," ",""))=0, A4, 
RIGHT(A4,LEN(A4) -FIND("*",SUBSTITUTE(A4," ", "*", LEN(A4)-
LEN(SUBSTITUTE(A4," ","")))))) 

  

    แยกคําสดุทา้ยออกจากประโยคภาษาองักฤษ   
 

85 =RIGHT(A1,LEN(A1)-FIND(" ",A1,1))   

    แยกคําทีѷเหลอืซึѷงไมใ่ชคํ่าแรก ออกจากประโยคภาษาองักฤษ   
 

86 

=LEFT(A1,FIND(" ",A1)-1)  

=IF(ISERR(MID(A1,FIND(" ",A1)+1,IF(ISERR(FIND(" ",A1,FIND(" 
",A1)+1)),FIND(" ",A1),FIND(" ",A1,FIND(" ",A1)+1))-FIND(" 
",A1)-1)),"",MID(A1,FIND(" ",A1)+1,IF(ISERR(FIND(" 
",A1,FIND(" ",A1)+1)),FIND(" ",A1), FIND(" ",A1,FIND(" 
",A1)+1))-FIND(" ",A1)-1)) 

=RIGHT(A1,LEN(A1)-FIND("*",SUBSTITUTE(A1," ","*",LEN(A1)- 
LEN(SUBSTITUTE(A1," ",""))))) 

  

    แยก first name, middle names, last names   
 

87 
=IF(OR(LEFT(A1,2)="Mr",LEFT(A1,3)="Mrs",LEFT(A1,2)="Ms"), 
RIGHT(A1,LEN(A1)-FIND(" ",A1)),A1) 

  

    ตัดคํานําหนา้ชืѷอออกจากชืѷอ   
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88 
=LEN(SUBSTITUTE(TRIM(A1),CHAR(32),CHAR(32)&CHAR(32)))-
LEN(TRIM(A1))+1 

  

    นับจํานวนคําในเซลล ์   
 

89 

=LEFT(TRIM(A1),FIND(" ",TRIM(A1),1)-1)&" 
"&RIGHT(TRIM(A1),LEN(TRIM(A1))-IF(ISERROR(FIND(" 
",TRIM(A1),FIND(" ",TRIM(A1),1)+1)),FIND(" 
",TRIM(A1),1),FIND(" ",TRIM(A1),FIND(" ",TRIM(A1),1)+1))) 

  

    ตัด middle names ออกจากชืѷอนามสกลุ   
 

90 
=SUBTOTAL(9, INDIRECT(ADDRESS( ROW(C3),COLUMN(C3) 
)&":"& ADDRESS( ROW(C3), 
ROW(INDIRECT(COLUMN(C3)&":"&COLUMN(G3))) ))) 

  

    Cumulative Sum คา่ในเซลล ์C3:G3   
 

91 
=MAX( 0, MIN( เวลาสิѸนสดุกะ, กําหนดสิѸนสดุ ) - MAX( เวลาเริѷมกะ, 
กําหนดเริѷม ) ) 

  

    ระยะเวลาทีѷใชใ้นกะนัѸน   
 

92 =IF( Date>=Start, Amount, 0 )   
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    แสดง Amount เมืѷอถงึวันทีѷกําหนด   
 

93 =IF( Date<=Stop, Amount, 0 )   

    แสดง Amount เมืѷอยังไมเ่ลยวันทีѷกําหนด   
 

94 =IF( AND( Date>=Start, Date<=Stop ), Amount, 0 )   

    แสดง Amount ในชว่งวันทีѷกําหนด   
 

95 
=IF( AND( Date>=Start, Date<=Stop, OR( MOD( Date-
Start+1,Cycle ) = 1,Cycle = 1 ) ), Amount, 0 ) 

  

    แสดง Amount ในชว่งวันทีѷกําหนด และกําหนดเป็นชว่งๆตาม Cycle   
 

 

  



224 

 

© พ.ศ.2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ
www.ExcelExpertTraining.com 

Day and Time Formulas 

1 =DATEDIF(Date1,Date2,Interval)    

    

คํานวณระยะเวลาระหวา่งชว่งทีѷกําหนด 

Interval Code ความหมาย 

 "m" จํานวนเดอืนสะสม 

 "d จํานวนวันสะสม 

 "y" จํานวนปีสะสม 

 "ym" จํานวนเดอืนทีѷเหลอื เมืѷอนับปีชนปี

 "yd" จํานวนวันทีѷเหลอื เมืѷอนับปีชนปี 

 "md" 
จํานวนวันทีѷเหลอื เมืѷอนับเดอืนชน
เดอืน แตไ่มค่วรใชเ้พราะอาจคนืคา่
แปลกๆ 

 

  

 

2 
=DATEDIF(วันเกดิ,NOW(),"y") & " years, " & DATEDIF(วันเกดิ
,NOW(),"ym") & " months, " & DATEDIF(วันเกดิ,NOW(),"md") & " 
days" 

  

    คํานวณอาย ุ   
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3 =AND((TDate>=MIN(TDate1,TDate2)),TDate<=MAX(TDate1,TDate2))   

    ตรวจสอบวา่ TDate อยูร่ะหวา่ง TDate1 ถงึ TDate2   
 

4 

=IF(OR(Date2<VDate1,VDate2<Date1),Date2-
Date1+1,IF(OR(AND(Date1<=VDate1,Date2>=VDate2), 
AND(Date1>=VDate1,Date2<=VDate2)),MAX(0,(Date2-Date1)-(VDate2-
VDate1)), 
IF(OR(AND(Date1<=VDate1,Date2<=VDate2),AND(Date1>=VDate1,Date2
>VDate2)), 
MAX(0,(VDate1-Date1))+MAX(0,Date2-VDate2),NA()))) 

 

    

นับจํานวนวันในระหวา่งชว่งวันทีѷกําหนด 
   

ชืѷอ ความหมาย 

Date1 วันทีѷเริѷมงาน 

Date2 วันทีѷเสร็จงาน 

VDate1 
วันเริѷม ซึѷงไมต่อ้งการนับเป็นวัน
ทํางาน 

VDate2 
วันสดุทา้ย ซึѷงไมต่อ้งการ
นับเป็นวันทํางาน 
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NWRange ตารางวันหยดุ 
 

 

5 

=IF(OR(Date2<VDate1,VDate2<Date1),NETWORKDAYS(Date1,Date2,NWR
ange), 
IF(OR(AND(Date1<=VDate1,Date2>=VDate2),AND(Date1>=VDate1,Date2
<=VDate2)), 
MAX(0,NETWORKDAYS(Date1,Date2,NWRange)-
NETWORKDAYS(VDate1,VDate2,NWRange)), 
IF(OR(AND(Date1<=VDate1,Date2<=VDate2),AND(Date1>=VDate1,Date2
>VDate2)), 
IF((Date1>=VDate1),0,NETWORKDAYS(Date1,VDate1-1,NWRange))+ 
IF((Date2<=VDate2),0,NETWORKDAYS(VDate2+1,Date2,NWRange)),NA())
)) 

 

    นับวันเฉพาะวันธรรมดา ไมนั่บวันหยดุสดุสปัดาหห์รอืวันหยดุอืѷน  
 

6 
=IF(OR(IDate2<RDate1,IDate1>RDate2),0,(MIN(IDate2,RDate2)-
MAX(IDate1,RDate1)+1)) 

  

    

นับจํานวนวันทีѷอยูใ่นทั Ѹงสองชว่งเวลาเหมอืนกนั 
   

ชืѷอ ความหมาย 

IDate1 วันเริѷมตน้ของชว่งแรก 

IDate2 วันสดุทา้ยของชว่งแรก 
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RDate1 วันเริѷมตน้ของชว่งทีѷสอง 

RDate1 วันสดุทา้ยของชว่งทีѷสอง 

NWRange ตารางวันหยดุ 
 

 

7 
=IF(OR(IDate2<RDate1,IDate1>RDate2),0, 
ABS(NETWORKDAYS(MIN(IDate2,RDate2),MAX(IDate1,RDate1),NWRange)
)) 

 

    นับวันเฉพาะวันธรรมดา ไมนั่บวันหยดุสดุสปัดาหห์รอืวันหยดุอืѷน  
 

8 
=MAX(0,NETWORKDAYS(MAX(D$5,$B6),MIN(DATE(YEAR(D$5),MONTH(D$
5)+1,0),$C6))) 

 

    

สรปุจํานวนวันทํางานแตล่ะเดอืน  

 

 

 

9 
=MAX(0,(MIN($C17,DATE(YEAR(D$16),MONTH(D$16)+1,0))-
MAX($B17,D$16)+1)) 
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สรปุจํานวนวันแตล่ะเดอืน  

 

  

 

1
0 

=MAX(0,NETWORKDAYS(MAX(DATE(D$27,1,1),$B28),MIN(DATE(D$27,12,
31),$C28))) 

 

    

สรปุจํานวนวันทํางานแตล่ะปี  

 

 

 

11 
=MAX(0,(MIN($C39,DATE(D$38,12,31))-
MAX($B39,DATE(D$38,1,1))+1)) 

  

    

สรปุจํานวนวันแตล่ะปี  
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12 
=FLOOR("5/"&DAY(MINUTE(B2/38)/2+56)&"/"&B2,7)-34  

=FLOOR(DAY(MINUTE(B2/38)/2+56)&"/5/"&B2,7)-34  
  

    
วัน Easter  

B2 เป็นปีทีѷตอ้งการหาวัน Easter 
  

 

13 =TRUNC(((B6-DATE(YEAR(B6),1,0))+6)/7)   

    เลขทีѷสปัดาห ์   
 

14 

=INT((A1-SUM(MOD(DATE(YEAR(A1-MOD(A1-2,7)+3),1,2), 
{1E+99,7})*{1,-1})+5)/7)   

=1+INT((A1-DATE(YEAR(A1+4-WEEKDAY(A1+6)),1,5)+ 
WEEKDAY(DATE(YEAR(A1+4-WEEKDAY(A1+6)),1,3)))/7) 

  

    เลขทีѷสปัดาหต์าม ISO   
 

15 =RIGHT(YEAR(A1),2)&TEXT(A1-DATE(YEAR(A1),1,0),"000")   

    เปลีѷยนวันทีѷปกต ิเป็น Julian Date   
 

16 =DATE(IF(0+(LEFT(A1,2))<30,2000,1900)+LEFT(A1,2),1,RIGHT(A1,3))  

    เปลีѷยน Julian date เป็นวันทีѷปกต ิ  
 



230 

 

© พ.ศ.2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ
www.ExcelExpertTraining.com 

17 
=DATE(IF(0+(LEFT(A1,2))<30,2000,1900)+LEFT(A1,2),1,RIGHT(A1,3)) 
- 
DATE(IF(0+(LEFT(A2,2))<30,2000,1900)+LEFT(A2,2),1,RIGHT(A2,3)) 

 

    ระยะเวลาระหวา่งสอง Julian Dates  
 

1
8 

=DATE(IF(0+(LEFT(A1,2))<30,2000,1900)+LEFT(A1,2),1,RIGHT(A1,3)+A
2) 

 

    เพิѷมจํานวนวันนับจาก Julian Date  
 

19 
=IF(ROW(A1),CALL("Xlcall32","Excel4","2JRJ",74))  

=IF(ROW(A1:A4),CALL("Xlcall32","Excel4","2JRJ",74)) 
  

    วันปรับปรงุคา่ครั Ѹงสดุทา้ย   
 

20 

=IF(INT(StartDT)=INT(EndDT),"0 days " & ROUND(24*(EndDT-
StartDT),2)&"hours",MAX(NETWORKDAYS(StartDT+1,EndDT-
1,HolidayList),0)+INT(24*(((EndDT-INT(EndDT))-(StartDT-
INT(StartDT)))+(DayEnd-DayStart))/(24*(DayEnd-DayStart)))&" 
days "&MOD(ROUND(((24*(EndDT-INT(EndDT)))-
24*DayStart)+(24*DayEnd-(24*(StartDT-INT(StartDT)))),2), 
ROUND((24*(DayEnd-DayStart)),2))&" hours ") 

  

    
ระยะเวลาเป็นวันและชัѷวโมง ระหวา่งชว่งเวลาทีѷกําหนด 
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ชืѷอ  ความหมาย  ตัวอยา่ง 

 StartDT 
 วันทีѷและเวลา
เริѷมตน้ 

 25-Oct-99 
13:00 

 EndDT 
 วันทีѷและเวลา
สิѸนสดุ 

 28-Oct-99 
15:00 

 DayStart 
เวลาเริѷมงาน
ประจําวัน 

 9:00 

 DayEnd 
เวลาเลกิงาน
ประจําวัน 

 17:00 

 HolidayList  ตารางวันหยดุ  H1:H10 
 

 

21 

=IF(INT(StartDT)=INT(EndDT),ROUND(24*(EndDT-StartDT),2), 
(24*(DayEnd-DayStart)*(MAX(NETWORKDAYS(StartDT+1,EndDT-
1,HolidayList),0)+INT(24*(((EndDT-INT(EndDT))- 
(StartDT-INT(StartDT)))+(DayEnd-DayStart))/(24*(DayEnd-
DayStart))))+MOD(ROUND(((24*(EndDT-INT(EndDT)))-
24*DayStart)+(24*DayEnd-(24*(StartDT-INT(StartDT)))),2), 
ROUND((24*(DayEnd-DayStart)),2))))  

  

    นับจํานวนชัѷวโมงทํางาน   
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22 =IF(OR(WEEKDAY(A4+1)=1,WEEKDAY(A4+1)=7),A4+3,A4+1)   

    ลําดับวันทีѷเฉพาะวันทํางานปกต ินับตั Ѹงแตว่ันแรกในเซลล ์A4   
 

23 =DAY(DATE(YEAR(A1),MONTH(A1)+1,0))    

    เลขทีѷจํานวนวันในแตล่ะเดอืน หรอืเลขวันทีѷสดุทา้ยของเดอืน   
 

24 =DATE(YEAR(A1),MONTH(A1)+1,0)   

    วันทีѷสดุทา้ยของเดอืน   
 

25 =DATE(YEAR(A1),MONTH(A1),0)   

    วันทีѷสดุทา้ยของเดอืนกอ่น   
 

26 
=DATE(Yr,Mon,1+((Nth-(DoW>=WEEKDAY(DATE(Yr,Mon,1))))*7)+ 
(DoW-WEEKDAY(DATE(Yr,Mon,1)))) 

  

    

return the date of Nth day-of-week for a given month and year. 
For example, it will return 26-March-98 for the 4th Thursday of 
March, 1998.   Days-of-week range from 1 to 7, with Sunday = 
1 and Saturday = 7.  

Where Yr, Mon, Nth,  and DoW are cell references or values 
indicating Year, Month, Nth, and Day-Of-Week. 

  

 



233 

 

© พ.ศ.2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ
www.ExcelExpertTraining.com 

27 
=DATE(Yr,1,1+(Nth-(Dow>=WEEKDAY(DATE(Yr,1,1))))*7)+ 
Dow-WEEKDAY(DATE(Yr,1,1)) 

  

    

return the date of Nth day-of-week for a given  year  

Where Yr,Nth, and DoW are cell references or values indicating 
Year, Month, Nth, and Day-Of-Week 

  

 

28 =TRUNC((B1-A1)/7)&" Weeks "&MOD(B1-A1,7)&" Days"   

    จํานวนสปัดาหร์ะหวา่งชว่งเวลาทีѷกําหนด   
 

29 =IF(ISERROR(VLOOKUP(WEEKDAY(A1),WorkDays,1,0)),FALSE,TRUE)   

    ตรวจสอบวา่ เป็นวันทํางานปกตหิรอืไม ่   
 

30 =ROUNDUP(MONTH(A1)/3,0)   

    เลขทีѷไตรมาส   
 

31 
=TRUNC(((A1-DATE(YEAR(A1),1,1))/7))+1+ 
IF(WEEKDAY(DATE(YEAR(A1),1,1))>WEEKDAY(A1),1,0) 

  

    เลขทีѷสปัดาหข์องวันทีѷกําหนด   
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32 =DATE(YEAR(A1)+1,MONTH(A1)+6, DAY(A1)+10)   

    วันทีѷนับถัดไปอกี 1 ปี 6 เดอืน 10 วัน   
 

33 =IF(A1>B1,B1+1-A1,B1-A1)   

    ระยะเวลาระหวา่งชว่งเวลา   
 

34 =TIME(HOUR(A1),MROUND(MINUTE(A1),B1),0)   

    
ปรับเวลา ในเซลล ์A1 เป็นเลขชัѷวโมง ครึѷงชัѷวโมง หรอืสบิหา้นาท ีทีѷใกล ้
ทีѷสดุ 
B1 เป็นเลขนาท ีซึѷงตอ้งการปัดเขา้สู ่

  

 

35 
=TIME(HOUR(A1),FLOOR(MINUTE(A1),B1),0)  

=TIME(HOUR(A1),CEILING(MINUTE(A1),B1),0)  
  

    ปัดเวลาขึѸนลงสูช่ว่งทีѷใกลท้ีѷสดุ   
 

36 =SUMPRODUCT(N(MONTH(A1:A20)=12))   

    นับจํานวนเซลลท์ีѷมวีันทีѷซ ึѷงอยูใ่นเดอืนธันวาคม   
 

37 =SUMPRODUCT((MONTH(A1:A20)=12)*(YEAR(A1:A20)=2000))   
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    นับจํานวนเซลลท์ีѷมวีันทีѷซ ึѷงอยูใ่นเดอืนธันวาคม ปี 2000   
 

3
8 

=SUMPRODUCT(N(A1:A20>DATE(2000,11,15))*N(A1:A20<=DATE(2000,1
2,15)))  

=countif(A1:A20,">=16/11/2000")-countif(A1:A20,">15/12/2000") 

 

    
นับจํานวนเซลลท์ีѷมวีันทีѷซ ึѷงอยูร่ะหวา่งวันทีѷ 16 พฤษจกิายน ถงึวันทีѷ 15 เดอืน
ธันวาคม 

 

 

39 =(A1>B1)+B1-A1   

    หาระยะเวลาระหวา่งเวลาทีѷกําหนด    
 

40 

  A B C 

1 TIME Time สตูรทีѷใช ้

2 1 0:01:00 
=ROUNDDOWN(A2,-2) / 2400 + MOD(A2,100) / 
1440 

3 2 0:02:00 
=ROUNDDOWN(A3,-2) / 2400 + MOD(A3,100) / 
1440 

4 3 0:03:00 
=ROUNDDOWN(A4,-2) / 2400 + MOD(A4,100) / 
1440 
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5 1200 12:00:00 
=ROUNDDOWN(A5,-2) / 2400 + MOD(A5,100) / 
1440 

6 1201 12:01:00 
=ROUNDDOWN(A6,-2) / 2400 + MOD(A6,100) / 
1440 

7 2400 0:00:00 
=ROUNDDOWN(A7,-2) / 2400 + MOD(A7,100) / 
1440 

8 3359 9:59:00 
=ROUNDDOWN(A8,-2) / 2400 + MOD(A8,100) / 
1440 

 

    เปลีѷยนเวลาแบบทหาร เป็น เวลาแบบมาตรฐาน  
 

41 

=INT((A1-(DATE(YEAR(A1+(MOD(8-WEEKDAY(A1),7)-3)),1,1))-3+ 

MOD(WEEKDAY(DATE(YEAR(A1+(MOD(8-WEEKDAY(A1),7)-
3)),1,1))+1,7))/7)+1 

  

    คนืคา่เป็นเลขทีѷสปดาห ์   
 

42 =NOW()+12/24   

    เวลา 12 ชัѷวโมงถัดไปจากเวลาปัจจบุัน (24 ชม / วัน)   
 

43 =NOW()+10/1440   
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    เวลา 10 นาทถีัดไปจากเวลาปัจจบุัน (1440 นาท ี/ วัน)   
 

44 =NOW()+30/86400   

    เวลา 30 วนิาทถีัดไปจากเวลาปัจจบุัน (86400 วนิาท ี/ วัน)   
 

45 
A2: =TODAY()  
B2: =A2-MOD(A2-2,7)  
C2: =B2 

  

    Monday week starting dates   
 

46 

=A2&IF(INT(MOD(A2,100)/10)=1, "th", IF(MOD(A2,10)=1, "st", 
IF(MOD(A2,10)=2,"nd", IF(MOD(A2,10)=3, "rd","th"))))  

=DAY(A2)&IF(INT(MOD(DAY(A2),100)/10)=1, "th", 
IF(MOD(DAY(A2),10)=1, "st", IF(MOD(DAY(A2),10)=2,"nd", 
IF(MOD(DAY(A2),10)=3, "rd","th"))))& " " & TEXT(A2,"mmmm, 
yyyy") 

  

    ตัวเลขและวันทีѷแบบนับมคํีาวา่ st nd rd th ตอ่ทา้ย   
 

47 =MROUND(A22,1/(24*4))    

    Rounding to nearest quarter hour   
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48 =FLOOR(A22,1/(24*4))    

    Rounding down to nearest quarter hour   
 

49 =CEILING(A22,1/(24*4))   

    Rounding Up to nearest quarter hour   
 

50 =TEXT(NOW(),"dd mmmm yyyy")   

    
เปลีѷยนเวลาเป็นรปูแบบตัวอกัษร จะไดจั้ดชดิซา้ยและยดืขา้มขอบขวา
ออกไปได ้

  

 

5
1 

(วันทีѷแสดงในแบบของ US/Canada mm/dd/yyyy)  
   

  
04/14/200
1 

Sat 36995 

 First Day of Week  
04/08/200
1 

Sun =B1-WEEKDAY(B1)+1 

 Last Day of Week  
04/14/200
1 

Sat =B1-WEEKDAY(B1)+7 

 



239 

 

© พ.ศ.2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ
www.ExcelExpertTraining.com 

 First Day of Month 
04/01/200
1 

Sun =DATE(YEAR(B1),MONTH(B1),1) 

 Last Day of Month 
04/30/200
1 

Mo
n 

=DATE(YEAR(B1),MONTH(B1)+1,0
) 

 First Day of Year 
04/01/200
1 

Sun =DATE(YEAR(B1),MONTH(B1),1) 

 Last Day of Year 
12/31/200
1 

Mo
n 

=DATE(YEAR(B1)+1,1,0) 

 Closest Monday 04/16/200
1 

Mo
n 

=DATE(YEAR(B1),MONTH(B1),DAY
(B1) 
+CHOOSE(WEEKDAY(B1),1,0,-1,-
2,-3,3,2,1)) 

 Next Monday 04/16/200
1 

Mo
n 

=DATE(YEAR(B1),MONTH(B1),DAY
(B1) 
+CHOOSE( 
WEEKDAY(B1),1,7,6,5,4,3,2)) 

 Next Monday 04/16/200
1 

Mo
n 

=A1-WEEKDAY(A1,2)+8 

 1st Monday of 
Month 

04/02/200
1 

Mo
n 

=DATE(YEAR(B1),MONTH(B1), 
CHOOSE(WEEKDAY(DATE(YEAR(B
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1), 
MONTH(B1),1)),2,1,7,6,5,4,3)) 

 2nd Monday of Mon
th  

04/09/200
1 

Mo
n 

=DATE(YEAR(B1),MONTH(B1),7 
+CHOOSE(WEEKDAY(DATE(YEAR(
B1), 
MONTH(B1),1)),2,1,7,6,5,4,3)) 

 3rd Monday of 
Month 

04/16/200
1 

Mo
n 

=DATE(YEAR(B1),MONTH(B1),14 
+CHOOSE(WEEKDAY(DATE(YEAR(
B1), 
MONTH(B1),1)),2,1,7,6,5,4,3)) 

 4th Monday of 
Month 

04/23/200
1 

Mo
n 

=DATE(YEAR(B1),MONTH(B1),21 
+CHOOSE(WEEKDAY(DATE(YEAR(
B1), 
MONTH(B1),1)),2,1,7,6,5,4,3)) 

 5th Monday of 
Month 

04/30/200
1 

Mo
n 

=IF(MONTH(DATE(YEAR(B1), 
MONTH(B1),28+ 
CHOOSE(WEEKDAY(DATE(YEAR(B
1), 
MONTH(B1),1)),2,1,7,6,5,4,3)))= 
MONTH(B1),DATE(YEAR(B1), 
MONTH(B1),28 
+CHOOSE(WEEDATE(YEAR(B1), 
MONTH(B1),1)), 
2,1,7,6,5,4,3)),"none") 
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 Last Monday of 
Month 

04/30/200
1 

Mo
n 

=DATE(YEAR($B$1), 
MONTH($B$1)+1,1)- 
WEEKDAY(DATE(YEAR($B$1), 
MONTH($B$1)+1,6)) 

 For a different day of the week rotate the 2nd to last parameters in 
CHOOSE. 
   i.e. 7,6,5,4,3,2,1 for Wednesday instead of 2,1,7,6,5,4,3 for Monday as 
used in some of the formulae. 

 Formula in C1 & D1, downward   =IF(ISNUMBER(B1),WEEKDAY(B1)
,"") 

 

       
 

5
2 

   

A B E 

Dates 
 format 
mm/dd/yyy
y 

สตูรทีѷใช ้

First ddd 
of Month 

03/01/199
9 

=DATE(YEAR(B18),MONTH(B18),1) 
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Last ddd 
of Month 

03/31/199
9 

=DATE(YEAR($B$18),MONTH($B$18)+1,1)-1 

First 
Sunday of 
Mo. 

03/07/199
9 

=DATE(YEAR($B$18),MONTH($B$18),1)+ 
MOD(1+7-
WEEKDAY(DATE(YEAR($B$18),MONTH($B$18),1
)),7) 

First 
Monday 

03/01/199
9 

=DATE(YEAR($B$18),MONTH($B$18),1)+ 
MOD(2+7-
WEEKDAY(DATE(YEAR($B$18),MONTH($B$18),1
)),7) 

First 
Tuesday 

03/02/199
9 

=DATE(YEAR($B$18),MONTH($B$18),1)+ 
MOD(3+7-
WEEKDAY(DATE(YEAR($B$18),MONTH($B$18),1
)),7) 

First 
Wednesda
y 

03/03/199
9 

=DATE(YEAR($B$18),MONTH($B$18),1)+ 
MOD(4+7-
WEEKDAY(DATE(YEAR($B$18),MONTH($B$18),1
)),7) 

First 
Thursday 

03/04/199
9 

=DATE(YEAR($B$18),MONTH($B$18),1)+ 
MOD(5+7-
WEEKDAY(DATE(YEAR($B$18),MONTH($B$18),1
)),7) 
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First 
Friday 

03/05/199
9 

=DATE(YEAR($B$18),MONTH($B$18),1)+ 
MOD(6+7-
WEEKDAY(DATE(YEAR($B$18),MONTH($B$18),1
)),7) 

First 
Saturday 

03/06/199
9 

=DATE(YEAR($B$18),MONTH($B$18),1)+ 
MOD(7+7-
WEEKDAY(DATE(YEAR($B$18),MONTH($B$18),1
)),7) 

Last 
Sunday of 
Mo. 

03/28/199
9 

=DATE(YEAR($B$18),MONTH($B$18)+1,1)- 
WEEKDAY(DATE(YEAR($B$18),MONTH($B$18)+
1,7)) 

Last 
Monday 

03/29/199
9 

=DATE(YEAR($B$18),MONTH($B$18)+1,1)- 
WEEKDAY(DATE(YEAR($B$18),MONTH($B$18)+
1,6)) 

Last 
Tuesday 

03/30/199
9 

=DATE(YEAR($B$18),MONTH($B$18)+1,1)- 
WEEKDAY(DATE(YEAR($B$18),MONTH($B$18)+
1,5)) 

Last 
Wednesda
y 

03/31/199
9 

=DATE(YEAR($B$18),MONTH($B$18)+1,1)- 
WEEKDAY(DATE(YEAR($B$18),MONTH($B$18)+
1,4)) 
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Last 
Thursday 

03/25/199
9 

=DATE(YEAR($B$18),MONTH($B$18)+1,1)- 
WEEKDAY(DATE(YEAR($B$18),MONTH($B$18)+
1,3)) 

Last 
Friday 

03/26/199
9 

=DATE(YEAR($B$18),MONTH($B$18)+1,1)- 
WEEKDAY(DATE(YEAR($B$18),MONTH($B$18)+
1,2)) 

Last 
Saturday 

03/27/199
9 

=DATE(YEAR($B$18),MONTH($B$18)+1,1)- 
WEEKDAY(DATE(YEAR($B$18),MONTH($B$18)+
1,8)) 

Last 
weeknum  
of yr 

53 =WEEKNUM(DATE(YEAR(B18),12,31),1) 
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53 

   

Description สตูร 

The date for 
Monday in the 
previous week 

=TODAY()-WEEKDAY(TODAY(),2)-6 

The date for 
Monday in the 
current week 

=TODAY()-WEEKDAY(TODAY(),2)+1 

The date for 
Monday in the next 
week 

=TODAY()-WEEKDAY(TODAY(),2)+8 

Create a valid date =DATE(2002,12,24) 

Create a valid date =DATEVALUE("1.1.1980") 

Count of days in a 
month 

=DAY(DATE(YEAR(A1),MONTH(A1)+1,0)) 

Last date in a 
month 

=DATE(YEAR(A1),MONTH(A1)+1,0) 

  



246 

 

© พ.ศ.2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ
www.ExcelExpertTraining.com 

Determine which 
quarter a date 
belongs to 

=CHOOSE(MONTH(A1),1,1,1,2,2,2,3,3,3,4,4,4) 

 

        
 

54 

=DAY(A1)&IF(INT(MOD(DAY(A1),100)/10)=1, "th", 
IF(MOD(DAY(A1),10)=1, "st",IF(MOD(DAY(A1),10)=2,"nd", 
IF(MOD(DAY(A1),10)=3, "rd","th"))))& " " &TEXT(A1,"mmmm, 
yyyy") 

  

    Ordinal Date   
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List & Database Formulas 

1 =INDEX(Rng,MATCH(MAX(COUNTIF(Rng,Rng)),COUNTIF(Rng,Rng),0))   

    แสดงคา่ทีѷใชบ้อ่ยทีѷสดุ   
 

2 =INDEX(Rng,MATCH(MIN(COUNTIF(Rng,Rng)),COUNTIF(Rng,Rng),0))   

    แสดงคา่ทีѷใชน้อ้ยครั Ѹงทีѷสดุ   
 

3 

=INDIRECT(ADDRESS(ROW(Rng)+MATCH(C1,Rng,0)-1,COLUMN(Rng)-
ColsToLeft)) Or  
=INDIRECT(ADDRESS(ROW(Rng)+MATCH(C1,Rng,0)-1,COLUMN(A:A) 
)) 

  

    Left Lookups   
 

4 =IF(MAX(COUNTIF(Range1,Range1))>1,"Duplicates","No Duplicates")   

    ตรวจสอบคา่ซํѸา   
 

5 =IF(COUNTIF(Range1, A5)>1,TRUE,FALSE)   

    ตรวจสอบคา่ซํѸา   
 



248 

 

© พ.ศ.2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ
www.ExcelExpertTraining.com 

6 =IF(COUNTIF(Range1,???)>1,"Duplicate","")   

    ตรวจสอบคา่ซํѸา   
 

7 =COUNTIF($A:$A,$A1)>1   

     ตรวจสอบคา่ซํѸาในแถวตั Ѹง   
 

8 

=SUM(N(OFFSET(E1,ROW(1:5)-1,-1*ROW(1:5)+1)))  

=SUMPRODUCT(N(OFFSET(E1,ROW(INDIRECT("1:5"))-1,-
1*ROW(INDIRECT("1:5"))+1))) 

=SUM(N(OFFSET(E1,ROW(INDIRECT("1:5"))-1,-
1*ROW(INDIRECT("1:5"))+1)))  

  

    sum A5:E1 ตามแนวทะแยงมมุ   
 

9 

=INDEX(Range2,MATCH(Value,Range1,0))  

=LOOKUP(Value,Range1,Range2) 

=VLOOKUP(Value,Range12,2,FALSE) 

  

    สตูรคน้หาคา่   
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Conditional Formatting & Data 
Validation Formulas 

Conditional Formatting   
 

1 =MOD(ROW()-Rw,N*2)+1<=N   

    
กําหนดรปูแบบใหเ้ป็นแถบแบบเลขคีѷ  
Rw เป็นเลขทีѷบรรทัดแรก 
N เป็นจํานวนบรรทัดในแตล่ะแถบ 

  

 

2 =MOD(ROW()-Rw,N*2)+1>N   

    
กําหนดรปูแบบใหเ้ป็นแถบแบบเลขคู ่ 
Rw เป็นเลขทีѷบรรทัดแรก 
N เป็นจํานวนบรรทัดในแตล่ะแถบ 

  

 

3 =ISERROR(cell_reference)   

    กําหนดรปูแบบใหก้บัเซลลท์ีѷเป็น Error Values    
 

4 =ISTEXT(A1)   

    เซลลซ์ึѷงไมใ่ชต่ัวเลข   
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5 =A1>AVERAGE($A$1:$D$12)   

    เซลลซ์ึѷงมคีา่เกนิกวา่คา่เฉลีѷย   
 

6 =MONTH(A1)=6   

    เซลลซ์ึѷงเป็นเดอืนมถินุายน   
 

7 =A1=TODAY()   

    เซลลซ์ึѷงเป็นวันนีѸ   
 

8 =IF(ISBLANK(A1),"",OR(WEEKDAY(A1)=7,WEEKDAY(A1)=1))   

    เซลลซ์ึѷงเป็นวันเสารอ์าทติย ์   
 

9 =A1=MAX($A$1:$A$30)   

    เซลลซ์ึѷงมคีา่สงูสดุ   
 

10 
=OR( A1=LARGE($A$1:$A$30,1), A1=LARGE($A$1:$A$30,2), 
A1=LARGE($A$1:$A$30,3) ) 

  

    เซลลซ์ึѷงมคีา่สงูสดุ 3 ลําดับแรก   
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11 =MOD(ROW(),2)=0   

    row เลขคู ่   
 

12 =MOD(INT((ROW()-1)/4)+1,2)   

    row ชดุละ 4 row   
 

13 =MOD(ROW(),2)=MOD(COLUMN(),2)   

    row เลขคู ่และเป็น column เลขคู ่   
 

14 =IF(COUNTIF($A$1:$D$12,A1)>1,TRUE,FALSE)   

    เซลลซ์ึѷงมคีา่ซํѸา   
 

15 =A2<A1   

    เซลลซ์ึѷงไมไ่ดเ้รยีงลําดับ   
 

16 
=LEN( SUBSTITUTE(TRIM(A1), CHAR(32), CHAR(32)&CHAR(32)) )-
LEN(TRIM(A1))+1>1 

  

    เซลลซ์ึѷงมคํีามากกวา่ 1 คํา   
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17 =LEN(A3)-LEN(SUBSTITUTE(SUBSTITUTE(A3,"A",""),"a",""))>0   

    เซลลซ์ึѷงมตีัวอกัษรตัว a   
 

18 =AND($B$1:$B$4<>"")   

    เมืѷอเซลลอ์ืѷนมคีา่ครบแลว้   
 

1
9 

=MATCH($A1&$B1&$C1&$D1,$F$6:$F$15&$G$6:$G$15&$H$6:$H$15&$I$
6:$I$15,0)>=1 

 

    
เซลลซ์ึѷงมคีา่ตรงกบัคา่ในตารางทกุ column $F$6:$F$15 และ $G$6:$G$15 
และ $H$6:$H$15 และ $I$6:$I$15 

 

 

Data Validation   
 

1 =COUNTIF($A$1:$A$50,A1)=1   

    ป้องกนัการบันทกึขอ้มลูซํѸา   
 

2 =ISNA(VLOOKUP(A9,A$1:A8,1,FALSE))   

    ป้องกนัการบันทกึขอ้มลูซํѸากบัขอ้มลูบรรทัดเหนอืขึѸนไป   
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3 =ISTEXT(A5)   

    รับเฉพาะตัวอกัษร   
 

4 =A2>A1   

    รับคา่ซึѷงมากขึѸน   
 

5 =LEFT(A2)="a"   

    รับคา่ซึѷงนําดว้ยตัว a   
 

6 =COUNTIF(A3,"A????")=1   

    รับคา่ซึѷงนําดว้ยตัว a และม ี5 ตัวอกัษร   
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Array Formulas 

สตูร Array ตอ่ไปนีѸตอ้งสรา้งขึѸนโดยกดปุ่ ม Ctrl+Shift+Enter จะเกดิเครืѷองหมายวงเล็บปีก
กาปิดหัวทา้ยสตูร ซึѷงสามารถใชก้บั Excel ไดท้กุรุน่ 

1 

=SUM(IF(List>0,List,FALSE))  

=AVERAGE(IF(List>0,List,FALSE)) 
 
=MIN(IF(List>0,List,FALSE)) 

=MAX(IF(List>0,List,FALSE)) 

  

    
หาผลลัพธเ์ฉพาะคา่บวกเทา่นัѸน สามารถละไมต่อ้งใส่

คําวา่ FALSE ในสตูร 
  

 

2 

=SUM(IF(List<>0,List,FALSE))  

=AVERAGE(IF(List<>0,List,FALSE)) 

=MIN(IF(List<>0,List,FALSE)) 
 
=MAX(IF(List<>0,List,FALSE)) 

  

    
หาผลลัพธเ์ฉพาะคา่ทีѷไมเ่ทา่กบั 0 เทา่นัѸน สามารถละ
ไมต่อ้งใสคํ่าวา่ FALSE ในสตูร 
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3 

=SUM(IF((List>=LLim)*(List<=ULim),List,FALSE)) 
 
=AVERAGE(IF((List>=LLim)*(List<=ULim),List,FALSE))  

=MIN(IF((List>=LLim)*(List<=ULim),List,FALSE)) 
 
=MAX(IF((List>=LLim)*(List<=ULim),List,FALSE)) 

  

    

หาผลลัพธเ์ฉพาะคา่ทีѷอยูร่ะหวา่ง LLim ถงึ ULim สามารถ
ละไมต่อ้งใสคํ่าวา่ FALSE ในสตูร  

LLim เป็นขดีจํากดัลา่ง, ULim เป็นขดีจํากดับน 

  

 

4 

=IF(A1=B1,1,0)  

=SUM(IF(A1:A10=B1:B10,1,0)) 

=SUM((A2:A10="Phone")*(B2:B10="Smith")*C2:C10) 

=SUM(IF((A2:A10="Fax")+(B2:B10="Jones"),1,0)) 

=SUM(IF(MOD((A2:A10="Fax")+(B2:B10="Jones"),2),1,0)) 

=SUM(IF((A2:A10="Fax")+(B2:B10="Jones")<>2,1,0) 

  

    

นับจํานวนเซลลต์ามเงืѷอนไข โดยใชส้ตูร SUM ตัวเลข 1 โดย
ไมต่อ้งใชส้ตูร COUNT  

สงัเกตการใชเ้ครืѷองหมายบวก หรอื เครืѷองหมายคณู 

  

 

5 =SUM((Month="Jan")*(Region="North")*Sales)   
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รวมคา่ของ Sales ในตําแหน่งซึѷง Month="Jan" AND 
Region="North" 

  

 

6 =SUM((Month="Jan")*(Region<>"North")*Sales)   

    
รวมคา่ของ Sales ในตําแหน่งซึѷง Month="Jan" AND 
Region<>"North" 

  

 

7 =SUM((Month="Jan")*(Region="North"))   

    
นับคา่ของ Sales ในตําแหน่งซึѷง Month="Jan" และ 
Region="North" 

  

 

8 =SUM((Month="Jan")*(Sales>=200)*(Sales))   

    
รวมคา่ของ Sales ในตําแหน่งซึѷง Month="Jan" และ 
Sales>= 200 

  

 

9 =SUM((Sales>=300)*(Sales<=400)*(Sales))   

    รวมคา่ของ Sales ระหวา่ง 300 ถงึ 400   
 

10 =SUM((Sales>=300)*(Sales<=400))   

    นับคา่ของ Sales ระหวา่ง 300 ถงึ 400   
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11 =SUM((A1:A10>=5)*(A1:A10<=10)*A1:A10)   

    รวมคา่ระหวา่ง 5 ถงึ 10   
 

12 =SUM((A1:A10>=5)*(A1:A10<=10))   

    นับจํานวนเซลลท์ีѷมคีา่ระหวา่ง 5 ถงึ 10   
 

13 

สตูรนับ คนืคา่ 

=SUM((F4:F23="yes")+(F4:F23="no")) 
นับจํานวนเซลล์
ทีѷมคํีาวา่ yes 
หรอื no 

=SUM(MOD(G4:G23,2)) 
นับจํานวนเซลล์
ทีѷมเีลขคีѷ 

=SUM(IF(MOD(G4:G23,2)=0,1,0)) 
นับจํานวนเซลล์
ทีѷมเีลขคู ่

=SUM(IF((F4:F23="yes")*(G4:G23>10),1,0))
นับจํานวนเซลล์
แบบและ 

=SUM((F5:F24="yes")*(G5:G24>10)) 
นับจํานวนเซลล์
แบบและ 

  



258 

 

© พ.ศ.2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ
www.ExcelExpertTraining.com 

=SUM((F4:F23="yes")+(F4:F23="no")) 
นับจํานวนเซลล์
แบบหรอื 

 

    
สงัเกตวา่คํานวณแบบหรอื ใชเ้ครืѷองหมายบวก สว่นแบบและ ใช ้

เครืѷองหมายคณู 
  

 

14 

=SUM(IF(MOD(ROW($A$1:$A$20),N)=0,$A$1:$A$20,0))  

=SUM(IF(MOD(ROW($B$3:$B$22)-
ROW($B$3)+1,N)=0,$B$3:B$20,0)) 

=SUM(IF(MOD(ROW($B$3:$B$22)-
ROW($B$3),N)=0,$B$3:B$22,0)) 

  

    รวมคา่ทกุๆตําแหน่งทีѷ N ตรงกนั   
 

15 =IF(COUNTIF($A$1:A1,A1)=1,A1,"")   

    แยกขอ้มลูทีѷไมซ่ํѸาออกมาแสดง   
 

16 =IF(COUNTIF($A$1:$A$10,B1)>0,B1,"")   

    แยกขอ้มลูทีѷซํѸากนัจากตารางตา่งกนัออกมาแสดง   
 

17 =IF(COUNTIF($A$1:$A$10,B1)=0,B1,"")   
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แยกขอ้มลูทีѷอยูใ่นตารางหนึѷง ซึѷงไมซ่ํѸากบัขอ้มลูในอกี
ตารางออกมาแสดง 

  

 

18 =AVERAGE(IF((A1:A60>=Low)*(A1:A60<=High),A1:A60))   

    เฉลีѷยคา่ทีѷอยูร่ะหวา่ง Low ถงึ High   
 

19 
=AVERAGE(LARGE(A1:A60,ROW(1:10)))  

=AVERAGE(LARGE(A1:A60,ROW(INDIRECT("1:10")))) 
  

    

เฉลีѷยคา่ทีѷมากทีѷสดุ 10 อนัดับแรก  

ใหเ้ปลีѷยน "1:10" เป็น "1:N" เพืѷอกําหนด N ลําดับแรกทีѷ
ตอ้งการ 

  

 

20 =AVERAGE(SMALL(A1:A60,ROW(INDIRECT("1:10"))))   

    

เฉลีѷยคา่ทีѷนอ้ยทีѷสดุ 10 อนัดับแรก  

ใหเ้ปลีѷยน "1:10" เป็น "1:N" เพืѷอกําหนด N ลําดับแรกทีѷ
ตอ้งการ 

  

 

21 =SUM(IF(ISERR(data),1,0))   

    นับจํานวนเซลลท์ีѷมคีา่ error   
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22 

สตูร คนืคา่ 

=SUM(E4:E13*F4,F13) 
รวมผลคณูของ
ตาราง E4:E13 คณู
ดว้ย F4:F13 

=SUM((E4:E23)*(MOD(ROW(E4:E23) 
-ROW(E4),2)=0)) 

รวมคา่แบบบรรทัด
เวน้บรรทัด 

=SUM((E4:E23)*(MOD(ROW(E4:E23) 
-ROW(E4),5)=0)) 

รวมคา่ทกุๆบรรทัดทีѷ 
5 ของแตล่ะชดุ 

=SUM(IF(MOD(I4:I23;2)=0,I4:I23,0)) 
รวมคา่เฉพาะคา่ทีѷ
เป็นเลขคู ่

=SUM(IF(MOD(I4:I23,2)<>0,I4:I23,0)) 
รวมคา่เฉพาะคา่ทีѷ
เป็นเลขคีѷ 

=SUM(IF((E4:E23>50)*(H4:H23="North"),
E4:E23,0)) 

รวมคา่เฉพาะคา่
แบบและ 

=SUM((E5:E24>50)*(H5:H24="North") 
*E5:E24,0) 

รวมคา่เฉพาะคา่
แบบและ 

=SUM((H4:H23="North")*E4:E23 
+(H4:H23="South")*E4:E23) 

รวมคา่เฉพาะคา่
แบบหรอื 
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23 =OFFSET(List,MAX(ROW(RevList))-ROW(),0)    

    กลับลําดับคา่ในแนวตั Ѹง   
 

24 
=OFFSET(RowList,0,MAX(COLUMN(RevRowList))-
COLUMN()) 

  

    

กลับลําดับคา่ในแนวนอน  

RowList เป็นตารางขอ้มลูเดมิตามแนวนอน, 
RevRowList เป็นตารางเก็บคา่ทีѷจัดลําดับกลับขา้ง 

  

 

25 

=OFFSET(CList,COLUMN()-MIN(COLUMN(RList)),0) 

=OFFSET(CList,MAX(COLUMN(RevRList))-
COLUMN(),0) 

  

    
ตะแคงตารางแนวตั Ѹง CList เป็นแนวนอน RList  

RevRList เป็นตารางแนวตั Ѹงทีѷสลับคา่ 
  

 

26 

=OFFSET(RowList,0,ROW()-MIN(ROW(TXList)))  

=OFFSET(RowList,0,MAX(ROW(TList))-ROW()) 
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ตะแคงตารางแนวนอน RowList เป็นแนวตั Ѹง TXList  

TList เป็นตารางแนวนอนทีѷสลับคา่ 
  

 

2
7 

=ADDRESS(MIN(IF(NumRange=MIN(NumRange),ROW(NumRange))
), COLUMN(NumRange),4) 

 

    Address ของคา่ทีѷนอ้ยทีѷสดุคา่แรก  
 

2
8 

=ADDRESS(MAX(IF(NumRange=MIN(NumRange),ROW(NumRange)
* (NumRange<>""))), 
COLUMN(NumRange),4) 

 

    Address ของคา่ทีѷนอ้ยทีѷสดุคา่สดุทา้ย  
 

2
9 

=ADDRESS(MIN(IF(NumRange=MAX(NumRange),ROW(NumRange)
)), COLUMN(NumRange),4) 

 

    Address ของคา่ทีѷมากทีѷสดุคา่แรก  
 

3
0 

=ADDRESS(MAX(IF(NumRange=MAX(NumRange),ROW(NumRange)
* (NumRange<>""))),COLUMN(NumRange),4) 

 

    Address ของคา่ทีѷมากทีѷสดุคา่สดุทา้ย  
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3
1 

=INDEX(Rng,MATCH(MAX(COUNTIF(Rng,Rng)),COUNTIF(Rng,Rng),
0))  

 

    คา่ทีѷใชซ้ํѸามากทีѷสดุ  
 

32 
=(MAX((DataRange2<>"")*ROW(DataRange2)))-
ROW(DataRange2)+1 

  

    นับจํานวนบรรทัดทีѷมขีอ้มลู   
 

3
3 

=INDIRECT(ADDRESS(MAX((DataRange2<>"")*ROW(DataRange2))
, 
COLUMN(DataRange2),4)) 

 

    คนืคา่สดุทา้ยลา่งสดุในแถวตั Ѹงแถวแรก  
 

3
4 

=INDIRECT(ADDRESS(MAX((DataRange2<>"")*ROW(DataRange2))
, 
COLUMN(DataRange2)+1,4)) 

 

    คนืคา่สดุทา้ยลา่งสดุในแถวตั Ѹงแถวทีѷสอง  
 

3
5 

=SUM(IF(FREQUENCY(IF(LEN(Range1)>0,MATCH(Range1,Range1,0
),""), 
IF(LEN(Range1)>0,MATCH(Range1,Range1,0),""))>0,1)) 
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    นับจํานวนคา่ทีѷเป็น Unique   
 

36 =SUM(1/COUNTIF(A1:A10,A1:A10))   

    นับจํานวนคา่ทีѷเป็น Unique กรณีไมม่ ีblank   
 

37 =SUM(N(FREQUENCY(A1:A10,A1:A10)>0))   

    
นับจํานวนคา่ทีѷเป็น Unique ใชก้บัตารางตัวเลขหรอื
เซลลว์า่ง 

  

 

38 
=ADDRESS(ROW(DataRange2),COLUMN(DataRange2),4)&":"& 
ADDRESS(MAX((DataRange2<>"")*ROW(DataRange2)), 
COLUMN(DataRange2)+COLUMNS(DataRange2)-1,4) 

  

    
แสดง range ทีѷมขีอ้มลู data เชน่ DataRange2 เป็นตารางขอ้มลู 
H7:I25 โดยเซลล ์H7:I17 มตีัวเลขอยู ่นอกจากนัѸนเป็นเซลลว์า่ง 

  

 

39 

=RIGHT(A1,LEN(A1)-
MAX(ROW(INDIRECT("1:"&LEN(A1))) 
*(MID(A1,ROW(INDIRECT("1:"&LEN(A1))),1)=" 
"))) 

  

    แสดงคําสดุทา้ยขวาสดุ   
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40 

=MID(A10,SMALL(IF(MID(" "&A10,ROW(INDIRECT 
("1:"&LEN(A10)+1)),1)=" 
",ROW(INDIRECT("1:"&LEN(A10)+1))), 
B10),SUM(SMALL(IF(MID(" "&A10&" ",ROW(INDIRECT 
("1:"&LEN(A10)+2)),1)=" 
",ROW(INDIRECT("1:"&LEN(A10)+2))), 
B10+{0,1})*{-1,1})-1) 

  

    แยกคําออกจากประโยค ซึѷงมเีครืѷองหมายวรรคแยกแตล่ะคํา   
 

41 

=MID(A10,SMALL(IF(MID(" "&A10,ROW(INDIRECT 
("1:"&LEN(A10)+1)),1)=" 
",ROW(INDIRECT("1:"&LEN(A10)+1))), 
B10),SUM(SMALL(IF(MID(" "&A10&" ",ROW(INDIRECT 
("1:"&LEN(A10)+2)),1)=" 
",ROW(INDIRECT("1:"&LEN(A10)+2))), 
B10+C10*{0,1})*{-1,1})-1) 

  

    

แยกคําลําดับทีѷตอ้งการออกจากประโยค  

A10 เป็นประโยคทีѷมคํีาอยู ่
B10 เป็นเลขทีѷคําเริѷมตน้ทีѷตอ้งการ 
C10 เป็นจํานวนคําทีѷตอ้งการ เริѷมตน้จาก B10 

  

 

42 
=SUM(IF(WEEKDAY(A2-1+ROW(INDIRECT("1:"&TRUNC(B2-
A2)+1)))=C2,1,0)) 

  

    นับจํานวนวันจันทรห์รอืวันอืѷนๆ จากชว่งเวลาทีѷกําหนด    
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A2 เป็นวันเริѷมตน้ 
B2 เป็นวันสิѸนสดุ 
C2 เป็นเลขทีѷของวันในสปัดาห ์(1=Sunday, 
2=Monday,...,7=Saturday) 

 

43 

=IF(ROW()-ROW(NoBlanksRange)+1>ROWS(BlanksRange)-  
COUNTBLANK(BlanksRange),"",INDIRECT(ADDRESS(SMALL( 
(IF(BlanksRange<>"",ROW(BlanksRange),ROW()+ 
ROWS(BlanksRange))), 
ROW()-ROW(NoBlanksRange)+1),COLUMN(BlanksRange),4))) 

  

    
ตัดเซลลว์า่งออกจากตาราง BlanksRange ใหเ้ป็นตารางใหม ่
NoBlanksRange เหลอืเฉพาะเซลลท์ีѷมคีา่เทา่นัѸน  

  

 

44 
=SUM(IF(IF(B$5>=F6:F10,F6:F10-F5:F9,$B$5-F5:F9+1)>0, 
IF(B$5>=F6:F10,F6:F10-F5:F9,$B$5-F5:F9+1),0)*G5:G9) 

  

    

Progressive Pricing คํานวณจํานวนเงนิทั Ѹงหมด ใชห้ลัก FIFO 

สตูรนีѸมปีระโยชนอ์ยา่งมาก ใชก้บัปัญหาอืѷนๆ เชน่ อตัราภาษีแบบ
กา้วหนา้ การตัด Stock แบบ FIFO 

  E F G H 

4   Quantity UnitPrice   

5   1 5   

  



267 

 

© พ.ศ.2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ
www.ExcelExpertTraining.com 

6   10 4   

7   30 3   

8   60 2   

9   100 1   

10   9999999     

11         

 

 
    

 

 

4
5 

  A B C D E 

1 Part# ALPHA 
portio
n 

NUMERI
C 
portion 

    

2 ab2 ab 2 

{=LEFT(A2, 
MIN(IF(ISNUMBER( 
MID(A2,{1,2,3,4,5,6},1
) *1),{1,2,3,4,5,6},7))-
1)} 

=RIGHT(A2
, LEN(A2) -
LEN(B2))*1
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3 OP30 OP 30 

{=LEFT(A6, 
MIN(IF(ISNUMBER( 
MID(A3,{1,2,3,4,5,6},1
) *1),{1,2,3,4,5,6},7))-
1)} 

=RIGHT(A3
, LEN(A6) -
LEN(B6))*1

4 
OP122
1 

OP 1221 

{=LEFT(A8, 
MIN(IF(ISNUMBER( 
MID(A4,{1,2,3,4,5,6},1
) *1),{1,2,3,4,5,6},7))-
1)} 

=RIGHT(A4
, LEN(A8) -
LEN(B8))*1

 

    แยกคําทีѷเป็นตัวอกัษรออกจากตัวเลข  
 

46 

=INDIRECT(ADDRESS( ROW(MyRange) +INT((ROW() -
ROW(CxRV))/COLUMNS(MyRange)), 
COLUMN(MyRange)+MOD(ROW() -ROW(CxRV), 
COLUMNS(MyRange)),4,,"Sheet1"))  

=INDIRECT(ADDRESS( ROW(MyRange) +MOD(ROW() -
ROW(CxCV),ROWS(MyRange)), 
COLUMN(MyRange)+INT((ROW() -
ROW(CxCV))/ROWS(MyRange)), 4,,"Sheet1")) 

=INDIRECT(ADDRESS( ROW(MyRange) +INT((COLUMN() -
COLUMN(RxRV))/COLUMNS(MyRange)), 
COLUMN(MyRange)+MOD(COLUMN() -COLUMN(RxRV), 
COLUMNS(MyRange)), 4,,"Sheet1")) 
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=INDIRECT(ADDRESS( ROW(MyRange) +MOD(COLUMN() -
COLUMN(RxCV),ROWS(MyRange)), 
COLUMN(MyRange)+INT((COLUMN() -
COLUMN(RxCV))/ROWS(MyRange)),4,,"Sheet1"))  

    

ตะแคงตารางเป็นแนวตั Ѹง  

MyRange เป็นตารางขอ้มลู มขีนาด M rows และ N 
columns 

CxRV เป็นตารางผลลัพธ ์
 

  

 

47 

=OFFSET($B$5,MIN(IF(COUNTIF($G$11:G11,$B$5:$GR$10)=0, 
ROW($B$5:$GR$10)- 
ROW($B$5))),MOD(MIN(IF(COUNTIF($G$11:G11,$B$5:$GR$10)=0, 
ROW($B$5:$GR$10)- ROW($B$5) +(COLUMN($B$5:$GR$10)-
COLUMN($B$5))/1000)),1)*1000)  

=INDEX(tbl,MIN(IF(COUNTIF($A$1:A1,tbl)=0,ROW(tbl)- 
MIN(ROW(tbl))+1)), 
MATCH(0,COUNTIF($A$1:A1,INDEX(tbl,MIN(IF( 
COUNTIF($A$1:A1,tbl)=0,ROW(tbl) -MIN(ROW(tbl))+1)),,1)),0),1)  

  

 

    list of unique entries in an n * m array   
 

48 =AND(NOT(ISNA(MATCH(Range1,Range2,0))))    
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    ตรวจสอบวา่ขอ้มลูใน Range1 แสดงใน Range2   
 

49 

=MMULT(N(ROW(INDIRECT("1:"&ROWS(A)))=TRANSPOSE( 
ROWS(A)+1-ROW(INDIRECT("1:"&ROWS(A))))),A)  

=MMULT(A,N(ROW(INDIRECT("1:"&COLUMNS(A)))=TRANSPOSE 
(COLUMNS(A)+1-ROW(INDIRECT("1:"&COLUMNS(A))))))  

 

    กลับขา้งตาราง  
 

50 
=OR(A1=2,A1=3,ISNA(MATCH(TRUE,A1/ROW(INDIRECT( 
"2:"&INT(SQRT(A1))))= 
INT(A1/ROW(INDIRECT("2:"&INT(SQRT(A1))))),0)))  

  

    ตรวจสอบวา่เป็นตัวเลข prime number   
 

51 =MATCH(TRUE,EXACT("A",MyRange),0)    

    case-sensitive MATCH    
 

52 

17 = 5x + 3y + 2z  
13 = 2x + 4y + z  
22 = 3x + 2y + 5z  

Put the coefficients of the unknowns in, e.g., A1:C3 (i.e., 5,3,2 in 
A1:C1, 2,4,1 in A2:C2, etc.);  
Put the constants (17, 13, 22) in, e.g., D1:D3;  
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Highlight, e.g., E1:E3 and array enter (i.e., enter with 
Ctrl+Shift+Enter instead of just Enter)  

=MMULT(MINVERSE(A1:C3,D1:D3)  

and the solution vector (1,2,3) will appear in E1:E3; i.e., x=1, 
y=2, z=3 For a set of equations that does not have a solution, 
the #VALUE error will appear in E1:E3.  

    solve a set of simultaneous equations    
 

53 
=SUM(N(MATCH(MID(A1,ROW(INDIRECT("1:"&LEN(A1))),1), 
MID(A1,ROW(INDIRECT 
("1:"&LEN(A1))),1),0)=ROW(INDIRECT("1:"&LEN(A1)))))=LEN(A1) 

 

    ตรวจสอบวา่ตัวอกัษรในเซลลม์ซีํѸากนัหรอืไม ่  
 

54 
=SUM(VALUE(MID(A1,ROW(INDIRECT("1:"&LEN(A1))),1))*10 
^(ROW(INDIRECT ("1:"&LEN(A1)))-1))  

  

    กลับขา้งหลักตัวเลข   
 

55 

A1:D1 = {1,2,3,4}  
A5:D5 = {5,6,7,5}  
=SUM({1,2,3,4}*{5,7,6,5}) = 57  
=SUM(A1:D1*INDEX(A5:D5,5-COLUMN(A5:D5))) 
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สตูรเพีѸยนโดยไมท่ราบสาเหต ุเมืѷอสรา้งสตูรสดุทา้ยลงในเซลลเ์ดยีวจะ
คํานวณผดิ ตอ้งสรา้งสตูรลงในเซลล ์2 เซลล ์

  

 

56 
=ROWS(iRng)-
ROW(OFFSET($A$1,,,ROWS(iRng),)). 

  

    กลับตําแหน่งเซลล ์   
 

57 

=IF(T(OFFSET(iRng,ROWS(iRng)-
ROW(OFFSET($A$1,,,ROWS(iRng),)),,,))="",N 
(OFFSET(iRng,ROWS(iRng)-
ROW(OFFSET($A$1,,,ROWS(iRng),)),,,)),T(OFFSET 
(iRng,ROWS(iRng)-ROW(OFFSET($A$1,,,ROWS(iRng),)),,,)))  

  

    กลับตารางแนวตั Ѹง   
 

58 
=LARGE(IF(MATCH(Rng,Rng,0)=ROW(Rng)-
MIN(ROW(Rng))+1,Rng,""),N) 

  

    Nth largest unique value in a column range   
 

59 
=SUM(N(FREQUENCY(IF(lookupRange="specifStr", 
MATCH(colRange,colRange,0)), MATCH(colRange,colRange,0))0))  

  

    นับจํานวนขอ้มลู unique ซึѷงมตีัวอกัษรตามกําหนด   
 



273 

 

© พ.ศ.2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ
www.ExcelExpertTraining.com 

60 

=SMALL(IF(MATCH(TheList,TheList,0)=ROW(TheList), 
ROW(TheList),""), 
ROW(INDIRECT("1:"&SUM(N(MATCH(TheList,TheList,0)= 
ROW(TheList))))))-1  

  

    แยกขอ้มลู Unique item ออกมา   
 

61 
=IF(SUBTOTAL(3,OFFSET(Rge,ROW(Rge)-
MIN(ROW(Rge)),,1)),Rge,"") 

  

    create an array of filtered items in a column list.    
 

62 

=IF(MONTH(DATE(y,m,1))<>MONTH(DATE(y,m,1)-
(WEEKDAY(DATE(y,m,1))-1)+{0;1;2;3;4;5}*7+{1,2,3,4,5,6,7}-1), 
"", DATE(y,m,1)-(WEEKDAY(DATE(y,m,1))-
1)+{0;1;2;3;4;5}*7+{1,2,3,4,5,6,7}-1) 

  

    สรา้งปฏทินิของเดอืน   
 

63 
=SUM((WEEKDAY(DATE($B$2,$A3,ROW(INDIRECT("1:"& 
DAY(DATE($B$2,$A3+1,0))))))=C$1)*1) 

  

    
รวมจํานวนวันของสปัดาห ์C1 ในเดอืน A3 และปี B2 ทีѷ
กําหนด 

  

 

64 =SUM(IF(ISNONTEXT(data),1))   
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    จํานวนเซลลท์ีѷไมเ่ป็นตัวอักษร   
 

65 =SUM(IF(ISTEXT(data),1))   

    จํานวนเซลลท์ีѷเป็นตัวอกัษร   
 

66 =SUM(IF(ISLOGICAL(data),1))   

    จํานวนเซลลท์ีѷเป็น logical   
 

67 =SUM(IF(EXACT(data,text),1))   

    นับจํานวนเซลล ์ซึѷงม ีtext ตรงกนั   
 

68 
=SUM(IF(LEN(data)-
LEN(SUBSTITUTE(data,text,""))>0,1)) 

  

    นับจํานวนเซลล ์ซึѷงม ีtext ตรงกนั แมบ้างสว่น   
 

69 

=(SUM(LEN(data))-
SUM(LEN(SUBSTITUTE(UPPER(data),UPPER(text),""))))/LEN(text)  

=(SUM(LEN(data))-SUM(LEN(SUBSTITUTE(data,text,""))))/LEN(text)

  

    นับจํานวนเซลล ์ซึѷงม ีtext ตรงกนั ทั Ѹงหมดหรอืแมบ้างสว่น   
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70 
=INDIRECT(ADDRESS(ROW(Data)+MATCH(MIN(ABS(Target-
Data)),ABS(Target-Data),0)-1,COLUMN(Data)+ColOffset)) 

  

    Closest Match   
 

71 
=SUM((MATCH(Grades,{"F","D","C","B","A"},0)-
1)*CreditHours)/SUM(CreditHours) 

  

    GPA   
 

72 
=ADDRESS(ROW(Data)+MATCH(Target,Data,0)-
1,COLUMN(Data)) 

  

    ตําแหน่งเซลลท์ีѷมคีา่อยูใ่นตารางแนวตั Ѹง   
 

73 
=ADDRESS(ROW(Data),COLUMN(Data)+MATCH(Target,Data,0)-
1) 

  

    ตําแหน่งเซลลท์ีѷมคีา่อยูใ่นตารางแนวตั Ѹง   
 

74 
=INDEX(Code, 
MATCH(Make&Model,Range1&Range2,0)) 

  

    2 value lookup   
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75 

=INDEX(Data, SMALL(IF(Data>0, 
ROW(INDIRECT("1:"&ROWS(Data)))), 
ROW(INDIRECT("1:"&ROWS(Data)))))  

IF(ISERR( SMALL(IF(Data>0, 
ROW(INDIRECT("1:"&ROWS(Data)))), 
ROW(INDIRECT("1:"&ROWS(Data))))), "", INDEX(Data, 
SMALL(IF(Data>0, ROW(INDIRECT("1:"&ROWS(Data)))), 
ROW(INDIRECT("1:"&ROWS(Data)))))) 

  

    สรปุคา่บวก   
 

7
6 

=IF(ISERR(SMALL(IF(Data<>"",ROW(INDIRECT("1:"&ROWS(Data))
)), ROW(INDIRECT("1:"&ROWS(Data))))), 
"",INDEX(Data,SMALL(IF(Data<>"", 
ROW(INDIRECT("1:"&ROWS(Data)))), 
ROW(INDIRECT("1:"&ROWS(Data)))))) 

 

    สรปุคา่ทีѷไมใ่ชเ่ซลลว์า่ง  
 

77 

=IF(INDEX(Data,ROWS(Data) - 
ROW(INDIRECT("1:"&ROWS(Data)))+1)="", "", 
INDEX(Data,ROWS(Data) - 
ROW(INDIRECT("1:"&ROWS(Data)))+1)) 

  

    กลับตําแหน่งคา่ในตารางแนวตั Ѹง   
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78 

=LARGE(Data,ROW(INDIRECT("1:"&ROWS(Data))))  

=IF( ISERR( LARGE( Data, ROW( INDIRECT("1:"&ROWS(Data))))), 
"", LARGE( Data, ROW( INDIRECT("1:"&ROWS(Data))))) 

  

    เรยีงลําดับตัวเลข จากมากไปนอ้ย   
 

79 
=INDEX( data, SMALL( IF( MATCH(data,data,0) = 
ROW(INDIRECT("1:"&ROWS(data))), MATCH(data,data,0), ""), 
ROW(INDIRECT("1:"&ROWS(data))))) 

  

    Unique items in List   
 

80 =SUM(LARGE(Data,ROW(INDIRECT("1:"&n))))   

    รวมคา่ทีѷมากทีѷสดุ n ลําดับแรก   
 

81 
=IF(OR(TheName=NameList),"Found","Not 
Found") 

  

    ตรวจสอบวา่ มคีา่ TheName อยูใ่น NameList   
 

82 =SUM(IF(MyData=YourData,0,1))   

    นับจํานวนเซลลท์ีѷมคีา่ไมเ่ทา่กนั เมืѷอเทยีบ 2 ตาราง   
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83 
=ADDRESS(MIN(IF(Data=MAX(Data),ROW(Data), 
"")),COLUMN(Data)) 

  

    ตําแหน่งเซลลซ์ึѷงมคีา่สงูสดุ   
 

84 =MIN(IF(Data=MAX(Data),ROW(Data), ""))   

    เลขทีѷ row ของเซลลซ์ึѷงมคีา่สงูสดุ   
 

85 =SMALL(IF(Data=Value,ROW(Data), ""),n)   

    เลขทีѷ row ของเซลลซ์ึѷงมคีา่ซํѸากนัครบ n ครัѸง   
 

86 =INDEX(Data,MATCH(MAX(LEN(Data)),LEN(Data),FALSE),1)   

    คํายาวทีѷสดุในตาราง   
 

87 =ISNA(MATCH(TRUE,ISNA(MATCH(MyList,Master,0)),0))   

    ตรวจสอบวา่ คา่ใน MyList มอียูใ่น Master   
 

88 =SUM(1*ISNA(MATCH(MyList,Master,0)))   

    จํานวนเซลลข์อง MyList ซึѷงไมม่อียูใ่น Master   
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89 =INDEX(MyList,MATCH(TRUE,ISNA(MATCH(MyList,Master,0)),0))  

    คา่แรกของ MyList ซึѷงไมม่อียูใ่น Master  
 

90 
=SUM(VALUE(MID(ABS(A1),ROW(INDIRECT 
("1:"&LEN(ABS(A1)))),1))) 

  

    รวมตัวเลขทกุหลักในคา่จํานวนเต็ม   
 

91 

=MID(A4,MATCH(0,(ISERROR(MID(A4, 
ROW(INDIRECT("1:"&LEN(A4))),1)*1)*1),0),LEN(A4)-
SUM((ISERROR(MID(A4, ROW(INDIRECT( 
"1:"&LEN(A4))),1)*1)*1))) 

  

    แยกเฉพาะสว่นตัวเลขออกจากตัวอกัษร   
 

92 
=INDEX(Data,MATCH(SMALL(ABS(Target-
Data),1),ABS(Target-Data),0)) 

  

    คา่ทีѷใกลเ้คยีงทีѷสดุกบัคา่ทีѷตอ้งการ   
 

93 
=INDIRECT(ADDRESS(MAX((ROW(4:503)* 
(A4:A503<>""))),COLUMN(A:A))) 

  

    คา่ลา่งสดุใน column A แมจ้ะไมไ่ดอ้ยูต่ดิกนั   
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94 
=INDIRECT(ADDRESS(6,(MAX((TRANSPOSE( 
ROW(1:256))*(6:6<>"")))))) 

  

    คา่ขวาสดุใน row 6 แมจ้ะไมไ่ดอ้ยูต่ดิกนั   
 

95 =SUM(1*(B6<=Sales))-(SUM(1*(B6=Sales))-1)/2   

    
ลําดับทีѷของคา่ โดยใชลํ้าดับแบบเฉลีѷยกรณีซํѸากนั ตา่ง
จากการใชส้ตูร =RANK(B6,Sales) 

  

 

96 =SUM(IF($E6&F$5=Date&Category,Amount))   

    Dynamic crosstabulation   
 

97 
=LEN(A1)+1-MATCH(" ",MID(A1,LEN(A1)+1- 
ROW(INDIRECT("1:"&LEN(A1))),1),0) 

  

    ตําแหน่ง space ขวาสดุ   
 

98 
=SUM((SUBTOTAL(9, INDIRECT(ADDRESS( ROW(E3),COLUMN(E3) 
)&":"& ADDRESS( ROW(E3), 
ROW(INDIRECT(COLUMN(E3)&":"&COLUMN(AI3))) )))<=B3)*1)+1

  

    
จํานวนเซลล ์ซึѷงยอดรวม Cumulative Sum คา่ในเซลล ์C3:G3 มคีา่
มากกวา่หรอืเทา่กบั คา่ในเซลล ์B3 
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99 
=INDEX(คา่ทั Ѹงหมด,SMALL(IF(คา่ทั Ѹงหมด<0,ลําดับตัวเลข),ลําดับ
ตัวเลข),1) 

  

    คา่ตดิลบ   
 

100 

=INDEX(Product, SMALL(IF((Type=YourType) *  
(Account=YourAcct) * (Date>=YourDate) * ROW(INDIRECT("1:"& 
ROWS(Product)))<>0, (Type=YourType) * (Account=YourAcct) * 
(Date>=YourDate) *  ROW(INDIRECT("1:"&ROWS(Product)))), 
ROW(INDIRECT("1:"&ROWS(Product)))),1) 

  

    แยกขอ้มลูซึѷงมปีระเภท เลขทีѷบัญช ีวันทีѷ ตามตอ้งการ   
 

101 

=INDEX(Type, LARGE(IF( NOT(ISBLANK(Type)),  
MATCH(Type,Type,0)) * (IF( NOT(ISBLANK(Type)), 
MATCH(Type,Type,0))=ROW( INDIRECT("1:"&ROWS(Type)))), 
ROW(INDIRECT("1:"&SUM( IF( NOT(ISBLANK(Type)), 
1/COUNTIF(Type,Type))))) ) ) 

  

    Unique List   
 

102 
=INDEX(Product, MATCH( MAX(COUNTIF(Product,Product)),  
COUNTIF(Product,Product), 0),1) 

  

    คา่ซึѷงใชบ้อ่ยทีѷสดุ   
 

 



282 

 

© พ.ศ.2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ
www.ExcelExpertTraining.com 

การกาํหนดขอบเขตตารางแบบยดืหยุน่ 

งานทีѷสรา้งขึѸนดว้ย Excel ไมไ่ดใ้ชตํ้าแหน่งอา้งองิ (Reference) เพืѷอใชใ้นสตูรคํานวณแตเ่พยีง
อยา่งเดยีว ตําแหน่งอา้งองิยังถกูเรยีกใชใ้นคําสัѷง Conditional Formatting, Data Validation, 
Advanced Filter, Pivot Table, หรอืในคําสัѷงอืѷนๆ แมแ้ตใ่นรหัส Visual Basic for Applications 
(VBA) ซึѷงโดยทัѷวไปเมืѷอมกีาร Insert หรอื Delete row หรอื column หรอืโยกยา้ยตําแหน่ง
ตาราง จะสง่ผลใหตํ้าแหน่งอา้งองิทีѷใชเ้ดมิปรับเปลีѷยนขนาดตามทันท ีและหากรูจั้กใชช้ืѷอในการ
กําหนดตําแหน่งอา้งองิจะชว่ยทําใหก้ําหนดตําแหน่งอา้งองิในสตูรไดง้า่ย และยังทําใหตํ้าแหน่ง
อา้งองิทีѷใชใ้นกราฟหรอื VBA ปรับขนาดตามไดอ้กีดว้ย ชว่ยทําใหไ้มต่อ้งเสยีเวลาสรา้งกราฟ
ใหมห่รอืตอ้งยอ้นกลับมาแกไ้ขรหัส VBA อกีแมแ้ตน่อ้ย 

ขอบเขตตารางแบบยดืหยุน่ หมายถงึ ขอบเขตตารางทีѷสามารถยดืไดห้ดไดต้ามจํานวนรายการ
หรอืปรมิาณขอ้มลูทีѷมเีพิѷมลด ทําใหไ้มต่อ้งใชว้ธิคีอ่ยๆ Insert เพิѷม row เพืѷอขยายพืѸนทีѷตาราง
ใหม้เีซลลว์า่งเตรยีมไวส้ําหรับขอ้มลูในอนาคต หรอืไมต่อ้งกําหนดขอบเขตตารางแบบฟุ่ มเฟือย
โดยสรา้งสตูรอา้งองิกบัทั Ѹง column เชน่  

=VLookup( IDCode, A:D, 3)  

ซึѷงการกําหนดตําแหน่งอา้งองิ A:D เชน่นีѸจะทําใหส้ตูรทํางานชา้ลงอยา่งมากและยังทําใหแ้ฟ้มมี
ขนาดใหญข่ึѸนโดยไมจํ่าเป็นอกีดว้ย 

ในบทความนีѸขอแนะนําวธิกีําหนดขอบเขตตารางแบบยดืหยุน่ ตั Ѹงแตว่ธิ ีDynamic Cell ไปจนถงึ
วธิ ีDynamic Range ซึѷงใชส้ตูร Offset, Index, Indirect, Address ชว่ยในการกําหนดขอบเขต
ตารางแบบอัตโนมัต ิ

วธิกํีาหนดตาํแหนง่เซลลแ์บบยดืหยุน่ (Dynamic Cell) 

คนทัѷวไปมักมองขา้มเรืѷองพืѸนฐานทีѷนกึวา่ไมส่ําคัญหรอืไมเ่คยคดิวา่ Excel ทําไดไ้ปใชส้ตูร 
Offset กําหนดขอบเขตตารางกนัเลย โดยหารูไ้มว่า่เมืѷอนําตําแหน่งเซลลข์องเซลลเ์พยีงเซลล์
เดยีวหรอืเซลลใ์นแนวเดยีวกนัมาใชใ้หเ้ป็น จะทําใหเ้กดิขอบเขตตารางแบบยดืหยุน่ไดเ้ชน่กนั 
แถมเป็นวธิทีีѷงา่ยกวา่เสยีอกีเพราะไมจํ่าเป็นตอ้งใชส้ตูร Offset ใหยุ้ง่ยาก 
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ตวัอยา่ง 

 

ตัวอยา่งนีѸเป็นตารางสตูรคณูซึѷงนําตัวเลข 2, 3, 4, 5 บนหัวตารางมาคณูกบัตัวเลข 10, 20, 30 
ดา้นขา้งซา้ยของตาราง โดยใชว้ธิตีั Ѹงชืѷอเซลล ์C2:F2 บนหัวตารางวา่ Top และตั Ѹงชืѷอเซลล ์
B3:B5 ดา้นซา้ยของตารางวา่ Left 

ในเซลล ์C3 สรา้งสตูร =Top*Left แลว้เมืѷอ copy เซลล ์C3 ไป paste ลงไปในเซลลต์ั Ѹงแต ่
C3:G7 ยอ่มพบวา่สตูร =Top*Left สามารถคํานวณหาผลคณูไดถ้กูตอ้งเฉพาะพืѸนทีѷ C3:F5 ซึѷง
เป็นตารางทีѷอยูใ่นขอบเขตแนวคูข่นานตัดกนัของ Top และ Left เทา่นัѸน สว่นสตูรในเซลลน์อก
แนวคูข่นานของ Top กบั Left ใหคํ้าตอบเป็น error วา่ #VALUE! 

แทนทีѷจะดัดแปลง Top กบั Left ใหเ้ป็น Dynamic Range ดว้ยสตูร Offset เพืѷอทําให ้Top กบั 
Left ขยายขอบเขตใหม้ขีนาดตามคา่ตัวเลขบนหัวตารางและตัวเลขขา้งซา้ยของตารางทีѷอาจจะ
มเีพิѷมขึѸน ใหด้ัดแปลงตําแหน่งอา้งองิของ Top กบั Left ใหเ้ป็น Dynamic Cell โดยมขีั Ѹนตอน
ดังนีѸ 

1. คลกิเลอืกเซลล ์C3 
2. เลอืกคําสัѷง Formulas > Name Manger  
3. แกตํ้าแหน่งอา้งองิของ Top =C$2 และ Left =$B3 
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เมืѷอ Top =C$2 จะทําให ้Excel ถอืวา่ทกุเซลลท์ีѷอยูใ่น row 2 มชีืѷอวา่ Top และเมืѷอ Left =$B3 
ยอ่มหมายถงึทกุเซลลใ์น column B มชีืѷอวา่ Left ทําใหส้ามารถใชส้ตูร Top*Left ไดท้กุทีѷใน
ชทีโดยไมจํ่าเป็นตอ้งกําหนดขอบเขตตารางของ Top กบั Left ตามขนาดขอ้มลูอกีตอ่ไป 

หากตอ้งการยา้ยตารางสตูรคณูนีѸไปยัง row อืѷน ไมส่ามารถใชว้ธิ ีCut เฉพาะพืѸนทีѷตารางสตูร
คณู B2:G7 แตต่อ้งเลอืก Cut row 2:7 ไปวางทีѷ row อืѷน หรอืใชว้ธิ ีInsert row เพืѷอขยบั
ตําแหน่งอา้งองิของ Top ทั Ѹงแนว row ทีѷ 2 ไปพรอ้มกนั เพราะ Top มไิดห้มายถงึแคพ่ืѸนทีѷ
บางสว่นของ หากครอบคลมุพืѸนทีѷทั Ѹง row ทีѷ 2 ทั Ѹงหมด 

ตวัอยา่ง 

ในกรณีทีѷตอ้งการเปลีѷยนส ีcolumn ในตารางสตูรคณูใหม้สีเีฉพาะแนวของ column ทีѷอยูใ่ต ้
ตัวเลขบนหัวตารางทีѷเป็นเลขคีѷ  
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ใหเ้ลอืกพืѸนทีѷตัวเลขผลคณูตั Ѹงแต ่C3:G7 แลว้ใชคํ้าสัѷง Home > Conditional Formatting 
แบบ Use a formula to determine which cells to format แลว้ใชส้ตูรตอ่ไปนีѸ 

=MOD(C$2,2)=1 

ขอใหส้งัเกตตําแหน่งเซลล ์C$2 ในสตูรนีѸวา่เป็นเซลลแ์รกบนหัวตารางดา้นบนซึѷงอยูใ่นแนว
คูข่นานกบัพืѸนทีѷ C3:G7 ทีѷเลอืกไว ้และตอ้งกําหนดใหใ้สเ่ครืѷองหมาย $ ไวห้นา้เลข 2 แตไ่มไ่ด ้
ใส ่$ หนา้ตัว C เพืѷอควบคมุให ้Excel นําตําแหน่งเซลลถ์ัดไปใน row ทีѷ 2 มาใชใ้นการคํานวณ 
ซึѷงไดแ้กเ่ซลล ์C2, D2, E2, F2, และ G2 นัѷนคอืตัวเลข 2, 3, 4, 5, 6 ตามลําดับ ซึѷงเมืѷอนํามา
หารดว้ยเลข 2 แลว้ หากเหลอืเศษเทา่กบั 1 ยอ่มแสดงวา่เลขในเซลลบ์นหัวตารางดา้นบน
เซลลนั์Ѹนเป็นเลขคีѷ ทําให ้Conditional Formatting เปลีѷยนสเีซลลผ์ลคณูทีѷอยูใ่ตเ้ลข 3 และ 5 
ซึѷงเป็นเลขคีѷ 

ประโยชนข์องวธิทํีาใหเ้ซลล ์C$2 เป็น Dynamic Cell จะชว่ยทําใหใ้ชคํ้าสัѷง Conditional 
Formatting กําหนดเงืѷอนไขใหก้บัทั Ѹงตารางไดพ้รอ้มกนัในทเีดยีว โดยไมจํ่าเป็นตอ้งเสยีเวลา
ใชคํ้าสัѷงนีѸกบัทลีะเซลลห์รอืทลีะ column และยังสามารถนําหลักการนีѸไปใชก้บัคําสัѷง Data 
Validation ทีѷกําหนด Allow แบบ Custom โดยใชส้ตูรตรวจสอบการบันทกึคา่ไดเ้ชน่กนั 
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วธิใีช ้Table กําหนดขอบเขตตารางโดยอตัโนมตั ิ

ตามปกตเิมืѷอสรา้งสตูรอา้งองิกบัตําแหน่งเซลลห์รอืตําแหน่งตาราง จากนัѸนเมืѷอมกีารยา้ยหรอื 
Insert/Delete ทําใหเ้ซลลห์รอืตารางนัѸนเปลีѷยนตําแหน่งหรอืมขีนาดพืѸนทีѷตา่งไปจากเดมิ จะ
พบวา่ตําแหน่งอา้งองิทีѷกําหนดไวใ้นสตูรมกีารปรับตําแหน่งตามใหเ้อง แตถ่า้มกีารเปลีѷยนแปลง
เฉพาะจํานวนรายการของขอ้มลูในตารางนัѸนใหม้จํีานวนรายการเพิѷมลด จะพบวา่ตําแหน่งอา้งองิ
ทีѷกําหนดไวใ้นสตูร มไิดข้ยายหรอืลดขอบเขตตารางตามปรมิาณขอ้มลูทีѷมอียูแ่ตอ่ยา่งใด ผูใ้ช ้
Excel ทัѷวไปจงึมักแกไ้ขโดยสรา้งสตูรทีѷมขีอบเขตตารางเผืѷอไว ้บางคนถงึกบัใชตํ้าแหน่งอา้งองิ
ทั Ѹง column เผืѷอไว ้สง่ผลใหแ้ฟ้มนัѸนมขีนาดใหญแ่ละคํานวณชา้ลงผดิปกต ิ

ใน Excel 2003 และรุน่กอ่นนัѸน มคํีาสัѷง Data > List ไวใ้ชช้ว่ยแกปั้ญหาดังกลา่ว สว่นใน Excel  
2010 ไดต้ั Ѹงชืѷอคําสัѷงใหมเ่ป็น Table (เป็นคําสัѷงทีѷตา่งจาก Data Table) โดยสัѷง Insert > 
Table หรอื Home > Format as Table ทําให ้Excel ปรับขอบเขตตารางตามปรมิาณขอ้มลูทีѷ
เพิѷมใหโ้ดยอัตโนมัต ิชว่ยทําใหตํ้าแหน่งอา้งองิทีѷกําหนดไวใ้นสตูร, Format, Conditional 
Formatting, Data Validation, หรอืแมแ้ตใ่น Pivot Table ปรับขนาดตามใหทั้นท ี

 

กอ่นทีѷจะใชคํ้าสัѷง Table ควรตั Ѹงชืѷอ Range Name ใหก้บัตารางฐานขอ้มลูทางดา้นซา้ยมอืของ
ภาพนีѸไวก้อ่น โปรดสงัเกตวา่ Range Name แตล่ะชืѷอตอ้งมขีนาดอยา่งนอ้ย 2 เซลลข์ึѸนไป 
(ตามภาพนีѸคอื MyData, Id, Name, Amount และสาเหตทุีѷไมต่ั Ѹงชืѷอใหก้บัเซลลข์อง Cost เพืѷอ
พสิจูนว์า่ไมจํ่าเป็นตอ้งตั Ѹงชืѷอไวก้อ่นก็ยังได)้ จงึจะทําให ้Table ขยายขอบเขตของชืѷอตาราง
ตามปรมิาณขอ้มลูทีѷเพิѷมขึѸน 

เมืѷอตั Ѹงชืѷอ Range Name ไวก้อ่นเรยีบรอ้ยแลว้ ใหค้ลกิลงไปในตารางฐานขอ้มลูแลว้สัѷง Insert 
> Table โดย Excel จะเลอืก =$B$2:$E$3 เป็นขอบเขตตารางใหเ้องพรอ้มกบักาชอ่ง My 
table has headers ไวด้ว้ยแลว้ เมืѷอกดปุ่ ม OK จะเกดิ Range Name ชืѷอ Table2 มตํีาแหน่ง
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อา้งองิ =$B$3:$E$3 สรา้งขึѸนโดยอตัโนมัต ิ(ชืѷอ Table2 นีѸ จะมเีลขตอ่ทา้ยเพิѷมขึѸนทลีะ 1 ตาม
จํานวนครั Ѹงทีѷใชคํ้าสัѷง Table) 

เมืѷอบันทกึขอ้มลูเพิѷมขึѸน จะพบวา่ชืѷอ Range Name ทัѸงหมดมขีอบเขตของตําแหน่งอา้งองิ
ขยายตามใหอ้ยา่งอตัโนมัต ิชว่ยทําใหตํ้าแหน่งอา้งองิทีѷกําหนดไวใ้นสตูร, Format, 
Conditional Formatting, Data Validation, หรอืแมแ้ตใ่น Pivot Table ปรับขนาดตามใหทั้นท ี

 

แมคํ้าสัѷง Table จะมปีระโยชนอ์ยา่งมาก แตก่็เหมาะกบัตารางเก็บขอ้มลูซึѷงบันทกึไวเ้ป็น
ฐานขอ้มลูทีѷดเีทา่นัѸน และผูใ้ชง้านควรทราบเพิѷมเตมิอกีวา่ คําสัѷงนีѸจะทําใหเ้กดิตําแหน่งอา้งองิ
แบบพเิศษทีѷเรยีกวา่ Structured Reference มาใชแ้ทนตําแหน่งอา้งองิแบบปกต ิเชน่ 
=SUM(Table2[Cost]) จะคนืคา่เป็นยอดรวมของ Cost หาตอ่มามกีารสัѷงยกเลกิ Table จะทํา
ใหส้ตูรทีѷเคยใช ้Structured Reference แกก้ลับมาใชตํ้าแหน่งอา้งองิตามปกตใิหเ้อง ทําให ้
สตูร =SUM(Table2[Cost]) แกก้ลับมาเป็น =SUM(Sheet1!$E$3:$E$7) 

การยกเลกิ Table ทําไดง้า่ยๆโดยคลกิขวาลงไปในตารางทีѷเป็น Table แลว้สัѷง Table > 
Convert to range แตถ่า้เปลีѷยนใจสัѷง Insert > Table ขึѸนมาใหม ่จะพบวา่สตูร 
=SUM(Sheet1!$E$3:$E$7) ไมเ่ปลีѷยนกลับไปเป็น =SUM(Table2[Cost]) แตอ่ยา่งใด ดังนัѸน
จงึขอแนะนําใหใ้ช ้Range Name ทีѷตั ѸงชืѷอขึѸนมาเองไวก้อ่น จะยดืหยุน่และถาวรกวา่การใช ้
Structured Reference 

นอกจากนีѸโปรดสงัเกตวา่ ในตัวอยา่งนีѸกอ่นการใชคํ้าสัѷง Table มขีอ้มลูบันทกึไวเ้พยีงรายการ
เดยีว จงึจําเป็นตอ้งตั Ѹงชืѷอ Range Name ชืѷอ Id, Name, และ Amount ใหก้บัเซลล ์B3:B4, 
C3:C4, และ D3:D4 ซึѷงเผืѷอไวถ้งึ row 4 ทีѷเป็นเซลลว์า่ง ทําใหส้ตูรทีѷใชตํ้าแหน่งอา้งองิรวมถงึ
เซลลว์า่งนีѸอาจทํางานผดิพลาดก็ได ้ดังนัѸนเพืѷอป้องกนัปัญหานีѸ ควรใชคํ้าสัѷง Table กบัตารางทีѷ
บันทกึขอ้มลูไวต้ั Ѹงแต ่2 รายการขึѸนไป และตั Ѹงชืѷอ Range Name ใหก้ําหนดขอบเขตไวเ้ทา่กบั
ปรมิาณขอ้มลูทีѷมจีรงิโดยไมต่อ้งเผืѷอเซลลว์า่งไวด้ว้ย 
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อยา่งไรก็ตามหากมกีารลบเฉพาะตัวขอ้มลูทิѸงโดยไมไ่ดส้ัѷง Delete Row จะพบวา่ขอบเขต
ตารางยังคงมขีนาดคงเดมิ ทั Ѹง Range Name และตําแหน่งอา้งองิทีѷใชใ้นสตูร ไมไ่ดล้ดขนาด
ตามจํานวนรายการทีѷลดลงแตอ่ยา่งใด จงึเป็นขอ้แมส้ําคัญของการใช ้Table วา่จะชว่ยขยาย
ขอบเขตตารางตามปรมิาณขอ้มลูทีѷเพิѷมโดยอตัโนมัต ิแตไ่มไ่ดล้ดขนาดตามปรมิาณขอ้มลูทีѷ
ลดลง จงึขอแนะนําใหใ้ช ้Table เมืѷอจะเพิѷมรายการ จากนัѸนใหค้นืสภาพเป็นพืѸนทีѷธรรมดา 

วธิใีชส้ตูร IF หรอื Choose กําหนดขอบเขตตาราง 

ตามปกตใินสตูร VLookup, Match, Offset, หรอืสตูรดา้นฐานขอ้มลูใดๆ สามารถรับตําแหน่ง
ตารางไดเ้พยีงตารางเดยีวในวงเล็บของสตูร เชน่ สตูร =VLOOKUP($H$3,MyData,2,0) ใช ้
Range Name ชืѷอ MyData เป็นตําแหน่งตารางฐานขอ้มลูทีѷตอ้งการคน้หาคําตอบ ถา้ตอ้งการ
ทําใหส้ตูร VLookup หรอืสตูรฐานขอ้มลูสตูรใดๆสตูรเดยีวสามารถคน้หาขอ้มลูจากหลากหลาย
ตาราง ใหใ้ชส้ตูร IF หรอื Choose ซอ้นเขา้ไปในสว่นของ MyData 

สมมตวิา่ มตีารางฐานขอ้มลูของลกูคา้หลายๆกลุม่ตามเกรดของลกูคา้ ซึѷงลักษณะของตาราง
ฐานขอ้มลูของแตล่ะกลุม่มหีนา้ตาตารางเหมอืนๆกนั เพยีงแตจั่ดเก็บแยกตารางไวต้า่งพืѸนทีѷ 
(หรอืตา่งชทีกนั) แลว้ตั Ѹงชืѷอตารางวา่ ClassA, ClassB, และ ClassC 

 

เมืѷอตอ้งการคน้หาขอ้มลู ใหพ้มิพช์ืѷอ Class A, B, หรอื C ลงไปในเซลล ์B10 ซึѷงตั Ѹงชืѷอวา่ Class 
แลว้พมิพร์หสัลกูคา้ลงไปในเซลล ์B14 จะสามารถคน้หาขอ้มลูของ Name และ Amount โดย
ใชส้ตูร IF(Class="A", ClassA, IF(Class="B", ClassB, ClassC) ) ซอ้นลงไปในสตูร 
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VLookup เพืѷอทําใหส้ามารถเลอืกไดว้า่จะหาขอ้มลูจากตารางใดตามเงืѷอนไขชืѷอ Class 
กลายเป็นสตูรดังนีѸ 

ในเซลล ์C14 
=VLOOKUP(  $B$14,  IF(Class="A", ClassA, IF(Class="B", ClassB, ClassC) ),  2,  0) 

ในเซลล ์D14 
=VLOOKUP(  $B$14,  IF(Class="A", ClassA, IF(Class="B", ClassB, ClassC) ),  3,  0) 

หากไมต่อ้งการเสยีเวลาพมิพช์ืѷอ Class เพืѷอเพิѷมความสะดวกใหใ้ชร้หัสในเซลล ์B14 เลอืก
คน้หาขอ้มลูไดทั้นท ีใหใ้ชส้ตูร =Left(C14) สรา้งลงไปในเซลล ์B10 ซึѷงตั Ѹงชืѷอวา่ Class เพืѷอดงึ
ตัวอกัษรทีѷอยูซ่า้ยสดุของรหัสมาใชเ้ป็นชืѷอ Class ดังนัѸนการตั Ѹงชืѷอรหัสใหม้คีวามหมายจะทําให ้
เกดิประโยชนช์ว่ยลัดขั Ѹนตอนในการใชง้านอยา่งมาก 

การใชส้ตูร IF เพืѷอเลอืกพืѸนทีѷตารางหลายๆแหง่มาใช ้จะกลายเป็นสตูร IF ซอ้นกนั ทําใหส้รา้ง
ขึѸนมาไดย้ากและกลายเป็นสตูรยาวขึѸนเรืѷอยๆ จงึแนะนําใหใ้หใ้ชส้ตูร Choose แทน IF แตต่อ้ง
ใชต้ัวเลขทีѷตาราง 1, 2, หรอื 3 มาใชเ้ป็นเงืѷอนไขแทนชืѷอตาราง A, B, หรอื C 

 

เมืѷอตอ้งการคน้หาขอ้มลู ใหพ้มิพเ์ลขทีѷ Class 1, 2, หรอื 3 ลงไปในเซลล ์B10 ซึѷงตั Ѹงชืѷอวา่ 
Class แลว้พมิพร์หัสลกูคา้ลงไปในเซลล ์B14 จะสามารถคน้หาขอ้มลูของ Name และ Amount 
โดยใชส้ตูร CHOOSE(Class,Class1,Class2,Class3) ซอ้นลงไปในสตูร VLookup เพืѷอทําให ้
สามารถเลอืกไดว้า่จะหาขอ้มลูจากตารางใดตามเงืѷอนไขเลขทีѷ Class กลายเป็นสตูรดังนีѸ 

ในเซลล ์C14 
=VLOOKUP(  $B$14,  CHOOSE(Class,Class1,Class2,Class3),  2,  0) 
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ในเซลล ์D14 
=VLOOKUP(  $B$14,  CHOOSE(Class,Class1,Class2,Class3),  3,  0) 

หากไมต่อ้งการเสยีเวลาพมิพเ์ลขทีѷ Class เพืѷอเพิѷมความสะดวกใหใ้ชร้หัสในเซลล ์B14 เลอืก
คน้หาขอ้มลูไดทั้นท ีตอ้งสรา้งตารางสรปุความสมัพันธร์ะหวา่งรหัสกบัเลขทีѷ Class ขึѸนมาใชง้าน 
ตามภาพตอ่ไปนีѸคอืเซลล ์F10:G12 โดยตัѸงชืѷอวา่ ClassTable ซึѷงม ีcolumn ซา้ยสดุเรยีงลําดับ
เลขรหัส Id เฉพาะรหัสตวัแรกของแตล่ะกลุม่ แลว้ใหใ้ชส้ตูร VLookup แบบ Approaching 
Match =VLOOKUP(B14,ClassTable,2) สรา้งลงไปในเซลล ์B10 ซึѷงมชีืѷอวา่ Class 
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วธิใีชส้ตูร Index กําหนดขอบเขตตาราง 

สตูร Index เป็นสตูรทําหนา้ทีѷดงึคา่ออกมาจากตารางทีѷกําหนดตามตําแหน่ง row และ column 
ทีѷตอ้งการ เชน่ ตามภาพตัวอยา่งตอ่ไปนีѸ =Index(Class1,3,2) จะดงึชืѷอ c ออกมาใหเ้พราะอยู่
ในตําแหน่ง row ทีѷ 3 ตัดกบั column ทีѷ 2 ภายในพืѸนทีѷตารางชืѷอ Class1 หรอืถา้ไมต่อ้งการ
กําหนดตําแหน่ง row หรอื col ก็ใหก้ําหนดเลขตําแหน่งรายการทีѷตอ้งการแทนเพยีงคา่เดยีว 
เชน่ =Index(CustId1,3) จะดงึรหัส a003 ออกมาเพราะรหัสนีѸมตํีาแหน่งเป็นลําดับทีѷ 3 ใน
ตารางชืѷอ CustId1 (ทั ѸงนีѸ CustId1 มลัีกษณะเป็น Single Column จากเซลล ์B3:B7) 

 

สตูร Index ยังมโีครงสรา้งสตูรแบบพเิศษ ซึѷงชว่ยเลอืกตําแหน่งตารางทีѷตอ้งการไดทั้นทโีดยไม่
จําเป็นตอ้งอาศัยสตูร If หรอื Choose เขา้มาชว่ย เชน่ 

สตูรในเซลล ์C11 ใชห้าชืѷอลกูคา้ g ตามรหัส b002 ทีѷพมิพล์งไปในเซลล ์B11 
=INDEX(  (Class1,Class2,Class3),  TrNum, 2, Class) 

 ในสตูรนีѸ พืѸนทีѷตารางสว่นของ (Class1,Class2,Class3) เป็น 3 ตารางทีѷตอ้งการเลอืก 
 TrNum เป็นเลขทีѷตําแหน่งรายการของรหัส b002 ทีѷพมิพไ์วใ้นเซลล ์B11 มาจากสตูร 

=MATCH(B11, CHOOSE(Class, CustId1,CustId2,CustId3), 0) 

 เลข 2 คอื เลขชีѸตําแหน่ง column ของชืѷอลกูคา้ 
 Class เป็นเลขทีѷตารางซึѷงหามาจาก ClassTable ดว้ยสตูร 

=VLOOKUP(B11, ClassTable, 2) 
 CHOOSE(Class, CustId1,CustId2,CustId3) ทําหนา้ทีѷเลอืกตําแหน่งตารางรหัสลกูคา้

ตามเลขทีѷของ Class 
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นอกจากนีѸถา้สรา้งสตูร Index แบบ Array จะทําหนา้ทีѷหาตําแหน่งตารางทั Ѹงหมดตามแนวนอน
หรอืแนวตั Ѹงไดอ้กีดว้ยโดยกําหนดเลขทีѷ row หรอื column ใหเ้ทา่กบั 0 เชน่  
=Index(Class1, 0, 3)  
จะไดค้า่ทกุ row ของ column ทีѷ 3 คอื ยอด Amount ={10;20;30;40;50} หรอื  
=Index(Class1, 3, 0)  
จะไดค้า่ทกุ column ของ row ทีѷ 3 คอื รหัส a003 ={"a003","c",30} 

วธิใีชส้ตูร Offset กําหนดขอบเขตตารางแบบยดืหยุน่ (Dynamic Range) 

สตูร VLookup และสตูร Index มลัีกษณะการใชง้านเหมอืนกนัประการหนึѷง คอื ใชก้บัพืѸนทีѷ
ตารางซึѷงกําหนดขอบเขตไวต้ายตัวอยูแ่ลว้ แมจ้ะนําสตูร IF หรอื Choose เขา้มาชว่ยก็เป็นเพยีง
ชว่ยทําใหส้ตูร VLookup และสตูร Index สามารถเลอืกพืѸนทีѷตารางจากตา่งพืѸนทีѷกนัมาใชง้าน 
แตจ่ะไมร่ับรูข้อบเขตใหมห่ากภายหลังมกีารเพิѷมลดจํานวนรายการ 

สว่นการใชคํ้าสัѷง Table เหมาะสําหรับตารางฐานขอ้มลูซึѷงมลัีกษณะถกูตอ้งและจะชว่ยขยาย
ตําแหน่งอา้งองิตามจํานวนรายการ แตจ่ะไมล่ดขนาดเวน้แตว่า่ผูใ้ชจ้ะสัѷง delete row 

สตูร Offset เป็นสตูรทีѷชว่ยกําหนดขอบเขตตารางใหส้ามารถเพิѷมลดขนาดตามจํานวนรายการ
และสามารถนําไปใชก้บัตารางทกุประเภท โดยไมจํ่ากดัวา่จะตอ้งเป็นตารางฐานขอ้มลูเทา่นัѸน 
แตม่ขีอ้จํากดัวา่ หากใชส้ตูร Offset ดงึขอ้มลูขา้มแฟ้มมาใช ้จะตอ้งเปิดแฟ้มตน้ทางขึѸนมาใช ้

รว่มกบัแฟ้มปลายทางทีѷใชส้ตูรนีѸดว้ยเสมอ 

 

จากภาพนีѸเมืѷอตอ้งการขอบเขตตารางตั Ѹงแต ่B3:D7 ใหใ้ชส้ตูร =OFFSET($B$3,0,0,5,3) 
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 $B$3 เป็นตําแหน่งเซลลอ์า้งองิเพืѷอกําหนดเซลลอ์า้งองิเริѷมตน้ของตาราง 
 เลข 0 ตัวแรกในสตูร เป็นตําแหน่งจํานวน row ถัดไป สาเหตทุีѷใชเ้ลข 0 เพืѷอชีѸวา่

จดุเริѷมตน้ของตารางยังคงอยูใ่น row เดยีวกนักบัเซลลอ์า้งองิเริѷมตน้ของตาราง $B$3 
 เลข 0 ตัวทีѷสองในสตูร เป็นตําแหน่งจํานวน column ถัดไป สาเหตทุีѷใชเ้ลข 0 เพืѷอชีѸวา่

จดุเริѷมตน้ของตารางยังคงอยูใ่น column เดยีวกนักบัเซลลอ์า้งองิเริѷมตน้ของตาราง 
$B$3 

 เลข 5 เป็นสว่นของความสงูของตาราง ในทีѷนีѸแสดงวา่มคีวามสงู 5 row 
 เลข 3 เป็นสว่นของความกวา้งของตาราง ในทีѷนีѸแสดงวา่มคีวามกวา้ง 3 column 

หากตอ้งการใหส้ตูรนีѸปรับขนาดแบบยดืหยุน่ (Dynamic Range) โดยทัѷวไปเฉพาะสว่นของ
ความสงูของตารางเทา่นัѸนทีѷจะเพิѷมลดตามจํานวนรายการทีѷบันทกึไว ้เมืѷอตอ้งการทําใหส้ตูร 
Offset ปรับขนาดความสงูตาม สามารถหาความสงูไดห้ลายวธิ ีดังนีѸ 

1. สตูร CountA($B:$B)-1 เพืѷอนับจํานวนเซลลใ์น column B ทีѷมขีอ้มลูแลว้ลบทิѸงเสยี 1 
เพราะไมต่อ้งการนับรวมหัวตารางเซลล ์B2 ซึѷงมคํีาวา่ Id  

2. ใชส้ตูร CountA($B$3:$B$10000) เพืѷอนับจํานวนเซลลท์ีѷมขีอ้มลูตั Ѹงแตร่ายการแรกลง
มา อาจเผืѷอขนาดไวถ้งึ row 10000 

การใชส้ตูร CountA ใหเ้ลอืกใชก้บั column ทีѷมัѷนใจวา่มขีอ้มลูบันทกึไวค้รบทกุรายการเสมอ 
หา้มมเีซลลเ์วน้วา่งแทรกอยา่งเด็ดขาด ซึѷงโดยทัѷวไปในตารางหนึѷงๆตอ้งม ีcolumn หนึѷงซึѷงตอ้ง
บันทกึครบทกุรายการอยูแ่ลว้ โดยเฉพาะ column ของรหัสหรอืวันทีѷ 

หากเป็นตารางซึѷงมชีอ่งวา่งแทรกไวไ้มแ่น่นอน สามารถคํานวณหาความสงูของตารางได ้โดย
ใชส้ตูร Array {=MAX(IF(B:D<>0,ROW(B:D)))-MIN(IF(B:D<>0,ROW(B:D)))} 

 สตูร Array { =MAX(IF(B:D<>0,ROW(B:D)))} หาเลขทีѷ row สดุทา้ยของตาราง 
 สตูร Array { =MIN(IF(B:D<>0,ROW(B:D)))} หาเลขทีѷ row แรกของตาราง 

หมายเหต ุสตูร Array มวีงเล็บปีกกาปิดหัวทา้ยสตูร เกดิจากการกดปุ่ ม Ctrl+Shift+Enter 
พรอ้มกนัแทนการกดปุ่ ม Enter และอาจตอ้งปรับเพิѷมลดตัวเลขใหเ้ทา่กบัความสงูทีѷแทจ้รงิหาก
ตารางในชว่ง column B:D มขีอ้มลูอืѷนซึѷงไมเ่กีѷยวขอ้งบันทกึอยู ่
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เมืѷอหาความสงูของตารางดว้ยสตูรไดแ้ลว้ จากเดมิทีѷเป็นสตูร =OFFSET($B$3,0,0,5,3) ใหนํ้า
สตูรคํานวณหาความสงูมาซอ้นกนักลายเป็นสตูร  
=OFFSET($B$3,0,0, CountA($B:$B)-1, 3)  

หรอืจะลงิคเ์ฉพาะผลลัพธข์องความสงูทีѷคํานวณไดม้าใชก้็ได ้กลายเป็นสตูร  
=OFFSET($B$3,0,0, เซลลห์าความสงู, 3) 

สตูร Offset ทีѷทําหนา้ทีѷเป็น Dynamic Range นีѸ หากสรา้งลงไปในเซลลเ์ดยีวจะเกดิ error 
#VALUE! เสมอ เนืѷองจากสตูรนีѸหาคา่หลายคา่มาใหจ้งึไมส่ามารถแสดงครบทกุคา่ในเซลลใ์ด
เซลลห์นึѷงได ้หากตอ้งการตรวจสอบวา่สตูรทํางานไดถ้กูตอ้งหรอืไม ่ใหก้ดปุ่ ม F2 ตามดว้ย F9 
จะพบวา่สตูรคนืคา่เป็นคา่ทั ѸงหมดในตารางนัѸนออกมาใหเ้ห็นแบบ Array 

={"a001","a",10;"a002","b",20;"a003","c",30;"a004","d",40;"a005","e",50} 

เมืѷอเห็นคา่ทีѷแทจ้รงิของสตูรแลว้ ใหก้ดปุ่ ม Esc เพืѷอแกก้ลับคนืเป็นสตูรตามเดมิ 

อกีวธิหีนึѷงในการตรวจสอบสตูร ใหค้ลกิลงไปในชอ่ง Formula Bar ลากเลอืกสตูรทั Ѹงหมด 
=OFFSET($B$3,0,0, CountA($B:$B)-1, 3) แลว้กดปุ่ ม F5 แลว้กดปุ่ ม Enter เพยีงครั Ѹงเดยีว 
จะพบวา่ Excel เปลีѷยนสตูร Offset เป็นตําแหน่งอา้งองิ =B3:D7 พรอ้มกบัแสดงตําแหน่งใน
ตารางใหเ้ห็น จากนัѸนใหก้ดปุ่ ม Esc เพืѷอแกก้ลับคนืเป็นสตูรตามเดมิ 

เมืѷอพบวา่สตูร Offset แสดงคา่หรอืชีѸตําแหน่งไดถ้กูตอ้ง ใหต้รวจสอบตําแหน่งอา้งองิทกุ
ตําแหน่งในสตูรวา่เป็น Absolute Reference เชน่ $B$3 และ $B:$B กอ่น จากนัѸนจงึนําสตูรนีѸ
ไปตั Ѹงชืѷอใหเ้ป็น Formula Name โดยใชคํ้าสัѷง Formulas > Define Name ตอ่มาเมืѷอตอ้งการ
สรา้งสตูร VLookup, Match, หรอื Index ใหนํ้าชืѷอ Formula Name ทีѷตั ѸงขึѸนนีѸไปใชแ้บบ
เดยีวกบัการใชช้ืѷอ Range Name โดยทัѷวไป 
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ถา้ตอ้งการปรับสตูร Offset ใหค้นืคา่เป็นพืѸนทีѷตารางเพยีงบางสว่น ใหป้รับสว่นของตําแหน่ง 
row, column, ความสงู และความกวา้งในสตูร เชน่ 

 

 =OFFSET($B$3,2,0) หมายถงึ B5 
 =OFFSET($B$3,4,2) หมายถงึ D7 
 =OFFSET($B$3,2,0,1,3) หมายถงึ B5:D5 
 =OFFSET($B$3,4,0,1,3) หมายถงึ B7:D7 
 =OFFSET($B$3,2,0,2,3) หมายถงึ B5:D6 
 =OFFSET($B$3,0,0, CountA($B:$B)-1, 1) หมายถงึ B3:B7 
 =OFFSET($B$3,0,1, CountA($B:$B)-1, 1) หมายถงึ C3:C7 

 =OFFSET($B$3,0,2, CountA($B:$B)-1, 1) หมายถงึ D3:D7 
 =OFFSET($B$3,0,0, CountA($B:$B)-1, 2) หมายถงึ B3:C7 
 =OFFSET($B$3,0,1, CountA($B:$B)-1, 2) หมายถงึ C3:D7 
 =OFFSET($B$3, CountA($B:$B)-2,0,1,3) หมายถงึ B7:D7 หรอืรายการสดุทา้ย 

นอกจากนีѸ ผูใ้ชส้ตูร Offset สามารถกาํหนดตําแหน่งเซลลอ์า้งองิเซลลแ์รกไวท้ีѷเซลลใ์ดก็ได ้
(ไมจํ่าเป็นตอ้งใชเ้ซลล ์B3 ซึѷงเป็นเซลลแ์รกของรายการแรก) และยังสามารถใชห้าคา่ในทกุ
ทศิทาง เพยีงกําหนดจํานวน row ถัดไปหรอืเลข column ถัดไปใหเ้ป็นคา่ลบ 
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วธิใีช ้Text กําหนดขอบเขตตารางแบบยดืหยุน่ (Dynamic Range) 

แมส้ตูร Offset จะชว่ยกําหนดขอบเขตตารางใหอ้ัตโนมัตกิ็ตาม แตข่อบเขตทีѷไดข้ ึѸนอยูก่บั
ปรมิาณขอ้มลูหรอืจํานวนรายการทีѷบันทกึไว ้ซึѷงในบางกรณีอาจไมต่รงกบัความตอ้งการ บางครั Ѹง
ผูใ้ชง้านอาจตอ้งการกําหนดขอบเขตตารางใหแ้ปรเปลีѷยนไปตามเงืѷอนไขพเิศษ 

 

จากภาพนีѸสมมตุวิา่ตอ้งการหายอดรวมของตัวเลขในพืѸนทีѷตารางจาก B2:F15 ซึѷงตามปกติ
สามารถใชส้ตูร =SUM(B2:F15) ไดอ้ยูแ่ลว้ เมืѷอตอ้งการเพิѷมลดขนาดตาราง B2:F15 ใหต้า่งไป
จากเดมิก็ตอ้งแกไ้ขตําแหน่งอา้งองิในสตูร หรอืสัѷง Insert/Delete Row หรอื Column ซึѷงยอ่ม
ทําใหตํ้าแหน่งอา้งองิในสตูร Sum ปรับตาม แตผ่ลจากการ Insert/Delete Row หรอื Column 
อาจกระทบกบัพืѸนทีѷตารางใกลเ้คยีงทีѷอยูใ่นแนวเดยีวกนัและทําใหต้อ้ง Copy สตูรทีѷสรา้งไวเ้ดมิ
มลํีาดับเซลลท์ีѷอา้งองิไวผ้ดิเพีѸยนไปจากทีѷควรก็ได ้

เริѷมตน้จากใชส้ตูรในเซลล ์I2 และ I3 =Cell(“Address”,cell) หาตําแหน่งอา้งองิของเซลลห์ัว
มมุซา้ยบนสดุ(First)และเซลลห์ัวมมุขวาลา่งสดุ(Last) จะไดตํ้าแหน่งอา้งองิ $B$2 และ $F$15 
ตามลําดับ 

นําตําแหน่งอา้งองิทีѷไดม้าเชืѷอมตอ่กนัในเซลล ์I4 ดว้ยสตูร =FirstCell&":"&LastCell ทําใหไ้ด ้
ตําแหน่งอา้งองิ $B$2:$F$15 ซึѷงมลัีกษณะเป็น Text ทีѷบอกตาํแหนง่ พรอ้มทีѷจะนําไปใชก้บั
สตูร Indirect 
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เมืѷอตอ้งการหายอดรวม ใหใ้ชส้ตูรในเซลล ์I6 =SUM(INDIRECT(I4)) หรอืจะนําสตูร 
=INDIRECT($I$4) ไปตั Ѹงชืѷอเป็น Formula Name เพืѷอเพิѷมความสะดวกในการนําไปใชร้ว่มกบั
สตูรอืѷนใดก็ได ้โดยไมจํ่ากดัเฉพาะสตูร Sum 

หากตอ้งการปรับเปลีѷยนขนาดตาราง ใหย้า้ยเซลล ์First หรอื Last ไปวางลงในตําแหน่งทีѷ
ตอ้งการ  

 

จากภาพนีѸเมืѷอยา้ยเซลล ์First กบั Last ไปวางไวท้ีѷเซลล ์C5 และ E9 ตามลําดับ จะทําใหส้ตูร 
Sum หายอดรวมในขอบเขตตาราง C5:E9 ตามไปดว้ย 

ประเด็นสําคัญมไิดข้ ึѸนกบัการสัѷงยา้ยเซลลไ์ปตําแหน่งอืѷน เพราะการสัѷงยา้ยเซลลย์อ่มตอ้งเกดิ
จากฝีมอืของมนุษย ์แตข่ึѸนกบัการใชส้ตูร =Cell(“Address”,cell) ตา่งหาก เพราะสตูรนีѸจะคนืคา่
เป็นตําแหน่งของเซลลท์ีѷกําหนดไวภ้ายในวงเล็บของสตูร เมืѷอใชส้ตูร IF, Choose, Index, หรอื 
Offset ซอ้นเขา้ไปก็จะไดตํ้าแหน่งเซลลแ์ปรเปลีѷยนตามใหทั้นท ีเชน่ 

=CELL("Address",INDEX(MyNum,FirstRow)) 

 

เมืѷอซอ้นสตูร INDEX(MyNum,FirstRow) เขา้ไปในสตูร Cell จะเปลีѷยนหนา้ทีѷจากการหาคา่ทีѷ 2 
คอืเลข 22 จากพืѸนทีѷตารางชืѷอ MyNum มาเป็นการบอกตําแหน่งเซลล ์B3 
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การจดัการคา่ซํ ҟา 

ในหลักการบันทกึขอ้มลูทีѷดตีอ้งควบคมุการบันทกึคา่ซํѸาใหเ้กดิขึѸนไดเ้ทา่ทีѷจําเป็นเทา่นัѸน เชน่ใน
งานบันทกึขอ้มลูสนิคา้ทีѷขาย จะมตีารางบันทกึรายละเอยีดของสนิคา้เอาไว ้จากนัѸนเมืѷอตอ้งการ
รายละเอยีดของสนิคา้ไปใชท้ีѷเซลลอ์ืѷน ไมจํ่าเป็นตอ้งพมิพร์ายละเอยีดของสนิคา้นัѸนๆซํѸาอกี 
คา่ทีѷจําเป็นตอ้งพมิพซ์ํѸามเีพยีงรหัส พอพมิพร์หสัลงไปแลว้ใหใ้ชส้ตูรดงึขอ้มลูของรหัสสนิคา้นัѸน
มาแสดง โดยใชส้ตูร VLookup, Match, Index, หรอืสตูรอืѷนๆดงึรายละเอยีดของรหัสมาแสดง 

อยา่งไรก็ตามมบีางงานทีѷผูใ้ช ้Excel อาจเผลอพมิพค์า่ซํѸา โดยเฉพาะงานทีѷตอ้งกระจายให ้
พนักงานหลายๆคนชว่ยกนับันทกึขอ้มลู เครืѷองมอืทีѷใชช้ว่ยเตอืนทันททีีѷมกีารบันทกึคา่ซํѸาไดแ้ก ่
คําสัѷง Data Validation เพืѷอป้องกนัหรอืเตอืนการบันทกึซํѸาและ Conditional Formatting เพืѷอ
เปลีѷยนสเีซลลท์ีѷมคีา่ซํѸา โดยใชง้านรว่มกบัสตูร CountIF  

 

หากตอ้งการสัѷงให ้Excel เตอืนเมืѷอมกีารพมิพค์า่ซํѸา ใหเ้ริѷมจากเลอืกพืѸนทีѷตารางตั Ѹงแต ่B3:B15 
ซึѷงเตรยีมไวส้ําหรับบันทกึขอ้มลู จากนัѸนสัѷง Data > Data Validation > Data Validation 
เลอืก Allow แบบ Custom แลว้พมิพส์ตูร =COUNTIF($B$3:$B$15,B3)=1 ลงไปในชอ่ง 
Formula โดยไมต่อ้งใสเ่ครืѷองหมาย $ ในสว่นของ B3 ทีѷอยูด่า้นทา้ยในวงเล็บของสตูร เพืѷอทํา
ให ้Excel ใชตํ้าแหน่งถัดไปในการตรวจสอบใหเ้อง 
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ถา้ตอ้งการเปลีѷยนสเีซลลท์ีѷมกีารบันทกึคา่ซํѸา ใหเ้ริѷมจากเลอืกพืѸนทีѷตารางตั Ѹงแต ่B3:B15 แลว้สัѷง 
Home > Conditional Formatting > New Rule โดยเลอืกใชเ้งืѷอนไขแบบ Use a formula to 
determine which cells to format แลว้ใชส้ตูร =COUNTIF($B$3:$B$15,B3)>1 ซึѷงถา้สตูรนีѸ
คนืคา่เป็น True ยอ่มแสดงวา่สตูร CountIF นับขอ้มลูแลว้พบวา่มคีา่ซํѸาจรงิ 

 

โปรดสงัเกตวา่ถา้ใช ้Data Validation จะใชส้ตูร =COUNTIF($B$3:$B$15,B3)=1 แตเ่มืѷอใช ้

กบั Conditional Formatting ตอ้งเปลีѷยนสมการจากเทา่กบั 1 เป็นมากกวา่ 1 แทน ดว้ยสตูร 
=COUNTIF($B$3:$B$15,B3)>1 เพราะ Data Validation จะยอมใหบ้ันทกึคา่ตอ่เมืѷอนับแลว้มี
เพยีงคา่เดยีวคอืนับแลว้เทา่กบั 1 คา่เทา่นัѸน สว่นการใช ้Conditional Formatting จะเปลีѷยนสี

เพืѷอเตอืนเมืѷอมคีา่ซํѸาคอืเมืѷอนับแลว้ทีѷคา่มากกวา่ 1 

Data Validation เป็นเครืѷองมอืทีѷควรนํามาใชร้ว่มกบั Conditional Formatting เสมอ เนืѷองจาก 
Data Validation จะชว่ยตรวจสอบคา่ซํѸาใหต้อ่เมืѷอเกดิคา่ซํѸาขึѸนจากการพมิพล์งไปในตาราง
เทา่นัѸน แตจ่ะไมต่รวจสอบหากมกีาร copy คา่ซํѸาวางลงไปแตอ่ยา่งใด ดังนัѸนเมืѷอเกดิคา่ซํѸาขึѸน
เมืѷอใดก็จะเห็นสใีนเซลลเ์ปลีѷยนแปลงตา่งไปจากเดมิจากคําสัѷง Conditional Formatting เป็น
ปราการดา่นสดุทา้ยของการตรวจสอบอกีชั Ѹนหนึѷง 

ในภาพตอ่ไปหากตอ้งการเปลีѷยนสเีซลลเ์พืѷอชว่ยแสดงตําแหน่งขอ้มลูรายการทีѷตอ้งการใหเ้ห็น
ชดัเจนขึѸน  
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ตารางดา้นซา้ยมอืเป็นตารางฐานขอ้มลู ใหเ้ลอืกพืѸนทีѷตารางเฉพาะสว่นของรายการทั Ѹงหมด
ตั Ѹงแต ่B3:E20 แลว้สัѷง Home > Conditional Formatting > New Rule โดยเลอืกใชเ้งืѷอนไข
แบบ Use a formula to determine which cells to format แลว้ใชส้ตูร =$C3=$G$3 

 

เซลล ์G3 เป็นเซลลท์ีѷใชก้รอกรหัสทีѷตอ้งการใชส้บีอกตําแหน่ง ดังนัѸนในสตูร =$C3=$G$3 ทีѷ
ใชน้ีѸจงึกําหนดตําแหน่งแบบคงทีѷ $G$3 เอาไว ้สว่นเซลล ์C3 เป็นเซลลแ์รกของรายการหัส ID 
ซึѷงในสตูรนีѸกําหนดใหเ้ลืѷอนตําแหน่งไปเรืѷอยๆใน column C จงึตอ้งใช ้$C3   
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การหาเลขตาํแหนง่รายการขอ้มลูทีѷซํ ҟาดว้ยสตูร Multiple Match  

สตูร VLookup และสตูร Match มจีดุออ่นตรงทีѷสตูรเหลา่นีѸจะทํางานกบัขอ้มลูทีѷไมซ่ํѸาเทา่นัѸน 
หากนําไปใชก้บัตารางทีѷมขีอ้มลูซํѸาจะใหคํ้าตอบของขอ้มลูรายการแรกทีѷซํѸากนั สว่นคําสัѷง Data 
> Advanced หรอื Filter จะทํางานตอ่เมืѷอถกูสัѷงใหมเ่ป็นครั Ѹงๆไป ดังนัѸนหากตอ้งการแสดง
รายละเอยีดของขอ้มลูทีѷซํѸากนัในทันททีีѷมกีารเปลีѷยนแปลง ตอ้งหันมารูจั้กกบัสตูรทีѷเรยีกกนัวา่
สตูร Multiple Match 

สตูร Multiple Match ถอืเป็นสตูรทีѷถกูถามกนับอ่ยครั Ѹงมาก ถงึแมไ้ดเ้คยเขยีนอธบิายไวอ้ยา่ง
ละเอยีดหลายครั Ѹงหลายโอกาสแลว้ก็ตาม มักไมเ่ขา้ใจวา่สตูรนีѸสรา้งกนัไดอ้ยา่งไรหากไมไ่ดเ้ห็น
ขั Ѹนตอนการสรา้งทลีะขั Ѹนกบัตาตัวเอง 

 

ตารางดา้นซา้ยมอืของภาพนีѸเป็นตารางฐานขอ้มลูซึѷงมคีา่ซํѸากนับันทกึไว ้เชน่ ขอ้มลูของรหัส 
a001 ถกูบันทกึไวใ้นรายการทีѷ 1, 6, 9, 11, และ 15 โดยตัวเลขตําแหน่งรายการของรหัส a001 
เหลา่นีѸสามารถหาไดด้ว้ยสตูร Multiple Match {=SMALL(IF(ID=G3,Num),Num)} ซึѷงสรา้ง
ไวใ้นเซลล ์L3:L12 แบบ Array 

ตัวอยา่งนีѸใชก้ารตั Ѹงชืѷอ Range Name วา่ Num, ID, Name, และ Amount ใหก้บัพืѸนทีѷขอ้มลู 
B3:B20, C3:C20, D3:D20, และ E3:E20 ตามลําดับ สว่นเซลล ์G3 เป็นเซลลร์ับคา่รหัสทีѷ
ตอ้งการคน้หาตําแหน่งรายการ 
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เพืѷอแสดงใหเ้ห็นทีѷไปทีѷมาของสตูร {=SMALL(IF(ID=G3,Num),Num)} วา่เกดิจากการ
คํานวณหลายขั Ѹนตอนและแตล่ะขั Ѹนทําหนา้ทีѷหาคา่อะไรบา้ง ขออธบิายสตูรทีѷสรา้งไวใ้น Step1 - 
Step3 ดังนีѸ (เวลาใชง้านจรงิไมจํ่าเป็นตอ้งสรา้งสตูรเหลา่นีѸแตอ่ยา่งใด) 

Step1 : เริѷมจากเลอืกเซลล ์I3:I20 พรอ้มกนัแลว้สรา้งสตูร =ID=G3 แลว้กดปุ่ ม 
Ctrl+Shift+Enter จะมวีงเล็บปีกกาปิดหัวทา้ยสตูรกลายเป็น {=ID=G3} คนืคา่ออกมาเป็น 
True คูข่นานตรงกบัตําแหน่งรายการทีѷมรีหัส a001 

Step2 : ปรับตําแหน่งทีѷเป็น True จาก Step1 ใหเ้ป็นเลขทีѷรายการ Num โดยเลอืกเซลล ์
J3:J20 พรอ้มกนัแลว้สรา้งสตูร =IF(I3:I20,Num) แลว้กดปุ่ ม Ctrl+Shift+Enter จะมวีงเล็บ
ปีกกาปิดหัวทา้ยสตูรกลายเป็น {=IF(I3:I20,Num)} จะพบวา่ตําแหน่งทีѷเคยเป็นคา่ True 
กลายเป็นเลขตําแหน่งรายการ 1, 6, 9, 11, 15 ขึѸนมาใหเ้ห็นแทน 

Step3 : นําตัวเลขตําแหน่งรายการจาก Step2 มาเรยีงจากนอ้ยไปมากโดยนําไปซอ้นในสตูร 
Small โดยเลอืกเซลล ์K3:K20 พรอ้มกนัแลว้สรา้งสตูร =SMALL(J3:J20,Num) แลว้กดปุ่ ม 
Ctrl+Shift+Enter จะมวีงเล็บปีกกาปิดหัวทา้ยสตูรกลายเป็น {=SMALL(J3:J20,Num)} 

เมืѷอนําสตูรจาก Step1 – Step3 มาซอ้นกนัจะกลายเป็นสตูร Multiple Match ในเซลล ์L3:L12 
{=SMALL(IF(ID=G3,Num),Num)} ทั ѸงนีѸโปรดสงัเกตวา่ไมจํ่าเป็นตอ้งสรา้งสตูรลงไปในเซลล ์
L3:L20 ทีѷยาวลงมาถงึ row 20 เชน่ทีѷใชก้บัสตูรใน Step1 – Step3 แตอ่ยา่งใด แตใ่หเ้ลอืก
จํานวน row จากเซลล ์L3:L12 หรอื 10 row เทา่ทีѷคดิวา่รหัสจะมโีอกาสซํѸากนัสงูสดุกีѷครั Ѹงก็พอ 
จากนัѸนใหใ้ชส้ตูร Index ดงึขอ้มลูตามลําดับรายการทีѷหาไดม้าแสดงตอ่ไป 
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การหาเลขตาํแหนง่รายการขอ้มลูทีѷเป็น Unique Item 

Unique Item คอื ขอ้มลูทีѷไมซ่ํѸากบัขอ้มลูอืѷน ซึѷงในกรณีทีѷมกีารบันทกึรายการซํѸากนัไวห้ลาย
รายการ รายการแรกของแตล่ะชดุทีѷซํѸากนัก็คอื Unique Item โดยใชส้ตูรคลา้ยกบัสตูร Multiple 
Match เพยีงมขีั ѸนตอนเพิѷมขึѸนอกีหนึѷงขั Ѹนตอน 

 

ในภาพนีѸตารางรหัส ID จาก C3:C20 มรีหัสบันทกึไวซ้ํѸากนั รหัส ID ทีѷเป็น Unique Item คอื
รหัสรายการทีѷ 1, 2, 3, 4, 5, 7, 10, และ 16 ซึѷงหาตัวเลขตําแหน่งรายการเหลา่นีѸไดจ้ากสตูร 
Array ในเซลล ์I3:I12 { =SMALL( IF(MATCH(ID&"",ID&"",0) = Num, Num), Num)} 
โดยสตูรนีѸตอ้งสรา้งพรอ้มกนัลงทเีดยีวไปในเซลล ์I3:I12 แลว้กดปุ่ ม Ctrl+Shift+Enter เพืѷอ
ทําใหม้เีครืѷองหมายวงเล็บปีกกาปิดหัวทา้ยสตูรใหเ้อง (ทั ѸงนีѸใหเ้ลอืกจํานวนเซลล ์I3:I12 มาก
หรอืนอ้ยกวา่นีѸก็ไดแ้ลว้แตว่า่จะมจํีานวน Unique Item ทัѸงหมดมากนอ้ยเทา่ใด) 

Step1 : สตูร MATCH(ID&"",ID&"",0) ทําหนา้ทีѷหาเลขตําแหน่งรายการของ ID แตล่ะตัว 
สาเหตทุีѷตอ้งปรับใหใ้ช ้ID&"" เพืѷอทําใหส้ตูรนีѸยังใชง้านไดห้ากมเีซลลว์า่ง เชน่ เซลล ์C20 

Step2 : นําคา่จาก Step1 ไปเทยีบกบัเลขลําดับ Num จะพบวา่ตําแหน่งรายการทีѷตรงกนั หรอื
แสดงคา่เทา่กบั True คอืตําแหน่งทีѷเป็น Unique Item 
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Step3 : เปลีѷยนคา่ True จาก Step2 ใหเ้ป็นเลขทีѷรายการดว้ยสตูร 
IF(MATCH(ID&"",ID&"",0) = Num, Num) 

Step4 : เรยีงเลขตําแหน่งรายการทีѷไดจ้าก Step3 ใหเ้รยีงจากนอ้ยไปมากดว้ยสตูร Small 

เมืѷอไดต้ัวเลขตําแหน่งรายการทีѷเป็น Unique แลว้ใหใ้ชส้ตูร Index แสดงชืѷอรหัส ID ตอ่ไป 

นอกจากสตูรขา้งตน้แลว้ ยังมสีตูรลัดหาชืѷอรายการทีѷเป็น Unique หรอืจะใชคํ้าสัѷง Data > 
Advanced แบบ Unique records only 

 

เซลล ์D3 สรา้งสตูร =B3 เพืѷอนํารหัสรายการแรกยกมาเป็น Unique Item ไวก้อ่น จากนัѸนใน
เซลล ์D4 ใหส้รา้งสตูร Array {=INDEX(ID,MATCH(0,COUNTIF($D$3:D3,ID),0))} แลว้ 
copy สตูรไปตอ่ลงไปในเซลลถ์ัดไปดา้นลา่ง โปรดดรูายละเอยีดของสตูรนีѸไดจ้าก 
http://www.get-digital-help.com/2009/03/30/how-to-extract-a-unique-list-and-the-
duplicates-in-excel-from-one-column/ 
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การคาํนวณยอดรวมเพืѷอจดัทาํรายงาน 

การจัดเก็บขอ้มลูไวใ้นโครงสรา้งฐานขอ้มลูทีѷถกูตอ้ง เป็นองคป์ระกอบสําคัญชว่ยทําใหเ้กดิ
ความสะดวกและงา่ยในการหาคําตอบทีѷตอ้งการ แตผู่ใ้ช ้Excel แบบมักงา่ยอาจหาทางทีѷงา่ย
กวา่นัѸนโดยปรับแตง่โครงสรา้งฐานขอ้มลูใหก้ลายเป็นหนา้รายงาน ทําใหไ้มส่ามารถใช ้

ฐานขอ้มลูไดเ้ต็มทีѷอกีตอ่ไป ยิѷงกวา่นัѸนหากรายงานทีѷตอ้งจัดพมิพม์รีอ้ยหนา้ ก็มักออกแบบ
ตารางรายงานเลยีนแบบหนา้รายงานทัѸงรอ้ยหนา้ ทําใหแ้ฟ้มมขีนาดใหญข่ึѸนอยา่งมากเนืѷองจาก
ตอ้งเตรยีมพืѸนทีѷในชทีเดยีวกนั ตา่งชที หรอืตา่งแฟ้ม รอไวส้ําหรับแสดงขอ้มลูทกุหนา้ 

พงึระลกึไวเ้สมอวา่ฐานขอ้มลูทีѷดตีอ้งคงสภาพโครงสรา้งเชน่เดมิไวต้ลอด การเปลีѷยนแปลงทีѷ
เกดิขึѸนกบัตารางฐานขอ้มลูจะมเีพยีงการเพิѷมรายการใหมต่อ่ทา้ยรายการเดมิลงไปเรืѷอยๆ หากไม่
จําเป็นจะไมม่กีาร insert row แทรก หรอื delete row ลบรายการทีѷบันทกึไวท้ิѸง และหนา้
รายงานตอ้งหาทางสรา้งขึѸนเพยีงหนา้เดยีวหรอืสตูรเดยีว แลว้หาทางเปลีѷยนหนา้เดยีวหรอืสตูร
เดยีวนัѸนใหแ้สดงคําตอบหนา้อืѷนๆหรอืเรืѷองอืѷนๆไดโ้ดยไมต่อ้งสรา้งหนา้ใหมห่รอืสตูรใหมข่ึѸนอกี 

หลังจากฐานขอ้มลูมโีครงสรา้งทีѷแน่นอนชดัเจนแลว้ เมืѷอตอ้งการหาคําตอบเกีѷยวขอ้งกบัตัวเลข
ยอดรวม มทีางเลอืกใหใ้ชคํ้าสัѷงหรอืสตูรได ้ดังนีѸ 

 ใชส้ตูร SubTotal รว่มกบัคําสัѷง Filter และ Custom Views 
 ใชคํ้าสัѷง Data > SubTotal เพืѷอสรา้งยอดรวมรายการแตล่ะประเภทขึѸนภายในตาราง

ฐานขอ้มลูนัѸน 
 ใชคํ้าสัѷง Data > Consolidate เพืѷอรวมตัวเลขของหลายตารางตามตําแหน่งเรืѷอง

เดยีวกนัเขา้ดว้ยกนั 
 ใชส้ตูร Array SumIF หรอื DSum เพืѷอหายอดรวมแยกประเภท แลว้ใชคํ้าสัѷง Data > 

What-if Analysis > Data Table เพืѷอหายอดรายการอืѷนๆตอ่ 
 ใชคํ้าสัѷง Insert > Pivot Table เพืѷอสรา้งตารางเปรยีบเทยีบตัวเลขคําตอบ 
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ทางออกทีѷดกีวา่การใชส้ตูรบวกหรอืสตูร Sum 

กอ่นจะอธบิายสตูร SubTotal หลายคนอาจจะสงสยัวา่ทําไมจงึไมอ่ธบิายวธิใีชส้ตูร Sum ไว ้
กอ่น ทั ѸงนีѸไมใ่ชเ่พราะสตูร Sum เป็นสตูรงา่ยทีѷทกุคนควรรูจั้กกนัดอียูแ่ลว้หรอก แตเ่นืѷองจาก 
Sum เป็นสตูรทีѷเหมาะสําหรับใชห้ายอด
รวมจากตารางซึѷงมโีครงสรา้งแน่นอน
ถาวร และในอนาคตตอ้งไมม่กีาร
เปลีѷยนแปลงโครงสรา้งอกีตอ่ไป 

ในภาพนีѸ เซลล ์B12 หายอดรวมของ
เซลล ์B2:B11 ดว้ยสตูร =SUM(B2:B11) 
ไดคํ้าตอบยอดรวมเทา่กบั 55 

หากตอ่มามกีารปรับโครงสรา้งตาราง โดย
กําหนดใหห้ายอดรวมของเซลล ์B2:B6 เพิѷม และใหแ้ทรก row ใหมร่ะหวา่ง row 6 และ row 7 
แลว้สรา้งสตูร =SUM(B2:B6) ลงไปในเซลล ์B7 ไดย้อดรวมเทา่กบั 15 แตจ่ะสง่ผลใหส้ตูร 
Sum เดมิทีѷหายอดรวมทัѸงหมดเทา่กบั 55 กลายเป็นยอดรวมใหมเ่ทา่กบั 77 ซึѷงเป็นคําตอบทีѷผดิ
เนืѷองจากนํายอดรวมของ Sum ในเซลล ์B7 ไปรวมเขา้ไปอกี 

 

แทนทีѷจะเลอืกใชส้ตูร Sum ตั Ѹงแตแ่รก ถา้เปลีѷยน =SUM(B2:B11) ไปสรา้งสตูรบวกแตล่ะเซลล์
เขา้ดว้ยกนัเป็น =B2+B3+B4+B5+B6+B7+B8+B9+B10+B11 แลว้หากภายหลังมกีารแทรก 
row และใสค่า่ใหมเ่พิѷมเขา้ไปในเซลลเ์ชน่ทีѷยกตัวอยา่งขา้งตน้ ก็จะไมเ่กดิปัญหาทําใหส้ตูรบวก
คํานวณคา่ผดิพลาด เพราะสตูรบวกยงัคงเลอืกเฉพาะเซลลต์ามเดมิทีѷกําหนดไวใ้หเ้สมอ แตส่ตูร
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บวกกนัทลีะเซลลไ์มใ่ชท่างออกทีѷดนัีกหากมเีซลลท์ีѷตอ้งการนํามาบวกกนันับพันนับหมืѷนเซลล ์
วธิทีีѷดกีวา่การใชส้ตูรบวกหรอืสตูร Sum ก็คอื การใชส้ตูร SubTotal 

การใชส้ตูร SubTotal รว่มกบัคาํส ัѷง Filter และ Custom Views 

หากแปลคําวา่ SubTotal กนัตรงๆอาจเขา้ใจวา่สตูร SubTotal นีѸทําหนา้ทีѷหายอดรวม Total 
ของรายการแตล่ะกลุม่ทีѷ Sub เอาไว ้ซึѷงก็แปลงไดไ้มผ่ดินัก แตส่ตูรนีѸมไิดห้าคําตอบใหเ้ฉพาะ
ยอดรวมเทา่นัѸน หากยังสามารถดัดแปลงใหคํ้านวณหาคา่เฉลีѷยหรอืนับไดอ้กีดว้ย โดยเลอืก
กําหนดใหส้ตูร SubTotal คํานวณหายอดตัวเลขไดถ้งึ 11 แบบตามโครงสรา้งสตูรตอ่ไปนีѸ 

=SubTotal( ตัวเลขประเภทการคํานวณ, พืѸนทีѷเซลล ์) 

ตัวเลขประเภทการคํานวณ กําหนดตัวเลขตั Ѹงแตเ่ลข 101 – 111 แตเ่ลขทีѷใชก้นัทัѷวไปไดแ้ก ่

 101 กําหนดให ้SubTotal ทําหนา้ทีѷแบบสตูร Average 
 102 กําหนดให ้SubTotal ทําหนา้ทีѷแบบสตูร Count 

 103 กําหนดให ้SubTotal ทําหนา้ทีѷแบบสตูร CountA 
 109 กําหนดให ้SubTotal ทําหนา้ทีѷแบบสตูร Sum 

SubTotal มคีวามสามารถพเิศษเหนือกวา่สตูร Sum กลา่วคอื SubTotal เป็นสตูรทีѷจะไมนํ่าคา่
จากเซลลท์ีѷมสีตูร SubTotal มาคํานวณซํѸาอกี 
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สงัเกตวา่ในเซลล ์B7 และ B13 ใชส้ตูร SubTotal เพืѷอหายอดรวมของตัวเลขจากเซลล ์B2:B6 
และ B2:B12 ตามลําดับ โดยในเซลล ์B13 ใชส้ตูร =SUBTOTAL(109,B2:B12) แมว้า่ได ้
กําหนดขอบเขตของตารางทีѷตอ้งการหายอดรวมไวต้ั Ѹงแตเ่ซลล ์B2:B12 ซึѷงรวมถงึเซลล ์B7 ทีѷมี
ยอดตัวเลขรวมจากเซลล ์B2:B6 ไวก้ต็าม สตูร SubTotal ในเซลล ์B13 จะละเลยไมนํ่าคา่ใน
เซลล ์B7 มาคํานวณซํѸาอกี ทําใหย้ังคงไดคํ้าตอบเทา่กบั 55 

ถา้นําสตูร SubTotal ไปใชร้ว่มกบัตารางทีѷถกูซอ่น row/column hide หรอืกรองจากคําสัѷง Data 
> Filter จะพบวา่ สตูร SubTotal แสดงตัวเลขคําตอบเฉพาะทีѷไดม้าจากเซลลท์ีѷยังมองเห็นตัว
เซลลอ์ยูเ่ทา่นัѸน (Visible Cells Only) โดยตัวสตูรเองไมไ่ดต้อ้งเปลีѷยนแปลงใหมแ่ตอ่ยา่งใด 

(Excel รุน่เกา่กวา่ Excel 2003 จะรับตัวเลขประเภทการคํานวณตัѸงแตเ่ลข 1 - 11 และใชร้ว่มกบั
การ Filter เทา่นัѸน แตถ่า้ใช ้Excel 2003 เป็นตน้มาแนะนําใหใ้ชต้ัวเลข 101 – 111 แทน จะ
สามารถใชร้ว่มกบั Filter หรอืจะซอ่น row/column เองไดอ้กีดว้ย) 

 

หลังจากทีѷกรองหรอืจัดโครงสรา้งตารางเพืѷอแสดงผลใหเ้ห็นบนจอตามตอ้งการไดแ้ลว้ ควรใช ้

คําสัѷง View > Custom Views > Add เพืѷอตั Ѹงชืѷอใหก้บัการแสดงผลตามทีѷจัดไว ้
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จากนัѸนเมืѷอตอ้งการแสดงโครงสรา้งตารางตามแบบใด ใหส้ัѷง View > Custom Views แลว้คลกิ
เลอืกชืѷอแบบทีѷตั Ѹงไวใ้นชอ่ง Views แลว้กดปุ่ ม Show จะไดโ้ครงสรา้งตารางตามแบบทีѷตั Ѹงชืѷอไว ้
พรอ้มกบัสตูร SubTotal แสดงตัวเลขคําตอบเฉพาะเซลลท์ีѷยังมองเห็นใหพ้รอ้มกนัไป 
(นอกจากนัѸน Custom Views ยังชว่ยจําการกําหนด Print Setting แตล่ะแบบใหอ้กีดว้ย) 

การใชค้าํส ัѷง Data > Subtotal 

Data > SubTotal ใชก้บัตารางฐานขอ้มลูซึѷงจัดเรยีงขอ้มลูแยกตามกลุม่ทีѷตอ้งการไวก้อ่นแลว้
และตอ้งเป็นตารางซึѷงไมม่สีตูรใดๆสรา้งไว ้เมืѷอใชคํ้าสัѷงนีѸจะเกดิสตูร SubTotal หายอดรวมแยก
ตามกลุม่ใหทั้นท ีพรอ้มกบัสรา้ง Outline เพืѷอใชค้ลกิเลอืกแสดงรายละเอยีดทลีะขั Ѹนตาม
ตอ้งการใหอ้กี และเมืѷอนํามาใชง้านรว่มกบั Custom Views จะเป็นเครืѷองมอืใชช้ว่ยงาน
ฐานขอ้มลูไดอ้ยา่งไมน่่าเชืѷอ 

เริѷมจากจัดเรยีงขอ้มลูเพืѷอจัดกลุม่ขอ้มลูทีѷตอ้งการหายอดรวม แยกเฉพาะแตล่ะกลุม่กอ่น โดยสัѷง 
Data > Sort จากนัѸนคลกิลงในตารางขอ้มลูเซลลใ์ดก็ได ้แลว้สัѷง Data > Subtotal 
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 ชอ่ง At each change in: ใหเ้ลอืกชืѷอ Header ทีѷตอ้งการหาผลรวมตามกลุม่ของ 
Header นัѸนๆ 

 ชอ่ง Use function: ใหเ้ลอืก Sum 
 ชอ่ง Add subtotal to: ใหเ้ลอืกชืѷอ Header ของ Field ทีѷตอ้งการหายอดรวม 
 กดปุ่ ม OK จะพบวา่ ม ีRow ใหมแ่ทรกขึѸนเองและมสีตูร Subtotal คํานวณยอดใหทั้นท ี

หากตอ้งการสรา้ง Subtotal ระดับรองซอ้น Subtotal ระดับแรก ใหส้ัѷง Data > Subtotal ซํѸาอกี
ครั Ѹงแลว้เปลีѷยน Header ใหมใ่นชอ่ง At each change in: แลว้ใหต้ัดกาเครืѷองหมายถกูในชอ่ง 
Replace current subtotals ออก แลว้กด OK 
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เมืѷอกดปุ่ มเครืѷองหมายลบหรอืปุ่ มหมายเลขระดับชั Ѹนของ Outline ดา้นบนซา้ย รายการขอ้มลูจะ
หบุ และปุ่ ม Outline จะกลายเป็นเครืѷองหมายบวกแทน หากตอ้งการ Copy เฉพาะ Visible 
Cells ใหเ้ลอืกพืѸนทีѷตารางแลว้กด F5 > Special > เลอืก Visible cells only จากนัѸนสัѷง Copy 
ไป Paste จะไดเ้ฉพาะพืѸนทีѷทีѷเหลอืจากการกดปุ่ ม Outline เทา่นัѸน 

ขอ้ดขีองการใชคํ้าสัѷงนีѸ นอกจาก Excel จะสรา้งสตูร SubTotal ใหเ้องแลว้ หากตอ้งการสัѷง
ยอ้นกลับไปเป็นตารางฐานขอ้มลูตามแบบเดมิ ใหก้ดปุ่ ม Remove All 

หมายเหต ุหากตอ้งการสรา้ง Outline ขึѸนมาใชเ้อง ใหเ้ลอืกเซลลท์ีѷตอ่เนืѷองกนัแลว้ใชคํ้าสัѷง 
Data > Group  
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การใชค้าํส ัѷง Data > Consolidate 

 

จากภาพนีѸตารางของ Division 1 และ Division 4 มโีครงสรา้งเหมอืนกนั ถา้ตอ้งการหายอดรวม
ตัวเลขเรืѷองเดยีวกนัจากหลายตารางเขา้ดว้ยกนั ใหเ้ริѷมจากเปิดชทีใหมข่ึѸนมากอ่น แลว้สัѷง Data 
> Consolidate จากนัѸนคลกิเลอืกพืѸนทีѷตารางขอ้มลูชดุแรกใหแ้สดงในชอ่ง Reference แลว้กด
ปุ่ ม Add แลว้เลอืกพืѸนทีѷจากตารางอืѷนมา Add ซํѸาจนกวา่จะครบทกุตารางทีѷตอ้งการ (โดยจะ
เลอืกจากตารางทีѷอยูต่า่งชทีหรอืตา่งแฟ้มกนัก็ได)้ แลว้อยา่ลมืกาชอ่ง Use labels in พรอ้มกบั
กาชอ่ง Crate links to source data ใหค้รบเพืѷอจะไดส้ตูรลงิคค์า่จากตารางตน้ทางมาใชด้ว้ย 
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วธิสีรา้งสตูรบนกราฟ 

กราฟ Excel มคีวามพเิศษอยา่งหนึѷง คอื แทบทกุสิѷงซึѷงประกอบกนัเป็นรปูกราฟ สามารถนําสตูร 
link คา่จากตารางไปทีѷกราฟ ไมว่า่จะเป็นตัว marker หรอืคําอธบิายแตล่ะสว่น เราสามารถสรา้ง
สตูร link ในแตล่ะจดุไดโ้ดยใชว้ธิงีา่ยๆ ตอ่ไปนีѸ 

1. สรา้งกราฟใหเ้สร็จกอ่นตามวธิปีกต ิ 
2. คลกิครั Ѹงหนึѷง ลงไปทีѷตัว marker หรอืขอ้ความใดๆก็ไดบ้นกราฟ แลว้คลกิลงไปอกีททีีѷ

เดมิ จะพบวา่ จดุนัѸนกลายเป็นกลอ่ง  
3. ใหค้ลกิลงบน formula bar แลว้พมิพเ์ครืѷองหมายเทา่กบั =  
4. คลกิกลับไปยังเซลลข์อ้มลูตน้ตอในตาราง แลว้กด enter  
5. จะพบวา่ตัว marker กลายเป็นสตูร link ขอ้มลูมาจากเซลล ์ 

ดว้ยวธิเีดยีวกนันีѸ เราสามารถสรา้งสตูร link นําขอ้มลูมาทั Ѹงตาราง นํามาแสดงไวบ้นกราฟไดเ้ลย
ทัѸงตาราง เริѷมตน้โดย 

1. เลอืกตารางขอ้มลูซึѷงตอ้งการนําไปแสดงบนกราฟ  
2. กด Shift พรอ้มกบัคลกิเมนูคําสัѷง Edit > Copy Picture แลว้กดปุ่ ม OK 

 
3. คลกิลงไปในหนา้กราฟ แลว้สัѷง Paste แลว้ยา้ยรปูตารางไปยังตําแหน่งวา่งๆบนกราฟ จะ

ไดเ้ห็นตารางชดัเจนไมทั่บกบัรปูสว่นอืѷนๆ  
4. คลกิลงไปใน formula bar แลว้พมิพเ์ครืѷองหมายเทา่กบั =  
5. คลกิกลับไปยังพืѸนทีѷตารางขอ้มลูซึѷงสัѷง copy picture มาจะไดส้ตูร link มาทีѷรปู  
6. กด Enter  



314 

 

© พ.ศ.2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ
www.ExcelExpertTraining.com 

 

วธิสีรา้งสตูรเพืѷอดงึรปูภาพ 

สตูร Excel สามารถใช ้link รปูภาพมาแสดงผลไดเ้ชน่เดยีวกบัการสรา้งสตูร link เพืѷอนําคา่ใน
เซลลอ์ืѷนมาแสดง โดยเริѷมตน้จาก 

1. สรา้งตารางเก็บรปูภาพ เซลลล์ะรปู แลว้กําหนดชืѷอตารางเก็บรปูนีѸวา่ PicTable หรอืชืѷอ
อืѷนก็ได ้ 

2. ใชเ้มนูคําสัѷง Formulas > Define Name สรา้ง Formula Name ชืѷอวา่ ChoosePic 
กําหนดให ้Refers to: สตูร =INDEX(PicTable,1,Sheet1!$A$1) 

 
   

3. เลอืกเซลลว์า่งๆเซลลใ์ดก็ได ้แลว้สัѷง Home > Copy as Picture  
4. เลอืกตําแหน่งเซลลซ์ึѷงจะแสดงรปู แลว้สัѷง Paste จะไดร้ปูเซลลว์า่งๆทีѷเรา copy มา  
5. คลกิลงไปใน Formula Bar พมิพส์ตูร =ChoosePic  
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6. กําหนดเลขทีѷรปูลงไปในเซลล ์A1 เชน่ใสเ่ลข 2 จะไดร้ปูทีѷ 2 ถกูนํามาแสดงในรปูเซลล์
ทีѷ copy มา  

7. คลกิขวาทีѷรปูเซลล ์แลว้จัดรปูแบบของสแีละเสน้กรอบตามตอ้งการ  
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วธิจีดัการกบัความอว้นอุย้อา้ย...ของแฟ้ม 

แฟ้ม Excel ทีѷเราเพิѷงเปิดใชง้านขึѸนใหมใ่นวันนีѸ จะเริѷมมขีนาดแฟ้มใหญข่ึѸนเรืѷอยๆ แลว้เมืѷอวัน
เวลาผา่นไปสกัปีสองปี คอมพวิเตอรท์ีѷใชอ้ยูก่็จะทํางานชา้ลงไปจนผดิสงัเกตโดยมเีหตมุาจาก
แฟ้มใหญข่ึѸนมากนีѷแหละ ตัวผูใ้ช ้Excel มักชอบวิѷงไปบอกหัวหนา้ ขอใหซ้ืѸอคอมพวิเตอรเ์ครืѷอง
ใหมเ่พืѷอจะไดทํ้าให ้Excel ทํางานเร็วเหมอืนเดมิ ซึѷงถา้ผมเป็นหัวหนา้ของคณุละ่กอ้ ... แทนทีѷ
จะเปลีѷยนคอมพวิเตอรเ์ครืѷองใหม ่ขอเปลีѷยนตัวพนักงานเป็นคนอืѷนจะดกีวา่ !!! เพราะแมจ้ะไดใ้ช ้

คอมพวิเตอรเ์ครืѷองใหมแ่ลว้ก็ตาม ตอ่มาพอแฟ้มเริѷมใหญข่ึѸนอกี คอมพวิเตอรก์็จะชา้ลงไปอกี 
แลว้เราก็ตอ้งซืѸอเครืѷองใหมท่ีѷเร็วขึѸนกวา่อกีหรอือยา่งไรกนั 

กอ่นทีѷจะสายเกนิไป ผูใ้ช ้Excel ควรเขา้ใจกอ่นวา่ ทีѷวา่แฟ้ม Excel ใหญข่ึѸนนัѸน อะไรบา้งทีѷเป็น
เหตใุหแ้ฟ้มมขีนาดใหญข่ึѸน แลว้อยา่นกึตอ่ไปวา่ แฟ้มใหญต่อ้งใชเ้วลาคํานวณนานกวา่แฟ้มทีѷ
เล็กกวา่เสมอไป ซึѷงเมืѷอเขา้ใจประเด็นเหลา่นีѸแลว้เราตอ้งหาทางออกแบบแฟ้มใหใ้หญพ่อดีๆ  ไม่
ใหญ ่ไมเ่ล็กเกนิไป และไมใ่ชเ้วลาคํานวณชา้จนรอไมไ่หว 

สิѷงทีѷมผีลตอ่ขนาดของแฟ้ม 

1. จํานวนเซลลท์ีѷใช ้
2. จํานวนเซลลท์ีѷถกูอา้ง 
3. รปูแบบหรอื Format ทีѷใช ้

จํานวนเซลลท์ีѷใช ้

แฟ้ม Excel ในยคุแรก มขีนาดแฟ้มใหญม่ากเพราะกําหนดวา่ พืѸนทีѷตารางทกุเซลลต์ั Ѹงแตเ่ซลล ์
A1 ไปจนถงึเซลลห์ัวมมุขวาลา่งสดุทีѷมขีอ้มลูอยูถ่อืเป็นพืѸนทีѷซ ึѷงถกูใชง้าน ตอ่มา Excel ได ้
พัฒนาใหข้นาดของแฟ้มไมต่อ้งนับจากเซลล ์A1 แตใ่หนั้บเฉพาะเซลลท์ีѷถกูใชง้านเทา่นัѸน สว่น
เซลลท์ีѷเราไมไ่ดเ้ขา้ไปแตะตอ้งแกไ้ขใสอ่ะไรลงไป ไมม่สีว่นกระทบตอ่ขนาดของแฟ้มแตอ่ยา่ง
ใด ซึѷงชว่ยใหเ้ราสามารถใชพ้ืѸนทีѷตารางไดส้ะดวก ไมต่อ้งออกแบบตารางใหช้ดิตดิกนัเป็นพดื 
เพืѷอหาทางลดขนาดแฟ้มอยา่งแตก่อ่น  

ขอใหส้งัเกตวา่ ขนาดของแฟ้ม ไมไ่ดข้ ึѸนอยูก่บัจํานวนอกัขระทีѷมอียูใ่นเซลล ์ไมว่า่จะพมิพเ์ลข 1 
ลงไปในเซลล ์100 เซลล ์หรอืพมิพเ์ลข 123 ลงไปในเซลล ์100 เซลล ์แฟ้มก็ยังคงมขีนาด



317 

 

© พ.ศ.2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ
www.ExcelExpertTraining.com 

ใหญเ่ทา่กนัเพราะใชจํ้านวนเซลล ์100 เซลลเ์ทา่กนั แตอ่ยา่งไรก็ตามในเซลลจํ์านวน 100 
เซลลท์ีѷสมมตวิา่ถกูพมิพค์า่ลงไปนัѸน หากพมิพต์ัวอกัษรหรอืสรา้งสตูรลงไปก็จะทําใหแ้ฟ้มมี
ขนาดใหญข่ึѸนตามลักษณะของขอ้มลูทีѷพมิพล์งไป ซึѷงลําดับขนาดแฟ้มจากเล็กไปใหญข่ึѸนกบั
ประเภทของขอ้มลู ดังนีѸ 

1. ถา้เป็นตัวเลข แฟ้มจะเล็กทีѷสดุ ไมว่า่จะเป็นเลข 1 หรอืเลข 123 แฟ้มยังคงมขีนาด
เทา่กนั 

2. ถา้เป็นตัวอกัษร แฟ้มจะใหญข่ึѸน ไมว่า่จะเป็นตัวอักษร A หรอื ABC แฟ้มยังคงมขีนาด
เทา่กนั (ใน Excel 2010 พบวา่ ขอ้ 1 และ 2 นีѸไมไ่ดม้ขีนาดแฟ้มตา่งกนั) 

3. ถา้เป็นสตูรและคนืคา่เป็นตัวเลข แฟ้มจะใหญข่ึѸน 
4. ถา้เป็นสตูรและคนืคา่เป็นตัวอกัษร แฟ้มจะใหญม่ากทีѷสดุ 

 จํานวนเซลลท์ีѷถกูอา้ง 

ในกรณีทีѷสรา้งสตูร link ขอ้มลูขา้มแฟ้ม จะพบวา่แฟ้มปลายทางมขีนาดใหญข่ึѸนมาก หรอื
บางครั Ѹงจะมขีนาดใหญก่วา่แฟ้มตน้ทางเสยีอกี ทั Ѹงๆทีѷในแฟ้มปลายทางมเีซลลท์ีѷใชง้านเพยีง
เซลลเ์ดยีวก็ตาม เนืѷองจากในสตูร link ขา้มแฟ้มทีѷสรา้งไวใ้นเซลลไ์ดนํ้าขอ้มลูจากแฟ้มตน้ทาง
มาเก็บไวใ้นแฟ้มปลายทาง เรยีกวา่ Cache Data  

ยกตัวอยา่งเชน่ สตูร =VLOOKUP(A1,[Input.xls]Sheet1!$B$2:$H$200,2) ทีѷหาคา่จากแฟ้ม 
Input.xls ในชที Sheet1 ตั Ѹงแตเ่ซลล ์B2:H200 นีѸ จะทําให ้Excel แอบสรา้งตารางทีѷเรามองไม่
เห็นเก็บขอ้มลูจากแฟ้มตน้ทางทัѸงหมดไวใ้นแฟ้มปลายทางทีѷมสีตูรนีѸอยู ่ซ ึѷงตารางทีѷมองไมเ่ห็นนีѸ
แหละเป็น Cache Data 

Cache Data ชว่ยทําใหเ้มืѷอเปิดแฟ้มปลายทางขึѸนมาใชเ้พยีงแฟ้มเดยีว เราก็สามารถใชส้ตูร 
VLookup คน้หาขอ้มลูจากแฟ้มตน้ทางไดโ้ดยไมจํ่าเป็นตอ้งเปิดแฟ้มตน้ทางขึѸนมาใชพ้รอ้มกบั
แฟ้มปลายทางแตอ่ยา่งใด แตก่็ทําใหแ้ฟ้มปลายทางมขีนาดใหญข่ึѸน 

รปูแบบหรอื Format ทีѷใช ้

การกําหนดรปูแบบใหก้บัชทีทั Ѹงชทีพรอ้มกนัทเีดยีวทกุเซลล ์จะทําใหแ้ฟ้มมขีนาดเล็กกวา่การ
กําหนดรปูแบบเพยีงบางสว่นของตาราง เพราะ Excel จะใชว้ธิรีับรูท้เีดยีววา่ชทีนัѸนๆใชร้ปูแบบใด 
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แตถ่า้ในตารางมกีารกําหนดรปูแบบตา่งกนัไปในแตล่ะสว่น จะทําให ้Excel ตอ้งรับรูล้ะเอยีดมาก
ขึѸนวา่ พืѸนทีѷตารางสว่นใดใชร้ปูแบบใด จงึทําใหแ้ฟ้มมขีนาดใหญข่ึѸน 

ตามปกต ิExcel ไดก้ําหนดไวใ้นคําสัѷง Excel Options ใหก้าชอ่ง Extend data range formats 
and formulas ไวแ้ลว้ตั Ѹงแตต่น้ เพืѷอชว่ยใหเ้ซลลข์อ้มลูตัวเลขทีѷใชง้านตดิตอ่กนัไวต้ามแนวตั Ѹง
ตั Ѹงแต ่3 เซลลข์ึѸนไป สง่รปูแบบทีѷกําหนดไวใ้น 3 เซลลนั์Ѹนตอ่ไปยังเซลลท์ีѷ 4 และเซลลต์อ่ๆไป
ใหทั้นท ีแลว้หากมเีซลลท์ีѷสรา้งสตูรไวต้ดิตอ่กนัตามแนวตั Ѹง 4 เซลลอ์ยูแ่ลว้ คําสัѷงนีѸจะชว่ย 
copy สตูรและรปูแบบจากเซลลท์ีѷ 4 ไปยังเซลลท์ีѷ 5 ตอ่ไปเรืѷอยๆใหเ้ชน่กนั (ขอใหท้อ่งไวว้า่ 
ครบ 3 ได ้4 ครบ 5 ไดส้ตูร หมายความวา่ เดมิครบ 3 เซลล ์จะไดร้ปูแบบตอ่ในเซลลท์ีѷ 4 แลว้
พอเริѷมครบ 5 เซลล ์จะไดทั้ Ѹงสตูรและรปูแบบตามตอ่ไปใหเ้อง) อยา่งไรก็ตามคําสัѷงนีѸจะทํางาน
ตอ่เมืѷอขอ้มลูตามแนวตั Ѹงทีѷบันทกึตอ่กนัไปเป็นตัวเลขทกุเซลล ์เชน่ ถา้บันทกึตัวเลขเอาไว ้ก็
ตอ้งบันทกึตัวเลขในเซลลต์อ่ไปเทา่นัѸน หากเมืѷอใดทีѷบันทกึคา่เป็นตัวอกัษรลงไปในเซลลท์ีѷควร
เป็นตัวเลข ตอ้งลบคา่นัѸนทิѸงไปกอ่น จงึจะกระตุน้ใหคํ้าสัѷงนีѸทํางานดังเดมิ  

สิѷงทีѷผลตอ่ความเร็ว 

ในเรืѷองความเร็วนีѸไมไ่ดเ้กีѷยวขอ้งกบัความเร็วในการคํานวณของโปรแกรม Excel เทา่นัѸน แตย่ัง
สง่ผลกระทบตอ่ความเร็วของมนุษยใ์นการใช ้Excel อกีดว้ย นับตั Ѹงแตจ่ะชา้หรอืเร็วในการสรา้ง
งาน สรา้งเสร็จแลว้เมืѷอนํามาแกไ้ขจะตอ้งเสยีเวลาแกไ้ขชา้หรอืเร็วเพยีงใดกวา่จะแกไ้ขเสร็จ 
บางคนใชเ้วลาสรา้งแฟ้มนดิเดยีวแตพ่อยอ้นกลับมาแกไ้ขแฟ้มเดมิกลับตอ้งเสยีเวลาแกไ้ขนาน
ขึѸนมาก  

มนษุยน์ีѷแหละตน้เหตขุองความชา้อุย้อา้ย 

แมย้คุนีѸเราใชเ้ครืѷองคอมพวิเตอรแ์ทนเครืѷองคดิเลขกนัมากขึѸน แตแ่ทนทีѷเครืѷองคอมพวิเตอรจ์ะ
ชว่ยใหทํ้างานไดเ้ร็วขึѸน หลายๆคนกลับทํางานเสร็จชา้ลง จนแทบอยากจะยอ้นไปกดปุ่ มบน
เครืѷองคดิเลขทีѷตนใชไ้ดเ้ร็วกวา่ ทั ѸงนีѸเนืѷองจากคนเราไมช่อบการเปลีѷยนแปลง ชอบทําอะไรใช ้

อะไรทีѷตัวคุน้เคยมากอ่น พอจะใชค้อมพวิเตอรก์็คดิไมอ่อกวา่จะใชโ้ปรแกรมอะไร ฟังเขามาวา่
ถา้เรืѷองของตัวเลขตอ้งใชโ้ปรแกรม Excel แตถ่า้เรืѷองเก็บขอ้มลูตอ้งใช ้Access แลว้ถา้ขอ้มลูมี
ทั Ѹงตัวเลขและตัวอกัษรละ่ จะใชโ้ปรแกรมอะไรด ีบางคนอาจคดิงา่ยๆวา่ ถา้ขอ้มลูมเีลขมากกวา่ 
ก็ใหใ้ช ้Excel หรอืถา้ขอ้มลูมตีัวอกัษรมากกวา่ตัวเลข ก็ใหใ้ช ้Access แลว้กนั  
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ในประเด็นของการเลอืกใชโ้ปรแกรม Excel หรอื Access นีѸ ในเบืѸองตน้สําหรับคนทีѷเพิѷงจับ
คอมพวิเตอร ์ขอแนะนําใหเ้ลอืกใช ้Excel กบังานทีѷตอ้งการความยดืหยุน่ หรอืงานทีѷผูใ้ชย้ังไม่
มัѷนใจวา่จะจัดโครงสรา้งหนา้ตาของตารางขอ้มลูทีѷตอ้งการเก็บไวอ้ยา่งไร เพราะ Excel มคํีาสัѷง
ชว่ยสําหรับการโยกยา้ยขอ้มลูเตรยีมไวพ้รอ้ม และเราอยากจะยา้ยตารางไปเก็บไวท้ีѷชทีอืѷนแฟ้ม
อืѷน ก็จะเห็นผลทันทบีนหนา้จอกบัตา แถม Excel ยังชว่ยแกไ้ขสตูรทีѷเกีѷยวขอ้งกบัตารางซึѷงถกู
ยา้ยใหเ้สร็จ แลว้ตอ่มาภายหลังพอมขีอ้มลูปรมิาณมากขึѸน เริѷมมมีาตรฐานของโครงสรา้งตาราง
แน่นอนตายตัวแลว้ จงึคดิถงึ Access  

ครั Ѹนเลอืกใช ้Excel สรา้งตารางเก็บขอ้มลูตอ่ไปสกัพัก คอมพวิเตอรแ์สนเร็วของเรากบัผูท้ีѷใช ้
Excel ก็จะพรอ้มใจกนักอดคอทํางานชา้ลงไปเรืѷอยๆ โดยมสีาเหตยุอดนยิมดังตอ่ไปนีѸ 

1. ออกแบบตารางเก็บขอ้มลูไมเ่ป็น พอเปิดแฟ้มขึѸนด ูแลว้งงไปหมดวา่ขอ้มลูอะไรอยู่
ตรงไหน 

2. เก็บขอ้มลูทีѷเกีѷยวขอ้งกบัวันทีѷ แตว่ันทีѷซ ึѷงเก็บบันทกึไว ้ไมส่ามารถนํามาใชคํ้านวณตอ่ได ้
3. เก็บขอ้มลูซํѸาซอ้นกนั พอจะแกไ้ขเป็นขอ้มลูใหมต่อ้งเสยีเวลาหาตําแหน่งเซลลใ์หพ้บ

กอ่นวา่อยูท่ีѷชทีใดแฟ้มใด 
4. แยกขอ้มลูทีѷเก็บไวใ้นตารางเดยีวกนัออกจากกนัไมไ่ด ้ตอ้งฝืนบันทกึขอ้มลูตอ่ไปเรืѷอยๆ

นับพันนับหมืѷนบรรทัด 
5. สรา้งสตูรยากๆยาวๆแบบฉันเองคนสรา้งคนเดยีวเทา่นัѸนทีѷจะแกะออก 
6. เลอืกใชส้ตูรไมเ่ป็น ชอบใชส้ตูรสั Ѹนๆทีѷคนชอบ แต ่Excel ไมช่อบเพราะโปรแกรมจะ

ทํางานชา้ลง 
7. แยกตารางสตูรทีѷไมจํ่าเป็นตอ้งคํานวณพรอ้มกนัออกจากกนัไมไ่ด ้ทําใหต้อ้งเสยีเวลารอ

การคํานวณสตูรซํѸาโดยไมจํ่าเป็น 
8. ไมรู่จั้กแยกคา่ตัวแปรทีѷอาจเปลีѷยนแปลงภายหลังไวน้อกสตูร 
9. สรา้งชทีทีѷใชคํ้านวณเรืѷองเดยีวกนัซํѸากนัเต็มไปหมด แตล่ะชทีมตีารางหนา้ตาเดยีวกนั 

ตา่งกนัแตค่า่ทีѷนํามาใชคํ้านวณ 
10. เลอืกใช ้VBA กบังานทีѷยงัไมค่วรใช ้VBA แม ้VBA จะชว่ยใหเ้สร็จงานเร็วขึѸน แตก่็ไมใ่ช่

เร็วขึѸนไดเ้ต็มทีѷอยา่งทีѷควร 

 สาเหตยุอดนยิมเหลา่นีѸแหละทีѷทําใหเ้ราไดผ้ลลัพธจ์าก Excel ชา้ลง แตโ่ดยทัѷวไปผูใ้ช ้Excel 
ทีѷไมเ่คยนําผลงานไปเปรยีบเทยีบกบัผูอ้ืѷนมักจะหลงภาคภมูใิจในผลงานของตน และเขา้ใจผดิ
ไปวา่ตนไดใ้ช ้Excel ชว่ยสรา้งผลงานทีѷเร็วขึѸน ดังนัѸนการใหพ้ืѸนฐานในเรืѷองแนวทางการใช ้
Excel ทีѷดแีละถกูตอ้งจงึเป็นเรืѷองทีѷสําคัญมาก  
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แนวทางการใช ้Excel ทีѷดแีละถกูตอ้ง 

 เราตอ้งมุง่หวังทีѷจะใช ้Excel ใหไ้ดผ้ลงานมากขึѸนและเร็วขึѸนแบบคอมพวิเตอร ์นัѷนคอื 
ตอ้งสามารถนําแฟ้มทีѷสรา้งไวแ้ลว้กลับมาใชซ้ํѸาแลว้ซํѸาอกี โดยไมจํ่าเป็นตอ้งแกไ้ขสตูร
หรอืโครงสรา้งตารางทีѷสรา้งไวแ้ลว้อกีเลย 

 แยกโครงสรา้งตารางเป็น 3 ประเภท คอื ตารางทีѷใชเ้ก็บขอ้มลู(ตัวเลขและหรอืตัวอกัษร) 
ตารางสําหรับสรา้งสตูรคํานวณ และตารางสําหรับแสดงเป็นรายงาน 

 พงึระลกึไวเ้สมอวา่ สกัวนัหนึѷงขอ้มลูในแฟ้มจะถกูเก็บไวจ้นทําใหแ้ฟ้มใหญแ่ละ Excel 
ทํางานชา้ลง ดังนัѸนตอ้งเตรยีมโครงสรา้งตารางทีѷพรอ้มตอ่การโยกยา้ยไปเก็บไวท้ีѷแฟ้ม
อืѷน 

 ขอ้มลูทีѷเก็บไวใ้นตารางทีѷใชเ้ก็บขอ้มลูตอ้งจัดเก็บไวใ้นลักษณะโครงสรา้งฐานขอ้มลูทีѷ
สามารถนําไปใชก้บัเมนู Data หรอืใชก้บัสตูรพวก Lookup ไดทั้นท ี

 ขอ้มลูทีѷเป็นตัวเลข ตอ้งมคีา่เป็นตัวเลขอยา่งแทจ้รงิ ซึѷงมลัีกษณะทีѷตอ้งชดิขวาของ
เซลลโ์ดยไมจํ่าเป็นตอ้งใช ้Format 

 หา้มพมิพข์อ้มลูใดๆซํѸาโดยไมจํ่าเป็น แตใ่หใ้ชส้ตูรนําคา่สง่ตอ่ไปใชเ้มืѷอตอ้งการใช ้

ขอ้มลูนัѸนซํѸา 
 ในชทีหนึѷงๆ พยายามสรา้งสตูรเดยีวซึѷงสามารถนําไปใชไ้ดก้บัทกุตําแหน่งเซลลใ์นชที

นัѸนๆ ไมว่า่จะมกีารแกไ้ขทีѷทําใหตํ้าแหน่งโครงสรา้งตารางเปลีѷยนไปอยา่งไรก็ตาม 
 สตูรทีѷสรา้งขึѸนตอ้งใชห้ลักการคํานวณทีѷงา่ยตอ่การทําความเขา้ใจของตนเองและผูอ้ืѷน 

และเมืѷอทเีงืѷอนไขเปลีѷยนแปลงไปจากเดมิก็ไมจํ่าเป็นตอ้งแกไ้ขโครงสรา้งสตูรใหต้า่งไป
จากเดมิมากนัก 

 ตอ้งใชส้ตูรปรับคา่ในเซลลใ์หไ้ดค้า่ถกูตอ้งตามทีѷตอ้งการกอ่นแลว้จงึใชคํ้าสัѷง Format 
ปรับการแสดงผลของคา่นัѸนในภายหลัง 

 ในโครงสรา้งสตูร หา้มใสค่า่คงทีѷใดๆไวอ้ยา่งเด็ดขาด 
 แทนทีѷจะสรา้งสตูรยากๆยาวๆทีѷมสีว่นการคํานวณทีѷซํѸากนัลงไปในตารางนับพันนับหมืѷน

เซลล ์ซึѷงทําใหแ้ฟ้มใหญแ่ละคํานวณชา้ลง ควรหาทางกระจายโครงสรา้งสตูรออกเป็น
สตูรสั Ѹนๆหลายๆเซลลแ์ตใ่ชก้ารคํานวณครั Ѹงเดยีว เพืѷอทําใหแ้ฟ้มเล็กลงและคํานวณเร็ว
ขึѸน 

 อยา่ลมืวา่ ตารางทีѷเป็นสตูร จะมขีนาดแฟ้มใหญก่วา่ตารางทีѷเป็นตัวเลขหรอืตัวอกัษร 
ดังนัѸนแทนทีѷจะใชส้ตูรคํานวณคา่ใดๆทีѷเป็นคา่คงทีѷ เชน่ เลขลําดับ แนะนําใหใ้ชต้ารางทีѷ
เป็นตัวเลขผลจากการคํานวณแทนไปเลยดกีวา่ 
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 ในกรณีทีѷตอ้งสรา้งสตูรทีѷอา้งองิกบัตารางแนวนอนแนวตั Ѹง แนะนําใหเ้ลอืกตารางตาม
แนวนอนกอ่นตารางแนวตั Ѹงเพืѷอสรา้งมาตรฐานวธิสีรา้งสตูรของตนเอง และนอกจากนัѸน
ยังสอดคลอ้งกบัโครงสรา้งของสตูร Excel เชน่ Index หรอื Offset จะใชตํ้าแหน่งอา้งองิ
ตามแนวนอนกอ่นแนวตั Ѹงเสมอ 

 หากสรา้งสตูรทีѷตอ้งนํามาใชซ้ํѸาแลว้ซํѸาอกี ควรตั Ѹงชืѷอตําแหน่งเซลล ์(Range name) ทีѷ
สืѷอถงึทีѷไปทีѷมาของสตูร แทนการอา้งองิกบัตําแหน่งอา้งองิโดยตรง 

 ควรแยกสตูรทีѷไมจํ่าเป็นตอ้งคํานวณพรอ้มกนัออกเป็นแฟ้มแยกจากกนั (หรอือกีนัยหนึѷง 
ใหเ้ก็บเฉพาะสตูรทีѷตอ้งคํานวณพรอ้มกนัเทา่นัѸนไวใ้นแฟ้มเดยีวกนั) เพืѷอทําใหเ้รา
สามารถเลอืกเปิดแฟ้มตามขอบเขตการคํานวณทีѷชดัเจน และทําใหแ้ฟ้มมขีนาดเล็กลง 

 ใหเ้ลอืกใช ้VBA เฉพาะเมืѷอตอ้งการใช ้Excel ทีѷเหนอืกวา่ปกตจิากสตูรและเมนูคําสัѷงทีѷ
ทําได ้และรหัส VBA ทีѷใชต้อ้งสามารถใชไ้ดต้อ่เนืѷองไปตลอดแมโ้ครงสรา้งตารางจะ
เปลีѷยนแปลงตา่งไปจากเดมิก็ตาม 

 ทกุอยา่งมไีดก้็ตอ้งมเีสยี ไดอ้ยา่งก็ตอ้งเสยีอยา่ง ขอใหพ้จิารณาเปรยีบเทยีบขอ้ดี
ขอ้เสยีกอ่นทีѷจะสรา้งงาน เพืѷอใหเ้หมาะสมกบัเงืѷอนไขและสภาพแวดลอ้มของการ
ทํางาน 

แนวทางการลดความอว้น 

ลองคดิดวูา่ ถา้เราเก็บรายการขอ้มลูลงไปในชทีเต็มทั Ѹงหมดทกุ row แลว้ จะนําขอ้มลูรายการ
ใหมไ่ปเก็บไวท้ีѷไหน จะเริѷมตน้เก็บไวใ้นชทีใหมใ่นแฟ้มเดมิหรอืจะเปิดแฟ้มใหม?่ 

ผูใ้ช ้Excel สว่นมากชอบเก็บขอ้มลูไวเ้รืѷอยๆในชทีเดมิแฟ้มเดมิเพราะสะดวกในการคน้หา
เรยีกใช ้ซึѷงหากใชค้อมพวิเตอรร์ุน่ใหมม่คีวามเร็วสงูก็ไมต่อ้งรอนานนัก แตถ่า้เก็บขอ้มลูไวใ้น
แฟ้มเดมิตอ่ไปเรืѷอยๆ สดุทา้ยเจา้เครืѷองคอมพวิเตอรท์ีѷวา่ทํางานเร็วก็จะทํางานชา้ลงชา้ลง นีѷเป็น
เพราะเราชอบเก็บขอ้มลูไวใ้นแฟ้มเดมิตอ่กนัไป และก็ไมเ่คยมคีวามจําเป็นตอ้งใชข้อ้มลูทั Ѹงหมด
ทีѷเก็บไวพ้รอ้มกนัสกัครั Ѹงเดยีว 

แลว้สตูรคํานวณทีѷสรา้งไว ้มันตอ้งถกูนํามาคํานวณใหมพ่รอ้มกนัทกุครั Ѹงทีѷมขีอ้มลูเปลีѷยนแปลง
ไปแคเ่ซลลเ์ดยีวหรอืไม ่สตูรทีѷคํานวณหาตน้ทนุสนิคา้หรอืคา่ใชจ้า่ยซึѷงมคีา่คงทีѷ ซึѷงนานๆจงึจะ
มคีา่เปลีѷยนแปลงไปสกัท ีจําเป็นหรอืทีѷรวมตารางคํานวณคา่คงทีѷเหลา่นัѸนไวใ้นแฟ้มซึѷงมสีตูร
คํานวณยอดกําไรจากการขาย 
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จากนัѸนเมืѷอถงึคราวตอ้งนําขอ้มลูนับพันนับหมืѷนบรรทัด หรอืตารางรายงานทีѷตอ้งพมิพนั์บรอ้ยนับ
พันหนา้มาแสดงใหด้นัูѸน เราใชส้ายตาดตูารางทั Ѹงหมดหรอืกระดาษทกุแผน่ทีѷพมิพอ์อกมาพรอ้ม
กนัทกุหนา้หรอืไม?่ 

ผูส้รา้งงานตอ้งพจิารณาถงึประเด็นดังกลา่วขา้งตน้ไวเ้สมอ ตอ้งพรอ้มทีѷจะแยกขอ้มลูทีѷเก็บไวใ้น
แฟ้มไปเก็บไวใ้นแฟ้มอืѷน ขอ้มลูใดทีѷจําเป็นตอ้งเก็บไวใ้ช ้เพืѷอหาผลลัพธท์ีѷตอ้งการจากการ
คํานวณรว่มกนัทกุครั Ѹง ก็ควรจัดเก็บไวใ้นแฟ้มเดยีวกบัตารางทีѷเป็นสตูรคํานวณ แตถ่า้ไม่
จําเป็นตอ้งใชคํ้านวณพรอ้มกนัก็ควรแยกออกเป็นแฟ้มตา่งหากทําใหแ้ฟ้มมขีนาดเล็กลง แลว้จงึ
ใชส้ตูร link ขอ้มลูขา้มแฟ้มมาใชคํ้านวณตอ่ตามแตว่า่เราจะเลอืกเอาขอ้มลูมาใชจ้ากแฟ้มไหน 
ซึѷงจะชว่ยใหใ้ชต้ารางสตูรหนา้เดยีวตารางเดยีวแตส่ามารถคํานวณผลลัพธไ์ดต้ามแตข่อ้มลูทีѷ 
link มาใชอ้กีตอ่หนึѷง  

ในกรณีทีѷ link ขอ้มลูขา้มชที ใหใ้ชส้ตูร Indirect เลอืกนําขอ้มลูจากชืѷอชทีทีѷตอ้งการมาใชใ้น
ชทีคํานวณ สว่นกรณีทีѷ link ขา้มแฟ้ม ใหใ้ชคํ้าสัѷง Change Source เพืѷอเลอืกชืѷอแฟ้มทีѷตอ้งการ
มาใชใ้นแฟ้มคํานวณ 
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ผลจากสตูรทีѷมตีอ่ขนาดแฟ้มและความเร็วในการคาํนวณ 

ขอนําผลการทดสอบจากการใชส้ตูรคํานวณหลายหลายประเภทมาเลา่สูก่นัฟัง และขอใหล้อง
หาขอ้สรปุกนัเองวา่ สตูรแบบไหนดกีวา่กนัและเพราะเหตใุด (โดยการทดสอบนีѸไดจ้ากการสรา้ง
สตูรลงไปในตารางขนาดใหญต่ั Ѹงแตเ่ซลล ์D1:D55,000 และใช ้Excel 2003 กบั Pentium D 
3.0 GHz)  

กรณีใชส้ตูร SumIF เพืѷอหายอดรวมตามเงืѷอนไขเดยีว 

 สตูร SumIF ใชเ้วลา 4 วนิาท ี/ ขนาดแฟ้ม 2,984 KB เชน่ 
=SumIF(IDRange,ID,NumRange) 

 สตูร SumIFArray ใชเ้วลา 38 วนิาท ี/ ขนาดแฟ้ม 6,089 KB เชน่ 
{=Sum(IF(IDRange=ID,NumRange))} 

 สตูร SumArray ใชเ้วลา 47 วนิาท ี/ ขนาดแฟ้ม 5,547 KB เชน่ 
{=Sum((IDRange=ID)*NumRange)} 

 สตูร SumProduct แบบใสเ่ครืѷองหมาย -- ใชเ้วลา 44 วนิาท ี/ ขนาดแฟ้ม 2,987 KB
เชน่ =SumProduct(--(IDRange=ID),NumRange) 

 สตูร SumProduct แบบใสเ่ครืѷองหมายคณู ใชเ้วลา 50 วนิาท ี/ ขนาดแฟ้ม 2,986 KB
เชน่ =SumProduct((IDRange=ID)*NumRange) 

กรณีใชส้ตูร SumIF เพืѷอหายอดรวมตามเงืѷอนไข 2 เง ืѷอนไขตอ่เนืѷองกนั 

 สตูร SumIF ใชไ้ดเ้พยีงเงืѷอนไขเดยีวจงึไมไ่ดนํ้ามาทดสอบ 
 สตูร SumIFArray ใชเ้วลา 2 นาท ี23 วนิาท ี/ ขนาดแฟ้ม 9,716 KB เชน่ 

{=Sum(IF(IDRange=ID,IF(KeyRange=Key,NumRange)))} 
 สตูร SumArray ใชเ้วลา 2 นาท ี39 วนิาท ี/ ขนาดแฟ้ม 8,633 KB เชน่ 

{=Sum((IDRange=ID)*(KeyRange=Key)*NumRange)} 
 สตูร SumProduct แบบใสเ่ครืѷองหมาย -- ใชเ้วลา 2 นาท ี30 วนิาท ี/ ขนาดแฟ้ม 

5,168 KB เชน่ =SumProduct(--(IDRange=ID),--(KeyRange=Key),NumRange) 
 สตูร SumProduct แบบใสเ่ครืѷองหมายคณู ใชเ้วลา 2 นาท ี33 วนิาท ี/ ขนาดแฟ้ม 

5,165 KB เชน่ =SumProduct((IDRange=ID)*(KeyRange=Key),NumRange) 
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 สตูร SumProduct แบบใสเ่ครืѷองหมายคณูทกุตัว ใชเ้วลา 2 นาท ี42 วนิาท ี/ ขนาด
แฟ้ม 5,166 KB เชน่ 
=SumProduct((IDRange=ID)*(KeyRange=Key)*NumRange) 

 สตูร SumProduct แบบใสเ่ครืѷองหมายคณู 1 ใชเ้วลา 2 นาท ี50 วนิาท ี/ ขนาดแฟ้ม 
5,171 KB เชน่ =SumProduct((IDRange=ID)*1,(KeyRange=Key)*1,NumRange) 

กรณีใชส้ตูร VLookup VS Match 

 VLookup แบบ Approaching Match ใชเ้วลาไมถ่งึ 1 วนิาท ี/ ขนาดแฟ้ม 2,979 KB 
แตถ่า้หาคา่ไมพ่บ (Not Available) ใชเ้วลา 3 วนิาท ีเชน่ 
=VLookup(ID,DataRange,2) 

 Match แบบ Approaching Match ใชเ้วลาไมถ่งึ 1 วนิาท ี/ ขนาดแฟ้ม 2,976 KB แต่
ถา้หาคา่ไมพ่บ (Not Available) จะแสดงตําแหน่งสดุทา้ย ใชเ้วลาไมถ่งึ 1 วนิาท ีเชน่ 
=Match(ID,IDRange)  

 VLookup แบบ Exact Match ขนาดแฟ้ม 2,981 KB โดยจะใชเ้วลานานขึѸนหากตําแหน่ง
คา่ทีѷใชห้าหา่งจากบรรทัดแรกมากขึѸน แตถ่า้หาคา่ไมพ่บ (Not Available) ใชเ้วลา 7 
วนิาท ีเชน่ =VLookup(ID,DataRange,2,0)  

 Match แบบ Exact Match ขนาดแฟ้ม 2,979 KB โดยจะใชเ้วลานานขึѸนหากตําแหน่ง
คา่ทีѷใชห้าหา่งจากบรรทัดแรกมากขึѸน เชน่ =Match(ID,IDRange,0) 

นอกจากนัѸนยังไดท้ดสอบสตูรบวกลบคณูหาร ซึѷง Excel คํานวณเร็วมากใชเ้วลาคํานวณไมถ่งึ
วนิาท ีแตพ่บวา่ขนาดแฟ้มจะเล็กหรอืใหญข่ึѸนกบัความยาวของสตูรทีѷใช ้เชน่ =1+2+3+4+5 มี
ขนาดแฟ้มใหญก่วา่ =A2+5 โดยทีѷ A2 มสีตูร =1+2+3+4 เพืѷอคํานวณสว่นแรกแยกไวก้อ่น 
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เมืѷอตอ้งเลอืกระหวา่งขนาดแฟ้มหรอืความเร็วในการคาํนวณ 

ประเด็นเรืѷองความอว้นอุย้อา้ยของแฟ้มตามทีѷกลา่วมาทัѸงหมดในบทความนีѸจะไมเ่ป็นสาระสําคัญ
หากคดิแตเ่พยีงวา่ ถา้แฟ้มใหญข่ึѸน หรอืคอมพวิเตอรช์า้ลง เราก็ซืѸอคอมพวิเตอรเ์ครืѷองใหมห่รอื
ซืѸอ RAM มาเพิѷมหน่วยความจําในเครืѷองใหม้ากขึѸนก็แกปั้ญหาไดแ้ลว้ แตถ่า้คดิกนังา่ยๆเชน่นีѸ 
ปัญหาทีѷเกดิจากการใช ้Excel จะยิѷงมคีวามสลับซบัซอ้นมากขึѸน โดยเฉพาะอยา่งยิѷงเมืѷอใช ้
Excel 2007 ขึѸนไป โดยในชทีหนึѷงมกีวา่ 10,000 column และกวา่ 1 ลา้น row ซึѷงยอ่มทําให ้
ผูใ้ช ้Excel ทีѷขาดความรูพ้ืѸนฐาน และขาดวนัิยในการสรา้งงาน สรา้งแฟ้มงานทีѷจะยอ้นกลับมาทํา
รา้ยตัวเองในทีѷสดุ 

แตถ่า้ตอ้งเลอืกระหวา่งขนาดแฟ้มหรอืความเร็วในการคํานวณ ในความคดิเห็นสว่นตัวขอเลอืก
ความเร็วในการคํานวณวา่มคีวามสําคัญมากกวา่เรืѷองของขนาด เพราะปัญหาเรืѷองขนาดแฟ้มเป็น
ปัญหาทีѷแกไ้ขไดไ้มย่าก แคห่าทางแยกตารางทีѷไมจํ่าเป็นตอ้งถกูเรยีกใชง้านพรอ้มกนัออกไป
เก็บเป็นแฟ้มตา่งหากก็ทําใหแ้ฟ้มเล็กลงเรยีบรอ้ยแลว้ และแมจ้ะแยกตารางออกเป็นแฟ้มเล็กๆ
ไมไ่ด ้เรายังสามารถจัดเก็บแฟ้มลงไปในสืѷอไดห้ลายชนดิ ไมว่า่จะเป็น USB Drive, CD, DVD, 
หรอืฮารด์ดสิก ์ซึѷงปัจจบุันมคีวามจมุากขึѸนกวา่แตก่อ่นมากในขณะทีѷมรีาคาลดลง 

สว่นประเด็นในเรืѷองความเร็วของการคํานวณนัѸนแมถ้อืวา่สําคัญกวา่เรืѷองขนาดแฟ้ม แตค่วามเร็ว
เป็นเรืѷองของความรูส้กึ เป็นเรืѷองยากทีѷจะหาเกณฑม์าวัดวา่อยา่งนีѸเร็วหรอืชา้ มักใชค้วามรูส้กึ
ของคนทีѷตอ้งนัѷงรอคอยคําตอบเป็นตัวชีѸวัด ถา้ยังรอกนัได ้ก็ยังไมเ่ดอืดรอ้นหาทางอืѷนทีѷจะทําให ้
แฟ้มคํานวณเร็วขึѸน ดังนัѸนประเด็นเรืѷองความเร็วในการคํานวณ จงึตอ้งถอืเป็นภาระหนา้ทีѷของ
ผูส้รา้งงาน ตอ้งคอยตดิตามเสมอวา่สตูรหรอืวธิทีีѷตนเพิѷงสรา้งใหมล่งไปในตาราง สง่ผลใหแ้ฟ้ม
งานนัѸนคํานวณชา้ลงไปกวา่เดมิอยา่งผดิสงัเกตหรอืไม ่และตอ้งลองสรา้งสตูรหลายๆแบบทีѷ
สามารถใหคํ้าตอบเดยีวกนั แตใ่ชเ้วลาคํานวณเร็วทีѷสดุ ซึѷงควรพจิารณาผลในระยะยาวทีѷมตีอ่
ตัวเองหรอืผูอ้ืѷนทีѷรว่มใชแ้ฟ้มงานเดยีวกนัดว้ยวา่ ทกุคนสามารถใชแ้ฟ้มงานไดส้ะดวก เมืѷอ
ตอ้งการยอ้นกลับมาปรับปรงุแกไ้ข ตอ้งสามารถทําไดง้า่ยในระยะเวลารวดเร็ว แมจ้ะทําใหแ้ฟ้มมี
ขนาดใหญข่ึѸน และคํานวณชา้ลงก็ตาม 
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การออกแบบโครงสรา้งตารางคาํนวณ 

ในโปรแกรม Microsoft Excel มอีงคป์ระกอบอยูส่องอยา่งแทบไมเ่ปลีѷยนแปลงเลยในหลายยคุ
หลายสมัยทีѷผา่นไป ไมว่า่จะเป็น Excel รุน่ใดก็ตามยังคงมสี ิѷงนีѸใชก้นัเรืѷอยมา สิѷงทีѷวา่นีѸก็คอื 
ตารางทีѷประกอบดว้ยเซลลม์หีลาย row หลาย column และสตูรสําเร็จรปูอกีหลายรอ้ยสตูรตดิ
มาพรอ้มกบัตัวโปรแกรม ซึѷงผูใ้ดสามารถนําตารางและสตูรมาใชร้ว่มกนัไดเ้ป็นอยา่งด ีจะทําให ้
ใชโ้ปรแกรม Excel ทีѷมรีาคาไมก่ีѷหมืѷนบาททํางานไดย้ดืหยุน่กวา่โปรแกรมสําเร็จรปูราคาแพง
เป็นแสนเป็นลา้นบาททเีดยีว 

บทความนีѸจะแนะนําคณุใหห้าทางใชต้าราง Excel อยา่งสรา้งสรรค ์เพืѷอใชคํ้านวณหาผลลัพธใ์น
ปัญหาตา่งๆไดส้ารพัด เพยีงแคนํ่าตารางและสตูรสําเร็จรปูของ Excel มาใชร้ว่มกนัอยา่งมี
หลักการ อยา่งเป็นขั Ѹนเป็นตอน และอยา่งมเีหตผุล จะชว่ยใหค้ณุไดร้ับประโยชนม์ากขึѸนกวา่แต่
กอ่น เชน่ 

1. สามารถคํานวณหาคําตอบในปัญหาทีѷไมเ่คยคดิวา่ Excel จะทําไดม้ากอ่น  

2. สตูรสั Ѹนลง และสามารถแกไ้ขสตูรไดง้า่ยและรวดเร็ว  

3. สามารถตรวจสอบความถกูตอ้งของการคํานวณในทกุขั Ѹนตอน  

4. สามารถขยายขนาดหรอืเคลืѷอนยา้ยตําแหน่งเซลล ์เพืѷอนําตารางไปใชซ้ํѸาใน
เซลลอ์ืѷน ชทีอืѷนหรอืแฟ้มอืѷนไดทั้นท ี 

5. สามารถนําตารางไปใชใ้นงานคํานวณอืѷนทีѷใชห้ลักการเดยีวกนัไดทั้นท ีหรอื
หลังจากผา่นการปรับปรงุเพยีงเล็กนอ้ย  

6. สามารถนําตารางไปใชง้านรว่มกบัเมนูคําสัѷงของ Excel ไดท้กุเมืѷอ แมแ้ตก่ารนํา
ขอ้มลูไปแสดงผลตอ่ในรปูกราฟ  

7. แฟ้มคํานวณเร็วและมขีนาดแฟ้มเล็กลง แมจ้ะมตีารางขนาดใหญก่็ตาม 

ตารางคาํนวณคอือะไร 

เพืѷอทําใหเ้ขา้ใจตรงกนั จงึขอใหคํ้าจํากดัความในความหมายของตารางคํานวณกอ่นวา่ ตาราง
คํานวณในบทความนีѸมไิดห้มายถงึพืѸนทีѷตารางวา่งๆทีѷคณุจะเห็นทันทบีนจอเมืѷอเปิดโปรแกรม 
Excel ขึѸนมาใชง้าน แตต่ารางคํานวณในทีѷนีѸมคีวามหมายถงึตารางซึѷงคณุสรา้งขึѸนมาเองโดยมี
ขอ้มลูบันทกึไวแ้ลว้ อาจเป็นขอ้มลูตัวเลข ตัวอกัษร หรอืสตูรใดๆก็ได ้ทั ѸงนีѸมเีจตนาเพืѷอใชพ้ืѸนทีѷ
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เซลลห์รอืตารางนัѸนในการคํานวณหาคําตอบทีѷคณุตอ้งการโดยเฉพาะ เชน่ ตารางคํานวณคา่แรง
ทีѷตอ้งจา่ยใหล้กูจา้งทํางานในแตล่ะกะ ตารางคํานวณยอดตน้ทนุขายแบบ Fist-in First-
out ตารางคํานวณหาจํานวนสนิคา้ทีѷตอ้งวางแผนสัѷงผลติ (Material Requirements Planning) 
หรอืตารางคํานวณเพืѷอวางแผนการลงทนุ (Feasibility Study) เป็นตน้ 

ตารางทีѷไมถ่อืวา่เป็นตารางคํานวณในบทความนีѸ ไดแ้ก ่ตารางฐานขอ้มลูซึѷงใชบ้ันทกึขอ้มลูดบิ
(ไมม่สีตูร) ตารางรายงานทีѷจัดโครงสรา้งเพืѷอพมิพใ์นกระดาษหรอืแสดงผลใหเ้ห็นบนจอ หรอื
ตารางทีѷ Excel จัดโครงสรา้งใหเ้องอัตโนมัตจิากการใชคํ้าสัѷงบนเมนู SubTotals หรอื Pivot 
Table 

ตารางคํานวณโดยทัѷวไปประกอบดว้ยพืѸนทีѷตารางยอ่ย 2 สว่น สว่นแรกเป็นพืѸนทีѷตารางสําหรับ
เก็บคา่ตัวแปรทีѷใชใ้นการคํานวณ และพืѸนทีѷตารางอกีสว่นหนึѷงใชส้ําหรับสรา้งสตูรคํานวณซึѷงรับ
คา่มาจากคา่ตัวแปรในพืѸนทีѷสว่นแรกนัѷนเอง โดยผูใ้ชง้านจะใชพ้ืѸนทีѷสว่นแรกในการพมิพค์า่ตัว
แปรตัวใหมล่งไป จากนัѸนจะแสดงคําตอบจากการคํานวณใหเ้ห็นในตารางสว่นทีѷเป็นสตูรคํานวณ 

ขอ้ควรพจิารณากอ่นเร ิѷมสรา้งตารางคาํนวณ 

สมมตวิา่คณุกําลังหาทางคํานวณคา่แรงทีѷตอ้งจา่ยใหล้กูจา้งทํางานในแตล่ะกะ จะตอ้งคดิ
พจิารณาอะไรบา้ง 

1. กําหนดขอบเขตของความตอ้งการของคณุทีѷเป็นไปไดว้า่มอีะไรบา้ง 
เชน่ ตอ้งการใชต้ารางในชทีหนึѷงเพืѷอคํานวณคา่แรงของพนักงานคนหนึѷงซึѷง
ทํางานในวันหนึѷง หรอืตอ้งการใชต้ารางในชทีหนึѷงเพืѷอคํานวณคา่แรงของ
พนักงานคนหนึѷงซึѷงทํางานในเดอืนหนึѷงโดยแสดงเป็นรายวันตอ่เนืѷองกนัไป หรอื
ตอ้งการคํานวณคา่แรงของพนักงานทกุคนในวันหนึѷงๆ หรอืตอ้งการคํานวณ
คา่แรงใหก้บัพนักงานทกุคนในเดอืนหนึѷงโดยแสดงเป็นรายวันตอ่เนืѷองกนัไป 
หรอืมคีวามตอ้งการอืѷนๆอกีบา้งไหม ทั ѸงนีѸเพืѷอหาทางสรา้งตารางคํานวณเพยีง
ตารางเดยีวแตต่อ้งมคีวามยดืหยุน่สามารถนําไปใชคํ้านวณไดท้กุกรณีตามทีѷคณุ
ตอ้งการ(ทั Ѹงทีѷเคยตอ้งการในอดตีและอาจจะมมีากขึѸนในอนาคต)  

2. คน้หาเงืѷอนไขทัѸงหมดทีѷเกีѷยวขอ้งในการคํานวณ ซึѷงโดยทัѷวไปผูท้ีѷคลกุคลกีบัการ
บรหิารการจา้งแรงงานยอ่มตอ้งมเีงืѷอนไขทีѷตนนําไปใชใ้นงานอยูแ่ลว้ เชน่ 
เงืѷอนไขเกีѷยวกบัชว่งเวลาหรอืกะทีѷกําหนดใหทํ้างานในแตล่ะวันแบง่เป็นกีѷชว่ง แต่
ละชว่งใชเ้วลาทํางานมากนอ้ยเพยีงไร แบง่เป็นชว่งเวลาหยดุพักกีѷครั Ѹง แตล่ะครั Ѹง
ใหห้ยดุพักไดน้านเทา่ใด ลกูจา้งตอ้งตอกบัตรหรอืบันทกึการเขา้ทํางานไว ้
อยา่งไร บรษัิทมเีงืѷอนไขในการจา่ยคา่จา้งแรงงานเป็นอยา่งไร ซึѷงเงืѷอนไขเหลา่นีѸ
จะตอ้งหาทางนํามาใชใ้นการคํานวณ  
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3. ในอดตีจนถงึปัจจบุันใชว้ธิกีารคํานวณคา่แรงอยา่งไร มขีั Ѹนตอนการคํานวณทีѷ
ชดัเจนเป็นมาตรฐานทีѷใชก้นัไดต้ลอดมาหรอืไม ่หรอืมกีรณีพเิศษใดบา้งทีѷทําให ้
ตอ้งคํานวณวธิอีืѷนตา่งจากทีѷเป็นมาตรฐานนัѸน ใหเ้ก็บรวบรวมตวัเลขทีѷใชใ้นแตล่ะ
ชว่งแตล่ะกรณีเอาไวเ้พืѷอนํามาใชเ้ป็นตัวอยา่งสรา้งตารางคํานวณใน Excel และ
เพืѷอใชเ้ปรยีบเทยีบผลคํานวณทีѷเกดิขึѸนวา่ตรงกนัหรอืไม ่ 

4. คน้หาความเป็นไปไดท้กุทางทีѷลกูจา้งคนหนึѷงจะเขา้งานในชว่งเวลาทีѷกําหนด ซึѷง
ในกรณีปัญหาการเขา้งานนีѸพบวา่มโีอกาสความเป็นไปไดท้ีѷจะมชีว่งเวลาทํางาน
ซึѷงสมัพันธก์บัชว่งเวลาทีѷกําหนดหรอืกะหนึѷงๆถงึ 7 กรณี เชน่ ถา้สมมตวิา่
กําหนดใหก้ะทํางานจาก 8:00 ถงึ 10:00 น. ลกูจา้งสามารถมชีว่งทํางานตรงกบั
กะ(8:00-10:00) อยูภ่ายในกะ(8:30-9:00) ครอ่มกะทั Ѹงกอ่นและหลัง(7:00-
12:00) ครอ่มกะเพยีงชว่งเริѷมงาน(7:00-9:00) ครอ่มกะเพยีงชว่งเลกิงาน(9:00-
12:00) นอกกะชว่งกอ่นกะ(6:00-7:00) และนอกกะชว่งหลังกะ(11:00-12:00) 
ซึѷงคณุจะตอ้งหาทางคดิสตูรเพยีงสตูรเดยีวใหส้ามารถคํานวณไดค้รบทัѸง 7 กรณ ี 

5. ขอใหย้ดึหลักวา่ อยา่พยายามคดิหาสตูรลัดเพืѷอคํานวณหาคําตอบใหแ้ลว้เสร็จ
โดยใชเ้ซลลส์ตูรเพยีงเซลลเ์ดยีว เพราะนอกจากสตูรจะตอ้งยาวเหยยีดซอ้นสตูร
กนัหลายชั Ѹนจนแกะแทบไมอ่อกแลว้ ยังอาจเป็นไปไมไ่ดเ้ลยทีѷจะคดิหาสตูร
ขึѸนมาใชไ้ด ้และคณุอาจป่วยเป็นโรคกระเพาะเพราะมัวแตค่ดิสตูรอยูทั่ Ѹงวันทั Ѹงคนื  

6. แทนทีѷจะคดิสตูรลัดสตูรเดยีวเซลลเ์ดยีว ขอใหแ้บง่การคํานวณออกเป็นขั Ѹนๆ แลว้
หาทางใชส้ตูรสําเร็จรปูทีѷ Excel มอียูใ่หไ้ดก้อ่น แตห่ากไมม่สีตูรสําเร็จรปูทีѷหา
คําตอบไดโ้ดยตรง คณุตอ้งหาทางนําสตูรสําเร็จรปูทีѷมมีาใชร้ว่มกนัโดยอาจนํามา
ซอ้นสตูรกนัในเซลลเ์ดยีว หรอืใชเ้ซลลแ์ยกคํานวณทลีะขั Ѹน แลว้จงึนําผลลัพธท์ีѷ
ไดจ้ากเซลลห์นึѷงสง่ไปคํานวณตอ่ในสตูรของอกีเซลลห์นึѷง กลายเป็นทีѷมาของ
ตารางคํานวณนัѷนเอง  

7. ลองคน้หาวธิกีารคํานวณจากอนิเตอรเ์น็ต เชน่ คน้หาจาก Google เพืѷอเรยีนรูจ้าก
ตัวอยา่งของคนอืѷน คณุอาจโชคดไีดต้ัวอยา่งทีѷตรงตามทีѷคณุตอ้งการ สามารถ
นําไปใชต้อ่ไดเ้ลย หรอืแคนํ่าไปดัดแปลงเพยีงเล็กนอ้ยกอ่นก็ใชก้บังานของคณุ
ไดแ้ลว้ ซึѷงแมว้า่จะไดต้ัวอยา่งไมต่รงกบัสิѷงทีѷตอ้งการก็ตาม แตต่ัวอยา่งเหลา่นัѸน
น่าจะเป็นแนวทางใหค้ณุไดค้ดิพจิารณาและเกดิมมุมองทีѷกวา้งขวางและชดัเจน
กวา่เดมิ 

 ข ัҟนตอนการสรา้งตารางคาํนวณ 

หลังจากทีѷไดพ้จิารณาขอบเขตความตอ้งการและพอไดเ้ห็นแนวทางสรา้งงานทีѷคนอืѷนใชก้นัมา
กอ่นแลว้บา้ง คราวนีѸก็ถงึประเด็นสําคัญวา่พอเปิดโปรแกรม Excel ขึѸนมาแลว้ คณุจะเริѷมตน้
ออกแบบตารางกนัอยา่งไรด ีซึѷงลักษณะของตารางคํานวณนีѷเองทีѷจะชีѸใหเ้ห็นฝีไมล้ายมอืวา่ใคร
เยีѷยมยทุธก์วา่กนั ถา้เทยีบกบัการสรา้งบา้นสกัหลังหนึѷงแลว้ ขอ้พจิารณาทีѷผา่นไปเป็นเพยีงแค่
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การออกแบบครา่วๆและเตรยีมซืѸออปุกรณ์กอ่สรา้ง หนิ ทราย ปนูซเิมนต ์เตรยีมไวไ้มใ่หข้าด
ไมใ่หเ้กนิกวา่ความจําเป็น ขั ѸนจากนีѸเป็นหนา้ทีѷของสถาปนกิและวศิวกรทีѷจะตอ้งลงมอืกอ่สรา้ง
บา้นของจรงิใหส้วยหร ูดดู ีอยูส่บาย อากาศถา่ยเทสะดวก และสามารถตกแตง่ตอ่เตมิใหน่้าอยู่
ไปชัѷวลกูชัѷวหลาน 

กอ่นอืѷนผมจําเป็นตอ้งขอเตอืนใหท้ราบขอ้ผดิพลาดทีѷผูใ้ช ้Excel ทัѷวไปมักคดิออกแบบตาราง
อยา่งรวบรัดเกนิไป โดยการพยายามนําตารางคํานวณไปรวมกบัตารางทีѷใชพ้มิพอ์อกไปเป็น
รายงานหรอืแสดงผลลัพธท์ีѷตอ้งการบนหนา้จอคอมพวิเตอรไ์วเ้ป็นตารางเดยีวกนั ซึѷงความคดิ
เชน่นีѸจะกลายเป็นอปุสรรคสําคัญทําใหไ้มส่ามารถใชเ้ซลลต์อ่เนืѷองกนัเพืѷอจัดการคํานวณทลีะ
ลําดับ จงึขอแนะนําใหค้ดิแยกตารางคํานวณออกเป็นพืѸนทีѷตา่งหากแยกจากตารางทีѷใชพ้มิพ์
รายงาน แมต้อ้งทําใหเ้สยีพืѸนทีѷเซลลม์ากขึѸนโดยอาจตอ้งแยกออกเป็นชทีหลายๆชที แตจ่ะชว่ย
ทําใหส้ามารถออกแบบโครงสรา้งตารางคํานวณไดอ้ยา่งอสิระ แลว้ตอ่เมืѷอตารางคํานวณนีѸ
สามารถคํานวณหาคําตอบไดต้ามทีѷตอ้งการแลว้ จงึคอ่ยนําผลลัพธท์ีѷได ้link ไปประกอบกนัเป็น
ตารางรายงานในทีѷสดุ 

โครงสรา้งพืѸนฐานของตารางคํานวณ ประกอบดว้ยสว่นทีѷเป็นพืѸนทีѷตารางสําหรับรับคา่ตัวแปร 
และพืѸนทีѷตารางสําหรับสรา้งสตูรคํานวณ โดยใหย้ดึหลักวา่สตูรทีѷสรา้งขึѸนในตารางคํานวณนัѸน 
หากเป็นไปไดข้อใหค้ดิสรา้งสตูรลงไปในเซลลแ์รกเซลลเ์ดยีวทีѷหัวมมุซา้ยบนสดุของตาราง 
จากนัѸนเมืѷอ copy สตูรนีѸไปใชท้ีѷเซลลส์ว่นอืѷนในตารางตอ้งสามารถใชส้ตูรเดมินัѸนไดโ้ดยไม่
จําเป็นตอ้งแกไ้ขสตูรใหแ้ตกตา่งกนัไปจากเดมิแตอ่ยา่งใด หรอือกีนัยหนึѷงใหใ้ชส้ตูรเดยีวกบัทกุ
เซลลใ์นตารางคํานวณใหไ้ด ้แตถ่า้ไมส่ามารถสรา้งสตูรเดยีวทีѷเซลลห์ัวมมุ ก็ขอใหพ้ยายาม
สรา้งสตูรเดยีวในแตล่ะแนว row หรอื column 

เพืѷอทําใหเ้ห็นโครงสรา้งตารางคํานวณแบบงา่ยๆ ขอยกตัวอยา่งการสรา้งตารางคํานวณสตูรคณู
มาพจิารณากนัตามรปูตอ่ไปนีѸ  
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รปูตารางนีѸเป็นตัวอยา่งการคํานวณสตูรคณูแม ่2 ถงึ 5 โดยกําหนดใหนํ้าไปคณูเลข 1 ถงึ 5 

 ใหแ้ยกเซลลร์ับตัวแปรวางไวต้ามแนวคูข่นานกบัพืѸนทีѷคํานวณโดยอาจวางไวเ้ป็น
แนวหัวตารางดา้นบน (C2:F2) หรอืหวัตารางดา้นขา้ง (B3:B7) ซึѷงตัวแปรทีѷวา่นีѸ
เป็นเซลลร์ับตัวเลขทีѷคณุอาจมคีวามตอ้งการเปลีѷยนแปลงเป็นคา่อืѷนในอนาคต   

 C3:F7 เป็นพืѸนทีѷเซลลท์ีѷคณุตอ้งหาทางสรา้งสตูรลงไปทกุเซลล ์โดยใหส้รา้ง
สตูรลงไปทีѷเซลล ์C3 ซึѷงเป็นตําแหน่งเซลลห์ัวมมุซา้ยบนเพยีงเซลลเ์ดยีว ใหม้ี
สตูร =C$2*$B3 จากนัѸนให ้copy ไป paste ทกุเซลลใ์นพืѸนทีѷ C3:F7 

โปรดสงัเกตวา่ตัวอยา่งสตูรคณูนีѸเป็นตัวอยา่งการนําคา่ไปคํานวณแบบ 1 ตอ่ 1 หมายถงึ เซลล์
สตูรหนึѷงๆจะรับคา่จากเซลลต์ัวแปรตามแนวนอนหรอืแนวตั Ѹงเพยีงขา้งละ 1 เซลลเ์ทา่นัѸน ซึѷงใน
ปัญหาอืѷนอาจจําเป็นตอ้งใชก้ารคํานวณทีѷซบัซอ้นมากขึѸน โดยเซลลส์ตูรหนึѷง จะใชเ้ซลลต์ัวแปร
มากกวา่เซลลเ์ดยีวก็เป็นไดโ้ดยใชส้ตูรพวก Lookup ชว่ยในการเลอืกขอ้มลูมาใชคํ้านวณ 

นอกจากเซลลส์ตูรจะรับคา่มาจากเซลลต์ัวแปรแลว้ เซลลส์ตูรยงัอาจรับคา่ตอ่มาเซลลส์ตูร
คํานวณในขั Ѹนกอ่นไดอ้กี ซึѷงจะเห็นไดช้ดัจากตารางคํานวณงบการเงนิหรอืวางแผนการผลติทีѷมี
ยอดคงเหลอืปลายงวดสง่ตอ่ไปตั Ѹงเป็นยอดคงเหลอืตน้งวดของชว่งเวลาถัดไป 

ตารางคํานวณทีѷดตีอ้งมคีวามยดืหยุน่สามารถคํานวณใหผ้ลลัพธไ์ดต้ามตอ้งการตลอดไปไมว่า่จะ
มกีารโยกยา้ยหรอืแยกตารางตัวแปรไปวางไวท้ีѷชทีอืѷนเหนอืแฟ้มอืѷน ดังนัѸนพอสรา้งตาราง
คํานวณเสร็จ ขอใหท้ดลอง cut ตารางไปวางไวท้ีѷตําแหน่งอืѷนหรอืโยกยา้ยเซลลต์ัวแปรแยก
ออกจากกนั เพืѷอพสิจูนว์า่ตารางคํานวณยังคงสามารถใหผ้ลลัพธถ์กูตอ้งตามเดมิหรอืไม ่

ตวัอยา่งตารางคาํนวณหาระยะเวลาทีѷใชใ้นกะ 

สมมตวิา่ลกูจา้งคนหนึѷงเขา้งานตั Ѹงแตเ่วลา 7:00-9:00 น. ใหส้รา้งตารางคํานวณหาระยะเวลาทีѷ
เขาทํางานในกะทีѷกําหนดซึѷงเริѷมตั Ѹงแตเ่วลา 8:00-10:00 น.  

จากคําถามขา้งตน้นีѸ คณุคงคดิคําตอบในใจไดว้า่ตอ้งทํางานในกะเป็นเวลา 1 ชัѷวโมงใชไ่หม 
เพราะลกูจา้งคนนีѸออกจากงานเวลา 9:00 น. จงึนับระยะเวลาตั Ѹงแตเ่ริѷมกะตอน 8:00 น. ไป
จนถงึเวลาทีѷเขาออกจากงาน ไดเ้ป็นระยะเวลา 1 ชัѷวโมง (8:00-9:00) ซึѷงคงหาทางสรา้งสตูร
คํานวณไดไ้มย่าก แตถ่า้เขามชีว่งทีѷเขา้ทํางานหลากหลายกรณีจะใชส้ตูรอยา่งไร 

1. ตรงกบักะ (8:00-10:00)  

2. อยูภ่ายในกะ (8:30-9:00)  
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3. ครอ่มกะ ทั Ѹงกอ่นและหลัง (7:00-12:00)  

4. ครอ่มกะ เพยีงชว่งเริѷมงาน (7:00-9:00)  

5. ครอ่มกะเพยีงชว่งเลกิงาน (9:00-12:00)  

6. นอกกะ ชว่งกอ่นกะ (6:00-7:00)  

7. นอกกะ ชว่งหลังกะ (11:00-12:00) 

 

 

 

สตูรคํานวณหาระยะเวลาทํางานทีѷใชใ้นกะ ในเซลล ์H4 = 
MAX(  0,  MIN(F4,D4)  -  MAX(E4,C4) ) โดยแยกอธบิายแตล่ะสว่นในสตูรได ้ดังนีѸ 

 MIN(F4,D4) เป็นการนําเวลาปลายกะมาเทยีบกบัเวลาปลาย job (เวลาออก
จากงาน) เพืѷอหาเวลาสดุทา้ยทีѷเป็นไปไดท้ีѷเกดิขึѸนกอ่น  

 MAX(E4,C4) เป็นการนําเวลาตน้กะมาเทยีบกบัเวลาตน้ job (เวลาเริѷมเขา้งาน) 
เพืѷอหาเวลาสดุทา้ยทีѷเป็นไปไดท้ีѷเกดิขึѸนหลังสดุ  

 MIN(F4,D4)-MAX(E4,C4) คํานวณหาระยะเวลาทํางานทีѷใชใ้นกะ  

 MAX(0,xxx) ปรับผลลัพธท์ีѷคํานวณไดใ้หไ้มม่ทีางตํѷากวา่ 0 

สตูร = MAX(0,MIN(F4,D4)-MAX(E4,C4)) นีѸ เป็นสตูรสัั Ѹนๆทีѷสามารถใชแ้ทนสตูร IF เพราะ
หากจะใช ้IF ในการคํานวณก็จะตอ้งนํา IF มาซอ้นกนัถงึ 7 ชั Ѹน 
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ตารางคาํนวณตอ้งมากอ่น สว่นสตูรลดัมาทหีลงั 

ทกุวันนีѸคณุสามารถคน้หาสตูรคํานวณเพืѷอหาคําตอบในปัญหาตา่งๆไดโ้ดยตรงจากอนิเตอรเ์น็ต 
หรอืยกคําถามไปหารอืในฟอรัมถามตอบปัญหา Excel ไดไ้มย่าก หลายๆครั Ѹงทเีดยีวทีѷจะไดร้ับ
คําตอบเป็นสตูรซอ้นกนัยาวเหยยีดเป็นหนา้ จนอดทึѷงในความสามารถของคนทีѷสรา้งสตูร
เหลา่นัѸนไมไ่ดว้า่เขาคดิสตูรกนัมาไดอ้ยา่งไร 

หากจะไลเ่รยีงลําดับความเกง่เกีѷยวกบัการใช ้Excel แลว้ การทีѷเกง่มคีวามสามารถสรา้งสตูร
ยากๆยาวๆได ้ถอืวา่เป็นความเกง่ขั Ѹนสงูทีѷมักเป็นความสามารถเฉพาะตัว ยากทีѷคนอืѷนจะ
เลยีนแบบหรอืเขา้ใจทีѷไปทีѷมาของสตูรทีѷนํามาซอ้นกนั เพราะคนเกง่แตล่ะคนมักเลอืกใชส้ตูรทีѷ
ตนถนัดแตกตา่งกนัไป แตอ่ยา่งไรก็ตาม ในเรืѷองสตูรทีѷตัวผมเองคดิขึѸนนัѸน หลายๆครั Ѹงทเีดยีวทีѷ
พบวา่ไมส่ามารถแกะสตูรยาวๆทีѷตัวเองเป็นคนตน้คดิ จงึเป็นสิѷงทีѷน่าเป็นหว่งอยา่งยิѷงวา่ ในเมืѷอ
แมแ้ตต่ัวผูท้ีѷคดิสตูรขึѸนเองยังไมส่ามารถเขา้ใจทีѷไปทีѷมาของแตล่ะสว่นในสตูรยาวๆไดเ้ลย แลว้
ไฉนผูอ้ืѷนจะเขา้ใจสตูรทีѷตนไมไ่ดส้รา้งเองหรอืสามารถนําสตูรไปดัดแปลงใชง้านไดเ้ลา่ ดังนัѸน
การสรา้งสตูรยากๆยาวๆใหแ้กผู่อ้ืѷนใช ้จงึเป็นการสรา้งปัญหาระยะยาวใหเ้กดิขึѸนกบัผูใ้ชส้ตูรทีѷ
ตนเองไมไ่ดเ้ป็นคนสรา้ง เพราะวา่เมืѷอใดทีѷเงืѷอนไขในการคํานวณแตกตา่งไปจากเดมิ เมืѷอนัѸนก็
จําตอ้งยอ้นกลับมาตั Ѹงคําถามใหค้นอืѷนชว่ยสรา้งสตูรใหมใ่หอ้กี 

แทนทีѷจะใชส้ตูรลัดซึѷงเป็นสตูรซอ้นกนัยาวเหยยีด แนะนําใหก้ระจายการคํานวณออกเป็นหลาย
เซลลเ์พืѷอแยกคํานวณแตล่ะอยา่งกอ่น แลว้จงึนําผลลัพธท์ีѷไดไ้ปคํานวณหาผลลัพธส์ดุทา้ย จะ
เป็นวธิชีว่ยสรา้งความเขา้ใจใหเ้กดิขึѸนถงึทีѷไปทีѷมาของสตูรวา่คดิกนัมาไดอ้ยา่งไร 

ยกตัวอยา่งสตูรคํานวณหาชืѷอแฟ้ม ซึѷงดแูลว้ยากทีѷจะจํา และไมม่ทีางรูว้า่มหีลักการคดิมาได ้
อยา่งไร 

=MID(CELL("filename"),FIND("[",CELL("filename"))+1,FIND("]",CELL("filenam
e"))-FIND("[",CELL("filename"))-1) 

สตูรนีѸมทีีѷมาจากสตูร  

=MID(ขอ้ความทีѷมชีืѷอแฟ้ม, เลขตําแหน่งเครืѷองหมาย [, เลขจํานวนตัวอกัษรของชืѷอ
แฟ้ม) 

แยกคํานวณแตล่ะสว่นไดต้ามรปูตอ่ไปนีѸ 
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แทนทีѷจะใชส้ตูรยาวจนจําแทบไมไ่หวในเซลล ์B7 ใหเ้ริѷมจากการใชส้ตูรหาคา่ทีѷเกีѷยวขอ้งกบั
การแยกคําทลีะขั Ѹน ดังนีѸ 

1. เซลล ์A1 ใชส้ตูร =CELL("filename") เพืѷอหาชืѷอแฟ้ม โดยคําตอบทีѷไดจ้ะแสดง
ทัѸงชืѷอ drive ชืѷอโฟลเดอร ์ชืѷอแฟ้ม และชืѷอชที  

2. เซลล ์B3 และ B4 ใชส้ตูร =FIND("[",$A$1) และ =FIND("]",$A$1) เพืѷอ
คํานวณหาตําแหน่งของเครืѷองหมายวงเล็บ [ ] ตามลําดับ  

3. เซลล ์B5 ใชส้ตูร =MID(A1,B3+1,B4-B3-1) เพืѷอแยกเฉพาะสว่นทีѷเป็นชืѷอแฟ้ม
ออกมาใชง้าน 
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การออกแบบโครงสรา้งตารางคาํนวณรว่มกบัสตูรลดั 

จากสตูร = MAX(0,MIN(F4,D4)-MAX(E4,C4)) ซึѷงใชคํ้านวณหาระยะเวลาทีѷใชใ้นกะซึѷงได ้
อธบิายทีѷไปทีѷมาของแตล่ะสว่นในสตูรแลว้วา่เป็นอยา่งไร จากนีѸขอใหค้ณุคดิตอ่ไปอกีวา่จะนํา
สตูรนีѸไปใชใ้นการวางแผนโดยจําเป็นตอ้งนําสตูรนีѸไปใชร้ว่มกบัตัวแปรอืѷนๆ เชน่ ชว่งเวลาของกะ
อืѷนๆ ชว่งเวลาเขา้งานในวันอืѷนๆหรอืเวลาเขา้งานของลกูจา้งคนอืѷน ตลอดจนหาทางคํานวณ
คา่แรงทีѷตอ้งจา่ยออกเป็นตัวเงนินัѸน ตอ้งออกแบบตารางคํานวณใหม้หีนา้ตาอยา่งไรด ี

 

ตัวอยา่งนีѸขอสมมตวิา่ในกําหนดเวลาทํางานแตล่ะวัน ตั Ѹงแต ่6:00-24:00 น.นัѸน ถกูแบง่ออกเป็น 
8 กะ แตล่ะกะเริѷมจากชว่งเวลา 6:00, 8:00, 10:00, 12:00, 13:00, 17:00, 19:00, และ 
22:00 โดยกําหนดคา่แรงในชว่งกะทีѷเริѷม 8:00, 10:00, 13:00, และ 17:00 ใหใ้ชอ้ตัราคา่แรง
ปกต ิสว่นกะอืѷนๆมอีตัราคา่แรง OT 1.5 เทา่ของอตัราปกต ิ

แรกสดุผมตัดสนิใจวา่ จะยังไมนํ่าประเด็นเรืѷองคา่แรงมาใชใ้นการคํานวณ โดยตอ้งการคํานวณ
ใหไ้ดร้ะยะเวลาทีѷใชใ้นแตล่ะกะใหไ้ดก้อ่น เพืѷอเผืѷอวา่จะสามารถใชต้ัวเลขระยะเวลาไปใชใ้นงาน
วางแผนอืѷนทีѷอาจเกีѷยวขอ้งไดอ้กี เชน่ หากตอ้งการวัดประสทิธภิาพในการทํางาน ก็อาจนํา
ระยะเวลาทีѷใชใ้นแตล่ะกะไปคณูกบัอตัรากําลังผลติมาตรฐาน แลว้นํามาเปรยีบเทยีบกบัผลงานทีѷ
ผลติไดจ้รงิในแตล่ะกะวา่ดกีวา่หรอืตํѷากวา่มาตรฐานอยา่งไร 

ในการออกแบบตารางคํานวณใหเ้ลอืกวางแนวตารางทีѷอาจจะมรีายการเพิѷมใหเ้พิѷมไดใ้น
แนวนอน จะสะดวกกวา่การวางตารางทีѷเพิѷมไวต้ามแนวตั Ѹง ดังนัѸนจงึกําหนดใหแ้บง่หัวตารางทีѷ
เป็นกะตา่งๆไวต้ั Ѹงแตเ่ซลล ์E5:L5 เพราะเชืѷอวา่สว่นนีѸคงไมม่กีารปรับเพิѷมจากเดมิมากนัก แลว้
กําหนดใหใ้ชต้ารางดา้นซา้ยสดุเรยีงลําดับงานแตล่ะงานไปเรืѷอยๆ จากเซลล ์B6:D10 
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ตัวเลขเวลาเริѷมกะทีѷบันทกึไวใ้นเซลล ์E5:L5 นัѸน ยังถกูนําไปกระจายแยกเป็นเวลาเริѷมกะ 
(From) และเวลาสิѸนสดุของกะ (To) ไวท้ีѷเซลล ์E2:L3 เพืѷอแสดงใหเ้ห็นชดัเจนขึѸนวา่แตล่ะกะมี
เวลาเริѷมตน้และสิѸนสดุอยา่งไร และยังเผืѷอไวใ้ชก้บัสตูรคํานวณหาระยะเวลาทีѷใชใ้นกะอกีดว้ย จะ
ไดทํ้าใหส้ตูรมกีารใชตํ้าแหน่งอา้งองิในแนวเดยีวกนัไปตลอด ชว่ยใหส้รา้งและแกะทีѷไปทีѷมาได ้
งา่ยขึѸน  

สว่นดา้นของรายละเอยีดการทํางานนัѸน ในชว่งแรกนีѸใชเ้ลขทีѷงานเรยีงไปเรืѷอยๆไวก้อ่นในเซลล ์
B6:B10 ซึѷงในอนาคตอาจเปลีѷยนจากเลขทีѷงาน ไปเป็นชืѷอคน หรอืเลขเครืѷองจักรแทนก็ได ้ทั ѸงนีѸ
เพืѷอใชแ้สดงชืѷอรายการเทา่นัѸนวา่เป็นการทํางานของใคร และสามารถพมิพร์ายการตอ่ไปไดอ้กี
นับหมืѷนรายการตามแนวนอน 

กําหนดใหบ้ันทกึเวลาเริѷมงาน (Start) และออกจากงาน (Stop) คูข่นานกบัเลขทีѷ Job ไวใ้น
เซลลต์ั Ѹงแต ่C6:C10 และ D6:D10 ตามลําดับ 

ตารางตั Ѹงแตเ่ซลล ์E6:L10 ใชส้ตูร =MAX(0,MIN( E$3, $D6 ) - MAX( E$2, $C6 )) เพืѷอ
คํานวณหาระยะเวลาทีѷทํางานในแตล่ะกะ โดยสรา้งสตูรนีѸลงไปในเซลล ์E6 เซลลเ์ดยีวแลว้ 
copy ไป paste เพืѷอใชคํ้านวณทกุเซลลต์ั Ѹงแต ่E6:L10 

เพืѷอแสดงใหเ้ห็นเฉพาะตัวเลขเวลาทีѷคํานวณได ้ไมใ่หแ้สดงตัวเลขเวลาทีѷเทา่กบั 0 จงึเลอืกใช ้
Format แบบ hh:mm;; และใชส้พีืѸนแยกแตล่ะกะทีѷใชอ้ตัราคา่แรงปกตอิอกจากพืѸนตารางสว่นทีѷ
ใชอ้ตัราคา่แรงพเิศษ (OT) 

จากนัѸนสรา้งสตูรรวมหายอดระยะเวลาทีѷทํางานในชว่งอตัราปกตแิละชว่งอตัรา OT ไวใ้นตาราง
ดา้นขวาตั Ѹงแตเ่ซลล ์N6:O10 ซึѷงเมืѷอนําไปคณูกบัเลขอตัราในเซลล ์Q4 และ R4 แลว้ ทําให ้
คํานวณหาคา่แรงแยกประเภทของอตัราแตล่ะตัวแสดงใหเ้ห็นในตาราง Q6:R10  

วเิคราะหล์กัษณะโครงสรา้งตารางคาํนวณทีѷใช ้

1. พืѸนทีѷตารางทีѷใชร้ับตัวแปร เชน่ B6:B10, C6:C10, D6:D10, และ E5:L5 ถกูวาง
ไวเ้ป็นแนวคูข่นานกบัแนวตารางสตูรคํานวณ E6:L10  

2. สตูรคํานวณในพืѸนทีѷตาราง E6:L10 เกดิจากสตูรในเซลล ์E6 เพยีงเซลลเ์ดยีวทีѷ
นําไป paste ตอ่ใหเ้ซลลอ์ืѷนๆ ทําใหส้ะดวกในการแกไ้ขสตูรไมต่อ้งคน้หาและ
แกไ้ขสตูรในเซลลแ์ตล่ะเซลล ์ 

3. ตารางกําหนดเวลาแตล่ะชว่งกะ E2:L3 ชว่ยชีѸชดัวา่แตล่ะกะมเีวลาใด ชว่ยให ้
สรา้งสตูรคํานวณไดง้า่ยขึѸนและยังทําใหม้คีวามเขา้ใจชดัเจนมากขึѸนสําหรบั
ผูใ้ชง้านทัѷวไป ซึѷงในอนาคตหากไมต่อ้งการแสดงพืѸนทีѷสว่นนีѸก็สามารถโยกยา้ย
ไปซอ่นทีѷอืѷน  
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4. จดุเดน่ของโครงสรา้งตารางซึѷงชว่ยใหส้ามารถคํานวณคา่แรงในแตล่ะอตัราได ้
คอื การใชต้ารางแบง่ออกเป็นแตล่ะกะเพืѷอแยกคํานวณหาระยะเวลาทีѷใชใ้นกะ
นัѸนๆกอ่น และยังชว่ยใหส้ามารถตรวจสอบความถกูตอ้งของการคํานวณไดง้า่ย 
ชดัเจนกวา่การคดิสตูรยากๆยาวๆเพยีงเพืѷอคํานวณแยกแตล่ะกะใหแ้ลว้เสร็จใน
เซลลเ์ดยีว  

5. ในแงข่องเลขตัวเงนิคา่แรงทีѷโดยทัѷวไปถอืเป็นเรืѷองปกปิด ไดถ้กูแยกคํานวณใน
ตาราง Q6:R10 ชว่ยใหส้ามารถใชต้ารางสว่นนีѸในการบรหิารคา่แรงไดโ้ดยตรง
และสามารถโยกยา้ยตารางไปแยกเก็บไวเ้ป็นเรืѷองลับในชทีอืѷนหรอืแฟ้มอืѷน  

6. เลขทีѷ Job ในตาราง B6:B10 นัѸน ในอนาคตสามารถบันทกึรหัสหรอืชืѷอลงไป
แทน จากนัѸนจงึนําสตูร Vlookup หาเวลาทํางานมาแสดงโดยอัตโนมัตใินตาราง 
C6:D10 ไดด้ว้ย หรอือาจใชคํ้าสัѷง Data > Table เพืѷอสง่ตัวแปรลงไปแทน
เลขทีѷ Job เพืѷอคํานวณลัดหายอดคา่แรงไดทั้นทโีดยไมจํ่าเป็นตอ้งยอ้นกลับมา
เพิѷมรายการใหม ่ 

7. สามารถใชก้บัการคํานวณหาคา่แรงไดห้ลายกรณี เชน่ คา่แรงของลกูจา้งคนหนึѷง
ในวันหนึѷง หรอืคา่แรงของลกูจา้งคนหนึѷงรายวัน หรอืคา่แรงของลกูจา้งเรยีงตัว
ไปทกุคนในแตล่ะวัน ซึѷงคณุอาจใชช้ทีเดมิชทีเดยีวคํานวณ หรอื copy เป็นชที
ใหมเ่พืѷอคํานวณแยกตามรายบคุคล 

หมายเหต ุ: 

1. การไลลํ่าดับงานในตัวอยา่งนีѸเป็นการไลจ่ากบนมาลา่งหรอืจากซา้ยไปขวา ซึѷงใน
แงก่ารวางแผนกําหนดการณ์แลว้ เรยีกวา่ แบบ Push เพืѷอหากําหนดเวลาทีѷงาน
เสร็จ  

2. ถา้ไลลํ่าดับงานจากลา่งไปบนหรอืจากขวามาซา้ย จะกลายเป็นแบบ Pull เพืѷอหา
กําหนดเวลาทีѷตอ้งเริѷมงาน  

3. หากตอ้งการแทรกระยะเวลาหยดุพักของแตล่ะ Job ซึѷงยอ่มมผีลทําให ้
กําหนดเวลาเริѷมตน้ของ Job ถัดไปชา้ลง สามารถปรับเพิѷมไดง้า่ยๆโดยสรา้งสตูร
หากําหนดเวลาเริѷมงานใน Job ถัดไปใหม้คีา่เทา่กบั เวลาออกจากงานของ Job 
กอ่นบวกดว้ยระยะเวลาทีѷหยดุพัก  
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การออกแบบโครงสรา้งตารางคาํนวณ ภาค 2 

ตารางคํานวณในภาคแรกเกดิจากการใชส้ตูรทีѷมโีครงสรา้งเดยีวกนัซํѸาในทกุเซลลข์องตาราง
คํานวณ โดยกําหนดใหห้าทางสรา้งสตูรขึѸนเพยีงสตูรเดยีวในเซลลแ์รกตรงหัวมมุซา้ยบนสดุของ
ตาราง แลว้จัดการ Copy สตูรไปใชทั้ Ѹงตาราง และจากการทีѷใชส้ตูรทีѷมโีครงสรา้งเดยีวกนัไป
ตลอดนีѸยอ่มแสดงวา่เป็นสตูรทีѷคํานวณหาคําตอบในเรืѷองเดยีวกนั จากนัѸนเราจงึใชโ้ครงสรา้งของ
ตารางเป็นตัวชว่ยในการเลอืกใชคํ้าตอบจากตําแหน่งของเซลลท์ีѷเกีѷยวขอ้งกบัคําตอบ ซึѷงตาราง
คํานวณแบบแรกนีѸไมเ่หมาะกบัการคํานวณทีѷมคีวามสลับซบัซอ้นมากนัก 

ในบทความภาคทีѷ 2 จะนําโครงสรา้งตารางคํานวณทีѷมคีวามซบัซอ้นมากขึѸนมาใหศ้กึษากนัโดย
ขอเรยีกตารางคํานวณแบบนีѸวา่ ตารางคํานวณแบบ Module ซึѷงสามารถนําไปใชง้านกนัได ้2 
แบบ คอื แบบ Module เดีѷยว (Single Module) และแบบ Module รวม (Compound Module) 

ความหมายของ Module 

ผูท้ีѷเคยใช ้Excel สรา้งตารางคํานวณงบการเงนิมากอ่น ตอ้งทราบดวีา่กวา่จะคํานวณหายอด
กําไรขาดทนุมาไดต้อ้งคํานวณผา่นยอดรายรับหักตน้ทนุขายเป็นกําไรขั Ѹนตน้ จากนัѸนจงึนํายอด
ตัวเลขกําไรขั Ѹนตน้ไปหักดว้ยคา่ใชจ้า่ยตา่งๆและภาษีเพืѷอเป็นยอดกําไรขาดทนุ ซึѷงลักษณะของ
การคํานวณงบการเงนินีѷแหละคอืลักษณะของตารางคํานวณแบบ Module 

ในงานดา้นวางแผนการผลติมลัีกษณะการใช ้Excel แบบ Module เชน่กนั นับตั Ѹงแตร่ับคําสัѷงซืѸอ
แลว้ตอ้งนํายอดไปเปรยีบเทยีบกบัสนิคา้คงคลังเพืѷอคํานวณหายอดวัตถดุบิทีѷตอ้งใชต้ามกําลัง
การผลติทีѷมอียู ่อกีทั Ѹงตอ้งกําหนดเวลาใหก้บัตัวเลขการสัѷงผลติหรอืจัดหาวัตถดุบิตามโครงสรา้ง
ผลติภัณฑใ์หไ้ดอ้กีวา่ ตอ้งการใชใ้นปรมิาณเทา่ใดและตอ้งเริѷมสัѷงของเมืѷอใดเพืѷอใหส้ามารถ
ดําเนนิการตามขั Ѹนตอนการผลติแลว้ไดส้นิคา้สําเร็จรปูตามเวลาทีѷกําหนด 

Module คอื ตารางทีѷประกอบดว้ยเซลลส์ตูรคํานวณหลายๆเซลลซ์ึѷง
คํานวณตอ่เนืѷองกนัไปทลีะขั Ѹน โดยผลการคํานวณทีѷไดใ้นแตล่ะขั Ѹนไม่
จําเป็นตอ้งมคีวามหมายใดเลยก็ได ้แตเ่มืѷอนํามาคํานวณรว่มกนัหรอื
คํานวณตอ่เนืѷองกนัแลว้ตอ้งทําใหไ้ดผ้ลลัพธต์ามตอ้งการ 

จากคําจํากดัความของ Module ขา้งตน้ อาจทําใหค้ณุหลงภมูใิจวา่ตนเองเคยสรา้งตาราง
คํานวณแบบ Module นีѸมานานแลว้ บทความนีѸไมเ่ห็นมอีะไรทีѷแปลกใหมต่า่งจากทีѷคณุรูด้อียู่
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แลว้ จงึขอใหล้องนกึดวูา่หากคณุสามารถใช ้Excel อยา่งคอมพวิเตอรไ์ดส้มบรูณ์จรงิ คณุตอ้ง
หาทางนํา Module ทีѷสรา้งไวนั้Ѹนมาใชซ้ํѸาแลว้ซํѸาอกีโดยไมจํ่าเป็นตอ้งสรา้ง Module ขึѸนใหม ่
และดว้ยตารางคํานวณแบบ Module ทีѷคณุมเีพยีง Module เดยีว จะทําอยา่งไรทีѷจะนําตารางนัѸน
มาใชซ้ํѸาแลว้ซํѸาอกี เพืѷอหาทางใช ้Module เดยีว ชทีเพยีงชทีเดยีว หรอืแฟ้มเพยีงแฟ้มเดยีวกบั
งานคํานวณทีѷคณุคดิไมถ่งึวา่จะใช ้Excel ทําไดโ้ดยไมต่อ้งพึѷงการเขยีนโปรแกรม Visual Basic 
มาชว่ยแมแ้ตน่อ้ย 

จดุประสงคข์องการสรา้งตารางคาํนวณแบบ Module 

1. เพืѷอลดความซบัซอ้นของสตูรคํานวณ จากเดมิทีѷตอ้งสรา้งสตูรยากๆยาวๆลงไปในเซลล์
เพยีงเซลลเ์ดยีว เปลีѷยนไปเป็นการกระจายสตูรแยกใหใ้ชเ้ซลลแ์ตล่ะเซลลม์สีตูรคํานวณ
ทลีะขั Ѹนสง่ผลการคํานวณตอ่เนืѷองกนัไป ทําใหส้ตูรสั Ѹนลง และทําใหค้ณุเขา้ใจลําดับการ
คํานวณไดง้า่ยขึѸน  

2. เพืѷอทําใหค้ณุสามารถใช ้Excel กบัการคํานวณงานทีѷมหีลายขั Ѹนตอนหรอืเกีѷยวขอ้งกบั
การทํางานทีѷมลัีกษณะตอ่เนืѷองกนั  

3. เพืѷอชว่ยใหค้ณุสามารถลดขนาดแฟ้มและจํานวนตารางทีѷมอียู ่

ลกัษณะโครงสรา้งตารางคาํนวณแบบ Single Module 

ตารางคํานวณแบบ Single Module มลัีกษณะตรงกบัความหมายของคําวา่ Single นัѷนคอืเป็น
ตารางคํานวณแบบตารางเดยีวหรอืตารางเดีѷยว ทีѷสามารถคํานวณใหผ้ลลัพธท์ีѷตอ้งการได ้
ครบถว้นภายในตารางคํานวณตารางเดยีว 

ผูใ้ช ้Excel ทัѷวไปมักใช ้Excel กนัแบบผดิๆ จากความงา่ยของการใชต้ารางของ Excel เชน่ ถา้
รายงานทีѷตอ้งการมรีอ้ยหนา้ เราก็มักจะออกแบบตาราง Excel ใหม้คีวามยาวเหยยีดเลยีนแบบ
ตามหนา้กระดาษทีѷตอ้งการพมิพ ์หรอืเมืѷอใดทีѷตอ้งการรายงานตามรายเดอืน ก็มักจะสรา้งชที
หลายๆชทีแยกเป็นชทีละเดอืนหรอืสรา้งตารางแบง่เป็นแฟ้มคํานวณตามรายเดอืน ซึѷงยังดทีีѷในปี
หนึѷงมแีค ่12 เดอืน จงึทําใหม้จํีานวนชทีหรอืแฟ้มเพยีง 12 ชทีหรอื 12 แฟ้ม แตถ่า้เป็นงานทีѷ
ตอ้งใชต้ดิตอ่กนัไปหลายปีหรอืแบง่รายงานตามวัตถดุบินับรอ้ยนับพันชนดิ เห็นทยีอ่มทําใหม้ี
จํานวนชทีหรอืจํานวนแฟ้มทีѷมกีารคํานวณแบบเดยีวกนัซํѸามากจนจดจํากนัไมไ่หว 

ตารางคํานวณแบบ Single Module เป็นตารางคํานวณเพยีงตารางเดยีวทีѷคณุสามารถกําหนดให ้
ตารางคํานวณนัѸนเลอืกรับตัวแปรตา่งไปจากเดมิไดต้ามตอ้งการ ทําใหส้ามารถใชต้ารางคํานวณ
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เพยีงตารางเดยีวหรอืหนา้เดยีวเพืѷอแสดงผลการคํานวณเปลีѷยนไปเป็นตารางคํานวณรายละเอยีด
ของเดอืนทีѷตอ้งการหรอืวัตถดุบิทีѷตอ้งการ โดยใชโ้ครงสรา้งตารางแบง่ออกเป็น 3 สว่น ดังนีѸ 

1. สว่นของตาราง Input ใชส้ําหรับเก็บตัวแปรทีѷตอ้งการตามรายเดอืนหรอืแตล่ะชดุ ซึѷง
ตาราง Input นีѸใชจั้ดเก็บขอ้มลูรายเดอืนหรอืแตล่ะชดุไวเ้ป็นแนวนอนหรอืแนวตั Ѹงตดิกนั
ก็ได ้ 

2. สว่นของตารางสตูรตวักลางใชด้งึขอ้มลู เพืѷอเลอืก Input ตามเลขเดอืนหรอืเลขทีѷ
ของชดุ ซึѷงมักใชส้ตูร Index เพืѷอเลอืกดงึขอ้มลูจากตาราง Input ในชทีเดยีวกนั หรอื
ใชส้ตูร Indirect เพืѷอเลอืกดงึ Input จากตารางทีѷแยกชทีกนั  

3. สว่นของตารางคาํนวณ เพืѷอคํานวณตามคา่ทีѷรับมาจากตารางสตูรตัวกลาง 
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ตวัอยา่งโครงสรา้งตารางคาํนวณแบบ Single Module ในชทีเดยีว 

 

ตัวอยา่งนีѸเป็นการคํานวณงบกําไรขาดทนุจากตัวอยา่งประกอบการอบรมหลักสตูรสดุยอดเคล็ด
ลับและลัดของ Excel ซึѷงกําหนดใหม้ตีารางทีѷตอ้งการคํานวณตามยอดขายและตน้ทนุทีѷตา่งกนั
ไปอยู ่3 case แตล่ะ case กําหนดใหแ้ปรเปลีѷยนยอดขายและตน้ทนุตา่งกนัไป ดังนัѸนแทนทีѷ
จะตอ้งสรา้งตารางคํานวณขึѸน 3 ตารางเพืѷอแยกคํานวณแตล่ะ case ขอใหอ้อกแบบตารางในชที
เดยีวกนัแบง่เป็น 3 สว่น 

สว่นแรกใชส้ําหรับบันทกึตัวแปรแตล่ะ case ซึѷงในภาพใชต้ารางดา้นขวาสดุตั Ѹงแต่
เซลล ์I3:K6 (ตั Ѹงชืѷอ Range Name ตารางสว่นนีѸวา่ MyData) แบง่แยกใหแ้ตล่ะ column 
บันทกึตัวแปรของแตล่ะ case เชน่ case1 เป็นพืѸนทีѷตั Ѹงแตเ่ซลล ์I3:I6 โดยกําหนดใหเ้รยีงลําดับ
ตัวแปรของยอดขายและตน้ทนุตอ่กนัไปใน column เดยีวกนั แลว้ใช ้column ถัดไปบันทกึตัว
แปรของ case ตอ่ไปในทํานองเดยีวกนั 

สาเหตทุีѷตอ้งจัดใหบ้ันทกึตัวแปรของแตล่ะ case ไวใ้นแนวตั ѸงเดยีวกนันัѸน เพืѷอทําใหส้ามารถใช ้

สตูร Index ดงึขอ้มลูตัวแปรทีѷเก็บไวใ้นแนวตั Ѹงเดยีวกนัไปพรอ้มกนั โดยสรา้งสตูร Index 
ตอ่ไปนีѸไวใ้นเซลล ์F3:F6 แบบ Array (โดยเลอืกเซลล ์F3:F6 แลว้สรา้งสตูร จากนัѸนกดปุ่ ม 
Ctrl+Shift+Enter พรอ้มกนัเพืѷอบันทกึสตูรลงไปทเีดยีวทกุเซลล ์จะพบเครืѷองหมายวงเล็บปีก
กาปิดหัวทา้ยสตูรใหเ้อง) 

=INDEX( MyData, 0, CaseNum ) 

 MyData เป็นตารางบันทกึตัวแปรตั Ѹงแตเ่ซลล ์I3:K6  
 เลข 0 เพืѷอกาํหนดใหส้ตูร Index ดงึขอ้มลูทกุ Row  
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 CaseNum คอืเซลล ์F2 ใชส้ําหรับใสต่ัวเลข 1, 2, หรอื 3 ลงไป เพืѷอทําใหส้ตูร Index 
ดงึขอ้มลู Input จาก Case1, Case2, หรอื Case3 ตามลําดับ 

เมืѷอดงึตัวแปรตามตัวเลขของ CaseNum ทีѷตอ้งการมาแสดงในเซลล ์F3:F6 ไดแ้ลว้ จากนัѸนจงึ
สรา้งสตูร link ตามปกตไิปใชคํ้านวณงบกําไรขาดทนุในสว่นของตารางดา้นซา้ยสดุจากเซลล ์
D3:D9 

ในกรณีทีѷตอ้งการเปรยีบเทยีบผลของการคํานวณทกุ case พรอ้มกนั ใหส้รา้งตาราง Data 
Table แบบ 1 ตัวแปร ทีѷใช ้Row Input Cell เป็นเซลล ์CaseNum ตามรปูตอ่ไปนีѸ 

 

เซลล ์H11:K18 เป็นพืѸนทีѷตารางทีѷใชก้บัคําสัѷง Data > Table แลว้กําหนดใหเ้ซลล ์F2 หรอื 
CaseNum เป็น Row Input Cell หรอืเซลลม์ีѷรับคา่ตัวแปรจากหัวตารางตามแนวนอน ซึѷง
กําหนดใหใ้ชเ้ซลล ์I11:K11 บันทกึหมายเลข 1, 2, 3 ซึѷงหมายถงึเลขทีѷ case ไว ้สว่นหัวตาราง
ดา้นซา้ยสดุตั Ѹงแต ่H12:H18 เป็นสตูรทีѷ link การคํานวณมาจากตารางคํานวณงบกําไรขาดทนุ
จากเซลล ์D3:D9 

เมืѷอตาราง Data Table นีѸทํางาน เราจะไดผ้ลลัพธก์ารคํานวณของแตล่ะ case เสร็จใน
พรบิตา แตถ่า้เขา้ใจขั Ѹนตอนการทํางานของ Excel ทลีะขั Ѹน จะพบวา่ Excel คอ่ยๆสง่ตัวเลขตัว
แปร 1, 2, 3 บนหัวตารางดา้นบนไปทีѷเซลล ์F2 หรอื CaseNum ทลีะคา่ จากนัѸนสตูร Index จะ
ทําหนา้ทีѷดงึตัวแปรแตล่ะตัวตามเลข case สง่ไปคํานวณในงบกําไรขาดทนุดา้นซา้ยสดุ แลว้จงึ
สง่ผลลัพธก์ลับมาแสดงในพืѸนทีѷตาราง I12:K18 ตาม case บนหัวตารางดา้นบนของพืѸนทีѷซ ึѷงสัѷง 
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Data > Table นัѷนเอง (การใช ้Data > Table รว่มกบัสตูร Index นีѸจะทําให ้Data > Table 
สามารถสง่ตวัแปรไปใชคํ้านวณไดไ้มจํ่ากดัจํานวนตัวแปร ถอืเป็นเคล็ดการใช ้Excel ทีѷนอ้ยคน
นักจะใชเ้ป็น) 
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ตวัอยา่งโครงสรา้งตารางคาํนวณแบบ Single Module แบบแยก Input 
ไวใ้นชทีอืѷน 

ในกรณีทีѷการคํานวณมคีวามสลับซบัซอ้นมากขึѸนหรอืมจํีานวนตัวแปรมากขึѸน คณุสามารถแยก
ตารางสว่นของการคํานวณผลลัพธไ์ปไวใ้นชทีอืѷนตา่งหาก เพืѷอทําใหส้ามารถจัดโครงสรา้ง
ตารางไดย้ดืหยุน่และแยกชทีเก็บขอ้มลูใหแ้ยกเป็นสว่นๆไดช้ดัเจนยิѷงขึѸน 

ในตัวอยา่งตอ่ไปเป็นการคํานวณทางสถติขิองการวัด (Calibration) กอ่นอืѷนขอเลา่ทีѷไปทีѷมา
ของตัวอยา่งตอ่ไปนีѸกอ่นวา่ แตเ่ดมิทนัีѸนแฟ้มมขีนาดใหญม่ากเพราะมชีทีนับรอ้ยชที แตล่ะชทีมี
สตูรคํานวณทางสถติยิากๆยาวเหยยีดหลายๆเซลล ์ 

ทกุครั Ѹงทีѷมกีารผลติ ทางโรงงานตอ้งสุม่สนิคา้ทีѷผลติไดส้ง่มาตรวจสอบคณุภาพกอ่น โดยวัดผล
ออกมาเป็นตัวเลขแลว้นําไปคํานวณทางสถติวิา่เป็นตัวเลขทีѷอยูใ่นชว่งทีѷยอมรับไดห้รอืไม ่ทกุ
ครั Ѹงทีѷจะคํานวณ ก็ตอ้งเปิดชทีใหมแ่ลว้ copy ตารางคํานวณจากชทีเกา่มาแกต้ัวเลขตามการวัด
ทีѷเกดิขึѸนใหม ่ดังนัѸนถา้ตอ้งคํานวณกนัทกุวัน วันละหลายๆครั Ѹง ยอ่มทําใหม้ชีทีใหมเ่กดิขึѸนทกุ
ครั Ѹง 

นอกจากแฟ้มจะมขีนาดใหญเ่พราะมชีทีหลายๆชทีแลว้ สิѷงทีѷน่าหว่งคอืทกุครั Ѹงทีѷตอ้งสรา้งตาราง
คํานวณในชทีใหมนั่Ѹน อาจสรา้งตารางทีѷมสีตูรคํานวณผดิเพีѸยนไปจากสตูรทีѷสรา้งไวใ้นชทีเดมิ 
หรอืแมคํ้านวณไดถ้กูตอ้ง แตน่านไปอาจพลัѸงเผลอยอ้นกลับไปแกไ้ขบางเซลลใ์นบางชทีใหต้า่ง
ไปจากทีѷเคยเป็น และเนืѷองจากมชีทีหลายชที จงึเป็นไปไดว้า่เมืѷอทําการแกไ้ขไปแลว้ อาจ
หลงลมืจําไมไ่ดว้า่แกไ้ขชทีชืѷอใด และแกไ้ขอะไรทีѷเซลลใ์ดไปบา้ง ยิѷงกวา่นัѸนเมืѷอใดทีѷตอ้งการ
แกไ้ขโครงสรา้งตารางคํานวณตามหนา้ตาใหมท่ีѷผูบ้รหิารกําหนด ก็ตอ้งเสยีแรงเสยีเวลา
ยอ้นกลับไปแกไ้ขชทีเกา่ทั Ѹงหมดทีѷอาจมถีงึนับรอ้ยนับพันชทีเขา้ไปแลว้ทเีดยีว 

แทนทีѷจะตอ้งเปิดชทีใหม ่ขอใหใ้ชห้ลักการสรา้งตารางคํานวณแบบ Single Module โดยใช ้

โครงสรา้งตารางแบง่ออกเป็น 3 สว่น ดังนีѸ 
1. สว่นของตาราง Input ใชส้ําหรับเก็บตัวแปรทีѷตอ้งการตามการวัดคณุภาพสนิคา้แตล่ะ

ครั Ѹง ซึѷงตาราง Input นีѸใชจั้ดเก็บขอ้มลูการวัดแตล่ะครั Ѹงไวเ้ป็นแนวตั Ѹงตดิกนั  
2. สว่นของตารางสตูรตวักลางใชด้งึขอ้มลู เพืѷอเลอืก Input ตามเลขทีѷของเลขครั Ѹงใน

การวัด โดยใชส้ตูร Index เพืѷอเลอืกดงึขอ้มลูจากตาราง Input ในชทีเดยีวกนั  
3. สว่นของตารางคาํนวณ เพืѷอคํานวณตามคา่ทีѷรับมาจากตารางสตูรตัวกลาง แต่

เนืѷองจากมกีารคํานวณทีѷซบัซอ้นและเป็นรายงานทีѷตอ้งใชต้ารางขนาดใหญ ่จงึใหใ้ชช้ที
อกีชทีหนึѷงเป็นสว่นของการคํานวณโดยเฉพาะ 
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จากเดมิซึѷงตอ้งมหีลายชที จงึกลายเป็นแฟ้มใหมซ่ึѷงมชีทีเพยีง 2 ชที ชทีหนึѷงเป็นชทีทีѷใชบ้ันทกึ
ผลการวัดคณุภาพแตล่ะครั Ѹง แลว้ใชอ้กีชทีหนึѷงเป็นชทีแสดงการคํานวณทางสถติ ิ 

โครงสรา้งภายในชทีสําหรบับนัทกึตวัเลขจากการวดั 

 

ตารางตั Ѹงแตเ่ซลล ์E2:E21 ใชส้ําหรับบันทกึขอ้มลูจากการวัดครั Ѹงแรกแลว้ใช ้column ถัดไป
บันทกึขอ้มลูจากการวัดในครั Ѹงถัดไปตดิตอ่กนัไปตามแนว column โดยในตัวอยา่งนีѸตั ѸงชืѷอพืѸนทีѷ
ตารางสว่นทีѷใชบ้ันทกึขอ้มลูจากการวัดนีѸวา่ DataRange 

ตารางดา้นซา้ยตั Ѹงแตเ่ซลล ์C2:C21 เป็นสตูร Index ใชส้ําหรับดงึขอ้มลูทีѷบันทกึไวต้ามเลขทีѷ
ของการวัด ซึѷงใชต้ัวเลข 1-20 ใน Column D ชว่ยในการชีѸตําแหน่งเลขทีѷ row 

=INDEX( DataRange, D2, CaseNo ) 

 DataRange คอืพืѸนทีѷตาราง E2:N21 ใชส้ําหรับบันทกึขอ้มลูจากการวัด  
 D2 เป็นเลขทีѷ row เนืѷองจากเป็นคา่แรกจงึใชด้งึคา่จาก row ทีѷ 1  
 CaseNo เป็นเซลลร์ับเลขทีѷครั Ѹงของการวัด ซึѷง link มาจากชทีตารางคํานวณทางสถติ ิ
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โครงสรา้งภายในชทีสําหรบัคาํนวณทางสถติขิองการวดั 

 

เซลล ์B4 ถอืเป็นหัวใจของชทีนีѸ เมืѷอคณุพมิพเ์ลขทีѷ CaseNo ลงไป จะทําใหส้ตูร Index ใน 
column C ของอกีชทีหนึѷงตามภาพกอ่นหนา้นีѸ ดงึขอ้มลูสง่ตอ่มาใชแ้สดงหรอืคํานวณในตาราง
คํานวณ Uncertainty Budget อกีทั Ѹงยังใชเ้ซลล ์B4 รว่มกบัคําสัѷง Data > Table เพืѷอสรปุ
ผลเปรยีบเทยีบการวัด หรอืใชร้ว่มกบัคําสัѷงพมิพอ์ตัโนมัตทิีѷเขยีนดว้ย VBA ตามนีѸไดอ้กีดว้ย 

    For i = StartNum To StopNum 
        Range("CaseNo") = i 
        Calculate 
        ActiveWindow.SelectedSheets.PrintPreview 
    Next i 

 StartNum เป็นตัวแปรกําหนดตัวเลขเริѷมของเลขทีѷ Case ทีѷตอ้งการพมิพเ์ป็นรายการ
แรก  

 StopNum เป็นตัวแปรกําหนดตัวเลขสดุทา้ยของเลขทีѷ Case ทีѷตอ้งการพมิพเ์ป็นรายการ
สดุทา้ย  

 For Next Loop จะสง่คา่ i ไปยังเซลลช์ืѷอ CaseNo เพืѷอดผูลกอ่นพมิพบ์นจอ (Print 
Preview) ซึѷงถา้เปลีѷยนเป็นคําสัѷง Print ก็จะพมิพร์ายงานตามรายการทีѷตอ้งการโดย
อตัโนมัต ิ
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การออกแบบโครงสรา้งตารางคาํนวณ ภาค 3 

ตารางคํานวณแบบ Single Module ในภาคนีѸเป็นตารางคํานวณในกรณีทีѷแยกชทีหรอืแยกแฟ้ม 
เพืѷอใชก้บังานทีѷมกีารคํานวณสลับซบัซอ้นมากกวา่เดมิ แทนทีѷจะมตีารางคํานวณเพยีงตาราง
เดยีวแลว้ใชข้อ้มลูตัวแปรสง่คา่ใหมไ่ปคํานวณในตารางนัѸนๆในชทีเดยีวกนั คราวนีѸผมจะนําเสนอ
วธิกีารสรา้งตารางคํานวณพรอ้มกนัในหลายชทีหรอืหลายแฟ้ม จากนัѸนจงึเลอืกนําผลการคํานวณ
จากชทีหรอืแฟ้มทีѷตอ้งการไปนําเสนอผลงานตอ่ไป 

ผูใ้ช ้Excel ตอ้งคดิไวเ้สมอวา่ แมว้ันนีѸขอ้มลูทีѷเก็บไวย้ังคงมไีมม่ากและสามารถใชช้ทีเดยีวเก็บ
ขอ้มลูทั Ѹงหมดไวด้ว้ยกนั แตใ่นอนาคตขอ้มลูทีѷตอ้งเก็บไวจ้ะตอ้งมปีรมิาณของขอ้มลูมากขึѸนไป
เรืѷอยๆ จากเดมิทีѷเคยเก็บไวใ้นชทีเดยีว จะกลายเป็นตอ้งเก็บไวใ้นชทีหลายชที และในทีѷสดุเมืѷอ
แฟ้มมขีนาดใหญม่ากแลว้ใชเ้วลาคํานวณชา้ลง ก็ตอ้งหาทางโยกยา้ยขอ้มลูแยกออกไปเก็บไว ้
ในแฟ้มใหมใ่นทีѷสดุ พฤตกิรรมเชน่นีѸถอืเป็นววิัฒนาการของการใช ้Excel ทีѷเราทกุคนหลกีหนไีป
ไมพ่น้ 

ดังนัѸนการออกแบบโครงสรา้งตารางคํานวณทีѷด ีจงึตอ้งหาทางออกแบบตารางตั Ѹงแตแ่รกใหใ้ช ้

พืѸนทีѷตารางแยกเป็นสว่นๆ เพืѷอสามารถโยกยา้ยตารางจากเดมิทีѷเก็บอยูใ่นชทีเดยีว ไปแยกเก็บ
ในชทีใหมห่รอืแฟ้มใหมไ่ดทั้นททีีѷตอ้งการ 

ลกัษณะของตารางคาํนวณ Single Module แบบแยกชทีหรอืแยกแฟ้ม 

1. ตารางคํานวณทีѷแยกชทีนีѸ มไิดห้มายความวา่ใหแ้ยกแตล่ะลําดับของการคํานวณใหใ้ช ้
พืѸนทีѷตา่งชทีแลว้สง่ผลการคํานวณไปคํานวณตอ่ในชทีอืѷนตอ่กนัไป แตเ่ป็นการรวมลําดับ
การคํานวณทัѸงหมดไวใ้นชทีเดยีวกนั จากนัѸนจงึสรา้งชทีใหมใ่หม้ตีารางคํานวณซํѸากบั
ตารางคํานวณทีѷมอียูใ่นชทีเดมิ เพยีงแตว่า่การคํานวณทีѷเกดิขึѸนในแตล่ะชทีจะเกดิจากตัว
แปรทีѷตา่งกนั เชน่ ชทีเดมิใชคํ้านวณตัวเลขในอดตี สว่นชทีใหมใ่หใ้ชคํ้านวณตัวเลขใน
ปัจจบุัน จากนัѸนจงึนําผลทีѷคํานวณไดนํ้ามาเปรยีบเทยีบหาความแตกตา่งระหวา่งอดตี
และปัจจบุัน 

2. เมืѷอใดทีѷใชช้ทีหลายๆชทีแยกตารางคํานวณ ยอ่มแสดงวา่ชทีทั Ѹงหมดยังคงอยูใ่นแฟ้ม
เดยีวกนั เมืѷอนัѸนยอ่มทําใหแ้ฟ้ม Excel มขีนาดใหญข่ึѸน ซึѷงหากในการใชง้านไมไ่ด ้
ตอ้งการใหท้กุตารางทําการคํานวณพรอ้มกนั ก็ไมจํ่าเป็นตอ้งเก็บชทีทั Ѹงหมดไวใ้นแฟ้ม
เดยีวกนั ก็หาทางแยกชทีไปแยกเก็บเป็นแฟ้มไดทั้นท ีจากนัѸนเมืѷอใดทีѷตอ้งการใหแ้ฟ้ม
ใดคํานวณก็จัดการเลอืกเปิดเฉพาะแฟ้มทีѷตอ้งการขึѸนมาสัѷงคํานวณ 

3. แตล่ะชทีหรอืแฟ้มลว้นมตีารางคํานวณทีѷมโีครงสรา้งและลําดับคํานวณเดยีวกนั ซึѷงไมใ่ช่
เรืѷองยากทีѷจะสรา้งชทีหรอืแฟ้มขึѸนใหมใ่หม้ตีารางคํานวณแบบเดมิเพราะเพยีงแค ่copy 
ตารางทั Ѹงตารางไปทับก็ใชง้านไดแ้ลว้ แตถ่า้มกีารแกไ้ขสตูรคํานวณหรอืยา้ยตําแหน่ง
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เซลลใ์นชทีใด จงึเป็นขอ้ควรระวังวา่ตอ้งตดิตามไปแกไ้ขทกุชทีและทกุแฟ้มใหม้สีตูร
คํานวณและตําแหน่งเซลลต์รงกนัดว้ยในแตล่ะชทีหรอืแตล่ะแฟ้ม 

4. แทนทีѷจะสรา้งตารางคํานวณแยกชทีหรอืแยกแฟ้มซึѷงทําใหเ้กดิขอ้ควรระวงัในการ
ตดิตามไปแกไ้ขสตูรในแตล่ะตารางคํานวณดังกลา่วขา้งตน้แลว้ ยังมวีธิทีีѷดกีวา่โดยการ
ใชช้ทีเดยีวเป็นตารางคํานวณ สว่นชทีอืѷนๆใหใ้ชส้ําหรับเก็บคา่ตัวแปร จากนัѸนจงึใชส้ตูร
ดงึขอ้มลูตัวแปรจากชทีทีѷตอ้งการมาคํานวณในชทีเดยีว และเมืѷอใดทีѷตอ้งการ
เปรยีบเทยีบผลของการคํานวณก็สามารถใช ้Data Table สรปุผลในลักษณะ
เชน่เดยีวกบัโครงสรา้งตารางคํานวณ Single Module ในชทีเดยีวตามทีѷไดแ้นะนําไวใ้น
ภาคกอ่น 

ตวัอยา่งโครงสรา้งตารางคาํนวณ Single Module  
แบบแยกชที (อยา่งงา่ย) 

 

ตัวอยา่งนีѸดัดแปลงมาจากตัวอยา่งทีѷใชใ้นการอบรมหลักสตูรสดุยอดเคล็ดลับและลัดของ Excel 
จากเดมิซึѷงรวมตัวแปรของงบการเงนิทั Ѹงสาม case ไวต้ดิกนัในตารางเดยีวกนัในชทีเดยีวกนั 
เปลีѷยนมาเป็นการแยกตัวแปรของแตล่ะ case ไวใ้นชทีตา่งหากของมันเอง 

โปรดสงัเกตวา่นอกเหนอืจากตําแหน่งของตารางในชที Case1, Case2, และ Case3 ตอ้งใช ้

ตําแหน่งเซลลต์รงกนัทั Ѹงสามชทีคอืใชเ้ซลล ์F3:F6 เก็บตัวเลขของยอดขายและตน้ทนุแลว้ การ
ตั Ѹงชืѷอชทีใหม้คํีานําหนา้วา่ Case เหมอืนกนัแลว้ตามดว้ยตัวเลข 1, 2, หรอื 3 ถอืเป็นสว่นสําคัญ
ทีѷจะชว่ยใหส้ตูรทีѷใชด้งึขอ้มลูจากชทีทีѷตอ้งการสามารถทําไดง้า่ยขึѸนดว้ย ดังรปูตอ่ไปนีѸซ ึѷงเป็น
ชทีชืѷอ SheetModule เป็นตารางคํานวณทีѷเลอืกดงึขอ้มลูจากชทีชืѷอทีѷตอ้งการมาคํานวณ 
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1. ประเด็นสําคัญคอืตําแหน่งเซลล ์F3:F6 เป็นตําแหน่งเดยีวกบัขอ้มลูทีѷแยกเก็บไวใ้นชที 
Case1, Case2, และ Case3 

2. เซลล ์F2 เป็นเซลลเ์ดยีวเทา่นัѸนทีѷมกีารแกไ้ขตัวเลข คณุสามารถบันทกึตัวเลข 1, 2, หรอื 3 
ลงไปเพืѷอแสดงถงึเลขทีѷของ CaseNum ตาม case ทีѷถกูแยกไวใ้นชทีอืѷน ดังนัѸนเมืѷอนํา
ตัวเลขในเซลล ์F2 ไปตอ่ทา้ยกบัคําวา่ Case โดยใชส้ตูร =”Case”&$F$2 ยอ่มไดช้ืѷอชทีทีѷ
ตอ้งการ (ตามภาพนีѸ F2 มเีลข 2 บันทกึอยู ่ดังนัѸนสตูร =”Case”&$F$2 จงึคนืคา่เป็นคําวา่ 
Case2) 

3. สตูรในเซลล ์F3:F6 คอื 
=INDIRECT("Case"&$F$2&"!"&ADDRESS(ROW(),COLUMN())) 
3.1. สตูรสว่นตั Ѹงแต ่"Case"&$F$2&"!" จะคนืคา่ออกมาเป็นคําวา่ Case2! 
3.2. สตูรสว่นของ ADDRESS(ROW(),COLUMN()) คนืคา่ออกมาเป็นตําแหน่งเซลลข์อง

เลขทีѷ row และเลขทีѷ column ของตําแหน่งเซลลท์ีѷมสีตูรนีѸอยู ่เชน่ ในเซลล ์F3 สง่ผล
ใหส้ตูร Row() มคีา่เป็น 3 และสตูร Column() มคีา่เป็น 6 เพราะ Column F เป็น 
Column ทีѷ 6 จงึสง่คา่ไปยังสตูร ADDRESS(3,6) ใหค้นืคา่เป็น $F$3 

3.3. เมืѷอนําผลลัพธคํ์าวา่ Case2! มาเชืѷอมกบัคําวา่ $F$3 ดว้ยสตูร 
"Case"&$F$2&"!"&ADDRESS(ROW(),COLUMN()) จงึไดช้ืѷอชทีกบัตําแหน่งเซลลท์ีѷ
ตอ้งการออกมาเป็นคําวา่ "Case2!$F$3" 

3.4. สตูร Indirect จงึหาคา่จากชืѷอชทีและตําแหน่งเซลล ์"Case2!$F$3" ไดต้ัวเลข 200 
ตามตอ้งการ 

4. เมืѷอหาคา่ดว้ยสตูร Indirect ในเซลล ์F3:F6 ไดแ้ลว้ จงึสง่คา่ตอ่ไปคํานวณในตารางคํานวณ
งบการเงนิในพืѸนทีѷตารางดา้นซา้ยสดุ D3:D6 เพืѷอใชคํ้านวณหา Margin  

เคล็ดลบัทีѷใชร้ว่มกบัโครงสรา้งตารางคาํนวณ Single Module แบบแยกชที 

1. กรณีตอ้งการสรา้งชทีหลายชทีใหม้หีนา้ตาแบบเดยีวกนัโดยการสรา้งงานพรอ้มกนัเพยีงครั Ѹง
เดยีว ใหเ้ริѷมจากกดปุ่ ม Ctrl พรอ้มกบัคลกิทีѷ Sheet Tab เพืѷอเลอืกชทีทีѷตอ้งการ หรอืหาก
ตอ้งการเลอืกทกุชทีทีѷตดิกนั ใหเ้ริѷมจากอยูใ่นชทีแรกแลว้กดปุ่ ม Shift พรอ้มกบัคลกิเลอืก
ชทีสดุทา้ย ซึѷงจะพบคําวา่ [Group] แสดงไวต้อ่ทา้ยชืѷอแฟ้มทีѷปรากฏอยูด่า้นบนสดุของ
หนา้จอ จากนัѸนทกุอยา่งทีѷคณุสรา้งลงไปในชทีจะถกูสรา้งพรอ้มกนัลงไปในชทีทกุชทีทีѷ
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เลอืกไวใ้น [Group] เดยีวกนั และเมืѷอตอ้งการเลกิงานใหค้ลกิเลอืกชทีอืѷนทีѷไมไ่ดเ้ลอืกไว ้
หรอืชทีอืѷนในกรณีทีѷเดมิเลอืกไวท้กุชที ซึѷงจะพบวา่คําวา่ [Group] หายไป 

2. กรณีตอ้งการสรา้งชทีหลายชทีใหม้หีนา้ตาแบบเดยีวกนัโดยไมต่อ้งใชว้ธิ ีCopy จากชที
ตน้แบบไปยังชทีอืѷน ใหเ้ลอืกชทีแบบ [Group] โดยกดปุ่ ม Ctrl หรอื Shift แลว้คลกิเลอืก
ชทีเชน่เดยีวกบัวธิใีนขอ้แรก จากนัѸนใหค้ลกิเลอืกพืѸนทีѷตารางทีѷตอ้งการ แลว้สัѷง Home > 
Fill > Across Worksheets  

3. กรณีตอ้งการคํานวณหายอดรวมของทกุชที ใหเ้ริѷมจากพมิพส์ตูร =sum( แลว้คลกิเซลลใ์น
ชทีแรกทีѷตอ้งการ จากนัѸนกดปุ่ ม Shift แลว้คลกิเลอืกชทีสดุทา้ยแลว้กดปุ่ ม Enter จะไดส้ตูร 
=SUM(Case1:Case3!F3) โดยสตูรนีѸจะหายอดรวมของเซลล ์F3 จากทกุชทีตั Ѹงแตช่ทีชืѷอ 
Case1 ถงึ Case3 ใหทั้นท ีโดยไมต่อ้งเสยีเวลาสรา้งสตูรบวกตอ่กนัทลีะเซลลท์ลีะชที ตาม
สตูร =Case1!F3+Case2!F3+Case3!F3 อกีตอ่ไป  

4. กรณีตอ้งการคํานวณหายอดรวมของทกุชที ”เวน้” เฉพาะคา่จากชทีทีѷมสีตูรยอดรวม ให ้
พมิพส์ตูร =sum('*'!f3) โดยขอสมมตวิา่ในแฟ้มม ี3 ชทีตดิกนัตามลําดับ คอืชืѷอ Sheet1, 
Sheet2, และ Sheet3 ถา้สรา้งสตูรนีѸลงไปใน Sheet1 จะไดส้ตูร 
=SUM(Sheet2:Sheet3!F3) แตถ่า้สรา้งสตูรลงไปใน Sheet2 จะไดส้ตูร 
=SUM(Sheet1!F3,Sheet3!F3) หรอืถา้สรา้งสตูรลงไปใน Sheet3 จะไดส้ตูร 
=SUM(Sheet1:Sheet2!F3) 

5. กรณีตอ้งการจัดการแสดงโครงสรา้งแตล่ะชทีใหด้ตูา่งกนัไปหลายๆแบบโดยอตัโนมัต ิใหจั้ด
โครงสรา้งตารางโดยอาจสัѷง Hide Row/Column ซอ่นสิѷงทีѷไมต่อ้งการแสดง เพืѷอทําใหเ้ห็น
เฉพาะพืѸนทีѷตารางเทา่ทีѷตอ้งการกอ่น จากนัѸนใหส้ัѷง View > Custom Views > Adds แลว้
ตั Ѹงชืѷอ View ใหก้บัโครงสรา้งตารางทีѷเห็นอยูบ่นจอในขณะนัѸน จากนัѸนใหจั้ดหนา้ตาตาราง
ใหมใ่นชทีเดมิซํѸาหรอืในชทีอืѷนตามตอ้งการแลว้ตั Ѹงชืѷอ Custom View เพิѷมเตมิจนครบ แลว้
เมืѷอใดทีѷตอ้งการไปทีѷชทีใดก็ไมจํ่าเป็นตอ้งใชว้ธิไีลค่ลกิไปทลีะชทีอกี แตใ่หส้ัѷง View > 
Custom View แลว้คลกิเลอืกชืѷอ View แทน ซึѷงวธินีีѸนอกเหนือจากชว่ยเลอืกตารางในชทีทีѷ
ตอ้งการใหแ้ลว้ ในแตล่ะ View ยังบันทกึ Print Settings และ Filter Settings ตามใหอ้กี
ดว้ย 

6. กรณีตอ้งการใชส้ตูรเพืѷอคน้หาชืѷอชทีทกุชทีมาแสดงในเซลล ์ ใหใ้ชส้ตูร 
=GetSheetName(เลขทีѷชที) โดยสรา้งรหัส Function VBA ตอ่ไปนีѸไวใ้นแฟ้ม 
      Function GetSheetName(x) 
          GetSheetName = Sheets(x).Name 
      End Function 
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ข ัҟนตอนการปรบัโครงสรา้งตารางคาํนวณ Single Module จากแบบแยกชทีใหเ้ป็นแบบ
แยกแฟ้ม 

1. แกส้ตูร Indirect ในเซลล ์F3:F6 เป็นสตูร =Case1!F3, =Case1!F4, =Case1!F5, 
และ =Case1!F6 ตามลําดับเพืѷอ link ขอ้มลูมาจากชทีชืѷอ Case1 ในตําแหน่งเซลล์
เดยีวกนั 

 
 

2. Move ชทีชืѷอ Case1, Case2, Case3 ไปเป็นแฟ้มใหม ่โดยใชว้ธิคีลกิขวาทีѷชืѷอชที 
Case1 แลว้เลอืก Move or Copy จากนัѸนคลกิเลอืก (new book) แลว้กด OK จะพบวา่
ชที Case1 ถกูยา้ยทั Ѹงชทีไปเป็นแฟ้มใหมท่ีѷมชีทีเพยีงชทีเดยีว แลว้ใหทํ้าซํѸากบัชที 
Case2 และ Case3 ใหเ้ป็นแฟ้มใหมแ่ยกจากกนัโดยใชว้ธิเีดยีวกนันีѸอกี 

 
3. จัดเก็บแฟ้มทีѷเกดิขึѸนใหมจ่ากการยา้ยชที Case1, Case2, และ Case3 โดยตัѸงชืѷอแฟ้ม

เป็น SingleModuleLinkFilesCase1.xls, SingleModuleLinkFilesCase2.xls, และ 
SingleModuleLinkFilesCase3.xls ตามลําดับ แลว้เมืѷอกลับไปคลกิดสูตูรในเซลล ์
F3:F6 ในชที SheetModule จะพบวา่สตูรเดมิทีѷเคยเป็นสตูร link ขา้มชทีถกูแกไ้ขเอง
เป็นสตูร link ขา้มแฟ้ม =[SingleModuleLinkFilesCase1.xls]Case1!F3, =
[SingleModuleLinkFilesCase1.xls]Case1!F4, =
[SingleModuleLinkFilesCase1.xls]Case1!F5, และ =
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[SingleModuleLinkFilesCase1.xls]Case1!F6 ตามลําดับใหเ้อง 

 
4. เมืѷอตอ้งการดงึขอ้มลูจาก Case2 หรอื Case อืѷน ใหเ้ปิดแฟ้มปลายทางทีѷมสีตูร link ขา้ม

แฟ้มแสดงอยูข่ ึѸนมาใชง้านเพยีงแฟ้มเดยีว (โดยไมต่อ้งเปิดแฟ้มตน้ทาง) จากนัѸนสัѷง 
Office > Prepare > Edit Links to Files  

 
5. ใหค้ลกิเลอืกชืѷอแฟ้มตน้ทางเดมิ แลว้กดปุ่ ม Change Source จากนัѸนไลค่ลกิหาแฟ้มตน้

ทางใหมท่ีѷตอ้งการ ซึѷงเมืѷอเลอืกแฟ้มตน้ทางใหมไ่ดเ้รยีบรอ้ยและกดปุ่ ม OK > Close 
กลับมาแฟ้มปลายทาง จะพบวา่สตูรเกา่ถกูแกไ้ขใหด้งึขอ้มลูมาจากแฟ้มตน้ทางใหมใ่ห ้
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เองทันท ี

 

ขอ้ควรระวงัในการใชข้อ้มลูทีѷ link ขา้มแฟ้ม 

1. โครงสรา้งภายในของแฟ้มตน้ทางตอ้งเหมอืนกนัทกุแฟ้ม โดยตําแหน่งเซลลใ์ดเป็น
ขอ้มลูอะไรกต็อ้งกําหนดใหท้กุแฟ้มใชตํ้าแหน่งเซลลเ์ดยีวกนัทั Ѹงหมด 

2. หากแฟ้มตน้ทางมชีทีเดยีวแตใ่ชช้ืѷอชทีตา่งกนัเชน่ในตัวอยา่งนีѸใชช้ืѷอชทีวา่ Case1, 
Case2, และ Case3 เมืѷอสัѷง Change Source จะพบวา่ Excel สามารถปรับสตูร link 
ขา้มแฟ้มใหถ้กูตอ้ง แตถ่า้แฟ้มตน้ทางมหีลายชที ตอ้งตั Ѹงชืѷอชทีใหต้รงกนัทกุแฟ้มดว้ย 
มฉิะนัѸน Excel จะมขีั ѸนตอนเปิดจอขึѸนมาถามวา่ใหจั้บชืѷอชทีใดแทนดว้ยชืѷอชทีใด 

3. ถา้ตอ้งการแกไ้ขโครงสรา้งตารางโดยเฉพาะตําแหน่งเซลลใ์นแฟ้มตน้ทาง กอ่นจะแกไ้ข
ใดๆใหเ้ปิดทกุแฟ้มทีѷ link กนั ทั Ѹงแฟ้มตน้ทาง แฟ้มปลายทาง รวมทัѸงแฟ้มตน้ทางใหมท่ีѷ
ยังไมไ่ด ้link ขึѸนมาบนจอใหค้รบทัѸงหมดกอ่น จากนัѸนจงึคอ่ยทําการแกไ้ข เพืѷอทําให ้
Excel ไลแ่กตํ้าแหน่งอา้งองิในสตูรทีѷอา้งถงึแฟ้มทีѷเกีѷยวขอ้งใหเ้อง (ถา้ไมไ่ดเ้ปิดแฟ้ม 
Excel จะละเลยไมส่นใจตามไปแกไ้ขใหแ้มแ้ตน่อ้ย) 

4. ถา้ตอ้งการ Save เพืѷอตั Ѹงชืѷอแฟ้มใหมห่รอืยา้ย Folder ทีѷเก็บแฟ้ม ใหส้ัѷง Save แฟ้มตน้
ทางกอ่นแลว้จงึ Save แฟ้มปลายทางทหีลัง (แตถ่า้ไมไ่ดแ้กไ้ขชืѷอแฟ้มหรอืยา้ย Folder 
จะ Save แฟ้มใดกอ่นก็ได ้แตต่อ้ง Save ใหค้รบทกุแฟ้ม) 
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การออกแบบโครงสรา้งตารางคาํนวณ  
แบบ Compound Module 

เคยมคํีากลา่ววา่ Excel ไมส่ามารถนํามาใชก้บัการวางแผนความตอ้งการวัสดไุดห้รอก เราตอ้ง
หันไปซืѸอโปรแกรมสําเร็จรปูราคาแพงเป็นแสนเป็นลา้นบาทมาใชใ้นการวางแผนการผลติ ซึѷง
โรงงานผลติสนิคา้หลายๆแหง่อาจคดิวา่ไมแ่พง เพราะเมืѷอนําราคาโปรแกรมสําเร็จรปูไปเทยีบ
กบัมลูคา่ของโรงงานและสนิคา้ทีѷผลติแลว้ถอืวา่เป็นสดัสว่นทีѷนอ้ยมาก แลว้เมืѷอนําโปรแกรม
สําเร็จรปูเหลา่นีѸมาใช ้กลับพบวา่ไมส่ามารถนํามาใชก้บัการวางแผนการผลติไดอ้ยา่งสมบรูณ์
เสยีอกี ครั Ѹนจะขอใหผู้ข้ายโปรแกรมสําเร็จรปูชว่ยแกไ้ขดัดแปลงโปรแกรมใหใ้หมก่็ถกูคดิ
คา่ใชจ้า่ยเป็นเงนิอกีมากมาย ทีѷแยท่ีѷสดุก็คอื พอซืѸอโปรแกรมมาใชไ้ดส้กัพัก เจา้ตัวบรษัิททีѷขาย
โปรแกรมใหก้ลับปิดตัวเลกิกจิการไปแลว้ เป็นเหตใุหโ้ปรแกรมสําเร็จรปูทีѷไดม้าถกูนํามาใชง้าน
แคค่รึѷงๆกลางๆหรอืถงึกบัเลกิใชไ้ปเลยก็ม ี

คนทีѷเกง่คอมพวิเตอรไ์มว่า่จะเป็นโปรแกรมเมอรห์รอืผูท้ีѷคลกุคลอียูใ่นแวดวง IT มักเขา้ใจวา่
ปัญหาการคํานวณยากๆ ตอ้งหาทางเขยีนโปรแกรมหรอืหาซืѸอโปรแกรมสําเร็จรปูทีѷถกูสรา้ง
ขึѸนมาเพืѷอใชแ้กปั้ญหายากๆเหลา่นัѸนโดยเฉพาะ แมแ้ตค่นทีѷเกง่ Excel ก็ตาม มักชอบคดิวา่ตอ้ง
ใชโ้ปรแกรม VBA (Visual Basic for Applications) เป็นทางออกสดุทา้ยเมืѷอไมส่ามารถใชส้ตูร
หรอืคําสัѷงบนเมนูของ Excel ชว่ยในการแกปั้ญหาทีѷวา่ยากนัѸนได ้ซึѷงถา้วา่ไปแลว้ก็ไมใ่ชก่ารคดิ
ทีѷไมม่เีหตผุล เพราะปัญหาการคํานวณยากๆ ยกตวัอยา่งเชน่การวางแผนการผลติ มสี ิѷงทีѷตอ้ง
คํานงึถงึหลายอยา่งทีѷเกีѷยวขอ้งกบัการวางแผน เชน่ เงืѷอนไขทีѷเกีѷยวขอ้งกบัยอดสนิคา้คงเหลอื
ตน้งวดปลายงวด ยอดวัตถดุบิทีѷตอ้งสัѷงซืѸอซึѷงยังสมัพันธก์บัโครงสรา้งผลติภัณฑห์รอือตัรา
สว่นผสม หากวัตถดุบิขาดมอืก็ตอ้งสัѷงซืѸอมาสํารองไวใ้หเ้พยีงพอซึѷงเกีѷยวขอ้งกบัเงืѷอนไขการ
ขายของผูข้ายเขา้ไปอกี และทัѸงหมดนีѸยังตอ้งหาทางกําหนดเวลาทีѷจะตอ้งสัѷงผลติเพืѷอใหไ้ด ้
จํานวนสนิคา้ตามตอ้งการ ณ กําหนดเวลาทีѷตอ้งการ .... แคเ่ห็นปัญหาทีѷเกีѷยวขอ้งเหลา่นีѸก็แทบ
ไมอ่ยากจะคดิดว้ยสมองแลว้ใชไ่หม หลายตอ่หลายคนจงึพากนัตอบวา่ หันไปซืѸอโปรแกรม
สําเร็จรปูมาใชก้นัดกีวา่ 

จากประสบการณ์ทีѷผมคลกุคลอียูก่บั Excel มานานกวา่ยีѷสบิปีพบวา่ คนทีѷเกง่ Excel มากๆมัก
ขาดความรูเ้รืѷองการวางแผนการผลติ สว่นคนทีѷเกง่ในการวางแผนการผลติก็มักจะไมเ่กง่ Excel 
จงึทําใหไ้มม่ใีครทีѷสามารถนําความรูทั้ Ѹง Excel และการวางแผนการผลติมาใชง้านรว่มกนัเสยีท ี
ทางสมาคมสง่เสรมิเทคโนโลย ี(ไทย-ญีѷปุ่ น) ไดก้รณุาใหผ้มเขา้อบรมหลักสตูรการวางแผนการ
ผลติทีѷสมาคมจัดขึѸน ทําใหเ้กดิแนวทางใช ้Excel โดยออกแบบตารางคํานวณแบบ Compound 
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Module นีѸข ึѸนมา จงึใครข่อใชโ้อกาสนีѸ ขอบคณุสมาคมสง่เสรมิเทคโนโลย ี(ไทย-ญีѷปุ่ น) เป็น
อยา่งยิѷง ซึѷงคงไมเ่ป็นการกลา่วทีѷเกนิไปวา่ ในโลกนีѸมแีตป่ระเทศไทยของเราเทา่นัѸนทีѷมี
เทคโนโลยกีารออกแบบตารางคํานวณแบบ Compound Module หรอืหากประเทศอืѷนทําไดก้็
น่าจะเรยีนรูม้าจากเราอกีตอ่หนึѷง 

ลกัษณะโครงสรา้งตารางคาํนวณแบบ Compound Module 

โครงสรา้งตารางคํานวณแบบ Compound Module เกดิจากแนวความคดิทีѷจะใชต้าราง Excel 
หลายๆเซลลต์อ่กนัสําหรับการคํานวณทีѷตอ่เนืѷองกนัหลายๆขั Ѹน พอเซลลห์นึѷงคํานวณขั Ѹนหนึѷง
เสร็จ ก็ใหส้ง่คา่ไปคํานวณตอ่ในอกีเซลลห์นึѷง แลว้สง่คา่ตอ่ๆกนัไปยังเซลลท์ีѷอยูใ่นพืѸนทีѷตาราง
คํานวณชดุเดยีวกนั ซึѷงในตารางคํานวณชดุเดยีวกนันีѸอาจตอ้งใชจํ้านวนเซลลต์ั Ѹงแต ่2 เซลลข์ึѸน
ไปจนถงึนับรอ้ยนับพันเซลลก์็เป็นไดเ้พืѷอใหไ้ลคํ่านวณตัѸงแตต่น้จนจบ 

แนวความคดิดังกลา่วนีѸฟังดแูลว้ก็ไมเ่ห็นเป็นเรืѷองแปลกใชไ่หม คณุเองก็ใชต้าราง Excel ใน
แบบทีѷกลา่วนีѸเป็นกนัอยูแ่ลว้ เพยีงแตว่า่แทนทีѷจะใชต้ารางคํานวณเพยีงชดุเดยีวเพืѷอคํานวณให ้
ผลลัพธท์ีѷตอ้งการแลว้เสร็จ เรายังตอ้งหาทางใชต้ารางคํานวณชดุถัดไป ทีѷมหีนา้ตาตาราง
เหมอืนกบัตารางคํานวณชดุแรก เพืѷอใชใ้นการคํานวณซํѸาแบบเดยีวกบัการคํานวณในตาราง
คํานวณชดุแรกซํѸาตอ่ไปอกีใหไ้ด ้โดยหาทางสรา้งสตูรในตารางคํานวณชดุถัดไปใหส้ามารถรับ
คา่จากตารางคํานวณชดุกอ่น (Simple Compound Module) หรอืเลอืกรับคา่ตารางคํานวณชดุ
ใดๆก็ไดม้าใชคํ้านวณซํѸาอกี (Dynamic Compound Module) 

องคป์ระกอบสําคัญทีѷเป็นสว่นชว่ยใหเ้ราสามารถสรา้งตารางคํานวณขึѸนเพยีงชดุเดยีว จากนัѸน
สามารถสัѷง Copy แลว้นําไป Paste ใหเ้กดิตารางคํานวณชดุตอ่ไปซึѷงมสีตูรซํѸากบัตารางคํานวณ
ชดุแรกทกุเซลลก์็คอื ขอใหห้ลกีเลีѷยงการกําหนดตําแหน่งอา้งองิใดๆในสตูรแบบ Absolute 
(เชน่ $A$1) แตใ่หใ้ชก้ารกําหนดตําแหน่งอา้งองิแบบ Relative (เชน่ A1) แทน หรอืถา้
หลกีเลีѷยงไมไ่ด ้ก็ขอใหใ้ชตํ้าแหน่งอา้งองิแบบ Mixed ในแบบควบคมุตําแหน่ง Column ให ้
คงทีѷ (เชน่ $A1) โดยใหใ้ชใ้หน้อ้ยทีѷสดุ เพราะถา้กําหนดตําแหน่งอา้งองิ $A1 ไว ้จะตอ้ง Paste 
ตารางคํานวณชดุถัดไปในแนว Column เดมิเสมอ มฉิะนัѸนการอา้งองิจะผดิเพีѸยนจากตําแหน่งทีѷ
ตอ้งการ 

ผูท้ีѷคุน้เคยกบัการสรา้งตารางคํานวณตอ้งทราบถงึประโยชนข์องการใสเ่ครืѷองหมาย $ เพืѷอชว่ย
ควบคมุตําแหน่งอา้งองิในสตูรวา่มคีวามสําคัญเพยีงใด แมเ้ครืѷองหมาย $ จะชว่ยใหเ้ราสรา้งสตูร
แลว้ Copy ไปใชท้ีѷเซลลอ์ืѷนไดทั้นท ีแตใ่นโครงสรา้งตารางคํานวณแบบ Compound Module นีѸ 
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เครืѷองหมาย $ กลับเป็นสิѷงตอ้งหา้ม ดังนัѸนแมใ้นระหวา่งการสรา้ง Module แรกขึѸนมาใชง้าน ซึѷง
เราจําเป็นตอ้งอาศัยเครืѷองหมาย $ แตเ่มืѷอสรา้งงานเสร็จแลว้ก็ตอ้งลบเฉพาะเครืѷองหมาย $ ทีѷ
ใชใ้นเซลลท์ิѸงไป โดยใน Excel 2007 ใชคํ้าสัѷง Home > Find & Select > Replace  

ตวัอยา่งตารางคาํนวณ Compound Module อยา่งงา่ย 

 

ตัวอยา่งนีѸอยูใ่นชทีชืѷอ SimpleCompound เป็นตารางคํานวณหาระยะเวลาทีѷใชใ้นการผลติ 
กําหนดใหผ้ลติสนิคา้ A, B, C, D (ProductName เซลล ์B4:B7) โดยสนิคา้แตล่ะชนดิตอ้งใช ้

เวลาในการผลติตา่งกนัไป เชน่ ในการผลติสนิคา้ A เมืѷอผา่นขั Ѹนตอนการผลติ 4 ขั Ѹนตอน (เซลล ์ 
C4:F4) ตอ้งใชเ้วลา 20 นาทใีนการผลติขั Ѹนตอนทีѷ 1 จากนัѸนตอ้งใชเ้วลา 10 นาท ีตามดว้ย 30 
นาท ีและตามดว้ย 20 นาท ีในขั Ѹนตอนทีѷ 2, 3, 4 ตามลําดับจงึจะแลว้เสร็จ 

ในกระบวนการผลติสนิคา้ A, B, C, และ D นีѸ หากกําหนดใหเ้ริѷมตน้ผลติในเวลา 8 นาฬกิา จะ
ผลติเสร็จในเวลาใด ทั ѸงนีѸกําหนดใหเ้ลอืกผลติสนิคา้ A, D, C, B กอ่นหลังตามลําดับ (หรอืใน
อนาคตอาจจัดลําดับการผลติกอ่นหลังตา่งไปก็ได)้ โดยหาทางใหใ้ชร้ะยะเวลาผลติทีѷนอ้ยทีѷสดุ 
เมืѷอผลติสนิคา้ใดเสร็จใหผ้ลติสนิคา้ชนดิตอ่ไปไดทั้นท ี

ตารางดา้นขวาทีѷเซลล ์L4:L6 ของรปูขา้งตน้เป็นคําตอบทีѷไดจ้ากการคํานวณ กลา่วคอื เมืѷอเริѷม
ผลติในเวลา 8 นาฬกิา จะผลติสนิคา้ทั Ѹงหมดเสร็จในเวลา 11 นาฬกิา ถอืเป็นระยะเวลาผลติ
ทั ѸงสิѸน 3 ชัѷวโมง 

ปัญหาทีѷตอ้งคํานงึถงึในการกําหนดขั Ѹนตอนการผลติในตัวอยา่งนีѸก็คอื เราตอ้งหาทางสรา้ง
ตารางคํานวณทีѷสามารถจัดลําดับการผลติกอ่นหลังแบบใดก็ได ้อกีทั Ѹงตอ้งหาทางสรา้งสตูรให ้
กําหนดเวลาเริѷมผลติในแตล่ะขั Ѹนตอนของสนิคา้แตล่ะตัว ตอ่เนืѷองกบัเวลาผลติเสร็จในขั Ѹนตอน
กอ่นหนา้ หรอือกีนัยหนึѷงหา้มสัѷงผลติสนิคา้ชนดิถัดไป หากสนิคา้ชนดิแรกยังอยูใ่นกระบวนการ
ผลติขั ѸนตอนนัѸนๆ ดังรปูตอ่ไปนีѸ 
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ขอใหพ้จิารณาภาพ Gantt Chart ในลําดับการผลติของ Process 2 จะพบวา่เมืѷอสนิคา้ A ผลติ
เสร็จในเวลา 8:30 นาฬกิา แตย่ังไมส่ามารถนําสนิคา้ D มาผลติตอ่ใน Process 2 ไดทั้นท ี
เพราะในขณะนัѸนสนิคา้ D ยังอยูใ่นกระบวนการผลติของ Process 1 อยู ่ตอ้งรอจนถงึเวลา 8:40 
นาฬกิา จงึเริѷมผลติสนิคา้ D ใน Process 2 ตอ่ไปได ้แลว้ตอ่เมืѷอสนิคา้ D ผลติเสร็จใน Process 
2 ก็สามารถนําสนิคา้ C และ B มาผลติตอ่ใน Process 2 ไดต้อ่เนืѷองทันท ี

 

Compound Module ในตัวอยา่งนีѸคอืพืѸนทีѷตารางตั Ѹงแตเ่ซลล ์B12:Z15 โดยกําหนดใหใ้ชเ้ซลล ์
B12 ตรงหัวมมุซา้ยบนสดุสําหรับบันทกึชืѷอสนิคา้ทีѷตอ้งการลงไป จากนัѸนเซลล ์C13:F13 จะดงึ
ระยะเวลาทีѷใชใ้นการผลติ (Time Consumed) จากตาราง Time Consumed Table ดา้นบน
ของชทีลงมาใชง้าน โดยใชส้ตูร =VLOOKUP($B12,TimeConsumedTbl,C12+1,0) จากนัѸน
เมืѷอนําเวลาเริѷมผลติ 8:00 ในเซลล ์C10 มาบวกเพิѷมดว้ยระยะเวลาทีѷใชใ้นการผลติ ทําให ้
คํานวณหา Start Time และ Stop Time ในพืѸนทีѷเซลล ์C14:F15 

เซลลส์ําคัญทีѷสดุทีѷทําให ้Compound Module สามารถนําไปใชง้านตอ่ไปไดใ้นตารางชดุอืѷนคอื 
เซลล ์D14 มสีตูร =MAX(D10,C15) โดยขอใหส้งัเกตวา่ตําแหน่งเซลล ์D10 ทีѷกําหนดไวใ้น
สตูร MAX นีѸเป็นตําแหน่งเซลลท์ีѷอยูเ่หนอืขอบเขตของตาราง Module (B12:Z15) เพืѷอใหใ้ช ้
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ตําแหน่งเซลล ์D10 ซึѷงไมไ่ดก้ําหนดเครืѷองหมาย $ ไวห้รอือกีนัยหนึѷงคอืเซลลท์ีѷอยูเ่หนอืพืѸนทีѷ
ตาราง Module ขึѸนไปอกี 2 เซลล ์สาํหรับนําเวลา Stop Time ของ Module กอ่นหนา้มาเทยีบ
กบัเวลา Stop Time ของ Module ตัวเอง (D10 vs C15) วา่ใหเ้ลอืกนําเวลาทีѷมากทีѷสดุมาใช ้

เป็นกําหนดการเริѷมกระบวนการผลติในขั Ѹนตอนตอ่ไป 

หลังจากสรา้ง Module แรกในเซลล ์B12:Z15 เสร็จแลว้ เมืѷอตอ้งการคํานวณหากําหนดการ
ผลติของสนิคา้ในลําดับถัดไป ก็เพยีงแค ่Copy เซลล ์B12:Z15 ไป Paste ตอ่กนัลงไปแลว้
เปลีѷยนชืѷอสนิคา้ทีѷเซลลห์ัวมมุซา้ยของแตล่ะ Module ตามชืѷอสนิคา้ทีѷผลติในแตล่ะลําดับ ก็จะ
พบวา่ Module ทกุชดุคํานวณรว่มกนัไดร้ะยะเวลาและกําหนดการผลติแตล่ะขั Ѹนตอนตาม
ตอ้งการในทันท ี

 

โปรดสงัเกตวา่ แตล่ะ Module ถกูวางหา่งกนัโดยเวน้ระยะ 1 row ระหวา่งกนัเสมอ ทั ѸงนีѸเพืѷอทํา
ใหส้ตูร =MAX(D10,C15) จาก Module แรกเป็นสตูรดงึคา่จาก Stop Time ซึѷงเป็น row 
ลา่งสดุของ Module ดา้นบนมาใชต้อ่ไปนัѷนเอง 
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ตวัอยา่งตารางคาํนวณ Compound Module  
แบบ Dynamic 

ตัวอยา่งทีѷผา่นมาเป็นการกําหนดตําแหน่งอา้งองิทีѷเชืѷอมคา่จาก Module ทีѷวางไวด้า้นบนตดิกนั 
เหมาะกบัการคํานวณทีѷมขีั Ѹนตอนตอ่เนืѷองกนัไปแบบเสน้ตรง แตห่ากการวางแผนการผลติตอ้ง
เกีѷยวขอ้งกบัโครงสรา้งผลติภัณฑ ์(Bill of Materials : BOM) ในโครงสรา้งทีѷซบัซอ้นตามภาพ
ตอ่ไปนีѸ ก็ตอ้งหาทางพัฒนาโครงสรา้งตารางคํานวณแบบ Dynamic 

 

จากภาพแสดงถงึการผลติสนิคา้ A ซึѷงหากผลติเพยีง 1 หน่วย ( Unit = 1 ) ตอ้งอาศยัวัสด ุB 
จํานวน 2 หน่วยและ C จํานวน 3 หน่วย โดยในการผลติวัสด ุB ตอ้งใชว้ัสด ุD จํานวน 2 หน่วย
และวัสด ุE จํานวน 2 หน่วย สว่นวัสด ุC ตอ้งใชว้ัสด ุE จํานวน 2 หน่วยและวัสด ุF จํานวน 2 
หน่วย ซึѷงในการผลติวัสด ุF เองก็ตอ้งอาศัยวัสด ุG จํานวน 1 หน่วยและวัสด ุD จํานวน 2 หน่วย  

สว่นคําวา่ LT ยอ่มาจากคําวา่ Lead Time หมายถงึชว่งเวลานํา ซึѷงเป็นระยะเวลาทีѷใชใ้นการ
ผลติหรอืระยะเวลาทีѷตอ้งรอคอยในการไดม้าของสนิคา้ จากภาพแสดงวา่สนิคา้ A ตอ้งใช ้

ระยะเวลาผลติ 1 วัน (หรอืหน่วยของระยะเวลาอืѷนๆก็ได ้ในตัวอยา่งนีѸขอใชร้ะยะเวลาเป็นหน่วย
วัน) วัสด ุB, C, D, E, F, G ตอ้งใชร้ะยะเวลาผลติหรอืระยะเวลารอคอยเทา่กบั 2 วัน, 1 วัน, 1 
วัน, 2 วันและ 3 วัน ตามลําดับ (โปรดศกึษารายละเอยีดเพิѷมเตมิจากหนังสอื ระบบการวางแผน
และควบคมุการผลติ โดยรศ.พภิพ ลลติาภรณ์ สํานักพมิพข์องสมาคมสง่เสรมิเทคโนโลย ี(ไทย-
ญีѷปุ่ น)) 

ในการออกแบบตารางคํานวณเพืѷอวางแผนความตอ้งการวัสด ุ(Material Requirements 
Planning - MRP) ตอ้งหาทางสรา้งตารางคํานวณทีѷสามารถคํานวณตามโครงสรา้งผลติภัณฑท์ีѷ
อาจเปลีѷยนแปลงไปจากเดมิ เชน่ เดมิสนิคา้ A มวีสัด ุB และ C เป็นโครงสรา้งในการผลติ หาก
ในภายหลังมวีัสด ุG เพิѷมเตมิ หรอืเลกิใชว้ัสด ุB หรอืใชว้ัสดอุืѷนมาแทนทีѷ และหากตัวเลขจํานวน
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การใชว้ัสดแุละ LT เปลีѷยนแปลงไปจากเดมิ ก็ตอ้งหาทางประยกุตใ์ช ้Excel กบังาน MRP ได ้
โดยไมจํ่าเป็นตอ้งแกไ้ขสตูรคํานวณใหมแ่มแ้ตน่อ้ย 

อนึѷงในแงข่องโครงสรา้งผลติภัณฑย์ังมศีัพทคํ์าวา่ Parent กบั Child ทีѷตอ้งทําความเขา้ใจ
เพราะเป็นหลักการสําคัญทีѷนําไปใชใ้นการสรา้งตารางคํานวณ เชน่ หากกําหนดใหส้นิคา้ A เป็น 
Parent ก็จะพบวา่มวีัสด ุB และ C เป็น Child แลว้หากกําหนดใหว้ัสด ุB เป็น Parent ก็จะพบวา่
มวีัสด ุD และ E เป็น Child ซึѷงจะเห็นวา่การพจิารณาความสมัพันธร์ะหวา่งการเป็น Parent-
Child เป็นการพจิารณาความสมัพันธร์ะหวา่งการผลติสนิคา้หรอืวัสดใุนลําดับหนึѷงนัѷนเอง 

ตัวอยา่งตอ่ไปนีѸมาจากชทีชืѷอ DynamicCompound ในแฟ้มชืѷอ CompoundModule.xls 

 

โครงสรา้งตารางคํานวณแบบ Compound Module คอื พืѸนทีѷตารางตั Ѹงแตเ่ซลล ์B6:P7 มเีซลล์
ทีѷใชร้ับคา่ตัวแปรใน Column B, C, E, และ F โดยใชเ้ซลล ์B6 สําหรับบันทกึชืѷอ Item ในระดับ 
Child และใชเ้ซลล ์C6 บันทกึชืѷอ Parent โดยใชเ้ซลล ์E6 และ F6 บันทกึตัวเลขสดัสว่นการ
ผลติและ Lead Time ตามลําดับ 

วธิกีารนํา Module ไปใชง้าน ใหเ้ริѷมจาก Copy Module จากเซลล ์B6:P7 ไป Paste ตอ่ๆกนัไป
ใหค้รบตามจํานวนความสมัพันธร์ะหวา่ง Child->Parent ทีѷมอียู ่(B->A, C->A, D->B, E->B, 
E->C, F->C, G->F, D->F) จากนัѸนใหบ้ันทกึคา่ใหมล่งไปในเซลลร์ับตัวแปรใน Column B, C, 
E, และ F ของแตล่ะ Module ใหค้รบถว้นถกูตอ้งตามทีѷกําหนดไวใ้นโครงสรา้งผลติภัณฑ ์จะ
พบวา่พืѸนทีѷตารางใน Column H:P จะคํานวณจํานวนวัสดทุีѷตอ้งการและกําหนดเวลาทีѷตอ้งเริѷม
สัѷงผลติเพืѷอใหไ้ดส้นิคา้หรอืวัสดเุสร็จตามกําหนดใหทั้นท ี
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หลักการคํานวณทีѷใช ้เกดิจากการหาตําแหน่งเลขทีѷ row สดุทา้ยของแตล่ะ Module (Last Row 
of Module) ใน Column D ใหไ้ดก้อ่น จากนัѸนจงึใชเ้ลขเลขทีѷ row สดุทา้ยของแตล่ะ Module 
สําหรับดงึตัวเลขการสัѷงผลติจาก Module ของ Parent ไปใชใ้นการสัѷงผลติของ Module ทีѷเป็น 
Child 

เพืѷอทําใหเ้ห็นลําดับการคํานวณไดช้ดัเจนยิѷงขึѸน ขอใหด้ ูRow 14 ซึѷงเป็นการสัѷงผลติวัสด ุE 
ใหก้บัวัสด ุC พอคณุบันทกึชืѷอวัสด ุC ลงไปในเซลล ์C14 จะพบวา่ในเซลล ์D14 คํานวณหาเลข 
9 มาให ้ซึѷงเกดิจากสตูร =MATCH(C14,B$1:B$1001,0)+1 โดยสตูร Match จะนําชืѷอ Parent 
C ไปเทยีบหาตําแหน่งจากพืѸนทีѷ B1:B1001 พบวา่ชืѷอ C อยูใ่นลําดับทีѷ 8 จากนัѸนนําไปบวก 1 
ใหก้ลายเป็นเลขทีѷ Row 9 ซึѷงเป็นตําแหน่งเลขทีѷ row สดุทา้ยของ Module (Last Row of 
Module) ทีѷม ีChild ชืѷอ C 

พอไดเ้ลข 9 ในเซลล ์D14 แลว้ จากนัѸนจงึใชส้ตูรดงึตัวเลข 150 จากเซลล ์N9 สง่ตอ่มาใชท้ีѷ
เซลล ์N14 โดยใชส้ตูร =INDIRECT(ADDRESS($D14,COLUMN()))*$E14 โดยในการผลติ
วัสด ุC จํานวน 1 หน่วย ตอ้งอาศัยวัสด ุE จํานวน 2 หน่วย (เซลล ์E14 = 2) จงึตอ้งสัѷงผลติ E 
จํานวน 300 หน่วย (=150x2) สว่นวัสด ุE นัѸนกวา่จะผลติเสร็จก็ตอ้งใชร้ะยะเวลา (LT) 2 วัน ทํา
ใหต้อ้งสัѷงผลติหรอืจัดหาวัสด ุE ลว่งหนา้ตั Ѹงแตว่ันทีѷ 5 จงึจะพรอ้มตอ่การนําไปใชผ้ลติตอ่ใน
วันทีѷ 7 

สว่นของสตูร =INDIRECT(ADDRESS($D14,COLUMN())) ในเซลล ์N14 ชว่ยดงึคา่มาจาก
เซลลท์ีѷทราบตําแหน่ง Row และ Column  โดยทีѷ D14 เป็นเลขทีѷ Row สว่นสตูร Column() จะ
หาเลขทีѷ Column N ณ ตําแหน่งของเซลลส์ตูร จงึทําใหเ้กดิสตูร Address(9,14) คนืคา่ออกมา
เป็นตําแหน่งเซลล ์$N$9 จากนัѸนสตูร Indirect(“$N$9”) จงึดงึคา่จากเซลล ์N9 มาใหใ้นทีѷสดุ 

ตัวอยา่งจากชทีชืѷอ DynamicCompound นีѸเป็นการคํานวณอยา่งงา่ยเพืѷอแสดงหัวใจของการ
เชืѷอมโยงตัวเลขการสัѷงผลติ ณ กําหนดเวลาทีѷตอ้งการของแตล่ะ Module เขา้ดว้ยกนั แตใ่นการ
ผลติจรงิยังตอ้งคํานงึถงึตัวเลขสนิคา้ตน้งวดปลายงวดและตัวเลขอกีมากมายทีѷเป็นเงืѷอนไข
เกีѷยวขอ้งกบัการผลติแตล่ะครั Ѹง จงึขอใหใ้ช ้Module ทีѷสรา้งไวใ้นชทีชืѷอ MRPModule แทน 



361 

 

© พ.ศ.2564 โดย สมเกยีรต ิฟุ้งเกยีรต ิ
www.ExcelExpertTraining.com 

 

วธินํีา Module ไปใชก้็ใชว้ธิ ีCopy ไป Paste ซํѸาตามโครงสรา้งผลติภัณฑเ์ชน่เดยีวกนั โดย
โครงสรา้งตารางคํานวณทีѷสรา้งขึѸนแบบสมบรูณ์นีѸ Child แตล่ะตัว สามารถสัѷงผลติเป็นวัสดใุห ้
Parent ได ้3 ตัว (เซลล ์D20:D22) ทําใหไ้มจํ่าเป็นตอ้งเตรยีม Module ของ Child ซํѸากนัเชน่
ตัวอยา่งทีѷผา่นมา 

จากนัѸนเมืѷอนําตัวอยา่งการทํา MRP จากหนังสอื ระบบการวางแผนและควบคมุการผลติ โดยรศ.
พภิพ ลลติาภรณ์ สํานักพมิพข์องสมาคมสง่เสรมิเทคโนโลย ี(ไทย-ญีѷปุ่ น) หนา้ 136 มาวางแผน
ความตอ้งการวัสด ุจะเกดิเป็น Compound Module ทีѷคํานวณรว่มกนั 
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ตัวอยา่งในแฟ้ม CompoundModuleMRP(Ans).xls นอกเหนือจากแสดงการใช ้Compound 
Module แบบซบัซอ้นโดยนําโครงสรา้งผลติภัณฑ ์2 โครงสรา้งมาใชร้ว่มกนัแลว้ ยังแสดงวธิกีาร
สรา้งตารางฐานขอ้มลูเพืѷอเก็บคา่ตัวแปร แลว้ใชส้ตูรดงึคา่จากตารางตัวแปรไปยังเซลลร์ับคา่ใน 
Module ใหเ้องอกีดว้ยเพืѷอชว่ยอํานวยความสะดวกในการกรอกขอ้มลูและลดโอกาสผดิพลาด
จากการกรอกขอ้มลูผดิชอ่ง จากนัѸนเมืѷอไดผ้ลลัพธท์ีѷคํานวณใน Compound Module เสร็จ
เรยีบรอ้ยก็ยังแสดงวธิใีชส้ตูรดงึผลลัพธไ์ปสรปุเพืѷอเปรยีบเทยีบกบัจํานวนการผลติทีѷเกดิขึѸนจรงิ
ทีѷอาจแตกตา่งจากแผนการผลติทีѷวางไว ้

บทสง่ทา้ย 

การออกแบบตารางคํานวณทีѷนํามาอธบิายนีѸ น่าจะเป็นการจดุประกายความคดิใหผู้ใ้ช ้Excel 
สามารถสรา้งสรรคง์านไดห้ลายหลายรปูแบบมากขึѸน ผมเชืѷอวา่หลักการหรอืแนวความคดิทีѷได ้
ใหไ้ปแลว้นีѸยอ่มเป็นสิѷงทีѷสําคัญมากกวา่ตัวอยา่งทีѷมปีระโยชนจํ์ากดัแคใ่ชก้บัการแกไ้ขปัญหา
หนึѷงเสร็จแลว้ก็แลว้กนัไป ขอเพยีงสามารถนําหลักการหรอืแนวความคดิไปพัฒนาตอ่ ยอ่มเป็น
แนวทางใหส้ามารถใช ้Excel แบบคอมพวิเตอร ์สามารถนํา Excel ไปประยกุตใ์ชก้บังานทีѷหลาย
คนคดิวา่ทําไมไ่ดม้ากอ่น หาทางสรา้งตารางคํานวณทีѷสะดวกตอ่การนํามาใชง้านซํѸาแลว้ซํѸาอกี 
งา่ยตอ่การแกไ้ข และทีѷสาํคัญคอืเป็นหลักการทีѷงา่ยตอ่ความเขา้ใจ 


